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Modeling with PowerDesigner

The chapters in this part introduce you to the SAP® PowerDesigner® interface and the core concepts available for

all kinds of models.

1.1

Getting Started with PowerDesigner

SAP® PowerDesigner® is a graphical enterprise architecture and design solution supporting standard
methodologies and notations and providing automated code reverse engineering and generation through
customizable templates. PowerDesigner provides powerful reporting capabilities, is highly extensible, and offers a
scalable enterprise repository solution with strong security and versioning capabilities to aid multi-user

development.
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The default PowerDesigner window displays the following views:
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The Browser - displays your models and the objects belonging to them (see The Browser [page 38]). The
Browser also allows you to view a PowerDesigner repository (see The Repository [page 242]) and may display
an enterprise library of shared models (see The Library [page 43]) and an enterprise glossary (see The
Glossary [page 39]).

The Canvas - is a tabbed view that displays your open diagrams (see Diagrams [page 185]) and report
outlines (see Reports [page 3241]).

The Toolbox - displays graphical tools to help you quickly build model diagrams. The available tools depend on
the type of the currently selected diagram (see Creating Objects from the Toolbox [page 93]).

The Result List - displays the results of a search or a model check.

The Output view - (grouped, above, with the Result List) displays the progress of any PowerDesigner process,
such as checking a model or generating or reverse engineering a database.

For information about moving, docking, grouping, splitting, and hiding these views, see Organizing Views [page
443].

In addition, you will work extensively with:

Object property sheets - which permit you to view and edit the object's properties. You can access an object's
property sheet by double-clicking its symbol or browser entry, or right-clicking it and selecting Properties (see
Object Properties [page 107]).

Object lists - provide a spreadsheet-like presentation of, and allow for the easy creation and modification of
objects in your model. Lists are available under the Model menu and on the property sheets of composite
objects such as entities, tables, and classes, which contain sub-objects (see Object Lists [page 118]).

1.1.1 The Welcome Page

The Welcome page gives you one-click access to all your recent projects, workspaces, and models, as well as
providing a direct link to the New Model and New Project dialogs and a range of help materials. To suppress this

page, select the Do not show this page again check box. You can redisplay it at any time by selecting |# View »

Welcome Page .

8
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By default, the following items are available:

e (Getting Started

o

o

o

o

Create Model - Opens the New Model dialog to let you create a model (see Creating a Model [page 12]).
Create Project - Opens the New Project dialog to let you create a project (see Creating a Project [page
497).

Open Model or Project - Opens a standard Open dialog to let you browse for a model or project to open.
Examples - Opens the PowerDesigner Examples folder to let you select an example model to open.
Help - Opens the PowerDesigner online help.

What's New in PowerDesigner - Opens the PowerDesigner New Features Summary.

Documentation and Videos - Opens a Web page listing the available PowerDesigner documentation and
videos.

PowerDesigner Web Site - Opens the PowerDesigner page on the SAP® website.
PowerDesigner Newsgroup - Opens the PowerDesigner newsgroup page.

® Recent projects and workspaces - Lists your most recent projects and workspaces. Click a project or
workspace to open it.
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® Recent models - Lists your most recent models. Click a model to open it.

1.1.2 PowerDesigner Models

PowerDesigner enables you to closely integrate the design and maintenance of your application's core data layers
with your project requirements, business processes, OO code, XML vocabularies, and database replication
information and to align these with your overall enterprise architecture and corporate standards. By providing you
with a comprehensive set of models at all levels of abstraction, PowerDesigner helps you broaden the reach of your
iterative design process to all aspects of your system architecture, from conception to deployment, and beyond.

The following types of PowerDesigner models are available:

Icon

o

Description

A requirements model (RQM) helps you analyze any kind of written requirements and link them with users and
groups who will implement them and with design objects in other models. You can use an RQM to represent any
structured document (e.g. functional specification, test plan, business goals, etc.) and import and export hierar-
chies of requirements as MS Word documents.

File extension: . rgqm Backup: . rgb

An enterprise architecture model (EAM) helps you analyze and document your organization, its capabilities and
processes, the applications and systems that support them, and the physical architecture on which they are imple-
mented.

File extension: . eam Backup: . eab

A business process model (BPM) helps you identify, describe, and decompose business processes. You can analyze
your system at various levels of detail, and focus alternatively on control flow (the sequence of execution) or data
flow (the exchange of data). SAP® PowerDesigner® supports Analysis, SOA, DFD, SAP® Solution Manager, BPMN
(including for SAP BPM), and BPEL process languages, and process simulation through SIMULS.

File extension: . bpm Backup: .bpb

A conceptual data model (CDM) helps you analyze the conceptual structure of an information system, to identify
the principal entities to be represented, their attributes, and the relationships between them. A CDM is more ab-
stract than a logical (LDM) or physical (PDM) data model.

File extension: . cdm Backup: . cdb

A logical data model (LDM) helps you analyze the structure of an information system, independent of any specific
physical database implementation. An LDM has migrated entity identifiers and is less abstract than a conceptual
data model (CDM), but does not allow you to model views, indexes and other elements that are available in the
more concrete physical data model (PDM).

File extension: . 1dm Backup: . 1db

10
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Icon Description

%g A physical data model (PDM) helps you to analyze the tables, views, and other objects in a database, including mul-
tidimensional objects necessary for data warehousing. A PDM is more concrete than a conceptual (CDM) or logical
(LDM) data model. You can model, reverse-engineer, and generate for all the most popular DBMSs.

File extension: . pdm Backup: . pdb

aF A data movement model (DMM) provides a global view of the movement of information in your organization. You
can analyze and document where your data originates, where it moves to, and how it is transformed on the way,
including replications and ETL.

File extension: . dmm Backup: . dmb

% An object-oriented model (OOM) helps you analyze an information system through use cases, structural and be-
havioral analyses, and in terms of deployment, using the Unified Modeling Language (UML). You can model, re-
verse-engineer, and generate for Java, .NET and other languages.

File extension: . oom Backup: . oob

ﬁéﬁ An XML model (XSM) helps you analyze an XML Schema Definition (.XSD), Document Type Definition (.DTD) or
XML-Data Reduced (.XDR) file. You can model, reverse-engineer, and generate each of these file formats.

File extension: . xsm Backup: . xsb

pio) A free model (FEM) provides a context-free environment for modeling any kind of objects or systems. You can use it
to sketch simple visualizations or create entirely new forms of model by defining your own concepts and graphical
symbols through an extension file. See The Free Model (FEM) [page 240].

File extension: . fem Backup: . feb

The glossary model (GLM) helps you capture and organize the terminology to be used for naming your model ob-
@ jects. An administrator deploys the glossary, and users enable it in their models to provide autocompletion for ob-
ject names and model checks to ensure compliance. The glossary appears in the Browser Glossary tab and updates
are pushed to users each time they connect to the repository, or on demand. Only one glossary is permitted per
repository. See The Glossary [page 39] and Deploying an Enterprise Glossary [page 577].

File extension: . glm Backup: . geb

L= A multimodel report (MMR) is a PowerDesigner report that can document any number of models together and
show the links between them. To create such a report, you must have at least one model open in the workspace,
and you can add additional models at any time. See Reports [page 324].

File extension: .mmr Backup: .bmr

PowerDesigner does not impose any particular software engineering methodology or process. Each company can
implement its own workflow, defining responsibilities and roles, describing what tools to use, what validations are
required, and what documents to produce at each step in the process.

A development team will comprise multiple user roles, each of whom will use different PowerDesigner models:

e Business Analysts — define the architecture of the organization, the business requirements and high-level
business flows, and may use:

Core Features Guide
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o

EAM - for providing a big picture of the organization, defining its structure, and analyzing high-level
functions, processes, and flows. These architectural objects can be attached to implementation objects in
any of the other models.

RQM - for defining business requirements to be refined into technical requirements by Analysts and
Designers.

BPM - to define the high-level business process flows in existing and new systems, and to simulate
business processes to improve productivity.

e Data Analysts and Designers - map technical requirements to business requirements, and may use:

o

o

o

OOM - to define use cases and map them to requirements.

BPM - to write functional specifications and define more precisely the nature and details of each process,
the application and its data structure.

CDM - to provide a clear view of business data across all systems.

e Database Administrators use the well-defined data structure to optimize, denormalize, and create the
database, and may use:

o

PDM - to represent a database running on a server with complete information on the structure of the
physical objects, such as tables, columns, references, triggers, stored procedures, views, and indexes, and
to generate to and reverse-engineer from scripts or a live database connection. By maintaining a PDM and
a CDM, you can ensure that your analysis and design efforts are reflected exactly in your actual systems.
LDM - which can act as a bridge between a CDM and a PDM, allowing you to resolve many-to-many and
super/sub-type relationships, de-normalize your data structures, and define indexes, without specifying a
particular RDBMS.

DMM - to represent the replication of information from a source database to one or several remote
databases.

e Developers model the application, defining object structures and behaviors, and Object/Relational mappings,
and may use:

o

e}

RQM - to write technical specifications.

OOM - to represent objects and their interactions in UML, and to generate and reverse engineer OO code.
Close integration with your BPM, CDM, and PDM can greatly simplify the maintenance and development
of your system.

XSM - to graphically model the complex structure of an XML file and to generate and reverse-engineer
DTDs, and XSDs and link them to your PDM and OOM.

e Testers will use the RQM, CDM, and other models, together with the design documents to understand how the
application should work and how it is developed.

1.1.3 Creating a Model

You create a new model by selecting [+ File » New Model 3.

Context

1 Note

A project can provide a convenient environment for working with multiple interconnected models and other files
(see Projects and Frameworks [page 47]).

12
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The New Model dialog is highly configurable, and your administrator may hide options that are not relevant for
your work or provide templates or predefined models to guide you through model creation. When you open the
dialog, one or more of the following buttons will be available on the left hand side:

e (Categories - which provides a set of predefined models and diagrams sorted in a configurable category
structure.

® Model types - which provides the classic list of PowerDesigner model types and diagrams.

e Template files - which provides a set of model templates sorted by model type.

%5 New Model
Categon: Categony jtems:
= rK Buginess
£ rK | Hfarmation ?ﬁj
Categories rﬂ Application L = ==
= Conceptual Data [rata Flove Diagram [ ata Movement Logical Data
; Technology W adel
E rK Requirements and Flanning 3 - :
Model tppes i &
Phwzical Data UL Clags Diagram MultiDimengional
j Data
Templates
A&, phyzical data model [POM) helpz wou to analyze the tables, views, and other ohjects in a database, including multidimensional ;I
objects neceszzany for data warehouszing, A PDM iz more concrete than a conceptual [COM) or logical [LODM) data model, v'ou can
model, reverse-engineer, and generate for all the most popular DEMSs. ;I
t odel name: IDeveIopment FLO
DEMS: ISybase A5 Enterprize 15.5 j
Extensions: | j
Ok I Cancel | Help |
Procedure

1. Select|p File » New Model 3 to open the New Model dialog.
2. Click a button, and then select a category or model type ( as appropriate ) in the left-hand pane.
For a list of PowerDesigner model types, see PowerDesigner Models [page 10].

3. Select anitem in the right-hand pane. Depending on how your New Model dialog is configured, these items
may be first diagrams or templates on which to base the creation of your model.
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Use the Views tool on the upper right hand side of the dialog to control the display of the items.

Enter a model name. The code of the model, which is used for script or code generation, is derived from this
name using the model naming conventions.

[BPM, PDM, OOM, and XSM] Select a target resource file , which customizes PowerDesigner's default
modifying environment with target-specific properties, objects, and generation templates.

By default, PowerDesigner creates a link in the model to the specified file. To copy the contents of the resource
and save it in your model file, click the Embed Resource in Model button to the right of this field. Embedding a
file in this way enables you to make changes specific to your model without affecting any other models that
reference the shared resource.

6. [optional] Click the Select Extensions button and attach one or more extensions to your model.

Click OK to create and open the model .

1 Note

Sample models are available in the Example Directory.

Results

1 Note

For information about creating new models in the PowerDesigner Eclipse plugin, see Creating a Model in Eclipse
[page 414].

1.1.3.1 Attaching Extensions At Model Creation Time

The Select Extensions dialog allows you to attach extensions to your model at creation time. Extensions may
contain additional types of objects or extensions to standard objects, along with additional generation targets and
other extensions to PowerDesigner's standard capabilities.

Procedure

1

Click the Select Extensions tool in the New Model dialog.

2. Review the different sorts of extensions available by clicking the sub-tabs and select one or more to attach to

your model.

By default, PowerDesigner creates a link in the model to the specified file. To copy the contents of the
extension file and save it in your model file, click the Embed Resource in Model button in the toolbar.
Embedding a file in this way enables you to make changes specific to your model without affecting any other
models that reference the shared resource.

3. Click OK to close the dialog and return to the New Model dialog.

14
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1 Note

You can attach extensions to your model after creation by selecting [ Model  Extensions 3 and clicking
the Attach an Extension tool.

1.1.3.2 Model Templates

A model template is a shell model that can set model options and display preferences and contain extensions and
objects to initialize new models. Model templates are stored in the model templates directory, which is, by default,
in your Documents folder.

Context

You can make any model available as a model template by saving it to the model templates directory. Alternatively,

you can manage your model templates from the New Model dialog by selecting [|r File » New Model 3 and clicking
the Templates button).

1 Note

The New Model dialog is highly customizable. If the Enable model template files option is deselected or if no
valid template directory is selected then the Templates button will not be available (see Model Creation Options
[page 442]).

The New Model dialog lists the model templates that are available, sorted by model type, and provides the
following tools:

Tool Description
|| Copy Model as Model Template — allows you to select one or more models as model templates, and copies them
o to the model templates folder.
|E| Change Model Templates Folder — allows you to select a folder for use as the model templates folder.
1 Note

You can make model templates available to other users by checking them into the repository Library/
Resources/Model Templates folder (see Sharing Model, Report, and Project Templates and Conversion
Tables via the Library [page 589]).
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1.1.4 Accessing the Repository

You can access the repository directly, via the repository proxy, or through a web browser (via the PowerDesigner
Portal). Your administrator will tell you which methods are available to you.

The following diagram shows the various ways that users can connect to the repository:

® Proxy Access [if the repository proxy is installed] - see Setting up PowerDesigner for Access Via the Proxy
[page 19]

® Direct Access — see Setting up PowerDesigner for Direct Access [page 17]

e \Web Browser [if the PowerDesigner Portal is installed] — see The PowerDesigner Portal [page 295]

PowerDesigner Client PowerDesigner Client Web Browser
{Proxy Access) (Direct Access)
1 Note

Before you can access the repository, an administrator must install and configure it and provide you with a user
name and password. For information about installing the repository, see Installation Guide .
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1141  Setting up PowerDesigner for Direct Access

To create a direct repository definition, you must have a login name and password for the repository AND a user
name and password for the database where it is stored. You may also need to install a database client or driver in
order to connect to the repository database. Your repository administrator will supply you with this information.

Context

If your administrator has installed the repository proxy, see Setting up PowerDesigner for Access Via the Proxy
[page 19].

1 Note

For information about installing the repository and making the first connection to it as an administrator, see the
Installation Guide .

Procedure

1. Select|r Repository » Repository Definitions 3 to open the List of Repository Definitions.

2. Click the Add a Row tool and type a name in the Repository Name column to identify the definition for future
use.

3. Type your user name in the Repository User column. If you are an administrator and are creating the first
repository definition that will be used to initialize the repository (see Controlling Repository Access [page
550]), you must use the ADMIN repository user name.

4. Press F4 or click the Ellipsis button in the Data Source Name column to open the Select a Data Source dialog:

P o

B | Select a Data Source @

Data zource
(71 ODEC machine data source:

(71 ODEC file data source:

- [ElEl

kdodify. .. ] [ LConfigure. .. ]

[ ok ][ Cancel ][ Help

5. Select one of the following options:
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o ODBC machine data source
o ODBC file data source
o Connection profile (for JDBC connections)

Use the tools to the right of the data source field to browse to a new connection profile file or directory, and the
Modify and Configure buttons to change your existing data source connection.

For detailed information about creating, configuring, and using connection profiles, see Configuring

Connection Profiles [page 28].

6. Select a data source and click OK to return to the List of Repository Definitions, where it will be displayed in the

Data Source Name column.

7. Click Apply to apply your changes, and then click the Properties tool to open the Direct Repository Definition

dialog:

P

Direct Repository Definition
Repositony

Bepozitory name: Repositony

[ atabaze

Data source name: PD-Repositary (SGL Anywhere 12)

IJzer name: dba
Pazgwiord: I
Bytes per char: [ 1-byte A ]

-

=]

o] Comea ] |

Help

This window has two group boxes:

o Repository — specifies the name of the repository definition.

o Database — specifies the name of the data source that hosts the repository database, and the user name
and password that you will use to connect to it. The user name and password are optional, but if you do
not specify them here you will need to enter them each time you connect to the repository.

For non-Oracle unicode or multi-byte character set databases, you should also specify the bytes per

character used by the database:
o 1-byte - For SBCS (Single-Byte Character Set)

o 2-byte - [default] For DBCS (Double-Byte Character Set)
o 3-byte - For Unicode or MBCS (Multi-Byte Character Set)

8. Test the definition by clicking the Test button. A message box will state whether your connection succeeds or

fails.

9. Click OK to return to the List of Repository Definitions.

18 PUBLIC
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1.1.4.2 Setting up PowerDesigner for Access Via the Proxy

To create a proxy repository definition, you must have a login name and password for the repository and know the
server on which the proxy is installed. Your repository administrator will supply you with this information.

Context

If you are connecting directly, see Setting up PowerDesigner for Direct Access [page 17].

Procedure

1. Select | Repository # Repository Definitions 3 to open the List of Repository Definitions.

2. Click the Add a Row tool and type a name in the Repository Name column to identify the definition for future
use.

3. Type your user name in the Repository User column, and select Proxy in the Connection Type column (you may
need to widen the window to see this column).

4. Click Apply to apply your changes, and then click the Properties tool to open the Proxy Repository Definition

window:
- 5
Proxy Repository Definition ﬁ
Feposzitony
Bepository name; Repositorny
Prowy
Server name: RepositonyMain
Port number: 32999
Instance name: reposito -
[ k. ] [ Cancel ] [ Help
b

This window has two group boxes:
o Repository — specifies the name of the repository definition.
o Proxy — specifies the name of the server where the repository proxy is installed, the port number, and the
name of the repository instance that you will connect to.

5. Test the definition by clicking the Test button. A message box will state whether your connection succeeds or
fails.
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6. Click OK to return to the List of Repository Definitions.

1.14.3 Connecting to a Repository

Before you can connect to a repository, an administrator must install and configure it and provide you with a user
name and password, and you must have created a repository definition.

Context

For information about creating a repository definition, see Accessing the Repository [page 16].

Procedure

1. Select | Repository # Connect 3 (or double-click the root in the Browser Repository tab) to open the Connect
dialog.

P o)

Connect @
Repository connection
3—] Bepozitary name: [F{epusjmw v]ﬁ
Login name: ADMIN
Pazzword:
k. ] [ Cancel ] [ Help ] [ Setup...

2. Select arepository to connect to and enter your login name and password. To review the repository definition,
click the Properties tool.

3. Click OK to connect.

The contents of the repository are displayed in the Repository tab of the Browser. The root node displays the
name of the repository and your login.

If any of the local copies of Library files (see The Library [page 43]) are not up to date, the Library
Synchronization dialog will open to invite you to update them:
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Select library documents bo update in vour local warkzpace libran.

Diocuments that are dimmed are up to date on your machineg and will

be added to pour work.zpace librane if they are not already prezent.

Library documents

By Oy Bt S

MName Status Repository Location

Global Business Rules Mew document /£ Library

_-_E| Project Guidelines pdf MNew documert /. Librany

&l Data Dictionary Up to date £ Library

1 | el i b
[V:Remember selectior IJpdate local workzpace

Do not show this dialog nest time

I 0k, I[ Cancel H Help

4. Select documents to update in your local library folder, and set options as appropriate:

Option Description

Remember selection Specifies to retain the same selection for updating next time you connect to the repository.

Update local workspace Specifies to update the files displayed in the Library folder in the local workspace. Dese-
lecting this option allows you to display only the subset of library files that you commonly
use in the Library folder (or to hide the folder altogether), while keeping a wider selec-
tion of library files on your client machine up-to-date.

Do not show this dialog next | Specifies to have the library update silently from now on without displaying this dialog.
time

1 Note

You can display the Library Synchronization dialog and change your settings at any time by selecting
| Repository ¥ Synchronize Library 4.

5. Click OK to perform any requested updates and begin modeling.

To review the information stored for your repository user account, select | Repository » User Account 3.

Core Features Guide
Modeling with PowerDesigner PUBLIC 21



To disconnect from the repository, select | Repository  Disconnect 3 (or right-click the root in the Browser
Repository tab and select Disconnect).

1.1.4.3.1 Connecting Automatically to the Default Repository
You can specify that you want to connect automatically to a repository each time you open PowerDesigner. On

opening PowerDesigner will prompt for your password to the repository to which you were last connected.

Procedure

1. Select | Tools » General Options 3 to open the General Options dialog and click the Repository category.
2. Select Auto-connect in the Connection group box, and then click OK.

For information about the other options on this tab, see Repository Options [page 437].

1.1.4.3.2 Changing Your Repository Password

You can change the password that you use to connect to the repository at any time. You may be required to change
your password if it has expired or if the password policy has become more restrictive.

Context

1 Note

In the event that you have forgotten your password or have been blocked for multiple failed logins or inactivity,
you must ask your administrator to reset your password (see Unblocking Blocked Users [page 573]).

Procedure

1. Select | Repository » Change Password Jto open the Change Password dialog.

The dialog lists the rules of the repository password policy that all passwords must respect (see Defining a
Password Policy [page 559]).

2. Enter your old password, and then enter your new password twice.
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P o)

Change Password @

Fleaze enter a new password. To comply with the repoziton
pazzwiord policy, your new pazswaord must;

* Contain betwesn B and 20 characters

* Contain uppercaze letters

* Contain lowercasze letters

* Contain nurbers

* Mok contain vour login name

L L Y

* Be different from your lagt 5 passwords

Current user

Login name: Jennifer Brady

0ld paszword: Il

Hew paszword: TIIIIIL

Confirm pazgword:. sesssssss

MHew pazzwaord must comply with the policy.

MHew and confirmed pazswords must be identical.

0k, ][ Cancel H Help

When your new password conforms to all the policy rules and the values entered in the New password and
Confirm password fields are identical, the OK button becomes available.

3. Click OK to complete the change and return to the repository.

1.1.5 Connecting to a Database

PowerDesigner allows you to define data connections to access information in different database management
systems (DBMSs) using Structured Query Language (SQL).

A data connection processes function calls and SQL requests coming from PowerDesigner and sends them to a
data source, and returns results to PowerDesigner.

The PowerDesigner physical data model (see Data Architecture ) and data movement model (see Data Movement
Architecture ) allow you to define data connections for target databases in order to generate your models and
reverse engineer your data sources, while the repository (see The Repository [page 242]) requires a database to
store your models and other design documents.

PowerDesigner supports the following forms of connection:
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You have... Configure a connection of type...

ODBC driver ODBC machine or file data source (see Configuring ODBC Machine and File Data Sources
[page 25]).

JDBC driver JDBC connection profile (see Configuring Connection Profiles [page 28]).

To configure your database connections, select | Database » Configure Connections 3

m

| ODBC Machine Data Sources | ODBC File Data Sources | Connection Profiles |

F AEX E DE DD

File Mame Connection ... DBMS
C:A\Profiles\ASE - JOBC dep JDBC SAP Adaptive Server Enterprise
C:\Profileg'Oracle - Native dop Mative Oracle 11g

1 Note

In order to create a data source on a Windows 7 machine, you may need to launch PowerDesigner or the ODBC
Data Source Administrator by right-clicking its icon or menu item and selecting Run as administrator.

The following tools are available on each of the tabs:
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Tool Description

|§| Properties — Opens the ODBC Setup or Connection Profile Definition dialog for the selected profile.

|_L:l| Add Data Source — Creates a new connection.

|E| Browse Data Source File [ODBC file data sources and connection profiles] — Opens a file browser to select a .dcp
o profile file.

|Y| Delete — Deletes the selected connection.

| li | Test Connection — Tests the selected connection.

| ODBC Administrator [ODBC machine and file data sources] — Opens the ODBC Data Sources Administrator win-
T dow.

|E| Change Connection Profiles Directory [Connection profiles] — Opens a file browser in which to search for profiles.
o The default directory is <install dir>/Connection Profiles.

|| Refresh — Refreshes the list of connections.

|| Select All - Selects all the connections in the list. Connections that are selected will be displayed in lists in the
T PowerDesigner interface.

|| Unselect All - Unselects all the connections in the list. Connections that are not selected will not be displayed in
T lists in the PowerDesigner interface.

1.1.5.1 Configuring ODBC Machine and File Data Sources

Before you can connect to a database through ODBC, you must create an appropriate ODBC data source. You
define data sources using the Windows ODBC Administrator, which you can access directly from PowerDesigner.

Procedure

1. Select |l Database » Configure Connections 4 to open the Configure Data Connections window, and click the
ODBC Machine Data Source or ODBC File Data Sources tab:

Data source Description

Machine The data source is created on the client machine (stored in the current user settings in the regis-
try), and is only available to the user currently logged onto the system.
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Data source Description

System The data source is created on the client machine (stored in the machine settings in the registry),
and is available to all users of the machine.

File The data source is stored as a file with the extension .dsn, which can be used by users if it is

placed in the default location for file data sources. File data sources are usually managed by data-
base administrators.

1 Note

In order to create a data source on a Windows 7 machine, you may need to launch PowerDesigner or the
ODBC Data Source Administrator by right-clicking its icon or menu item and selecting Run as administrator.

2. Click the Add Data Source tool to open the Create New Data Source dialog, select a File, User, or Machine data
source as appropriate and click Next.

3. Select the appropriate driver for your DBMS and click Next and then Finish to access a driver-specific
configuration dialog:
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QODBC Configuration for 5QL Anywhere

ODBC | Login | Metwork | Advanced

Diata source name: Repository

Description:
Izolation level:

[ Delphi applications

[ Suppress fetch wamings

Describe Cursor Behavior

) Never

[ Microsoft applications (Keys in SGLStatistics)

[| Prevent driver not capable emors

[ Delay AutoCommit until statement close

@ K required

() Always

| Test Connection |

OK

|| Cancel || Help

4. Enter your DBMS parameters, then click OK to close the profile definition, and return to the Configure Data

Connections window, and click OK again to return to your model.
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1.1.5.2 Configuring Connection Profiles

Before you can connect to a database through a JDBC driver, you must create an appropriate connection profile.

Procedure

1. Select | Database ¥ Configure Connections 4 to open the Configure Data Connections window, and click the
Connection Profiles tab.

2. Click the Add Data Source tool to open the Connection Profile Definition dialog, and enter the following

properties:

Property Description

Connection profile name Specifies the name of the connection profile.

Directory Specifies the directory in which the .dcp connection file will be created. By default .dcp files
are stored in the Connection Profiles directory directly beneath the PowerDesigner installa-
tion directory.

Description Optional additional description of the connection profile.

Connection type Specifies the type of connection profile. JDBC is supported.

DBMS type Specifies the DBMS to which the connection profile will connect. The list includes only
those DBMSs supported for JDBC.

Server name [not used]

Database name [not used]

Service [not used]

User name Specifies the username to use when connecting.

Password Specifies the password to use when connecting.

JDBC driver class Specifies the driver class to use for the connection.

JDBC connection URL Specifies the connection URL to use for the connection.

JDBC driver jar files Specifies the driver jar file to use for the connection.
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Property

Connection parameters

Description

[read-only] Lists advanced connection parameters. Click the parenthesis tool to the right of
this field to add parameters.

In the Connection Parameters dialog, click the Add a Row tool to create a new parameter
and enter a name and value pair in the two columns.

To connect to a HANA server over SSL, you must use the encrypt=true connection op-
tion and may need also to use the validateCertificate=true and
hostNameInCertificate=<fullyQualifiedHostName> options. For morein-
formation about these and other HANA connection properties, see JDBC Connection Prop-
erties in the SAP HANA Client Interface Programming Reference.

In this example, | have installed the SAP® Adaptive Server® Enterprise JDBC driver:

Directory:
Description:
Connection type:
DBMS type:

Server name:
Database name:

Liser name:

IDBC driver dass:
JDBEC connection LEL:

IDBC driver jar files:

# | Connection Profile Definition =

Connection profile name:  ASE - JDBC dep

Connection parameters:  Driver='com sybase jdbc3 jdbe.SybDriver', URL=]jdbc sybase: Tds:F E]

C\Profiles)|

|JDBC -
| SAP Adaptive Server Enterprise -
| |
| |
grahiam

com sybase jdbc 3 jdbe. SybDriver .
idbi:sybase: Tds:Rainbow:5000,Green -
iconnd jar - |[E

Test Connection...

ok J[ cancel |[ ke |
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3. Click the Test Connection button to open the Test Connection window, enter the necessary password, and click
OK to test your connection.

4. Click OK to close the profile definition, and return to the Configure Data Connections window, and click OK
again to return to your model.

1.1.5.3 Connecting to a Data Source

When you connect to your database, PowerDesigner can communicate with it for reverse-engineering, generation
or any other form of request.

Procedure

1. Select|» Database » Connect . to open the Connect to a Data Source window:

P "

5| Connect to a Data Source @

Data zource
J (") DDBC machine data zource:
(") DDBC file data source:

i@ Caonnection prafile:

ASA 12.dep - J ﬂ

b dify. .. ] [ Configure. ..

Lagin
User 1D: ADMIMN

Pazsword:

LConnect ][ Cancel H Help

2. Select one of the following radio buttons, depending on your chosen method for connecting to your data
source:

o ODBC machine data source (see Configuring ODBC Machine and File Data Sources [page 25])

o ODBC file data source (see Configuring ODBC Machine and File Data Sources [page 25]) - use the tool to
the right of the data source field to browse to a new file

o Connection profile (see Configuring Connection Profiles [page 28]) - use the tools to the right of the data
source field to browse to a new directory or file

You can use the Modify and Configure buttons to modify or configure the selected connection.

Core Features Guide
30 PUBLIC Modeling with PowerDesigner



3. Enter your user ID and password, and then click Connect. If prompted by your data source, you may need to
enter additional connection parameters.

1 Note

You stay connected until you disconnect or terminate the shell session.

1.1.5.4 Running SQL Queries Against Your Database

You can query your PDM database by selecting | Database » Execute SQL 3. Administrators can query the
repository database by selecting |» Repository » Administration » Execute SQL .

In addition to the standard tools (see Text Editor Tools [page 225]), the following tools are available in this dialog:

Tool Description

Run (). Executes the current script

]

[n/a] Insert Bookmark ( + ) - inserts a blue bookmark box at the cursor position. Press Ctri+F2 to delete
the bookmark.

[n/a] Go to Next Bookmark ()

[n/a] Go to Previous Bookmark ( + )

1.1.6 Managing Your PowerDesigner License

You must select a license when installing PowerDesigner. If you subsequently need to change your type of license
or the package of modules you use, then you should use the License Management wizard. If you use a served
license and will be out of contact with the license server, you should request a temporary mobile license.

Context

You may need to access the License Management wizard when:

e Moving from a trial license to a regular license - You may need to rerun the setup program before launching the
wizard if you need to install additional modules.

e Extending a trial license — After having requested your extension (which will be in the form of a time-limited
unserved license) from SAP.

e (Obtaining a trial of a new package — You must rerun the setup to install the additional modules before
launching the wizard.
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Moving from an unserved to a served license — You must be able to connect to the license server to make this
change.

Procedure

1. Select|}» Tools » License Parameters i to open the wizard.

32

1 Note

If you have taken a mobile license, you will be prompted to return it before accessing the wizard. If you are
using a served license and the server cannot be contacted, an error message will be displayed and you will
not be able to access the wizard.

License Management Wizard @

-

Welcome to the License Management wizard. This wizard allows you to activate your
license or to change the way in which your license is provided.

Your organization may have purchased PowerDesigner licenses in the form of Named User
Licenses (assigned to a single named user) and Concurrent User Licenses (available to any
user),

Both types of license can either be served (deployed to a central license server) or
unserved (deployved to your dient machine).

Select the type of license you want to use:

i) Served

The license is requested fram the license server when PowerDesigner is opened and
is returned when PowerDesigner is dosed.
You must provide the name and port of the license server,

(71 Unserved
The license is lodked to your dient machine, Yaou must provide a valid license key.

@ Standalone Seat - Served (legacy)

This option is available only for dients who purchased this type of license for vw16.5
SPO3 or earlier,

] [ Help

e

Select a type of license and then click Next. The following types of license are available:

o Served - Specify the name of the license server (and, if your administrator has specified one, a port
number), and click Next.
The license is requested from the SySAM license server when PowerDesigner is opened, and is returned
when PowerDesigner is closed, or after 3 hours of inactivity. You must be connected to the license server
in order to obtain a license, and must remain in contact (brief losses of contact only are permitted) in
order to continue using it. When a user begins to work after a period of inactivity, PowerDesigner will
automatically try to obtain a license, and if it is unable to do so, will display a message suggesting that you
save your work.
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1 Note

For periods when you must be out of contact with the server, you can request a mobile license for up to
30 days.

o Unserved - Follow the instructions to load a valid license key and then click Finish to validate your license
and exit the wizard.
The license is locked to your client machine. PowerDesigner reviews the local license file and authorizes
only the use of modules for which a valid license is present. A license server is not needed.

o Standalone Seat - Served (legacy) - This option is available only for clients who purchased this type of
license for v16.5 SPO3 or earlier.

3. Specify the PowerDesigner package that you want to use, and then click Finish to validate your license and exit
the wizard.

1 Note

The list displays all the packages that are available on the server but does not necessarily mean that a
license for a particular package is available. If no license is available for the selected package, you must
select an alternate package or click Cancel to restore your previous license configuration.

o Ifyou arein trial mode, a license agreement dialog box is displayed.

If you have selected an unserved license, the license file information is added to the license folder as a new

license file.

o If you have selected a served license, a new license file is created to store the server name and port
number.

o If you have selected a different package, the new modules will be available the next time you start
PowerDesigner.

[}

1.16.1 Obtaining a Mobile License

When you are using a served license and anticipate being out of contact with the license server, you can borrow a
mobile license to allow you to continue using PowerDesigner for up to 30 days.

Procedure

1. Select|p Tools » Take Mobile License 3.

A confirmation dialog box is displayed.
2. Click Yes to obtain a mobile license and click OK to confirm.
Once you have obtained a mobile license, the 30 day limit is renewed automatically each time you connect to

the license server. If you do not contact the server for 30 days, the mobile license is returned to the pool and
you will not be able to use PowerDesigner until you reconnect.
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1 Note

When you no longer need the mobile license you should return it to the server to make your license seat

available to the general license pool. To do so, select [ Tools » Return Mobile License 3.

1.1.6.2 Troubleshooting Licensing Problems

In rare cases, PowerDesigner may repeatedly fail to obtain authorization from an unserved license file or the
license server. If this happens, you can troubleshoot as follows:

Procedure

1. Exit PowerDesigner and navigate to the following directory:

C:\Documents and Settings\All Users\Application Data\PowerDesigner <x>

2. Move any file with the .lic extension this folder to a safe place.

3. Make a backup copy of the file sysam.properties, and open it in a text editor. Remove the lines starting
"Pd.LicenseMode" and "Pd.Package" at the end of the file and save the file.

4. Restart PowerDesigner.

You will be prompted to open the License Management Wizard (see Managing Your PowerDesigner License
[page 31]). Re-load your unserved license key or select the appropriate served license type.

1.1.7 PowerDesigner Documentation

Full documentation is provided as context-sensitive help by pressing F1 and as PDFs by selecting | Help » Online

Documentation 3.
The following manuals are provided with your PowerDesigner installation:

e New Features Summary

® Quick Reference

® |nstallation Guide

e Core Features Guide

® Requirements Management

e [Enterprise Architecture

e [xploring the EA Example Model
® Business Process Architecture

e Data Architecture

e Data Architecture for SAP HANA
e Data Movement Architecture
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e (Object-Oriented Architecture

e XML Architecture

e (Customizing and Extending PowerDesigner
e PowerDesigner Web

This documentation is also available for consultation or download from https://help.sap.com/viewer/p/
SAP_POWERDESIGNER.

Demonstration videos are also available. They can be installed with PowerDesigner (select | Help ¥ Tutorial
Videos 1) or viewed from the installation CD).

For documentation of the PowerDesigner metamodel, click [» Help » Metamodel Objects Help 3 (or click the Find
in MetaModel Objects Help button at the bottom-right of the Version Info tab of the property sheet of any object).

1.1.8 SAP Platform Support

PowerDesigner provides support for various components in the SAP platform.

SAP HANA

PowerDesigner supports round-trip reverse-engineering and generation of HANA tables and other catalog objects
directly or via CDS entities for SAP HANA® 1.0 and 2.0 databases. In addition, for SAP HANA® 1.0 environments,
PowerDesigner supports initializing and reverse-engineering graphical calculation views (including the XML
definition and projection list) for inclusion in impact analysis.

For detailed documentation, see Data Architecture > DBMS Definition Reference > SAP HANA .

SAP HANA Core Data Services (CDS)

PowerDesigner supports modeling and generation of CDS artifacts to SAP HANA® 1.0 Classic Repository and SAP
HANA® 1.0 and 2.0 HDI environments.

For detailed documentation, see Data Architecture > DBMS Definition Reference > SAP HANA .

SAP Business Suite

An SAP Business Suite installation is built on a complex database structure, which comprises many thousand
tables with often cryptic names, and may include large numbers of customizations. In certain environments, there
may be multiple servers, each with different customizations. PowerDesigner allows you to browse the application
component and package hierarchy and to import them and their supporting logical objects for analysis,
comparison, and merging of data dictionaries, and can also help you prepare a HANA table structure to allow
consolidated reporting on one or more SAP® Business Suite installations.
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PowerDesigner supports importing any recent version of SAP® Business Suite.

For detailed documentation, see Data Architecture > DBMS Definition Reference > SAP Business Suite .

SAP BusinessObjects

PowerDesigner supports generation of a SAP® BusinessObjects™ universe from your PDM for editing in the
BusinessObjects Universe Design or Information Design tools, or for direct consumption by the Web Intelligence
rich client. Generating a universe from your PDM gives you access to table, view, and column names and
comments and more reliable cardinality information than if you create a universe directly from your database.

To generate universes, you must have SAP® BusinessObjects™ SBOP Bl Platform Clients 4.0 SP04 Patch 3
(v14.0.4.819) or higher installed on your workstation. On Windows Vista or Windows 7 machines, if PowerDesigner
fails to recognize a valid BusinessObjects installation, it may be necessary separately to launch the Universe
Design tool one time with administrator privileges to enable the BusinessObjects SDK.

For detailed documentation, see Data Architecture > Building Data Models > Generating and Reverse-Engineering
Databases > Generating an SAP BusinessObjects Universe .

SAP Solution Manager

PowerDesigner supports round-trip importing and exporting of SAP® Solution Manager v7.1 SPO7 to SP13 projects
through the desktop client. You can import SAP® Solution Manager v7.2 process diagrams via the PowerDesigner
Web client and export changes to those diagrams back to the Solution Manager v7.2 server.

For detailed documentation, see Business Process Architecture > SAP Solution Manager and PowerDesigner Web >
Business Processes > Importing SAP Solution Manager 7.2 Process Diagrams .

SAP NetWeaver

PowerDesigner supports round-trip importing and exporting of SAP BPM v7.3 and higher BPMN 2.0 files.
PowerDesigner Web makes your process models available for browsing and importing directly into the SAP
NetWeaver Developer Studio Process Composer v7.3 EHP1 SP15 or higher.

For detailed documentation, see Business Process Architecture > BPMN 2.0 Descriptive and Executable >
Importing and Exporting BPMNZ Files .

SAP Data Services

PowerDesigner supports round-trip importing and exporting of SAP Data Services v4.2 and higher XML files.

For detailed documentation, see Data Movement Architecture > ETL Modeling > SAP Data Services .
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SAP Information Steward

PowerDesigner can be used as a metadata integrator with SAP Information Steward v 4.2 SPO1 and higher.

For detailed documentation, see the Information Steward documentation at https://help.sap.com/viewer/p/
SAP_INFORMATION_STEWARD.

1.1.9 Next Steps

Now that you are familiar with the PowerDesigner Interface, you will want to start experimenting with a particular
type of model suitable to your needs.

e Requirements Model (RQM) - Now turn to the Requirements Management guide where you will learn how to:
o Add, modify, promote and demote requirements in the requirements hierarchy
o Allocate requirements to particular team members and add traceability links to other model components
o Import requirements from a structured MS Word document
o View traceability and user allocation reports

e Enterprise Architecture Model (EAM) - Now turn to the Enterprise Architecture guide where you will learn how
to:

o Create diagrams in the business, application, and technology layers
o Import Visio diagrams
o Export and Import objects to and from other models

e Business Process Model (BPM) - Now turn to the Business Process Architecture guide where you will learn how
to:

o Create Process Hierarchy, Business Process, Process Service, and Composite Process diagrams
o Manipulate Service Description Objects
o Generate an executable BPM, and implement processes
e Conceptual Data Model (CDM), Logical Data Model (LDM), or Physical Data Model (PDM) - Now turn to the
Data Architecture guide where you will learn how to:
o Create CDM entities and relationships between them
o Create LDM or PDM tables, columns, primary keys, indexes, and references and define referential integrity
o Create PDM views, triggers, and abstract data types
o Create business rules, domains, and data items
o Generate a PDM from your CDM or LDM
o Reverse engineer from and generate to database scripts
o Work with PDM multidimensional diagrams
e Data Movement Model (DMM) - Now turn to the Data Movement Architecture guide where you will learn how
to:

o Define databases, replication processes, event scripts, and other replication objects
o Reverse engineer from and generate to the SAP® Replication Server® replication engine
o Design extract, transform, and load (ETL) operations to move data between databases

e Object-Oriented Model (OOM) - Now turn to the Object-Oriented Architecture guide where you will learn how
to:

o Design class, use case, and other standard UML diagrams

Core Features Guide
Modeling with PowerDesigner PUBLIC 37


https://help.sap.com/viewer/p/SAP_INFORMATION_STEWARD
https://help.sap.com/viewer/p/SAP_INFORMATION_STEWARD

o Generate a PDM with O/R mapping
o CreateanEJB
© Deploy a component
o XML Model (XSM) - Now turn to the XML Architecture guide where you will learn how to:
o Define elements, entities, and other components of an XML schema
o Reverse engineer from and generate to DTD, XSD, and XDR files
o Generate an XSM from a PDM or OOM

1.2 The Browser

The Local tab of the Browser provides a hierarchical view of all the model objects in your workspace. If the Browser
is not visible, select |+ View » Browser 3 (or press + [0] to display it.

To expand all nodes, press the numpad plus sign (). To collapse all nodes, press the numpad minus sign (El). To
filter the Browser tree, start typing the name of an object that you want to find in the Filter box:

Eitter:

%[ 2]

Filter:

aCCo

(%[ 2]

Ej Workspace

EEI"':"'E:I Library

G- High-Level Anchitecture
[]E HR Data Warehouse *
E—:l"ﬁ Primary Company Site ™

e

o

Relationships
o Person == Account

=-*%3 Physical Data
-] Communication between ser E--3 Tables
-] Technical infrastructurs =
Important business functions

Ll

L
1
g

PowerDesigner monitors your local documents against the versions stored in the repository, and communicates
their status using icons to the left of the document icons:

Locked by You (Green Pad-

Locked by Other (Red Pad-

Up to Date (Green Circle)

lock)

lock)

Local Changes (Red Checkmark)

tion)

Changes on Server (Yellow Exclama-
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No Locks Locked by You (Green Pad- Locked by Other (Red Pad-
lock) lock)
Local and Server Changes g 5 E
1 Note

When a model file is closed (as all are when you open PowerDesigner) its icon bears a red dot in its bottom-left
corner. To open a closed model, double-click it or right-click it and select Open or Open as Read-only. To close
an open model to free up memory, right-click it and select Close.

You can control the display of status icons with the Display status icons in Local Browser general option (see
Repository Options [page 437]).

A typical hierarchy of objects in the Browser Local tab may include:

e \Workspace - The root of every Browser tree, which contains and organizes all your models and supporting
documents (see Workspaces [page 45]).

e Library - A folder containing enterprise models that are pushed automatically to all users when they connect
to the repository (see The Library [page 43]).

® Projects — Act as containers for models and other documents, allowing you to save them as a single unit in the
repository (see Projects and Frameworks [page 47]).

e Folders - Organize models and other files (see Folders [page 46]).

e Models - Are the basic design unit in PowerDesigner and contain one or more diagrams and any number of
model objects (see Models [page 46]).

® Packages - Divide large models into smaller "sub-models" to avoid manipulating large sets of objects, and can
be used to assign different tasks or subject areas to different development teams (see Packages [page 1441]).

e Diagrams - Graphical views of model objects (see Diagrams [page 185]).
e Model objects — Include all items belonging to a model (see Objects [page 93]).
® Reports - Are generated to document your models (see Reports [page 3247).

You can create objects from the Browser (see Creating Objects from the Browser [page 95]) and drag, drop, and
copy objects in the Browser, or between the Browser and the Canvas (see Moving and Copying Objects [page
103]).

To find the Browser entry for a diagram symbol, right-click it and select |» Edit #» Find in Browser 3. To find the
diagram symbol for a Browser entry, right-click it and select |» Edit ¥ Find in Diagram 3.

1.2.1 The Glossary

In environments with a repository, administrators can deploy an enterprise glossary to help everyone to use the
same approved terms between projects for enterprise-wide consistency. Updates to the glossary are pushed to
users each time they connect to the repository or on demand. The glossary appears in the Browser Glossary tab.

The glossary can contain the following objects:

e Terms - are words or phrases that are approved for use in naming model objects. When you enable the
glossary for your model, glossary terms are proposed as you enter object names.
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e Synonyms - are words or phrases that are not approved for use in naming objects, and which are associated
with the terms that should be used instead. The approved terms are proposed when you begin entering a
synonym as an object name.

e Categories - to organize your terms. Each term can only appear in a single category.

e Glossary terms lists (see Glossary Terms Lists [page 583]), dependency matrices (see Dependency Matrices
[page 198]), and reports (see Reports [page 324]) - to present glossary terms in various ways.
e Business Rules - see Business Rules [page 139].

Use the Glossary browser tab to review the approved terms, and double-click a term or synonym to open its
property sheet, to view supporting information or references. Start typing the word you want to find in the Filter
box at the top of the Browser to filter the glossary in real time:

Fitter: @ Fiter: ab @

ED Glossany Root - ED Glossary Root

=-¥[ 1§ Glossary * [l =¥ Glossary *
..... & abstract - object
..... ) abstract data type --{#4 object allocation map [OAM)
----- &3 abstraction ~-{#4 object identifier (01D)
..... &3 actor --{#4 object queue 1D (DQID)
..... &5 actors 3 --{#4 object request broker (ORE)
..... 3 actual parameter -4 problem domain

1 Note

You can only edit the glossary if you have Write permission on the glossary model (see Deploying an Enterprise

Glossary [page 577]).

Select | Tools » General Options 3 and select the Glossary category to control the appearance of the Glossary tab
with the following options:

Option ‘ Description

Show glossary tab

Shows the Browser Glossary tab.

Display

Controls whether names or codes appear in the Browser Glossary tab.
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1.2.11 Using Glossary Terms in Your Models

Enabling the glossary in your model provides autocompletion for object names (including guidance to discourage
the use of synonyms) and enables model checks to guide your models toward glossary compliance.

Procedure

1. Select | Tools » Model Options 3, then click Naming Convention in the category list and select Use glossary
for autocompletion and compliance checking to enable the use of the glossary in your model.
2. When entering the names of objects in property sheets, diagram symbols, object lists, or in the Browser,

glossary terms are suggested to autocomplete the name. Continue typing or use the down arrow to descend
to aterminthe list, and press Enter to select it.

F-

] Entity Properties - Entity_1 (ENTITY_1) =
| Dependencies I Traceability Links I Wersion Info
General | Attributes I |dentifiers I Mapping I Motes I Rules | Related Diagrams
Mame: Cus| E]
Code: Custom - E
Cliert{Prefemed term for Customer) —
Commeri: Customer Authorization String ICAS) >
€| T b
Stereotype: -
MNumber: Generate
Parent ertity: <Mone: E
Keywords:
) el e G

If you click the object's Dependencies tab, the link to the chosen term is listed there:
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General Aftibutes |  Identifies |  Mapping | Netes |  Rules
Related Diagrams | Dependencies | TraceabiltyLinks | Version Info
&G | Impact and Lineage Analysis
Mame Code
3 Client Client

4]+ [ Diagrams } Terms f

[ussless ) B - Lok J[ Cocel | oy [[ Heb

3. [optional] Perform a model check to see which objects have names containing terms that are not included in
the glossary (see Checking Glossary Compliance [page 155]).

1.2.1.2

Term Properties

To view a term's properties, double-click its Browser entry. The property sheet tabs and fields listed here are those
available by default, before any customization of the interface by you or an administrator.

The General tab contains the following properties:

Property Description

Name/Code

Identify the object. The name should clearly convey the object's purpose to non-technical users,
while the code, which is used for generating code or scripts, may be abbreviated, and should not nor-
mally include spaces. By default the code is generated from the name by applying the naming con-
ventions specified in the model options. To decouple name-code synchronization, click to release the
= button to the right of the Code field.

Description

Provides an explanation for the definition of the term. For information about using the RTF editing
tools, see Text Editor Tools [page 225].
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|
Property ’ Description

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereo-
types to the list by specifying them in an extension file.

Reference URL Specifies a site, which provides more information about the term.

The following tabs are also available:

e Synonyms - Specifies the synonyms of the term, which are not approved for use. The Parent property of a
synonym specifies the term with which the synonym shares a meaning, and which should be used instead of
the synonym.

® Related Terms - Specifies other terms associated with the term.

1 Note

Only an administrator or other user with Write permission on the glossary can edit terms (see Creating Terms,
Synonyms, and Related Terms [page 5777).

1.2.2 The Library

In environments with a repository, administrators can deploy an enterprise library containing reference models,
model templates, resource files, and other documents. Updates to the library are pushed to users each time they
connect to the repository or on demand. Models and other documents appear in a special folder in the Browser
Local tab.

The library appears by default at the top of your workspace as a folder named Library and provides access to
enterprise reference models (such as a data dictionary or a PDM containing standard domains) for reuse in your
projects as shortcuts or replicas, and other reference documents:

Object Browser O X
L
ED Waorkspace
=2 Library

“G] Entemrise Business Rules
- ¥ Data Dictionary

?%2 Entemrise Processes
Jil Maodeling Guidelines pdf
"ﬁ HR Data Warehouse

........ @ Main Diagram

|5 Analysis and design
[a Hequiremems

[a |mp|emen‘tEltiDﬂ

- Data Management

ﬁ Lacal —ﬁ Glossary I E-i H&pﬂsitur}r|

i

[ O e O e Y
[y L Ly )
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You can rename your local library folder, move it in the Browser tree or detach it from your workspace. To reinstate
your Library if you have removed it, select |» Repository ¥ Reinitialize Local Library 3.

The library documents and resource files are automatically updated whenever you connect to the repository (see
Connecting to a Repository [page 20]) and you can control which ones will be pushed to your workspace. You can,
at any time, confirm that you have the very latest version of library documents by selecting |+ Repository
Synchronize Library 3.

Resource files, such as DBMS or language definition files and extensions, are not displayed in the Browser library

folder unless you have permission to modify them, but they appear automatically in the new model dialog,
resource file lists, and anywhere in the interface where a resource file can be selected.

1 Note

By default, library documents are checked out to a subfolder inside My Documents/PowerDesigner
Libraries, controlled by the SHARED named path (see Named Paths [page 4347). You can only check in
changes to library documents if you have write permission on the library folder or on one or more of its children
(see Deploying an Enterprise Library [page 586]).

1.2.2.1 Reusing Library Objects in Your Models

Library models can contain reference objects that are intended for reuse in your models in the form of shortcuts or
replicas.

Procedure

1. Expand the library model in the Browser to show the object that you want to reuse:

Filter: @ IEI

E: Workspace

,_:_,@ Library

ﬁ Erterprise Business Rules
#2. Data Dictionary

-?%2 Enterprise Processes

-------- [Z] Process Hisrarchy

2 Block User

— Change Password
— Create User

- Deactivate User
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2. Right-click on the object in the library model and drag and drop it into your model diagram where you want to
reuse it (or onto a model or package in the Browser).

3. Release the right mouse button, and select one of the following:
o Create Shortcut(s) Here - when you want create a reference to the library object.

o Replicate Here - when you want to create a local copy of the library object and make changes to one or
more of its properties

The shortcut or replica is created in your model, and can be connected to any appropriate locally-created
objects. In this example, a shortcut to the Create User library object is connected to other locally-created
objects:

Create User
{=Enterprise
Processes=)

Initialize User
acation
Allowance

If the library object subsequently changes, any updates will cascade automatically to your model.

1 Note

For detailed information about working with shortcuts and replicas, see Shortcuts and Replicas [page 484].

1.2.3 The Repository Browser

The Repository tab in the Browser displays the content of the repository to which you are currently connected.

For more information, see Browsing the Repository [page 243].

1.2.4 Workspaces

The Local tab of the Browser contains a workspace to organize all your modeling and supporting files. You can
create projects, models, and folders in a workspace. To add external files, drag and drop them from Windows
Explorer.

We recommend that you save your workspace regularly:
e To perform a standard save - select |# File » Save Workspace 3 or right-click the workspace node in the
Browser and select Save. You will be prompted to save any models that contain changes.

e To save the workspace under another name - select || File » Save Workspace As 4 to open a standard Save As
dialog, or right-click the workspace node in the Browser and select Save As. You will be prompted to save any
models that contain changes.

e To save the workspace and all the models it contains - select | File ¥ Save All 3, or click the Save All tool.
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1 Note

Workspace files (* . sws) contain only the structure of the workspace. Deleting the workspace file in Windows
Explorer will not delete any projects, models, or other referenced files.

To create a new workspace, simply close the current workspace by selecting | File » Close Workspace 4. You will
be prompted to save the workspace and any models that contain changes, and a new, empty workspace will open.

You can create multiple workspaces, but only one can be open at a time. To change workspace, select [ File 3

Open Workspace 3. You will be prompted to save the current workspace and any models that contain changes, and
the selected workspace will open. The models contained in the workspace are not open by default.

1.2.5 Folders

You can use folders to organize the projects, models, and other files in your workspace. The folder structure is
saved in the workspace file.

To create a folder, right-click the workspace root or another folder and select |» New » Folder 3, then enter a name
in the highlighted area. Folder names must be unique in the workspace.

To create a project, model, or multi-model report in a folder, select the folder and use the standard tools, or right-
click the folder and select [ New » <New item> 1.

To add an existing project, model, or multi-model report to a folder from another location in the Browser, drag and
drop it onto the folder. You can also drag and drop PowerDesigner and other files from Windows Explorer to the
Browser.

To delete a folder, select it and click the Delete tool or right-click it and select | Edit » Delete .

1 Note

Deleting a folder cannot be undone. When you delete a folder, you remove the models and reports it contains
from the workspace, but you do not delete them.

1.2.6 Models

Models are the basic work unit in PowerDesigner. You can create a model directly in the workspace, in a folder, or
as part of a project.

To create a model, click the New tool or select | File » New Model 3 (see Creating a Model [page 12]). For a list of
available types of models, see PowerDesigner Models [page 10]. For detailed information about a particular type of
model, and for information about creating a model by importing, generating or reverse engineering, see the
appropriate modeling guide.

To add an existing model to the workspace, click the Open tool or select |¢ File » Open 3, browse to the model file,
and click Open. To open the model as read-only, select the Open as read-only check box.
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1 Note

When a model file is closed (as all are when you open PowerDesigner) its icon bears a red dot in its bottom-left
corner. To open a closed model, double-click it or right-click it and select Open or Open as Read-only. To close
an open model to free up memory, right-click it and select Close.

When a model contains unsaved changes, an asterisk is appended to its name in the Browser. When you save a
model or a multi-model report, PowerDesigner assigns it a unique identifying number called GUID (Global Unique
ID, which is used to identify documents in the Repository and during model generation), and creates a backup
copy of your file with the same identifying number:

e To perform a standard save - select ||» File » Save J, click the Save tool, or right-click the model entry in the
Browser and select Save.

e To save the model as a backup version with the same GUID - select |+ File » Save As 3, or right-click the model
node in the Browser and select Save As.

e To save the model as a new model with a new GUID - select ||» File » Save As New Model J, or right-click the
model node in the Browser and select Save As New Model. If you check the new model into the repository, it
must be as a new model without any revision history. Other models with shortcuts pointing to the original
model will continue to be connected to that model.

e To save the workspace and all the model it contains - select [» File » Save All J, or click the Save All tool.

1 Note
The following formats are available when you save a model:

e XML - [default] Larger and somewhat slower to load, but editable in a text editor. Recommended for small
to medium-sized models.

e Binary - Smaller and faster to load, but not editable outside of PowerDesigner. Recommended for large
models.
To change the display name of a model in the Browser, select it and press F2, or right-click it and select Rename.

To delete a model from the workspace, select it and click the Delete tool, press Del, or right-click it and select
Detach From Workspace. The model is removed from the workspace, but the file is not deleted from your disk.

1.3 Projects and Frameworks

A project allows you to group together all the models and other types of documents you need for a particular
modeling task, and save them as a simple entity in your repository.

A project can contain one or more project diagrams (see Project Diagrams [page 51]), which show the
connections between models and other documents:
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Your project can also contain one or more framework diagrams and/or a framework matrix, which direct how your
project must be modeled and list the documents that are needed (see Completing Framework Diagrams and
Matrices [page 58]).

You can create a project from scratch or from a template. PowerDesigner provides a set of predefined project
templates, and you can also create your own (see Project Templates [page 827).

1 Note

Projects and framework diagrams and matrices are only available with Enterprise versions of PowerDesigner.

Core Features Guide
48 PUBLIC Modeling with PowerDesigner



1.3.1 Creating a Project

Every project (.prj) contains at least one diagram, and any number of model or file documents. The project can
also contain one or more framework diagrams, a framework matrix, and one or more dependency matrices.

Procedure

1. Select|» File » New Project ;to open the New Project dialog box.

Mew Project

Project bype hange template directory:

_  Description
E <Empty Project: : i
{57 COMsLDMPDM an Empty Project does nok contain any models or docurments,

; . ‘fou can use it a5 a starting poink For creating wour own sek of
{1 Framewark, Matrix 1R o

: interdependent maodels,
--1_J Syb Project Templates
+-_1 Framework diagram

Mame: IWEI::LiI::rar_I,I

Location: IE:HMyPrniectsH

¥ aAppend name to location

Fuoot directary: IE:HMyPrniectsHWebLibrary'x

] I Cancel Help

2. Select atype of project in the tree. You can choose to create:

©  Anempty project.

o A project based on a template (see Project Templates [page 82]). Click the Change Template Directory
tool to search for templates in another location.

3. Enter a project name and location, and select the Append Name To Location check box if you want to add the
project name to the root directory.

4. Click OK to close the dialog box, and create the project.
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The project opens. You can add models and other documents to your project (see Adding Model and File
Documents to a Project [page 50] and Completing Framework Diagrams and Matrices [page 58]).

1.3.2 Adding Model and File Documents to a Project

You can create models in your project and add existing models and files to it. Project documents are listed in the
Browser and displayed as icons in the project diagram. You can open a model or file by double-clicking its icon in
the diagram or in the Browser.

Creating Models Adding Existing Models and Documents

e Click the New Model tool in the Toolbox, and click in the e Click the Add Project Document tool in the Toolbox, and

diagram to open the New Model dialog (see Creating a click in the diagram to open an Open dialog box. Browse
Model [page 12]). to and select one or more documents and then click
Open.

® Right-click a project or a project folder, select b New »

Model }t the New Model dial e Drag and drop one or more documents from the Browser,
ode o open the New Model dialog.
P g or the Windows Explorer to the project node in the

Browser or to the project diagram.

1 Note

If you drag a folder with sub-folders from Windows Ex-
plorer, the hierarchy is preserved but, since projects
are not synchronized with the file system, any files you
subsequently add to these folders outside
PowerDesigner will not be displayed in the Browser.

The models contained in your project are visible in the Browser, beneath the project node and also in the List of
Models available (when the project has context) by selecting |+ Model » Models 2.

When you add existing documents from other locations to your project, they are listed under the project node in
the Browser, but are not moved to the project directory. Such documents display a shortcut overlay on their

symbols in the Browser and project diagrams to indicate that they are located outside the project folder, and their
entries in the List of Models have the read-only [/]nside Project check box deselected.

In the following example, Object Model is inside the project and Physical Model is outside the project:

B Mapping 0 :

Object Model FPhysical Maodel

In order to profit from the convenience of the project as a container, we recommend that you create (or place) all
its models and files inside the project directory in your file system.

To move a document from outside to inside the project, right-click its Browser entry or its symbol in the project
diagram, and select Move to Project Directory. The file is moved to inside the project directory in your file system,
the shortcut overlay disappears, and the [/]nside Project check box is selected in the List of Models.
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1.3.2.1 Project Diagrams

A project diagram allows you to display project documents and the relationships between them.

You can create one or more project diagrams in an existing project to display different views of your project in any
of the following ways:
e Right-click a project in the Browser, and select | New j» Project Diagram 4.
e Right-click the background of any project diagram, and select |+ Diagram » New Diagram ¥ Project Diagram 3.
e Select|p View j» Diagram » New Diagram j Project Diagram 3.
In the following example, the models and other documents for the WebLibrary project are organized into sub-

folders, and the connections between them (by reference, mapping, and generation) are displayed in the Main
Diagram project diagram:
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The following tools are available in the Toolbox of a project diagram:

Description

Lj New Model — Creates a PowerDesigner model in the project.

Core Features Guide
Modeling with PowerDesigner PUBLIC 51



Tool Description

.;‘;.j Add Project Document — Adds an existing document to the project, which can be:

e A PowerDesigner model (PDM, OOM, LDM etc.).
e An external file (PDF, text file etc.).

N/A Dependency links, such as generation, mapping, reference, and file links, are automatically created between docu-

ments. These links cannot be created, but you may need occasionally to rebuild them (see Rebuilding Dependency
Links [page 54]).

1.3.2.2 Converting a Set of Repository Documents into a
Project

You can retrieve a set of documents checked into the repository and convert them into a project to benefit from
the convenience of the project as a container.

Procedure

In the Repository Browser, create a project root folder to contain the project documents.
[optional] Create project sub-folders to organize documents according to your needs.
Drag and drop repository documents into these folders.

AW

Right-click the project root folder, and select Convert to Project to convert it and all its contents into a project.

Results

In the following example, repository documents in the Examples folder are are transformed into the WebLibrary
Project:
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5 Data Warehouse - v1
Q‘a Duplicated Database - v1

Object Browser v aXx
(3 PD_Repository::ADMIN
{h Librany
EI{EJ Exmples Object Browser 0 X
JE WebLibraryRequirements. doc - v1 = _
-- WehLibrarny Conceptual Data - v1 IIE." PD—H_EWSMW:A'DM'N
[#-4& Data ETL and Replication -1 @ Library
: EI@ Examples

-4 Data ETL and Replication - v1

EIE WebLibrary Project - v1

= Weblibrary Datatabase - v1
-5k WebLibrary Design - v1
-5t WebLibrary Java Implemertation - v1

EI@ Analysis and Design
: ﬁ WeblLibrany Conceptual Data - v1
-k, WebLibrary Design - v1
. @& WebLibrary Data Fow - v1
Elia Data Managemert
l% WeblibranyRequirements .doc - v1

Data Warehouse - v1

= Duplicated Database - v1
% WebLibrary Datatabase - v1

-- WeblLibrary Java Implementation - v1

1.3.2.3 Opening Project Documents

Once you have added a PowerDesigner model to a project, you should only open the model within the context of
the project, as links between it and any other models in the project are managed by the project file. If you attempt
to open the model outside of the project, you will be prompted to cancel the operation, and to open the project
instead.

You can open a project document in the context of its project by double-clicking it in:

® aframework matrix or diagram
® aproject diagram
e the Browser under its parent project

Similarly, models that belong to a project should only be checked in and out of the repository via the project.

1.3.2.4 Viewing Dependency Links

You can explore the details of any of the dependency links in your diagram by right-clicking it and selecting Show
Dependencies.

Context

Each type of link has its own viewer:
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e Generation — displays the generation links between models in the Generation Links Viewer (see The
Generation Links Viewer [page 480]).

® Mapping — displays the mapping links between models in the Mapping Editor (see The Mapping Editor [page
508])).

e Reference — displays the shortcuts and replications between models in the Shortcuts and Replications dialog
box.

In the following example, right-clicking the reference link between Data ETL and Replication and Data Warehouse
models opens the Shortcuts and Replications dialog box which displays Data Warehouse object shortcuts:

! Reference Dt§:|
Fi =
— o [rata MWiarehouse
[rata ETL and Replication

1.3.2.5 Rebuilding Dependency Links

Dependency links are automatically generated in your project diagram when you add documents that are linked to
each other by, for example, generation, mappings, shortcuts, etc.

Context

Rebuilding dependency links can be useful to update:

e Links between closed models you add to your project.
® |inks deleted by error in your diagram.

Procedure

1. Select | Tools » Rebuild Dependency Links 3 to open the Rebuild Dependency Links dialog box.
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Rebuild Dependency Links E2 |

General |

¥ ‘Open clozed models
— Select the kinds of dependency links ta rebuild

¥ Fiebuild fils references

¥ Febuild generation links
v Rebuild mapping links

v Rebuid other dependencies

| k. I Cancel Apply Help

2. [optional] Clear the Open closed models check box to rebuild only those links in a limited number of models.

3. Select the check boxes that correspond to the dependency links you want to rebuild.
4. Click OK to close the dialog box and return to the diagram. Any missing links are updated in the diagram.

1.3.2.6 Project and Framework Display Preferences

PowerDesigner display preferences allow you to customize the format of object symbols, and the information that

is displayed on them.

To set project display preferences, select |[» Tools » Display Preferences 2 (or right-click the diagram background
and select Display Preferences).

1 Note

For information about changing the format of symbols, see Format Display Preferences [page 233]. Note that
only framework architects (see Designing Framework Diagrams and Matrices [page 65]), are allowed to
modify the framework diagram and matrix format display preferences (see Symbol Format Properties [page

213]).
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Display Preferences

Category:

El Content
L Model
-~ File

i e Title
=1- Farmat

- Folder
- Model
- Fila

- Free Symbal

- Dependency Link,

- Dependency Link,

YWindow color: || |j

— Unit
" |nch " Millimeter {* Pingl

[T Snaptogid [ Display Size: I'I1

— Diagram
v Show page delimiter v Constrain Labels

~ Gnid

Default | Set bz Defaultl

Apply To... |

()% I Cancel Help

To set display preferences for a particular object, select it under the Content category. The following table lists the
display preferences available. The objects available to be customized in the Display Preferences window depend
upon the current diagram type.

Preference Description

Code

Displays the code of the object.

Comment

Displays the comment of the object.

Completion status

[node and cell only] Displays a rectangle, which represents the work completion status according to
the percentage entered in node and cell floating lists and property sheets.

Documents [node and cell only] Displays the list of documents in the node or cell, instead of in floating lists.
Stereotype Displays the stereotype of the object.
Type [dependency link only] Displays the type of the dependency link, which can include mapping links,
shortcut links, generation links, etc.
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1.3.2.7 Project Checks

You can check the validity of your project at any time by pressing F4, selecting | Tools » Check Project 3, or right-
clicking the diagram background, and selecting Check Project.

Context

For information about using the Check Project Parameters dialog, see Checking Models [page 149].

1.3.2.71 Model and File Checks

PowerDesigner provides default model checks to verify the validity of models and files.

Check Description and Correction

Model and file location
unigueness

Multiple models or files cannot have the same location.

e Manual correction: Delete unnecessary model or file.

e Automatic correction: None.

Model location empty

[model only] There must be a path in the model document Location field.

e Manual correction: Save the model to specify a model location.

e Automatic correction: None.

External document URL
not under a named path

A model or file is defined outside the project directory.

e Manual correction: Right-click the model or file, and select Move to Project Directory.

e Automatic correction: None.

Target models not in
project

[model only] One or more target models of a model contained in the project is missing.

® Manual correction: Add missing target model with appropriate dependency link.

e Automatic correction: Yes.
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1.3.2.7.2 Framework Node and Cell Checks

PowerDesigner provides default model checks to verify the validity of framework diagram nodes and matrix cells.

Check Description and Correction

Name/Code uniqueness Object names must be unique in the namespace.

e Manual correction: Modify the duplicate name or code.

e Automatic correction: Appends a number to the duplicate name or code.

Documents not consistent A document in a node and cell must be consistent with its source action.

with node/cell actions e Manual correction: Modify the node's and cell's content according to its specified actions.

e Automatic correction: None

Mandatory actions not exe- | A mandatory action in a node and cell must be executed.

cuted e Manual correction: Execute the mandatory action.

e Automatic correction: None

1.3.3 Completing Framework Diagrams and Matrices

Your project may contain one or more framework diagrams and/or a framework matrix, which direct how your
project should be built.

e Aframework diagram - lets you model a framework with nodes and links, which you can style as necessary.
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Preliminary

A,
Architecture
Vision

H. B.
Architecture Business
Change Architecture
Management

G. C.
Implementation Requirements Information
Governance Management Systems

Architectures

F. D.
Migration Technology
Planning Architecture

E.
Opportunities
and
Solutions

® Framework matrix - lets you model a framework in a matrix, in which columns usually represent various
aspects of the enterprise that can be described or modeled, and the rows represent various viewpoints from
which the aspects can be described. Each cell formed by the intersection of a column and a row represents an
aspect of the enterprise modeled from a particular viewpoint.
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PowerDesigner provides a set of predefined framework diagrams and matrices, and users with framework design
rights can also create their own (see Designing Framework Diagrams and Matrices [page 65]). You complete a
framework diagram or matrix by creating (or adding existing) documents in nodes, cells, and additional areas
according to predefined rules:

e Documents — can be of different types and can each be associated with multiple nodes, cells, and additional
areas:

© Model — a PowerDesigner model, such as a BPM or a PDM, created from scratch, based on a template, or
generated from another model.

o Diagram — a PowerDesigner model diagram, such as an OOM use case diagram.
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o Dependency matrix — a grid that displays the links between model objects (see Dependency Matrices
[page 198]).

o List — alist of PowerDesigner model objects, such as BPM processes, or PDM tables.

o File — an external file, such as a .doc or .txt file.

e Nodes and cells [when active] — must be completed by particular kinds of documents.

e Additional areas [framework matrix only] — can be defined outside of the grid (for example, the global view in
the FEAF framework matrix that is created at the end of the enterprise architecture implementation).

1.3.3.1 Navigating in Framework Diagrams and Matrices

You can interact with framework diagram and matrix elements using various mouse actions.

e Hover over a framework element - to display its name and any comment.

e C(Click anode or cell - to open a floating list, which lets you manage the documents attached to the node or cell
(see Working with Floating Lists [page 64]).

e Right-click a node or cell — to opens contextual menu (see Working with the Framework Node and Cell
Contextual Menu [page 65]).

® Double-click a framework matrix element [framework architects only] — to open the property sheet of the
element (see Framework Matrix Properties [page 88]).

1.3.3.2 Attaching a Document to a Framework Node or Cell

You can attach new (or existing) documents to each node of a framework diagram and cell of a framework matrix.

Procedure
1. Open the framework diagram or matrix by double-clicking its Browser entry.

2. Click the node or cell to which you want to add the document to open its floating list, which displays the
documents attached to it.

¥ List of Business Dbjects H =]

ﬁﬁ|3'l§*|xk@é§§|mv Shatuis: J— W
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3. Click one of the following tools:

o New Document - to create a document of the specified kind:
© Model [from scratch or based on a template] — creates the model and opens it in the diagram window.

© Model [generated from another PowerDesigner model] — opens the Model Generation Options dialog
box to let you create a model (see Generating Models [page 465]).

o Diagram - opens a model selection dialog box to let you select a new or existing model to create the
diagram.

o Dependency matrix — opens a model selection dialog box to let you select a new or existing model to
create the dependency matrix (see Dependency Matrices [page 198]).

o List — opens the List of Objects dialog box to let you create objects in a new or existing model.

o File — opens a standard Save As dialog box to let you enter a file name. Click Save to open the file in
the application corresponding to the file extension.

o Add Document, and select:

o Attach Project Document — to add documents already in the project. Select the type of document you
want to attach.

o Add Document — to add documents from outside the project. Select the type of document you want to
add.
1 Note

You can also drag a project document from the Browser and drop it onto a node, a cell or a floating list,
or right-click a node or a cell, and select the New Document, Attach Project Document, and Add
Document commands. Documents can also be moved from one node or cell to another.

4. [optional = New Document only] Complete the creation of the new document by, for example, adding objects
to the model or diagram, or entering text in the file, etc.

The document is displayed in the floating list.

1.3.3.2.1 Example: Creating a PDM from a Cell's Floating List

In this example, we create a PDM, which has been specified as a requirement to complete a framework matrix cell.

Procedure

1. Click a cell to open its floating list, which displays the documents attached to the cell.

2. Click the New Document tool, and then select New PDM to create the required PDM.

The new PDM document is displayed in the cell, and in the Browser in the folder specified by the framework
architect.

For information about specifying a model as a requirement to complete a framework node or cell, see
Example: Specifying a Model Action [page 68].
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1.3.3.2.2 Example: Creating a List of Processes from a Node's
Contextual Menu

In this example, we create a list of BPM processes, which has been specified as a requirement to complete a
framework diagram node.

Procedure

1. Right-click a node, and select [|» New » Document ¥ List of processes . to open the List of Processes dialog.

2. Create an appropriate number of processes in the list, entering a name for each, and then click OK to close the
dialog box.

The list of processes document is displayed in the node, and in the Browser under a BPM node in the folder
specified by the framework architect.

For information about specifying a list as a requirement to complete a framework node or cell, see Example:
Specifying a List Action [page 71].

1.3.3.3 Deleting Documents from Framework Nodes and Cells

You can delete documents from framework nodes and cells. You can choose to simply detach a document from the
node or cell or completely remove it from the project.

Procedure
1. Click a node or cell to open its floating list, select one or more documents in the list, and then click the Delete

tool.

Alternatively, select one or more documents in a node or cell and press the Del key or right-click a document
and select ||» Edit » Delete

The Confirm Deletion dialog box is displayed.

Confirm Deletion E3 |

Haow do pou want o delete the zelected documents?

{+ Detach the documents from the celk

Remove the documents and any supporting files and modelz from the project
[Caution: Certain of the affected fles or models are used elzewhere in the project!]

Impact... | ] I Cancel Help
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2. Choose one of the following delete options:

o

Detach the document from the node or cell - the document is detached from the node or cell but remains
available in the project to be used elsewhere.

Remove the document and any supporting file or model from the project - their deletion from the project
may affect files or models used elsewhere in the project.

3. Click OK to close the dialog box and confirm the deletion.

1.3.3.4 Working with Floating Lists

You open a floating list by clicking a framework diagram node or matrix cell.

1 Note

Floating lists are not available when you select the Documents display preference (see Project and Framework
Display Preferences [page 55]).

Floating lists contain the following tools to let you manage project documents in the framework diagram and

matrix:

Tool Description

|§| Properties — opens the property sheet of the selected document.
| Open Document — opens the selected document.

=18

Add Document — contains the following tools:

e Attach Project Document — lets you select a document of the specified kind from inside the
project.

e Add Document — lets you select a document of the specified kind from outside the project.

New Document - creates a document of the specified kind.

Delete — deletes the selected document from the node and cell. You can choose to:

e Detach the document from the node and cell.

® Remove the document and any supporting file or model from the project.

For information see Deleting Documents from Framework Nodes and Cells [page 63].

|$| Customize Columns and Filter — allows the definition of filter expression on the columns of the float-
ing list (see Customizing Object List Columns and Filtering Lists [page 124]).
3 Enable/Disable Filter — enables or disables the filter.

Core Features Guide

64 PUBLIC Modeling with PowerDesigner



Tool Description

| vl Views — controls the display of documents in the floating list. You can choose between:

® | arge lcons — displays documents as large icons.
e | st —displays documents in multiple columns to optimize space.

e Details — displays documents in a grid, which can be filtered.

Status Status - indicates the percentage of work completed in the node and cell.

1.3.3.5 Working with the Framework Node and Cell
Contextual Menu

The contextual menu available on framework nodes and cells allows you to perform various actions.

The contextual menu of a framework node and cell contains the following commands. For information about the
additional commands available only in Framework Design Mode, see Styling Framework Nodes and Cells [page
821):

Command Description
List of Documents Opens the node's or cell's floating list.
New Document Creates a document of the specified kind in the node or cell. An action must be specified in

the node or cell in order for this command to be available.

Attach Project Document Attaches a document from inside the project to the node or cell.

Add Document Adds a document from outside the project to the node or cell.

1.3.4 Designing Framework Diagrams and Matrices

Framework architects (users who have selected the Authorize Framework Design user profile when installing
PowerDesigner) can create, design, and delete framework diagrams and matrices in projects, by enabling the
Framework Design Mode.

Procedure

Select | Tools » Framework Design Mode 3.

In the framework matrix, you can alternately right-click the framework matrix top-left corner, and select
Framework Design Mode. The design icon displays in the matrix top-left corner.

In the framework diagram, the Toolbox displays in the diagram.
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1.3.41 Creating a Framework Diagram

Framework architects can create one or more framework diagrams to guide their modeling teams through building
a project. You can specify actions for each node in the framework diagram that control what kind of document
(model, diagram, model objects list etc.) must be attached to them.

Procedure

1. Right-click a project in the Browser, and select | New » Framework Diagram 3 to open the framework
diagram property sheet.

2. Enter a name for the framework diagram on the General tab, and click OK to close the property sheet.

3. Click the Node tool in the Toolbox, click in the diagram, and create an appropriate number of framework
diagram nodes.

4. Click the Link tool in the Toolbox, click in the diagram, and create an appropriate number of framework
diagram links between the nodes to express connections between them.

5. [optional] Decompose one or more nodes to analyze them in more detail (see Decomposing a Framework
Node [page 66]).

6. Create actions for each node to specify the types of documents that your modelers can attach to the node
(see Specifying Framework Node and Cell Actions [page 67]).

7. [optional] Select |+ File » Save As Template 3 to open the Project Template Wizard, and convert the project
containing your framework diagrams into a template to allow it to be reused as the basis for future projects
(seeProject Templates [page 827).

1.34.11 Decomposing a Framework Node

You can decompose one or more nodes in the framework diagram to analyze them in more detail. The
decomposed node has its own sub-diagram, which models the links between its sub-nodes. Sub-nodes can,
themselves, be decomposed into further sub-nodes, and so on until you obtain a sufficient level of detail.

Context

You can decompose a node in a framework diagram in any of the following ways:

® Press ctrl and double-click the node symbol (this will open the sub-node directly)
e Open the property sheet of the node and, on the General tab, select the Composite check box.

Decomposed node symbols in a framework diagram carry a plus-sign symbol to indicate that they contain further
detail

The sub-diagram of the decomposed node is empty at first. You have to create the appropriate number of nodes
and links between them to show their connections (see Creating a Framework Diagram [page 66]).
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1.3.4.2 Creating a Framework Matrix

Framework architects can create a framework matrix to guide their modeling teams through building a project. You
can specify actions for each cell in the framework matrix that control what kind of document (model, diagram,
model objects list etc.) must be attached to them.

Procedure

1. Right-click a project in the Browser, and select | New » Framework Matrix Diagram 3 to open the framework
matrix property sheet, or right-click the background of any project diagram, and select | Diagram » New

Diagram ¥ Framework Matrix 4, or select | View » Diagram » New Diagram » Framework Matrix 3.

1 Note

You can create only one framework matrix per project.

2. Enter a name for the framework matrix on the General tab (see Framework Matrix Properties [page 88]).

3. Click the Columns tab, and create an appropriate number of framework matrix columns, entering a name for
each.

4. Click the Rows tab, and create an appropriate number of framework matrix rows, entering a name for each.

5. [optional] Click the Additional Areas tab, and create an appropriate number of additional areas, which will be
displayed outside the main matrix grid, entering a name for each.

6. Click OK to close the property sheet and create your framework matrix.
Create actions for each cell to specify the types of documents that your modelers can attach to the cell (see
Specifying Framework Node and Cell Actions [page 67]).

8. [optional] Select [ File » Save As Template 3 to open the New Template Wizard, and convert the project
containing your framework matrix into a template to allow it to be reused as the basis for future projects (see
Project Templates [page 82]).

1.3.4.3 Specifying Framework Node and Cell Actions

Actions control the types of documents that can be attached to nodes and cells when completing framework
diagrams and matrices. You can specify one or more action types per node and cell.

Procedure

1. Double-click a node or a cell to open its property sheet.

2. Onthe General tab, enter a node or a cell name, and any other appropriate properties (see Framework Node,
Cell and Additional Area Properties [page 89]).
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3. Click the Actions tab, and click the Add a Row tool to create a new action.

4. Double-click the action to open its property sheet and, on the General tab, enter an action name, and any other
appropriate properties (see Framework Action Properties [page 90]).

5. Click the Detail tab, and select one of the following types of actions as a means to populate the node or cell:

o Model — a PowerDesigner model (see Example: Specifying a Model Action [page 68]).
o Diagram — a PowerDesigner model diagram (see Example: Specifying a Diagram Action [page 70]).
o List — alist of PowerDesigner model objects (see Example: Specifying a List Action [page 71]).

o Model Generation —a PowerDesigner model generated from another model (see Example: Specifying a
Model Generation Action [page 73]).

o Object Generation —a PowerDesigner model populated with one type of objects generated from another
model (see Example: Specifying an Object Generation Action [page 75]).

o File — an external file (see Example: Specifying a File Action [page 76]).

o Matrix — a PowerDesigner dependency matrix showing links between model objects (see Example:
Specifying a Matrix Action [page 78]).

o Script - a VB script that can define any scriptable action (see Example: Specifying a Script Action [page
79)).

6. Specify any other appropriate properties to refine the action.

Click OK to close the action and node or cell property sheets and return to the framework diagram or matrix.

The action is now available for use by framework users (see Attaching a Document to a Framework Node or
Cell [page 61]). Note that only fully-defined actions are available for selection.

¥ List of Business Dbjects =] E3
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1.3.4.3.1 Example: Specifying a Model Action

The Model action lets a framework user (add or) create one or more models of the specified kind in the node or
cell. The model will be displayed in the Browser under the project node and as a document in the node or cell to
which it has been attached.

Context

In the following example, we will specify an action in a framework diagram node that enables the user to create one
or more Java OOMs with the EJB 3.0 xem attached.
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Procedure

Double-click a framework node to open its property sheet, and click the Actions tab.

. Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

. Select the Multiple check box to specify that more than one OOM can be attached to the node.

1
2
3. Onthe General tab, enter "Detailed object model" in the Name field.
4
5

. Click the Detail tab, and specify the following properties:

Property Select or enter

Type

Model

Default document name

Java Model

Model type Object-Oriented Model
Document template Leave blank
Model language Java

Diagram type

Class Diagram

Extension

EJB3.0

Bl action Properties - Detailed object model {Detailed_object model)

Geperal  Detai |Nn:|tes I

Type:

=10l x|

| Model

L

Default document name: IJ ava Model

Model tppe:
Document template:
Mode| language:
Djagram bype:

Extension:

| Object-Oriented Mode!

IJava

I Clazz Diagram

2 |1 | ER R

| k. I Cancel Apply

Help
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6. Click OK to close the action and node property sheets and return to the framework diagram.

The Model action is now available for use by framework diagram users (see Attaching a Document to a
Framework Node or Cell [page 61]).

1.3.4.3.2 Example: Specifying a Diagram Action

The Diagram action lets a framework user (add or) create one or more diagrams of the specified kind in the node
or cell. The diagram will be displayed in the Browser under an existing or new model node and as a diagram in the
node or cell to which it has been attached.

Context

In the following example, we will specify an action in a framework matrix cell that enables the user to create exactly
one BPM process hierarchy diagram from a previously defined template.

Procedure

Double-click a framework cell to open its property sheet, and click the Actions tab.
Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

On the General tab, enter "Process high level view" in the Name field.

A woN o

Clear the Multiple check box to specify that exactly one BPM process hierarchy diagram can be attached to
the cell.

5. Click the Detail tab, and specify the following properties:

Property Select or enter
Type Diagram
Default document name PHD
Default model name Processes
Model type Business Process Model
Document template Click the Ellipsis button to select the Orders.bpm template.
For information about creating model templates see Model Templates [page 15].
Diagram type Business Process Diagram
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Type: Diagrarn

Default document name: IF'HD

Default model name: IF'rDu:esses

Model tppe: I Buzinessz Process Model j
Docurnent template: IE:'\MyPrniects.hpm J
Mode| language: I <Mones j
Djagram bype: IF'ru:u:ess Hierarchy Diagram j
Extension: I <Mones j

Mare > | :'g - | k. I Cancel Apply Help

6. Click OK to close the action and cell property sheets and return to the framework matrix.

The Diagram action is now available for use by framework matrix users (see Attaching a Document to a
Framework Node or Cell [page 61]).
1.3.4.3.3 Example: Specifying a List Action

The List action lets a framework user (add or) create one or more model object lists of the specified kind in the
node or cell. The list will be displayed in the Browser under the appropriate model node and as a document in the
node or cell to which it has been attached.

Context

In the following example, we will specify an action in a framework diagram node that requires the user to create at
least one list of PDM clusters.
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Procedure

Double-click a framework node to open its property sheet, and click the Actions tab.

. Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

. Select the Mandatory check box to specify that at least one list of PDM clusters must be attached to the node.

1
2
3. Onthe General tab, enter "List of PDM clusters" in the Name Field.
4
5

. Click the Detail tab, and specify the following properties:

Property Select or enter

Type

List

Default document name

List of clusters

Default model name Clusters

Model type Physical Data Model

Document template Leave blank

Model language ORACLE Version 11g

Extension <none>

List object type PDM::Cluster (click the Select Object tool, navigate to Oracle Version 11g, and select

the Cluster node)
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Default model name: IEIusters

Model tppe: I Phyzical Data Model

Document template: I

] | Ledled]: Ll

Mode| language: IEIFL-’-‘-.ELE Verzion 11g
Extension: I <Mones
Ligt object type: PDb:: Chazter

Mare > | :'g - | k. I Cancel Apply Help

6. Click OK to close the action and node property sheets and return to the framework diagram.

The List action is now available for use by framework diagram users (see Attaching a Document to a
Framework Node or Cell [page 61]).

1.3.4.3.4 Example: Specifying a Model Generation Action

The Model Generation action lets a framework user generate one or more models from another model. The
generated model will be displayed in the Browser under the project node and as a document in the node or cell to
which it has been attached.

Context

In the following example, we will specify an action in a framework matrix cell that enables the user to generate
exactly one Sybase AS Enterprise 15.0.2 PDM from a Logical Data Model.
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Procedure

Double-click a framework cell to open its property sheet, and click the Actions tab.

Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

On the General tab, enter Generate from Logical Model in the Name field.

Clear the Multiple check box to specify that exactly one generated PDM can be attached to the cell.

Click the Detail tab, and specify the following properties:

Property Select or enter

Type Model Generation

Model type Physical Data Model
Model language Sybase AS Enterprise 15.5
Source model type Logical Data Model

Source location

Logical data model

General Detail |Nntes I

Type:

Bl Action Properties - Generate from logical model (Generate from 2l '

=10l x|

taodel type: I Phyzical D ata kodel

todel language: IS_I.II:uase A5 Enterprize 15.5

LefLe

Source model ype: IL:::giu:aI Drata kModel

Source location: |E| Logical Data Model

Lo

o | L]

Mare »» | = -

[ |

Cancel

Apply

Help

6. Click OK to close the action and cell property sheets and return to the framework matrix.
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The Model Generation action is now available for use by framework matrix users (see Attaching a Document to
a Framework Node or Cell [page 61]).
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1.3.4.3.5 Example: Specifying an Object Generation Action

The Object Generation action lets a framework user generate objects from one model to another. The generated
model will be displayed in the Browser under the project node and as a document in the node or cell to which it has

been attached.

Context

In the following example, we will specify an action in a framework matrix cell that enables the user to generate
exactly one Java OOM containing classes from a list of entities.

Procedure

Double-click a framework cell to open its property sheet, and click the Actions tab.

. Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

. Clear the Multiple check box to specify that exactly one generated OOM can be attached to the cell.

1
2
3. Onthe General tab, enter Classes from Entities inthe Name field.
4
5

. Click the Detail tab, and specify the following properties in the fields:

Property Select or enter
Type Object Generation
Object type Click the Select Object tool, navigate to [[F PdOOM # Class 4 in the dialog, and click

OK to select it.

Model language

C#20

Source object type

Click the Select Object tool, navigate to |} PdCDM > Entity } in the dialog, and click
OK to select it.

Source location

List of Business Objects
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Bl Action Properties - Entities to Classes (Entities_to_Classes)

Gereral Detail |Nn:ntes I

Type:

Object type: OOM::Clazs

bodel language: IE# 20

Source object tppe; COM::Erlity

L
=
o] e ] | Led [€]

Source location: |E| Lizt of Buzsiness Objects

Mare »> | ;§|' - k. I Cancel Apply Help

6. Click OK to close the action and cell property sheets and return to the framework matrix.

The Object Generation action is now available for use by framework matrix users (see Attaching a Document
to a Framework Node or Cell [page 61]).

1.3.4.3.6 Example: Specifying a File Action

The File action lets a framework user (add or) create one or more files of the specified kind in the node or cell. The
file will be displayed in the Browser under the project node and as a document in the node or cell to which it has
been attached.

Context

In the following example, we will specify an action in a framework diagram node that requires the user to create at
least one MS Word file from a predefined template.
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Procedure

1. Double-click a framework node to open its property sheet, and click the Actions tab.

2. Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

3. Onthe General tab, enter "MS Word File" in the Name field.

4. Select the Mandatory check box to specify that at least one MS Word file must be attached to the node.
5. Click the Detail tab, and specify the following properties in the fields:

Property Select or enter

Type File

Document template Click the Ellipsis button to select the Functional specifications.doc template.
File type .doc

Action Properties - MS Word File {(M5_Word_File)

General Detail |N|:-tes I

Tupe: File -
Document template: IE:\MyF‘rDiects"-.Functi-:nnal specifications. doc J
File tupe: I.u:h:u:

bore > | % - ] 4 I Cancel Apply Help

6. Click OK to close the action and node property sheets and return to the framework diagram.

The File action is now available for use by framework diagram users (see Attaching a Document to a
Framework Node or Cell [page 61]).
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1.3.4.3.7 Example: Specifying a Matrix Action

The Matrix action lets a framework user (add or) create one or more dependency matrices of the specified kind in
the node or cell. The dependency matrix will be displayed in the Browser under the project node and as a
document in the node or cell to which it has been attached.

Context

In the following example, we will specify an action in a framework matrix cell that enables the user to create exactly
one dependency matrix between PDM tables and users connected by the Owner dependency.

Procedure

Double-click a framework cell to open its property sheet, and click the Actions tab.

. Click the Add a Row tool to create a new action, and double-click it to open its property sheet.

. Clear the Multiple check box to specify that only one dependency matrix can be attached to the cell.

1
2
3. Onthe General tab, enter Table-User Matrix inthe Name field.
4
5

. Click the Detail tab, and specify the following properties:

Property Select or enter

Type

Matrix

Default model name

Table-User Matrix

Model type

Physical Data Model

Document template

Leave blank

Model Language

Sybase AS Enterprise 15.5

Extension

<none>

Dependency matrix

Click the Create tool to open the dependency matrix property sheet and specify the
following values:

o Matrix rows object type — Table
o Matrix columns object type — User

o Matrix cells dependency — Owner

6. Click OK to close the dependency matrix property sheet, and return to the action property sheet.
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Action Properties - Table-User Makrix (Table_User_Makrix) - | Ellil

Geperal  Detail |Nn:|tes I

L

Type: I B atris

Default model name: ITaI:uIE-Ll zer Matrix

Model tppe: IF'h_I,Isi-:aI Data Model

Document template: I

Mode| language: I Sybaze AS Enterprize 155

Extension: I <Mones

Diependency matris: Dependency katrix D efinition

]
G [ Ledled]: Lel

Mare > | :'g - | k. I Cancel Apply Help

7. Click OK to close the action and cell property sheets and return to the framework matrix.

The Matrix action is now available for use by framework matrix users (see Attaching a Document to a
Framework Node or Cell [page 61]).

1.3.4.3.8 Example: Specifying a Script Action

The Script action lets a framework user execute a script in the node or cell. You can use the script to create a
project document and attach it to the node or cell.

Context

In the following example, we will specify an action in a framework diagram node that enables the user to execute a
script that generates a model from another model. The result of this example is the same as that of a Generation
action, but the script is intended to demonstrate the possibilities that you can script in your own projects. You
could, for example, write a script to connect to a live database and reverse engineer it into a cell. For information
about writing scripts for use in your models and projects, see Customizing and Extending PowerDesigner >
Extension Files > Methods (Profile) .
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Before you can specify a script action, you have to create a method script on the FrameworkAction metaclass in an
extension, and then attach it to your project. In this case, the following script is called GenerateModel, and will
generate a PDM:

Sub %$Method% (ob7j)

This is a sample method that can be used in a script action

It generates a PDM from a source cell CDM and attaches it to the current cell
Steps:

1- Get the source cell: found by its code "mySourceCell"

2- Get the source model: first document in the source cell

3- Generate a PDM from the source model

4- Attach the generated model to the current cell

5- Set current action as source action for the new document

=> That will prevent generating twice if the action is not multiple

If obj Is Nothing Then Exit Sub
Dim sourceCell, targetCell, modelDoc, sourceModel, targetModel

The script is defined on the action so the current cell is simply the action

parent

Set targetCell = obj.Parent

First check if we can execute the action on the current cell
for non multiple actions, the CanExecute should return true only the first time

If obj.CanExecute (targetCell) Then

' Get Source cell

Set sourceCell = FindCellByCode (targetCell.Parent, "mySourceCell") ' See

function code below End Sub statement

' Get source model (supposed to be the first in its artifact document list)

Set modelDoc = sourceCell.ArtifactDocuments.Item(0)

Set sourceModel = modelDoc.TargetModelObject

' Generate PDM Model

Set targetModel = sourceModel.GenerateModel (Nothing, PdPDM.cls Model)
' Attach generated model to current cell

Set modelDoc = targetModel.SourceModelDocument
targetCell.AttachDocument (modelDoc)

' Set current action as source for the new model document
obj.SetAsSource (modelDoc)

Else

' In this sample, the action is supposed to be non-multiple

' Therefore, CanExecute fails if it's already a source action for an existing

document

output "The action has already been executed"

End If

End Sub

FindCellByCode function (Global Script function):

Function FindCellByCode (fmx, Code)

Set FindCellByCode = Nothing
Dim Cell
For Each Cell In fmx.cells

If Cell.Code = Code Then
Set FindCellByCode = Cell
Exit For

End If

Next

End Function

>>

Procedure

1. Double-click a framework node to open its property sheet, and click the click the Actions tab.

2. Onthe General tab, enter Generate Model Script inthe Name field.
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3. Clear the Multiple check box to specify that exactly one generated model can be attached to the node.

4. Click the Detail tab, and specify the following properties in the fields:

Property Select

Type Script

Method GenerateModel

Action Properties - Generate Model Script {Generate Model Script)

General Detail |N|:utes I

ethod: Iﬁ FrameworkAction:: Generatehd odel j

baore > |;§|I - 0k, I Cancel Apply Help

5. Click OK to close the action and node property sheets and return to the framework diagram.

The Script action is now available for use by framework diagram users (see Attaching a Document to a
Framework Node or Cell [page 61]).
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1.3.4.4 Styling Framework Nodes and Cells

Framework architects have access to additional commands that allow them to change the format of framework
nodes and cells.

Context
Command Description
Format Opens the Symbol Format dialog box to let you specify line and fill colours, fonts and formatting for
each textual element, and an image for the node or cell (see Symbol Format Properties [page
213]).
Change Image Opens the Select Image dialog box to let you insert an image in the node or cell (see Browsing for
Images [page 221]).
Get Format Copies the format of the selected node or cell for pasting in other nodes or cells.
Apply Format Pastes a previously copied node or cell format into the selected node or cell.
Properties Opens the property sheet of the selected node or cell.

For information about the standard commands available outside design mode, see Working with the Framework
Node and Cell Contextual Menu [page 65].

1.3.5 Project Templates

A project template can provide predefined content, rules, and formatting for your project.

Context

For example, you could create:

e Adata project template - containing a CDM, LDM, and PDM targeting your preferred DBMS.

e Anapplication project template - containing an OOM with the UML diagrams required for your modeling
practices, along with a PDM and XSM to handle data persistance and format.
e Aframework project template - containing a FEAF or other framework matrix.
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Procedure

1. Create a project (see Creating a Project [page 49)).
2. Create the content that you want to make available in your template:

o [optional] Add any appropriate models or files (see Adding Model and File Documents to a Project [page
50]).

o [optional] Create one or more framework diagrams (see Creating a Framework Diagram [page 66]).

o [optional] Create a framework matrix (see Creating a Framework Matrix [page 67]).

o [optional] Specify any appropriate display preferences (see Project and Framework Display Preferences
[page 55]).

3. Select|fr File ¥ Save As Template . to open the Template Wizard and click Next.

1 Note

If you have unsaved changes to the contents of your project, you will be prompted to save them before
beginning the wizard.

4. Specify a directory in which to save the project template. By default, the project template directory (defined

via |» Tools » General Options » Project Templates ) is selected. Click the Change Template Directory tool to
select another location.

5. Select a template category from the list or enter a template category name that will appear in the New Project
dialog. You can use the \ character to create sub-categories.

Project Template Wizard Ed

Location.

The wizard allows the conversion of an existing project into a template that can
be instantiated marny times.

Template directory: IE:"-.M_I,IF'n::ie::tS'xF'rDiect Templatesz

Template categony: IFunu:tiu:unaI Specification j

< Back I Mest » I Finizh Cancel Help

6. Click Next, and enter a description for the new template that will be displayed in the New Project dialog.
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Project Template Wizard

Template Description.

Enter a description for the template to dizplay in the Mew Project wWizard.

Thiz template is a guide for wiiting specifications for highrlevel features)

< Back et > | Finizh I Cancel Help

1 Note

You can modify a template description by right-clicking a project template in the Browser, and selecting Edit
Template.

7. Click Finish to close the wizard and create the template.

The project (.prj) and the models and files it contains are copied to the template directory.

1 Note

If any documents are outside the project and only attached to it they will not be copied to the template
directory and thus may not be available to a user when she creates a project from the template.

When you select |» New » Project 4, the template is available for selection in the Project type tree:
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Mew Project !EI

Project type @

Mame:

Location:

Rook
directon,:

4 COM+LDM+PDM
--1_J Frarnework, b atrix
EILJ Functional Specification
O =k -l Features
E|1_J S pecification
L5 FEAF matris

--1_J Syb Project Templates

=]

— Descripkion

This kemplate is a guide For writing specifications For high-level

features,

Zhange template directory:

IF'rl:uie-:t_E

IE: WrduProjectsh,

¥ append name to location

IE: WrduProjectzhProject_G%

]

Cancel Help

8. [optional] Check the project template into the repository Library/Resources/Project Templates folder

to make it available to other users (see Sharing Model, Report, and Project Templates and Conversion Tables

via the Library [page 589])).
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1.3.6 Project and Framework Properties

Projects, model and file documents, and framework diagrams and matrices have a variety of properties that you
can configure to control their behavior.

1.3.6.1 Project Properties

To view or edit a project's properties, double-click its Browser or list entry. The property sheet tabs and fields listed
here are those available by default, before any customization of the interface by you or an administrator.

The General tab contains the following properties:

Property Description
Name/Code/Comment Identify the object. The name should clearly convey the object's purpose to non-technical users,
while the code, which is used for generating code or scripts, may be abbreviated, and should not
normally include spaces. You can optionally add a comment to provide more detailed information
about the object. By default the code is generated from the name by applying the naming conven-
tions specified in the model options. To decouple name-code synchronization, click to release the
= button to the right of the Code field.
File name Specifies the location of the project file. This field is empty if the project has never been saved.
Author Specifies the author of the project. If you enter nothing, the Author field in diagram title boxes
displays the user name from the project property sheet Version Info tab. If you enter a space, the
Author field displays nothing.
Version Specifies the version of the project. You can use this box to display the repository version or a
user defined version of the project. This parameter is defined in the Title page of the project dis-
play preferences.
Default diagram Specifies the diagram displayed by default when opening the project.
Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate
them with commas.
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1.3.6.2 Model and File Document Properties

To view or edit a document's properties, double-click its diagram symbol or Browser or list entry. The property
sheet tabs and fields listed here are those available by default, before any customization of the interface by you or
an administrator.

The General tab contains the following properties:

Property Description

Name/Code/Comment Identify the object. The name and code are read-only for model documents. You can optionally
add a comment to provide more detailed information about the object.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add ster-
eotypes to the list by specifying them in an extension file.

Location Specifies the path or URL to the document. Read-only for model documents.

[read-only] The property sheet provides read-only information on the extension, size, and creation and modi-
fication dates of the document, as well as noting whether it is inside the project or simply refer-
enced by it.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate
them with commas.

1.3.6.3 Dependency Link Properties

To view or edit a dependency link's properties, double-click its diagram symbol or Browser or list entry. The
property sheet tabs and fields listed here are those available by default, before any customization of the interface
by you or an administrator.

The General tab contains the following properties:

Property Description

Type [read-only] Specifies the type of the dependency link, which can include generation links,
reference links, mapping links, and file links.

Influent object [read-only] Specifies the source object of the dependency link. Click the Properties tool be-
side the list to open its property sheet.

Dependent object [read-only] Specifies the target object of the dependency link. Click the Properties tool be-
side the list to open its property sheet.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, sep-
arate them with commas.
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1.3.6.4 Framework Matrix Properties

Framework architects can modify a framework matrix properties from its property sheet by enabling the
Framework Design Mode, and double-clicking the framework matrix top-left corner.

For more information on enabling the Framework Design Mode, see Designing Framework Diagrams and Matrices
[page 65].

The General tab contains the following properties:

Property ‘ Description

Name/Code/Comment | Identify the object. The name should clearly convey the object's purpose to non-technical users,
while the code, which is used for generating code or scripts, may be abbreviated, and should not nor-
mally include spaces. You can optionally add a comment to provide more detailed information about
the object. By default the code is generated from the name by applying the naming conventions
specified in the model options. To decouple name-code synchronization, click to release the = button
to the right of the Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereo-
types to the list by specifying them in an extension file.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate
them with commas.

In addition to the General tab, the framework matrix property sheet contains the following tabs:

e Rows tab — displays a sortable list of rows, in which you can create, edit or delete rows. See Framework
Column and Row Properties [page 88].

e Columns tab — displays a sortable list of columns, in which you can create, edit or delete columns. See
Framework Column and Row Properties [page 88].

e Cellstab — displays a list of cells, which is computed from the intersection of columns and rows or from the
creation of additional areas. You can edit cells but you cannot delete them unless you delete the columns or
rows to which they belong. See Framework Node, Cell and Additional Area Properties [page 89].

e Additional Areas tab — displays the four additional areas available to the framework matrix. You can create,
edit or delete additional areas. See Framework Node, Cell and Additional Area Properties [page 89].

1.3.6.5 Framework Column and Row Properties

[Framework architects] To view or edit a column or row's properties, enable the Framework Design Mode, and
double-click a column or row header in the framework matrix.

For more information about enabling the Framework Design Mode, see Designing Framework Diagrams and
Matrices [page 65]).
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The General tab contains the following properties:

Property Description

Name/Code/Comment Identify the object. The name should clearly convey the object's purpose to non-technical users,
while the code, which is used for generating code or scripts, may be abbreviated, and should not
normally include spaces. You can optionally add a comment to provide more detailed information
about the object. By default the code is generated from the name by applying the naming conven-
tions specified in the model options. To decouple name-code synchronization, click to release the
= button to the right of the Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add ster-
eotypes to the list by specifying them in an extension file.

Help file Specifies a location for the help file associated with the row or column.

Default folder Specifies a default folder for the creation of the cell's documents. If no default folder is specified
in the cell's property sheet, the row's default folder is used first, then the column's default folder.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate
them with commas.

1.3.6.6 Framework Node, Cell and Additional Area Properties

[Framework architects] To view or edit a node, cell or additional area's properties, enable the Framework Design
Mode, and double-click a node in the framework diagram or a cell or an additional area in the framework matrix.

For more information about enabling the Framework Design Mode, see Designing Framework Diagrams and
Matrices [page 65].

The General tab contains the following properties:

Property Description

Name/Code/Comment Identify the object. The name should clearly convey the object's purpose to non-technical
users, while the code, which is used for generating code or scripts, may be abbreviated, and
should not normally include spaces. You can optionally add a comment to provide more de-
tailed information about the object. By default the code is generated from the name by ap-
plying the naming conventions specified in the model options. To decouple name-code syn-
chronization, click to release the = button to the right of the Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add
stereotypes to the list by specifying them in an extension file.

Help file Specifies a location for the help file associated with the node and cell.

Default folder Specifies a default folder for the creation of the node's and cell's documents.
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Property Description

Cell location [framework matrix only - read-only]

[cell] Specifies the name of the column and row for which the cell is the intersection. Click
the Properties tool beside Row and Column fields to open their property sheet.

[additional area] Specifies the location of the additional area: Left, Top, Right, or Bottom
area.

Completion status Controls the percentage of work completed in the node and cell. Enter a value between 1
and 100 in the box. This value is also displayed in the node's and cell's floating list and a rec-
tangle on the node and cell shows the work progression if you have selected the Completion
status display preference.

Inactive [cell only] Specifies a cell which is not available.

Constrain content Specifies a node and cell, whose content can only be completed by its defined actions.

Composite [node only] Specifies whether the node is decomposed into sub-nodes displayed in sub-dia-
grams. When selected a Sub-Nodes tab is displayed in the property sheet to list these sub-
nodes. If you deselect this property, then any sub-nodes that you have created will be de-
leted.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, sep-
arate them with commas.

In addition to the General tab, the framework node and cell property sheet contains the following tabs:

e Actions tab — displays a list of actions, in which you can create, edit or delete actions (see Framework Action
Properties [page 90]).

® Documents tab - displays a list of documents, in which you can create or add existing documents, and also
edit or delete documents (see Attaching a Document to a Framework Node or Cell [page 61]).

1.3.6.7 Framework Action Properties

[Framework architects] To view or edit an action's properties, enable the Framework Design Mode, and double-
click an action on the Actions tab of a node or cell property sheet.

1 Note

For information about enabling the Framework Design Mode, see Designing Framework Diagrams and Matrices
[page 65].
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The General tab contains the following properties:

Property Description
Parent [read-only] Specifies the name of the parent node and cell to which the action belongs.
Name/Code/Comment Identify the object. The name should clearly convey the object's purpose to non-technical
users, while the code, which is used for generating code or scripts, may be abbreviated, and
should not normally include spaces. You can optionally add a comment to provide more de-
tailed information about the object. By default the code is generated from the name by ap-
plying the naming conventions specified in the model options. To decouple name-code syn-
chronization, click to release the = button to the right of the Code field.
Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add
stereotypes to the list by specifying them in an extension file.
Multiple When selected, specifies that one or more documents of the selected type can be created.
Mandatory When selected, specifies that at least one document of the selected type must be created.
Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, sep-
arate them with commas.
Detail Tab

The Detail tab specifies the nature of the action.

Property

Type

Description

Specifies the nature of the document to attach to the framework nodes and cells (see Speci-
fying Framework Node and Cell Actions [page 67]).

Default document name

[Model, Diagram, and File only] Specifies the model, diagram or file name created by default
in the Browser.

Model type

[not for File and Dependency Matrix] Specifies a model type to create, for example Enterprise
Architecture Model.

Document template

[not for Generation and Dependency Matrix] Specifies the model or file template on which
the model or file to create is based, for example a PDM, an LDM, or a .doc, a .xIs etc. Click the
Ellipsis button to browse for a file on your system.

Model language

[not for File and Dependency Matrix] Specifies a target language associated with the model
to create, for example Analysis for a BPM or Java for an OOM. Select a model language in the
list. If you do not specify a language, your system default model language is used.

Diagram type

[Model and Diagram only] Specifies a diagram type for the model, for example Class Diagram
for an OOM, or Business Process Diagram for a BPM.
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Property Description

Extension [not for File and Dependency Matrix] Specifies an extension file attached to the model, for
example SIMULS for a BPM.

Object type [List only] Specifies the model object type in the list, for example entity, process, table, class
etc.

Object stereotype [List only] Specifies a stereotype to filter the metaclass, for example a <<cluster>> stereo-
type on an extended object in a PDM targeted for the Oracle Version 9i DBMS.

Dependency matrix [Dependency Matrix only] Specifies a dependency matrix definition between model objects.
Click the Create tool to create a new dependency matrix.

File type [File only] Specifies the extension of the file to create, for example, .doc, .xsl, .txt, etc.

Source model type [Generation only] Specifies the model type from which to generate the model, for example
Business Process Model, Conceptual Data Model etc.

Source cell [Generation only] Specifies the node and cell containing the model type from which to gener-
ate the new model.

1.3.6.8 Framework Link Properties

[Framework architects] To view or edit a framework link's properties, double-click its diagram symbol or Browser
or list entry. The property sheet tabs and fields listed here are those available by default, before any customization
of the interface by you or an administrator.

For more information about enabling the Framework Design Mode, see Designing Framework Diagrams and
Matrices [page 65].

The General tab contains the following properties:

Property Description

Name/Code/Comment Identify the object. The name should clearly convey the object's purpose to non-techni-
cal users, while the code, which is used for generating code or scripts, may be abbrevi-
ated, and should not normally include spaces. You can optionally add a comment to pro-
vide more detailed information about the object. By default the code is generated from
the name by applying the naming conventions specified in the model options. To decou-
ple name-code synchronization, click to release the = button to the right of the Code
field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or
add stereotypes to the list by specifying them in an extension file.

First object Specifies the node that the link leads from. You can click the Properties tool to the right
of the list to view the properties of the selected object.
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Property Description

Second object Specifies the node that the link leads to. You can click the Properties tool to the right of
the list to view the properties of the selected object.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords,
separate them with commas.

1.4 Objects

Modeling objects, such as tables and entities, are the building blocks of your models. All the objects in a model are
listed as items in the Browser and they may also appear as symbols in your diagrams.

Each type of model diagram (see Diagrams [page 185]) supports certain specific types of objects, and each object
created in a diagram is represented by a symbol (see Symbols [page 202]). A single object can have multiple
symbols associated with it to allow it to appear in multiple diagrams or multiple times in the same diagram (see
Creating Graphical Synonyms for Object Symbols [page 219]).

1 Note

For detailed information about a specific type of model or object, see the appropriate modeling guide. The
following sections describe generic features available for all objects.

1.4.1 Creating Objects from the Toolbox

The toolbox is a toolbar that lets you quickly create objects in diagrams. To create an object, click the appropriate
tool and then click in the diagram. When you release the mouse button, the object is created, and you can click
again elsewhere to create a second object and so on.

|E
|~ Standard | v Standard i
|‘E @ G & F X | |(~) Physical Diagram =
'::E] Physical Diagram [l Package

EE®S & A3 = Table

|~ Free Symbols | |63 View

EBSTe@m N ™NO 2 Reference

G LA &2 Procedure

| » | Predefined Symbols Y File E
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To release the tool, simply select another tool or right-click in free space. To revert to a previously selected tool,
hold down and perform a double right-click.

To create a link, click the appropriate link tool, click in the object from which you want the link to begin and hold the
mouse button as you drag the pointer to the object in which you want the link to end. When you release the mouse
button, the link is created.

The toolbox contains four categories that can be collapsed or expanded by clicking on the up and down arrows:

e Standard - containing the basic tools available in all diagrams:

W%

Pointer [default] — Selects, moves, and resizes individual symbols. Double-click to select all the objects in the
diagram. To switch back to the Pointer from another tool, right-click anywhere in the diagram.

Grabber — Single-click to select the entire diagram. Double-click to display the entire diagram, centered.

Zoom In/Zoom Out.

&,

Open Diagram - Click a composite object or package to open its default diagram.

&

Delete - Click a symbol to delete it and, optionally, its associated object (see Deleting Objects [page 106]).

=4

Properties - Click a symbol to open the property sheet of its object (see Object Properties [page 107]).

e <Type> Diagram - containing tools specific to the current diagram (see the appropriate modeling guide) and
the following tools for objects that are available in all diagrams:

Icon Action

E

Package — see Packages [page 144].

3

File - see File Objects [page 142].

® free Symbols - containing tools for drawing free shapes and links to decorate your diagrams (see Decorative
Symbols [page 2247]).

® Predefined Symbols - containing tools for drawing standard flowchart shapes.

1 Note

To rename an object from its symbol, select it and then press . If the symbol carries additional editable
properties (but not lists of sub-objects), you can navigate to the next with (or the previous with +
). Select the Edit in place after creation general option to have the name of each object that you create
immediately selected for editing (see General Options [page 429]).

94 PUBLIC
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1.4.2 Creating Objects from the Browser

You can create any object, including objects that do not have symbols, from the Browser. If the Browser is not
visible, select |+ View » Browser 3 (or press Alt+0) to display it.

Procedure

1. Right-click the model, package, object, or category where you want to create the object, and select |» New »
<object type> }

2. Type an object name and code in the General tab of the property sheet, and then add any other relevant
properties (see Object Properties [page 107]).

3. Click OK to confirm the creation of the object.

The object is created in the appropriate category in the Browser. If the object has a symbol, it will also be
added (where possible) to the current diagram.

1.4.3 Creating Objects from an Object List

You can create most types of objects in object lists, available under the Model menu. Some property sheet tabs,
such as a table's Columns tab or a class's Attributes or Operations tabs also contain object lists. Lists provide a
method to quickly create multiple objects and change their properties simultaneously.

Procedure

1. Select|r Model » <object type> 4 (oropen an appropriate property sheet tab).

2. Click the Add a Row tool or, if the list is ordered, the Insert a row tool.

A new item is added at the end, or before the selected row, of the list.
3. Enter an object name and code and, for link objects, a source and destination object.
4. Repeat as necessary to create additional objects of the same type, and then click OK.

Results

For detailed information about object lists, see Object Lists [page 118].
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1.4.4 Importing Objects from Excel Files

The Excel Import extension provides a wizard to guide you through mapping tables of objects in an Excel file
(v2003 and higher) to PowerDesigner objects and properties, to import them to your model. For example, you
could create a list of database tables in an Excel file, specifying any appropriate properties, and then import them
into a PDM.

Context

You can import any number of different types of objects from a single Excel file, so long as they can all be imported
to a single type of model. Each type of object should be listed in its own table on a separate worksheet of the Excel
file. Each row in a table represents one object to import, and each column represents one property (an attribute or
list of associated objects) of the object.

In the following example, the Excel file contains worksheets listing tables, keys, references, and reference joins. The
Table sheet, contains a list of three table to import. The columns Name, Owner, and Columns will be imported as
the corresponding table properties:

Name Oowner Columns

Customers dba 1D, Name,Password,Email
Orders dba 1D, CustomerlD,Date
OrderLines dba OrderlD,ProductlD, Oty

Table - Table.Key Reference Reference. Reference Join ¥

For detailed information about how to organise the file, see Preparing Your Excel File for Import [page 99].

1 Note

An example Excel file for importing into a PDM is provided at <install dir>\Examples
\excel import.xls and asetof nine files forimporting into an EAMis at <install dir>\Examples
\EAExample.

Procedure

1. [optional] Create extensions to allow you to easily import objects or properties not defined in the standard
PowerDesigner metamodel (see Extension Files [page 452]).

If you do not predefine extensions, the wizard will allow you to specify them during the definition of the
mappings prior to beginning the import, but predefined extensions can be more sophisticated and allow the
import to proceed more quickly.

2. Open the Excel Import Wizard:
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o To create a new model, select |j» File » Import » Excel File A. Specify the kind of model you want to create
in the New Model dialog (see Creating a Model [page 12]), and then click OK.

o Toimport objects into an existing model, attach the Excel Import extension (available for all model types
on the Import subtab of the Select Extensions dialog) to your model (see Attaching Extensions to a Model
[page 4541), then right-click the model in the Browser, and select Import Excel File.

Excel Import Wizard Hi=]

Wielcome to the Excel Import “izard. Thiz wizard guides you
through importing tables of objects defined in an Excel spreadzhest.
T get started, zelect an Excel file ta impart.

IE: hremphtables. ko

Options... |
Hest: I Cancel Help

3. Click the Select File tool, browse to and select the Excel file to import, and click Open to return to the wizard.

4. [optional] Click the Options button to open the Import Options dialog (see Excel Import Options [page 101]),
specify any appropriate options and then click Close to return to the wizard.

5. Click Next to go to the Import Table page:

Import Table [_ O]

The wizard has found a table to import. Select the kind of
PowerDezigner abject pau want ta create for each table row.

¥ |mpart table ITaI:nIe

Az I Table j

Cancel | Help |

On this page, you must either:
o Select a PowerDesigner object type to import the table lines As from the list.
o Select to import the table lines as a new object type by clicking the New tool to the right of the list to open
the New Object Type dialog.
o Deselect the check box to not import this table. When you click Next, PowerDesigner will search the Excel
file for another table of objects to import.

6. Click Next to go to the Import Column page:
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Import Column Hi=]

Select the PowerDesigner attribute ar lizk that is contained in thiz column,
For lists ar attributes that reference other objects,
wou muzt alzo zpecify the aszociated PowerD esigner object.

pﬂmpnrt ol IName of table | Table

s £ Attribute  © List of aszociated objects

Aftribute; INamE j

M et I Cancel | Help |

On this page, you must either:

o Select a PowerDesigner attribute to import the table column as from the Attribute list. To create a new
attribute, click the New tool to the right of the list.

o Select the List of associated objects radio button to import the column as a list, selecting the List to use
and (if the list can contain multiple types of objects), the appropriate Object. To create a new list, click the
New tool to the right of the list.

o Deselect the check box to not import this table column.

7. Click Next. The wizard will search for the next column in the table and if there is none (or if you have selected to
skip importing the table), will search for the next sheet containing a table of objects.
When all the worksheets and columns have been processed, the import will begin. You can stop the import at
any time by clicking the Cancel button in the bottom-right corner. When the import is complete, a dialog will
appear showing how many objects have been created.

8. Click OK to return to your model and review the imported objects.
If you have instructed PowerDesigner to create new object types or new properties, a new embedded
extension called Import Extensions is created under the Extensions category in the Browser to hold the
definitions of these extensions.

Results

During the import, in addition to the objects that are created, PowerDesigner creates an Excel Import object that
contains your import parameters, along with a Table Mapping object for each of the imported tables, which lists
the column mappings used. Right-click the Excel Import Object to access the following commands:

98

Import - to re-import your file based on the options and mappings you have already defined. All the objects will
be reimported, overwriting any existing objects based on their names. If you have added new objects to your
worksheet tables they will be added to the model, but any objects that you have deleted from your worksheet
will not be deleted from the model.

Change Mappings - to re-import your file via the Excel Import Wizard in order to modify your table or column
mappings.

Change Options - to change the import options preparatory to re-importing with the command Import.
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® Properties - to open the Excel Import properties sheet.

1 Note

Advanced users may want to modify the Excel Import XEM to enable the import of data from other external file
types. For detailed documentation about its implementation, open the XEM (which is located at

<install dir>\Resource Files\Extended Model Definitions\ExcelImport.xem inthe Resource
Editor and read the detailed commentary on the root element.

1.44.1 Preparing Your Excel File for Import

By following certain simple rules, you can greatly help PowerDesigner to recognize the information in your Excel
files, and thus improve the accuracy and speed of the import.

Follow these rules to ensure that your import goes as smoothly and quickly as possible:

Determine your
extensions strategy

Insert only one table
of objects per
worksheet

Name your
worksheet after the
object to import

Name table columns
after the property
they contain
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The wizard can create simple extensions (new object types or new properties not included
in the PowerDesigner metamodel) for you during the import. However, to define more
complex extensions or to speed up the import process, you may prefer to predefine your
extensions beforehand (see Extension Files [page 452]) and have the import
automatically map them.

If you have more than one table on a worksheet, only the first will be recognized and
imported.

If the name of your worksheet matches the name of a PowerDesigner object type, then
the wizard will suggest mapping the table to that object type. The wizard does not
recognize plural forms so, if your sheet contains tables, you should call it Table, and if it
contains classes, call it Class.

Table Table.Key Reference

For sub-objects (objects linked to their parent by composition), you must prefix the name
of the object with that of its parent object, (eg Table.Key) or it will not be recognized.

If you name each of your columns after the attribute or collection that it contains, then the
wizard will suggest mapping the column to that attribute or collection. As a general rule,
attributes are singular and collections plural so that, for example, you should name the
column that contains your tables' names Name and the column containing its columns,
Columns.

Name Owner Columns
Customers dba 1D, Name,Password,Email
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Determine how you  Properties can contain references to other objects. For example, a table Owner property

will reference other  contains a reference to a user object and a business process references the organization

objects unit that performs it. The import tries to resolve references first by searching for an
appropriate object in the Excel file, and then in any of the models open in the Workspace
(creating a shortcut to the referenced object). Follow these suggestions to optimize your
references:

e Control whether references will be made via object names or codes using the
Reference associated objects by option.

e To maximize the clarity of dependencies between objects, place objects that are to be
referenced on a worksheet before the objects that will reference them.

e Ensure that the necessary target models are open in the Workspace to create
shortcuts, if appropriate, and select the Search for referenced objects in other models
option.

e Use the Create associated objects if not found option to instruct PowerDesigner to
create the necessary objects if it cannot resolved references either in the Excel file or
in models open in the Workspace.

Quickly create You can create a collection simply by listing its items in a single cell, separated by
collections by listing commas:
objects in a single

cell
Columns

(1%}
-

1D, Mame,Password,Email
ID,CustomerlD,Date

OrderlD,ProductlD, Oty
Tahle .~ Table.Key Reference

To change the separator, use the List value separator option.

Represent To specify composition relationships (such as columns in a table, classes in a package, or
relationships of attributes in a class) between objects on different worksheets, specify the parent or
composition usinga location for the sub-object in a Parent column. You can specify a multi-level hierarchy of
Parent column parents separated by a qualified name separator.

Name Parent
Areal

Area2 Areal
Area3 Areal
Aread Areal.Area2
Areas Areal.Area3

Architecure Area Business Fur
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1

Note

Whereas specifying a collection of sub-objects in a single cell on the parent worksheet
allows you to quickly populate the collection, specifying sub-objects on a separate
worksheet allows you to detail all their properties.

1.4.4.2 Excel Import Options

The Excel Import Wizard provides a number of options to allow some flexibility in the format of the data it can

import.

Option ’ Description

Auto-map columns to prop-
erties

Instructs the wizard to automatically map Excel tables and columns to objects and properties in
the PowerDesigner metamodel. If all your Excel worksheets and table column headings are
named from the PowerDesigner metamodel (or your predefined extensions), this option can
make the import run without requesting further input (see Preparing Your Excel File for Import

[page 99)).

Default: Unselected

Check data integrity

Enables validation of objects and property values (such as the uniqueness of names and codes)
during import. Disabling this option can provide significant performance improvements when

importing larger files. Data integrity can be confirmed after the import by selecting |} Tools >

Check Model }(or pressing F4) in the model.

Default: Selected

Create symbols in active dia-
gram

Instructs the wizard to create symbols, where appropriate, for the imported objects in the cur-
rently selected diagram.

Default: Unselected

Create associated objects if
not found

Instructs the wizard to create objects referenced by the imported objects, if they cannot be
found in the Excel file (or in an open model, if the Search for referenced objects in other models
option is selected).

For example, in a list of PDM tables, the Owner, property references a user object. If you do not
supply a list of users on another worksheet or in an open model (or if your list is incomplete),
PowerDesigner will create user objects for any references that cannot be resolved.

Default: Selected

Search for referenced objects
in other models

Instructs the wizard to search any models open in the workspace to resolve references as short-
cuts if the referenced object cannot be found in the Excel file.

Default: Unselected
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|
Option ’ Description

Reference associated objects

b Specifies whether the object's name or code (the latter of which does not usually permit spaces
Y

or special characters) is used in columns that reference the object. In the example above, you
could use the user's name or code to reference it in the Ownexr column of the list of tables.

Default: Name

Qualified name separator Specifies the character used to separate namespaces in a qualified name, which is used to

specify the location or parent of an object. For example, to specify that area Area3 is inside
Area2, whichisinturninside Areal, you would enter Areal .Area?2 in the Parent column

for Area3.

Default: Dot

List value separator Specifies the character used to separate items in a list in an Excel cell. For example, you could

list all the columns of a table in a cell as follows: ID ,Name ,Email , Password.

Default: Comma

String literal for "True' value Specifies the string used to signify 'True' for boolean attributes. False is signified by an empty

cell.

Default: X ("Y', 'Yes', 'True', and '1' also always signify 'True'.

1.4.5 Importing Objects from XML Files

PowerDesigner allows you to import objects from an XML file by defining mappings between the elements in the
XML schema and objects in the PowerDesigner metamodel (and any extensions). The import mappings are
defined in an extension file, can be shared with all users through the repository library, and are accessed by

selecting | File » Import » <Import Name> 4.

Context

Once an import is defined for a particular XML schema, any XML data files conforming to the schema can be
imported. If you do not have access to the schema, PowerDesigner can infer a schema from a data file.

1 Note

The following procedure gives an overview of the process for defining an XML import. If an administrator has
already defined an import and provided the resource file to you, you can perform an import directly by selecting

| File » Import » <Import Name> 4.
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Procedure

1. Select|p Tools » Resources » Extensions » <Model Type> 410 open the appropriate extension file list.

1 Note

As XML imports are mapped to a specific set of objects in the PowerDesigner metamodel, you must choose
the correct type of extension file. For example, if you are importing business processes, you should create
the import definition in a business process model extension file. If the objects defined in your schema do
not relate to any of the standard PowerDesigner model types, you should choose a free model (see The Free
Model (FEM) [page 240]) extension file. If appropriate you can, alternately, define the import in a DBMS or
language definition file (see Creating and Copying Resource Files [page 451]).

2. Create a new extension file in the list to contain your XML import definition (see Creating an Extension File
[page 453]).

3. Create an XML import definition in the extension file (see Customizing and Extending PowerDesigner >
Extension Files > XML Imports (Profile) ).
4. Save the extension file and test the import by selecting [ File » Import » <Import Name> 4.

5. [optional] Check the extension file into the repository library to have it automatically deployed to all users (see
Sharing Resource Files via the Library [page 588]).

1.4.6 Moving and Copying Objects

Objects in the PowerDesigner working environment are easy to manipulate and to reuse from one model or
package to another.

Drag and Drop

You can drag objects from one package or model to another to copy, or move them, or to create a shortcut or
replica. You can drag objects from the Browser, a diagram, an object list, or the Result List to the Browser or a
diagram. By default, you perform a move when the start or drop point is the Browser or create a shortcut when
dragging between diagrams. You can change this behavior temporarily, or set a different default.

To temporarily change the behavior; press and hold the following keys while dragging:

[shift]-Move

[cex1]- Copy

+ - Create shortcut (see Creating Shortcuts [page 487])
+ - Create replica (see Creating Replicas [page 492])

To obtain any behavior without modifier keys, right-click and drag and release to open a contextual menu listing
the available drop actions.

To modify the default Browser drag and drop behavior, select | Tools » General Options J and select the
appropriate Default action in the Browser drag & drop group box (see General Options [page 429]).
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Copy and Paste

You can copy objects from the Browser, a diagram, an object list, or the Result List and paste them into the
Browser, a diagram, or an object list. Symbols can be pasted as images into MS Word or image applications, while
lines from object lists or the Result List can be pasted in CSV format into Excel, Word, or other text editors.

1 Note

To create a graphical synonym of a symbol, which is merely a second instance of the object in the diagram to
improve readability or reduce link lengths, see Creating Graphical Synonyms for Object Symbols [page 219]

To copy one or more objects, select them, and then:

e Select|p Edit » Copy J from the menu bar.

° Press + .

e Right-click and select |+ Edit » Copy 2.

Click in the place where you want to paste the object and then:

e Select|p Edit » Paste Jfrom the menu bar.

° Press + .

e Right-click and select |+ Edit » Paste 3.

e [to paste as a shortcut] Select | Edit  Paste As Shortcut 3 from the PowerDesigner menu bar, or right-click

and select | Edit » Paste As Shortcut 3. For more information, including the rules governing the creation of
shortcuts, see Shortcuts and Replicas [page 484].

When you copy an object, you also copy its child objects, and any references to other objects. For example, if you
copy a CDM entity, you also copy its attributes and any references to business rules attached to that entity. When
you paste an object, you transfer all of its properties from the Clipboard and create a new object, and not a
graphical synonym or a new instance of the copied object.

When you paste in PowerDesigner, the creation of the object must not violate name uniqueness rules (see Object
Namespaces [page 118]). If an object with the same name and code already exists in the model or package,
PowerDesigner will append a number to the name and code, and display a message in the Output pane to warn you
that the object was renamed.

1 Note

When a paste conflict occurs on a CDM entity, the copied entity is given a new name and code and, if the Allow
Reuse model option is not selected, new attributes will be created, with the same names as those being copied.
If the Unique Code model option is not selected, the codes because they are in the context of the new entity) a
new identifier is created (which will have the same name according to the data item options set in the model.

1.4.6.1 Moving Objects from One Package to Another

You can move objects from one package to another by drag and drop or cut and paste. Moving an object does not
involve copying it, but a shortcut will be created in the original model or package, which points to the object's new
location. You can only move an object to a model that supports this kind of object, and global objects (such as
business rules, domains, storages etc.) cannot be moved into packages.
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Context

When you move an object from a package to another, linking objects that you move keep their links in the target
package and a shortcut is usually created in the source package. The general rule being that conceptual modeling
must be preserved.

When you move an object with a non-oriented link:

Entity_1 Entity 2

Source package Target Package
A shortcut of the moved entity is created: The moved entity is displayed:
Entity_1 Entity 2 Entity_2
0.n a,1
— e
Ll
When you move an object with an oriented link:
TABLE_Z TABLE_1

[————————
Move Table Source Package Target Package
Parent TABLE 2 A shortcut of the parent TABLE_ 2 is created: The parent TABLE_ 2 is displayed:

TABLE_Z TABLE_A TABLE_Z
e
A
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Move Table Source Package Target Package
Child TABLE_1 Only the parent TABLE_ 2 is displayed: The child TABLE 1 is displayed with the refer-
ence link and a shortcut is created for the parent
TABLE = TABLE 2.
TABELE_Z TABLE_1
ong—————
2l

When moving CDM entities containing data items, the data items will be moved to the new package or model with
the entity unless they are reused by other entities, in which case copies will be made.

For more information about shortcut and copy rules, see Creating Shortcuts [page 487].

1.4.7 Deleting Objects

You can delete an object from a diagram, the Browser, or an object list.

Since PowerDesigner gives you the freedom to create multiple symbols in multiple diagrams to represent the same
object, when deleting a symbol in a diagram, you can choose to delete just the symbol or the entire object.

When you delete an object, you also delete any sub-objects it contains (for example, when you delete a table from
a PDM, you delete its columns, keys, triggers and indexes), along with all its diagram symbols. If you delete an
object that is connected to another object via a link, the link is also deleted.

To delete an object, do one of the following:

e Select its symbol in a diagram and press the key or right click it and select | Edit j Delete 3. A dialog will
open asking you whether you want to delete the object itself (including any sub-objects it contains) or just the
symbol:

How do you want to delete the selected sypmbols?

() Delete symboalz anly

Impact... Cancel
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You can review the impact that deleting the object would have on other objects in your environment by clicking
the Impact button on the confirmation dialogs (see Impact and Lineage Analysis [page 529]). You can undo a
deletion by clicking the Undo tool.
Make your choice and click OK. If you delete only the symbol, you can restore it to the diagram, by selecting
| Symbol » Show Symbols 3 and reselecting the object in the Show Symbols dialog.

e Selectits symbolin a diagram and press + |pel| The object, any sub-objects it contains, and any
associated diagram symbols will be deleted immediately without the need for confirmation.

e Selectitin the Browser and press the key or right click it and select | Edit » Delete 3. A dialog will open
asking you to confirm the deletion:

@ Do you want bo delete the selectad item?

Impact...

Click OK to delete the object, any sub-objects it contains, and any associated diagram symbols.
e Selectitinan object list and click the Delete tool or press the key. The object, any sub-objects it contains,
and any associated diagram symbols will be deleted immediately without the need for confirmation.

1 Note

You can suppress the display of the Confirmation dialogs by deselecting the Confirm Object Deletion general
option (see General Options [page 429]).

Deleting Domains and Data Items

If you have specified that domains and data items can be reused by multiple objects in a CDM or PDM and you
delete a parent object to which they belong, these sub-objects will not be deleted with their parent. For more
information, see Data Architecture .

1.4.8 Object Properties

All model objects created in PowerDesigner have property sheets, which organize object properties on tabs.
You can open an object property sheet in any of the following ways:

e |nthe Browser, double-click the object symbol or its entry.
® Right-click the object symbol or its Browser entry, and select Properties.
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e Select the object from an object list or in the property sheet of its parent object, and click the Properties tool.
® Select an object symbol and press + [Enter]

Property sheets let you assign extensive and sophisticated properties to objects. Most PowerDesigner objects
have the following tabs and properties, but many others, specific to the particular object type, may be available:

® General — provides basic information about the object. Almost all objects have these properties:

o Name - clearly identifies the object. By default, names can have up to 254 characters, and can include
uppercase, lowercase, and mixed-case strings. Names are controlled by naming conventions (see Naming
Conventions [page 155]) and must be unique within a namespace (see Object Namespaces [page 118]).

If the enterprise glossary is enabled in the model, then autocompletion and glossary compliance checking
is available (see The Glossary [page 39]).

o Code —is used in scripts generated from the model. Codes are controlled by naming conventions and
must be unique within a namespace. By default, codes are synchronized with names, but you can
decouple them individually by clicking to deselect the equal sign button to the right of this field or in the
model as a whole by unselecting the Synchronize code model option (see Naming Conventions [page
155)).

o Comment — provides a more detailed description of the object.

o Stereotype - extends the semantics of the object. You can enter a stereotype directly in this field, or add
stereotypes to the list by specifying them in an extension file.

o Keywords - Provide a way of loosely grouping objects through tagging. Separate multiple keywords with
commas. You can use keywords as criteria for finding objects (see Finding Objects [page 134]), and in
impact and lineage analysis (see Impact and Lineage Analysis [page 529]).

Property sheets of link objects display a picture of the link together with its extremities. Additional information,
such as the cardinality value and the role, may also appear.

e Definition — Provides fuller information about the object. See Definition Tab [page 112].

® Rules - lists the business rules with which the object must comply. A business rule may be a government-
imposed law, a customer requirement, or an internal guideline. See Business Rules [page 139].

e \ersion Info - provides details about the object owner, creation, and modification date and allows you to access
help for the PowerDesigner metamodel metaclass on which the object is based. See Version Info Tab [page
116]

® Dependencies - lists all the objects that depend on the object. See Dependencies Tab [page 116]

e Traceability Links - lists all the objects on which the object depends. See Traceability Links [page 146]

® Requirements — lists the project requirements that the object is intended to satisfy. By default, this tab does
not appear. See Requirements Tab [page 115]

1 Note

Use|ctrl| + [Page Down|or|ctrl]| + |Page Up|to move tothe next or to the previous tab and display the
corresponding object type tab.

By default, property sheets open to the General tab. You can choose to open property sheets at the last

accessed tab by selecting [ Tools » General Options » Dialog 3, and selecting Keep Last Tab in the Property
Sheets groupbox.

You can customize, create, and hide properties and property sheet tabs using extension files (see Customizing and
Extending PowerDesigner > Extension Files ). Administrators can prepare customized property sheets through
permission profiles (see Customizing the PowerDesigner Interface [page 591)).
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You can control the form of the symbols, the background color, and the text format with display preferences (see
Display Preferences [page 227]). For display preferences to be applied to the mini-diagrams in link object property
sheets, click Set As Default in the Display Preferences dialog for each modification.

1.48.1 Customizing a Property Sheet

Since PowerDesigner can hold a rich variety of information about your model objects, property sheets can become
overloaded. The More or Less button at the bottom left corner of the property sheet allows you to toggle between
displaying all the available property sheet tabs, and a subset of "favorite" tabs.

You can customize your list of favorite tabs, and access various other property sheet features, from the property
sheet menu, which is accessible from the bottom-left corner of all property sheets.

Command Description
Find in Diagram Finds the object in the diagram, selects it, and centers the diagram on it.
Find in Browser Finds the object in the Browser and highlights it.

Impact and Lineage Analysis | Opens the Impact and Lineage Analysis dialog (see Impact and Lineage Analysis [page 529]).

Parent Properties Opens the property sheet of the parent object.

New Attribute Opens the New Attribute dialog, which lets you add new properties to your object property
sheets (see Adding a New Attribute to an Object [page 168]).

New List of Associated Ob- | Opens the New List dialog, which lets you add new lists of associated objects to your object
jects property sheets (see Adding a New Collection to an Object [page 171]).

Manage Object Extensions Opens the Manage Object Extensions dialog, which lets you access the metaclass on which the
object is based in the Resource Editor (see Managing Extensions [page 174]).

Find in Metamodel Objects | Opens the MetaModel Objects Help for the metaclass on which the object is based.
Help

Customize Current Tab Opens a dialog to change the properties displayed in the current tab (see Customizing an Object
Property Sheet Tab [page 173]).
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Command

Customize Favorite Tabs

Description

Opens a sub-menu, which allows you to define favorite tabs:

e Help - opens this help topic.

e Display All Tabs - Displays all available property tabs for the current property sheet.
e Display Favorite Tabs for All - Displays favorite tabs for all property sheets throughout all

models.

e Display All Tabs for All - Displays all tabs for all property sheets in all models.

Beneath the sub-menu are listed all the tabs available for the present object. Favorite tabs have
a check against them. Click a tab in the list to select or remove it from the list of favorite tabs.

Note that the General tab cannot be unchecked.

When you check or uncheck a tab such as Definition, Rules, and Dependencies, which are com-
mon to many objects, you are asked to confirm the change for all other objects. If you click No,

only the current property sheet is modified.

In the following example, only the General and Definition tabs are selected and are displayed:
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:'. Person Properties - James Jackson (James_lackson)

=3 HOR =

8
(-]

JEEE

v ol 3] ]

Name: James Jackson
Code: James_Jackson
Comment:

Stereotype:

Manager: [i‘. <None>
Site: [ <Monez
Job title:

Telephone:

Email:

Keywords:

Customize Current Tab...

Customize Favorite Tabs

Moe s> [ =y oK || cancel
Find in Diagram Ctrl+Shift+F
Find in Browser Ctrl+Shift+B
Impact and Lineage Analysis... Ctrl+F11
Parent Properties... Ctrl+Shift+P
Mew Attribute...
Mew List of Associated Objects...
Manage Object Extensions...
Find in Metamodel Objects Help... Ctrl+F1

Help...

Display All Tabs

Display Favorite Tabs for All
Display All Tabs for All

General

Roles

Definition

Rules

Related Diagrams
Dependencies
Traceability Links

Yersion Info

Ctrl+Shift+ A&

Any changes in the display of tabs are immediately applied to the current property sheet but not to other property

sheets that are currently open. The changes become the default setting for any property sheet of the same type.

1 Note

You can control whether tabs display on one or several rows in property sheets by selectinglr Tools » General

Options ¥ Dialog 3 and using the options available in the Property sheets groupbox (see Dialog Box Options

[page 431]).
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1.4.8.2 Definition Tab

The Definition tab in an object property sheet can be used to provide detailed documentation about the object.

e Description - Provides detailed information about the object. For example, a description of the Employee entity
might read: This entity has one occurrence for each employee in our worldwide operations. This base should
grow by 20 percent by 2020.

® Annotation - Provides information about the implementation of a model or the objects it contains. For
example, an annotation of the Employee entity might read: Verify list of attributes with Director of Human
Resources.

Both fields can be edited directly in the tab with the internal PowerDesigner RTF editor and you can insert existing
text and RTF files into them (see Text Editor Tools [page 225]).
1 Note

To verify that all objects have a description, open the appropriate object list (Object Lists [page 118]) and review
the Description column. For information about adding columns to a list, see Customizing Object List Columns
and Filtering Lists [page 124].

1.4.8.3 Preview Tab

Click the Preview tab in the property sheet of the model, packages, and various other model objects in order to
view the code that will be generated for it.

The following tools are available on the Preview tab toolbar:
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Tools

=M

Description

Editor Menu ((shift] + [F11])- Contains the following commands:

® New ( + ) - Reinitializes the field by removing all the existing content.

e  Open... ( + |§|) - Replaces the content of the field with the content of the selected file.

® Insert... ( + ) - Inserts the content of the selected file at the cursor.

e Save ( + ) - Saves the content of the field to the specified file.

e Save As... - Saves the content of the field to a new file.

e Select All ( + ) - Selects all the content of the field.

e find... ( + ) - Opens a dialog to search for text in the field.

e Find Next... () - Finds the next occurence of the searched for text.

® Find Previous... ( + ) - Finds the previous occurence of the searched for text.

* Replace... (ctr1] + [H])- Opens a dialog to replace text in the field.

e GoToline... ( + ) - Opens a dialog to go to the specified line.

e Toggle Bookmark ( + ) - Inserts or removes a bookmark (a blue box) at the cursor position.
Note that bookmarks are not printable and are lost if you refresh the tab, or use the Show Generation
Options tool

® Next Bookmark () - Jumps to the next bookmark.

® Previous Bookmark ( + ) - Jumps to the previous bookmark.

Edit With (ctr1] + [£]) - [0OM only] Opens the previewed code in an external editor. Click the down arrow
to select a particular editor or Choose Program to specify a new editor. Editors specified here are added to

the list of editors available at [ Tools * General Options  Editors 3.

L]

Save ( + ) - Saves the content of the field to the specified file.

Print ( + |E|) - Prints the content of the field.

EIY

Find ( + ) - Opens a dialog to search for text.

=
v
0

Cut ( + ), Copy ( + ), and Paste ( + ) - Perform the standard clipboard ac-

tions.

Undo ( + ) and Redo ( + ) - Move backward or forward through edits.

Refresh () - Refreshes the Preview tab.

You can debug the GTL templates that generate the code shown in the Preview tab. To do so, open the target
or extension resource file, select the Enable Trace Mode option, and click OK to return to your model. You
may need to click the Refresh tool to display the templates.

Select Generation Targets ( + ) - Lets you select additional generation targets (defined in exten-
sions), and adds a sub-tab for each selected target. For information about generation targets, see Customiz-
ing and Extending PowerDesigner > Extension Files > Generated Files (Profile) > Generating Your Files in a
Standard or Extended Generation .
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Tools Description

|E| Show Generation Options ( + ) - Opens the Generation Options dialog, allowing you to modify the
o generation options and to see the impact on the code.

Ignore Generation Options ( + @) - [PDM only] Ignores changes to the generation options made
|E | with the Show Generation Options tool.

1.4.8.3.1 Finding Text Using Regular Expressions

You can use regular expressions to find script text displayed in the Preview or Script tab of a table property sheet,
as well as in the Edit/Run Script editor, the Resource Editor, and various other windows.

In order to be able to search for text using regular expressions, you must select the Regular Expression check box
in the dialog box and enter a regular expression in the Find What box.

Regular expressions can contain ordinary characters and the following metacharacters:

Character Description
\ Matches a special character
Examples:

"n" matches "n". "\n" matches a newline character. "\\" matches "\" and "\(" matches "("

N Matches the position at the beginning of the input string
Examples:

"AWin" matches strings beginning with "Win

$ Matches the position at the end of the input string
Examples:

"then$" matches strings ending with "then"

* Matches the preceding character zero or more times
Examples:

"zo*" matches "z" and "zoo"

+ Matches the preceding character one or more times
Examples:

"zo+" matches "zo" and "zoo", but not "z"
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Character Description
? Matches the preceding character zero or one time
Examples:
"to?" matches either "t" or "to"
Matches any single character except the newline \n
Examples:
".ork" matches "Work", "Fork" etc
[1] Matches any one of the enclosed character
Examples:
"[abc]" matches "a", "b", or "c" A range of character can be indicated with a dash "[a-z]"

For a complete list of metacharacters and their behavior in regular expressions, see the Visual Basic
Documentation.

1484 Requirements Tab

You can attach one or more requirements to an object using the Requirements tab in the object property sheet.
This tab is not displayed by default, and can only be used if one or more requirements models is open in the
workspace.

Context

1 Note

To display the Requirements tab, select |F Tools » Model Options Jand select the Enable links to requirements
option.

Procedure

1. Open the object's property sheet and click the Requirements tab.

2. Click the Add Objects tool to open a selection dialog.

3. Select a Requirements model and, optionally, a package to display a list of the requirements contained therein.
4. Select the requirements that you want to attach to the object and click OK.

The selected requirements appear in the Requirements tab.
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5. [optional] Select the requirement in the list and click the Properties tool to open its shortcut property sheet. To
open the property sheet of the requirement itself, click the Target Object Properties button to the right of the
Name field.

1 Note

To access the property sheet of the requirement directly instead of passing by the shortcut, select |+ Tools
» General Options ¥ Dialog , and select the Target Object radio button beside the External Shortcut option.

6. Click OK to close the property sheet and return to the model.

1.4.8.5 Version Info Tab

PowerDesigner automatically manages version information about model objects on the read-only Version Info tab
of the object's property sheet.

Property Description

Creation User Specifies the name of the User who created the object.

Creation Date Specifies the date of creation of the object

Last Modification User Specifies the Name of the user who made the last modification to the object.

Last Modification Date Specifies the date of the last modification of the object

Replicated From [replicated objects only]Specifies the name of the origin object from which the object was re-
plicated.
Click the button to the right of this field to open the origin object property sheet

Generated From [generated objects only]Specifies the name of the origin object from which the object was gen-
erated.
Click the button to the right of this field to open the origin object property sheet

1 Note

In addition to the standard help accessible via FI or by clicking the Help button, you can obtain information
about the PowerDesigner metamodel metaclass on which this object is based by clicking the small question
mark button at the bottom right of the tab.

1486 Dependencies Tab

The PowerDesigner metamodel provides the capability to link objects to other objects in a variety of semantic
ways. For example, when you create an external shortcut, or when you attach a business rule to an object, a

Core Features Guide
116 PUBLIC Modeling with PowerDesigner



dependency link is created between models or objects. The Dependencies tab of the object's property sheet

displays these links.

Context

Dependencies can be:

e |nternal - to other objects within the model. These dependencies are saved in the model and are always
available on the Dependencies tab of an object property sheet

e [External - to objects in other models via shortcuts or generation links (see Creating Links Between Models
[page 463]). These dependencies are available on this tab only if the linked model is open in your workspace,
or if you have checked both models into the repository and have checked your model out with the Check out

dependencies option (see Checkout Parameters [page 269]).

B Table Properties - Employee (EMPLOYEE) M=l

General I Coalurnnz I |ndexes I Kenz I Trigaers I Procedures | Phuzical Options |
Sybasze I MHates I Rules Presiew Dependencies
iﬁ“ Ee V} Impact and Lineage Analysis... |
M ame | Code | Child T able | Farent T able | Farent | todel
%n |lzed ISED |lzed Employes Physzical Data ... Project M
Qc. |z respon.. |S5_RESPO.. Project Employes Phwsgical Data ... Project M
%n Chief CHIEF Ermployes Ermployes Phyzical Data k... Project M
%:. b ernbier FMERMEER b ernbier Employes Phyzical Data k... Project M
%:, Workz on WORKS_OM  Participate Employes Phyzical Data ... Project M

F

L r\lncnming References ,{Outgcuing References ADiagrams ,J'

More >3 | = - Ok, I

Cancel | Smply |

Help |
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1.4.8.7 Object Namespaces

In PowerDesigner, each package can be a namespace. It is however possible to expand the namespace to the
parent of a given package. You can cascade the expansion until you reach the level of the model itself.

Objects that appear in the Browser obey the general rules that follow:

In Browser Namespace Uniqueness rule

Objects directly under a package or a model (table, | Model Unique name and code in model

process, class)

Package Unique name and code in package

Objects under parent object (column, attribute) Not applicable Unique name and code in parent

Linking objects (reference, relationship) Not applicable Unique name and code between same end ob-
jects (i.e., parallel links with same name and
code are not allowed between same end ob-
jects)

However, you may encounter some exceptions to those rules. For example only the code of a reference allows to
identify the object in the entire model, when the "Unique code" option is selected in the Model Options dialog box.
PowerDesigner warns you when a general rule is not respected.

1.4.9 Object Lists

PowerDesigner object lists provide a spreadsheet-like interface for manipulating large quantities of objects. They
offer you an overview of the objects in your model and can save you time and effort in managing your metadata.
While property sheets provide depth of detail for individual objects, lists allow you to select and manipulate
multiple objects simultaneously to streamline creation and improve consistency.

Lists of all the major objects in your model are available under the Model menu or by right-clicking your model in

the Browser and selecting |# List of <objects> 4. Each list shows all the objects of that type in the currently
selected package or model, including those that do not have symbols in the current diagram:
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B List of Tables
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15, @ | = 3 -

=10l x|

I ame Code |G~ Qwarner *| Mumber ] =
= | [ = COMPOSE F i<Mones
2 Custormer CUSTOMER [ <Mone:
3 Divizion DIVISION [ | <Mones:
4 Employes EMPLOYEE [ | <Mones:
] hd aterial MATERIAL [ <Mone:
E Member MEMBER [ i <Mone:
f Participate PARTICIFATE v i <Mone:
8 Fraoject PROJECT [ <Mores
3 Task T&SE [ <Mores
10 T eanm TEAM v <Mone> =
11 Used USED v <Mone> =
1| >

ak. I Cancel Smply | Help |

The properties of the listed objects are organized in columns. You can order the list by a particular columns values
by clicking on its column header. To filter the values in a column, click the down-arrow on the right of the column
header and enter your filter (see Filtering a List Using In-Column Filters [page 122]).

You can control which property columns are displayed, and also filter the list based on the values in any of the
columns (see Customizing Object List Columns and Filtering Lists [page 124]).

You can select multiple items in a list by -cIicking them in the far-left, numbered column. To select all the
items in a list, click the top-left corner box. When multiple items are selected, any edits you make to properties are
applied to all the selected items.

1 Note

By default, you must click the Apply button to commit changes or the OK button to commit and close the list. To
have changes commited immediately when you enter them in a field, enable the Auto commit general option
(see Dialog Box Options [page 431]). You can always use the Undo tool to cancel the change.

All or some of the following tools are available on object lists:

Tool Description

|§| Properties - Opens the property sheet of the selected item (see Object Properties [page 107]).

|@| Insert a Row - [ordered lists only] Inserts a row before the selected row in the list.

|E| Add a Row - Adds a row at the end of the list.

|E| Add Objects - Opens an object selection dialog box to select objects and copy them to the list (see Adding an
o Item from a Selection List [page 130]).
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Tool Description
|E| Create Object - Creates a new object and opens its property sheet to allow you to complete its definition.
|E| Reuse/Replicate Objects - Opens an object selection dialog box to reuse objects. When you select an item you

create a link to the original instead of copying it to the list.

|£| Cut - Cuts the row and stores it in the Clipboard.

|§| Copy - Copies the selected row to the Clipboard.

|El Paste - Pastes the contents of the Clipboard.

|Z| Delete - Deletes the row.

|E| Find a Row - Opens the Find dialog to search for an item in the list.

|@| Find Symbol in Diagram - Finds the object's symbol in the diagram.

|§| Customize Columns and Filter - Opens a dialog to change the columns displayed in the list or define a filter (see

Customizing Object List Columns and Filtering Lists [page 1241]).

|E Enable/Disable Filter - Toggles the filter specified in the Customize Columns and Filter dialog.

|El Include Sub-Packages - Includes objects in sub-packages in the list.

|E| Include Composite Objects - Includes composite objects (such as sub-processes, sub-activities, sub states, etc.)
o in the list.

|@ Include Shortcuts - Includes object shortcuts (see Creating Shortcuts [page 487]) in the list. Shortcuts are

grayed as they cannot be modified. When you include shortcuts whose target model is closed, some information
may be unavailable.

|| Open Diagrams - [Related Diagrams tab] Opens a target model or a diagram (see Specifying Diagrams as Related

o Diagrams [page 1897).

|@| Shortcut - Opens an object selection list to change the target object of a shortcut

|| Export to Excel - Saves the list to a *xIs, *xIsx, or *csv format (specify the format in the Save as type field in the
Save as dialog).

|l§| v| Print - Prints the list. Click the arrow to the right of the button to view a print preview or to access the Page Setup
dialog.
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Sub-Object Lists

Many objects have property sheets that contain sub-object lists, which list all of the child objects of that type

belonging to the object. For example, the Columns tab in a table property sheet displays the list of columns in the

selected table:

& Table Properties - Customer {CUSTOMER) . — | Ellil
Script I Phyzical Optionz I b apping I Permizzions I Sybasze I Motez I Rulez
Felated Diagrams | Preview Dependencies I Estended Dependencies I Yerzion [nfo
General Calurmnz |ndexes I Keyps I Triggers I Procedures I Check
F| AT A B X AR EHS -

M amne Code Data Twpe | Length | Precision] P | =)
1 CUSMUM numeric(a) (6 Wil
2 CISMNARE char[30] an m
3 Customer address CUSADDR char[30] a0 T
4 Custorner activity CUSACT char(20) a0 i
5 Customner telephare CUSTEL char(12) 12 m
E Custorner Fax CLUISFAX char[12] 12 [ [
kIR RAETEARY | 2
<< Less | ;§|' - 0k, I Cancel Apply | Help |

These lists provide the same features as the lists of objects available from the Model menu. Depending on the

properties of the listed objects, the list may have a natural order that you can control. For example, a list of
columns has such an order, and you can move objects in the list by selecting them and then clicking on one of the
arrows at the bottom left corner of the list.
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1.491 Filtering a List Using In-Column Filters
To filter a list by the values in a column, click the down arrow on the right of the column header to display the in-

column filter dialog.

Context

1 Note

If the in-column filter arrows are not displayed, click the Customize Columns and Filter tool and select the Show
column filter buttons option.

Procedure

1. Select an operator from the first list and, if appropriate, select or enter an expression value to test against it. In
this example, the list will be filtered to show only rows where the Name column contains values beginning with
Cust*.

E= List of Columns i _ O] x|
B4 @B XA DS | ES-
I I ame 4|: Code = | Table = | Comm ~jDataT | Lengt = |Precisi = P <] =
1 CUSACT char[80] :80 -
2 |= j CUSADD char[80] :80 ]
3 -1 |CUSFAX char(12] 12 ]
4 [Cust = s char[30] 730 ~
5 “ Clear Column Filker CUSHUM numenc(5i 5 H|
& CUSMLM rurmenc]5 5 [
— ] I C I : i
7 ancel | | et char12) 12
a Divizgion addresz DivADD char[30] (80 [
9 Divizion name DY M AR char[30] 30 ]
10 Drivizion Aumber DM LIR numenc(5: 5
11 Drivizion number (1% ] nuamenc[Di 5
12 Emp_Employes number  (EMP_EM numenc[5: 5
"l‘ | Y PR FRP R ikl =l = an I
k. Cancel | F¥um 1 | Help

For an explanation of the available operators and the syntax for the expressions, see Defining a Filter
Expression [page 128].

2. When you are satisfied with your criteria, click OK to apply the filter. The down arrow is overlaid with a filter
symbol to show that a filter is applied, and any rows not meeting the criteria are hidden. In addition, to Enable/
Disable Filter button is pressed. In this example, the Name=Cust* filter is applied:
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EE List of Columns

A % G2 @ X |88 | 0|

g, | = S -

I ame 4 T| Code = | Table = | Comm ~|DataT = |Lengt ~ |Precisi | F = | =]
1 Customer activity CUSACT char[30] (80 I
2 Cusztomer address CUSADD char[230] 80 [
3 Cuztomer fax CUSFax char12] 12 [
4 Cuztomer name CUSHAM char(30] 30 [
] Custarner nurber CUSMIIK numenc[5: 5 [
G Customer nurmber CLSMIR numenic(5: 5 [V
fi Customer kelephone CUSTEL char[12] 12 [

< | o

k. I Cancel | Lpply | Help |

3. [optional] Further restrict the rows displayed by defining a filter on any number of other columns. In this
example, both the Name=Cust* filter and a Length<80 filter are applied:

E= List of Columns _ O] x|

N IEEN A AT A S

Mame 4 T|Code v | Table | Comm ¥ |DataT ¥ fLengt ¥ |Precisiv|P v | =
3 Custorner fam CLSFA char[12] 12 |
4 Customer name CLISMAk char[30] 30 [
3] Customer number CUSHUM rumencDi 5 [
B Cuzstomer number CUSHUM numernc[5:h [V
7 Cuztomer telephone CUSTEL char12] 12 [
4| | 3

k. I Cancel | Apply | Help |
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1 Note

The filter criteria are stored in the Customize Columns and Filter dialog and remain applied until you remove
them. To remove all filters, click to release the Enable/Disable Filter. To remove a filter from a single column,
click the filter button in the column header, and then click the Clear Column Filter button.

1.4.9.2 Customizing Object List Columns and Filtering Lists

You can choose which property columns to display in object lists, reorder them, and filter the rows to be displayed
from the Customize Columns and Filter dialog.

Procedure

1. Click the Customize Columns and Filter tool on an object list toolbar to open the Customize Columns and Filter
dialog.

2. Perform any of the following functions to filter the list:

o Select columns to display - by checking the [Dlisplay column checkbox.

o Reorder the columns in the list - by using the arrows at the bottom left of the dialog. To move all the
selected rows to the top of the list, press|shift| + [Enter|.

o Define one or more filter expressions - by selecting an operator in the Operator column and entering an
expression to filter by in the Expression column.

Customize Columns and Filter | =] |

-

Column Heading Operator E xprezzion
M amne = Cust”
Code
Farent
Dizplay M ame
Object Type
Creation Date
Creatar
Maodification Date
kd addifier
Dverall Modifization Date

[ Clazs Mame
(a4 RARd B IEIRN

v Show column filker buttons k. I Cancel Help

[ =

1711111 e

The [U]sed checkbox is automatically selected when you enter a filter expression. To disable the
expression but keep it in memory, clear the checkbox.

o Enable or disable in-column filtering directly in the list (see Filtering a List Using In-Column Filters [page
1227) by selecting the Show column filter buttons option.
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3. Click OK to return to the list. The filter is applied by default, and the Enable/Disable filter tool is depressed.
Click this tool to toggle between enabling and disabling the filter.

1.4.9.2.1 Customizing Columns in Lists Containing Multiple
Types of Objects

PowerDesigner supports lists containing multiple types of objects. As each type of object has different sets of
properties, by default only properties common to all the object types are available for selection to display in the
list. However, you can customize display properties specific to one or more object types by using the Add Attribute
button at the bottom of the Customize Columns and Filter dialog.

Customize Columns and Filter -0l x|

F

Column Heading [ perator E wprezzion

Mame

Object Type
Dizplay Mame
Creation D ate
Creatar
Fodifization Date
b odifier

Dverall kModification Date
Clazz Mame
Farent Folder
Short Description
Object Location

akARARdE TEIEN! |

¥ Show column filter buttans

Add attril:uutel ok | concel | Hep

17111 <slo

1 Note

The Add Attribute button is only available when the list can contain multiple types of objects.

The button opens a dialog that lets you select any attribute for any object that is available in this context:
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When you select an attribute and click OK, it is added to the list in the Customize Columns and Filter dialog and all
instances of the attribute (if it is available for multiple objects) are removed from the Add Attribute dialog. You can
add as many attributes as necessary and apply filters on them as appropriate.

1 Note

If you deselect an attribute in the Customize Columns and Filter dialog and click OK, it will be removed from the
list of properties available for display. If you change your mind and want to display it once again, you will need to
re-add it with the Add Attributes button.

For example, an area can contain many different types of objects, and these are listed on the Attached Objects tab
of its property sheet. Here, I've added the following attributes:

® Application::Type - though | selected the Type attribute for the Application metaclass, the Type attribute
present in any other metaclasses available in this context will be displayed too.
® Database: :DBMS

® Database: :DBMS Version
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1.4.9.3 Defining a Filter Expression

You can define expressions to filter PowerDesigner lists directly in the list with the in-column filters or through the
Customize Columns and Filter dialog.

The following operators are available

Operator ’ Finds items that are...

= [default] Equal to the expression.

> Greater than the expression.

>= Greater than or equal to the expression.

< Less than the expression.

<= Less than or equal to the expression.

Not Equal Different from the expression.

In List Within the comma-separated list of values given in the expression (or the items selected in the list in the
in-column filter). For example: "global", "Architecture", "proc*"

Not In List Outside the comma-separated list of values given in the expression (or the items selected in the list in the
in-column filter).

Between Located in the range between defined by the two values given in the expression and separated by a
comma. For example, to find values between A and E, enter'A | E

Not Between Located outside the range defined by the two values given in the expression and separated by a comma.
For example, to find values outside of the range between A and E, enter:A ,E

Empty Null. No expression is necessary with this operator.

Not Empty Not null. No expression is necessary with this operator.

You can use the following wildcards when entering a filter expression:

Wildcard Description

* Any string (from none to any number of characters). For example P* finds "protocol" and "Paris".
? Any character. For example ????? finds "Table" and "inner" but not "Seller".

\ Escapes the special characters *, ?, and \. For example, \?\\ finds "?\".
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Examples

The following examples show some possible combinations of operators and expressions:

Operator Expression Find

= W Work, Washington

- *CODE AREA CODE, COUNTRY CODE, CITY CODE

g 122 200, 405, 609

Between 0,8 012345678

In List * emp ???, * grp ??? div_emp_fun, _emp_idn, div_grp_fun, _grp_idn
= *\? Is this book ready for production?

1494 Adding Items to and Reordering Items in a List

If alistis ordered you can choose to add an item at the end or at a certain point in the list, and you can reorder the
items in the list. When you add a new item to a list, it is created with a default name and code that you can edit.
Objects are not actually created until you click Apply or OK.

1 Note

In general, you are not required to provide any specific properties when you create an object. However, when
you create a link object, such as a reference, association link, or inheritance link, you must specify the source
and the destination.

Adding Items at the End or at a Particular Point in a List

The following tools are available for adding items to a list:

Tool ‘ Description

Add a Row - Adds an item to the end of the list. You can also add an item to the end of a list by clicking in any
empty row.

Insert a Row [ordered lists only] - Adds an item in the row above the selected row. You can always reorder items
in an ordered list by selecting and dragging and dropping them or by using the arrow tools at the bottom left of
the list.
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Arranging Iltems in an Ordered List

In ordered lists, you can drag and drop objects to reorder them, or use the following buttons at the bottom of the
list:

Tool Description

ﬂ Move the selected items to the top of the list.
ﬂ Move the selected items up one page

ll Move the selected items up one line

il Move the selected items down one line

_#J Move the selected items down one page

_#J Move the selected items to the bottom of the list

1.4.9.5 Adding an Item from a Selection List

Selection lists allow you to select items from a list in order to associate them with another object.

Most selection lists display objects contained in the current model or in individual packages contained in that
model. Other selection lists, such as the following, allow you to display both objects contained in the current model
and other models:

e Select Diagrams. From this dialog box you can select the diagram to which you want to apply pre-defined
display preferences.

e Add Shortcuts. From this dialog box you can select objects to include them as shortcut in your model or
package.

e Add Objects. From this dialog box you can select objects to which you want to attach traceability links.

The following tools are available in selection lists:

Tool Description

- Model list - Lets you specify a model as the basis for the list.

- Package list - Lets you specify a package as the basis for the list.

- Owner List - [PDMs only] Lets you specify a user as the basis for the list. The list will contain only objects
owned by the specified user or by no user. If you select User <NONE>, then all the objects are displayed.
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Description

Include Sub-Packages - Includes objects contained in sub-packages (Include Sub-Packages) in the list.

As this tool allows you to display all objects, regardless of their package, some objects in the list may have the
same name and be difficult to identify. In this situation, you can use the Customize Columns and Filter tool, to
display the Object Location column to identify where the objects are defined.

Include Composite-Objects - Includes composite objects, such as sub-process, sub-activity, sub state, in the
list

Include External Shortcuts - Includes shortcuts to objects in other models in the list. The model containing
the original objects must be open for external shortcuts to be available for selection. When generating, exter-
nal shortcuts are generated as ordinary objects.

Select All - Selects all the objects in the current object type tab. To select all check boxes in all object type
tabs, click the arrow and select All Lists or you can press the Ctrl key and click the Select All tool.

Deselect All - Deselects all the objects in the current object type tab. To clear all check boxes in all object type
tabs, click the arrow and select All Lists or press the Ctrl key and click the Deselect All tool.

i Use Graphical Selection - Selects only the objects currently selected in the diagram. To apply the graphical
selection in all object type tabs, press the Ctrl key and click the Use Graphical Selection tool.
Et Move Selected Items to Top - Moves all selected objects to the top of the list.
Hl Move Selected Items to Bottom - Moves all selected objects to the bottom of the list.
|7_5?| Customize Columns and Filter - Opens the Customize Columns and Filter dialog (see Customizing Object List
Columns and Filtering Lists [page 1241]), which allows you to define a filter expression to apply to the selec-
tion list.
|£| Enable/Disable Filter - Applies the filter defined in the Customize Columns and Filter dialog to restrict the list
of objects available for selection to those meeting its criteria. The currently defined filter is displayed in the
Filter box underneath the object list.
?E Use Filter for Selection - Applies the filter defined in the Customize Columns and Filter dialog to select all

objects meeting its criteria from the list. This selection by criteria is persistent for as long as the tool is ap-
plied.

Ctrl + selection
tool

Applies the action of the selection tool to all object types in the different tabs.

Saving Object Selections

In some selection lists, you can save sets of object selections in your model, so that you can reuse them easily. To
save a selection, enter a name in the Selection list at the bottom of the Selection tab then click the Save tool beside
the list. The selection is saved as part of the model file.
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1 Note

When reverse engineering from a live data source, object selections are saved into separate files, as you need
not have any model open in the Workspace (see Data Architecture > Building Data Models > Generating and
Reverse-Engineering Databases > Reverse Engineering a Database into a PDM > Database Reverse Engineering
Selection Window ). In this case, you must select a folder before being able to save the object selection.

Confirming Object Selections

In a selection list, the display of your object selection may be modified whenever you perform one of the following
actions:

e Change the folder selection using the Model or Package list

® Deselect the Include Sub-Packages/Sub-Objects tool

e Deselect the Include Shortcuts tool

e Apply afilter using the Enable Filter tool

e (Change the database or owner in the Reverse Engineering from a data source dialog box

In this case, some objects that have already been selected will no longer be displayed, and a dialog opens
prompting you to:

e Select only the objects displayed - Other objects that are no longer displayed are deselected.

e Keep the hidden objects in the selection — All the previously selected objects are retained, including those that
are no longer shown. This allows you to take into account object selections you have made in several packages
for example.

e Cancel - The commit of the selection list is canceled and the selection page now displays all objects and sub-
objects in the model to let you modify your selection if necessary.

If you confirm your selection by clicking OK, the confirmation dialog will not be displayed again, even if you again
modify your parameters.

1.4.9.6 Selecting an Object from a Selection Tree

Certain selection dialogs allow you to choose objects from a tree view or by searching by name.

The Browse tab allows you to choose an object from a tree view:
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Select an object
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] I Cancel Help

The Index tab lets you search for an object by entering all or part of its name (or code depending on the Display

Name/Code model option). Objects are sorted alphabetically in the list and dynamically update as you type. Select

an object and click the Properties button to view its property sheet:
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You can select an object on either tab and then click the other tab to retain the choice and view it in that context.
Double-click an object, or select it and click OK, to commit the selection and close the selection dialog.

1.4.10 Finding Objects

PowerDesigner lets you search for objects within all the models currently open in your workspace.

Context

1 Note

You can quickly find objects by name in the workspace by entering a string in the Filter field at the top of the
Browser Local tab (see The Browser [page 38]).
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Procedure

1. Select|p Edit » Find Objects J (or press + [F] to open the Find Objects dialog.
2. Specify the appropriate constraints on these tabs:
o Name and Location - to search on the name and location of PowerDesigner objects.
o User and Date - to search on the user and date of creation/modification of PowerDesigner objects.
o Advanced- to search on other criteria.
o Glossary - to search on keywords, terms, related terms, and synonyms.

For detailed information about these tabs, see Find Parameters [page 136].
3. Click Find Now.
1 Note
Once you have started the Find Objects process, you can stop it at any time by clicking the Stop button.

The Find Object dialog remains open, displaying messages in the Output pane, until the end of the process,
when the Result List displays the result:

.

Object Type Mame Code Loation

"W Calurmm Ermployes::Empl..  EMPLOYEE:E...  Project Management [POM]
T Column Employee:Emp_... EMPLOYEE:E...  Project Management [POM]
T Column Employee::Empl.. EMPLOYEE:E...  Project Management [PO]
T Column Employes;:Empl.. EMPLOYEE:E...  Project Management (PO

| T Column Project:Employve...  PROJECT::EMP... Project Management [POR]
T Column Participate:Empl...  PARTICIPATE:... Project Management [FOk]
T Column kember:Emplay...  MEMBER:EMP... Project Management [POM]
T Calurin Uzed:Emplopes... USED:EMPMUM  Project Management [POR]
Iy Fined A check Model /

Right-click an object in the list to find it in a diagram or the Browser, to open its property sheet or perform an
impact and lineage analysis on it.

The following operations are available by right-clicking an object in the Results List:
o Properties - to open the object's property sheet (see Object Properties [page 107]).
o Impact and Lineage Analysis - to analyze the object (see Impact and Lineage Analysis [page 529]).
o Find in Browser - to highlight the object in the Browser (see The Browser [page 38]).

o Find in Diagram - to open the diagram (see Diagrams [page 185]) with the symbol centered. If the object
has symbols in multiple diagrams, you see a list. If the object has no symbol, a warning message appears.

o Copy - to copy the object (seeMoving and Copying Objects [page 103]). Select a destination in the

Browser or a diagram and select |j» Edit » Paste 4 or ||» Edit » Paste as Shortcut

1 Note

For information about searching in the repository and PowerDesigner Portal, see Finding Objects in the
Repository [page 291] and PowerDesigner Portal Search [page 304].
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1.4.10.1 Find Parameters

The Find Objects dialog contains tabs that let you precisely specify your search criteria.

Name and Location Tab

The Name & Location tab provides basic search parameters:

Parameter Description

Look in Specifies the scope of the search. You can select the entire workspace, a project, folder, model, or
package.

Model type Specifies the type of PowerDesigner model to search. The options available in this list are affected by
your choice in the Look in field.

Object type Specifies the type of model objects to be searched. The options available in this list are affected by

your choice in the Model type field.

Include shortcuts

Instructs PowerDesigner to include object shortcuts that match your criteria in the results.

Name Specifies the object name to search for. You can use the following special characters:
® *-none toany number of characters. For example:
o W= finds "Work" and "Washington"
o *96 finds "01/11/96" and "26/08/96"
e ? —exactly one character. For example:
© * emp ?°?7?finds"Div_emp_idn" but not "Div_emp_ident"
e \ -escapes *, ?,or \.For example:
o \2\\ -finds ?\
e true/false - Boolean value (True is when the check box is selected)
Code Code of the object. You can type the exact code of the object or use a string expression.

Case sensitive

Specifies that the results must match the case of the criteria.
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User and Date Tab

The User & Date tab lets you constrain your search based on when and by whom the object was created and

modified:
Parameter Description
Created Enables searching on creation parameters. You can search against the name of the user who created
the object and against the creation date using the following options:
e Before the specified date
e After the specified date
e Between the two specified dates
® |nthe specified number of days since today
Modified Enables searching on modification parameters.
Advanced Tab

The Advanced tab allows you to specify additional search constraints for each property of the selected object type

in the following format:

Parameter Description

U (Used) Specifies a property on which to apply the search. Select this option for a property without entering
an expression to find objects for which the property is null.

Operator Specifies an operator to use for the search. Click in the Operator column to display the list of available
operators.

Expression Specifies a string expression to search for. For detailed information about the operators and the ex-
pression syntax, see Defining a Filter Expression [page 128].
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1 Note

If you do not select an object type on the Name & Location tab, then you can only search on the name and code
properties on this tab.

Glossary Tab

The Glossary tab allows you to search against any glossary objects (see The Glossary [page 39]) with which
objects may be associated:

Parameter Description

Search by Specifies the string that must be contained in the glossary object's name.

Search Range Specifies the glossary objects to search on. You can select one or more of Keywords and Terms [de-
fault] with which the object is related, and Related Terms and Synonyms that are associated with the
term (see Term Properties [page 42]).

Case sensitive Specifies that the results must match the case of the criteria.
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1.4.11 Business Rules

A business rule is a written statement specifying what a system must do or how it must be structured. Rules can
be derived from a government-imposed law, a customer requirement, or an internal guideline. You can attach rules
to your model objects to complement your diagrams with information that is not easily represented graphically.

For example, a rule stating that "An employee belongs to only one division." can help you graphically build the link
between an employee and a division. Rules often start as simple observations that develop, during the design
process, into more detailed expressions. You may, for example, develop rules to explicitly define what information a
customer supplies when placing an order, or how much a customer can spend based on a credit limit.

Rules can be developed from procedures that the system must respect, specifications dictating the scope of the
project, and external constraints. In the case of the PDM and OOM, you can generate business validation rules
attached to domains as check parameters.

Creating a Business Rule

You can create a business rule from the Model menu, from the Browser or from another object's property sheet:

e Select|r Model ¥ Business Rules 3to access the List of Business Rules, and click the Add a Row tool.

e Right-click the model or package in the Browser, and select [ New j Business Rule .
e Open the property sheet of the object to which you want to apply the rule, click the Rules tab, and click the
Create an Object tool.

Business Rule Properties

You can modify an object's properties from its property sheet. To open a business rule property sheet, double-click
its Browser entry in the Business Rules folder. The following sections detail the property sheet tabs that contain
the properties most commonly entered for business rules. The General tab contains the following properties:

Property Description

Name/Code/ Identify the object. The name should clearly convey the object's purpose to non-technical users, while
Comment the code, which is used for generating code or scripts, may be abbreviated, and should not normally
include spaces. You can optionally add a comment to provide more detailed information about the ob-
ject. By default the code is generated from the name by applying the naming conventions specified in
the model options. To decouple name-code synchronization, click to release the = button to the right of
the Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereotypes
to the list by specifying them in an extension file.
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Property Description

Type Specifies the nature of the business rule. You can choose between:

e (Constraint — a check constraint on a value. In a PDM, constraint business rules can be generated
in the database. For example, "The start date should be inferior to the end date of a project.”

e Definition — a property of the element in the system. For example; "A customer is a person identi-
fied by a name and an address".

® Fact — acertainty in the system. For example, "A client may place one or more orders".

e Formula — a calculation. For example, "The total order is the sum of all the order line costs".

e OCL constraint [OOM only] — An Object Constraint Language expression.

® Requirement — a functional specification. For example, "The model is designed so that total losses
do not exceed 10% of total sales".

e \Validation - a constraint on a value. For example, "The sum of all orders for a client must not be
greater than that client's allowance".

The following tabs are also available:

® [xpression - Though business rules typically start out as descriptions, as you develop your model and analyze
your business problem, you can enrich them by adding technical expressions on this tab. Expressions are used
primarily in CDMs and PDMs. Each rule can include two types of expression, which you define on the
appropriate sub-tab:
o Server
o Client

e OCL Constraint - This tab is only available for business rules with a type of OCL Constraint. Enter your OCL
expression in the text field using the Object Constraint Language / UML expression language.

1.4.11.1 Attaching a Business Rule to an Object

You can attach business rules to your objects on the Rules tab of the object's property sheet.

Procedure

1. Open the property sheet of an object, and then click the Rules tab:
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3. Select the business rules you want to add to the object, and then click OK to return to the object's property
sheet.

4. Click OK to close the object property sheet and return to the model.

1 Note

When you apply a business rule to an object, its U (Used) column in the List of Business Rules is
automatically checked. This column allows you to see what rules are unused, and delete them if necessary.

1.4.12 File Objects

You can embed any application file in your model or provide a link to it. For example you could include a detailed
description of your problematic by pointing to a text or Word file from your model. In an OOM, you could associate
aclass to a Java file. The file itself can be embedded in the model or referenced by it.

File objects can be simply included in the model or can be attached to other objects via traceability links.

To open afile in its associated editor, double-click its diagram symbol or browser entry.

1 Note

To change the associated editor, right-click the file object and select | Open With » Choose Program 3.

Creating a File Object

You can create a file object through drag and drop, or from the Toolbox, Browser, or Model menu:

® Drag a file from Windows Explorer and drop it in the diagram or Browser to automatically create a file object
pointing to the file in the filesystem.

® Use the File tool in the Toolbox.

e Select | Model ¥ Files Jto access the List of Files, and click the Add a Row tool.

e Right-click the model or package in the Browser, and select [ New » File J.
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File Object Properties

To view or edit a file object's properties, right-click its diagram symbol or Browser or list entry and select
Properties. The property sheet tabs and fields listed here are those available by default, before any customization
of the interface by you or an administrator. The General tab contains the following properties:

Property Description

Name/Code/ Identify the object. The name should clearly convey the object's purpose to non-technical users, while the

Comment code, which is used for generating code or scripts, may be abbreviated, and should not normally include
spaces. You can optionally add a comment to provide more detailed information about the object. By de-
fault the code is generated from the name by applying the naming conventions specified in the model op-
tions. To decouple name-code synchronization, click to release the = button to the right of the Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereotypes to
the list by specifying them in an extension file.

Location type Specifies the nature of the file object. You can choose from the following:

e Embedded file — the file is stored within the model and is saved when you save the model. If you sub-
sequently change the type to external, you will be warned that the existing contents will be lost.

e FExternal file — the file is stored in the Windows file system, and you must enter its path in the Location
field. If you subsequently change the type to embedded, you will be prompted to import the contents
of the file into the model.

® URL - the file is on the web and you must enter its URL in the Location field

Location Specifies the path or URL to the file.

Extension Specifies the extension of the file object. By default, the extension is set to txt.

Generate Specifies to generate the file object when you generate the model to another model.

Artifact Specifies that the file object is not a piece of documentation, but rather forms an integral part of the appli-
cation.
If an artifact has an extension that is defined in the Editors page in the General Options dialog linked to the
<internal> editor, a Contents tab is displayed in the artifact property sheet, which allows you to edit the
artifact file in the PowerDesigner text editor.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate them with
commas.

1.4.12.1 Attaching a File Object to a Model Object

You can attach file objects to other model objects via traceability links. Click the Link/Traceability Link tool in the
toolbox to draw a link from the object symbol to the file object symbol.

Alternatively, you can right-click an object symbol in the diagram and select | Edit  File ¥ Add File 3, or use the
Add Objects tool on the Traceability Links tab of the object property sheet (see Traceability Links [page 146]).
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The connection between the object and the file object can be seen:

e Asatraceability link in a diagram (if both the file and the object have symbols in the diagram):

Sample Quarterly
Quarterly Report Report

e Onthe Dependencies tab of the file object's property sheet.
e Onthe Traceability Links tab of the object's property sheet.

e By right-clicking the object symbol and selecting [F Edit ¥ File  <filename> 4.

1.4.13 Packages

Packages can be used to organize your model into different tasks and subject areas, and to assign parts of it to
different development teams. Each package has a default diagram, and you can add further diagrams, model
objects, and sub-packages. You can create as many packages as you need in a model and decompose a package
into other packages, and so on.

Property Description

Name/Code/ Identify the object. The name should clearly convey the object's purpose to non-technical users, while

Comment the code, which is used for generating code or scripts, may be abbreviated, and should not normally in-
clude spaces. You can optionally add a comment to provide more detailed information about the object.
By default the code is generated from the name by applying the naming conventions specified in the
model options. To decouple name-code synchronization, click to release the = button to the right of the
Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereotypes

to the list by specifying them in an extension file.

Default diagram [package only] Specifies the diagram to display by default when you open the package.

Use parent name- [package only] Specifies that the package does not represent a separate namespace from its parent and
space thus that objects created within it must have names that are unique within the parent container. If this
property is not selected, then the package and its parent package or model can both contain objects that
are called Object A.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate them
with commas.
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1.4.13.1 Controlling the Namespace of a Package

PowerDesigner applies uniqueness checks on the names of objects. The namespace defines an area in which the
name and the code of an object of a given type must be unique. You can decide whether an individual package
must represent a separate namespace or not with the Use parent namespace property.

Context

Depending on the type of model where you create a new package, this option may be selected by default:

e Forthe EAM, CDM, LDM, PDM, DMM, and FEM - the entire model is, by default, a single namespace, and all the
packages have the Use parent namespace. PowerDesigner applies checks on uniqueness at the model level.

1 Note

The Glossary and XSM do not support packages. For information on namespaces in the XSM, see XML
Architecture .

e Forthe OOM, RQM and BPM - each package is, by default, a separate namespace and the property is not
selected. PowerDesigner applies checks on uniqueness at the package level.

In the following example, the class Printer is located in the Peripheral Package of an OOM where each package is,
by default, a separate namespace:

=18 Object Model
----- E‘H High levvel diagram
=-[=8 Peripheral Package

i @ Peripheral main diagram

=-§8 Classes

- B Persistent computer
#-B paralelPeripheral
H-B peripheral tester
B printer

i B scanner

#-E Interfaces

#-E8 Associations

#-f8 Generalizations

#-E8 Realizations

#-§8 Dependencies

H-[28 Internal network,

1.4.14 Areas

An areais an abstract object that can group together other objects. The objects do not belong to the area and are
just grouped in it.

Areas are available in the following types of diagrams:
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e EAM - All diagrams except organization charts

e FEM

e CDM, LDM, PDM

e DMM - Top-level diagrams

e (OOM - All diagrams except sequence and interaction overview diagrams

Creating an Area

You can create an area from the Toolbox, Browser, or Model menu, or on the Sub-Areas tab of an area.

Area Properties

To view or edit an area's properties, double-click its diagram symbol or Browser or list entry. The property sheet
tabs and fields listed here are those available by default, before any customization of the interface by you or an
administrator.

The General tab contains the following properties:

Property ‘ Description

Name/Code/Comment | Identify the object. The name should clearly convey the object's purpose to non-technical users,
while the code, which is used for generating code or scripts, may be abbreviated, and should not nor-
mally include spaces. You can optionally add a comment to provide more detailed information about
the object. By default the code is generated from the name by applying the naming conventions
specified in the model options. To decouple name-code synchronization, click to release the = button
to the right of the Code field.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereo-
types to the list by specifying them in an extension file.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate
them with commas.

The following tabs are also available:

® Role Associations - [EAM only] Lists the organization units, people, and roles associated with the area, and the
type of role they play in relation to it.

e Attached Objects — Lists the objects that are associated with the area.

® Sub-Areas - Lists the areas contained within the area.

1.4.15 Traceability Links

Traceability links provide a flexible means for creating a connection between any object in any type of model and
any other object in the same model or any other model open in your workspace. Traceability links have no formal

Core Features Guide
146 PUBLIC Modeling with PowerDesigner



semantic meaning, but can be followed when performing an impact analysis or otherwise navigating through the
model structure.

To create a traceability link between objects in the same diagram, select the Link/Traceability Link tool in the
Toolbox. Click inside the symbol of the object that is dependent and, while continuing to hold down the mouse
button, drag the cursor and release it on the symbol of the object on which it depends. In this example, the Work
entity is shown as being dependent on School through a traceability link:

School LTS

To create a traceability link to any object in any model that is open in the Workspace, open the property sheet of
the dependent object, click its Traceability Links tab, and click the Add Objects tool. Use the Model list to select a
different model, select the object to point to and click OK to create the link and return to the dependent object's
Traceability Links tab. You can optionally specify a type for any traceability link in the Link Type column.

Click the Types and Grouping tool to perform various actions on this tab:

e To make a link type available for selection in the Link Type column, click the Types and Grouping tool and select
New Link Type. Enter a Name for the link type and, optionally, a Comment to explain its purpose, and then click
OK.

1 Note

Traceability link types created in this way are stored as stereotypes in an extension file embedded in the
model. To work directly with this file click the Types and Grouping tool and select Manage Extensions. For
detailed information about working with these files, see Customizing and Extending PowerDesigner >
Extension Files .

e To control the display and grouping of links, click the Types and Grouping tool and select:
o No Grouping - to display all the links in a single list.

o Group by Object Type - to display links to different types of objects on separate sub-tabs. To add a link to a
new object type, click the plus sign on the leftmost sub-tab.

o Group by Link Type - to display different link types on separate sub-tabs. To add a new link type, click the
plus sign on the leftmost sub-tab.

1 Note

To see all of the objects that point to an object via traceability links, open its property sheet, click its
Dependencies tab, and click the Incoming Traceability Links sub-tab.

1.4.16 Extended Objects, Sub-Objects, and Links

Extended objects, sub-objects, and links let you model concepts that are not natively supported by
PowerDesigner. For example, you can add extended objects to a PDM to model new database objects. You can
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specify generated files and templates in the definition of your extended objects in order to enable their generation
and reverse-engineering.

Extended objects and extended links are available by default in the free model (see The Free Model (FEM) [page
240]), and can be added to any other type of model through the Profile category in the model's resource file or in
an extension file (see Customizing and Extending PowerDesigner > Extension Files ).

To view or edit an extended object's properties, double-click its diagram symbol or Browser or list entry. The
property sheet tabs and fields listed here are those available by default, before any customization of the interface
by you or an administrator.

Property Description

Name/Code/ Identify the object. The name should clearly convey the object's purpose to non-technical users, while

Comment the code, which is used for generating code or scripts, may be abbreviated, and should not normally in-
clude spaces. You can optionally add a comment to provide more detailed information about the object.
By default the code is generated from the name by applying the naming conventions specified in the
model options. To decouple name-code synchronization, click to release the = button to the right of the
Code field.

Source [extended links only] Specifies the name of the origin object of the extended link.

Destination [extended links only] Specifies the name of the destination object of the extended link.

Stereotype Extends the semantics of the object. You can enter a stereotype directly in this field, or add stereotypes
to the list by specifying them in an extension file.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate them
with commas.

1 Note

You can use the CanLinkKind event handler to restrict the kind of objects you want to link together. This event
handler is called when you create a link using the Toolbox tool or when you try to modify the ends of a link from
its property sheet. For more information, see Customizing and Extending PowerDesigner > Extension Files >
Event Handlers (Profile) .
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1.4.17 Checking Models

You can check the validity of your model at any time. We recommend that you check your model before generating
code or another model from it. The Check model option is enabled by default in the Generate dialog box and, if an
error is found, the generation is stopped.

Procedure

1. Press F4, select |l Tools # Check Model 3, or right-click the diagram background and select Check Model to
open the Check Model Parameters dialog.

The Options tab lists the types of objects to be checked, and the individual checks to be performed are
displayed with symbols indicating their severity:

Check Model Parameters [_ O]

Options | Selection I

HEIESE

FH-#) Package
i W Class
El--.EJ Elass Attribute
Attribute name uniqueness
.‘I_l Attribute code uniqueness
vl __\.. Detect inconsistencies between check parameters
. Drata type azsighment
Imitial walue for final attribute
__\.. Diomain divergence
I .EJ Clazz Operation
=5 Interface
oW Interface Operation
W) Generalization
-0 Realization

ak. I Cancel Apply Help

2. [optional] Select or deselect types of objects to check, and expand object nodes to enable, disable, vary the
severity of, and enable or disable automatic correction of individual checks with the following tools:

Description

Elj Select All - Click the arrow to select all checks, all error checks, or all warning checks.
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Tool Description
Elj Deselect All - Click the arrow to deselect all checks, all error checks, or all warning checks.
¥ Error — Sets the selected check to error level. When errors are encountered, any model generation is stopped.
Warning - Sets the selected check to error level. Warnings do not allow model generation to proceed.
L] ) . . . : .
Automatic correction - [if available for the selected check] Enables automatic correction for the selected
check and places a small red cross on the bottom-right corner of the check icon.
Automatic corrections may have unexpected effects, and you might want to disable them in some cases. For
example, in a PDM, if a column code length is longer than the length specified in the DBMS MaxColumnLen
entry, then PowerDesigner will truncate the code, but may also change the code to avoid duplicating an exist-
ing code.
1 Note

Right-click a check and select Help to display its documentation.

3. [optional] Click the Selection tab, and select or deselect individual objects for checking. Sub-tabs are available
for each type of object:

Check Model Parameters B =l

Optiohz  Selection I

F:Obiect Model AE] - @ o= % W |
M ame I Code |
Perzigtent computer Perziztent_computer
parallelPeripheral parallelPeripheral
peripheral tester peripheral_tester
printer printer
sCanner sCanner

[ » [\Packages ) Claszes finterfaces ) Associstions ) Generalizations A Realizat
Filker: || Selected object(s]: 5/5

Selection: I <Mame your zelection: j IE
Ok I Cancel Apply | Help |
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1 Note

If you had previously selected symbols in your diagram, you can select them for checking with the Use
Graphical Selection tool. For detailed information about these tools, see Adding an ltem from a Selection
List [page 130].

4. Click OK to begin the model check.

The Check Model Result List displays errors and warnings based on the check options you have defined. For
information about how to correct errors, see Correcting Errors in the Check Model Result List [page 151].

Result List x|

Cateqgary Check. Ohject L ocation
_i-, Clazz Operation implementation Operation 'Penp...  <Model:::Periph...
"E& |nterface Ope... Return type azsignment Operation 'Penp...  <Model:::Periph...

‘ |+

v [\Find & Check Mode! /

.

1.4.17.1 Correcting Errors in the Check Model Result List

When errors and warnings are encountered during model checking, they are listed in the Check Model Result List
pane. You can correct the problems either by invoking a automatic correction (if available) or by opening the
property sheet of the affected object and correcting it manually.

The following tools are available to assist you in correcting problems with your model. If this toolbar is not
displayed, select [ Tools » Customize Toolbars 3, select Check, and click OK.

Tool Description
ifr‘, Correct error — Opens the property sheet of the affected object to allow you to correct the error.
'Ju' Display help - Provides documentation for the error or warning.
0", Check again — Re-performs the check, to allow you to verify your correction.
EL Automatic correction — Only available if an automatic correction is defined for this kind of error. Performs the au-
tomated correction.
@H First error — Goes to the first error in the list.
@4 Previous error - Goes to the previous error in the list.
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Tool Description
EI Next error - Goes to the next error in the list.
%I Last error - Goes to the last error in the list.
1 Note

These and other options are also available by right-clicking an item in the Check Model Result List.

1.4.17.2 Checking Generic Objects

Generic objects are available in all types of models and have standard checks defined for them. For model-specific
checks, see the appropriate modeling guide.

1.4.17.2.1 Business Rule Checks

PowerDesigner provides default model checks to verify the validity of business rules.

Check Description and Correction
Name/Code contains terms not in glossary [if glossary enabled] Names and codes must contain only approved terms
drawn from the glossary.
® Manual correction: Modify the name or code to contain only glossary
terms.
e Automatic correction: None.
Name/Code contains synonyms of glossary [if glossary enabled] Names and codes must not contain synonyms of glos-
terms sary terms.
® Manual correction: Modify the name or code to contain only glossary
terms.
e Automatic correction: Replaces synonyms with their associated glos-
sary terms.
Name/Code uniqueness Object names must be unique in the namespace.
e Manual correction: Modify the duplicate name or code.
e Automatic correction: Appends a number to the duplicate name or
code.
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Description and Correction

Unused business rule The business rule you have created is not used in the model.

e Manual correction: Apply the business rule to an object in the model

e Automatic correction: None

1.4.17.2.2 Extended Object/Link Checks

PowerDesigner provides default model checks to verify the validity of extended objects/links.

Check Description and Correction
Name/Code contains terms not in glossary [if glossary enabled] Names and codes must contain only approved terms
drawn from the glossary.
e Manual correction: Modify the name or code to contain only glossary
terms.
e Automatic correction: None.
Name/Code contains synonyms of glossary [if glossary enabled] Names and codes must not contain synonyms of glos-
terms sary terms.
e Manual correction: Modify the name or code to contain only glossary
terms.
e Automatic correction: Replaces synonyms with their associated glos-
sary terms.
Name/Code uniqueness Object names must be unique in the namespace.
® Manual correction: Modify the duplicate name or code.
e Automatic correction: Appends a number to the duplicate name or
code.
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1.4.17.2.3 File Checks

PowerDesigner provides default model checks to verify the validity of files.

Check Description and Correction
Name/Code contains terms not in glossary [if glossary enabled] Names and codes must contain only approved terms
drawn from the glossary.
e Manual correction: Modify the name or code to contain only glossary
terms.
e Automatic correction: None.
Name/Code contains synonyms of glossary [if glossary enabled] Names and codes must not contain synonyms of glos-
terms sary terms.
® Manual correction: Modify the name or code to contain only glossary
terms.
e Automatic correction: Replaces synonyms with their associated glos-
sary terms.
Name/Code uniqueness Object names must be unique in the namespace.
e Manual correction: Modify the duplicate name or code.
e Automatic correction: Appends a number to the duplicate name or
code.
Existence of external file location External file objects should have a valid path location.
e Manual correction: Define a valid path location
e Automatic correction: None

1.4.17.2.4 Replication Checks

PowerDesigner provides default model checks to verify the validity of replications.

Description and Correction

Partial replication A replica object is partially synchronized with its replicated object.

e Manual correction: Modify the list of replicated attributes from the replication property sheet

e Automatic correction: Enforces the replication of desynchronized attributes of the replica object
in the replication property sheet
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1.4.17.3 Checking Glossary Compliance

When you enable the use of glossary terms for your object naming conventions, additional model checks help you
monitor glossary compliance for object names and automate the replacement of unapproved synonyms with
approved glossary terms. You can restrict the scope of your compliance efforts by disabling the checks for certain
object types on a model-by-model basis.

The following checks are enabled for all model objects when you select Use glossary for autocompletion and
compliance checking for your naming conventions (see Naming Conventions [page 155]):

Check Description and Correction

Name/Code contains [if glossary enabled] Names and codes must contain only approved terms drawn from the glossary.

terms notin glossary e Manual correction: Modify the name or code to contain only glossary terms.

e Automatic correction: None.

To disable this check for a given object type, clear its check box in the tree in the Check Model
Parameters dialog. To reduce its severity from Error to Warning, right-click the check and select
Warning. The check icon changes to a warning sign.

Name/Code contains [if glossary enabled] Names and codes must not contain synonyms of glossary terms.
synonyms of glossary
terms

e Manual correction: Modify the name or code to contain only glossary terms.

e Automatic correction: Replaces synonyms with their associated glossary terms.

To enable the automatic replacement of synonyms with approved glossary terms for a given object
type, right-click the check in the Check Model Parameters dialog, and select Automatic Correction. A
small overlay with a red cross appears at the bottom-right of the check icon.

In addition, the following check is enabled for models and packages to allow administrators to add terms used in
object names to the glossary:

Check Description and Correction

List of missing terms in | [if glossary enabled] This special check lists all the terms that are used in the names or codes of all
object names/codes in | the objects contained in the model or package.

package e Manual correction: An administrator with write permission on the glossary can double-click the

line for this check in the Result List to open a merge window in which you can select to add some
or all of these missing terms, as appropriate, to the glossary.

e Automatic correction: None.

1.4.18 Naming Conventions

You can use naming conventions to specify a case, maximum length, and valid characters for object names and
codes, and enforce compliance with an enterprise glossary. You can also invoke conversion scripts and conversion
lists to generate appropriate object codes from names (or names from codes).
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"] Model Options E

Cateqony:

i e Agsertion Template — : - ey
EI Naming Convention [V :Enable glossam for autocompletion and compliance checking
- Azsociation — . — .
- Data hem Senchronize code Enable conversions
- Domain Mame | Code I Mame To Code I Code To Mame
e M aming template: [{Nnne} 'r] E] IEI
-~ Identifier Masimum length: 254 Characters
- |mhentance
- Other objects Character caze: (") UPPERCASE () lowercase @) Mized CASe
- Package (71 Title Caze
- Relationship
Walid characters: | All walid
Irevalid characters: Mo accents

Drefault character:

Defalt ] lﬁet bz Default]

l )4 I[ Cancel ][ Help ]

To set naming conventions to control the names and codes of all objects, select |+ Tools » Model Options 3 and
click the Naming Convention node. To set naming conventions for a particular kind of object, select its node under
the Naming Convention node.

These options are available only on the Naming Convention node and apply to all objects:

Option Description

Enable glossary for au- | Enables the use of the enterprise glossary in the model. When this option is selected, auto-comple-
tocompletion and com- | tion is enabled for object names and codes using the glossary terms (see The Glossary [page 397),
pliance checking and additional checks are made to ensure that all model objects use only approved glossary terms in
their names and codes (see Checking Glossary Compliance [page 155]).

For information about administering the glossary, see Deploying an Enterprise Glossary [page 577].
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Option

Synchronize code

Description

Specifies that the code of the object is synchronized with the name of the object by applying the
naming conventions specified on the Code subtab.

This option is enabled by default unless or until you reverse-engineer or import a database, business
process, XML or OO code, when it will be unselected to allow the free editing of object names without
affecting the underlying code. You can reselect the option at any time.

To disable name to code synchronization for an individual object, click to release the = button to the
right of the Code field on the General tab of its property sheet.

When names and codes are not synchronized, you can generate a name from a code or a code from a
name by clicking the = button to the right of field that you want to change.

Enable conversions

Enables the application of the conversion scripts and conversion tables specified on the Name to
Code tab when synchronizing object codes with names (see Name and Code Conversion Scripts
[page 158]).

These options are available on both the Name and Code subtabs of the Naming Convention node (where they
apply to all objects) and on each subnode (where they apply to the selected object):

Option

Naming template

Description

Specifies a naming template to supply the naming conventions for the name or code. A naming tem-
plate contains the same fields as on this tab, but in a format that can be reused for other objects (see
Creating a Naming Template [page 158]). Click the ellipsis button to the right of this field to open the
List of Naming Templates, or click the Properties tool to view and edit the selected template.

Maximum length

Specifies the maximum number of characters permitted in a name or code. In a PDM, you can set the
maximum here and in the DBMS definition file. If you specify both, then PowerDesigner applies the
stricter constraint. For example, if you set 128 here and the DBMS file specifies 30, PowerDesigner
applies the 30 character limit.

Character case

Specifies the case to apply to the name or code. You can choose between:

e UPPERCASE

® |owercase

o Mixed CASe

e Title Case (Name only)

e UpperCamelCase (Code only)

e |owerCamelCase (Code only)

Valid characters

Specifies the list of characters permitted in the name or code. Enter character ranges between single
quotes, separated by a dash. Enter individual or multiple characters between double quotes. Sepa-
rate valid items by a comma. By default, PowerDesigner allows the following valid characters for co-
des:

lal_lZl,IAI_IZI,IOI_I9I,H "

Select All valid to the right of this field to permit any character.
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Option Description

Invalid characters Specifies the list of characters not permitted in the name or code. By default, PowerDesigner ex-
cludes the following characters for names:

vv+_~k/\.’!:;u

Select No accents to the right of this field to remove accents from accented characters.

Default character Specifies the character that is used to replace any invalid characters that are entered.

1.4.18.1 Creating a Naming Template

You can create a naming template to specify naming conventions for names or codes and reuse it for multiple
types of objects.

Procedure

Select | Tools » Model Options 3 and click the Naming Convention node in the Category tree.
Click the Ellipsis button to the right of the Naming Template field to open the List of Naming Templates.
Click the Add a Row button and enter a name for the new naming template.

A woN o

Click the Properties tool to open the template property sheet, complete all the appropriate properties (see
Naming Conventions [page 1557), and then click OK to return to the list.

5. Click OK to return to the Model Options page.

Your template is now available for selection in the Naming Template field. Click the Properties tool to the right
of this field to modify the selected template.

1.4.18.2 Name and Code Conversion Scripts

Conversion scripts permit more complex transformations, including adding prefixes or suffixes and the use of

conversion tables. You specify the script on the Name to Code or Code to Name tab, depending on which direction
you want to perform the conversion.

1 Note

To enable the use of your conversion script, you must select Enable name/code conversions in the upper part of
the Naming Convention page of the Model Options dialog.
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- File arvwersian sonpt:

M ame I Code Mame To Code I Code Ta Hame

- |dentifier
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- Package
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Apply name to code conversion
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Drefault | Set Az Defaultl
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The following options are available on each of these tabs:

Option

Conversion script

Description
The default Name to Code conversion script is:

.convert name (%Name$," ")

This script takes the value of the Name field (represented by the GTL variable $Name%) and gener-
ates a Code by replacing any nonalphanumeric characters with an underscore. It also calls a conver-
sion table (if one is selected in the Conversion table field) to perform conversions on specific strings
encountered in the name or code.

You can modify the conversion script. For example, to insert the prefix tb1_ before the code of each
table, use:

.convert name (tbl %Name%," ")

If the stdnames conversion table is selected then, for a table with the name Customer,

PowerDesigner automatically provides a code tbl_CUST.

You can enter any valid GTL code (including macros such
as .foreach_part, .lowercase, .uppercase, .replace, and .delete), but only

the .convert name and .convert_code macros call a conversion table if one is selected.

For detailed information about GTL, see Customizing and Extending PowerDesigner > Customizing
Generation with GTL .

Conversion table

Specifies the conversion table to use to perform conversions on specific strings encountered in the
name or code (see Conversion Tables [page 161]).

PowerDesigner provides an example conversion table called stdnames . csv. For example, an ob-

ject name Customer_1 is transformed into the object code CUST_1 if stdnames is selected.

To use your glossary term names and codes (see The Library [page 43]) as a conversion table, select
glossary terms.

Apply name to code
conversion/ Apply code
to name conversion to

Applies the conversion script (and conversion table) when you click OK:

e To synchronized objects - those objects in which the object code is currently synchronized with

the name.
all objects . ) . ) . )
e Toall objects - all objects in the model regardless of whether the object code is synchronized
with the name.
The option on the Code to Name tab always applies your changes to all objects in the model.
1 Note

When generating one model from another, you can use name to code conversion to provide appropriate codes
for the target model objects (see the Convert Names into Codes options on the Model Generation Options [page

466)).
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1.4.18.3 Conversion Tables

Conversion tables are .csv files containing a list of strings that may appear in object names matched with

equivalent (generally shorter) strings with which to replace them when generating object codes. For example, each

instance of the word customer in object names in your model could be converted to cust in their codes.

Context

You can add your existing .csv files containing name/code pairs to the conversion table folder and create
conversion tables directly within PowerDesigner.

1 Note

To review the example conversion table provided with PowerDesigner navigate to and open <install dir>/

Resource Files/Conversion Tables/stdnames.csv.

You can check conversion tables into the repository Library folder to make them available to all users (see
Sharing Resource Files via the Library [page 588]).

Procedure

1. Select|» Tools » Resources » Conversion Tables . to open the List of Conversion Tables.

To review an existing conversion table, select it in the list and click the Properties tool. To change the folder
where PowerDesigner looks for conversion tables to populate the list, click the Path tool.

2. Click the New tool, enter a name and click Save to create the file and open the Conversion Table dialog.

3. Click the Add a Row tool and then enter a name and the code into which you want to convert it:

Il Conversion Table [ x|

M amne:

I “Fezource FileshConverzion Tables\conversiontable. cay

Walle:
e [ R [
M ame Code fices
1 Custamer CUST
2 Praduct PROD
3 Departrment DEPT
= | Client CusT| -
e

(AEARIRAE TEIER |

()% I Canicel | Help |
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You can create as many conversion Name-Code pairs as required. The values in these columns are not, by
default, case-sensitive, but you can turn on case-sensitive matching in your conversion script
(see .convert_name and .convert_code Macros [page 162]).

1 Note

It may be that several different names are converted to the same code. For example, client and customer
may both be converted to CUST. If a table containing these lines were used to convert codes to names, then
the first value encountered in the Name column is always used and there is a risk that multiple objects will
be given the same name.

4. Click OK to return to the list of conversion tables, and then click Close to return to your model.

Your conversion table is now available to be selected in the Model Options dialog Naming Convention page (see
Naming Conventions [page 155]).

5. [optional] Check the conversion table into the repository Library/Resources/Conversion Tables folder
to make it available to other users (see Sharing Model, Report, and Project Templates and Conversion Tables
via the Library [page 5897).

1.4.18.4 .convert_name and .convert_code Macros

These macros convert the object name to its code (or vice versa) and can search for and apply values found in an
associated conversion table.

Use the following syntax to convert a name to a code:

.convert name (<expression>[,"<separator>","<delimiters>",6 <case>,<sensitive>])
Use the following syntax to convert a code to a name:

.convert code (<expression>[,"<separator>","<delimiters>",<sensitive>])

The following parameters are available:

Parameter Description

<expression> Specifies the text to be converted. For .convert_name, this is generally the $Name$% variable and may
include a suffix or prefix.

Type: Simple template

<separator> [optional] Character generated each time a separator declared in <delimiters> is foundin the code.

For example, (underscore).

Type: Text
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Parameter Description

<delimiters> [optional] Specifies the different delimiters likely to exist in the input code or name, and which will be
replaced by <separator>. You can declare several separators, for example "_"and "-"
Type: Text

<case> [optional for . convert name only] Specifies the case into which to convert the code. You can choose
between:

e firstLowerWord -First wordinlowercase, first letters of subsequent words in uppercase

e FirstUpperChar - First character of all words in uppercase

® Jlower case -Allwordsinlowercase and separated by an underscore

® UPPER CASE - Allwords in uppercase and separated by an underscore

<sensitive> [optional] Controls case-sensitivity when looking up names to convert via a conversion table. You can
choose between:

e ( [default] - The first match found in the conversion table, irrespective of the case, is used. The
names account, Account, and ACCOUNT are treated as identical, and the first one encountered
in the list is matched.

e 1 -Matchingin the conversion table is case-sensitive and account, Account, and ACCOUNT are
treated as three different names.

In this example, the template is applied to class name Corporate Customer:
.convert name (cls %Name%[,,,FirstUpperChar])

Result:

clsCorporateCustomer

In this example, the template is applied to the entity name Current Account, and a conversion table is provided. The
macro specifies that case-sensitive matching should be used:

.convert name (%Name%[,,,,1])
The conversion table contains the following lines:

account, AC
Account, ACC
ACCOUNT, ACCT

Result:

CURRENT ACC

Core Features Guide
Modeling with PowerDesigner PUBLIC 163



Examples

In this example, the template produces a list of column names before and after conversion:

.foreach item(Columns)
$Name$%,
.foreach part ($Name%)
.convert name (%CurrentPart%,,,lower case)
.next ()
.next (\n)

Result:

Column 1, column 1
Column 2, column 2
Column 3, column 3

1.4.18.5 .delete and .replace Macros

These macros delete or replace all instances of the given string in the text input.

.delete (<string>)
<block-input>
.enddelete

.replace (<string>,<new-string>)
<block-input>
.endreplace

The following parameters are available:

Parameter Description

<string> Specifies the string to be deleted.
Type: Text

<new-string> [.replace only] Specifies the string with which to replace <string>.
Type: Text

<block-input> Specifies the text to be parsed for instances of the <string> to delete or replace.
Type: Complex template

Examples Result
.delete (Get) CustomerName
GetCustomerName
.enddelete
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|
Examples ’ Result

.replace (Get, Set) SetCustomerName
GetCustomerName
.endreplace
.replace(" ", ) Customer Name
Customer Name
.endreplace
1 Note
Surrounding quotes are optional for strings except whitespace.

1.4.18.6 .foreach_part Macro

This macro iterates over the parts of a string divided by a delimiter using the special $CurrentPart$ local
variable.

.foreach part (<input> [,"<delimiter>" [,<head> [,<tail>]]])
<output>
.next[ (<separator>) ]

The following parameters are available:

Parameter Description

<input> Specifies the text over which to iterate.
Type: Simple template

<delimiter> Specifies the sub-string that divides the input into parts. You can specify multiple characters includ-
ing ranges. For example [A-Z] specifies that any capital letter acts as a delimiter.
By default, the delimiterissetto ' -, \t' (space, dash, underscore, comma, or tab).

1 Note
The delimiter must be surrounded by single quotes if it contains a space.

Type: Text

<head> [optional] Specifies text to be generated before the output, unless there is no output.
Type: Text

<tail> [optional] Specifies text to be generated after the output, unless there is no output.
Type: Text

Core Features Guide
Modeling with PowerDesigner PUBLIC 165



Parameter Description

<output> Specifies the text to output for each part in the input.
Type: Complex template

<separator> [optional] Specifies text to be generated between each part of <output>
Type: Text

For example:

This template is applied toMy class:

.foreach part (%Name%)
%.FU:CurrentPart$%
.next

Result:

MyClass

This template is applied toMy class:

.foreach part (%Name%,' - ', tbl )
%.L:CurrentPart?
.next ()

Result:

tbl my class

This template is applied toMyClass:

.foreach part (%Name%, [A-Z])
%.L:CurrentPart$%
.next (=)

Result:

my-class
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1.4.19 Spell Checking

You can spell check your PowerDesigner models if you have MS Word 2000 or higher installed on your machine,
and if your system code page is consistent with the model language. For example, for the spell checker to work
properly on a Chinese model, your system code page should be Chinese.

Context

1 Note

You must enable the Spell Checker add in before use. To do so, select | Tools # General Options 3, click the
Add-Ins category, and select the Spell Checker add in in the list, then click OK to return to your model. To set

preferences, select |» Tools » Spell Checking Options 3 and choose the model objects properties for which you
want to check the spelling. If you select Check sub-objects, then all the child objects of any object you check will
also be checked. You can also specify the dictionary language to use when spell checking.

Procedure

1. Right-click an object or a model node in the Browser and select Spell Check. If an error is found the Spell
Checking dialog opens.

2. Foreach error, you can:

o

Click Change to accept the suggested replacement word.
o Type your own replacement and click Change

o

Click Change All to apply the change to the entire object or model.

O

Click Add to add the word to your custom dictionary

A message is displayed to inform you that spell checking is successful.

1.4.20 Extending Objects

PowerDesigner includes powerful tools to extend and customize your modeling objects. Many extensions are
defined in the resource files that are provided with PowerDesigner to support a particular language or DBMS, and
you can add your own to add new attributes and attribute lists to objects, create entirely new objects, and
customize object generation.

1 Note

Many extended attributes are displayed in standard or custom property sheet tabs, but if any are not so
assigned, an Extended Attributes tab will be displayed, listing all the extended attributes in alphabetical order
and giving their datatypes, values, and a column, [R]edefined, in which the checkbox is selected if you have
modified the attribute's default value.
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For detailed information about working with extensions, see Customizing and Extending PowerDesigner >
Extension Files .

1.4.20.1 Adding New Properties to an Object

To quickly add new attributes and collections to an object or to customize its property sheet, use the commands
available from the property sheet menu. Extensions added to an object are immediately available for all other
objects of that type in the model.

1.4.20.1.1 Adding a New Attribute to an Object

The PowerDesigner metamodel specifies the attributes available by default for an object (for example, name and
comment). To quickly extend the metamodel and add a new attribute from an object property sheet, click the
menu button, and select New Attribute. The new attribute is immediately available on all objects of this type.

Context

1 Note

The definition of the new attribute is stored in a PowerDesigner extension file. For detailed information about
working with these files, see Customizing and Extending PowerDesigner > Extension Files .

Procedure

1. Open the property sheet of the object you want to extend, click the menu button, and select New Attribute to
open the New Attribute dialog:
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T |

Mame:

Comment;

[rata type:
Default value:
List of walues:

Text Format;

[~ Open Resource Editor on Finizh

IL::ugin

[
[(Test =l
| <.
I _I Complete [
I Tt j

Create Anather.... |

< Back I Hest = I

Finizh

Cancel

Help

2. Enter a Name and Datatype for the new attribute and complete any other appropriate fields.

3. [optional] Click Next to specify the property sheet tab on which you want the attribute to appear. If you choose
to create a new property sheet tab, you must enter a tab label to display.
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Mew Attribute

Property sheet tab:

Label: I

[~ Open Resource Editor on Finish Create dnother... I
< Back [HEwt = | Finizh I Cancel Help |

By default, the attribute is inserted on the tab from which you launched the New Attribute dialog, if the tab is
editable.

4. [optional] If you want to view the new attribute in the PowerDesigner Resource Editor, select the Open
Resource Editor on Finish checkbox.
For information about working with the Resource Editor, see Customizing and Extending PowerDesigner >
PowerDesigner Resource Files

5. Click Finish to close the dialog and create the new attribute.

The attribute appears on the specified property sheet tab:
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.?_ Person Properties - John {John)

General | Roles I Grn:nupsl Mates I

M arne: IE j
Code: IJ ahn IT

Comment:

Stereotype: I j
Manager: | 2 Sarah j
Site: I Pariz j

Joblite: |

Telephone

3
Email: I
|

Login:

bore »» | % - | ] 4 I Cancel Apply Help

1.4.20.1.2 Adding a New Collection to an Object

The PowerDesigner metamodel specifies the collections of related objects available by default for an object (for
example table columns or class attributes). To quickly extend the metamodel and add a new collection from an
object property sheet, click the menu button, and select New List of Associated Objects. The new collection is
immediately available on all objects of this type.

Context

1 Note

The definition of the new collection is stored in a PowerDesigner extension file. For detailed information about
working with these files, see Customizing and Extending PowerDesigner > Extension Files .
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Procedure

1.

Open the property sheet of the object you want to extend, click the menu button, and select New List of
Associated Objects.

etz

Marme: I.-’-\-.pplin::atin:-ns Uzed

Target Type: Enterprisedpplication

T arget Stereotype: I j

[~ Open Rezource Editar on OF,

2. Enter aName for your list. This name is used as the name of the property sheet tab on which the list appears.

3. Select the type of associated object that you want your list to display. You can choose from any of the object

172

types available in your model.

[optional] To limit the objects of the selected type that your object can be associated with, specify a
stereotype that objects must bear in order to appear in the list.

[optional] If you want to view the new collection in the PowerDesigner Resource Editor, select the Open
Resource Editor on OK checkbox.

For information about working with the Resource Editor, see Customizing and Extending PowerDesigner >
PowerDesigner Resource Files

Click OK to exit the dialog and create the new list.

The list appears as a new tab in your property sheet, containing tools that let you associate existing and new
objects of the specified type with your object:
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.*_ Person Properties - John {John)
Generall Foles I Groups  Applications Llzed | M otes I
= RER I WEEN G W
Mame Code 1=
= |ASE ASE
2 Oracle Oracle
3 PowerD ezigner : PowerD esigner
4 Yigual Studio  PVizual_Studio
4| [ ]
bore »» | % - | ] 4 I Cancel Apply | Help |

1.4.20.1.3 Customizing an Object Property Sheet Tab

The PowerDesigner interface includes a standard property sheet for each type of object. To quickly customize a
property sheet tab, click the menu button, and select Customize Current Tab. The customized tab is immediately

available on all objects of this type.

Context

1 Note

The definition of the customized tab is stored in a PowerDesigner extension file. For detailed information about
working with these files, see Customizing and Extending PowerDesigner > Extension Files .

Procedure

1. Open the property sheet of the object whose property sheet you want to customize, select the tab to change,
click the menu button, and select Customize Current Tab.
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2. [optional] Modify the Name that will be displayed as the tab name.

3. Use the Add Attribute and Add Collection tools in the Form tab toolbar to add new properties to your form. You
can reorder controls in the form control tree by dragging and dropping them.

For detailed information about these and other form tools and properties click the Help button, or see
Customizing and Extending PowerDesigner > Extension Files > Forms (Profile) .

4. Click OK to close the dialog and return to the modified property sheet.

1.4.20.1.4 Managing Extensions

To review your object extensions in the Resource Editor, select Manage Object Extensions from the property sheet
menu.

Context

You can create basic new properties and lists using the wizards available from the property sheet menu. To
perform more advanced editing of extensions, you must open the appropriate extension.

Procedure

1. Open the property sheet of the object, click the menu button, and select Manage Object Extensions.

Manage Object Extensions

An object can be extended in the Profile categony of multiple extenzions. Select
which one you want bo open.

E stenszion:

Hame: Local Estenzions

V¥ Set as default extenzion

k. I Cancel Help

2. Select the Extension file that you want to open from the list of files attached to the model, or select <New> to
create a new embedded extension file.

3. [optional] Select the checkbox to set the chosen extension file as the default. The default extension file is used
to contain the extensions created from the property sheet menu

4. Click OK to open the chosen extension in the Resource Editor.

For detailed information about editing these files, see Customizing and Extending PowerDesigner > Extension
Files .
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1.4.20.2 Customizing the Generation of Files for an Object

In PowerDesigner, you can define a generated file on a selected metaclass (or stereotype or criterion), in this case
afile is generated for each instance of the metaclass existing in your model.

The generated files mechanism is defined in Customizing and Extending PowerDesigner > Extension Files >
Generated Files (Profile) .

You can modify the default generation of files using artifacts. Artifacts are used to generate files only for selected
instances of a metaclass in order to:

e Design a source file that includes the code of several objects in a single file.
® (Generate only for selected instances of a metaclass.
e (Customize the generated file name and path.

C# and VB .NET Reverse Engineering Use Case

Artifacts are visible in the C# and VB .NET object languages. This is to support round-trip engineering for these
languages: when you reverse engineer C# or VB .NET code, each source file in the source code becomes an
artifact in PowerDesigner. The artifact allows you to re-generate the same collection of objects while preserving file
structure.

1.4.20.2.1 Using Artifacts in a Model

To be able to use an artifact in a model, you have to declare it in a resource file attached to your model. You must
create a template called "DefaultTemplate" under an artifact stereotype or criterion bearing the name of the
corresponding file type to generate.

In the C# resource file, if you expand the Artifact folder, you can see that the stereotype "Source" and the template
"DefaultTemplate" are defined by default. This means that when you create a new artifact and assign the Source
stereotype, this artifact inherits the default template defined below:

Core Features Guide
Modeling with PowerDesigner PUBLIC 175



£ Object Language Properties [For All Models) _ O] ]
General I
B = IEﬂ::Plufile\.&ltifactkstereut}lpes\sDulce\TempIates'\DefaultTempIate j - B ek
() CH -

[:l Settingsz

[:l Generation

=1 Profile
[:l Shared
BB Aitact

-1 Stereatypes
E-ER Source

=

..... 3
..... 3
..... 3

EI[:I Templates

Caollection
DrefaultT emplate
definitions
header

uzings

{Compilation nitF ooter
{CompilationUnitH eads

Mame: DefaultTemplate

Comment; ﬂ

=

E--EES M L BB oo 8% nic

A4 dnitialization ;I
.get_objectihctivelModel.Currentirtifact, thiz)
[hctiveModel. pushObject (Nanespaceitack) ]

.44 compilation unit header

[5$headeriininly

. /4 using declarations

[Fusing=3ininlh

.S/ namespaces

..... ﬁ {Irmparts} [3definitionssininly

----- ] ilzings)
#-B Association
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oK I Cancel Al | Help |
Example

You define the following artifact criterion in an extension:
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4| Extended Model Definition Properties [ObjectOrientedModel 1)

General |

P IE:-:tendedDefinitinn_1::F'ru:ufile"-.&rtifau:t'xEriteria'xT:-:t.ﬂ.rtifacts j A-EH- T L%

] ExtendedD efirition_1
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[:l Generation
=-3 glfﬂe Conditiar: I %, Prlanes == txt
o] Shared
El% Autifact Parent: I <Mone> j
=2 Criteria
: C f:
=1L Tt Arifacts IS
E||:| Templates ﬂ
e DefaultTemplate

2k, I Cancel Spply Help

This criterion verifies that the last 4 characters of the artifact name are .TXT. You also need to create the default
template in order to define the content of the generated file. In this example, DefaultTemplate is defined as follows:

This is a text file.

.foreach item(ProductionObjects)
$ShortDescription$%

.next (\n)

You can now create artifacts in the model using the |» New » Artifact 2 command in the model contextual menu. If
you create an artifact with the TXT extension and select the correct target in the Template tab of the artifact
property sheet, the default template is automatically assigned to this artifact. This means that the short
description of each instance of object associated with the current artifact will be written in the generated file:
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B3 Artifact Properties - FirstGen_kxt |_ O] x|
General  Template | Objects | Prerequisites | Freview |

Target [ MG -

E-B-HEM L BE oo jo i (g

This iz a text file. :I
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JneExtT i)

o o

bore > | - k., I Cancel Apply | Help |

You can now define instances of objects you want to include in the file generated from the current artifact:
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Generall Template Objects | F"rerequisitesl F"reviewl

B B X # 7 L

Object Type Short Deszcrphion Stereohype [=
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1.4.20.2.2 Defining an Artifact

Artifacts can replace the standard generation of files; by default, an artifact generates the same code as the
generated file but only for selected instances of a metaclass.

Context

An artifact has the following properties:

Property Description

Name Name of the artifact.

Comment Descriptive comment for the artifact.

Stereotype Sub-classification used to extend the semantics of an object without changing its structure; it can be pre-
defined or user-defined.

Encoding Allows you to modify the default file encoding of the files to reverse engineer.
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An artifact definition also includes the following properties:

Property Description

Template Template used to generate the content of the generated file.
Objects List of objects associated with the current artifact.

Prerequisites List of artifacts that must be generated before the current artifact.
Preview Allows to visualize the generated code of the artifact.
Procedure

1. Double-click the symbol of an object with generated files, for example a class in C# language.
2. Click the Generated Files tab.

The Target column displays the resource file where the generated file is defined and the File Type column
displays the type of the generated file.

Each row in the list corresponds to a generated file type available for the current instance of a metaclass, you
can customize the generation of this file using an artifact.

3. Click the Create tool in the Artifact(s) column to add an artifact. This artifact will replace the standard file
generation for the current object.
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4. Click Apply and click the Properties tool to define artifact properties.
5. Click OK in both property sheets.

1.4.20.2.3 Managing Artifacts

Artifacts appear in the Artifact category of the Browser. You can perform the following actions to customize an

artifact. You can drag and drop authorized objects from the diagram or the Browser onto an artifact in order to add

the code of this instance to the artifact.

You can use folders to create an artifact hierarchy for generation by right-clicking the Artifact category or a sub-
. You can create as many folder levels as necessary and create or

folder and selecting |» New # Artifact Folder
place artifacts at any level.

) Arifacts
=7 GenerationFalder
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1.4.20.2.4 Generated Files Tab

In the Generation dialog box, the Generated Files tab displays a checkbox tree with generated files (with a dimmed
icon) and artifacts. You can select or deselect the files you want to generate.

Generation |_ (O] x|
Diirechony: Id:"xtest"'. j IEI

[V Check model

Selectiu:unl Options  Generated Files I Tasks I

B B E

=-iw] 1 d:Mest
1) Azsemblyinfo.cs

=) Customer.cs Arifact
ME]

1) ObjectOrientedtodel_1.czproj
v | ObjectOrientediodel_1.3ln

----- 1] Order.cs

Generated Files (dimmed icon)

Object|z] zelected: IW
k. I Cancel Apply | Help |

You can modify generation options from this dialog box, and you can also check artifact generation completeness:
if an exclamation mark is displayed on the artifact icon it means that one or several prerequisite artifacts are
missing.

If you click the Enforce Dependencies tool in the upper part of the dialog box, the artifacts that are prerequisites of
other artifacts are automatically selected in the tree view in order to properly generate artifacts.

Generate from an Artifact Folder

If you click the Generate command in the artifact folder contextual menu, a Generation dialog box is displayed to
let you manage the generation of a given artifact folder. This dialog box also displays a checkbox tree with children
artifacts of the selected artifact folder.
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You can enforce dependencies in the Generation dialog box to make sure all prerequisites are selected for
generation.

1.4.21 Applying Transformations to Objects

Transformations are used to perform generic modifications to your model objects. You can apply transformations
to your model as a sort of design pattern. You can design a pattern using the transformation feature and play it in
your model in order to modify objects. For example, in an OOM, you could use a transformation to convert all
analysis classes with the <<control>> stereotype into components in order to add an implementation layer to
your model.

Context

In order to apply transformations, you must have either defined transformation profiles in your model's language
definition file (for PDM, OOM, BPM, or XSM) or in an extension file (see Customizing and Extending PowerDesigner
> Extension Files > Transformations (Profile) ).
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1 Note

Pre- and post-generation transformations can be applied during model-to-model generation (see Applying Pre-
and Post- Generation Transformations [page 471]). You can only invoke post-generation transformations
outside of a generation.

Procedure

1. Select | Tools » Apply Transformations

2. Select the profiles and transformations to be applied. If you deselect a profile, none of its transformations will
be executed. You can drag and drop profiles to modify the order of execution of transformations.

Apply Transformations _ O

Transfarmations I Selechion I

By

Tranzformation Profile | Target | T ranzformation | Metaclazs | Desc
COkMtaCDM ChangeT of mtity ChangeMMRelat.. Model
COMehanges ChangeT of mity CharngeE rtity Madel

E rtityCialar Madel
Changelnhertan... Model

( [
- k. I Cancel | Spply | Help |

3. [optional] Click the Selection tab and deselect any objects that you want to exclude from the transformation.
4. Click OK to apply the transformations.

The object tree of the model is traversed from the model object down and, for each type of object for which
one or more post-generation transformation profiles is defined, each profile is applied in the order in which
they appear on the tab, with each transformation being applied in the order in which they are defined in the
profile.

1.4.22 Exporting Objects to Troux Semantics

The Troux Upload extension files provide a framework for mapping PowerDesigner metadata to Troux Semantics
domains. An extension file with the export mechanism is provided for each type of PowerDesigner model along
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with instructions for how you can define mappings to export your model objects in the Troux Upload XML format.
Example mappings are provided to map certain EAM objects to the Troux Application and Software domains

The extension files (along with developer and user documentation) are installed at <install dir>\Resource
Files\Extended Model Definitions\Troux, and should be copied intothe parent Extended Model
Definitions directory in order to be developed and used.

1.5 Diagrams, Matrices, and Symbols

Most PowerDesigner models contain diagrams, in which your model objects are represented by symbols. You can
add a dependency matrix to any model to show relationships between objects.

1.5.1 Diagrams

A diagram is a graphical view of a model or a package. All models and packages have at least one diagram, and you
can add additional diagrams as necessary. Objects can appear in multiple diagrams, and their symbols can show
different kinds of information in each diagram.

For example, in a Publishing model, different diagrams could define the different activities involved in this industry:
the printing diagram, the sales diagram, the accounting diagram, the book selection committee diagram.

When you save the model you also save all the diagrams it contains. You cannot save a diagram separately.

1 Note

In requirements models (see Requirements Management ), there are no diagrams, but rather views.

1.5.1.1 Creating a Diagram or a Diagram from a Selection

By default, any model or package opens with a default diagram. You can create as many diagrams as you wantin a
model or in a package. You can also select two or more symbols in an existing diagram and create a new diagram
from your selection.

Context

You can create a diagram in any of the following ways:

e Select|p View » Diagram » New Diagram » <Diagam type> 4. If you have previously selected any object
symbols, then the selected symbols will be copied into the new diagram. Alternatively, if you have selected two
or more symbols in a diagram, you can right-click a selected symbol and choose Create Diagram from
Selection.
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1 Note

Since PowerDesigner objects can appear in multiple diagrams, the selected objects are not duplicated in
the Browser, but they are now present in both the original and the new diagram.

e Right-click the background of your diagram and select | Diagram » New Diagram ¥ <bDiagram type> 4.

e Right-click the model node in the Browser and select | New » <Diagram type> 4.

In each case you will be invited to specify a name, code, and optional comment for the new diagram.

1.5.1.2 Diagram Properties

You can modify an object's properties from its property sheet. To open a diagram property sheet, right-click its
Browser entry and select Properties from the contextual menu, or right click the diagram background and select

|\ Diagram ¥ Properties J from the contextual menu.

The General tab contains the following properties:

Property Description

Name Specifies the name of the item which should be clear and meaningful, and should convey the item's pur-
pose to non-technical users

Code Specifies the technical name of the item used for generating code or scripts, which may be abbreviated,
and should not generally include spaces

Comment Additional information concerning the diagram
Parent Specifies the name of the parent model or package
Stereotype Specifies a stereotype for the diagram. For example, a statechart diagram can serve to model page flows in

JSF and other web frameworks.

You can use a profile to provide special processing for diagrams and other objects carrying stereotypes.
For more information, see Customizing and Extending PowerDesigner > Extension Files .

Page scale Sets a default display for page scale. The page scale percentage lets you define a page size according to
your modeling needs. If you have a lot of objects on several pages, you can reduce the page scale percent-
age in order for all the objects to fit on a single printable page

Default Diagram Diagram by default. This check box is automatically selected if the diagram is the first created diagram
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1.5.1.3 Opening and Viewing Diagrams

You can open a diagram from the Browser or from the View menu, and move between open diagrams using the
tabs above the canvas or by pressing|ctr1| + [Tab|or|ctrl| + [shift| + [Tab]

Context

® Double-click the diagram entry in the Browser.

e Press + [p] or select |p- View » Diagram  Select Diagram Jto open the Select Diagram dialog box,
select a diagram node in the tree and click OK.

1 Select Diagram |_ (O] x|

Ea, Orgarization
b T Accounts
-7 Marketing
B @ Sales
: ,,,,, -
- E"‘ Telesales

k. I Cancel Help

e To access diagrams beneath package or other composite object symbols:
o Select the Open Diagram tool from the Toolbox and click the symbol.
o Press[ctr1]and double-click the symbol.

o Right-click the symbol and select |+ Diagram » Open Diagram .

The following diagram viewing tools are available in the Toolbox or from the View menu:

Tool Description
{11 Zoom In () - Select the Zoom In tool and click anywhere in the diagram. The point clicked on is centered.

Alternatively, you can select |} View > Zoom In } or turn your mouse scroll wheel away from you while holding
the key.

To zoom in to a particular area, select the Zoom In tool and click and drag a rectangle around the area to be
displayed. When you release the mouse button, the diagram zooms to the selected area.
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Tool Description

a Zoom Out () - Select the Zoom Out tool and click anywhere in the diagram. The point clicked on is centered.

Alternatively, you can select |} View > Zoom Out } or turn your mouse scroll wheel towards from you while

holding the key.

'@] View the whole diagram () - Double-click the Global View tool or select |} View > Global View 1
[none] View actual size () - Select |} View > Actual Size }

[none] View the current (printable) page ( + ) - Select |} View > Page View > Current Page ]
[none] View all pages that contain symbols () - Select | View » Page View » Used Pages 3.

[none] View all pages in the diagram - Select |F View ¥ Page View ¥ All Pages 3.

[none] Center on selected symbols - Select |» View » View Selection 3.
[none] Return to previous view () - Select |} View > Previous View }

This and the Next View option allows you to toggle back and forth between various selections and zooms you
have used to navigate in your diagram, for example between a limited view and a global view of the diagram.

[none] Go to next view ((shift] + [F9])- Select [P View » Next View 1.
[none] Refresh View ( + ) - Select |} View > Redisplay }

1.5.14 Finding an Object Symbol in the Diagram

You can locate any object with a symbol in a diagram or among several diagrams using Find in Diagram (or, for an
RQM, Find in Document View). Objects without graphical symbol such as domains cannot be found in the diagram.

Context

If the object has only one symbol, the appropriate diagram is opened with the object symbol centered. If the object
has several symbols, a dialog box opens to allow you to select one.

This feature can be very useful if you are looking for the target object of shortcut symbols, as you can access the
target object from the shortcut property sheet and then locate the target object in the diagram.

Find in Diagram (or Find in Document View) is available from:

e The Browser — Right-click an object in the Browser and select Find in Diagram (or Find in Document View)
from the contextual menu.
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e The Result List — Right-click an object in the Result List and select Find in Diagram (or Find in Document View)
from the contextual menu.

e The object property sheet dropdown menu — Open an object property sheet and select Find in Diagram (or
Find in Document View) from the dropdown menu at the bottom-left corner.

e Anobjects list — From an objects list, select an object in the list and click the Find Symbol in Diagram tool in
the list toolbar.

1.5.1.5

Specifying Diagrams as Related Diagrams

You can use related diagrams to further define the behavior and implementation of objects and to view them from
different angles and in terms of semantic relationships. You can associate any type of diagram open in the
workspace with an object, including diagrams from other packages or models.

To specify that a diagram is a related diagram of an object, open the property sheet of the object and click the
Related Diagrams tab. If this tab is not visible, click the More button. The following tools are available:

Tool

=

Description

Properties - Opens the property sheet of the selected diagram.

2]

Open Diagram - Opens the selected diagram.

1 Note

If the object is not composite (and so does not have any child diagrams), you can navigate to the first
related diagram in the list from an object symbol by pressing Ctrl and double-clicking the symbol. To navi-
gate to any related diagram in the list, including for composite objects, right-click the symbol and select

|} Related Diagram > <Diagram Name> }

=

Add Objects - Opens an object selection dialog to select existing diagrams and add them to the list.

Create an Object - Creates a new diagram, and adds to the list as a related diagram. You must specify the
location (model) and type of diagram to create and give it an appropriate name.

1 Note
To create a new diagram and associate it to the object from the object symbol, right-click the symbol and

select |+ Related Diagram ¥ <New> 4.
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1.5.1.6 Deleting a Diagram
When you delete a diagram, you delete a view of a model or a package. This action does not affect the objects in
the model or package.
Context
You can delete a diagram in any of the following ways:
e Select the diagram node in the Browser and press the Del key.

e Right-click the diagram window background and select | Diagram ¥ Delete J from the contextual menu.
e Select|p View » Diagram » Delete 3.

1.5.1.7 Printing Diagrams

You can print the currently selected diagram at any time. You can print the whole diagram, a selection of pages, or
a selection of objects.

Context

1 Note

To print detailed information about model objects, create a model report (see Reports [page 324]).

Procedure

1. [optional] Select symbols in the diagram in order to print them and exclude the others.

2. Select | File » Print 3, or click the Print tool to open the Print Diagram dialog, which displays default print
options and the number of printed pages needed for the diagram.
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Print Diagram |

Humber of copies: 1 = [ Bz _I

— Page range I
Al

= From; I T I
&+ Selected

— Z00Mm
Mumber of 4 -

pages L ﬁ —
Page zcale: 100% _‘%’_, - -

" Fitlopages: [4:2 - ;F =

¥ Center in pages -

— Print optiohz
W Erame [ Corer

b ade: ¥ Black & white _|;|
" Colar LI 3

— Printer
M arie: IH'\Dps-paris'\pr-paris-EE j Fage Setup |
Type: HP Lazerlet BSi/55) M PS Paper: Ad
Wwhere: Sybaze/Europe/France/Paris Orientation:  Portrait
Cornment: ath Floor - SDP Resolution: 00 DPI

k. I Cancel

3. [optional] Specify the pages to print in the Page range groupbox or by clicking in the Preview pane (see Print
Diagram Options [page 191]). Only pages with an overlaid page frame will be printed.

4. [optional] Specify a page scale or set of pages to fit to (see Print Diagram Options [page 191]). By default,
diagrams are printed at 100% scale on as many pages as necessary.

5. [optional] Click the Page Setup button to open the Page Setup dialog and specify your page layout (see Page
Setup Options [page 192]).
6. Click OK to start printing.

1.5.1.71 Print Diagram Options

You can preview the selection to be printed and specify various options in the Print diagram dialog box.

Description

Number of copies Specifies the number of copies to print.
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Option

Page range

Description

Specifies which pages to print. You can choose between:

e All- Prints all the pages of the diagram.

e From / To - Prints a range of pages covered by the diagram. The corresponding pages are
framed in the Preview window.

e Selected - Prints the pages you select in the Preview window.

Number of pages

Displays the number of pages required based on your zoom options.

Page scale

Specifies the scale at which the diagram will be printed.

Fit to pages

Reduces the scale of the diagram to print it on the number of pages specified, for example 1x3.
The Number of pages option is updated and the Center in pages option is unavailable. To apply

these changes to your diagram, select |} Symbol > Fit to Page File 1 and |} File > Page

Setup ] for paper orientation.

Center in pages

Centers the diagram in the pages that it covers. The Fit to pages option is unavailable.

Frame Draws a solid line border around the image on all pages.

Corner Specifies the printing of crop marks in each corner to help align multiple pages.

Mode Specifies whether the diagram will be printed in Black & White or Color.

Printer Select a printer from the Name list. Click the Page Setup button to modify printer parameters.

1.5.1.7.2

Page Setup Options

The Page Setup dialog allows you to modify standard printer parameters, such as Paper, Orientation and Margins,
and to add various kinds of information to the Header, Footer and Page of your printed diagram.

You can arrive at the Page Setup dialog by selecting | File ¥ Page Setup 3, or by clicking the Page Setup button in
the Print Diagram dialog (see Printing Diagrams [page 190]).

The following fields let you specify the content of the header and footer:
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|
Option Description

Header Specifies the content of the page header. You can insert fixed text and use the arrow button to the right of
the field to insert one or more of the following variables:

® Current Date - inserts the date

e Current Time - inserts the time

e Current Page - inserts the content of the Page field
e |ast Page - inserts the number of the last page

e Diagram - inserts the diagram name

® |ocation - inserts the file path

® Model - inserts the model name

e Package - inserts the package name

e Module - inserts the model type

e Application Name - inserts "PowerDesigner"

Footer Specifies the content of the page footer. You can insert fixed text and use the arrow button to the right of
the field to insert the same variables as for the page header.

Page Specifies the page number format to use in the header and footer. You can insert fixed text and use the
arrow button to the right of the field to insert one or more of the following variables:

® Page Row - inserts the diagram pagination grid row number. This can be useful to help assemble large
diagrams printed on multiple pages. You may need to zoom out to see the diagram pagination grid:

e Page Column - inserts the diagram pagination grid column number

e Page Number - inserts the standard page number
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1.5.1.8 Converting a Diagram to a Package

PowerDesigner lets you convert a diagram to a package. You can move all the objects in the diagram to the new
package or specify only certain objects. Other objects will stay in their original package and be represented via
shortcuts in the new package.

Context

The linking objects that you move keep their links in the target package and a shortcut is usually created in the
source package. The general rule being that conceptual modeling must be preserved.

Shortcuts creation rules in PowerDesigner also apply to moving objects between packages (see Shortcuts and
Replicas [page 484]).

Procedure

1. Select|» View » Diagram » Convert to Package . (or right-click the diagram background window and select
Diagram » Convert to Package . or right-click the diagram node in the Browser and select |» Convert to

Package .3) to open the Convert Diagram to Package wizard. By default the package takes the name of the
diagram.

Convert Diagram to Package

=] E3

Welzome to the Convert Diagram to Package wizard. T hiz
wizard alloves you to create a new sub-package and move
objects inzide. The original diagram will be prezerved in the
new package.

Chooze a name for the new package.

Mame: | GELHESEEN

T

Code:  |MAIN DIAGRAM

< Black I Hest » I Finizh Cancel Help
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2. Click Next to open the Selecting Objects to Move page, which lists all the objects in the diagram available to
move to the new package. Objects are organized by object type, with a sub-tab for each object type. By default,
all the objects are selected.

I =] E3

Selecting Objects to Move

Yau can now select the objectz vau would like to mave to the new
package object. Shortcutz will be created in the new packaage far the
objectz you have not zelected.

By - Oy » ¢ Gl

State | M ame | Code | E nitity 1 | E ity 2 | FParent | -
"Ji... Belong... BELO... Project  Tazk Conce...
=:= Wi.. Belong.. BELO.. Divizion Emplo.. Conce...
=:= Wi...  Chief CHIEF Emplo...  Emplo... Conce...
=:= Wi.. Compo.. COMP.. Material  Matenial Conce...
=:= Wi lsdon.. 15_D0O.. Task Partici... Conee.. ||
=:= Wi, lgresp.. I5_RE.. Emplo.. Progct Conce..
*""-.fi... kember  MEMB... Team Emplo...  Conce...

v =:= “Wi.. Subco.. SUBC.. Custo..  Project Conce... j
A | = I Ertity }\Relaticunship ,{Inher'rtance }\Inher'rtance Link ,J'

Obiject(z] zelected: | 10410

=i Firish |

< Back | Cancel | Help |

3. [optional] Deselect any objects you do not want to move to the new package. Objects deselected here will
remain in the original package and be represented in the new package via shortcuts.

4. Click Finish to create the new package and move the selected objects to it.

The new package and diagram are added in the Browser.

1.5.1.9 Moving a Diagram to a Package

In some cases, you may want to move a diagram and some or all of the objects it contains into another package or
composite object, such as a process or activity.

Context

The linking objects that you move with the diagram keep their links in the target package and a shortcut is usually
created in the source package. The general rule being that the design of the original diagram must be preserved.

Shortcuts creation rules in PowerDesigner also apply to moving objects between packages (see Shortcuts and
Replicas [page 484]).
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You can simply drag and drop the diagram from one package to another in the Browser to move all the objects in
the diagram to the target package. To control which objects are moved, use the wizard.

Procedure

1. Select|» View » Diagram » Move to Package . (or right-click the diagram background window and select
Diagram » Move to Package . or right-click the diagram node in the Browser and select |j» Move to
Package .3) to open the Move Diagram to Package wizard.

Move Diagram to Package

IS [=] E3

Ywelcome to the Move Diagram to Package wizard.

Thiz wizard allows pou to select the dizplayed objects that will be moved
with the diagram. Shortouts will be created for the objects not zelected
i arder ko prezerve the diagram contents.

Chooze a new target package for the diagram.

< Back I MNewt > I Finizh Cancel Help

2. Select the target package to which you want to move the current diagram and click Next to open the Selecting

Objects to Move page, which lists all the objects in the diagram available to move to the new package. Objects
are organized by object type, with a sub-tab for each object type. By default, all the objects are selected.

Core Features Guide
196 PUBLIC Modeling with PowerDesigner



Selecting Objects to Move

IS [=] E3

Y'ou can now select the objectz vou would like to move to the new
package object. Shaortcuts will be created in the new package far the
objectz you have not zelected.

- By - Bt
State | I arme | Code | Farent |
I Visible Custarmer Custarner Object-Orien...
;rl'; Wigible Salez Rep Salez_Rep Object-Onen...
% Wizible Store Manager  Store_Mana...  Object-Orien...

E\.&.mnr AlUse Case ) Use Case Association /

Objectz] zelected:

343

< Back |

Mest > | Finish |

Cancel |

Help |

3. [optional] Deselect any objects you do not want to move to the new package. Objects deselected here will
remain in the original package and be represented in the new package via shortcuts.

4. Click Finish to move the diagram to the new package.

If the last diagram is moved or deleted from a package, a new diagram is automatically created as all packages

must contain at least one diagram.

1.5.1.10 Moving Entities Between Packages in a CDM

In a CDM, when moving entities containing data items from one package to another, different rules apply

depending on where the data items are used.

Data items Namespace

Only used by selected entity Move within the same name-

space

‘ Move result

The data items are moved with the entity.

Reused among different entities | Move within the same name-

space

Shortcuts of data items are created for reused data items.

Used only by one entity or Change namespace

reused among different entities

The data items are copied in the other namespace.
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1.5.2 Dependency Matrices

You can create dependency matrices to review and create links between any kind of objects. You can create an
individual matrix from the Browser or define a matrix in a resource file for reuse.

Context

In the following enterprise architecture model (EAM) example, systems are listed along the top of the matrix, and
linked to the sites where they are in use, via traceability links:

Backup i Finance ;
Backup Live | Offhne Finance Fayroll | Purchasing | Sales Production
Europe
France
Lyonz ¥ .
France |Marzeiles v ¥ -
Paris -«
Europe Spain
Barcelona +
Spain  |Bilbao ¥ ¥
 adrid ¥ -
s
Chizago -
115 Mew vork, ¥ ¥
San Francizco ,/ + vy
Procedure

1. Right-click a model or package node in the Browser and select |» New » Dependency Matrix 3 to open the
matrix property sheet to the Definition tab.

2. Select an object type from the current model to populate your matrix rows and an object type from the current
or another model type to populate the columns.

3. Specify how the rows and columns of your matrix will be associated by selecting a dependency from the list.

In the following example, PDM tables are associated to users by the Owner dependency:
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Dependency Matrix Properties - DependencyMatrix_1 (DEPENDENCYMATRIX... =]

Gereral  Definition | M otes I

— Object types

R Ij Table j
Columz: If:,. Idzer j @

— Matrix cells
Cependency: - IEI Advanced... |
Object type: I

Ohbject attribute: |<N|:-ne> j Mo walue: I

bore »» | % - | ] 4 I Cancel Apply Help

Only direct dependencies are available from the list. To specify a more complex dependency, click the
Advanced button to open the Dependency Path Definition dialog (see Specifying Advanced Dependencies
[page 200)).

4. For certain dependencies, the Object type on which the dependency is based will be displayed, and you can
select an Object attribute to display in the matrix cells along with the No value symbol, which is displayed if
that attribute is not set in any particular instance.

5. Click the General tab and enter a name for the matrix (for example Table Owners Matrix).

6. Click OK to complete the definition and open your matrix.

Results

1 Note

For information about defining a dependency matrix in a resource file (such as a DBMS definition file, object
language file or extension file) and for detailed information about its properties, see Customizing and Extending
PowerDesigner > Extension Files .
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1.5.2.1

Specifying Advanced Dependencies

You can examine dependencies between two types of objects that are not directly associated with each other,
using the Dependency Path Definition dialog, which is accessible by clicking the Advanced button on the Definition
tab, and which allows you to specify a path passing through as many intermediate linking objects as necessary.

Each line in this dialog represents one step in a dependency path:

Property ‘ Description

Name Specifies a name for the dependency path. By default, this field is populated with the origin and destina-
tion object types.

Dependency Specifies the dependency for this step in the path. The list is populated with all the possible dependen-
cies for the previous object type.

Object Type Specifies the specific object type that is linked to the previous object type by the selected dependency.
This field is autopopulated if only one object type is available through the selected dependency.

In the following example, a path is identified between business capabilities and roles, by passing from the business
capability through the processes it contains, to the role linked to it by a role association:

Il Dependency Path Definition | x|

T

IBusiness Function / Role

Dependency path:

Create as many rows az necezzary in the lisk below to provide a path through the metamodel
from ‘Buziness Function' to ‘Role"

Dependency

Object Tepe

Processes

Process

Rale Azzociations

Roale

=]

-
IR

Reset |

(] I Cancel |

Help |
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1.5.2.2 Working with Dependency Matrices

The dependency matrix displays the connections between the objects of the types specified in your definition. You
can add and delete connections in the matrix as well as filter the rows and columns displayed and print or export
the matrix.

In the following example, the same hierarchy of business processes is shown in the row and column headers in
order to analyze the dependencies between them:

" & 2
[} m =
] 23] %
= o e
[&] [IE] =]
[E] = =
= = iz
fa = =
[m)]
=
= W
c g o= 5| £
[=] ol=1% TS| o =3
HEEHEEHEERRE
[} m = =
1l MEIFI AT 2l2|12]€]| a| @
z bl (2 (=] % Glo|ElE|la|E| = E|E
o= o | @ =l=sl=1=1al=
slBlalzlEl2lelgl2l2lE|l5 |l L
gl=|lo|g|wm|TB|oc|=|@|@m|m|S|=|™
Ola|lC|lew|x|lElo|lo|E|IE|lE|o|m |
Comnunication / 4 R
Direct Sales
Feqister Order ¥
Direct Sales Send to Manufacturning v
Walidate Order ¥ + e
Indirect Sales
: Contact Partner
Indirect Sales -
Crganize Event ¥
b arufactuning | v
b anufacture
: hd aterial Caontral +
b arufactuning -
[uality Azzurance ¥
Shipping Y
Flarnning oy

You can modify the links in the following ways:

e Toadd a link, click in the appropriate cell, and then click the Create link button at the bottom of the matrix (or
press the or[v]).

e Todelete alink, click in a cell containing a link, and then click the Delete link button at the bottom of the matrix
(or press the | spacebar|or|pel ).

e To select all the cells in a row or column, click the appropriate header. To select multiple cells, rows, or
columns, use the key. To select ranges, use the key or drag the cursor over the required area.
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The following tools are available above the dependency matrix:

Tool Description

|§| Properties — opens the property sheet of the object associated with the selected row, column, or cell.

|I='EE| Copy — Copies the entire matrix for pasting into a CSV environment such as Excel or a plain text file.

|E| Select Rows/Columns (ctrl] + [N]) - Opens a selection box which allows you to select rows and col-
umns to display in the matrix either by hand or by defining a filter (see Adding an Item from a Selection
List [page 130]).

Display only Non-Empty Rows/Columns ( + ) — Filters the display to show only rows/columns
that are populated.

Display only Empty Rows ( + ) — Filters the display to show only empty rows.

£ | [

abe

Vertical/Horizontal Column Header - Toggles between vertical and horizontal orientation of column head-

ers.

Shrink to Fit - Shrinks row and column headers to fit their contents.

Show Parents in Row Header - Displays the hierarchy of objects that are ancestors to the row objects.

Show Parents in Column Header - Displays the hierarchy of objects that are ancestors to the row objects.

Show Packages in Headers - Displays the hierarchy of packages that contain the row and column objects.

Refresh - Refreshes the display of dependencies in the matrix.

Export to Excel - Exports the matrix as an MS Excel file. If the specified file already exists, you will be given
the option to overwrite it or append a new worksheet in the file.

1 Note

You can modify the definition of the dependency matrix at any time by right-clicking its Browser node, selecting
Properties, and clicking the Definition tab.

1.5.3 Symbols

PowerDesigner gives you wide control over the formatting and arrangement of your object symbols.

The following symbol modes are available:
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1
Mode YT

Icon: Most EAM and DMM objects support icon or picture symbols that display a name or
other limited information beneath them. To switch between icon and detail mode, right-
click the symbol and toggle the Show Detail command or press CTRL+Q.

To change any object symbol to anicon, select a Custom Shape of type Bitmap in the
Symbol Format or Display Preferences dialog.

Detail: All objects support detail symbols (rectangles or other shapes) that can contain exten-
sive information about the object inside the symbol, including lists of sub-objects. To

control the information displayed, use the Content tab in the Symbol Format or Display

m My Systemn .
Preferences dialog.

SubSystern 1

SubSystem 2

Editable Composite: Some EAM objects (and CDM and LDM entities using the Barker notation) support ed-

itable composite symbols that allow you to create or drag and drop sub-objects on the
symbol.

m My System

To switch between composite and detail mode, right-click the symbol and use the
— == Composite View submenu.

P P
“‘ “O
.-'\. ."\.
. -

SubSystern 1 SubSystem 2

Read-Only Composite: Decomposed BPM processes and OOM activities and packages in all types of models
support read-only composite symbols that display the object's sub-diagram. To de-
scend into the sub-diagram for editing, press and double-click the symbol. To go

back up to the parent diagram, press + .

My Process

® To change the format or content of one or more individual symbols, select them, then right-click in the
selection, and select Format. Use the commands Get Format and Apply Format to copy the format of one
symbol to another.

e To change the format or content of all the symbols in a diagram, select | Tools ¥ Display Preferences .

e To arrange and manipulate groups of symbols, use the Symbol menu.
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1.5.3.1 Manipulating Symbols

You can select symbols in a PowerDesigner diagram using standard gestures. You can edit properties of the
selected symbol's object or it's sub-objects, and resize the symbol by clicking and dragging on its handles.

Click on a symbol with the default Pointer tool to select it. To select:

e Additional symbols, press and hold while clicking them.
e Allsymbolsin an area, click and hold while dragging the pointer over the area.

e All symbols connected to a symbol, click the symbol and then select |» Edit » Select Connected Symbols 3
e All symbols in the diagram, press + [a] click the Grabber tool, or select |} Edit » Select All 3

In the following example, the Customer table is selected, and can be moved by dragging or resized by dragging on
one of its handles:

. Sul.:-c-:-n.tra-::t.

1 Note

To resize all the symbols in a diagram at once, click the Grabber tool and then drag one of the handles.

When a symbol is selected, clicking on one of its object properties lets you edit its value. Now, the table name is
selected for editing:

.Sul.:ucnn.trac't.

When an object property is selected for editing, you can navigate through its editable properties and on into its
sub-object properties by pressing the|rab|or|shift| + [Tab|keys.

Core Features Guide
204 PUBLIC Modeling with PowerDesigner



1 Note

You can control the object and sub-object properties that appear on a symbol using display preferences
(I Tools # Display Preferences 3).

When a symbol is selected, clicking on one of its sub-objects selects that sub-object. Now, the Customer
activity column sub-object is selected:

.Sull:ucnn.tr.act.

You can navigate up and down in the list of sub-objects by pressing the Up Arrow or Down Arrow keys. When a sub-
object is selected, clicking on one of its properties lets you edit its value. Now the Customer activity column
name is selected for editing:

. Sul.:-c-:-n.tra-::t.

To create a new sub-object at the end of the list, press + [n] Toinsert a new sub-object above the selected

sub-object, press + [1] To delete the selected sub-object, press|pe1]. Right-clicking a sub-object opens a
contextual menu offering useful commands.

When a sub-object property is selected for editing, you can navigate right and left along the line of its editable
properties by pressing the|Tab|or|shift| + |Tab|keys.

1 Note
The following kinds of properties are not editable via object symbols:

e Boolean properties, such as the Abstract property on OOM class symbols.
e Custom indicators, such as those used to identify keys and indexes on PDM table symbols.
e (Certain calculated properties, such as Domain or Datatype on PDM table symbols.
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1.5.3.2 Manipulating Link Symbols

You can add and remove corners to and from link symbols, and change the objects that they connect.

Procedure

1. Draw a link between two objects:

Class A Clas=B

2. Press Ctrl and click a point on the line to create a handle where you want to insert a corner:

Class A Class B

3. You can add a second handle, or as many as you need:

Class A Class B

4. To create a corner, click and hold the handle and then drag it to where you want the corner to be:
Class A /:L\E% Class B
| |

5. You can drag the other handles too:

Class A Clas=B

6. Toremove a handle (and corner), press Ctrl and click on the handle to remove:
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Class A
[
1 Note

Clas=z B

To move an extremity of a link symbol from one object to another, click to select the link, and then drag the
end handle to the new object.

1.5.3.3

Formatting, Aligning, Ordering, Grouping, Hiding, and

Protecting Symbols

The Symbol menu provides various options for formatting and arranging your symbols.

Menu ltem

Format ( +
[r)

Function

Opens the Symbol Format dialog, which allows you to control appearance and content of the selected
symbols (see Symbol Format Properties [page 213]).

Get Format Copies the format of the selected symbol, making it available for applying to other symbols. Only avail-
able if a single symbol is selected.
Apply Format Applies the format copied with Get Format to the selected symbols.

Restore Format

Restores the default formats to the selected symbols. These may be the standard formats or any cus-
tom symbol formatting defined in an extension file (see Controlling the Format of Custom Symbols

[page 217]).

Restore Format For All
Diagrams

Restores the default formats to all symbols in all diagrams in the model.

Shadow ( +
[w)

Applies the standard shadow effect specified in the Symbol Format dialog to the selected symbols.

Adijust to Text (
+ )

Expands or shrinks the width of the selected objects to fit the length of their names.

Normal Size

Applies the default size specified in Display Preferences to the selected objects.

Fit to Page

Opens the Fit to Page dialog, which gives the number of pages currently used and allows you to specify
a display scale, the number of pages to use, or to center the symbols on pages.

Auto-Layout

Rearranges the symbols in the diagram (see Auto-Layout [page 209]).

Align

Provides various means for aligning the selected symbols (see Aligning Selected Symbols [page 210]).
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Menu Item Function
Disposition Arranges the selected symbols in various ways:
e Horizontal ( + )/Vertical ( + ) - Straighten selected link objects and makes
them horizontal or vertical where possible.
e Flip Horizontal/Flip Vertical — Reverses the relative positions of two or more selected symbols. In
the case where Table_1 is directly above Table_2, selecting them and then choosing Flip Hor-
izontal, will reverse their places so that Table_2 is now directly above Table 1.
® Arrange Symbols — Spaces the selected symbols evenly.
e Arrange Connectors — Straightens the selected link symbols and centers their endpoints in the
objects that they connect.
e Arrange Attach Points - Centers the endpoints of the selected link symbols in the objects that they
connect.
e Arrange Attached Text — Reverts labels associated with the selected link symbols to their default
positions.
Order Promotes or demotes the selected symbols in relation to other overlapping symbols in the diagram.
You can:
® Bringto Front
e Send to Back
® Bring Forward
e Send Backward
By default, when you place a free symbol such as a note on a design object symbol such as a table, the
free symbol is placed behind the object, as free symbols are usually used as backgrounds.
When symbols overlap, it may not be possible to select the symbol in the background, even if its han-
dles are visible, without moving the symbol in front of it.
Group Groups selected symbols, allowing them to be selected, moved, and resized as a single block.
Ungroup Separates selected objects that were previously grouped together.
Hide Hides (makes invisible) the selected symbols. You may want to do this to make a large model more

readable, or to focus on only a particular part of a model.

Show / Hide Symbols

Opens the Show Symbols dialog, which lets you select symbols in the diagram to show or hide (see
Showing, Hiding, Protecting, and Unprotecting Symbols [page 211]).

Protect Protects the selected symbols, making them impossible to select and edit.

Unprotect All Unprotects the selected symbols, making them available to select and edit.

Protect / Unprotect Opens the Protect Symbols dialog, which lets you protect and unprotect individual symbols in the dia-
Symbols gram
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1.5.3.3.1 Auto-Layout

The auto-layout command automatically rearranges symbols in diagrams in order to simplify the routing by
minimizing node and link overlaps and reducing the distances between related nodes.

Context
1 Note

Auto-layout is not available for the OOM sequence diagram or any diagram containing swimlanes.

Procedure

1. Select|l Symbol p Auto-Layout 3to open the Auto-Layout window.

Auto-Layout El

Shyle:

= = S T = T

e — e _ll_ = [~

“ L L 1 = L

Bazic Hierarchical Organic Orthogonal Circular Tree
— Placement

Origrtation : Top to Bottarn j

¥ Move zelection to free space

— Apply scope

{* Selected symbols £ 4l symbals

Drefault Set Az Default ak. I Cancel Help

2. Only the styles relevant for the current diagram can be selected. Choose one of the available styles:

o Basic — Provides minimal rerouting for any diagram style.

Hierarchical — Highlights the main direction or flow within a directed graph. You can additionally specify an
orientation for the flow within the graph.

o Organic — For undirected graphs.

Orthogonal - For undirected graphs. You can additionally specify an orientation for the flow within the
graph.
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o Circular — Produces interconnected ring and star topologies to emphasize group and tree structures
within a network. You can additionally specify a cycle or radiation shape.
o Tree — For directed or undirected trees. You can additionally specify an orientation for the flow within the
graph.
3. [if you have selected one or more symbols] Specify if you want to apply the auto-layout to all or only the
selected symbols.
When applying Auto-Layout to a selection, you can additionally check the Move selection to free space option
to extract the selected symbols from the main body of the diagram and place them in free space.
PowerDesigner may create graphical synonyms (see Creating Graphical Synonyms for Object Symbols [page
2197) for certain symbols in (or adjoining) the selection to minimize the length of connecting links.

4. Click OK to apply the auto-layout and return to the diagram.

1 Note

You can, at any time, click the Default button to revert to the default auto-layout settings. Click the Set As
Default button to set the currently selected style as the default.

1.5.3.3.2 Aligning Selected Symbols

The Alignment toolbar and Symbol Align submenu both provide multiple tools for aligning symbols selected in the
diagram.

Tool Action

I= Left - Aligns left borders of selected symbols with leftmost selected symbol

& Center on vertical axis - Centers selected symbols on the most central selected symbol

= Right - Aligns right borders of selected symbols with rightmost selected symbol

= Same width - Stretches selected symbols to the width of the selection area (from the leftmost symbol to the
rightmost symbol)

I=( Evenly space horizontally - Assigns equal space between three or more symbols on a horizontal axis

it Top - Aligns tops of selected symbols with topmost selected symbol

-} Center on horizontal axis - Centers selected symbols on the most central selected symbol

a4 Bottom - Aligns bottom borders of selected symbols with lowest selected symbol

|I| Same height - Stretches selected symbols to the height of the selection area (from the topmost symbol to
the lowest symbol)
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Action

I Evenly space vertically - Assigns equal space between three or more symbols on a vertical axis

1.5.3.3.3 Showing, Hiding, Protecting, and Unprotecting
Symbols

For PowerDesigner objects that have symbols, a symbol is displayed in the diagram when you create the object.
You can hide symbols to improve the focus or readability of the diagram without deleting its object. You can protect
diagram symbols to prevent them from being moved or deleted.

To hide or protect one or more symbols in the diagram, select them and then select [ Symbol » Hide 7 or Protect.

To show symbols, drag their objects from the Browser or from another diagram into the diagram or use the Show
Symbols dialog. To open the Show Symbols dialog, select [ Symbol » Show / Hide Symbols 3 or right-click the
diagram background and select | Diagram » Show Symbols :

Show Symbols BT
e I I - T A

Show Mame Code Parent Protect *

] Visible Division DIVISION  Physical ...  Unprotect...
1 \Visble Employee  EMPLOY.. Physical ... Unprotect...
] ] Visible Customer CUSTOM... Physical ... Unprotect...

m

] ] Visible Project PROJECT  Physical .. Unprotect. .
1 & Visible Team TEAM Physical ...  Unprotect. .
1 Visible Task TASK Physical ...  Unprotect. ..

= Visible Material MATERIAL Physical .. Unprotect... &
\isble Paicipate PARTICI... Physical ... Unprotect...
] Visible Member MEMBER  Physical .. Unprotect... il

||+ | Table A Diagram j Reference /

Selected object]z): | 8/11

EErntect Symbalz = aF. | Cancel | | Help |

R O e e o i
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To open the Protect Symbols dialog, select | Symbol §# Protect / Unprotect Symbols 3 or click the Protect
Symbols button at the bottom-left of the Show Symbols dialog:

Protect Symbols B=nEoh="

T B - v BB W W

Protect Mame Code Farent |
1 & Unprote... Division DIVISION Physical Dat...
] Protected Employes EMPLOYEE  Physical Dat...
O= Unprote... Customer CUSTOMER Physical Dat... =
] &2 Unprote... Project PROJECT Physical Dt ..
] &3 Unprote... Team TEAM Physical Dat...
(] Unprote... Task TASK Physical Dat... 1
1 & Unprote... Material MATERIAL Physical Dat...
1 Unprote... Participate PARTICIPATE  Physical Dat...
O= Unprote... Member MEMBER Physical Dat... w
[+ | Table 4 Diagram j Reference /

Selected object(z): | 1/12
£< Show Symbolz | ak. | | Cancel | | |

In both dialogs, object symbols are organized by type in sub-tabs. If shortcuts, traceability links and/or free
symbols are present in the package, they appear on their own sub-tabs. You show and hide symbols by selecting or
deselecting them.

The following tools are available for selecting symbols:

Tool

Description

Opens a dialog to select objects from other packages or open models to display them in the current diagram.

FEPE

Selects or deselects all objects in the current tab. To select or deselect all objects on all tabs, press the
key as you click or click the arrow and select All Pages.

At

=l Moves all selected object to the top or bottom of the list.
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1 Note

When you hide or show links or objects with links, the following rules apply:

e Hide an object - Links attached to the hidden object are also hidden
e Show an object - Links attached to the object are shown if the object at their other extremity is already visible.
e Show alink - The objects at both ends are also shown.

Ina CDM, the following rules apply:

e Hide a parent entity - Inheritances for which the hidden entity is the parent are also hidden.

e Show an association - Entities and association links attached to the association are also shown.

e Show an association link - Entities and associations attached to the association link are also shown.

e Show an inheritance - Parent and child entities and inheritance links attached to the inheritance are also
shown.

e Show an inheritance link - Parent and child entities and inheritances attached to the inheritance link are also
shown.

1.5.3.4 Symbol Format Properties

You can change the size, line style, fill, shadow, font, alignment, shape and content of symbols in the Symbol
Format dialog. Some items may not be available if your modeling methodology restricts the modification of
symbol format or content.

You may arrive at the Symbol Format dialog when changing the format of:

e One or more individual symbols — select the symbols and then press + [r] select [ Symbol »
Format 3, or Format from the contextual menu.

e All symbols - via display preferences (see Display Preferences [page 227]).

e Custom symbols defined for extensions — see Customizing and Extending PowerDesigner > Extension Files .

1 Note

When defining the format of custom symbols in the Resource Editor, each tab in the Symbol Format dialog
contains two additional options, Apply <format> to symbols, and Allow users to modify symbol <format>,
which allow you to control the default format of symbols and whether users can modify them to a very fine
degree. For more information on these options, see Controlling the Format of Custom Symbols [page 2171].
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Size Tab

The Size tab controls the size of the symbol and how the size can be manipulated:

Property Description
Current size Specifies the width and height (in pixels) of the symbol.
Normal size [read-only] Specifies the default width and height (in pixels) for symbols of this kind.
Auto-adjust to text [Default] Auto-resizes the width of the symbol to display all the text it contains up to the value speci-
( + ) fied for word wrapping in the diagram (see General Settings Display Preferences [page 228]).
This option is disabled if you select the Keep size preference or manually resize the symbol and can
be reapplied by selecting the symbol and pressing + .
Keep aspect ratio Maintains the ratio of height to width when manually resizing the symbol.
Keep center Maintains the center position of the symbol when resizing it.
Keep size Prevents the resizing of symbols through:
e Manual resizing
e The Auto-adjust to text preference (which is mutually exclusive with this preference).
® The creation of sub-object symbols in editable composite symbols (see Using Composite View
to Display Sub-Objects within a Symbol [page 219]). Selecting this option prevents the symbol
from growing to accomodate the addition of sub-symbols and may cause their display to be
truncated due to lack of space.
Line Style Tab

The Line Style tab controls the color, size and format of lines (for link and other one-dimensional symbols) and
borders (for two-dimensional symbols, such as classes or tables). You can modify the line style of any symbol in
the model.

Property Description

Color Specifies the color of the line or border.

Width Specifies the thickness of the line or border.

Style Specifies the format of the line or border, such as invisible, solid, dashed or dotted.

Corners [Link and line symbols only] Specifies the format of corners, such as sharp or rounded right-angles
and free angles.

Arrow [Link and line symbols only] Specifies the format of the link or line symbol at its Beginning, Center,
and End.
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Property Description

Use perpendicular arrow | [Link and line symbols only] Specifies that the link or line object always touches objects at its ends
at aright angle. This option allows you to use free angles for the body of a link or line object, while
retaining a connection at right angles for its beginning and end.

1 Note

These options may be overridden by the design semantics of a link symbol (such as a PDM reference).

Fill Tab

The Fill tab controls the color, content, and effects for symbol filling.

Fill effects Description

Fill color Specifies the color to use for the fill.
The Fill color check box is available for free symbols, packages, interaction fragments, and swimlanes,
and when cleared will create a transparent symbol. This can be useful when you wish to use an "in-box"
UML representation, for packages for example.
Note that transparent objects can only be selected by clicking near their borders.

Image Specifies a graphic file to display within the symbol. Click the Modify button to select a file.

Display Mode Specifies the alignment of the image within the symbol.

Gradient Specifies the gradient fill options. Click the Modify button to open a dialog allowing you to control Start
and End colors, End Color Luminosity, Shading Style and Gradient Mode.

Shadow Tab

The Shadow tab allows you to add a standard, 3D effect or gradient shadow to objects in a diagram.

Font Tab

The Font tab allows you to define the display preferences for the font, size, style, and color of text associated with
symbols in the model. When you modify font preferences, they apply to all existing and new symbols.
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Text Alignment Tab

The Text Alignment tab allows you to define the alignment of text in text boxes and rectangles, ellipses, rounded
rectangles, and polygons.

1 Note

You can only control the text alignment for these shapes, and not for model object symbols. When working with
RTF, all the options but Vertical are disabled.

Parameter Description

Center Centers the text horizontally and vertically.

Word wrapping Auto-wraps text in the symbol.

Horizontal Aligns text to the left, center, or right on the horizontal axis.

Vertical Aligns text to the top, center, or bottom on the vertical axis
Custom Shape Tab

The Custom Shape tab allows you to define a new symbol shape for most non-link symbols.
1 Note

Custom shapes with the Content position set to Under cannot display collections or attribute icons.

Property Description

Enable custom shape Enables or disables the customization of a symbol shape

Shape Type Specifies the type of shape to be used. Choose one of the following values, and then click the Browse
button to select an image (see Browsing for Images [page 221]):

® Predefined symbol - Default shape assigned to symbols in PowerDesigner.

e Metafile (EMF, WMF) - Representation using geometrical formulas allowing for resizing and
stretching.

e Bitmap (DIB, RLE, JPG, JPEG, TIF, TIFF, PNG) - Representation of a graphics image consisting of
rows and columns of dots.

e |con (ICO) - Small picture representing an object, usually smaller than standard PowerDesigner
symbols.

Shape Name List of the available shapes of the selected type. Click the Browse button to select shapes.
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Property Description

Content position Specifies where the object name and any other properties should be displayed on (or under) the
symbol (Center option is not available for icon shapes).

Content Tab

The Content tab allows you to specify the information that you want to display on the symbol. The properties that
are listed on this tab as being available for selection are controlled by the content display preferences (see Content
Display Preferences [page 231]).

Sub-Objects Tab

The Sub-Objects tab is only available when you open the Format tab after having selected a single object. It allows
you very fine control over the sub-objects (such as PDM table columns or OOM class attributes and operations)
that you want to display inside your object symbol. For each individual sub-object, you can decide whether to
display it or not, and what font to use for its display.

1 Note

For a collection of sub-objects to be available for selection and customization here, the collection must be
selected for display in the object's content display preferences (see Content Display Preferences [page 231]).
Where the number of lines to display for a collection is limited in the display preferences, that limit will take
precedence over any choices you make here.

Each collection of sub-objects that is enabled in the display preferences has its own sub-tab. For each sub-object,
you can:

e Select to display or hide it in the parent object symbol by selecting or deselecting its checkbox in the [D]isplay
column.

e Apply a specific font to its display by clicking the Select font tool or the ellipsis button in the Specific Font
column.

1 Note

When not all sub-objects in a collection are selected for display, the parent object symbol will display ellipses to
indicate that more items are available.

1.5.3.4.1 Controlling the Format of Custom Symbols

When defining custom symbols for your object extensions, you may want to enforce certain aspects of the symbol
format, while allowing users some liberty to change others. If you open the Symbol Format dialog from a custom
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symbol in the Resource Editor, you can control the default format options for the symbol, and whether users can
edit them, on a per-tab basis.

For example, you could extend the PDM table metaclass with a criteria to specify a custom symbol with a red
border for tables that are anticipated to contain more than 1m records. You may want to enforce this border style
for all such tables while allowing users to change the font, size, content, and other aspects of the symbol format.

When you access the Symbol Format dialog from a custom symbol in the Resource Editor, the following additional
options are available at the top of each tab:

Option Description

Apply <format>to | Specifies that the format options on the tab will be applied to custom symbols at creation time or when-
symbols ever the appropriate criteria are met or the specified stereotype applied.

If this option is not selected, the standard display preferences for the format options on the tab will be
applied and users are free to modify them.

Allow users to Specifies that users can modify the format options for the symbol and that any changes that are made
modify symbol will be respected in the event that the definition of the custom symbol is updated.
<format>

If Apply <format> to symbols is selected and this option is unselected, then the format options specified
on this tab cannot be changed by the user.

Click the Advanced button to open the Customize Content dialog to add or removed properties from this tab (see
Customizing Content Display Preferences [page 233]).

For detailed information about extending objects and creating custom symbols for them, see Customizing and
Extending PowerDesigner > Extension Files .

1.5.3.5 Finding Symbols from the Browser, Object Lists, and
the Result List

You can find all the symbols representing an object listed in the Browser, in a model list, or in the Result List
window by right-clicking the object and selecting Find in Diagram.

Context

If the object has only one symbol associated with it, the appropriate diagram is opened in the canvas with the
symbol centered.

If the object has several symbols in the present package or there are symbols representing shortcuts to the object
(see Shortcuts and Replicas [page 4841]) in other packages or models open in the Workspace, the Select Symbol
dialog opens listing all the available symbols with their parent model and diagram. To show only the symbols in the
present package in this dialog, deselect the Show symbols from other packages option. Select a symbol and click
OK to open its diagram in the canvas.
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1.5.3.6 Using Composite View to Display Sub-Objects within
a Symbol

Many objects (packages, processes, classes, activities, states, EAM objects, etc.) have the capability to display
sub-objects within their symbols through one or more composite view modes. Depending on the type of object,
the sub-objects can be displayed either as a static sub-diagram within the symbol or as dynamically editable
symbols that you can create and arrange directly from the parent diagram.

Context

To toggle between the different composite view modes, right-click a symbol and select Composite View and then
one of the following commands:

e None - display the parent symbol only without any sub-objects
e Read-only (Sub-Diagram) - display sub-objects in a non-editable sub-diagram that can be resized as
necessary. To access the sub-diagram, press Ctrl and double-click the symbol

e FEditable - allow the creation and arrangement of sub-objects directly within the symbol in the parent diagram.
e Adjust to read-only view - resizes the symbol to display all the objects in the read-only view.

1 Note

Not all modes are available for all objects that support composite view. Certain objects (for example, processes
in the BPM) must be decomposed before you can access composite view.

For information about the specific objects supporting composite view, see the appropriate modeling guide.

1.5.3.7 Creating Graphical Synonyms for Object Symbols

Graphical synonyms let you depict an object more than once within a diagram. This can improve readability by
reducing the length or complexity of links when you have an object that is linked to many other objects. You create

a graphical synonym by right-clicking a symbol and selecting | Edit » Create Graphical Synonym . You can create
as many graphical synonyms as you want within the same diagram, including graphical synonyms of graphical
synonyms and of shortcuts. Each graphical synonym displays the name of the object followed by a colon and the
number of the synonym.

1 Note

A graphical synonym is merely a second symbol representing an object within the same diagram. You can add
the same object to other diagrams in the same package or model by dragging and dropping it to them to create
an ordinary symbol. If the object must be referenced in another model (or in another package in the model), you
need to create a shortcut (see Shortcuts and Replicas [page 4841]).

In the following example, Employee : 1 and Employee : 2 bothrepresentthe Employee table:
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Emplayes : 1 Employee : 2
id =Undefined> id =Undefined=
first name =Undefined= first name =Undefined>
family name <Undefined= family name <=Undefined=

If you move an object for which you have created graphical synonyms from one package or model to another,
shortcuts are created for the graphical synonyms in the original package.

1 Note

To find any graphical synonyms of a symbol, right-click the symbol, select ||» Edit » Find Graphical Synonym
and then select a graphical synonym from the list. The graphical synonym is centered and selected in the
diagram window.

You can create graphical synonyms for link objects but only if both they and the symbols at both their extremities
(which will also be duplicated) support them. The following object symbols do not support graphical synonyms:
e CDM - inheritances and inheritance links

e (OOM - swimlanes, synchronizations, decisions, transitions, instance links, messages, association class links,
and interaction frames, fragments, and references

e BPM - swimlanes, synchronizations, decisions, and flows
e All-free symbolline

1 Note

Though you cannot visually distinguish a graphical synonym of a link from a normal link (unless you display the
name attribute), when you select a link symbol, it is identified as a graphical synonym in its tooltip:

TITLE: 2

TITLE ISBHN “phx
TITLEAUTHOR : 2 FUB_ID <t

TITLE_TEXT
Al D Apbe b =

TITLE_TYF
o= -
TITLE ISBEH®  =phktl= on TITLE_FRICE
T4_ORDER '

TITIE HNAOTES
Ta_FERCENT Reference 'Reference_7' between Table 'TITLE' and Table
TITLEAUTHOR' [Graphical Sunorym]
FER_FORMAT
FER_FREQUENCY
MONP_COLLECTIOMN
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1.5.3.8

Browsing for Images

The Select Image dialog lets you manage the images that you use in your model diagrams, and to insert them into
your models as object symbols, diagram backgrounds, etc.

Procedure

1. Open the Select Image dialog in any of the following ways:

o Right-click a diagram symbol and select Change Image.
o From the Symbol Format dialog Custom Shape tab, click the Enable Custom Shape check box, and then
click the Browse button next to the Shape type property (see Symbol Format Properties [page 2137).

o From the Symbol Format dialog Fill tab, click the Modify button in the Fill Effects group box (see Symbol

Format Properties [page 213]).

o Select|» Edit » Import Image

Select Image

Browse Images | Search Images I

(see Importing and Exporting Model Graphics [page 239]).

0] %]

Collections: g ml = (F Images: Type: |<AII> ~|  Dimension: |<AII> | [ % - =R
. Fecert Images = e -
El _,_: Erterprize Architecture , T : |
— - o ke e . R
(5 Accessonies &8 __ﬂ
=
L; Communic ation Accounting.ico Accounting. png Availbility. ico Aailbility. prg
=3 Computers
=] Databases
5 D ts and Fil . -
L; ocuments and Files e ._,r\‘vi_l : . ‘L‘{‘
= Frameworks - = \\ W i;“r i [
5 Industry - [ ) @ = '@_l,'i —
=3 Mohile
= Mulimedia Balance.ico Balance. png Bank Transaction.ico Bank
(5 Metwarking Transaction.png
(=] People
|5 Printers and Faxes i 5
5 Sites % :i/
[ Software /
[= Storage ) )
(55 Transportation Bazket.ico Basket.png Catalog.ico Catalog.png
(=7 Objects and Concepts i
&1 PowerDesigner lcons s =
G, . i
C3 Microsaft Office Clio Art LI 2 L ) '-._'—':h_ = LI
52 filets) Marne: piclib: //Enterprize Anchitecture, piclibH#Business\Accounting.ico
Type: Icon  Dimensions: 16, 32, 48 Size: 21,96 kB Colors: 256, 16M
ok I Cancel | Help |

2. Click a collection in the Collections pane to display its available images in the Images pane.

The following tools are available for this pane:
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Tool Description

ﬁ Open Image File - Lets you browse to an image file to select it directly without passing by an image
collection.

|3| Add Directory — Adds a directory to the list of collections. When you add a directory, any sub-direc-
tories containing images are also added along with any intermediate directories required to repre-
sent the directory tree.

| Add Executable or DLL - Adds an executable or DLL and all the images associated with it to the list
of collections.

|3| Remove Directory, Executable, or DLL — Removes a directory from the list of collections. Predefined
directories, such as Recent Images or Microsoft Office Clip Art cannot be removed.

|ﬁ| Up - Moves up a level in the collections tree.

3. [optional] In the Images tab, select an image type and/or dimension to filter by from the Type and Dimension
lists.

The following tools are available for this pane:

Tool Description
Type Filters images by type, such as PNG, Bitmap, Cursor, etc.
Dimension Filters images by dimension, such as 16, 48, 128, etc.
| | | —
= Refresh Preview — Refreshes the list of available images.
Delete Recent Image — Deletes a selected recent image.
e
|§ |§O |i Extra Large / Large / Medium / Small Icons — Change the display size of images in the Images
|_ pane.

4. Select animage and click OK to return to the Symbol Format dialog or to display the image in the diagram.

1.56.3.8.1 Searching for Images

You can search for images among your collections on the Search Images tab of the Select Image dialog.

Context

Core Features Guide
222 PUBLIC Modeling with PowerDesigner



Select Image

M=l E3
Browse Images  Search Images |
Search criteria Images: ﬂ | B | = =5 -
Y
Search For: Iﬂ
= & -
Type: f <l =]
Search in collections: [_Ih AnnotatedCompone... BusinessCommunic... BusinessCommunic... cdcompo. cur
_r Recent Images
[Fl=]) Enterprize Architecture
[#l=] Objects and Concepts " : )
= ; ol e,
[l PowerDesigner lcons g #
%2 Microsoft Office Clip A (COFO]
Belm1 windows Syster lcans CO-ROM.ico CD-ROM.prg Command Frompt.ico Command
Prarmpt.png
|
B
CarrunicationDiag... | CommunicationDiagrafp  Compact Flazhico  Compact Flazh.phg
Search Clear | . .
T L Aa, s =
76 File(s) Mame: piclib: {{PowerDesigner Icons. piclib# =ML ModeliannotatedComponent . ico
Type: Icon Dimensions: 16 x 16 Size: 1.37 KB Colars: 256
a4 I Cancel | Help |
Procedure

1. Specify the appropriate search criteria in the Search Criteria pane. You can specify:

o Search for — Enter all or part of a filename to search against. Wildcards are automatically applied so that
for example, entering "ec" will return an image named "vector.png".

o Type — Select the type of image to search for, such as PNG, Bitmap, Cursor, etc.

o Search in collections — Specifies the scope of the search by selecting or deselecting collections to search

in.

Click the Search button to display the result of the search in the Images pane.

Select animage in the Images pane, and click OK to return to the Symbol Format dialog or to display the image

in the diagram.

The Clear button resets the search criteria to the default values.

Core Features Guide
Modeling with PowerDesigner

PUBLIC

223



1.5.3.9 Decorative Symbols

Lines, ellipses, rectangles, and other decorative symbol tools available in the Toolbox have no technical meaning,
but can help with readability. You can use them to surround parts of a model to, for example, distinguish domains
of activity.

With each of the following tools, click and hold to draw, and release to complete the shape. To resize a completed
shape, click it and drag a handle.

Tool Description
Insert an area where you can write free notes
2 Draw either a graphical link between free symbols, a note link between a note and an object, or a traceability link
between objects (see Traceability Links [page 146])
= Title - A diagram title box retrieves from the model properties and displays such information as: the model and the

package to which the diagram belongs, the name of the diagram itself, the author and version of the model and
the date of modification.

If no Author is specified in the model property sheet, the user name specified in the Version Info page is used.

You can choose to display the repository version number of the model or a user-defined version number on the
Title display preferences page.

Text - You can insert free text in your model independently of any shape, and can select and move it like any sym-

=] bol.

, Line

™ Arc

| Rectangle - Press Ctrl while drawing to create a square.
(] Ellipse - Press Ctrl while drawing to create a circle.

Rounded Rectangle - Press Ctrl while drawing to create a rounded square.

Y Polyline - Release the mouse button at each point where you want to create a corner. Right-click to finish.
Polygon - Release the mouse button at each point where you want to create a corner. Right-click to finish and close
the polygon.
1 Note

To add text to the symbol, double-click it to open an editor window. Lines and polylines support the display of
text at their center, source, and destination (see Text Editor Tools [page 225]).
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To change the format of the symbol, right-click it and select Format (see Symbol Format Properties [page 213]).

1.5.3.9.1 Creating a Graphical Link Between Any Two
Symbols

You can create a graphical link between any two symbols in the diagram. This link is purely graphical and does not
convey any semantics.

Procedure

1. Select the Polyline tool in the Toolbox.

2. Click inside the first symbol and while continuing to hold down the mouse button, drag the cursor to a second
symbol. Release the mouse button inside the second symbol and right-click.

Alink is created. You can double-click the link symbol to open the Link Symbol Text dialog box and edit the link.

1.5.3.9.2 Text Editor Tools

PowerDesigner provides an internal rich text format (rtf) editor, and supports the use of external text editors.

The following tools are available on the editor toolbar (the Edit With command and various formatting commands
and tools are only available in RTF editors):
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Tools

Description

| % vl Editor Menu ( + ) - Contains the following commands:

e New ( + ) - Reinitializes the field by removing all the existing content.

e  Open... ( + @) - Replaces the content of the field with the content of the selected file.
® Insert... ( + ) - Inserts the content of the selected file at the cursor.

e Save ( + ) - Saves the content of the field to the specified file.

® Save As... - Saves the content of the field to a new file.

e Select All ( + ) - Selects all the content of the field.

e find... ( + ) - Opens a dialog to search for text in the field.

® Find Next... () - Finds the next occurence of the searched for text.

e Find Previous... ( + ) - Finds the previous occurence of the searched for text.

e Replace... ( + ) - Opens a dialog to replace text in the field.

e GoToline.. ( + ) - Opens a dialog to go to the specified line.

e format... [Ctrl+M] - Opens a dialog to specify fonts and styles.

e Remove All Formats [Ctrl+L] - Removes all formatting from the content of the field.

® Paragraph... [Ctrl+R] - Opens a dialog to specify paragraph indentation, spacing, and alignment.
e Tabs... [Ctrl+B] - Opens a dialog to specify tab stop positions and alignment.

@ - Edit With - Opens the content of the field in an external editor. Click the down arrow to select a particular
editor or Choose Program to specify a new editor. Editors specified here are added to the list of editors avail-

able at |* Tools  General Options ¥ Editors 3.

Save ( + ) - Saves the content of the field to the specified file.

Print (ctr1] + [2]) - Prints the content of the field.
Find ( + ) - Opens a dialog to search for text.
Cut ( + ), Copy ( + ), and Paste ( + ) - Perform the standard clipboard ac-

tions.

|E||F| Undo ( + ) and Redo ( + ) - Move backward or forward through edits.

(A Format ( + ) - Opens a dialog to specify fonts and styles.

L]

EIY

=
v
&

|ﬁ”T| |EJ Bold, Italic, and Underline - Format the selected text.

|§“E| |E| Align Left, Align Center, and Align Right - Align the selected text.

|| Bullets - Indent and bullet the selected text.

1 Note

When editing free text on decorative symbols, use the radio buttons at the bottom of the dialog to switch
between
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® Plain text - text formatting is controlled by the display preferences for free symbols
® RTF - text formatting can be controlled directly in the text input window

1.5.4 Display Preferences

Display preferences control the format of the symbols in your diagrams and the information displayed on them.
You can control the default display preferences for all objects, or set preferences for all, selected, or new objects in
the current diagram.

Procedure

1. [optional] Select one or more symbols to which you want to apply format or content changes. If you do not
select any symbols, you can choose to apply any changes to all objects or only to objects created after your
changes.

2. Select|» Tools » Display Preferences .to open the Display Preferences dialog.

3. Select an object in the Category list and change the preferences as appropriate in the right-hand panel. The
General Settings category controls preferences for the diagram as a whole (see General Settings Display
Preferences [page 228]).

On each of the pages, you can, at any time click:
o the Default button, which reverts any changes to their default values
o the Set As Default button, which assigns the current values to defaults.

4. [optional] Click the Apply To button to open the Select Diagrams dialog, select the diagrams to which you want
to apply your changes, and click OK:

Select Diagrams [_ |O0]
kodel: IEE Project Management [FOM] j
IEE. Praject Management [PDI‘vjE | By ~ G - G = T T
Diagram name | Diagram Code I Parent |

ﬁ@ Cuztomer manag... Customer management  Project Management ...
|:| Employe manage... Employe management  Project Management ..
|:| kd ain diagram bk ain diagram Project b anagement ...

E % Physical Diagram

Ohbjectz] selected: 043

Cancel | Help |
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You will be asked whether you want to apply your changes to all the symbols in the selected diagrams. If you
click:
© Yes — All existing and new symbols will reflect your changes to the Format, General and Content display
preferences.

o No — New symbols only will reflect your changes. Only the General and Content display preferences are
applied to existing symbols. The Format changes are canceled.

o Cancel - Your changes will not affect any symbols in any diagrams except the current one.

In each case, you return to the Display Preferences dialog.

5. On the Display Preferences dialog box, click OK. The Changing Formats dialog box will open:

Changing Formats E |

Do pou want bo apply the farmat changes to:

" Selected symbols

i~ Mew symbols

The choices in this dialog apply only to the present diagram and will not override your choices made in the
Select Diagrams dialog.

6. Click OK to apply your changes

1 Note

If you make changes in the Display Preferences dialog and these are not reflected in some or all of the
symbols in your diagram, this may be because of display constraints enforced by your modeling
methodology. For detailed information about how such constraints are defined, see Customizing and
Extending PowerDesigner > Extension Files .

1.5.4.1 General Settings Display Preferences

The General Settings category allows you to control the overall look of the diagram.
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LCategony:

General | Word Wrapping | Format |

=R General Settings
- Architecture Area

- Deployment Instance
... File S —
- Free Symbol Display: ) Name @ Code Wwindow caolor; |:| -
- Fulfillment ]

. Goal Unit

- Hardware Server
- Impact Grid

-~ Infrastructurs Link E Shap to grid Display Size:
- Mobile Device =
- Network Dizgrarm

- Networkc Mode Show page delimiter Constrain Labels
- Onganization Unit
- Package Link.s

- Person Show bridges at intersections Automatic Link Routing
- Program
. Project Compogite S
- Fole L4 Darken Child Symbol: 1 M
- Role Association
- Shortcut Default ] [Eet B Default]
.. Site

- Software Server S

(o< [ Coneel | [ e

| »

1 Inch 0 Millirneter @ Pixel

The following preferences are available on the General tab:

Property Description

Display Specifies whether object names or codes are displayed in the Browser and on diagram symbols. You
can toggle between the values of this setting with the Display Name/Code tool in the Standard toolbar.

Window color Sets the background color for the diagram.

Unit Specifies the measurement unit for symbol size. You can choose between inches, millimeters, and pix-
els.
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Property Description

Snap to grid Automatically aligns all objects in the diagram to the anchor points of a grid. Control the visibility of the
grid, and the number of anchor points per square inch with the Display and Size options:

Customer S Baoksellar

~ 04 0 Redtozipt” T 0On
< b e

Show page delimiter | Displays lines showing the limit of pages on the diagram background.

Constrain labels Limits the distance to which you can displace labels from link objects. Uncheck this option to be able to
move link labels anywhere in your diagram.

Show bridges at inter- | Creates a bridge (or "line hop") when two links cross to show that they do not intersect. This prefer-
sections ence has no effect on link symbols with free curve corners or CDM association links.

Automatic link routing | Calculates link paths to avoid crossing object symbols and to space links regularly. You can manually
move routed links, and the algorithm will respect your choices and exclude such links from its calcula-
tions. To revert a manually moved link to its automatically routed position, right-click it and select
Reroute Link.

This preference has no effect on links with free curve or free angle corners, CDM association links, or
any links in EAM organization charts, BPM process hierarchy diagrams, OOM sequence diagrams, or

XSM XML diagrams.
Organization unit [diagrams with swimlanes] Specifies that organization units will be displayed as swimlanes. You must
swimlane also specify whether swimlanes have a Horizontal or Vertical orientation.

Darken Child Symbol | [diagrams with composite symbols] Specifies that the symbols of child objects are darker than those
of their parents in order to make them stand out more.

Orientation [diagrams with tree structures] Specifies whether branches expand in a Horizontal (left to right) or
Vertical (top to bottom) orientation.
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The following preferences are available on the Word Wrapping tab:

Preference Description

Word wrapping Controls the display of text on symbols and links. You can choose between:

e None
e Truncation - Truncates name (or code), to the specified length

e Word wrapping - Wraps name and code text onto additional lines (up to the specified length) after
the specified wrap character

This preference is overriden if you manually resize a symbol or link text label. To reapply the wrapping
specified here, select the symbol or link text label and press + .

Wrap characters Specifies a set of characters after which word wrapping is possible.

Display overlay for Enables the display of an overlay on objects being reused in the same container but with distinct loca-
non-local objects tion. For instance an activity can be reused under another activity of the same package or an inner
class can be referenced by another class of the same package. The overlay is a mirror image of the
shortcut overlay (see Creating Shortcuts [page 487]).

The Format tab can be used to set the default size for all symbols in the diagram. Values entered here can be
overridden for specific objects on the Format tab for each object type (see Format Display Preferences [page 233]).

1.5.4.2 Content Display Preferences

The Content category allows you to control what information is displayed in object symbols.

You can modify the information displayed on each type of object by selecting it in the list.
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Display Preferences

Category:

- Free Symbol

- Hardware Server

- Infragtructure Link,
- Mobile Device

- Metwork,

- Metwork, Mode

- rganization it

- Package

- Person

- Process

- Repart Document
- Rale

- Shartcut

- Software Server

Content | Farmnat I

Default display mode: ™ lcon © Detail

¥ Stereotype
[ City
[T Country

Dretail mode
[T Comment

¥ Composite editable view

- Syztem
- Title
- Wfork station |-
4| | .,I Default | Set Az Default | Advanced... |
Apply To... | ] I Cancel Help |

Choose the information that you want to display by selecting the appropriate checkboxes. You can customize the
properties that are available to be displayed by clicking the Advanced button (see Customizing Content Display

Preferences [page 233]).

The following special preferences are available for certain objects that can act as containers for other objects:

Preference Description

Default display mode

Specifies the way the object will be displayed by default:

e |con

e Detail — arectangle permitting the display of additional information

This preference is only available if the object supports both modes.

1 Note

Multi-line fields and collections (such as table columns or class operations) cannot be dis-
played in icon mode or on link symbols

232 PUBLIC
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Preference Description

Detail mode Specifies the additional information that will be displayed in Detail mode:

e Comment - from the General tab of the object's property sheet
® <[collections]> - forexample, sub-sites, applications, etc.

e Composite view - displays child objects as symbols within the object symbol. If this option
is present, it cannot (unlike the other preferences) be removed from this screen

1.5.4.3 Format Display Preferences

The Format tab allows you to control the look of object symbols and provides a preview for the preferences
selected.

Click the Format tab of the General Settings category, to set the default horizontal and vertical size of all symbols in
the diagram containing text (measured in units of 1/7200 of an inch).

For objects, click the Modify button to change the line style, fill, shadow, font, and custom shape of symbols (see
Symbol Format Properties [page 213]).

1.5.4.4 Customizing Content Display Preferences

Click the Advanced button in the bottom-right corner of an object's Content tab to organize the information that is
available for display on the symbol.
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1] — 000 gt S >< | Smallican [ | Farce top align

Sterectype

oo0 Bxclusive Choice
MName
Owner and Name

— Separator

Columns

Keys

Indexes

Triggers

i Comment

Drefauilt Set iz Default Cancel

The list in the left hand pane shows the properties that are currently available to display on the symbol in the
Display Preferences dialog. In the case of link symbols the list contains three sublists, Source, Center, and
Destination, which allow you to specify different content to display on each of these parts of the link symbol.

You can drag and drop items to reorder the list, and use the following tools to modify it:

Tool Description

|ﬁ| Add Attributes — allows you to select additional attributes to add to the list (see Configuring the Display of Attrib-
utes [page 235]).

|| Add Collections — allows you to select additional collections (such as table columns, class operations, etc) to add

to the list (see Configuring the Display of Collections [page 237]).

|— | Add Separator Line — inserts a separator line after the item selected in the list. Separators added to horizontal lay-
outs display as vertical lines.
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Tool Description
e Add Exclusive Choice - inserts an item under which you can group properties from which your users will choose
one to display (see Configuring the Display of Exclusive Choices [page 238]).
i Add Horizontal Layout - inserts a horizontal layout. To arrange attributes to display side by side, drag them onto
the horizontal layout in the list.
Account (250) (Generated)
Login ‘ariable characters (2580) <M> | For connecting to a
Password Variable characters (250) <M= | computer system.
Administrator  Boolean
= Add Vertical Layout - inserts a vertical layout. To arrange attributes to display one under the other, drag them onto
the vertical layout in the list. Vertical layouts are often used in conjunction with a horizontal layout, to provide col-
umns of attributes.
Delete — removes the selected item from the list.

The following options control the overall look of symbols:

Tool Description

Small icon Places a small object icon in the top-left corner of the symbol in detail mode.

Fcl?rce P Forces top alignment in the symbol for object attributes, such as Name. If this option is not selected, these proper-
angn ties are centered on the vertical axis.

1.5.4.4.1 Configuring the Display of Attributes

An attribute is any single value property. To enable the display of an attribute, click the Add Attributes tool, select
attributes or extended attributes to display, and click OK.
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1] — 000 gt S >< | Smallican [ | Farce top align

Form
o0 Bxclusive Choice | abel-
MName

L] Cwner and Mame Prefic:

— Separator S
] Columns
Keys Alignmert: (@) Left () Centered () Right

Indexes [ ] Mandatary

Triggers

Drefauilt Set iz Default Cancel

Click on an attribute in the list to set the following options:

Option Description

Label Specifies a label to use in the Display Preferences dialog in place of the attribute's name.
Prefix/Suffix [text items] Insert a prefix and suffix before and after the value of the attribute.

Alignment [text items] Specifies the alignment of the text.

True/False [booleans] Specifies a value to display for true and false. For example, for an attribute Annotated,

you could specify Annotated and Not Annotated for true and false. By default, boolean proper-
ties are displayed if they are true and do not appear if they are false.

Mandatory Specifies that the attribute must be displayed on the symbol, and is not available for deselection in
the Display Preferences dialog.
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1.5.4.4.2 Configuring the Display of Collections

A collection is a group of sub-objects or related objects. To enable the display of a collection, click the Add
Collections tool, select collections or extended collections to display, and click OK.

| — o g S X [ ] Small icon [ | Force top align

Fom
Stersotype Collection: | Columns

e Exclusive Choice Label-
Name

Owner and Name List columns: |Sterectype

— Separator B:ga_]lp_;gzme {Mandatory)

Domain or Data type
Keys Domain

= e s
Indexes

Triggers All Columns

. PK Columns
Commert Key Columns

[ | Mandatory
Limit number of lines
[ | Hide when empty

Set Az Default aF.

Click on a collection in the list to set the following options:

Option ’ Description

Label Specifies a label to use in the Display Preferences dialog in place of the collection's name.

List columns Specifies the properties displayed for each object in the collection. Click the Select tool beside the
field to select attributes for display.

Filters Specifies one or more filters to offer as radio buttons under the checkbox to select the collection in
the Display Preferences dialog. Click the Select tool beside the field to open the Define Available Col-
lection Filters dialog, enter a name for the filter and then click the ellipsis button in the Filter
Expression column to define the parameters of the filter (see Defining a Filter Expression [page 128]).
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|
Option ‘ Description

Mandatory Specifies that the collection must be displayed on the symbol, and is not available for deselection in
the Display Preferences dialog.

Limit number of lines Enables a field in the Display Preferences dialog allowing the user to limit the display of collection
members to the number that they enter.

Hide when empty Specifies that the symbol compartment containing the collection is hidden when there is nothing to
display.

1.5.4.4.3 Configuring the Display of Exclusive Choices

An exclusive choice groups two or more attributes in the Display Preferences dialog, from which the user can
choose to display one To add an exclusive choice, click the Add Exclusive Choice tool, and drag attributes onto it.

1] — o b 4S5 >< | Small ican [ | Farce top align

Form
Stersotype Label:

o Buclusive Chaice Display: | Horizantal radio buttons
MName

) Owner and Name Mandataory

— Separator
Columns
Keys
Indexes

Triggers
Comment

Drefauilt Set iz Default Cancel

Click on an exclusive choice in the list to set the following options:
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I ———
Option Description

Label Specifies a label to use for the choice in the Display Preferences dialog.

Display Specifies whether the choice displays as horizontal or vertical radio buttons or as a combo list.

Mandatory Specifies that the choice must be displayed on the symbol, and is not available for deselection in the
Display Preferences dialog.

1.5.5 Importing and Exporting Model Graphics

You can import graphics to and export graphics from your PowerDesigner models.

To import an image into PowerDesigner, select | Edit » Import Image 3 to open the Select Image window (see
Browsing for Images [page 221]), select an image and click OK to display it in the diagram. Imported images are
saved in the model.

To export one or more symbols from PowerDesigner, select them in the diagram and then click |» Edit ¥ Export

Image Jto open a Save As dialog, select a format in the Save As Type list, enter the filename and click OK.

You can export symbols in any of the following file type formats:

File type Extension

Enhanced Metafile EMF
Bitmap BMP, DIB, RLE
JPEG Compliant JPG, JPEG
Portable Network Graphic PNG
Graphics Interchanged Format GIF
Tagged Image File Format TIF, TIFF
Scalable Vector Graphics SVG

1 Note

If you export symbols or cut or copy them to the Clipboard, you must select |+ Edit » Export in Color 3 to retain
themin color.
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1.6 The Free Model (FEM)

A free model (FEM) provides a context-free environment for modeling any kind of objects or systems. You can use
it to sketch simple visualizations or create entirely new forms of model by defining your own concepts and
graphical symbols through an extension file.

Customers Delivery

Data Center Warehouse

To create a new, empty FEM - Select ||» File » New Model 3, and choose Free Model.

For information about extending objects from their property sheets, see Extending Objects [page 167]. For detailed
information about all the extension mechanisms available in PowerDesigner, see Customizing and Extending
PowerDesigner > Extension Files .

1.6.1 Sketching Objects with the Free Model

You can quickly sketch a visualization of any concepts by creating extended objects in a free model and giving
them appropriate symbols.

Context
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Procedure

1. [optional] Select | Tools # General Options 3 and select the Edit in place after creation tool to allow you to
name objects immediately after creating them without opening their property sheets.

2. Select |l File » New Model 7, select Free Model, specify a model name, and click OK.

3. Use the Extended Object tool in the Free Diagram toolbox to create a basic object.

4. Right-click anywhere in the diagram to drop the tool and then right-click on your object and select Change
Image to select a new image for the image (see Browsing for Images [page 221]).

5. Create additional objects as necessary and link them as appropriate using theExtended Link tool.

Database Cluster Cloud Meobile Device
| ﬁﬁa
PC Tablet

1.6.2 Creating New Types of Model with the Free Model

You can define a set of extensions and attach them to a free model to model entirely new concepts.

Context

Procedure

1. Select|p Tools » Resources » Extensions j» Free Models 3.

2. Click the New button, enter an appropriate name, select to copy from the default template, and click OK to
open your extension file in the resource editor.

3. Right-click the Profile category, select Add Metaclasses, click the PdCommon sub-tab, select the
ExtendedObject metaclass, and click OK.
4. For each new concept that you want to define, right-click the ExtendedObject metaclass and select [ New »

Stereotype 4, enter an appropriate name, and select the Use as metaclass and the Toolbox custom tool
options.
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Stereotypes with these options selected have their own object lists under the Model menu, their own Browser
categories and a tool to create them in the Toolbox

5. Right-click a stereotype and define extended attributes (new properties) and other extensions under it as
necessary.

For detailed information about working with extensions, see Customizing and Extending PowerDesigner >
Extension Files .

6. To model with your extensions, select |» File » New Model J, select Free Model, specify a model name, click
the Select Extensions button, select your extension to attach it to the model, and click OK.

7. Begin modeling with your new concepts. You can, at any time, double-click your extension file in the
Extensions category under your model in the Browser to modify your extensions.

)

Assembly 1 Padkaging 1 Loading 1 Container 1
o, Max:1 000 M= 300 hax:500

Manufacture
Mazx:3 000

~

Assembly 2 Padkaging 2 Loading 2 Container 2
Mazx:1 000 Max: 800 Mazx:500

1.7 The Repository

The PowerDesigner repository is a tool for storing and sharing versioned models and other files used in your
modeling process. It provides robust, granular security, and supports full access from within PowerDesigner and
viewing and some administration via a Web browser.

1 Note

Before you can access the repository, an administrator must install and configure it and provide you with a user
name and password.

The following sections provide information about installing and administering the repository:

e |[nstalling and maintaining the repository (see Installation Guide > Installing the Repository )

e Providing access to the repository by managing rights and permissions (see Controlling Repository Access
[page 5507)

® Providing customization of the PowerDesigner interface through permission, Ul, and general profiles (see
Customizing the PowerDesigner Interface [page 591])
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e Deploying an enterprise glossary and library of reference models and other documents to be shared with all
users (see Deploying an Enterprise Glossary and Library [page 576])

e Adding resource files to the repository and managing their sharing (see Sharing Resource Files via the Library

[page 588])

1.71 Browsing the Repository

The Repository tab of the Browser displays the contents of the repository.

To expand all nodes, press the numpad plus sign (+). To collapse all nodes, press the numpad minus sign (-). To

filter the Browser tree by branch (see Branching Version Trees [page 280]), click the Customize Branch Filter tool
and select the branches you want to view in the Branch Filter Selection dialog. The filter works simply by name, so
that branch names that are reused in different folders are treated as the same. You can toggle the use of the filter
with the Enable/Disable Branch Filter tool:

-4k Development
-4k Production
--‘ﬁt Testing
—-C) Web Site

-4k Development
-4k Production
--‘ﬁt Testing
{5} Change Lists

ml

1 Note

Branch fitter: \1-7;; \%’E" Branch fitter: Production ?;)' Z@;
IiE’ Repository:ADMIN Ilﬂ Repository::ADMIN
-3 Library -3 Library
El{h Back Cffice El{ﬁ] Back Office
-4k Development . -4k Production
-4k Production =3 Sales
4R Testing . -4k Production
=) Sales =-C3) Web Site

: -4k Production
[#-{=} Change Lists

You can only see repository objects if you have at least List permission on them (see Granting Access

Permissions on Repository Items [page 571]).

A typical hierarchy of objects in the Browser Repository tab may include

® Root - [when connection is established] Displays the repository definition name, the user login, and the
current branch (see Repository Root Properties [page 246]).

e Folders - Used to organize documents in the repository (see Repository Folders [page 24417).

e | ibrary - A folder containing enterprise models that are pushed automatically to all users when they connect
to the repository (see The Library [page 43]).

e Branches - Allow concurrent development of multiple versions of documents (see Branching Version Trees

[page 280]).

Core Features Guide
Modeling with PowerDesigner

PUBLIC 243



® Projects - Container for models and other files (see Projects and Frameworks [page 47]).

e Documents - Models, multi-model reports, resource files, and external application files such as MS Office files,
or graphics.

e Packages - Model packages (see Packages [page 144]).

e Diagrams, object categories, and objects - Are displayed only if the Show objects general option is selected
(see Repository Options [page 4377).

1.71.1 Repository Folders

You can use folders to organize the contents of the repository by, for example, creating separate folders for each
subject area, or each team working on a project. You must have write permission on the location where you want to
create the folder. Documents checked in inside a folder inherit its permissions.

1 Note

A PowerDesigner project (see Projects and Frameworks [page 47]) acts as both a repository document and a
folder. Use the project permissions to control working with the project file itself (project diagram and any
framework or dependency matrices) and the folder permissions to grant access to the models contained within
the project, as you would for a repository folder.

You create a folder by right-clicking the root node, a project, or a folder, selecting |l* New * Folder J, and entering a
name for the folder in the property sheet. Click the Permissions tab to add permissions for all appropriate users
and groups for the folder and its contents (see Granting Access Permissions on Repository Items [page 571]).

You can rename a folder from its property sheet or by selecting its node in the Browser and pressing the F2 key.

You can move folders and documents in the repository by drag and drop if you have Full permission on the folder
or model to be moved, and Write permission on the target folder (see Moving Documents in the Repository [page
2570).

You can delete a folder if you have Full permission on it and all its contents (see Deleting Documents, Document
Versions, and Folders [page 294)).

1.7.1.2 Repository Document Properties

Double-click any item in the repository to see its repository property sheet.

The General tab displays read-only information about the object:

Property Description
Name/Code/ Display the name, code, and comment of the object. Repository folders have an editable name, but no
Comment code or comment.
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Property Description

Type [not available for folders] Specifies whether the item is a PowerDesigner model or package, or another
type of document or object.

Location [folders, documents, and model objects] Displays the full path to the folder or document.
[model packages]: Displays the hierarchy of packages in the model.

Status [not available for folders] Indicates the status of the document, which can be Updatable, Frozen (see
Freezing and Unfreezing Document Versions [page 274]), or Locked (see Locking and Unlocking Docu-
ments [page 275]).

Version Info Tab

The Version Info tab displays information about the current version of the object:

Property Description

Creation Displays the name of the user who created the item in the repository, and the date of creation.

Last modification Displays the name of the user who last modified the item, and the date of this modification.

Generated From Orri- [model objects only] When the current object has been generated from another object, displays the

gin Object name of the origin object. Click the Properties button to the right of this field to open the origin object
property sheet.

Version [not available for folders] Displays the number, branch name, and check-in comment for the current
version.

Versions Tab

The Versions tab displays a tree of the versions of the document including any versions under branches. For more
information about this tab, see Document Versions [page 272].

The following tabs are also available:

e Definition [models, packages, and model objects only] - contains annotations and descriptions of the object
(see Definition Tab [page 112])

e Attributes [models, packages, and model objects only] - displays additional properties for these items.

e C(Collections [models, packages, and model objects only] - displays a list of collections or related objects (but
not sub-objects) for the item. For example, the Collections tab in the property sheet of a CDM entity may
display the business rules attached to the entity, but will not display entity attributes.

e Permissions [models, packages, folders and other documents only] - lists those users and groups with
permissions on the document (see Granting Access Permissions on Repository Items [page 571]).
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1.71.3 Repository Root Properties

Right-click the root of the Repository tab of the Browser, and select Properties to open its property sheet.

The Connection tab contains the following properties:

Property Description
Repository name Specifies the name of the repository to which you are connected.
Login name Specifies the login name through which you are connected.

In addition, the following tabs are available:

e | DAP - lists LDAP configuration parameters to enable remote LDAP users to access the repository (see
Connecting to an LDAP Server for User Authentication [page 553]).

® SMTP - lists parameters for connecting the repository to an SMTP server (see Connecting to an SMTP Server
for Notifications [page 558]).

e fasswords - lists the requirements of the policy which controls the qualities of user passwords for the
repository (see Defining a Password Policy [page 5597).

e Permissions — lists those users and groups with permissions on the entire repository (see Granting Access
Permissions on Repository Items [page 571]).

e \ersion Info — specifies when the repository was created and last modified (see Version Info Tab [page 116]).

1 Note

In addition to the standard version properties, the repository root also has a Repository ID, specifying the
unique identifier of the repository, which is used to identify the associated glossary (see The Glossary [page
39]) and library (see The Library [page 43]).

1.7.2 Checking Documents into the Repository

You check documents into the repository to share them with others. You must have at least the Submit
permission on a document (or on one of its packages) to be able to check it into a change list for approval or at
least the Write permission to make changes directly to the repository version.

Procedure

1. Inthe Local tab of the Browser, select the documents to check in, then right-click and select Check In to open
the:
o Check In Project window - if you selected a project (see Checking In a Project [page 247]).
o  Check In Document window - if you selected a single model or file (see Checking In a Model, Resource File,
or Other Document [page 248]).
o Check In Multiple Documents window - if you selected multiple files, the workspace root, or a folder
containing multiple files (see Checking In Multiple Documents [page 2501).
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2. Select whether to check into a change list (see Change Lists [page 258]). You can choose from:

O <None> - [if you have Write permission on the target folder] Allows you to check the documents in
directly without review.
O <New change list>- To create a new change list to contain the checked in documents.

© Change list <xxxx>- Toadd the documents to an existing draft change list. Click the Properties tool to
the right of this field to access the property sheet of the change list.

1 Note

If you are checking in a new version of a document that is already contained in a draft change list, then
this field is read-only.

3. Enter acomment to explain the purpose of your check in, select any other appropriate parameters (see
Check-In Parameters [page 251]), and click OK to check in the document.

If you check into a change list, you can add other documents to it as necessary through other check ins before
submitting it (see Creating, Building, and Submitting a Change List [page 259]). Once the change list has been
approved by the reviewers, your changes are integrated into the official repository versions of the documents
and made available to other users. If an administrator has connected the repository to an SMTP server (see
Connecting to an SMTP Server for Notifications [page 558]) you will receive an email at the moment of
submission of your change list and when it is approved, rejected, or returned to you for further revision.

4. If you are checking in a document that is already stored in the repository, the Merge Changes to Repository
Document dialog (see Resolving Conflicts During Check In [page 253]) may open to let you review the
differences between your local document and the version in the repository. When you are satisfied, click OK to
complete the check in.

1 Note

If you have changed the target (DBMS, OO language, etc) of the model outside of the target family (such as
moving from Oracle 11g to SAP ASE 15.7), you will not be able to create a new version of the existing
repository document and will need to save the model as a new document in the repository.

1.72.1 Checking In a Project

The Check In Project dialog guides you through checking in a PowerDesigner modeling project along with all the
models and other documents it contains.

You arrive here by right-clicking a Project in the Local tab of the Browser, and selecting Check In. The dialog is
populated with any project documents that have changes. The first time you check in a project, you must check in
all its documents; subsequently, only documents with changes are listed and can be deselected if desired.
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For information about the parameters available in this dialog, see Check-In Parameters [page 251].

1.7.2.2 Checking In a Model, Resource File, or Other
Document

The Check In Document dialog guides you through checking in a PowerDesigner model, resource file, or other
document.

You can arrive here by:

e Right-clicking a model or file in the Local tab of the Browser, and selecting Check In.

e Selecting a model or file in the Check In Multiple Documents dialog (see Checking In Multiple Documents
[page 2507), and clicking the Settings tool.

e C(Clicking the Add Document tool in the Check In Multiple Documents window (see Checking In Multiple
Documents [page 250]). You must specify the model or file to check in in the Local Document group box.

e Selecting aresource file, and clicking the Check In tool in the resource file list (see Sharing Resource Files via
the Library [page 588]).

Depending on the context, this window can take various forms:

e Simplified (checking in a document for the first time) - Select a folder to check into (and a changelist if
required or desired), enter a comment, and click OK:
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e

# | Check In Document

Fuolder: hﬂSaIes

Change list: I <Mew change list:

Comment: == Lisa Mills - Thursday, Aprl 12, 2012 2:02:30 PM =

el |

e Simplified (checking in updates to a document already in the repository) - Choose whether to review your
changes (see Resolving Conflicts During Check In [page 253]) (and a changelist if required or desired), enter a

comment, and click OK:

i

B | Check In Document

Status: Ilpdate: Mo changes on server

[] Beview changes

-

=5

Change list: [ <MNew change list>

- |

Comment: == Lisa Mills - Thursday, Apdl 12, 2012 2:03.28 PM =

e

; 0K |[ Cancel ][

Help ]

e Advanced (when you click the Advanced button on either of the simplified dialogs):

| CheckIn Document [
Local document
@ Workspace " File
Mame:  [gEiCompany Business Fules EIE]
Versior: 1
[7] Check out after check in [ Check out dependsncies

Repository document

Status Update: Mo changes on server

Folder: \ J 5]
| g[E]
Version: ‘ J
Change Ist [ <New change list> =[]

Comment: | Lisa Mills - Thursday, April 12, 2012 2.03.28 FM

Fieeze before check in Cieate baseline version

Freeze after check in [F] Lock after check in

[7] Save diagrams for PowerDesigner Portal

<< Simpitied | | Options... | [k [ cancel | [ Hel
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For information about the parameters available in this dialog, see Check-In Parameters [page 251].

1.7.2.3  Checking In Multiple Documents

The Check In Multiple Documents dialog is used when you select more than one document for check in.
You can arrive here by:

e Right-clicking the workspace root or a folder containing multiple documents (or manually selecting multiple
documents) in the Local tab of the Browser, and selecting Check In.

* Selecting [ Repository » Check In 3 (or pressing[ctr1] + + [c].

1 Note

You cannot select projects, which themselves contain multiple documents (see Projects and Frameworks [page
471), to check in through this dialog.

F| B HTE x| R+ @

Source Documert  Target Documert Version Folder

@ Sales Latest Version  PO_Repository:: ADMIN
ESEIES Sales Latest Version  PD_Repositony::ADMIN
IEESEIIES Sales Latest Version  PD_Repositony::ADMIN
%Sales Sales Latest Version  PD_Repostony:: ADMIN

[ k. I[ Cancel H Help

The following tools are available to manage the documents in the list:

Description

|§| Settings — Opens the Check In Document window to let you specify check in parameters for the selected docu-
ment (see Checking In a Model, Resource File, or Other Document [page 248]).
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Tool Description

Add Document - Opens the Check In Document window to let you to specify a document to add to the list (see
Checking In a Model, Resource File, or Other Document [page 248]).

|E| Add Modified Documents in Workspace - Adds all the documents modified in the workspace during the current
session to the list.

|E Add All Documents in Workspace - Adds all the documents in the workspace (including closed documents) to the
list.
|ﬁ| Add Related Document Versions — Adds all documents related to the selected document through shortcuts or

generation or other links to the list. When you check in PowerDesigner models related by shortcuts, the models
being referenced are checked in before the models containing the shortcuts.

|Y| Delete — Removes the selected document from the list.

|d'E | Check In Options — Opens the Check In Options window to allow you to specify the update mode for changes (see
Resolving Conflicts During Check In [page 253]).

| ir | Move Up — Moves the selected document up in the list.

| ¥ | Move Down - Moves the selected document down in the list.

17.2.4 Check-In Parameters

These check-in parameters allow you to control details of your check in.

1 Note

You can set default values for some of these parameters (see Repository Options [page 437]). Each check inis
processed as one transaction. When you first check in a large model, the server creates large rollback logs and
uses a large number of locks, which may require you to configure your server to allow such large transactions.
Check ins of subsequent versions use much smaller transactions.

The Local Document group box contains the following parameters:

Parameter Description

Workspace or File [not for project] Specifies and displays the document name by its workspace name or file name and
path.

Name Specifies the name of the document to check in. Depending on whether you have selected Work-

space or File, this is a:

® Model name - click the Properties tool to open its property sheet

e File name and path - click the Browse tool to open a file selection dialog.
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Parameter

Version

Description

[not for project — read-only] Specifies the current version of the model or file in the repository, if
available.

Change list

Specifies the change list to check the item into (see Change Lists [page 258]). You can choose from
the following:
® <None> - [if you have Write permission on the target folder] Allows you to check the docu-
ments in directly without review.
® <New change list> - To create anew change list to contain the checked in documents.

® Change list <xxxx>-Toaddthe documents to an existing draft change list. Click the
Properties tool to the right of this field to access the property sheet of the change list.

1 Note

If you are checking in a new version of a document that is already contained in a draft change
list, then this field is read-only.

Check out after check
in

[models and resources only] Updates the local version after check in by checking out the repository
version to ensure that you have the most up-to-date version where other users may be working con-
currently.

Check out dependen-
cies

[projects and models only] Checks out additional information about cross-model depencies during
the check out after check in, to enrich dependencies and impact analysis information in future situa-
tions where you may be without a repository connection (see Obtaining Cross-Model Dependencies
Without a Repository Connection [page 541]).

The Repository Document group box contains the following parameters:

Parameter Description

Folder/Project [read-only after first check-in] Specifies the location where the document is checked in. Click the
Properties tool to open the property sheet of the folder.
If you do not specify a target folder, the document is checked in at the root of the browser. You
should grant individual access permissions to this document.

Name [not for project — read-only] Specifies the name of the document to apply your changes to. Click the
Properties tool to open the property sheet of the document.

Version [not for project — read-only] Specifies the version of the document to apply your changes to.

Comment Specifies a comment to describe the purpose of the check in.

Freeze before check in Freezes the previous versions of any modified objects in the repository, and creates a new version to
accept the changes to be checked in (see Freezing and Unfreezing Document Versions [page 274]).
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Parameter Description

Freeze after check in Freezes all modified object versions after check in to ensure that no further changes can be made to
them. Future changes to objects are made to new versions (see Freezing and Unfreezing Document
Versions [page 274]).

Create baseline version | Creates a completely new version of the model, instead of simply versioning the objects that have
changed. This option is available only if you have Full permission on the document. The Merge
Changes to Repository Document dialog does not open. Baseline versions may be quicker to check
in and out, but they require considerably more disk space than standard versions.

Occasionally, the repository cannot process a standard version; in this situation, you should try to
create a baseline version that can be used as a starting point for a new development step.

Lock after check in Locks the document after check in (see Locking and Unlocking Documents [page 275]).
Save diagrams for [not for resources] Prepares snapshots of the model diagrams that can be viewed in the
PowerDesigner Portal PowerDesigner Portal (see The PowerDesigner Portal [page 295]). Dependency matrices cannot be

viewed in the Portal.

The Project Documents group box lists the model and file documents associated with the project, and lets you
select them for check in with the project. Only project documents that are inside the project are listed here.
Documents that are outside the project and only attached to it must be checked in separately.

1.7.2.5 Resolving Conflicts During Check In

The Merge Changes to Repository Document dialog lets you inspect and approve (or reject) the changes you are
checking into the repository. To filter the tree and show only the changes, click the Change Filter tool and select
Show All Changes. By default, all your changes are selected to be applied.
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The window is divided in three parts:

e The Object comparison pane in the upper part of the window displays the anticipated result of the merge on
the target model. Click the Show Source Model button at the top left of the pane to split the pane between the
source and target models.

® The Property comparison pane in the middle of the window displays the properties of the nodes selected in the
model tree, listing the name of the property and its values in the From and To models.

e The Check in comment pane lets you edit the comment that will be associated with this check in.

For detailed information about using this dialog, see Merging Models [page 399].

You can instruct PowerDesigner to handle all or some of these conflicts (and thus suppress the display of the
Merge dialog) by deselecting the Review changes option in the simplified Check In Document dialog or from the
Check In Options dialog, which you open by:

e (Clicking the Options button at the bottom of the advanced Check In Document dialog.
e Clicking the Check In Options tool in the Check In Project or Check In Multiple Documents dialog. The options
specified will apply to all the models and files being checked in.
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Check In Options |
— Update mode

" |nteractive

@ Batch
Resolve conflicts: Usze my changes
" Keep repositony changes

£+ Fesolve manually

| F, I Cancel Help

The following modes are available:

e |nteractive - [default] Always opens the Merge Changes to Repository Document dialog to let you review and
approve or reject each change before check in.
e Batch - Automates the merging of changes and treats conflicts (where the same object has been modified
both by you and by another user) using one of the following rules:
o Use my changes — applies your changes and overwrites changes in the repository version (even if they are
to different attributes).
o Keep repository changes — retains the changes in the repository and rejects your changes (even if they are
to different attributes).

o Resolve manually — opens the Merge Changes to Repository Document dialog to let you review and
resolve conflicts.

1.7.2.6 Checking In Packages

If you check a model into the repository, you also check in the packages it contains.

While, generally, you need the Write or Full permission to check a document into the repository, you can check in a
model on which you only have Read permission if it contains at least one package for which you have Write or Full
permission. However, note that any edits made to packages for which you do not have Write or Full permission will
be lost during check in.

See also Checking Out Packages [page 271].

1.7.2.7 Checking In External Application Documents

The link between the local document and the repository document is saved in the current workspace. This link
allows you to update a document, model or external application file, in the repository.

To be able to update an external application document that does not belong to the current workspace, you have to
check the document out from the repository, select the Add to Workspace check box and then save the
workspace. This allows you to update the document the next time you check it in.
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1.7.2.8 Duplicating Models in the Repository

If you want to duplicate a model that has been checked into the repository, you must first check it out and then
save it as a new model (with a new GUID).

Procedure

1. Select the model to duplicate in the repository, right-click it, and select Check Out to check it out into your
local workspace.

2. Select the model in your local workspace and click [ File » Save as New Model .

3. Select an appropriate folder and filename and click Save to create the duplicate model.

1 Note
The duplicate model replaces the original model in the workspace, but you can verify that the duplication

has succeeded by reading the new path in the PowerDesigner window title bar.

4. Right-click the duplicate model and select Check In to open the Check in Document dialog.

5. Specify the folder to check the model into and any other check-in options (see Check-In Parameters [page
251]), and click OK.

1.7.2.9 Undoing a Check In

If you want to undo a check in, you can only delete the document version created by the check in.

Since a check in to the repository does not necessarily create a new document version (see Freezing and
Unfreezing Document Versions [page 274]), such a deletion may not always be possible.

1.7.2.10 Temporary Protection for Updates to Repository
Documents

When you check in, freeze, lock, or delete a document in the repository, all the versions of the document are
protected until the transaction is completed, and other users will receive an error message if they attempt to
update the document. For example, you cannot lock a version that another team member is checking in, or freeze
a version that someone is locking.

PowerDesigner - Error |

Q Y'ou cannot get excluzive access to the document 'Tests for G
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In rare cases, if the connection to the repository is interrupted during an update to a document, the document may
remain protected, and you may not be able to update the document in the future until you bypass the protection or
cancel the action:
e |fthe interruption occured during an operation launched from your workstation (PowerDesigner verifies the
machine name, not the connected user), then you can bypass the temporary protection and continue your
operation:

PowerDesigner - Confirmation |

The document 'Tests for GA iz alkeady in excluzive access on your work ztation.
Do pou want bo bppazs thiz protection?

1 Note

If you have two PowerDesigner sessions running on your workstation and are performing an operation on a
document in one session, and want to perform another operation on the same document from the second
session, then you should wait for the first operation to complete.

e |fthe interruption occured during an operation launched from another machine, you should ask an
administrator to unblock it. The administrator will verify that no other users are currently updating the
document and then perform an action on the document (for example, locking it) to display the message box
and click Yes to release it:

PowerDesigner - Confirmation |

The dacurment 'Tests for GA iz already in excluzive access (locked by 'PEGASLS'.
Do you want to bypazz thiz protection?

Caution

Bypassing the protection when you are not entitled to may severely damage the document.

1.7.2.11 Moving Documents in the Repository

You can move a document from one folder to another in the repository by drag and drop. You cannot move a single
document version nor can you move objects from one model to another.

To move a folder or a model you must have Full permission on the folder or model to be moved, and Wwrite
permission on the target folder.
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1 Note

You can move a document that is not in any branch structure (see Branching Version Trees [page 280]) to
beneath a branch, but you cannot move a document from beneath a branch to another branch or to outside any
branch. You cannot move a project (see Projects and Frameworks [page 47]) inside another project.

1.7.3 Change Lists

Users with the submit permission on a repository folder or model cannot write directly to that location, but must
instead check their changes into a change list, to be reviewed by one or more reviewers. You can add one or more
models or other documents to a change list all at once or over several check ins. Documents checked into a
change list are stored in a special folder in the repository and their contents are not available to other users until
they have been approved.

F W
[#%] Repository Change List Properties @M
General | Documents |.-“~.c:ti'u'ities | Pemissions | Version Info

e v| iji .I‘_i"l-’” HE

Digplay Mame Destination Folder

ﬁ Project Management (COM) - w1 /Repository: ADMIN
5'.:,3 Project Management (FOM) -v1 /Repositony:: ADMIM

=R 0K || Cancel Aoply Help

You can create a change list to propose:
e Checkin of a new model or other document or changes to an existing model or other document (see Creating,
Building, and Submitting a Change List [page 259]).

e |ntegration of repository documents from one branch to another (see Integrating Changes from One Branch to
Another [page 283]).

Core Features Guide
258 PUBLIC Modeling with PowerDesigner



An administrator will determine the policies by which documents can be checked into the repository on a global or
folder-by-folder basis (see Controlling Repository Access [page 5501]). PowerDesigner supports the following kinds
of review policy:
e Simple review - Change lists submitted by users with the Submi t permission are reviewed by users with the
Write or Full permission.
® Peerreview - Users with the Write or Full permission voluntarily submit change lists for review.

e Direct check in - The submit permission and change lists are not used, and users all check in changes without
review.

You can consult all the open change lists that you have created and those which are awaiting your review under the
Change Lists folder in the Browser Repository tab:

Branch filter: <All branches> 0 T

iy Repository: ADMIN

-3 Library

L) HR Backend

L) Purchasing

-3 Sales

L) Web Site

=-{=} Change Lists
#-[#£] 1048 - Update Processes
=[] 1047 - Add Descriptions
: ﬁ Project Management (COM) - w1
. -T2 Project Management (FDM) - v1
i#-[] 1046 - Rework for Upgrade
[#-[%] 1045 - Sales Processes - e-sales
1042 - Add Controls
1041 - New Procedures
-] 1040 - First Revision - Overview -

[_r_‘m Local | I'_‘m Glossary E.; Repository

m

To consult any change list, whether open or closed, containing models for which you have at least Read

permission, select [ Repository » Change Lists 3.

1.7.3.1 Creating, Building, and Submitting a Change List

When you check one or more documents into a change list, the change list is created in the repository. You can
check further changes to these documents into the change list or add other documents to it. Once you are
satisfied with the set of changes contained in your change list, you can submit it for review. After submission, you
can no longer edit it.
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Context

1 Note

If you have only Submit permission on a document, you are required to check your changes into a change list,
while if you have Write permission or higher, you can check the document in directly or choose to create a
change list to have your changes reviewed by a peer.

Procedure

Choose one or more models, projects, or other documents in your local workspace, right-click them, and
select Check In (see Checking Documents into the Repository [page 246]).

Choose New change listinthe Change list field, enter a Comment to explain your changes, set any other
appropriate options (see Check-In Parameters [page 251]), and click OK.

If you are checking in a document that is already stored in the repository, the Merge Changes to Repository
Document dialog (see Resolving Conflicts During Check In [page 253]) may open to let you review the
differences between your local document and the version in the repository. When you are satisfied, click OK to
complete the check in.

The change list is created in the repository, and your model updates are saved to it. You can consult the
change list under the Change Lists folder in the Browser Repository tab, and has a draft icon:

[optional] Check in further changes to the documents in your change list or add other documents to it by
selecting it in the change list dialog, until you have a complete set of changes that you want to submit for
approval.

1 Note

The documents that you add to a change list must form a coherent set of changes that can be appropriately
reviewed.You can only add documents to a change list if one or more other users has explicit Write
permission on all the documents included. If you try to add a document that does not share at least one
competent reviewer with the documents already included in the change list, then your check in will be
canceled and the change list not updated.

4. Right-click the change list in the Repository tab of the Browser and select Submit to open its property sheet.

260

Enter a final comment, and click Submit to submit your change list for review.

The icon of the change list changes to show that it has been submitted:

You can no longer edit it or check further changes into it. If an administrator has connected the repository to
an SMTP server (see Connecting to an SMTP Server for Notifications [page 558]), you will receive an email
confirming the submission, and any users with Write or higher permission on all the documents included in
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the change list will receive an email inviting them to review it. When the change list is approved, rejected, or
returned to you for revision, you will receive a further email.

1 Note

If you have Write permission or higher, and have voluntarily created a change list for peer review, you can, at
any time, change your mind and approve your change list yourself.

1.7.3.2 Reviewing a Change List

If you have Write or higher permission on all the documents included in a change list submitted by another user,

then you can review it and determine whether to approve the changes, reject them, or return the change list to the
user requesting her to revise it.

Context

1 Note

This procedure explains how to review a change list created by a user to propose changes to one or more
repository documents. For information about reviewing a change list created by a user to propose integrating
documents from one branch to another, see Reviewing an Integration Change List [page 287].

Procedure

1. When you connect to the repository a message in the Output window notifies you if you have change lists to
review. Open the Repository tab of the Browser and expand the Change Lists folder to view all the change lists
awaiting your review, which are identified by their "submitted" icon:

1 Note

If an administrator has connected the repository to an SMTP server (see Connecting to an SMTP Server for

Notifications [page 558]), you will receive an email when the user submits the change list, inviting you to
review it.

2. Double-click a change list to view its properties (see Change List Properties [page 2641]), and read the
Comment field to understand the reason for its submission.

3. Click the Documents tab and review the documents that are included in the change list. The documents in the
list display status icons to identify whether further changes have been checked into the mainline version by
other users since the change list version was created:
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Change List Document Status No Locks Mainline Locked by You Mainline Locked by Other
(Green Padlock) (Red Padlock)

Change list creates new document N/A N/A

(red cross) +

Changes in change list version (red | =
checkmark)

B | RDR

Changes in both change list and
mainline versions (yellow exclama-
tion point and red checkmark)

4. [recommended] Right-click any models that are shown as having subsequent changes on the mainline and
select Update from Mainline to merge these changes into the change list version (see Resolving Conflicts
During Check In [page 253]).

Merging modifications from the mainline ensures that you are reviewing the change list changes in the most
up-to-date context, and will also simplify the approval process.

5. Perform the following actions on a document by right-clicking it or using the toolbar:

o Check Out - Check the submitted version of the document out into your local workspace to review it in
more detail (see Checking Documents Out of the Repository [page 265]).

o Compare - Compare the submitted version of the document in the change list with the mainline version in
the repository (see Comparing Models [page 395]).

o Find in Open Change Lists - Open the List of Change Lists filtered to display only open change lists
containing the document.

6. Note your agreement with the proposed changes or explain why you will reject them or return them to the
submitter for modification in the Comment field of the change list, and then close it in preparation to approve,
return, or reject it.

7. Right-click the change list in the Browser and select:

o Approve - to approve the changes in the included documents and merge them into the mainline to make
them available to all users with the necessary permissions. Enter any appropriate final comment and click
the Approve button. For each PowerDesigner model included in the change list, an Integration dialog is
displayed, in which you can review the changes one last time before integrating them into the mainline
(see Resolving Conflicts During Check In [page 253]).

Caution

Once you begin the approval process, the mainline versions of all the documents in the change list are
locked (see Locking and Unlocking Documents [page 275]) to enable the changes to be integrated as a
coherent transaction. If you click Cancel before having integrated the entirety of the changes in each of
the documents, then all the documents will remain locked until you complete the approval process. You
can recommence the approval process at any time from the point at which you canceled it.

© Return for Revision - to return the change list to the user with a request to make any changes required for
you to approve it. Enter a comment explaining the changes to be made and click the Return button.

o Reject - to reject the changes proposed in the change list. Enter a comment explaining your reasons for
rejecting the change list and click the Reject button.
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In each case, if an administrator has connected the repository to an SMTP server, the change list owner and
any other potential reviewers receive emails notifying them of the approval, rejection, or return of the change
list.

1.7.3.3 Consulting the List of Change Lists

To consult any change list, whether open or closed, containing models for which you have at least Read

permission, select [ Repository # Change Lists 3.

7| List of Change Lists o 3]
Filter by L zer; [ B v] Location: ﬁgﬂepusﬁow::ﬂ.DMINj Document: J
= V) S

Code - Cregtor A MName bl Status+ - Comment -
= | 1005 Lisa Mils ChangeList 1005 Approved = David Archer - Wednesday, M P
2 1033 Robert Brown Changelist_1033 Approved = Jackie McGraw - Tuesday, Mz
3 1007 Dennis Reed ChangeLlist_1007 Approved = David Archer - Wednesday, M
4 1014 Dennis Reed Changelist_1014 Approved = Steve Jones - Tuesday, March
b 1008 Lisa Mills Changelist_1008 Approved = David Archer - Wednesday, M
& 1024 Angela Green Changelist_1024 Approved = Dennis Reed - Tuesday, Marcl
7 1009 Angela Green Changelist_1005 Approved = Steve Jones - Wednesday, Mz
8 1012 Robert Brown Changelist_1012 Approved = Jackie McGraw - Tuesday, Mz|=
9 1011 Lisa Mils ChangeList_1011 Approved = David Archer - Tuesday, Marcl
10 1032 Jackie McGraw Changelist_1032 Submitted = Jackie McGraw - Tuesday, Mz
11 1013 Gary James Changelist_1013 Submitted = Gary James - Tuesday, March
12 1000 ADMIN ChangeLlist_1000 Submitted = ADMIN - Thursday, February 1
13 1028 Fobert Brown Changelist_1023 Submitted * Robert Brown - Tuesday, Marc
14 1001 ADMIN ChangeList_1001 Submitted = ADMIN - Thursday, Februanye 1
15 1022 Simaon Smith Changelist_1022 Submitted = Simon Smith - Tuesday. Marchl_—
16 1023 Angela Green Changelist_1023 Submitted = Angela Green - Tuesday, Marc
17 1026 Dennis Reed Changelist_1026 Submitted = David Archer - Tuesday, Marcl
18 1006 Simon Smith ChangeList_1006 Diraft = Dennis Reed - Wednesday, M -
15 1027 Gary James Changelist_1027 Diraft = Gary James - Tuesday, March =
20 1034 Simon Smith Changelist_1034 Diraft = Simon Smith - Tuesday, Marc:hE‘
TI EEE 3 - = i IH = e = s R
Cloze ] [ Help ]

In addition to the standard in-column filters, this list features the following meta-filters above the list:

e User - Shows only change lists for which the selected user is the creator or reviewer.
® [ocation - Shows only change lists containing models or other documents in the selected folder.

e Document - Shows only change lists containing documents beginning with the characters entered. The list
filters dynamically after you have entered the first few characters.

You can filter on all three criteria in combination and your filter is remembered the next time you open the list. To
remove all filters, click the Clear button.
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1 Note

Though the list displays all relevant results for direct connections to the repository hosted on most DBMSs,
when connecting via the proxy or through certain DBMSs, an option is displayed below the list to allow you to
restrict the number of results to improve performance:

Dizplaying first  ELY * | results

1.7.3.4 Change List Properties

Change list property sheets provide information about the change list and give you tools to review the documents
it contains.

The General tab displays information about the change list itself:

Property Description
Name / Code Specify the name and code of the change list. The name is editable, and the change list is listed in the
repository browser as <code> - <name> (for example 1234 - My Changes.
Comment / Com- The comment field contains your comments, including any comments entered when checking in mod-
ment History els. The read-only comment history lists the comments entered by all users who have worked with the
change list.
Location Displays the full path to the change list in the repository.
Status Displays the current status of the change list, which may be:
e Draft - Not yet submitted for review, or returned for revision.
e Submitted - Awaiting review.
e Approved - Closed with changes integrated to mainline.
® Rejected - Closed with changes rejected.
Owner Displays the user who created the change list.
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Documents Tab

The Documents tab lists the documents included in the change list. The following management tools are available:

Tool

Description

|§T| Properties - Click the arrow to the right of the tool to open the property sheet of the :

e Original Mainline Version - the version of the document stored in the mainline at the time of the change list's
creation.

® (Change List Version - the version of the document included in the change list.

® Updated Mainline Version - the version of the document stored in the mainline, which includes the changes
merged from the change list version.

Check Out - Checks out the change list version of the document (see Checking Documents Out of the Repository

] [page 265]).

|L1}J | Compare - Opens the Select Models to Compare dialog, initialized to compare the change list version of the se-
T lected document with the current mainline version (see Comparing Models in the Repository [page 292]).

The following tabs are also available:

® Activities - Lists the actions taken on the change list (submission, approval, etc).

® Permissions - lists those users and groups with permissions on the change list (see Granting Access
Permissions on Repository Items [page 571]). For draft change lists, the owner has Full permission. For
submitted change lists, the owner has Read permission and reviewers have Write permission. For closed

change lists, the permissions are restricted to the lowest permission that a user has on all of the included
documents.

e \ersion Info - Displays the user who created the change list and the last user to modify it, along with the dates
of creation and last modification.

1.7.4 Checking Documents Out of the Repository

You check out documents from the Repository in order to work on them in your local workspace. You must have at
least the Read permission on a document (or on one of its packages) to be able to check it out.

Procedure

1. To check out a document not currently in your workspace, select the Repository tab of the Browser. If you are
updating an existing file, select the Local tab.

2. Select the documents to check out, then right-click and select Check Out to open the:

o Check Out Project window - if you selected a project (see Checking Out a Project [page 266]).

o Check Out Document window - if you selected a single model or file (see Checking Out a Document [page
267]).
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o Check Out Multiple Documents window - if you selected multiple files, the workspace root, or a folder
containing multiple files (see Checking Out Multiple Documents [page 267]).

3. Select the appropriate parameters (see Checkout Parameters [page 269]), and click OK to check out the

document.

4. If you are checking out a document that is already present in your workspace (and you have selected the
Merge document option), the Check Out Document window (see Resolving Conflicts During Check Out [page
2707]) will open to allow you to review the differences between the version in the repository and your local
version. When you are satisfied, click OK to complete the check out.

1.74.1

Checking Out a Project

The Check Out Project dialog guides you through checking out a PowerDesigner modeling project along with all the

models and other documents it contains.

You can arrive here by:

e Right-clicking a project in the Repository tab of the Browser, and selecting Check Out.
e Right-clicking a project in the Local tab of the Browser, and selecting Update from Repository.

# | Check Out Project
Reposzitory

Marme: WebLibrary

[El

LConfiguration: [::Latest Wersion:

-] |

-,

(3]

[] Check out dependencies  [] Lock before check out
Local
Fath: CMMy Projects \Web Librany™ ﬂ

[¥] Merge document [] Bead-only
Praoject documents
By Oy Ht S
MName Ver.. Reposiory Lo... Relative File *
| T2 DB Modeling 2 <Project>/Dat... .\Data Manz—
JData ETL and Replication 1 <Project=/Dat... \Data Manz
%:_‘,‘ Data Warehouse 1 <Project=/Dat... \Data Manz
%,-.‘Dupliu:ated Database 1 <Project=/Dat... \Data Manz ™
4| 1 3

k. ] [ Cancel ] [ Help

For information about the parameters available in this dialog, see Checkout Parameters [page 269].
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1.74.2 Checking Out a Document

The Check Out Document dialog guides you through checking out a PowerDesigner model or other document.

You can arrive at this window in any of the following ways:

e Right-clicking a model or file in the Repository tab of the Browser and selecting Check Out.

e Right-clicking a model or file in the Local tab of the Browser and selecting Update from Repository.
[ ]
[page 267]) and click the Settings tool.

Clicking the Add Document tool in the Check Out Multiple Documents window (see Checking Out Multiple
Documents [page 267]). You must specify the model or file to check out in the Local Document group box.

Select a resource file, and click the Update from Repository tool in a resource file list.

o "

¥ | Check Out Document

Reposzitory Document

Name: ESales _:J _j.ﬂ

Werzion: I‘ﬁ1 _:_J
Ot Dl

Check out to file

Path: C:\My Project™Sales Jdm _.—1_|
(]34 Bead-only

Open documett Add to workspace

)4 ][ Cancel ][ Help

For information about the parameters available in this dialog, see Checkout Parameters [page 269].

1.74.3 Checking Out Multiple Documents

The Check Out Multiple Documents dialog is used when you select more than one document for check out.

You can arrive here by:

e Right-clicking the workspace root or a folder containing multiple documents (or manually selecting multiple
documents in the Repository tab of the Browser, and selecting Check Out.
Right-clicking the workspace root or a folder containing multiple documents (or manually selecting multiple

documents in the Local tab of the Browser, and selecting Update from Repository.

Selecting | Repository » Check Out J(or pressing[ctr1] + + [E].
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1 Note

You cannot select projects, which themselves contain multiple documents (see Projects and Frameworks [page
471]), to check out through this dialog.

z C:Program Files®...
2 CM\Program Files*... Mo fes Yes Mo
1 CMProgram Files®... Mo fes fes Mo

1] | F

[ k. ][ Cancel H Help

The following tools are available in this window:

Tool Description

=)

Settings — Opens the Check Out Document window to let you specify check out parameters for the selected
document (see Checking Out a Document [page 267]).

(]

Add Document Version - Opens the Check Out Document window to let you to specify a document to add to the
list (see Checking Out a Document [page 267]).

&

Add Related Document Versions — Adds all documents related to the selected document through shortcuts or
generation links to the check out list.

#

Add Document Versions from a Configuration — Opens a selection window allowing you to add all the document
versions included in a configuration to the list (see Grouping Document Versions in a Configuration [page 277]).

X

Delete - Removes the selected document from the list.

Move Up - Moves the selected document up in the list.

| &

Move Down - Moves the selected document down in the list.
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1744 Checkout Parameters

The checkout parameters allow you to control details of your check out.

1 Note

You can set default values for some of these parameters (see Repository Options [page 437]).

The Repository (Document) group box contains the following parameters:

Parameter Description

Name Specifies the name of the document to be checked out from the repository.

Version [not for projects] Specifies the version of the document to check out.

Configuration [projects only] Specifies the configuration containing the project models and files to check out or (if
no configuration is specified) the latest project models and files versions held in the repository. You
create a project configuration by right-clicking a project node in the Repository tab of the Browser
(see Grouping Document Versions in a Configuration [page 277]).

Packages [models only] Click the button to open a package selection dialog box to specify individual packages

to check out instead of the entire model (see Checking Out Packages [page 271]).

Check out dependen- [projects and models only] Checks out additional information about cross-model dependencies, to
cies enrich dependency and impact analysis information in future situations where you may be without a
repository connection (see Obtaining Cross-Model Dependencies Without a Repository Connection
[page 541]).

Lock before check out | Locks the selected version of the document before checking it out, to prevent other users from modi-
fying it (see Locking and Unlocking Documents [page 275]). This option is available only to users who
have the Lock Versionsright.

The lock will be removed when you check the document back in unless you select the Lock after
check in option (see Check-In Parameters [page 251]).

The Check Out To File or Local group box contains the following parameters:

Parameter Description

Check out to file Checks out the model to a file on your local machine. This option can be unselected only for
PowerDesigner models, which can be loaded in memory and added to your workspace without creat-
ing afile.

Path Specifies the path of the file or (projects only) folder to which the document will be checked out. Click
the Select File tool to the right of this field to browse for a location.
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Parameter Description

Merge document Opens the Check Out Model window (see Resolving Conflicts During Check Out [page 2707), to allow
you to compare the local and repository versions of a document, and to review and approve or reject
differences for checking out. If you check out multiple documents, they automatically replace the ex-
isting document versions, and are not merged with them.
This option is available only if you have specified a path to an existing file or folder on your machine.

Read-only Sets the read-only flag on the file or folder after checking it out.

Open document [models and files only] Opens the document after checking out, either in the current PowerDesigner
workspace or in an external application.

Add to workspace [models and files only] Adds the checked out document to the current workspace.

The Project Documents group box lists the model and file documents associated with the project, and lets you
select them to be checked out with the project. Only project documents that are inside the projects are listed here.
Documents that are outside the project and only attached to it are not listed and must be checked out separately.

1.74.5 Resolving Conflicts During Check Out

The Merge Changes to Local Document dialog lets you inspect and approve (or reject) all the changes you are
checking out of the repository.

This dialog will open if you are checking out a PowerDesigner model to an existing file on your computer and you
have selected the Merge model option.
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Bl Check Dut Model M=l E3
@~ G- G FBE NP M|O
J IFru:um Repogitony : Sales - ASIQ POR - w1 i ToLocal : Sales - ASI0 PO
' 510 POM %y Sales - 4510 POM
- PhysicalDiagram_1 B PhysicalDiagram_1
=Ll Entities =Ll Entities
..... [ Area ..... O &rea
[ Customer [ Customer
[ Department [ Department
[ Employes -] Employes
- Product - Product
L[] Table B L 0"
-l Relationships F-a Relationships
-4 Target Maodels -4 Target Models
Property | From Fepositary | TolLocal -
3 MName Sales - ASIQ POM Sales - ASI0 POM
[ Code SALES_ ASIO_PDbM SALES_ ASIO_PDM b
3 Comment
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3 Default Diagram Phyzicalliagram_1 Phwzizalliagram_1 -
a| | »
(] 4 I Cancel | Help |

The repository version of the model that you are checking out is displayed in the left pane, and the local version is
in the right pane. To filter the tree and show only the changes, click the Change Filter tool and select Show All
Changes. By default, all the changes from the repository are selected to be applied. For detailed information about
using this dialog, see Merging Models [page 399].

1.74.6 Checking Out Packages

By default, when you check out a PowerDesigner model, all its packages on which you have Read, Write, or Full
permissions are checked out with the model. Packages with List or no permissions cannot be checked out.

If you do not want to check out a complete model, you can select one or more packages to check out from the
Select Packages dialog box, which displays the packages on which you have Read, Write, or Full permissions.

If you select a parent package, PowerDesigner automatically extends the selection to sub-packages. If you
deselect some sub-packages in the package tree, the selection of the parent packages is grayed to indicate this. If
you select a sub-package, PowerDesigner automatically extends the selection to parent packages to preserve the
context of the sub-package.
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Action

Select modelingproject

Selection

R0d) =8 modelingproject

’ Impact

Package 1, 2, and 3 are automatically se-

El Package 1

=) lected
=-lam Package_1
El Package 2
Package 3
Deselect Package 1 Package 2, and 3 are automatically dese-
=) 8 rnodelingproject lected
EID@ Package 1
EH:I% Package_2
D@ Package 3
Select Package 3 Package modelingproject, 1, and 2 are auto-
SR 2 modelingproject matically selected

Deselect Package 3

El Package 1
=g Package_2

Selection check boxes in package modeling-
project, 1, and 2 are grayed

1 Note

When you check out a package containing shortcuts, the package selection is extended to include the target
packages referenced by shortcuts even if you do not have the Read permission on these packages.

1.7.5 Document Versions

The repository provides version tracking for changes made to documents. Details of the current version of the
document are displayed on the Version Info tab of its repository object property sheet, and all the previous

versions including versions on other branches appear as a tree on the Versions tab.
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|E-ener:—.i|Ncﬂt&a|Fanissions| Versions |‘l.|"ersionlrfn|

FH % W kX

-3 Existing System

& = Steve Jones - Thursday, September 20, 2012 11:55:50 AM =
=8 . 5™ Steve Jones - Tuesday, Aprl 10, 2012 1:20:43 PM = Direct check in
EI{%' Future System

i 2™ Steve Jones - Thursday, September 20, 2012 11:55:31 AM =

37 Steve Jones - Tuesday, Aprl 10, 2012 11:17:45 AM =
27 Steve Jones - Tuesday, Aprl 10, 2012 11:10:48 AM =
1
El--{ﬁ' Future System
% 27 Steve Jones - Thursday, September 20, 2012 11:55:31 AM =
1

B -

The following version icons can appear on this tab:

Tool Description

Branch - You create a new branch in the tree by branching (see Branching Version Trees [page 280]).

B

1 Note

also as aroot.

i

o]~

proved by a reviewer.

e

In the example above, the document is first checked in directly, and then three versions are checked in via change
lists Robert Brown checks in the first version of the document, and Steve Jones checks in a second version which
is branched from the Existing System branch to become the first version in the Future System Branch.

The following tools are available on this tab:
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Branches are displayed twice; both beneath the document version from which the branch was created, and

Version from direct check in - Created directly in the repository without passing by a change list. You create a new
version by freezing (see Freezing and Unfreezing Document Versions [page 274]).

Version checked in/integrated via change list - Submitted in a change list (see Change Lists [page 258]) and ap-

Version integrated from/to another branch (see Integrating Changes from One Branch to Another [page 283]).




|
Tool Description

|§| Properties - Opens the property sheet of the selected version.

|| Change List - Opens the property sheet of the change list from which the selected version was approved (see
= Change Lists [page 258]).

|§| Check Out - Checks out the selected version (see Checking Documents Out of the Repository [page 265]).

|E| Compare - Compares two versions (see Comparing Models in the Repository [page 292]).

|%”@| Freeze/Unfreeze - Freezes or unfreezes the selected version (see Freezing and Unfreezing Document Versions
[page 274]).

Lock/ Unlock - Locks or unlocks the selected version (see Locking and Unlocking Documents [page 275]).

5
)

Delete - Deletes the selected version (see Deleting Documents, Document Versions, and Folders [page 294]).

X

1 Note

When you check in a document, the local date is converted to GMT. It is converted again to local time when you
check the document out. This is to let you to compare document versions stored in the repository when you are
working in different time zones.

All repository documents and model objects can be versioned, but repository folders, users, and groups are not
versioned. Versions other than the first or baseline version are stored as differences from the previous version. As
arule of thumb, the baseline version of a model stored in the repository takes twice the size as it does when saved
as an XML file.

1.75.1 Freezing and Unfreezing Document Versions

Unlike many repository systems, the PowerDesigner repository does not require you to create a new version of a
document each time you check it in. You create a version only when you want to, by freezing the document.

Freezing a document creates a version in the repository that you can go back to and view its state at the point in
time when it was frozen. You could choose to freeze a document (and thus create a new version) each time you
check it in, once a day, once a week, or at any other interval.

1 Note

To freeze a document, you must have the Freeze versions right (see Granting Rights to Users and Groups
[page 570]) and the appropriate permissions on the document.

You can freeze a document during check in (see Checking Documents into the Repository [page 246]) by selecting
one or both of the following options:

® Freeze before check in - to preserve the state of the model before your changes.

® freeze after check in - to preserve the state of the model including your changes (this option can be selected
by default if you select the Freeze after check in general option (see Repository Options [page 4371].
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1 Note

PowerDesigner Web does not support checking in changes without creating a new version. When users publish
changes through PowerDesigner Web the Freeze before check in and Freeze after check in options are both
automatically applied to freeze the previous document state and create a new frozen document version.

If you have the Write or Full permission on a document that is frozen, you can unfreeze it's most recent version.
Unfreezing a document version allows you to make further changes to the existing version, but means that you will
no longer be able to go back and view the previously frozen state.

You can freeze a document or unfreeze its latest frozen version at any time by:

e Right-clicking the document, folder, project, or root node and selecting Freeze or Unfreeze.

1 Note

To freeze or unfreeze all the documents inside a folder or branch, right-click it and select Freeze or Unfreeze.
You must have the appropriate permissions on all the contained documents.

e By clicking the Freeze or Unfreeze tool on the property sheet of a:
© Document - on the Versions tab.
o Configuration - on the Members tab.

1 Note

You cannot individually control the freezing and versioning of PowerDesigner model objects. Each changed
object has its version frozen and version number increased by one each time you freeze its parent model's
version.

1.7.5.2 Locking and Unlocking Documents

You can lock the latest version of a repository document to prevent other users from making changes to it. Only
you or a user with the Full permission on the document can check in changes to the document until you unlock it.
Generally, you will release the lock when you check in the document.

Locked documents display a lock icon in the repository browser:

’ Description ‘ Icon ’ Description

E:ﬂ Blue, if you have set the lock. Elfi Red, if another user has set the lock.

1 Note

To lock a document, you must have the Lock versions right (see Granting Rights to Users and Groups [page
570]) and the appropriate permissions on the document.

You can lock a document during check out (see Checking Documents Out of the Repository [page 265]) by
selecting the Lock before check out option, and remove the lock during check-in (see Checking Documents into the
Repository [page 246]) by selecting the Unlock after check in option.
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If you have locked a document (or have the Full permission on a document locked by another user), you can
unlock it. Unlocking a document allows any user with the appropriate permissions to check in changes to it.

You can lock or unlock a document at any time by

® Right-clicking the document and selecting Lock or Unlock.

1 Note

To lock or unlock all the documents inside a folder or branch, right-click it and select Lock or Unlock. You
must have the appropriate permissions on all the contained documents.

e C(Clicking the Lock or Unlock tool on the property sheet of a:
o Document - on the Versions tab, if the latest version is selected.
o Configuration - on the Members tab, if the document that is selected has its latest version included in the
configuration.

e Selecting |l Repository » Administration » Locks 4 and using the tools available on the List of Locks:

Tool Description

|ﬁ| Settings — Opens the Lock Document dialog for the selected document, which shows details of the lock upon
it.

|E| Add Lock — Opens the Lock Document dialog. Select a document to lock in the Name list and a comment,
and click OK to lock it and return to the List of Locks.

|E| Add Related Document Versions - [models only] Locks the latest versions of any models that the selected
model references through external shortcuts. The related models are automatically added to the List of
Locks.

|%| Add Document Versions from a Configuration — Opens the Select Configuration dialog box, which allows you
to select a configuration for locking. Document versions contained within the configuration are locked and
added to the List of Locks.

1 Note
Documents contained within a configuration can only be locked if they are the latest versions.

|£| Delete — Unlocks the selected document, and deletes it from the List of Locks. Note that this tool does not

delete the document.
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1.7.6 Grouping Document Versions in a Configuration

A configuration is a container for grouping a set of repository documents versions together to mark a particular
point in a project, such as a release or other project milestone. You must have the Manage Configurations right
to create configurations.

Procedure

1. Select|r Repository # Configurations Jto open the List of Configurations.

2. Click the Add a Row tool to create a new configuration, and then click the Properties tool to open its property
sheet.

3. Enter an appropriate Name, Code, and Comment to describe the configuration.

lﬁ: Configuration Properties

General | Memhersl Wersior |nfa

Marne: ||'v1in|:|r Felease _=|
Code: IMir‘n:nr Felease IT
Comment: Thiz configuration llags all verzsions used far the minar ;I

release of the software

[~

% - | ok I Cancel Apply Help

4. Click the Members tab to add document versions to the configuration, using the following tools.

Tool

=

=i Properties — Opens the selected repository document property sheet.

)

Description

Add Document Version — Opens the Add Document to Configuration dialog, which allows you to specify the
version of a document to add to the configuration.
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Tool Description

|@| Add Related Document Versions — [models only] Adds any models that the selected model references
through external shortcuts. The related models are automatically added to the configuration.

|@| Add Document Versions From a Configuration — Opens the Select Configuration dialog, which lets you select

a configuration, whose members will be added to the configuration.

| | Check Out — Checks out the selected version (see Checking Documents Out of the Repository [page 265]).

|@|@| Freeze/Unfreeze - Freezes or unfreezes the selected version (see Freezing and Unfreezing Document Ver-
sions [page 2747).

“-E I@' Lock/ Unlock - Locks or unlocks the selected version (see Locking and Unlocking Documents [page 275]).

|£| Delete — Deletes the selected version from the configuration (see Deleting Documents, Document Versions,
and Folders [page 294]).

lﬁ Configuration Properties

Gereral I ‘v’ersiu:unlnfu:ul
A E N e | X
M ame | Code | Locatian | Wersion
| &) Draft Diesian DRAFT_..  <roob 2
% | mplernentation Implement...  <rook: 1.21.1.3
IEEF'n:uinE!u:t tanagement [FOK] PROJECT... /Projectia.. &
?Q Phyzicall atakdodel_1 PHYSICA...  <roaks 1.1

%1 S ITI Cancel | Apply | Help |

5. Click OK to return to the List of Configurations.
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Results

In the following example, the versions used for a minor release are included in a configuration called Minor Release:

Development
Project
w214 w214
Minor [ i L
Ralpase [ N
ey ‘"\.\\
V23 ’T’
X Minor Release / EBF V213
\—L/ branch w2 ‘
B Vii2 EBF
L - Minor Release branch
. /' WAL
e
. / MINOR
MINOR branch
branch

——
] w1
W1 w1
MAJOR branch MAJOR branch MAJOR branch
Requirements.doc Model.PDM Im plementation.OOM

1.76.1 Creating a Configuration from a Project or Folder

You can quickly create a configuration from the current versions of all the documents in a project or repository
folder by right-clicking it and selecting Create Configuration.

Context

The property sheet of the new configuration opens. You can modify the default name and add a comment on the
General tab and modify the document versions it contains on the Members tab (see Grouping Document Versions
in a Configuration [page 277]).
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1.7.6.2 Checking Out a Configuration

When you check out a configuration, you check out all the document versions it contains.

Procedure

1. Select| Repository » Check Out Jto open the Check Out Multiple Documents dialog (see Checking Out
Multiple Documents [page 2677).

2. Click the Add Document Versions from a Configuration tool, select the configuration to check out, and click OK
to add the document versions it contains to the list.

3. Click OK to check out the documents.

1 Note

When you check out a configuration containing resource files, these files may overwrite any modifications in
your local resource files. If you need to preserve your changes, modify the path to which the configuration
will be checked out.

1.7.7 Branching Version Trees

Users with the Manage Branches right can create branches in the repository to support concurrent development
of multiple versions of documents. Standard permissions control read and write access to individual branches
(including integrating changes made in one branch into another).

Context

1 Note

Prior to v16.1, the repository browser only supported displaying a single branch at a time. When you upgrade an
existing repository to v16.1 or higher, all branches will become, by default, visible for all users. You may wish to
simplify viewing the repository by deleting documents and branches that are no longer used, by using
permissions to hide certain branches from users or groups who have no need of them, or by migrating active
models to a new repository (see Installation Guide > Installing the Repository > Upgrading the Repository ).

You can branch the contents of any folder in the repository, but we strongly recommend creating at least one level
of sub-folders beneath the repository root and creating your branches on one of these sub-folders.
Caution

Once you have branched a folder, you cannot add a new folder directly beneath the branched folder as a sibling
to the branches, because the entire contents of the folder is now branched and every document and folder must
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necessarily belong to one or more of the branches. If you branch the repository root, you will not be able to
create any other sub-folders at the root level and will be constrained to placing all of your repository documents
inside a single global branch structure.

Branch fitter: <All branches> Wy

-3 Library

EJ Architecture

=13 Back Office

-0 ERP

B-C3 HR

E--tt Development

E HR Data Warehousze - v1

E--tt Production

E HR Data Warehousze - v1

If_l--{k Testing

EIE HR Data Warehouse - v2

-C3) Analysis and Design
[#-{C3) Data Management
-3 Implementation
[#-IC3) Requirements

-4R Development
&-4R Production
Iél--tt Testing
a Primary Company Site - v

Branch names must be unique for the folder, but may be reused in another folder. In the example above, three
branches (Development, Testing, and Production) are created in the folder /Repository/Back
Office/HR, and branches with the same names are also created in the folder /Repository/Web

Users can filter the Browser Repository tab to display only the Branches that interest them (see Browsing the
Repository [page 243]).

Procedure

1. Right-click the folder that you want to branch (and on which you have at least Write permission), and select
|» New ¥ Branch 1.

1 Note

You cannot create sub-branches under a branch and nor can you create branches inside a project.

2. Enter a name for the branch and select a base branch from which to copy the initial contents of the new
branch:
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Create Branch = ||E|

Name: Development

Base branch: ['-H} <Default> ']ﬂ

[ Ok ] [ Cancel

The base branch can be any of the sibling branches (or befault if this is your first branch in this location),
and all the contents of the base branch will be copied to the new branch. Alternatively, you can select None to
create an empty branch.

The selected base branch is the default branch selected when you integrate items from the new branch to
another branch (see Integrating Changes from One Branch to Another [page 283]).

3. Click OK to complete the creation of the branch.

The new branch is displayed in the Browser. If it is the first branch created in this location, then a <Default>

branch is created next to the new branch. You can change the name by right-clicking the branch and selecting
Properties.

1.7.71 Controlling Branch Permissions

Administrators and users with the Full permission on a folder containing branches can grant permissions on the
branches from the Permissions tab of its repository property sheet.

Procedure

1. Right-click a branch in the repository browser and select |+ Permissions 3 to open the branch property sheet
at the Permissions tab:
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P -

‘kt Branch Properties El
General | Pemissions | Version Info
H EX A e NS -
Mamea = | Codeor L »| Granted P = | Effective = =
1 ADMIN ADMIN Full Ful
2 All users PUBLIC Fead Fiead
< | 1 | » =
=~ |0k ]| Canesl Apply Help

2. Click the Add tool to select any users or groups that should have access to the branch for adding to the list,
and then click OK.

3. Setthe Granted Permission for each user and group to an appropriate level (see Granting Access Permissions
on Repository Items [page 571]).

4. Select any users or groups in the list that should not have even List access to the branch and click the Delete
tool.

1 Note

Users can filter the Browser Repository tab to display only the Branches that interest them (see Browsing
the Repository [page 243]).

5. Click OK to complete the changes to the branch permissions.

1.7.7.2 Integrating Changes from One Branch to Another

You can integrate changes made to a project, model or other document (or to the contents of a folder) in one
branch to another branch. You must have submi t permission on the branch to which you want to integrate the
changes to propose an integration via change list or Write permission to integrate directly. You can select
individual changes to integrate on an object-by-object basis, and your choices are retained as defaults for
subsequent integrations.
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Procedure

1. Right-click the document, project, or folder in the branch containing the changes you want to merge to
another sibling branch and select Integrate. Depending on the item selected, one of the following dialogs will
open:

o For asingle document, you must select the version of the document you want to integrate and the target
branch to integrate your changes to. You can optionally enter a comment, and click the Advanced button
to access the same options as are available in the Check In Document dialog (see Check-In Parameters

[page 251)):

.| Integrate Document @
LCurrent branch: -ﬁt Desigh ﬂ
Current sersiar; Iv&‘l an Design branch j
T arget branch: [-ﬁh Test ']ﬁ
Statusg: Mew: Does not exigt on target branch
Change list: [ < Manes v] J

Comment; == glark - Thursday, Hovember 13, 2014 3:25:40 PM ==

: ()4 |’ Cancel ][ Help

If you have submi t permission on the target branch, you must select a change list. If you have Write
permission or higher, you can check in directly or to a change list for peer review. You can choose between:
O <None> - [if you have Write permission on the target branch] Allows you to integrate the documents
to the branch directly without review.
O <New change list> - To create a new change list to contain the documents to be integrated.
© Change list_ <xxxx>- Toadd the documents to be integrated to an existing draft change list. Click
the Properties tool to the right of this field to access the property sheet of the change list.
o For afolder or project, you must select a target branch to integrate your changes to and can optionally
enter acomment. Users with Submit permission on the target branch must select a change list. Users
with Write permission or higher can check in directly or to a change list:
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I

& | Integrate Folder @

Repozitory branch
Current branch: 4R Design ﬂ
Target branch: |4k Test 'lﬂ

Check in optionz

Folder: J ﬂ

Lhange list: <Mew change ligt: - |J

Comment; ## aclark - Thursday, November 13, 20014 3:40:53 P =

Freeze before check in Create bazeling werzion

Freeze after check in Unlock after check in

[ Save diagrams for PowerDesigner Portal

Diocuments in current branch with changes to integrate

By B Ht 2L B
Source Document Repository Location
,j Frimarny Compary Site - «2 Repository::aclark /Project 24D ezign. ..
_-E Server Landscape - v Repository::aclark /Project 24D ezign. .
_-ﬁ Detaled Processes - w2 Repozitory::aclark/Froject £/0ezign...
| ak. | [ Cancel ] [ Help
1 Note

Only documents with changes since the creation of the branch (or the last integration) are listed and
you can deselect documents in the list to exclude them from the integration.

2. Click OK:

o If youdid not select a change list and are integrating one or more PowerDesigner models, a merge dialog

(see Merging Models [page 399]) opens to allow you to begin merging changes from the current branch to
the target branch:
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X Integrate Changes to Target Branch = @

By~ By~ BovH BHE K A4 kM B
ﬂ J ch:. Repositary : WebLlibrany Conceptual Data - v1 on Production branch

vl WebLibrary Conceptual Data
=l Ertities
{ EI@ Author

EI---_;;_{I Generation Source Objects
% WebLibrary Design

Property From Reposttory 25 To Repostory 25 -
5 Displayed TRUE %

Check in comment;
= A0MIM - Tuesday, December 20, 20171 4:12:40 Pha === -

Ok ” Cancel ][ Help

Select or reject each change as appropriate and then click OK to merge the selected changes from the
current branch model to the target branch model.

If you are integrating a project or folder, an additional merge window will open for each of the models to be
integrated, to allow you to inspect and select or reject their changes. When the final model merge window
is closed, the integration is complete.

o If you selected a change list, you can add other documents to integrate as necessary before submitting it
(see Creating, Building, and Submitting a Change List [page 259]). Once the change list has been
approved by the reviewers, your changes are integrated to the target branch. If an administrator has
connected the repository to an SMTP server (see Connecting to an SMTP Server for Notifications [page
558]) you will receive an email at the moment of submission of your change list and when it is approved,
rejected, or returned to you for further revision.
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1.7.7.3 Reviewing an Integration Change List

If you have Write or higher permission on all the target branch documents included in an integration change list
submitted by another user, then you can review it and determine whether to approve the integration, reject it, or
return the change list to the user requesting her to revise it.

Context

1 Note

This procedure explains how to review a change list created by a user to propose integrating documents from
one branch to another. For information about reviewing a change list created by a user to propose changes to
one or more repository documents, see Reviewing a Change List [page 261].

Procedure

1. When you connect to the repository a message in the Output window notifies you if you have change lists to
review. Open the Repository tab of the Browser and expand the Change Lists folder to view all the change lists
awaiting your review, which are identified by their "submitted" icon:

E3)

1 Note

If an administrator has connected the repository to an SMTP server (see Connecting to an SMTP Server for
Notifications [page 558]), you will receive an email when the user submits the change list, inviting you to
review it.

2. Double-click a change list to view its properties (see Change List Properties [page 264]), and read the
Comment field to understand the reason for its submission.

3. Click the Documents tab and review the documents that are included in the change list. The documents in the
list display status icons to identify whether further changes have been checked into the mainline version by
other users since the change list version was created:

Change List Document Status No Locks Target Branch Locked by You | Mainline Locked by Other
(Green Padlock) (Red Padlock)

Change list creates new document N/A N/A

(red cross) +
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Change List Document Status No Locks Target Branch Locked by You | Mainline Locked by Other
(Green Padlock) (Red Padlock)

Changes in change list version (red | = g E

checkmark)

Changes in both change list and tar- g 5 E

get branch versions (yellow excla-

mation point and red checkmark)

4. Perform the following actions on a document by right-clicking it or using the toolbar:

o Check Out - Check the submitted version of the document out into your local workspace to review it in
more detail (see Checking Documents Out of the Repository [page 265]).

o Compare - Compare the submitted version of the document in the change list with the target branch
version in the repository (see Comparing Models [page 395]).

o Find in Open Change Lists - Open the List of Change Lists filtered to display only open change lists
containing the document.

1 Note

You will not be permitted to continue with the integration if any other submitted change list contains a
proposed integration of any earlier version of any of the included documents. If this is the case, you
must approve, return, or reject each change list in order so as to perform the requested integrations in
a coherent order.

5. Note your agreement with the proposed integration or explain why you will reject it or return it to the submitter
for modification in the Comment field of the change list, and then close it in preparation to approve, return, or
reject it.

6. Right-click the change list in the Browser and select:

o Approve - to approve the integration of the included documents and merge them into the target branch.
Enter any appropriate final comment and click the Approve button. For each PowerDesigner model
included in the change list, an Integration dialog is displayed, in which you can review the changes one last
time before integrating them into the target branch (see Resolving Conflicts During Check In [page 253]).

Caution

Once you begin the approval process, the target branch versions of all the documents in the change list
are locked (see Locking and Unlocking Documents [page 275]) to enable the integration to be
performed as a coherent transaction. If you click Cancel before having integrated all the documents,
then all the documents will remain locked until you complete the approval process. You can
recommence the approval process at any time from the point at which you canceled it.

© Return for Revision - to return the change list to the user with a request to make any changes required for
you to approve it. Enter a comment explaining the changes to be made and click the Return button.

o Reject - to reject the integration proposed in the change list. Enter a comment explaining your reasons for
rejecting the change list and click the Reject button.

In each case, if an administrator has connected the repository to an SMTP server, the change list owner and
any other potential reviewers receive emails notifying them of the approval, rejection, or return of the change
list.
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1.77.4 Deleting a Branch

Administrators and users with the Manage Branches right can remove unused branches by right-clicking them
and selecting Delete.

Context

Before deleting a branch, you must delete all its contents (see Deleting Documents, Document Versions, and
Folders [page 294]).
Caution

Deleting a branch cannot be undone.

1.7.8 Impact and Lineage Analysis in the Repository

You can analyze the impact of a change to an object (impact analysis) and identify the objects that take part in the
definition of the object (lineage analysis) on any model object in the repository by right-clicking it in the Repository
tab of the Browser and selecting Impact and Lineage Analysis.

By default, the analysis descends to only three levels of dependencies, but you can select more or fewer levels by
selecting a number in the Repository analysis level list.
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ﬁ-_lmpact and Lineage Analysis

=101 x|

Analyziz result nanme; IImpau:t analyziz for Entity 'Perzon’ [Change]

Fepozsitoy analyziz iule etz 3
Irpact rule et IGI::.I:.aI Impact &nalysis j [ )
Lineage rule zet: IGI::.I:uaI Lineage Analysis j '

Impact and Lineage | List I

Repositorny analysiz level: |3 "'I

EE Entity 'Perzon' [Change]
=-{3 Relationships
E Entity ‘Account’ [Change)
E Entity 'College’ [Change]
E Entity 'Laboratary’ [Change]
E Entity 'PhD Student’ [Change]
=-{3] Generated Objects
; Table 'Perzon’ [Change] [Physical Data - +1)
=-{3d Child Inheritances
ﬂ% Inheritance ‘|nhentance_1' [Change]
=4 Generation Origin
; Table 'Person’ [Lineage] [Physical Data - 1)
=[] Data

. g¢ Data 'PhD Student civl status' [Lineage] [Detalled Processes - »1)

Generate Diagram I |

Cloze

Help

For detailed information about using this dialog, see Impact and Lineage Analysis [page 529]. For information

about the limitations of repository analyses, see Repository Rule Set Limitations [page 549].

1 Note

By default, analyses launched from the Repository tab use the standard Global Impact Analysis and
Global Lineage Analysis rule sets delivered with PowerDesigner and available in the Library folder. You
can check additional rule sets into the library or into another repository folder (see Checking Rule Sets into the
Repository [page 548]). To change the folder where PowerDesigner looks for rule sets for selection in the dialog,

use the Choose Path tool above the rule set fields.
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1.7.9 Finding Objects in the Repository

You can search for PowerDesigner model objects in the repository. You do not need special user rights and the List

permission is sufficient for searching.

Procedure

1. Press + + [£] select |p Repository » Find Objects 3, or right-click the repository root, a folder, or
model in the Repository tab of the Browser and select Find Objects to open the Find Objects dialog:

Find Objects

Mame & Location | Local Datesl Fiepozitarny Datesl .ﬁ.dvancedl

Look jn: ht;repasitmm 21 ADMIM:: <D efaults

RE

Wierzion: HEurrent Yersiar

[

Model bupe: IPDwerDesigner Object-Onented Model

=

Object type: |§ Clazz

[ Include shortcuts

=]

Marme: ||

Code: I

[T Caze sensitive

g1

=101 %]
Eind Maow
Stop
Mew Search

Cloze

Help

2. Specify the appropriate parameters in the different tabs of the dialog box.

For detailed information about these tabs, see Find Parameters [page 136]. The repository Find Objects dialog

allows you to search by both local and repository dates.

3. Click the Find Now button. You can stop the process at any time by clicking the Stop button.

Progress is reported in the Output pane, and the dialog remains open until the process completes and the

Result List displays the result.

| Object Type I M ame I Code I Location
[ Entity Authar AUTHOR Design
H E rtity Author AUTHOR ww'ebLibramy Con...

[ 2]

v [\Find A Check Wodel 7

il
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If you right-click an object in the Result list you can select:
o Properties - to display the properties of the found objects.
o Check Out Model - to check out the model containing the found object.

1.7.10 Comparing Models in the Repository

You can compare two PowerDesigner models to obtain a detailed list of the differences between them. You can
compare two versions of the same repository model, two different repository models, or one repository model and
one local model.

Context

Caution

You can only compare models of the same type (for example, PDM, OOM, EAM).

Procedure

1. Press[ctrl] + + [w], select [ Repository » Compare 3, or right-click a model in the Repository tab of
the Browser, and select Compare.

M 5elect Models to Compare Ed

— Model 1
Location:  © “Workspace {* Fepositony

Marme: F‘: Diraft Design j
W ersion; Iwﬁ1 j

— Model 2
Location:  © “Wworkspace ¥ Bepozitony

M arie: F‘: Deszign j
W ersion; Imﬁ1 j

0k, I Cancel | Help |
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2. Foreach of Model 1 and Model 2, select:

o A Location to specify whether the model to compare is located in your local workspace or in the repository.
o The Name of the model to compare. Click the Properties tool to open the property sheet of the selected
model. Select the same model in both lists if you want to compare different versions.

o The Version of the model to compare — the most recent version is selected by default.

1 Note

The Version list includes only the versions in a particular branch (see Branching Version Trees [page
280]). To select a version in another branch, select the model in the Name list and then select a version.

3. Click OK to open the Compare Models dialog:

Il Compare Models _ |0l x|

T F B H 4 M E

_l kodel 1 : CS 00K - w1 d kodel 2 : CS O0M
=1 & % ST

El@ t ain Diagramn El@ b air Diagramn

- B Symbols - L Symbols

E|_"rg_1. Clazzes E|_"rg_1. Clazzes

2 Image o

- Attributes
: __,I |dentifiers : Mé
E---_"rg_t Generalizations E---_"rg_t Generalizatiors
oy ItemType e
Property | hadel 1 | hodel 2
Close I Help
Results

For detailed information about using this dialog, see Comparing Models [page 395].
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1.7.11 Deleting Documents, Document Versions, and Folders

If you have the Full permission on a document, you can delete the most recent version of the document or delete
the document (and all its versions). When you delete a document, you also delete all the objects it contains. If you
have Full permission on a folder and all its contents, you can delete it and all the versions of all the documents it
contains.

Caution

Deleting a version, document, or folder (see Repository Folders [page 244]) cannot be undone. If you delete a
document that contains objects referenced by shortcuts in other models, these shortcuts will be shown as
unresolved.

You can delete the latest version of a document by:

e Right-clicking the document in the Browser Repository tab and selecting Delete Version.

e Opening the repository document property sheet to the Versions tab (see Document Versions [page 272]),
selecting the latest version of the document (or the latest version in a branch), and clicking the Delete tool.

To delete all the versions of a document in a branch, right-click the document and select Delete Document.

To delete a folder, right-click it and select Delete. You must have Full permission on the folder and all its contents.

1.7.12 Repository Web Clients

This version of PowerDesigner comes with two repository Web clients. The new PowerDesigner Web client provides
a superior browsing experience, while the older PowerDesigner Portal is also provided.

PowerDesigner Web is a modern Web portal, which offers:

e Full repository access from your PC or mobile device.
® Full-screen zoomable SVG diagrams with stable URLs and image export.
e Creation and editing of:

o Requirements documents

o Enterprise architecture diagrams

o Process maps

o

BPMN business process diagrams.

e A private workspace, containing your diagrams in progress, diagrams sent to you for comment or review for
publication, recently viewed diagrams, and favorites.

e Commenting on any diagram object.

e Advanced search

® Graphical impact and lineage analysis

® [n-Web validation, review, and publication.
® Dynamically-generated charts.

For detailed documentation of PowerDesigner Web, see the separate PowerDesigner Web book.
For information about installing the Web clients, see Installation Guide > Installing the PowerDesigner Web Server

You can access the Web clients at the following addresses:
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e PowerDesigner Web: <server-name>:<port-number>/powerdesigner-web

1 Note

The default port numberis 3030.

e [owerDesigner Portal: <server-name>:<port-number>/cmr

1 Note

The default port number is 3040.

1.7.12.1 The PowerDesigner Portal

The PowerDesigner Portal allows you to view the contents of your PowerDesigner repository in your web browser.
You can share your models with a wide audience, including those who are not PowerDesigner users. Users with the
appropriate rights can edit object descriptions directly in the Browser.

Before you can access the PowerDesigner Portal, an administrator must install and configure it and provide you
with a user name and password. For information about installing the PowerDesigner Portal, see Installation Guide >
Installing the PowerDesigner Web Server . For information about the PowerDesigner repository, see The Repository
[page 242].

1.7.12.1.1 Logging into the PowerDesigner Portal

In order to log into the PowerDesigner Portal, you must have a repository user account, and obtain the appropriate
address for the site from your administrator. Your administrator must also advise you which connection profile to
use to connect to your repository.

Procedure

1. Inyour web browser navigate to the web site address provided by your administrator (for example http://

<server>:3040/cmr):

Core Features Guide
Modeling with PowerDesigner PUBLIC 295



PowerDesigner Portal g

Sign in to SAP PowerDesigner Portal.

User name:

Ll
Password: iV Logon HelD

2. Select the connection profile recommended by your administrator and enter your repository user name and
password.

Click Show profile information to display details of the selected profile or Advanced options to manually enter a
host name and port instead of using a profile.

3. Click Logon to go to the PowerDesigner Portal home page.

Each PowerDesigner Portal page includes the following links in the top-right corner of the screen:

o

e}

o

Help — to access this help document

Language - to change the interface language

Preferences — to review your connection parameters and change your password
Refresh - to refresh the display

Logout - to logout

1.712.1.2 PowerDesigner Portal Repository Explorer

The Repository Explorer is the main page of the PowerDesigner Portal, which contains a tree view of the contents
of the repository (with a Branch Filter at the top) and, on the right, the properties of the selected item.

To filter the Explorer tree by branch (see (see Branching Version Trees [page 2801).), click the Filter by Branch tool
and select the branches you want to view in the Branch Filter Selection dialog. The filter works simply by name, so
that branch names that are reused in different folders are treated as the same. You can toggle the use of the filter

with the Enable/Disable Branch Filter tool.
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PowerDesigner Portal g

Home | Repository Explorer | Search | Users and Groups | Settings Q

»

Branch Filter:  <All branches> _Tﬂ ﬁJ %‘_} Repository Document Properties: Purchasing Use Cases - v1

EI!.'aﬂReposmoryRoct IGeneral | @ Properties “aRelationships “Mersions W Permissions | #Subse

ZLibrary
B 3Purchasing

ESEVE IQF{eset

4 Purchasing Requirements - v1 Name:
Espurchasing Use Cases - v1 Code:
Disales Type: =
Dweb site
i Web Reguirements - v3 Stereotype:
Eweb Schema - vl Status:

EiChange Lists )
Repositary path:  /Purchasing/Purchasing Use Cases

Comment:

Thi=z model contains the primary use cases for -
the purchasing system. Er
Description: e
| = VR St B et V| - ERIEaE Q |
Fant |7 Size br By | 4

The explorer can contain the following types of node.

® Repository root - Displays the repository name.

e Folders - Subdivide and organize the documents in the repository.

e Branches - Allow concurrent development of multiple versions of documents.

e Projects — Group related models and other documents.

e Documents — Projects, models, multi-model reports, and external application files such as MS Office files, or
graphic files.

e Packages - Subdivide and organize model objects in models.

e (Object categories - Organize model objects in models.

e Diagrams - Requires that models are checked in with the Save diagrams for the PowerDesigner Portal option
(see Check-In Parameters [page 251]). You can click on object symbols in the diagrams to go to the relevant
object. Dependency matrices cannot be viewed in the Portal.

e Model objects - Tables, classes, etc.

1.712.1.2.1 Repository Document and Object Properties

Click any document or model object in the repository explorer to view its property sheet.

The following tabs are available:
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® General - displays basic information about the object. Users with the appropriate rights can edit the object
comment, description, and annotation. For shortcuts, click the entry in the Target object field to open the
object that the shortcut references.

® Properties - [models, packages, and model objects] displays the properties of the object.

® Diagram - [diagrams] displays the diagram. Requires that models are checked in with the Save diagrams for
the PowerDesigner Portal option (see Check-In Parameters [page 251]). Click on symbols in the diagram to go
to the related object.

® <sSub-objects> - [objects] displays a list of this type of sub-object (for example, table columns, keys, or
indexes, or class attributes or operations).

® Relationships - [objects] displays lists of the other objects with which the object is related.

e \ersions - displays the various versions of the document stored in the repository, along with information about
the current version of the document, its creation and last modification. For external application files, click the
icon in the Download column to download the file.

e Analysis - displays the impact of a change to the object (impact analysis) and identifies the objects that take
part in the definition of the object (lineage analysis) (see Impact and Lineage Analysis in the PowerDesigner
Portal [page 300)).

® Permissions - [models, packages and other documents] lists those users and groups with permissions on the
document (see Adding User or Group Permissions for a Repository Item [page 298]).

® (Compare - [models and objects] allows you to compare different versions of models and objects (see
Comparing Model and Object Versions [page 300]).

e Subscriptions - [projects, folders, and models] allows you to subscribe to email notifications of changes to the
object (see Subscribing to Change Notifications [page 299]).

1.712.1.2.2 Adding User or Group Permissions for a Repository
Item

You can change access permissions on an item from the PowerDesigner Portal.

Context

1 Note

These permissions can also be controlled through PowerDesigner (see Granting Access Permissions on
Repository Items [page 571]).

Procedure

1. Click the object in the repository explorer to display its property sheet, and then click the Permissions tab.
2. Click Add to open a selection box listing all the available users and groups.

3. Select one or more users and groups, selecting the appropriate permission for each from the drop down list
box in the Granted Permission column. The following permissions are available:
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o

o

List - View the document or folder in the browser and in search results, and display read-only property
sheets. Users who do not have even this permission on an item cannot see it in the repository Browser.
Read - Additionally compare documents, and check documents out from the repository.

Submi t - Additionally check the document into a changelist for review by a user with Write permission.
Write - Additionally check in (with or without a changelist), freeze, and lock document versions.

Full - Additionally manage permissions granted to users or groups and remove locks on documents.

4. [optional — for projects, folders, models] Select Cascade permission changes to folder contents to apply your
changes to children of the node.

5. Click Save to save your changes and return to the Permissions tab.

The Granted Permission column shows the permissions explicitly granted to groups and users, and Effective
Permission column displays their actual permissions, the most extensive permission granted either explicitly
or by way of membership in a group.

1.7.12.1.2.3 Subscribing to Change Notifications

You can subscribe to be notified of changes made to any project, model, external application document, or folder
on which you have at least Read permission.

Procedure

1. Navigate to the project, model, or folder for which you want to subscribe in the Repository Explorer, and then
click on the Subscriptions tab.

2. Select the Email checkbox against your name in the Notification Method column, and then click Save.

Results

1 Note

If you have the Manage users right, click New on the Subscriptions tab to open a list of users and groups, select
all those whom you want to subscribe to change notifications, and then click Save.
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1.712.1.2.4 Comparing Model and Object Versions

You can compare two versions of a PowerDesigner model or object in the PowerDesigner Portal to obtain a detailed
list of the differences between them.

Procedure

1. Click the object in the repository explorer to display its property sheet, and then click the Compare tab.

2. Select the branches and versions numbers of the two versions of the model or object that you want to
compare.

3. [optional] Click Expand All to open all the nodes.

4. [optional] Click any of the child nodes to view changes to their properties.

Results

For detailed information about working with this feature, see Comparing Models [page 395].

1.7.12.1.2.5 Impact and Lineage Analysis in the PowerDesigner
Portal

You can analyze the impact of a change to an object (impact analysis) and identify the objects that take part in the
definition of the object (lineage analysis) on any model object in the repository by selecting it in the Repository
Explorer and clicking the Analysis tab.

By default, the analysis descends to only three levels of dependencies, but you can select more or fewer levels by
selecting a number in the Analysis level list.
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Repository Object Properties: Account - v1

JGeneral @ Properties EVersions E'Compare wianalysis Attributes
%Change Impact Objects %Change Lineage Objects :ﬁ A uﬂF{e-ﬁu‘lalyze
Impact rule set:  Global Impact Analysis + Analysis level: 3

Lineage rule set: Global Lineage Analysis ~ Change action: Change

@lImpact and Lineage Analysis for Account
= Entity "Account’'[Change]

g [ZGenerated Objects
g Table 'Account'[Change](Physical Data - v2)
= [ERelationships
B Entity 'Person’[Change]
E- [ZChild Inheritances

Inheritance 'Inheritance 1'TChange]

E- [EGenerated Objects
Table 'Person’[Changel(Physical Data - v2)

- [ERelationships
Entity 'Laboratory'[Change]
Entity 'College’[Change]
Entity 'PhD Student'[Change]

B FEGeneration Origin
g Table 'Account'[Lineage](Physical Data - v2)
=- fE0utgoing References

Entity 'Account’'[Change] Properties: ¥ Show properties

1 Note

By default, impact and lineage analyses launched from the PowerDesigner Portal use rule sets checked into the

Library folder at the root of the repository.

For detailed information about using this feature, see Impact and Lineage Analysis [page 529].
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1.712.1.2.6 Editing Object Comments and Descriptions

Users with the Ssubmit, Write, or higher permission on a model can edit the Comment, Description, and
Annotation properties of its objects directly in the PowerDesigner Portal.

Context

1 Note

For information about object permissions, see Adding User or Group Permissions for a Repository Item [page
298].

Procedure

1. Navigate to the object whose properties you want to edit in the Repository Explorer and select the General tab.

2. Make any appropriate modifications directly in the text-only Comment field and the RTF Description or
Annotation fields.

The RTF fields provide integrated toolbars to allow you to modify the font (Arial, Comic Sans, Courier New,
Tahoma, Times New Roman, and Verdana), font size, and appearance, to change justification and add bulleted
lists, images (BMP, JPEG, non-animated GIF, and PNG), tables, and links.

3. Click the Save button to save your changes.

Caution

If you navigate to another object without clicking Save, all of your changes will be lost.

If you have the Write permission or higher, your check in is completed and is immediately available to other
users.

4. [if you have the submit permission] A message box warns that you may not directly submit changes to the
model and invites you to create a change list for review. Click OK to proceed with creation of the change list.

1 Note

If you click Cancel your proposed changes will be lost.

The change list is created, and the new version of the model is created under the change list.
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| Home | Repository Explorer | Search | Users and Groups | Settings Q

»

Branch Eilter: |<All branches> %_; Repository Document Properties: Purchasing Use Cases - v1

= BRepository Root —IGeneral | @ Properties | “aRelationships “Versions ML Permissions | #5ubs¢

Library
= Purchasing

ESE\,E # submit ‘ORESEt |Created change list 1050. Make further changes or submit.|

4 Purchasing Requirements - v1 Name:
%}Purchasing Use Cases - vl Code:
B CSales Type: !
Dweb site
4 wWeb Requirements - v3 Stereotype:
@Web Schema - vl Status:

]

EjChange Lists
= [Z£]1050 - Changelist_1050
= Purchasing
E:purchasing Use Cases -
[#11027 - Changelist_1027
[#11013 - Changelist_1013

Repository path:  |[/Change Lists/Changelist_1050/Purchasing/Purchasing Use
Cases

Comment: Thi= model contains the primary use cases for &

the purchasing system =

5. [optional] Make further edits to the objects in the model in the change list.

1 Note

Only one model can be added to a change list created in the PowerDesigner Portal.

6. When all your changes to the model have been completed, click the Submit button on the change list or any
object in the model, enter a comment to describe the changes contained in the change list, and click OK.

Comment: s+ gary - Tuesday 30 October 2012 14:26:04 #=#% =+
Added wvarious comments to clarify the nature of
objects in the use case model.

EDK 9 Cancel

The change list is now submitted and you can no longer make edits to the model contained in it. The change
list will be reviewed by a user with the Write permission or higher and, if approved, integrated into the
mainline, where your changes can be seen by other users.

For general information about change lists, see Change Lists [page 258].
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1.712.1.3 PowerDesigner Portal Search

You can search for PowerDesigner model objects in the PowerDesigner Portal via the Search box in the header. You
cannot search external application documents. You must have at least the Read permission to find objects.

Procedure

1. Enter your search string in the search field.

PowerDesigner Portal

‘ Home ‘ Repository Explorer | Search ‘ Users and Groups | Settings account AND NOT admin Q

The following special operators are supported:

Example Returns

sales Objects containing the text sales.

sales AND account (or +sales +account) Objects containing the text sales and account.

sales AND NOT account (or +sales - Objects containing the text sales but not account.

account)

sales OR account (or sales account) Objects containing the text sales or account.

sales~ Objects containing text like sales.

"sales account" Objects containing the exact string sales account.

sal?s Objects containing text such as sales or salts (? repre-
sents a single wild card character).

sal*s Objects containing text such as sales or salaries (* rep-
resents one or more wild card characters).

2. Click the Quick search button to display your results in the Search tab:
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<::'Elac|-c pdf
Name

Account

Account

Account

Account

Account

Account

Account

Account

Account

4

I# 4« B2245 % 3]

account AND NOT admin

Search in: /

hd Report
Object Type
Table

Edition
Class
Class
Class
Article
Entity

Class

List

All Properties

Resource Path

/Web/Production/Primary Company
Site/Physical Data

/Web/Testing/Primary Company Site/Web
Site

/Back Office/HR/Testing/HR Data

Warehouse/Implementation/WebLibrary
Java Implementation

/Back Office/HR/Development/HR Data

Warehouse/Implementation/WebLibrary
Java Implementation

/Back Office/HR/Development/HR Data
Warehouse/Analysis and
design/WebLibrary Design

/Back Office/HR/Testing/HR Data
Warehouse/Data Management/Data ETL
and Replication

/Back Office/HR/Development/HR Data
Warehouse/Analysis and
design/WebLibrary Conceptual Data
/Back Office/HR/Testing/HR Data
Warehouse/analysis and
Design/WebLibrary Design
/Web/Development/Primary Company
Site/Web Site

¥ Show properties

Click on aresult line to display the object's property sheet.

ngu ick search

Advanced search

[#Search vithin Results | 123 results.

Text View

Code:account
Name:Account

Code:Account
Name:Account

Name:Account
Code:Account

Code:Account
Name:Account

Code:Account
Name:Account

Remote Table:DUPLICATED_ACCOUNT
Name:Account
Code:ACCOUNT

Name:Account
Code:ACCOUNT

Name:Account
Code:Account

Name:Account

Page: 1 Go

1.7.12.1.3.1 Advanced PowerDesigner Portal Search

You can perform searches with more complicated and multiple criteria from the Search tab. To use a saved search,

click its Run button.

Context

*

Search name -
Saved Searches:
[ Search Name

Elsite Project
Requirements
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HiFilter lgl}"l‘del.rf Search

Owner

.’:’;ADMIN Requirements Model:Requirement

Search type

Description Run

Requirements selected for development. 3 Run
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Procedure

1. Click the Search tab and then click New Search.

2. [optional] Select a node in the Repository Explorer tree such as a branch, project, or model to restrict the
scope of your search. By default, you search the entire repository.

1 Note

Searching the entire repository may take a long time. You should, wherever possible, try to restrict the
scope of your search.

3. [optional] Select a model type and an object type to search. By default, you search all model types and all
object types.

In this example, | select Physical Data Model and Table:

@ Property S User & Date @iGlossary . Result Columns
Model Type: Object Type:
Physical Data Model - Table -

4. Select a property, operator and value to search against. Depending on the property that you select, the choice
of operator may be restricted and/or values may be suggested. Note that the case sensitivity of your searches
depends on your repository DBMS.

When using the Contains operator, the following special characters allow you to use basic regular
expressions for text searches:
o *-none to any number of characters
For example: W* finds "Work" and "Washington"
o 7 —exactly one character

o \-escapes* ? or\
o true/false - Boolean value (True is when the check box is selected in the interface)

5. Click the Add button to add the complete search clause to the Search clause table.

In this example, | choose to search for tables that are selected for generation:
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@ Property % User & Date wiGlossary Result Columns
Model Type: Object Type:
Physical Data Model - Table -
Attributes: Values:
Dimensional Type ENUM - true -
Element STRING false
End Script STRING Cinot
Generate BOOL g5 @©=
Initial rows DOUBLE
Modification Date DATE )15 NULL
Modifier STRING -
4 I e
Generate = true

o add #search [ Include shortcuts

Search type: Physical Data Model: Table

al Attribute Operator Value And/Or
[ Generate = true

6. [optional] Create additional search clauses and add them to the Search clause table, choosing one of the
following conjunctions:

© AND - results must satisfy all clauses
o OR - results must satisfy one of the clauses

In this example, | refine my search to look only for tables that are estimated to have more than 100 records:

@ Property T User & Date wiGlossary Result Columns

Model Type: Object Type:

Physical Data Model - Table -
Attributes: Values:

.-.uuj...,._.u.... == e > 100 -
Modifier STRING

Name STRING FINoT

Number of Records DOUBLE ®=

Number of Test Records INT = a;

Options STRING r

Partition range INT (OIS NULL

- . . N : :
Mumber of Records > 100

% add #search | || Include shortcuts

Search type: Physical Data Model:Table

[ Attribute Operator Value And/Or
[ Generate = true AND
1 Number of Records - 100
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7.

10.

11.

12.

[optional] Click the User & Date tab and specify additional search clauses based on user names and creation
and modification dates.

[optional] Click the Glossary tab and specify additional search clauses based on glossary objects (terms,
related terms, synonyms, and keywords) with which objects may be associated.

[optional] Click the Result Columns tab and select the columns that you want to display on the result page. By
default, only the object type and name are shown.

[optional] Select the Include Shortcuts check box to include shortcuts to objects in your search results.

Click the Search button to start your search.

Your search results are displayed. Click on an object to display all its available properties:

l’ﬁgQuicI‘c search

Search in: / Advanced search
TBack pdf + | Hreport All Properties  ~ [Asearch vithin Results
Mame Object Type Resource Path
Account Table /wWeb/Production/Primary Company Site/Physical Data
Account Table /Web/Testing/Primary Company Site/Physical Data
Account Table /Web/Development/Primary Company Site/Physical Data
Matriculation file Table /web/Development/Primary Company Site/Physical Data
Matriculation file Table SWeb/Production/Primary Company Site/Physical Data
Matriculation file Table /Web/Testing/Primary Company Site/Physical Data
Person Table /Web/Production/Primary Company Site/Physical Data
Person Table /Web/Development/Primary Company Site/Physical Data
Person Table /Web/Testing/Primary Company Site/Physical Data
PhD Table /Web/Production/Primary Company Site/Physical Data

[optional] After performing a search, you can:

o Select either pdf or xls and click the Report button to generate an Excel or PDF version of your results.

o Select an attribute, enter a value in the search box at the top of the screen and click the Search within
results button to further refine your search.

o Click the Back button and:
o Modify your search string.

o Enter a Saved search name and description and then click the Save button to make your search
available for reuse on the Search page.

1.7.12.1.4 PowerDesigner Portal Users and Groups

Repository users with the Manage users right can view, create, modify, and deactivate users and groups, and
manipulate their assignment to groups via the PowerDesigner Portal.

308
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| Home | Repository Explorer | Search  Users and Groups | Settings

Q

g 4% Users and Groups 5
AP
.’_';)Users =
4f,Groups Login name -

Users:

= Login name -
& ADMIN
[ ] E
0 Alice
[ -] .
9 Brian

& David

R

Jf‘ .
¥ Jennifer

P 3]
‘&' Search

Realm

PowerDesigner
PowerDesigner
PowerDesigner
PowerDesigner

PowerDesigner

[[] Show deactivated members

Full name

ADMIN
Alice
Brian
David

Jennifer

Users and groups can be created here or through PowerDesigner (see Controlling Repository Access [page 5507).

1.712.1.4.1 Creating a Repository User

You can create users on the Users and Groups tab.

Procedure

1. Click the Users and Groups tab and click on Users on the left of the screen to display the list of users.

2. Click New, select to create a PowerDesigner or external user, and enter a login name.

1 Note

External users and groups are those for whom authentication is delegated to an LDAP server. Note that
remote users and groups can be added to local groups, but local users and groups cannot be added to

remote groups.

3. [local users only] Enter a full name, email, and description for the user. An email address is required if the user

is to receive change notifications.

4. [optional] Click the Parent Groups tab and add the user to any appropriate groups (see Adding a Member to a

Group from the Member's Property Sheet [page 311]).

5. [optional] Click the Rights tab and assign the user any appropriate rights (see Granting Rights to Users and

Groups [page 310]).

1 Note

When you create a user, make sure you grant him/her access rights on repository documents, either by
inserting this user into a group, or directly. If a user connects to the repository without access rights, he

cannot see any documents in the browser.

6. Click Save to create the user and return to the list of users.
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1.712.1.4.2 Creating a Repository Group

You can create groups on the Users and Groups tab.

Procedure

Click the Users and Groups tab and click on Groups on the left of the screen to display the list of groups.
Click New, select to create a local or remote group, and enter a group and full name.

[optional] Enter an email address and/or a description for the group.

Awon o

[optional] Click the Members tab and add any appropriate users to the group (see Adding a Member to a
Group from the Group's Property Sheet [page 312])

5. [optional] Click the Rights tab and assign the group any appropriate rights (see Granting Rights to Users and
Groups [page 310])

1 Note

Rights granted to a group are inherited by its members. If a user connects to the repository without access
rights, he cannot see any document in the browser.

6. Click Save to create the group and return to the list of groups.

1.7.12.1.4.3 Granting Rights to Users and Groups

Each repository user and group has a set of rights that govern its interactions with the repository. A new user has
only the Connect right assigned by default, and a new group has no rights. You can assign rights to users and
groups on the Rights tab of their property sheets.

Context

User and group rights can be associated with permissions on documents to define the actions a user or group can
effectively perform on a document.

Procedure

1. Click the Users and Groups tab, select Users or Groups on the left of the screen, and click the appropriate
entry in the list to go to its property sheet.

2. Click the Rights tab and select the check boxes corresponding to the rights you want to assign. The following
rights are available:
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0 Connect - To connect to the repository.

0 Freeze - T0 freeze document versions.

O Lock - To lock document versions.

o Edit PowerDesigner Portal Objects - To edit objects in a Web browser (see Editing Object Comments
and Descriptions [page 302]).

© Manage branches - To create, modify, and delete branches.

©0 Manage configurations - To create, modify, and delete configurations.

0 Manage all objects - To create, check in, check out, unlock, unfreeze, define permissions, and delete
any document version.

1 Note

This right is typically granted to data administrators, and implicitly includes Full permission on all
repository documents to allow them to check in, freeze, lock, and delete any document.

© Manage users - [0 create, modify and delete repository users and groups, grant rights to users and
groups, and add users or groups to a group.
© Manage repository - To create, upgrade, and delete the repository database.

3. Click Save to save your changes and return to the list of users or groups.

1.7.12.1.4.4 Adding a Member to a Group from the Member's
Property Sheet

You can add a user or a group to a group from the prospective member's property sheet. When the member is
added to the group he will benefit from the rights associated with that group.

Procedure

1. Click the Users and Groups tab, select Users or Groups on the left of the screen, and click the appropriate entry
in the list to go to its property sheet.

2. Click the Groups tab to display the list of available groups and the list of groups to which the user or group
belongs:
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HSaue aReset

Ll .
¢p User properties : gemma

| _IGeneral S Parent Groups B Rights WSubscriptions ‘ B Permissions
Available groups: Parent groups: .
Salect groups to which to add the user. The user belongs to the following group(s).
I Mame x| £ 5earch I Mame x| Ssearch
|| Group name Realm r Group name
[}
r foapmMy PowerDesigner m  &PuUBLIC
M fDevelopment PowerDesigner
M &%Documentation PowerDesigner
| 4504 PowerDesigner

3. Select one or more groups from the Available groups list, and then click the right-pointing arrow to move them
to the Parent groups list.

4. Click Save to save your changes and return to the list of users or groups.

1.712.1.4.5 Adding a Member to a Group from the Group's
Property Sheet

You can add a user or a group to a group from the receiving group property sheet. When the member is added to
the group he will benefit from the rights associated with that group.
Procedure

1. Click the Users and Groups tab, select Groups on the left of the screen, and click the appropriate entry in the
list to go to its property sheet.

2. Click the Members tab to display the list of available members and the list of child members:

Core Features Guide
312 PUBLIC Modeling with PowerDesigner



HSaue aReset

-55 Group properties : Development

| IGeneral ffParent Groups ¥ Rights | W subscriptions | B Permissions
Available members: Child members:

Select members to add to the group. The following member(s) belong to the group.
I Name LI Iz: Search I Name LI Iz: Search
[] Mame Realm [ Mame

| 5aDMIN PowerDesigner
O gﬁgemma PowerDesigner
r Swarc PowerDesigner
- .
[T & Clivier PowerDesigner
r Srob PowerDesigner

3. Select one or more members from the Available members list, and then click the right-pointing arrow to add
them and move them to the Child members list.

4. Click Save to save your changes and return to the list of groups.

1.7.12.1.4.6 Deactivating a User

The repository administrator or a user with the Manage Users right can deactivate users, canceling their rights
and permissions in the repository. A user cannot deactivate himself.

Procedure

1. Click the Users and Groups tab, and select Users on the left of the screen to display the list of users.
2. Select auserin the list, click the Deactivate button, and then confirm the deletion by clicking OK.
The user remains in the List of Users but his rights and permissions are canceled. Select the Show deactivated

members checkbox above the list of users to see users who are no longer active. You cannot add a new user
with the same username as a deactivated member.
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1.7.12.1.4.7 Deleting a Group

The repository administrator or a user with the Manage Users right can delete groups from the repository. When
you delete a group you do not delete the members (either users or groups) of the group.

Procedure

1. Click the Users and Groups tab, and select Groups on the left of the screen to display the list of groups.

2. Selectagroupinthe list, click the Delete button, and then confirm the deletion by clicking OK.

The group is removed from the list. Deleting a group has the following effects:
o The users who belonged to the group lose the group rights
o All permissions on documents granted by the group and subscriptions via the group are canceled
o The group is removed from the groups to which it belonged
©  The group is no longer displayed in the list of groups

1.7.12.1.5 PowerDesigner Portal Settings

The Settings tab lists various parameters that administrators can use to control the server and client components
of the PowerDesigner Portal.

1.7.12.1.5.1 PowerDesigner Portal Client Settings

The PowerDesigner Portal provides a number of client settings that you can modify on the Settings page.

Logging

The following settings allow you to control logging:

Setting Description
Log file name Specifies the name to give to the log file.
Log level Specifies the minimum level of importance for the messages to be written to the log file.
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Setting Description

Rollover by Specifies how the log file should be rolled over. You can choose between:

e Time/Date - the file rolls over after a certain time. Specify the duration and the format of the log
file name in the date pattern field below.

e File size — the file rolls over when it reaches a certain size. Specify the maximum file size in the
field below.

Truncate the log file Specifies to create a new log file each time the server is restarted.
after the server starts

To view the log file directly in the browser, select the level of message that you want to view and, optionally, a
keyword to search on, and then click the Search button. Click the View button to view the file in a separate window.

SSL Connection

The following settings allow you to control SSL connections. You must log out and log back in again for changes to
take effect:

Setting Description

Keystore file name Specifies the name of the keystore file, a database used by the security provider to store public and
private key certificates, used by the security socket connection. A default client.keystore file is pro-
vided for the test environment.

KeyStore file path Specifies the path to the keystore file. The default is CMR_HOME/keystore.

TrustStore password | Specifies the TrustStore password, used to access the keystore file. The default for the test environ-
ment file is "changeit". We recommend that you change the TrustStore password and regenerate the
certificates and keystore files.

Theme

The following settings allow you to control the look of the site:

Setting Description

Color theme Specifies the color scheme used for the site pages.

Logo picture Specifies the logo image used in the site title bar. Use the Browse button to locate an image to use, and
the Upload button to upload it to the site.

Logo title Specifies the title used in the site title bar.
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1.7.12.1.5.1.1 Creating a New Color Theme

You can create new color themes for the PowerDesigner Portal. To do so, you will need to be comfortable editing
image and css files.

Procedure

1. Goto<install dir>\Tomcat\webapps\cmr\theme and make a copy of one of the existing color theme
directories to use as the basis of your new theme.

2. Rename the copied directory to the name that you want to see in the Color theme list on the Settings page.

3. Goto<new theme dir>\images\css-images\dgmto view allthe componentimages that are used to
construct the PowerDesigner Portal site.

4. Open each of the images in turn in your image editor, make appropriate, consistent changes to their color
schemes, and then save them back into the folder.

5. Goto<new theme dir>\cssandopen cmr.css inyour text editor to view the css code that controls the
look of other elements of the PowerDesigner Portal site.

6. Make appropriate changes to the background-color and color statements and then save your changes.

Navigate to the PowerDesigner Portal site in your Web browser and click the Settings tab. Click Refresh to
ensure that your changes are taken into account by the server.

8. Click | Settings ¥ Client settings » Theme 3 and select your new color theme from the list.
9. [optional] Select an image to use as your site logo and enter a new logo title for your site.

10. Click Save to apply your changes.

1.7.12.1.5.2 PowerDesigner Portal Server Settings

The PowerDesigner Portal provides a number of server settings that you can modify on the Settings page.

General

The following general settings are available. You must restart the PowerDesigner Portal for changes to take effect:

Setting Description
Name Specifies the name of the repository.
Comment Describes the repository.
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Setting

Session timeout (min)

Description

Specifies the amount of time that the browser session is permitted to be idle before it is automatically
logged out.

Max users

Specifies the maximum number of users that may connect to the PowerDesigner Portal at any one
time.

Object cache size
(MB)

Specifies the amount of memory assigned to object caching. The default is 128MB. Increasing this
value will improve performance.

LDAP

The following LDAP settings are available and can be set here or through PowerDesigner (see Connecting to an
LDAP Server for User Authentication [page 553]). You must restart the PowerDesigner Portal for changes to take

effect:

Parameter Description
Server type Specifies the type of the LDAP server and sets default values for the server. The following types are
available:

e Active Directory - if your environment supports anonymous binding, you may be able to connect
without further configuration. Click the Test Connection button and follow the instructions on the
dialog.

e Netscape Directory Server

e  OpenLDAP

e Oracle Directory Server

e Other

If you edit any parameters and want to revert to the defaults, click the Default Settings button.
Provider URL

Specifies the URL for the LDAP provider. By default, for Active Directory, the nearest LDAP server is au-
tomatically detected and used for authentication, initializing this field to:

LDAP:// ldap.<domain>:389
For other servers, this field is initialized to:
LDAP://ldap.<domain>:389

and you should replace 1dap with the name or IP address of your LDAP server.
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Parameter Description

Use Secure Socket

Specifies to connect to the LDAP server using SSL, changing the LDAP provider port to the standard
Layer (SSL)

secure 636. If you have deployed the PowerDesigner Portal, you must obtain and register your certifi-
cate authority root certificate in the Java installation. You must obtain and register your certificate au-
thority root certificate in the Java installation.

1 Note

PowerDesigner users may need to contact their administrator to obtain a certificate and use
\Windows\System32\certmgr .msc to register it on their workstations. Right-click Trusted

Root Certification Authorities and select |} All Tasks > Import } then follow the wizard instructions.

Default search base Specifies the level at which the query begins its search for users in the LDAP tree. By default this is ini-

tialized to the domain components (DCs) of the LDAP server. For example:
dc=acme, dc=com

You could include the location of the User directory such as OU=Users, dc=devpd, dc=local.
If the location of the User directory is not specified here, then you must include it in the Authentication
Search Base.

Anonymous bind [default] Specifies that the LDAP server supports anonymous access. If you deselect this parameter,

you must specify a bind user distinguished name (DN) and password for an account that has permis-
sions to query the LDAP server.

1 Note

If the Bind user DN is in the same DN as the Authentication search base then you can simply enter
the user id for the search. Otherwise, you must enter the full DN for that account. For example, if the
Default search base is ou=people, dc=0Onebridge, dc=ga, and you have a user
cn=csitest, cn=users, dc=Onebridge, dc=ga, then the Bind DN must be

cn=csitest, cn=users,dc=Onebridge, dc=ga.

Auto-create user ac-

Specifies that any users corresponding to the LDAP authentication search filter can connect to the re-
counts in repository

pository, and will have an account created for them in the repository when they do so. If you do not
select this option, then an administrator must create an account for each user before they can connect.

Search filter Specifies the LDAP query that selects users for authentication. By default this is initialized to (for Active

Directory):

(& (objectClass=person) (userPrincipalName={uid}))
and for other servers:

(& (objectClass=person) (cn={uid}))

To determine an alternative filter, you must know the properties of the users defined in the Active Direc-
tory, and which property (for example, name or samAccountName) is being used as the login name.
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Parameter

Search base

Description

Specifies the location of the User list in your LDAP server. By default this is initialized to the same value
as the Default search base. If the default search base does not include your users you must specify an
appropriate search base here. Users may be in a common node such as cn=Users or an organization
unit such as OU=Users. To determine the correct search base, you should use an LDAP browser to
look at the full distinguished name of a user. Note that your Bind DN may be a user in a different node in
the tree than general users so it is very important that you have the correct information for each.

Search scope

Specifies the scope of the authentication search. You can choose between:

e subtree - [default] the search begins at the level of the Search base and also searches any subn-
odes.

e onelevel -only the level specified in the Search base is searched

Authentication

Specifies the method to use for authentication requests. You can choose between:

method
e simple - [default] clear text authentication. If SSL is enabled, then the password will be en-
crypted.
® DIGEST-MD5 - hashed password authentication. If you select this option, you must specify a di-
gest format.
Logging

For information about the Logging settings, see PowerDesigner Portal Client Settings [page 314].

Database

The following database settings are available. You must restart the PowerDesigner Portal for changes to take effect:

Setting Description

Database type

Specifies the type of DBMS that hosts the repository.

Database driver

Specifies the driver used to connect to the repository database.

Host

[required] Specifies the name of the host machine for the repository database.

Port

[required] Specifies the port number of the host machine through which the repository database is
available.

Database name

Specifies the name of the repository database.

User name

Specifies the database user name that the repository uses to access the DBMS.
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Setting Description

Password Specifies the database password that the repository uses to access the DBMS.

Isolation level Specifies the isolation level used to isolate transactions in a multi-user environment. By default, level 1
is used for ASA databases and level 2 for ASE. See your DBMS documentation for information about
the behavior of each level in your environment.

Initial pool size Specifies the initial number of connections in the connection pool. The default is 1.

Minidle Specifies the minimum connection idle time.

Max idle Specifies the maximum connection idle time.

Max wait (msec) Specifies the maximum connection wait time.

Max active Specifies the maximum permitted number of connections to the database.

Charset [ASE only] Specifies the character set used by the database.

Search

The following search settings are available. You must restart the PowerDesigner Portal for changes to take effect:

Setting Description

Index Information Specifies the last time the search index was rebuilt, the next time it will be built, its location, size, and
the number of attributes indexed.

Index rebuild interval | Specifies the interval between rebuilds of the search index in minutes. By default, the index is rebuilt
every 120 minutes. Click the Rebuild Index button to perform an immediate rebuild.

Security

The following password policy settings are available and can be set here or through PowerDesigner (see Defining a
Password Policy [page 559]). You must restart the PowerDesigner Portal for changes to take effect:

Parameter ’ Description

Password length Specifies the minimum and maximum permitted length of passwords. This option cannot be
disabled. The minimum length for a password is 6 characters.

Password must contain Specifies that passwords must contain at least one of each of the character types selected.

Disallow reuse of previous Prevents users from reusing the specified number of old passwords.
<x> passwords
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|
Parameter

Enforce changing of pass-
words after <x> days

’ Description

Requires that users change their passwords after the specified number of days.

Block inactive users after <x>
days without connection

Blocks users if they try to log in after the specified number of days of inactivity.

Temporarily block users for
<x> minutes after <y> failures
tologin

Blocks users for the specified number of minutes if they submit an invalid combination of user-
name and password the specified number of times.

Temporary passwords issued
by an administrator are valid
for <x> days

Specifies the period for which temporary passwords (which are issued when a user is created
or unblocked) are valid. Users attempting to use a temporary password after this time will be
blocked.

Notification

The following change notification settings are available and can be set here or through PowerDesigner (see
Connecting to an SMTP Server for Notifications [page 558]):

Parameter Description
SMTP host Specifies the host name of the SMTP server used to send mail.
SMTP port Specifies the port number of the SMTP server used to send mail.

Sender's email address

Specifies the email address from which to send mails.

Use Secure Socket Layer
(SSL)

Specifies to connect to the SMTP mail server through SSL.

Server requires authentica-
tion

Specifies that the SMTP server requires authentication. If you select this option, then you must
specify an SMTP account and password, and can select to use Secure Password Authentica-
tion (SPA).

In addition, you can control the content of notification emails by selecting items in the Mail template list and
overriding the default text associated with them.
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1.712.1.5.2.1 Importing an LDAPS Certificate for the
PowerDesigner Portal

If you are required to connect to your LDAP server using SSL, then you must request a certificate from the LDAP
server administrator and import it into your PowerDesigner Portal installation. Importing the certificate allows the
PowerDesigner Portal to contact the LDAPS server to authorize users wanting to connect.

Context

This procedure explains the process for importing the certificate into the default Tomcat keystore file at install_dir/
keystore/common.keystore. For security purposes, we recommend that you generate your own key and keystore
file. The keystore information is saved in the following file: <install dir>/keystore/config/

cmrcommon . Xxml.

Procedure

1. [recommended] Create a backup of the JRE certificates file, $JAVA HOME\jre\lib\security\cacerts.
2. Copy the LDAP server certificate to $JAVA HOME\jre\lib\security.

Import the certicate into the keystore with the command:

keytool -import -file <certificate_name>.pem -keystore cacerts
4. Enter the keystore password to complete the import.

5. Restart the PowerDesigner Portal to allow it to obtain the certificate.

1.7.12.1.5.3 PowerDesigner Portal Server Status Settings

The PowerDesigner Portal provides a number of server status settings that you can modify on the Settings page.

Setting Description

Server Information Displays the host name, port, version, and status of the server, along with the number of users cur-
rently logged in. Click the Restart button to restart the PowerDesigner Portal service.

Change Notification Displays the SMTP host, port, and status of the notification service. Click the Suspend button to sus-
Information pend the notification service. Click the Resume button to resume the notification service. When re-
suming, you can optionally select the Include suspended notification items checkbox to send all notifi-
cations that would have been sent during the period since the suspension.
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1.712.1.6 Troubleshooting the PowerDesigner Portal

These sections contain information to help you troubleshoot problems with the PowerDesigner Portal.

1.7.12.1.6.1 Unicode Encoding with SAP® SQL Anywhere® V10

If you are using a SAP® SQL Anywhere® v10 database to store your repository information in a unicode format, you
must create the database with the -z option set to an appropriate value.

For example, to create a database to correctly store Japanese characters, you should use the following option:

-z 932JPN -zn UTF8BIN

For a list of the -z options for all the supported languages, see the SQL Anywhere documentation, available at:
https://help.sap.com/viewer/p/SAP_SQL_Anywhere.

1.712.1.6.2 Increasing Tomcat Memory

By default 256MB of memory is allocated to Tomcat. If you will be browsing large models (20MB or more) or if you
anticipate many concurrent users, you may need to increase this amount to 512M or 1GB.

Procedure

1. Stop the PowerDesigner Portal service.
2. Openacommand window and navigate to <portal install dir>/Tomcat/bin.

3. Run the following command:
tomcat?7 //US//<PortalServiceName> --JvmMs <x> --JvmMx <y>

For example, if you have not changed the default service name, to set the initial memory pool size to 1GB and
the maximum size to 2GB, run the following command:

tomcat?7 //US//PortalServerl6 --JvmMs 1024 --JvmMx 2048

For detailed information about the Tomcat Windows service command line syntax, see http://
tomcat.apache.org/tomcat-7.0-doc/windows-service-howto.html # .

4. Restart the PowerDesigner Portal service.
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1.8 Reports

PowerDesigner reports allow you to publish information about your models in HTML or RTF format.

You can create the following types of report:

e A model report — provides information about all or some of the objects in a model, and is shown in the Browser
in the Reports folder beneath its parent model (see Creating a Model Report [page 324]).

e A multi-model report — provides information about one or more models, and is shown in the browser as an
independent item, saved as a.mmr file (see Creating a MultiModel Report [page 339]).

e Alist report — provides information about a single type of object, and is shown in the Browser in the List
Reports folder beneath its parent model (see Creating a List Report [page 331]).

This version of PowerDesigner supports two kinds of model and multi-model reports:

® |egacy reports - use the traditional Report Editor, which is deprecated and will be removed from a future
version (see The Legacy Report Editor [page 363]).

e New format reports - use the new graphical Report Editor, which provides synchronized Design and Outline
views, seamless inclusion of model extensions, simplified WYSIWYG formatting, and modernized HTML and
RTF generation (see The Report Editor [page 340]).

1 Note

The initial version of the new Report Editor has the following limitations:
o No global selection of objects to display in the report - Define any appropriate selections on object
books.
o Not available in the plugin for Eclipse.

1.8.1 Creating a Model Report

You can create a model report using the Report Wizard or manually, refine it in the Report Editor, and generate it in
HTML or RTF format, or print it at any time.

Procedure

1. Create the report in your model using the Report Wizard (see Creating a Report with the Report Wizard [page
325]) or from the list of reports (see Creating a Report from a Template or an Empty Report [page 330]).

2. [optional] Refine the content and format of your report in the report editor (see The Report Editor [page 340]).

1 Note

The report is saved as part of its model. If your model is very large, you may want to create the report as a
multi-model report, which is saved separately (see Creating a MultiModel Report [page 339]).

3. Generate the report as HTML or RTF, or print it directly (see Generating a Model Report [page 385]).
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1.8.1.1 Creating a Report with the Report Wizard

The Report Wizard provides an easy way to create a report, select model objects and format them. The wizard can
be launched from your model to create a new report, or from the Report Editor to configure an existing report. You
can complete as much of the Wizard as you want. At each step, you click Next to advance to the next stage, or
Finish to create a report based on your selections so far.

Procedure

1. Select|» Report » Report Wizard 4 (or select |fr Report » Reports i to open the List of Reports, and then click
the Report Wizard tool) to launch the wizard.

2. Specify a name for the report and the language in which you want its titles to appear, and then click Next.

1 Note
[optional] To use the new report format and editor (see The Report Editor [page 340]), deselect Use legacy
Report Editor.

Report Creation Wizard

YWelcome to the Report Creation ‘Wizard. Thiz wizard helps pou to publish a
report an your maodel.

Welcome
Provide a name for your repart;

Presentation Options Process Report
Select a language faor the titles of report items:
|5} Engiish =

Package Options Usze legacy Fepart Editar

Repart Stucture

Report Layout

End

< Back Net> | [ Fnsh | [ Cancel | [ Hel

Core Features Guide
Modeling with PowerDesigner PUBLIC 325



3. Select whether you want to prepare your report for publishing as HTML or RTF, or for direct printing, select a
presentation template, and then click Next.

Report Creation Wizard
Select the format for pour report;
Welcome () HTML, for publishing wour repart on the Internet ar intranet
@ RTF, for publizhing vour repart in a Bich Text Format file
Presentation Dptions (71 Local, far printing the repart directly from its editor

Repart Stucture
Select a presentation terplate far pour report;

Fepart Layaut Professional '] Qﬂﬂ

End

<Back || Ned> | [ Fnsh | [ Cancel | | Heb

1 Note

For HTML and RTF reports, you can use the tools to the right of the template field to preview and edit the
template and to change the folder in which to search for templates.

4. Specify the types of information that you want to appear in your report, and click Next.
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Report Creation Wizard

Chooze what infarmation you want b see in pour report,

Feport 5tuctue The preview pane on the left hand-side shows vour choices in a
zample report,
T able of Contents Intraduchion zection

1. Intraducti ) )
1.q EEL;E[:;EIDH Intraduction test

1.2 Card of maodel ]
2. Full model dezcription HiESlE ey iss

2.1 Diagram 1

2.2 Objects [T15hort description zectior
%%12 lﬁlitieuéﬁblecm [ Dizplay diagrams
2221 Card of Object 1 List ohiect
2.2.3 Object 2 [ List abiects
2.2.3.1 Card of Object 2
2.3 Links s e e Full description section
2.3.1 Lizt af linkz Disolaw di
797 Link 1 izplay diagrams
AU B SL List objects before full description

Objects detailed dezcription

[ List objects diagram by diagram

<Back || Ned> | [ Fnsh | | Cancel | | Heb

The preview pane on the left hand-side displays a sample report that changes dynamically according to your
selections. You can select any or all of the following options:

o Introduction section — Inserts a page break followed by an introduction section, which can contain a
paragraph of Introduction text (click the Define button to enter text), and a card listing the Mode/
properties.

o Short description section — Inserts a page break followed by a short description section, which can Display
diagrams (including the Diagram book with a picture of each diagram with its description and annotation)
and List objects (with a list for each type of object in the model).

1 Note

RQM views are not diagrams and cannot be published graphically.

o Full description section — Inserts a page break followed by a full description section sub-heading, which
can display all the elements from the short description section plus the Objects detailed description (a
book item for each object type).

o List objects diagram by diagram - [except RQM] Instead of a flat display of object types, displays objects
sorted by the diagram in which they are displayed. Global objects, such as business rules, do not belong to
a specific diagram, and are therefore listed in their own section under the root.

5. [if your model contains packages] Specify whether you will report on the whole model or only a package and

whether you will ignore the package structure, or organize objects under a flat list of packages or a hierarchical
list of packages (where sub-packages are children of their parent package), and then click Next.
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Report Creation Wizard

Your model i decompozed into packages.
Package Options “r'ou can build a report on the entire model or on selected
objects belonging to a specific package:

Tahble of Contents &2 Logistics Processes j
1. Root Object 1

2. H'I'F't Dbll?':t 2 Choose how you want bo organize your report ikems:

3. Object 1 in Package

4 Object 2 in Package = Without packages, all objects are described at the

8. Object 1 in Sub-Package @ came level

E. Object 2 in Sub-Package

One section per package, objects are described under
- their package

- Hierarchical sections, each sub-package iz a sub-zection
-~ in the document

The preview pane on the left hand-zide shows vour choices in a
zample report containing packages.

| < Back ” et = | I Finish II Cancel I I Help

The preview pane (on the left hand-side) changes dynamically in order to preview your selection.

1 Note

Global objects, such as business rules, are always included, even if you select a package, and composite
objects, such as OOM activities or processes, are always displayed hierarchically, even if you have selected
a different package option. Only the hierarchical structure is supported for HTML reports or RQM reports.

6. Specify the types of object that will be included in your report, along with the properties that will be displayed
in each of their list and card report items, and then click Next.
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Report Creation Wizard

Y'ou can now custamize the layout of report items.

“'ou can chooze which types of objects will appear, and the order in which
wWeloome they will appear.

Y'ou can alzo zpecify which attributes to dizplay for each twpe of object in the
list and card lapouts,

Presentation Options Select an ohject type: Canfigure the layaut: g
B ‘ —|—|
Repart Struchre 2R List Layout | Card Lapout
~{w36, Organization Unit Atrbute Name | D| Width| =
. -]l Logical Component Mame HIEFE
Fesbeps e (-l + | Business Frocess Code FlEE A
H-v) Intermediate Evert Mutti-Instance W]i20m |
Report Layout [#-»}2 Process Step Parent Crganization % o
[ ]— Fow Parent ) 20m
End ~#E) File g::.plcat;-#lame ] %m
-] 7| General Documentatic |2Ct P L § 2\im
(-] = Master Data Creation Date | Hm
D Project Documentation Creator s 50m
Modification Date S0m X
Modifier i 50m : =
Owerall Modffication {7 50m | =
« | m g HEIR R EIE IR
<Back || Ned> | [ Fnsh | | Cancel | | Hep |

o Toinclude an object type in the report, select its check box in the list. You must select at least one object
type. Click on the plus sign to the left of an object to select sub-objects. Use the Move Up and Move Down
tools to reorder the list (sub-objects cannot leave their parent scope). New types of objects defined in
extensions (stereotypes used as metaclasses) are listed after their parent object type.

o To control the properties included for an object type in lists and cards, select the List Layout or Card
Layout tab and use the following columns

o Attribute Name — Use the arrows at the bottom of the list to reorder the list.
o Dfisplayed] — Select the check box to display the attribute.
o Width [List Layout] — Specify the width of the column either as a percentage or in millimeters.

7. Optionally preview your report, and select to open it in the report editor and or directly generate or print it, and
then click Finish.
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Report Creation Wizard

Congratulations, vour report iz now ready to be publizhed !

Welcome ou can now preview the whole report;

Prezentation Options
Y'ou can chooze what to do when you click Finizh:

Report Stucture Open the report in the Repart Editor to fine-tune more options.
[T Directly generate ar print the repart.
Fepart Layaut
End

Next > Fiish | [ Cancel | [ Heb

1.8.1.2 Creating a Report from a Template or an Empty
Report

You can create a model report directly from one of the standard report templates without making any object or
format selections. Whether you choose a template or create an empty report, you can modify it in the Report
Editor.

Procedure

Select |» Report ¥ Reports Ato open the List of Reports, and click the New Report tool.
2. Enter a Report name, and select a Language for the report's titles and other framing text.
3. [optional] Select a report template from the list to prepopulate the report. The following standard templates

are available:

o Full- provides lists of all the types of objects in the model, together with detailed information on each
main and sub-object.

Core Features Guide
330 PUBLIC Modeling with PowerDesigner



o List - provides lists of all the types of objects in the model.

© Standard - provides lists of all the types of objects in the model, together with detailed information on
each main object.
O <None> — creates an empty report.

1 Note
For more information about report templates, including how to create your own, see Report Templates

[page 386].

4. [optional] To use the new report format and editor (see The Report Editor [page 340]), deselect Use legacy
Report Editor.

5. Click OK to create the report and open it in the Report Editor (see The Report Editor [page 340]7).

6. [optional] Generate or print the report by clicking the appropriate toolbar tool.

1 Note

Report templates can also be applied at generation time (see Generating a Model Report [page 385]).

1.8.2 Creating a List Report

A list report documents a single object type within a model, and is displayed as a customizable list with columns
and rows that you can filter as necessary. A list report is saved in the model and can be exchanged between
models of the same type.

Context

You can create snapshots (called result sets) of a list report to keep a history of the execution of a list report in your
model. Result sets are listed in the browser beneath their parent list report, and are saved with the model (see
Creating Result Sets [page 337]).

Procedure

1. Launch the List Report Wizard by selecting |» Report » List Report Wizard 3, and select the object for which
you want to create the report. By default the list report is based on the model and excludes shortcuts and sub-
packages:
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List Report Wizard : Introduction (Step 1/5)

Ywelcome to the List Report ‘Wizard. Thiz wizard helpz you create a list report for an object type.

Select the object type pou want to list in the report.

Object bype: I:J Process j

Select the model or package.

taodel or package: |<M odel: _I

Include shortouts: [

Include sub-packages: [+ -

< Back I Mewt > I Finizh Cancel Help

2. Click Next to go to the Column Filter page, which allows you to specify which of the object's properties will be
included in the list report. Select a property in the left-hand pane to add it to the list in the right-hand pane. You

332

can promote or demote properties in the list using the arrows at the bottom of the pane:
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List Report Wizard : Column Filter {Step 2/5)

Y'ou can chooze which properties will appear and the order in which they will appear.

<] B Name - I Column Heading el [l
- T Code 1 M armne:
= |Code

B[] Parent

-1 %y Digplay Mame
-] %y Object Type
1%y Creation Date

-] %y Creator
-1 %y Modification Date

-1 %y Modifier
-1 @y Owverall Modification Dz

1%y Clasz Mame

B[ Parent Folder
-1 @y Shart Descriphion

-] %y Object Location
-1 A Parent Park ane x
| | _.|—| 74| 4|4[4]2]4] |
Add attribute |
< Back I Mest > I Finizh | Cancel | Help |

-
IR

3. Click Next to go to the Row Filter page allows you to specify filters to restrict the objects that will be included in
the list report. Select a property in the left-hand pane to add it to the list in the right-hand pane, select an
operator, and then enter an expression to filter by (see Defining a Filter Expression [page 128]). You can

specify to sort the list on the values of a property by selecting the S[ort] checkbox.

Core Features Guide
Modeling with PowerDesigner PUBLIC 333



List Report Wizard : Row Filter {Step 3/5)

f'ou can chooze properties and specify expressions by which to filter the list.

Select the column 5 to zpecity one or more properties by which to sart the list,

Commek ;I
Generation Origin
Sterentype

Drefault Diagram

M odel

Compozite

ketaclazs Stereatype

| mplermenter

Reuszable Process
Output Correlation Fey
|nput Correlation ey
kezzage Mapping
Received Mezzage

i B

Add attritute |

Attribuite

Operator

E xpreszion

Composzite

HEARIEIETEIED

-
N EIER|

FY

< Back I Mewt > I

Finizh

Cancel |

Help

4. Click Next to go to the Content Preview page allows you to visualize the results of your choices so far:
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List Report Wizard : Content Preview (Step 4/5)

Thiz previews digplavs the contents of your izt report.

I arme Code Sherenty = |
=+ Create Order
2 Frocess Corporate Order Frocess Corporate Order
3 Process Order Frocess Order
4 Check Stock. Check Stock.
] Ship United States Postal Service Ground i Ship US Pogtal Ground
G Confirrn Order Shiprnent Confirr Order Shiprient
v Ship Federal Exprezs Overnight Delivery Ship FedE = Owvernight
< | o
< Back I Mest > I Finizh | Cancel | Help |

To alter the definition click the Back button.

5. Click Next to go to the End page, which allows you to specify a name and code for the list report, and to add a
comment. You can also specify whether to generate the report to an external file.
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List Report Wizard : End (Step 5/5) x|

Congratulationz, you have created a list report!

Type a name, a code and a comment for the list repart in order ba identify and describe it

Hame:

Code:

Comment;

File format;

— v Generate the list repart to an extemnal file
" 5% RTF CHTML & WML

IF'rn:n::ess Lizt Repart

Tl

IF'n:u:ess Lizt Report

< Back st = | Finizh I Cancel Help

6. Click Finish to exit the wizard and create the report.

The list report is added to the model and listed in the Browser under the List reports folder. If you have
selected to generate the report to an external file, you will be asked to specify a file name.

1.8.2.1 List Report Properties

You can modify an object's properties from its property sheet. To open a list report property sheet, double-click its
Browser entry in the List Reports folder or in the List of List Reports. By default, the property sheet of a list report
always opens on the Content tab.

The General tab contains the following properties:

Property Description

Name Specifies the name of the list report.

Code Specifies the code of the list report.

Comment Descriptive comment for the object.

Object type Specifies the type of the object the list report will be based on. You must select an object type to have
any content in your list report.
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Property Description

Model or Package Specifies the model or package from which the objects will be drawn. Package selection is unavaila-
ble for global objects such as users.

Include shortcuts Specifies whether the list report includes shortcuts.

Include sub-packages | Specifies whether the list report includes sub-packages. This option is unavailable for global objects

such as users.

The following tabs are also available:

Column Filter - Lets you choose the object properties to be used as column titles in the list report and the order
in which they will be displayed.

Row Filter - Lists the filters that restrict the rows included in the list report. Select a property in the left-hand
pane to add it to the list in the right-hand pane, select an operator, and then enter an expression to filter by
(see Defining a Filter Expression [page 128]). You can specify to sort the list on the values of a property by
selecting the S[ort] checkbox.

Content - Displays the current values for the list report. Properties selected in the Column Filter tab are
displayed as column headings and property values in rows must satisfy filter expressions defined in the Row
Filter tab. You can open the property sheet of any object included in the list report by clicking the Properties
tool.

Note that data displayed on this tab does not dynamically change when you perform a change to your model
that may affect your list report. To update the data, you must click the Refresh List Report tool.

Use the generation tools to generate a list report result set as an RTF, HTML, XML, or XLS/CSV file (see
Generating a List Report [page 338]).

Result Sets - lists the result sets stored for the list report (see Creating Result Sets [page 337]). Click the
Properties tool to open a result set for generation.

1.8.2.2 Creating Result Sets

A result list is a snapshot of the content of a list report at a given system date and time. You can create as many
result sets as you want for the same list report, in order to keep a history of a given list report for future reference.

You can create a result set in any of the following ways:

Open the property sheet of a list report, click the Result Sets tab, and then click the Create Result Set tool.

Right-click a list report in the Browser and select | New » List Report Result Set 3 from the contextual menu.

Result sets are stored within the model and display under the list report to which they are related in the Browser:

E'@ List Reports

=] Table_ListRieport

------ Friday, September 02, 2005 4:22:54 P

------ Friday, September 02, 2005 4:23:53 P
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Result Set Properties

You can modify an object's properties from its property sheet. To open a result set property sheet, double-click its
Browser entry in the List Reports folder just beneath the list report to which it applies. The following sections detail
the property sheet tabs that contain the properties most commonly entered for result sets.

The General tab contains the following properties:

Property Description

List Report Name of the list report to which the result set applies.
Report Date Date and time when the result set was created.
Comment Descriptive comment for the result set that allows you to identify it.

The Content tab shows the contents of the result set. Use the generation tools to generate the result set as an RTF,
HTML, XML, or XLS/CSV file.

1.8.2.3 Generating a List Report

You can generate a list report to a CSV, XLS, RTF, HTML, or XML file.

Context

e Right-click the list report in the Browser and select | Generate » <Format> 4.
e Open the property sheet of the list report, select the Content tab, and click the Generation Format tool.

o Select|r Report ¥ Generate List Report Jto open the Generate List Report dialog box.

You can also right-click a result set in the Browser and select Preview or Print.
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1.8.2.4 Importing and Exporting List Report Files

It can be useful to exchange list report files between models of the same type. For example, you may want to
compare the properties of a certain subset of classes in two OOMs. You can import and export list reports to and

from your model using the List of List Reports (|* Report ¥ List Reports J).

The following tools are available on the List of List Reports:

Tool Description
List Report Wizard - Launches the List Report Wizard (see Creating a List Report [page 331]).

2

Import List Report from File - Opens a standard Open dialog, which allows you to browse to the list report file to
import. A list report file has a .LRT extension.

||a | Export List Report to File - Opens a standard Save As dialog, which allows you to browse to the location to save
the list report.

1.8.3 Creating a MultiModel Report

A multimodel report (MMR) is a PowerDesigner report that can document any number of models together and
show the links between them. To create such a report, you must have at least one model open in the workspace,
and you can add additional models at any time.

Procedure

1. Select |l File » New Model 3 and choose Multi-Model Report.

This item may be in the left or right hand pane, depending on the configuration of your New Model dialog (see
Creating a Model [page 12]). It is not available if you do not have at least one model open in your workspace.

2. Enter a Report name, specify the Language to use for report titles and other framing text, and select a model
from the Model name list as the basis for the first section of the report.

3. [optional] Select a template (see Creating a Report from a Template or an Empty Report [page 330]) for this
first section from the Report Template list.

1 Note

If you choose a template in a language different from the one specified for the report, standard report titles
and framing text will be presented in the report language and any user-defined text in the template will be in
the template language.

4. [optional] To use the new report format and editor (see The Report Editor [page 340]), deselect Use legacy
Report Editor.

5. Click OK to create the multimodel report and open it in the Report Editor.
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6. [optional] To add a second model open in the workspace, select |F Report » Add Section 7, select the model to
add (and, optionally, a template), and click OK.

Each model in the report belongs to a separate section. You can only add models that are currently open in the
workspace, but once a model has been added, you can edit the report even if the source model has been

closed.

1 Note

To add a section to a legacy report, use the report property sheet Sections tab (see Report Properties [page

387)).

7. [optional] Launch the Report Wizard to populate and format the section (see Creating a Report with the
Report Wizard [page 325]).

8. [optional] Edit the report in the Report Editor (see The Report Editor [page 340]).
9. [optional] Generate the report (see Generating a Model Report [page 385]).

1.8.4 The Report Editor

You can edit model reports, multi-model reports, and report templates in the Report Editor. To open a report in the

editor, double-click its entry in the Browser or select | Report  Reports 3, select your report in the list, and click

the Edit Report tool.

Reports are composed of report items, which provide various ways of documenting model objects (books, cards,
lists) and other report ornamentation such as a table of contents, page breaks, and free text (see Adding Items to a

Report [page 342]).

o1l PowerDesigner (= EeRc|
File Edit Wiew Report Repository Tools Window Help
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The Report Editor provides four views:

e (Outline (left) - Provides an overview of the tree structure of your report, and supports reordering by drag and
drop and various other operations by right-clicking items.

® Design (center) - Provides a detailed graphical view of the report, and supports wysiwyg editing of item layout
and formatting. The following tools are available on the command bar, which appears when you select a report
item in the Design view or by right-clicking an item in the Design or Outline views):

Tool Description

(0] Quick View - Previews the item (see Previewing a Report or Report Item [page 362]).

No Tool Up / Down - Moves the item up or down one place in the report.

No Tool Promote / Demote - Moves the item up or down one level in the report.

@ Properties - Selects properties to display in cards or lists, and reorder them (see List and Card Report ltems
[page 346]).

T . . . . . .
EEE Collection - [books, cards, lists] Changes the type of object that will be published to the item.
Selection - [books, cards, lists] Specifies the individual objects that will be published to the item (see Select-

ing Objects to Display for a Report Item [page 358]).

& 5&. Format/Styles - Modifies the specific format for the item or the default styles for all items of this type (see
Specifying Global Styles and Local Formats for Report Items [page 356]).

No Tool Show Title - Toggles the display of the item's title in the body of the report.

No Tool Hierarchical Display - [composite object books] Toggles the organization of composite object book items,
such as those representing packages, OOM activities, or BPM processes between List (where they are all dis-
played on one level as siblings) and Hierarchical (where child objects are displayed inside their parent).

No Tool Show Title in HTML TOC/Show Contents in HTML TOC - Toggles the display of the book item title and the the
book's sub-item titles in HTML report table of contents.

No Tool Delete - Hover over an item and then click the X in its upper right corner to delete the item.

e Toolbox (right) - Lists the report items you can add to your report by double-clicking or dragging and dropping
them onto the Design or Outline views (see Adding Items to a Report [page 342]). By default, only items
associated with objects present in your model are displayed. To show all items, deselect the Hide unavailable
components check box at the top of the Toolbox.

e Properties (right, hidden) - Lists the properties of the report item selected in the Design or Outline views.

The following tools are available from the Report toolbar:

Description

hi |§| Print Preview/Print - (see Previewing a Report or Report Item [page 362]).
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Tool Description
Generate HTML/RTF/XPS - Generates the report in the specified format.
jh‘ Styles - Opens the Default Styles dialog (see Specifying Global Styles and Local Formats for Report Items
[page 356]).
Show/Hide Header/Footer - Toggles the display of the report header and footer (see Modifying Report

Section Headers and Footers [page 361]).

e Up / Down - Moves the selected item up or down one place in the report.

@ | B Promote / Demote - Moves the item up or down one level in the report.

1.8.4.1 Adding Items to a Report

You can add report items by double-clicking or dragging and dropping tools in the report Toolbox. Generic report
items are available under the General Components section of the report Toolbox, while items instantiated for the
objects present in your model are available under the Model section. Standard and extended objects and
properties are all available for selection. You can insert the same item multiple times in a report.

To add an item to a report:

e Below the selected item - double-click the appropriate tool in the Toolbox.

e Anywhere in areport - drag the tool from the Toolbox and drop it in the appropriate position in the Design or
Outline views. When the cursor is over an existing report item in the Design view, arrows appear to guide the
placement of the new item. To place the item next to, above, or below the existing item, drop it on the left,
right, top, or bottom arrow. To add the item as a child of the existing item, drop it on the center guide arrows.

The following tools are available to insert report items to document model objects:

Icon Description

Book — Groups together cards, lists, and text items to display all or most of the properties of an object and may
fm contain sub-books to describe any sub-objects (see Book Report ltems [page 345]).

1 Note

To display packages or other composite objects (such as BPM processes that can contain other processes) hi-
erarchically with children shown beneath their parent instead of all at a single level, add the appropriate book
item, right-click it, and select Hierarchical Display. HTML reports always use hierarchical display.

Card - Displays a configurable subset of properties of an object in a two-column table with the property name in
the left column and the value in the right column (see List and Card Report Items [page 346]).

Core Features Guide
342 PUBLIC Modeling with PowerDesigner



Icon Description

List - Displays a list of objects in a multi-column table with one property in each column. (see List and Card Report
m Items [page 346]).

Text — Displays an object property or free text (see Text Property and Free Text Report Items [page 347]).

Diagram - Inserts a PowerDesigner diagram (see Diagram Report Items [page 348]).

=
Chart - Inserts a chart to visualize statistics about a collection of objects (see Chart Report Items [page 349]).
dh
Matrix - Inserts a dependency matrix (see Dependency Matrices [page 198]).
Section - Inserts a section. Sections are only supported in multimodel reports, where each section contains a re-
port relating to a specific model (see Creating a MultiModel Report [page 339]).
1 Note

By default, a report item will generate information for every object of the appropriate type in the model. For
example, the Table book will generate information for every table in your model. To generate for only a subset of
objects defined by name or criteria, use the Edit Selection tool in the item's command bar (see Selecting
Objects to Display for a Report Item [page 358]).

The following tools are available to add miscellaneous additional report items:
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Icon

Description

Cover Page - Inserts a set of text items followed by a page break to create a cover page:

[Enter your company name)

Enter a report namnmie

[Enter a report subtitle]

Image File - Displays an image, selected via a file chooser.

Column Panel - Inserts a container element that holds two report items side-by-side. A column panel is automati-
cally created when you drag an item onto the Design view and drop it on the left or right guiding arrow of an exist-

m o

ing item.

Page break — Inserts a page break. Right-click the inserted item and deselect Generate in HTML to disable it when
= generating HTML reports.
=

Table of contents — Inserts a table of contents followed by a page break.

Text — Inserts a text item. This can be a free text paragraph or, if you specify a data source, the value of a property.

Text file — Inserts the contents of a text file, selected via a file chooser.

@

Title - Inserts a titled container. Add items to the container, which inherits the scope of its parent item, as neces-
sary.

1 Note

You can move items from one report to another report of the same type of model by drag and drop. Press the
key while dragging and dropping to copy the item to the second report.
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1.8.4.2 Book Report Items

Book report items can contain cards, lists, text items, and sub-object books to give detailed information about
your model objects.

Procedure

1. Toinsert abook item, click in the Design or Outline view in the position where you want to add the item and
then double-click or drag and drop the appropriate Toolbox item.

A book is displayed in the Outline view as a node with a number of subitems, and the same series of items are
shown in the Design view:

& Report [ - -
4 () Entity . Entity %(Name)
5] Card of entity %(Name) = /Card of entity % (Name)

| Description of the entity :(Mame)
5] Annotation of the entity So{MName)

5] Code preview of the entity % (Name) Code %(Code)
ﬁ List of extended inverse collections of the entity %(Pai

Mame %a(MName)

% List of associated business rules of the entity Se(Parent Parent %(Parent)

% List of all dependencies of the entity %{Parent.Mame) Comment | %(Comment)
b L[] Diagram

B List of related dizgrams of the entity %(ParentName) Generate %(Generated)

5 List of objects in related diagrams of the entity Se(Pare

> (0 Entity Atiribute Number %a(Number)

E@E List o}‘ .attributes of the entity %(Parent.Mame) E=] Description of the entity %[Nam E]
¢ A Identifier
] List of identifiers of the entity %(Parent.Name) %a(Description)

% List of relationships of the entity Se(Parent.Name) X . .
% List of child inherntances of the entity %:{Parent.Name) = Annotation of the E]‘ltlty % [NanlE]

] List of Child Entities %(Annotation)
% List of parents of the entity %(Parent.Mame)

2. Toremove unwanted sub-items from the book, select them in the Outline view and press Delete or hover over
them in the Design view and click the X in the upper-right corner of the item.

3. Toreorder sub-items inside the book, drag and drop them in the Outline or Design view.

4. For composite objects (such as packages that can contain other packages or BPM processes or OOM classes
that can contain other processes or classes) you can choose between two presentations:

o List Display - [default] Objects, their children, grandchildren, and subsequent descendants are all
generated at the same level.

© Hierarchical Display - Children are generated as sub-items inside the parent object book, grandchildren
are generated as sub-items inside the child book, and so on to any level of decomposition. Select the
Hierarchical Display option in the Properties view.

5. To modify the selection of objects that will be generated in the report from this book and how they will be
sorted, click the command bar Selection tool and specify filter and sorting criteria or a manual selection of
objects (see Selecting Objects to Display for a Report Item [page 358]).

6. To modify the default styles for a sub-item, click its icon to display the command bar, and then click the Styles
tool (see Specifying Global Styles and Local Formats for Report Items [page 356]). To override the default
styles for this instance, click the Format tool.
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1.8.4.3

List and Card Report Items

List and card report items are generated as tables. A list displays all objects, with one column per property and one
row per object. A card displays a single object, with one row per property. You can specify which attributes will be
displayed, in which order, and the width of the columns.

Procedure

1. Toinsert alist or card item, click in the Design or Outline view in the position where you want to add the item
and then double click or drag and drop the appropriate Toolbox item.

= /List of entities

Name Code Parent Generate Number
%({Name) %(Code) %|(Parent) %|Generated) %({Number)
W Entity %(Name)
= _Card of entity %(Name)
Name %({Name)
Code %(Code)
Parent %|Parent)
Comment %{Comment)
Generate %(Generated)
Number %({Number)
1 Note

Cards and lists are commonly added to the report as part of a book (see Book Report Items [page 345]).

2. To modify the properties displayed, click the card or list icon in the Design view to display the command bar,
and then click the Properties tool to display a list of available properties, with properties selected for display on
the right, and unselected properties listed in alphabetical order on the left:
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Table %(!DisplayN|/ @ A £ A |

Y il s el [[] % Check Constraint Mame ~ # T Marme
_]i Card of table Q»'n{!Dlﬁpla}'?\ameD By Class Name B Code
| Name [ @ Cluster T Comment
i Code [[] % Creator T Creation Dats
Comment O] % Currency C& Dimensional Type
[C] @ DBMS
Creation Date ] " Dbspaceln

[[] @ Default Mapping
[C] " Description

e e [C] % Display Name
Description of the table %(!Di E % E::;Z:Z d
%|Description) [C] % End Script

RS Fully Qualified Code
Annotation of the table %(!Dij[] G Generate

%{Annotation) [[] % Generated Name m

Y el

Dimensional Type

3. Select or deselect properties as appropriate and then click outside the list to close it. Properties selected will
be added as columns in a list or rows in a card.

1 Note

All properties, including extended attributes are available for selection in this list.

4. Toreorder list columns or card rows click in a list column header or card row header to select it, and then click

again and drag and drop it to the desired position.

5. To modify the width of list columns or the column separating the card row header from the property values,
hover over a dividing line until the double-arrow cursor appears, and then click and drag to increase or
decrease the width.

6. To modify the default styles for a list or card item, click its icon to display the command bar, and then click the

Styles tool (see Specifying Global Styles and Local Formats for Report Items [page 356]). To override the
default styles for this instance, click the Format tool.

1.8.4.4 Text Property and Free Text Report Items

Multi-line text properties, such as the Comment or Code Preview, are provided by default as text items. You can
also add free text items wherever necessary.

Procedure

1. Toinsert a text property report item, click in the Design or Outline view in the position where you want to add
the item and then double click or drag and drop the appropriate Toolbox item.
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1 Note

Text properties are commonly added to the report as part of a book (see Book Report Iltems [page 345]).

2. To edit a free text item, double-click the item in the Design view and enter text as appropriate.

3. To modify the property referenced by a text property item, enter the name of the property in the format
(Property).

4. To modify the default styles for a text item, click its icon to display the command bar, and then click the Styles
tool (see Specifying Global Styles and Local Formats for Report Items [page 356]). To override the default
styles for this instance, click the Format tool.

1.8.4.5 Diagram Report Items

Diagram report items are generated as images. If a report is generated as HTML, diagram symbols are clickable
targets, with links to the corresponding object card.

Procedure

1. Toinsert adiagram item, click in the Design or Outline view in the position where you want to add the item and
then double click or drag and drop the appropriate Toolbox item.

____________________________________________________________________________________________________________________

1 Note

You can display objects organized by the diagram in which they appear by dropping the appropriate book,
card, or list items and dropping them onto a diagram item.

2. To modify the default styles for a diagram, click its icon to display the command bar, and then click the Styles
tool (see Specifying Global Styles and Local Formats for Report Items [page 356]). To override the default
styles for this instance, click the Format tool.

The zoom option offers the following settings:
© Fit to page - Shrinks the diagram to fit on a single report page.
O Custom zoom-Zooms by the given percentage.

© Keep diagram layout - Each diagram page appears full size on its own report page.
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1.8.4.6 Chart Report Items

Chart report items provide a way to visualize statistics about a collection of objects as a column, bar, or pie chart.

Procedure

1. Toinsert achartitem, click in the Design or Outline view in the position where you want to add the item and

then double-click or drag and drop the Chart tool.

The position in which you drop the chart determines the statistics that you can visualize. In this example, the

chartis a child of the Table book, which provides access to the Columns sub-object collection. To analyze
tables or any other collection of standard objects, you should drop the chart at the top level of your report. You
can base a chart on any of the standard collections in the PowerDesigner metamodel, or create you own
extended or calculated collection to analyze (see Customizing and Extending PowerDesigner > Extension

Files ).
. b4
\d Table %(!DisplayName)
Card of table %/('DisplayName)
i Name %6(Mame) i
Code %(Code) i
& b 4
Visualization : |dh| 3= @ Columns by Datatype
(O]
Object Set : [ %Cclumns = ] E:;\.Lrjerzl-fnly
a | Measurels) :
E - - - -
E ixi~||0L -}
U +
5
[=]
=
Group by : Sorted
Datatypes
2. Select the type of visualization to use. You can choose between:
o Column chart - vertical columns and/or line graphs.
© Bar chart - horizontal bars or and/or line graphs.
o Pie chart - acircle divided into sectors.
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3. Specify the parameters of the chart:

o Object set - Specifies the collection of objects that the chart will analyze.

o Recursive - Specifies that the chart should include all sub-objects in the case of composite objects
such as areas or BPM processes, and objects in packages. In the case of composite objects, selecting
the Leaves-only sub-option restricts the data set to only those final objects in the tree that are not
further decomposed.

1 Note

o Group by - Specifies the property that will be used to categorize objects for display. If you select nothing or
the Name property, then one bar or segment will be displayed for each object. If you select a property of
type date, you can choose to group by day, week, month, quarter, or year.

o Measure(s) - Specifies how the size of bars or segments will be calculated. While a pie chart can only
support one measure, column and bar charts can support multiple measures. For each measure, you can
also specify:

o  The measure type - Count is always available, and sum and average are available for numeric
properties.
o The base color from which the color scheme is determined and the label to give to the measure. For
column or bar charts, you can also specify whether the measure is represented as bars/columns or as
a graph line.
4. Replace the placeholder text to the left of, below, and above the chart to give labels to the x and y axes and to
provide a title for the chart.You can specify to print the column or bar names diagonally using Primary and
Secondary Axis Labels Rotation Angle properties in the Properties view.

1 Note

The graphic displayed in the Design view is for illustration purposes only. To preview your chart with actual
data, click the chart background and then click the Quick View tool.
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Columns by Datatype

Mo of Columns

binary datetime int warchar(128) wml
Datatypes

5. To modify the default styles for a chart item, click its icon to display the command bar, and then click the
Styles tool (see Specifying Global Styles and Local Formats for Report Items [page 356]). To override the
default styles for this instance, click the Format tool.

1.8.4.6.1 Example: Creating Charts for Hardware Servers

In this example, we will create three charts to visualize information about a set of hardware servers modeled in an
enterprise architecture model. We will analyze the distribution of servers by geographic site, the operating system
split, and the quarterly spend on servers (using extended attributes).

Context

Before creating the report, the EAM model was created and populated with hardware servers assigned to various
sites, and two new properties were added to the Hardware Server property sheet (see Adding New Properties to an
Object [page 168]) as extended attributes:

Name ‘ Data Type

Purchase Date Date

Purchase Cost Integer
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Procedure

1. Create areport, expand the General Components category in the report Toolbox, and double-click the Title
tool to add a title. Click the default title text and enter Hardware Servers.

2. Click the Chart tool and drag and drop it onto the center of the guide arrows on the title item to create a chart
in the Hardware Servers item:

Hardware Servers

3. Drag the Chart tool again and drop it onto the bottom guide arrow on the first chart item to create a new chart
underneath it. Then drag the Chart tool a third time and drop it on the right guide arrow on the second chart to
create a new chart next to it:

Hardware Servers

<Enter Title>

<Enter Title:

<Enter Titlex»

<Enter Title>

<Enter Title:

<Enter Title>
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4. Enter the following chart parameters:

Parameter

First Chart

Second Chart

Third Chart

Visualization Column Pie Column
Object Set Hardware Servers Hardware Servers Hardware Servers
Group by Site Operating System Purchase Date/ ([Q]uarter)
Measure [None]/Count/Bar [None]/Count Purchase Cost/Sum/Line
Top Title Servers by Site Operating System Quarterly Hardware Spend
Left Title [Space] N/A Euros
Bottom Title [Space] N/A [Space]

1 Note

The representation of the chart in the Design view does not change as you complete the parameters. You
can, at any time, click the background of a chart and then click the Quick View tool to preview it with the

data from your model.
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ardware Servers
Servers by Site
@
& x
Operating System Visualization : [dif] &= @ Hardware Spend
(O]

= :
Object Set : [ % Hardware Servers ™ ] E:;:;I—fnly —‘

Measure(s) :

Group by : D W M| Q|Y # sorted

5. Click the Generate Web Report (HTML) tool in the report tool bar and select to open it in your browser:
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1.8.4.7 Dependency Matrix Report Items

Dependency matrix report items are generated as tables with one row per object and one column per dependent
object with an X or other value in matrix cells to indicate a dependency.

Procedure

1. Toinsert a dependency matrix item, click in the Design or Outline view in the position where you want to add
the item and then double click or drag and drop the appropriate Toolbox item.
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] Dependency Matrix
F

%{Name)

Y(Name) %(GetCellvalue(%(CurrentRow), %(CurrentColumn), "X"))

1 Note

Dependency matrices are commonly added to reports as part of the Dependency Matrix book item, which
also describes the properties of the matrix. To add only the matrix itself, expand the matrix book and then
double-click or drag and drop the matrix item.

2. To modify the default styles for the matrix cells, column header, or row header, click in the appropriate field to
display the command bar, and then click the Styles tool (see Specifying Global Styles and Local Formats for
Report Items [page 356]). To override the default styles for this instance, click the Format tool.

3. To modify or override the default styles for row and column header dividers, the horizontal and vertical cell
dividers and the overall format of the matrix, click in the top left field and then click the Styles or Format tool.

1.8.4.8 Specifying Global Styles and Local Formats for
Report Items

The formatting of your report is highly customizable. You can set global default styles and override them for
individual report items by specifying local formats.
Context

Use the following tools on the Design view command bar to access global default styles and individual formats:

Tool ’ Description

A Format - Specifies the format for the selected report item

Styles - Specifies the default global style for all report items of this type.

G:\

Procedure

1. Select|r Report ¥ Styles 3 from the Report Editor window to open the Styles dialog:
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[0 Edit Styles [

Text File “ | Properties
Image File

) MName [Title 1
Diagram

Title Component i s

Title 1 Bl

Title 2
Title 3
Title 4
Title 5
Title &
Title 7 E =
Title 8
Title 9
Header
Footer -
Free Text

Table of Contents Title

Table of Contents Entry

Card

Card Row Header

Card Content

Card Table

Ii_L

Mo Border

Formatting

ok | [ cancel

2. Select the report item element for which you want to specify a default style in the left pane. The following
elements are available:

o

o

e}

Text / Image File

Title Component - Control the borders, fill, and spacing around the container headed by a title report item.
Title 1-9

Header / Footer

Free Text

Table of Contents Title / Entry

Card / List / Matrix - Control the borders, fill, and spacing around the item (including its title).

Card Row Header / List Column Header / Matrix Row / Column Header - Control the font and spacing of
the header cells.

Card Content / List Content / Matrix Content. - Control the font and spacing of the content cells.

Card Table / List Table / Matrix Table - Control the borders and spacing of the table and the internal
dividers between the header and the cells and between the cells.

3. Specify the default styles for the selected element using the following tools. Changes are visible immediately in
the Design window:
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Tool Description

caioi 7] ont
E] Font Size

Bold / Italic / Underline / Strikethrough

=
(-
th

Font Color

Align Left / Center / Right / Justify

Borders / Border Color / Fill

¥ =[[ = Increase / Decrease Vertical Spacing - Increase or decrease the spacing above and below
the element equally.

+ L] = —
= || = ([ * [ * Increase / Decrease Top / Bottom Spacing - Increase or decrease the vertical spacing
above or below the element.
= |52 . . .
o) | =7 Increase / Decrease Horizontal Spacing - Increase or decrease the spacing to the left and
right of the element equally.
55 E = =

= Increase / Decrease Left / Right Spacing - Increase or decrease the horizontal spacing to
the left or right of the element.

Row / Column Header Divider - Toggle the display of a dividing line between the table row
or column header and the content cells.

(I
=

Horizontal / Vertical Cell Dividers - Toggle the display of dividing lines between the table
content cells.

1.8.4.9 Selecting Objects to Display for a Report Item

You can refine the selection of objects for individual report items and control their order by criteria or by selecting
individual objects from the list of objects included in the report. For example you can have a list of all the tables in
your PDM, but you need detailed information about only some of them, and so specify a selection for the Table

Book.

Context
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Procedure

1. Right-click a book or list item and select Edit Selection to open the Define Sort and Filter dialog.

2. To define a filter and sorting criteria:

o Select columns to sort on - by checking the [S]ort column checkbox.

o Reorder the columns in the list - by using the arrows at the bottom left of the dialog. To move all the
selected rows to the top of the list, press|shift| + [Enter|

o Define one or more filter expressions - by selecting an operator in the Operator column and entering an
expression to filter by in the Expression column. For information about the operators and expression
syntax, see Defining a Filter Expression [page 128].

Define Sort and Filter = (B -]
e [

5 Column Heading Cperator Expression -
Checl on Commit
Parent Key
Implementation

Auto Amange Join Order
Foreign Key Columns
Parent Key Columns
Parent Role

Child Raole

[#]i Dimensional Type = 1
i Description

REARIRAEIE RN i |

sddatibute.. [ 0K ][ Cancel | [ Help |

The [U]sed checkbox is automatically selected when you enter a filter expression. To disable the
expression but keep it in memory, clear the checkbox.

1 Note

For lists containing multiple types of objects, to display properties other than those that are common to all
the object types, click the Add Attribute button (see Customizing Columns in Lists Containing Multiple
Types of Objects [page 125]).

3. To select individual objects from the list of objects included in the report, click the Switch to Selection button:

Caution

You can specify either a filter or a selection, but not both. When you click this button, any information
entered in the Define Sort and Filter dialog will be lost.
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Select Objects _ O] x|

I@Tutnrial j ts | IR Y

I arme | Code |
WD Record order request Recard_order_request
WD Check item availabity in stock Check_item_availabity_in_stock
WD Check credit card details Check_credit_card_details
WD Send email to custamer Send_email_to_customer
Wi Email notice of unawailability Email_natice_af_unawvailability

WD Send email to acknowledge or... Send_email_to_acknowledge_order
WD Dispatch item Dizpatch_itemn
WD Send request for item to be de...  Send_request_for_item_to_be deli..

E\Pmcesses )
= %+ + ¥ E Objectz] selected: a/8

Switch ko Eriteriu:unl Cancel | Help |

1 Note

If you have made a selection of objects at the report level (see Selecting Objects to Display in the Report
[page 370]), objects excluded there will not be available for selection at the report item level.

4. By default, all the objects are selected. Select the objects that you want to display using this report item. You
can reorder the objects in the list by using the arrow buttons at the bottom of the dialog.
1 Note

If you define a selection of ordered objects on a package for which you have selected the Hierarchical
Display option (see Adding Items to a Report [page 342]), any reordering you do here is ignored.

5. When you are satisfied with your filtering or selection, click OK to return to the Report Editor. Note that only
the last of the filter or selection from which you clicked OK will be applied.

1.8.4.10 Modifying or Suppressing the Titles of Report Items

Most report items are preceded by a title item. To modify the title, select the item and then click the title text to
enter edit mode. To suppress an item title from the body of the report, right-click the item and deselect the Show
Title option.

You can reference object properties using the syntax % (<Property>) . For example, you could modify the title of
the table card and use reference the Code property instead of the Name property:
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Card of Table % (Name) Table % (Code) Card

1 Note

You can edit the default titles of all report items in the report language resource file that is attached to your
report. For more information, see Customizing and Extending PowerDesigner > Translating Reports with Report
Language Files .

1.8.4.11 Modifying Report Section Headers and Footers

You can review and modify the report header and footer in the Report Editor Design view. In multi-model reports,
you can specify a different header and footer for each section (model).

Context

For more information about the default header and footer, including specifying separate headers and footers for
each section of your RTF report, see Report Properties [page 387].

Procedure

1. Click the Header & Footer tool to display the header and footer at the top and bottom of the Design view:

Both the header and footer contain left, center, and right fields, which can contain a mixture of text and
variables.

Report1  Main diagram | Result List

%

(Model.MetaClass.Library.LocalizedNa %(Model.Name)

me)

%l !ApplicationMName) %{!CurrentDate) Page %(!PageNumber)
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2. Click once in a field to display the command bar, from which you can launch a preview of the field or modify its
format. Click again to edit the contents of the field, including modifying the variables referenced (see
Referencing Object and Model Properties [page 362]).

3. [optional] Click the Preview tool in the command bar to review your changes.

4. Click the Header and Footer tool to return to your report.

1.8.4.12 Referencing Object and Model Properties

You can reference object and model properties in your reports using their public names as defined in the
PowerDesigner Public Metamodel.

To reference object properties, use the following syntax:
% (Property)
For example, to reference the object code, use:

% (Code)

The following additional report variables are available:

Variable Description

%(!CurrentDate) Report date defined in report property sheet.
%(!CurrentTime) Report generation time.

% (Model.Name) Model name or code of a report section.
%(Model.Code)

%(Model.Metaclass.Library.Localized- Module name of a report section.

Name)

%(!ApplicationName) Application name (PowerDesigner).
%(!PageNumber) [RTF] Current page number.

1.8.4.13 Previewing a Report or Report Item

You can preview your report by selecting |* Report » Print Preview 3 or by clicking the Preview tool in the End page
of the Report Creation Wizard. You can preview a report item by selecting it in the Design or Outline view and
clicking the Quick View tool.
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« [ % e  HEA B
=
Enterprise Architecture Model Acme Enterprise architecture
2.11 List of architecture areas
Name Code Stersotype
Application farm Application_farm
Application layer Application_laver
Business layer Business_layer
CEM Customer Relationship CEM_Customer_BRelationship_Manage
Management ment
Central repository Central repository
Central site Central site
Databaze Databaze_cluster
Load balanced Web Farm Load balanced Web Farm
Management process Management process
Manuvfacturing Manufacturing
Manufacturing site Manufacturing_site Il
|cluster| LR
=

The following tools are available in this window:

Tool Goes to preview
ﬁ" Print - Prints the report.
Copy - Copies the selected text.
'-’:-_'I':J\ '!:—;)\ Zoom In/Zoom QOut.
E3(E= (0 coomte
e 100%
® Page Width
®  One Page
® Two Pages

To search for text in your preview, enter the string in the search box at the bottom of the window and click the right
or left arrow to search forward or backward.

1.8.5 The Legacy Report Editor

You can edit model reports, multi-model reports, and report templates in the Report Editor. To open a report in the

Report Editor, double-click it in the Browser or select | Report » Reports 3 to open the List of Reports, select your
report and click the Edit Report tool.
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-8 Physical Data Model 1 zzE| Available itemns «| [l OOM List
B4, Conceptual Data Model =[] Table of contents Table of contents
-84 Object-Oriented Model 1 -~ Title .= Page break
- @ Mulb-todel Report 73880 B | IS E Text paragraph -- Title - O0M Graphz
&y Test file R Title - Lists
Graphic file
----- =3 Page break
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d | LI ----- £] Model Description
Local | @8 Repostoy| ] £] Model Annatation | [AJoom List APDM List } GCOM List /

The left pane, Available Items, lists the items you can include in the report, while the right pane, Report Items,
displays the structure of your report.

The Available Items pane lists only the report items that correspond to objects that exist in the current model. For
example, if you have not created any interfaces in your OOM, then the List of Interfaces and Interface book will not
be listed. Select Show All ltems at the top of the pane to display all the report items available for this kind of model.
By default, in the Multi-Model Report Editor, all available report items are displayed if the associated model is not
open in the workspace.

The following tools are available from the Report toolbar:

Tool Description

Report Wizard - Opens the Report Wizard (see Creating a Report with the Report Wizard [page 325]).

Print Preview - Displays a report print preview (see Previewing Your Report (Legacy Reports) [page 382])

Print - Prints the report.

Generate RTF - Generates the report as an RTF file.

Generate HTML - Generates the report as an HTML file.
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Tool Description
Add ltem - Adds an item to the Report Items pane.
#1
Up One Level - Moves item up one level.
i
Down One Level - Moves item down one level.
&
Raise Level - Moves item at the same level as the book item (item that contains other items) that precedes.
e
Lower Level - Moves item within the book item that follows.
&

1.8.5.1 Adding Items to a Report (Legacy Reports)

The Available Items pane of the Report Editor lists the items that you can add to your report.

You can add an item to the Report Items pane in any of the following ways:

e Double-click the item in the Available Items pane to place it below the currently selected item in the Report
Items pane.
e Drag the item from the Available Items pane and drop it at the desired position in the Report Items pane. Use

the or[shift]key to select multiple items. If the pointer becomes a barred circle, that means the drop
target is unauthorized. Note that you can drag and drop an item only when the Report Items pane already

contains at least one item.
e Right-click the item in the Available Items pane and select Add from the contextual menu

The following kinds of report items are available:

Icon Description

Table of contents — Inserts a table of contents. PowerDesigner automatically inserts a following page break.

Title - Free text to introduce what is next.

@
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Icon

Description

Paragraph - the following types are available, depending on the context:

e Text paragraph - free text that can be inserted anywhere
e Description — contents of the Description sub-tab of the Definition tab of the model or object property sheet
e Annotation — contents of the Annotation sub-tab of the Description tab of the model or object property sheet

e Other — text paragraphs are available as necessary to display code preview, scripts, validation rules, etc

Text file — Inserts the contents of a text file, selected via a file chooser.

Graphical file - Inserts the contents of a graphics file, selected via a file chooser.

Page break — Inserts a page break. Right-click the inserted item and deselect Generate in HTML to disable it when
generating HTML reports.

Card — Inserts a table listing the properties of the model or package. Right-click the item after insertion and select
Layout to control the properties listed (see Controlling the Layout of Card Report Items (Legacy Reports) [page
379])

List - Inserts a table listing the objects of a given type belonging to the model or another object. Right-click the
item after insertion and select Layout to control the properties listed (see Controlling the Layout of List Report
ltems (Legacy Reports) [page 377])

T

Graphics — Inserts an image of a diagram.

Book - Inserts a set of sub-items to report on a particular type of object. May contain cards, lists, text items,
graphics, and other books as necessary.

When you add a book item to a report, you automatically add its dependent items. You can delete any dependent
item that you do not need.

When you add an item to the Report Items pane, the item remains in the Available Items pane. You can insert the
same item several times in the same report contents.

Notes:

e Composite objects - BPM processes can contain other processes, OOM activities can contain other activities,
and CDM entities can contain other entities. Such composite object hierarchies are not included by default in
the report, but you can display them by adding a second instance of the appropriate report item inside the
first. In the following example, the second Entity book is added inside the first Entity book to display child
entities inside their parent entities:

366
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=L Entity - Entity %I TEM3:

~-[=5] Entity Card - Card of entity %I TEMX
- Entity 2| TEM

=4

® Package and composite object hierarchy - When you add a package or composite object book item to a report,
you can select the Hierarchical Display command in the item contextual menu to display the package or
composite object hierarchy in the generated report. You do not need to use this command when you generate
for an HTML report, as HTML reports always provide a hierarchical display.

e Drag and drop between reports - You can drag and drop items between reports of the same type. If you simply
drag and drop an item from one report to another without pressing any key, you move the item from one
report to another. You can copy an item by pressing the key while dragging and dropping it. The reportin
which you want to drop the item must already contain at least one item.

1 Note

When you generate an HTML report that contains a diagram graphic and the object cards of the symbols,
hyperlinks are created between the diagram symbols and the corresponding object cards. You can click a
symbol in the diagram to access the object card that corresponds to it in the HTML page.

1.8.5.2 Modifying Items in the Report Items Pane (Legacy
Reports)

You can move items in the Report Items pane by dragging and dropping them.

To copy an item, hold down the key while dragging it.You can copy any item within the Report Items pane
except for the root folder. Any formatting applied to the copied item is preserved. When you copy a book item, you
also copy its dependent items.

Contextual Menu

The following actions are available by right-clicking items that you have added to the report in the Report Items
pane:

Command Description

Show Title Controls the display of the item title in generated reports.

Show Book Title in HTML [book items] Controls the display of the book item title in the table of contents of HTML reports.
TOC
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Command

Show Contents in HTML
TOC

Description

[book items] Controls the display of the sub-item titles in the table of contents of HTML reports.

Up Moves the item up one line in the tree.

Down Moves the item down one line in the tree.

Raise Level Moves the item up one level in the tree.

Lower Level Moves the item down one level in the tree.

Format Opens the dialog allowing you to modify the formatting of the item (see Formatting Textual Re-
port Items (Legacy Reports) [page 372] and Formatting Graphical Report Items (Legacy Reports)
[page 376)).

Layout [list and card items] Opens a dialog allowing you to modify the layout of the item (see Controlling
the Layout of List Report Items (Legacy Reports) [page 377] and Controlling the Layout of Card
Report Items (Legacy Reports) [page 379]).

Collection [list and book items] Opens a dialog allowing you to define the collection to which the report item
will be applied (see Modifying the Collection of an Item (Legacy Reports) [page 369]).

Selection [list and book items] Opens a dialog allowing you to refine the selection of objects to which the
report item will be applied (see Selecting Objects to Display for a Report Item [page 358]).

Edit Title Opens the item in a dialog allowing you to edit its title (see Modifying the Title of an Item (Legacy
Reports) [page 368]).

Delete Removes the item from the Report Items pane. You can delete any item except the root.

Quick View Generates a preview of the item (see Previewing Your Report (Legacy Reports) [page 382]).

1.8.5.3 Modifying the Title of an Item (Legacy Reports)

Package, object, and object-dependent items all have default titles, and you can insert Title items anywhere in the
Report Items pane and as often as you want. You can edit the default text of these report items.

Procedure

Right-click an item in the Report Items pane and select Edit Title to open it in the Editor dialog box.

2. Enter any appropriate changes to the title text. The user-defined check box will be automatically selected. To
revert to the default value, clear this check box.

3. [optional] Clear the Show Title check box if you do not want to show the title of the item in the previewed or

generated report.
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4. [optional] Insert GTL variables that represent the name of the object, its parent, or model, etc at the cursor, by
selecting them with the Insert button.

5. [optional] Click the Format button to open the Format dialog box, and select the appropriate formatting.

6. Click OK to return to the Report Editor. The first line of the title is displayed next to the item in the Report Items
pane.

1 Note

You can edit the default titles of all report items in the report language resource file that is attached to your
report. For more information, see Customizing and Extending PowerDesigner > Translating Reports with
Report Language Files .

1.8.5.4 Modifying the Collection of an Item (Legacy Reports)

You can extend the PowerDesigner metamodel to, for example, add new properties to an existing object (extended
attributes), to create new objects (extended objects), and to create new connections between object types
(extended and calculated collections and extended compositions). These latter collection extensions are not
included, by default, in the object book report items in the Available Iltems pane of the Report Editor and must be
added by hand.

Context

1 Note

If you create extended or calculated collections in your model and use the Report Wizard (see Creating a Report
with the Report Wizard [page 325]) to create your report, the generated report automatically creates a list for
each type of extended and calculated collection inside the book item for each affected metaclass.

You can add any object list or book inside any other object book to allow you to represent any extended or
calculated collection. Since there is no control over the location where you drop report items, and you are
responsible for the global consistency of items and collections in your report. Once you have dropped the
appropriate item, you can modify its collection and select a calculated or extended collection.

In the following example, a calculated collection is created on the operations metaclass that retrieves the diagrams
where messages using a given operation are displayed. To display these diagrams in the report, a diagram item
must be inserted inside the operation book item and the appropriate calculated collection selected for its
collection:

Ia| Section_1
=L Class - Class %ITEMZ
E‘LHI Clazs Operation - Operation ZITEM% aof the clazs ZPARENT X
EZRNMIE v - Criacram 21 TEM %

In the following example, in order to manage the "schedule" and "event" concepts, the extended object <<event>>
has been created, along with an extended collection of extended objects <<schedule>>. The Extended Object
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report item is added to the report and filtered on the stereotype Event (see Selecting Objects to Display for a

Report Item [page 358]) and the List of Extended Objects is added to the Extended Object book, with its collection
set to Schedule:

a Sechion_1
=1-AL| Estended Object - Extended object ZITEMX

i=5] Extended Object Card - Card of extended object ZITEME

L ﬁ Lizt of Extended Objects - List of extended Dbiects\w

/_F,_,fwith filker steratype = Event

attached ko extended caollzction S chedule

Procedure

1. Drag and drop the appropriate book or list item under the selected book item in the Report Items pane.
2. Right-click the book or the list item and select Collection to open its Collection dialog box.

3. Select a collection in the Collection list and click OK to return to the Report Editor.

1.8.5.5 Selecting Objects to Display in the Report

By default, the report includes all the objects in your model. You can restrict the objects included by making a
selection, which is saved with the report.

Procedure

1. Select | Report » Select Objects 1 from the Report Editor to open the Report Object Selection dialog box. All
the objects (except any external shortcuts) are selected by default.

Core Features Guide

370 PUBLIC Modeling with PowerDesigner



i Report Object Selection _ O]

Section: IM_'.-' section j

E&F‘rniectManagement [F'Ej||:_j B s | By - G~ 2 &4F | W W VE

| Mame | Code | Farent -
v ] Diwisian DIVISIOM Phyzical Data Model 'Praj...
7 = | Employes EMPLOYEE Phyzical Data Model 'Pra;...
W] Custamer CUSTOMER Physical Data Model 'Proj...
v Froject FROJECT Phwsical Data Model Pro...
¥ =] Team TEAM Phyzical Data Model 'Praj...
Wi Task TASE, Phyzical Data Model 'Praoj... =
v =] Material MATERIAL Physical Data Model 'Proj...
v Farticipate FARTICIPATE Physical Data Model Proj..
T=l . . —— —_ . - - _Ib
Ll s I\Diagrams }\Tables ,{References }\Dnmains }\Llsers kEIusiness Fules f

Filter: | Objectis] selected: 1711

Selection: Ij &l tables j IEI IE
k. I Cancel | Help |

Select a report section from the Section list (see Report Properties [page 387]).

[optional] Select a package from the package list.

o K~ W

selection is saved as part of the model file (or in the .mmr file for a multi-model report).

6. Click OK to confirm your selection and return to the Report Editor.

Results

For information about the tools in this dialog, see Adding an Item from a Selection List [page 130].
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Select the objects that you want to include in the report from each of the object-specific sub-tabs.

[optional] Specify a name for your selection in the Selection list and click the Save tool beside the list. The
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1.8.5.6 Specifying Default Fonts for Report Items (Legacy
Reports)

You can specify default fonts for report items, report templates and reports. The default fonts are saved in the
registry.

Procedure

1. Select|» Report » Change Fonts . from the Report Editor window to open the Change Fonts Properties dialog

box:
Change Fonts |

&vailable jtenns: Font |

Level 4 ;I Eont: Font style: Size:
Level B

Level B Times Mew Roman [talic I'I 1]

Level 7

b onotype Sortz | [Regular - -

peve 8 MT Exra B =
T'.Ei”"e Symbol Bold 12

e T ahoma —! |Bold Italic - 14 o
List Tile Times Mew Roman 16

iList Column Header ~ Effects

Ligt Teut [ Shikeout [ Underline

Bocok Title

Falder Title — Preview

Card Title

Card Label

Card Tenxt fimes new romam

Text Attribute Title

Tet Attribute =

Text File |

QK. I Cancel Help

2. Select one or more available items in the left-hand list, and specify a font, style, size, and effects as
appropriate.

3. Click OK to return to the Report Editor.

1.8.5.7 Formatting Textual Report Items (Legacy Reports)

The Format dialog allows you to specify formatting for the selected report items.

You can access this dialog in any of the following ways:

e Select one or more text or list report items in the left-hand Available Items pane, and select |» Report

Format . in order to set default formatting for them.
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Each instance of the item that you subsequently add to the right-hand Report Items pane will have this same
formatting, but your changes will not affect any report items already in the Report Items pane.

e Select one or more text or list report items in the right-hand Report Items pane, and select | Report »
Format 3 to change their formatting.

Format

Awailable jtems:

Card Label

Card Text

Lizt Title

Lizt Calurmn Header
Lizgt Tt

]

Font |F'aragraph| Eh:uru:lerl Tabz I

Foant; Font style: Size:

[aial Bold 10
_ Fregular =] -
Arial Black, Italic 11 =
Arial Marrow 12
Bookman Old Style Boald Italic 14
Bookshelf Symbol 1 =l - s =
— Effectsz

[ Stikeout W Underline
— Presiew
Arial
)4 I Cancel Help

Available Items

Some report items contain more than one text element. You can format each separately or use the Ctrl or Shift

keys to select several at once:

Report Item

Card items

mat:

Text Selections

e Title - Title of the item, eg "Card of the Table"
e |abel - Property name on a list of properties, eg "Table Code"

® Text — Value of a property, eg "EMPLOYEE"

The following selections are available for card items (lists of properties), which are output in table for-
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Report Item Text Selections

CRUD Matrix items The following selections are available for CRUD Matrix items, which are output in table format:

e Matrix title - Title of the item, eg "CRUD Matrix "

e Matrix row and column — Resource and process name, eg " Check item (process name in rows)"
and " Stock (resource name in columns)"

e Matrix text - CRUD value,eg"RU "

Model- and object-de- | The following selections are available for model- and object-dependent items, which are output in
pendent items text format:

e Title — Title of the item, eg " Table Description "
e Text — Text of the description, annotation, or script, eg "This table describes different employee
characteristics "

Listitems The following selections are available for list items, which are output in table format:

e Title — Title of the item, eg " List of Indexes "
® Column Header — Heading of column, eg " Code "
e Text — Value in the column, eg " PK_EMPLOYEE "

Title page The following selections are available for the title page (see Report Properties [page 387]), which is
output in text format:

e Title - Title of the report, eg "OOM Report"
e Optional Fields — Text of the author, date, version or summary, eg " VB, 09.15.99, draft, report
with lists only "

Table of contents The following selections are available for the table of contents, which is output in text format:

e TOC title - Title of the table of contents, eg " Table of contents "
e |evel <x>— Text of the different hierarchy levels in the table of contents, eg "2.1 Model informa-

tion"

1 Note

Select the levels to display from the Show levels list beneath the Available items pane of the Format dialog. To
define the levels to be shown in the TOC of an HTML report, see Report Properties [page 387].

Font Tab

The Format dialog Font tab allows you to specify a font, style, size, and effects for the text elements that you select
in the left-hand Available items list.
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Paragraph Tab

The Format dialog Paragraph tab allows you to specify indentation, spacing, and alignment for the text elements
that you select in the left-hand Available items list.

Border Tab

The Format dialog Border tab allows you to specify elements of a frame around the text elements that you select in
the left-hand Available items list. The following border formatting is available:

Option Description

Left / Right / Top / | Inserts a line to the left, right, top, or bottom of all the occurrences of the selected text elements.

Bottom

Box [card and list items only] Inserts a rectangle around all the occurrences of the selected text elements.
For card items, inserts a rectangle that groups all the occurrences of Text Label (property names) includ-
ing Text (corresponding property values).
For list items, inserts a rectangle that groups all the occurrences of Column Header (heading of column,
example Code), and also a rectangle that groups all the occurrences of Text (value in the column), if you
have previously highlighted each of these text selections in the Available Items pane.

Width Specifies the line width for the Left, Right, Top and Bottom frame options

Box width Specifies the line width of the box frame

From text Specifies the amount of space from text to top, bottom, left, and right border

Tab Tab

The Format dialog Tab tab allows you to specify tab positions and alignment for the text elements that you select in
the left-hand Available items list, which is particularly useful for the layout of headers and footers (see Modifying
Report Section Headers and Footers (Legacy Reports) [page 381]).

The following tab formatting is available:

Option Description
Tab stop position Specifies the measurement for a tab stop
Default tab stops Specifies the default spacing between tab stops
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Description

Alignment Specifies how text is to be aligned at the tab stop. To change the alignment for an existing tab
stop, click it in the Tab Stop Position box, and then click the new alignment option

1.8.5.8 Editing Textual Report Items (Legacy Reports)

You can edit the text of a text paragraph or a text file in a text editor by double-clicking it or right-clicking it and
selecting Edit.

Context

For text paragraphs, you can select the following kinds of content:

e User-defined - Enter text directly into the box. Click the Format button to apply formatting to selected text.
e Object attribute - Select an attribute from the list.

1.8.5.9 Formatting Graphical Report Items (Legacy Reports)

You can access the report items Graph Format dialog in any of the following ways:

Context

e Select one or more graphical report items in the left-hand Available Items pane, and select | Report »

Format Jin order to set default formatting for them.
Each instance of the item that you subsequently add to the right-hand Report Items pane will have this same
formatting, but your changes will not affect any report items already in the Report Items pane.

e Select one or more graphical report items in the right-hand Report Items pane, and select | Report »

Format 3 to change their formatting.
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Graph Format |
— Frame
™ Leit
£ Centered ™ Right
% fi3 paragraph [ Iop
[ Bottom

= Custom

Z00; |B4 ?'*é it |3.-’4 pt 'I

% Keep diagram layout

k., I I:an-:ell Help |

The following options are available in the Graph Format dialog:

Option Description

Zoom Specifies the resizing of the graphic in the report. You can choose between:

e Fittopage
e (Custom zoom

e Keep diagram layout - one page of the diagram per report page

Frame Specifies the borders to insert around the graphic.

1.8.5.10 Controlling the Layout of List Report Items (Legacy
Reports)

List report items are published as tables, ordered by the name or code of the objects. You can specify which
attributes will be displayed, in which order, and the width of their columns.

Procedure

1. Select one or more list report items in the Report Items pane and select |+ Report » Layout 3to open the List
Layout dialog, which lists all the attributes available for the object:
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List Layout

S [=] B3

Attibute Name D width =
Dirmensional Type [ 20 mm
Check Conztraint Mame [ 50 o
Frirmary Key [ 20 rorm
Cluzter [ 20 rrmn
Type v B0 mm
Annatated [ 10 mm
Has Symbal [ 10 mm
Feplica [ 10 mm
Date Extat v 50 rom
E«tGlobalTemporary T able [ 10
Ak AR AR4EIEIRN
k. I Cancel | Help |

2. Enter any appropriate layout changes as follows:

o Use the arrow buttons at the bottom of the dialog to reorder columns in the table.

o Select the D column next to a property to display it in the table.
o Enter a width in the width column. You can specify the width in millimeters (mm), inches (in) or as a

percentage of the table width.

3. Click OK to return to the Report Editor.

Results

1 Note

If extended attributes are specified for the object, they will be available for selection in the List Layout dialog.
You can choose to select all extended attributes or only those whose value has been modified using the

|» Display » All 3and | Display » Only modified ones 3 commands from the list item contextual menu.
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1.8.5.11 Controlling the Layout of Card Report Items (Legacy
Reports)

Card report items represent the property sheets of individual objects and are published as two-column tables. You
can specify which attributes will be displayed, and in which order.

Procedure

1. Select one or more card report items in the Report Items pane and select |+ Report » Layout 3 to open the
Card Layout dialog, which lists all the attributes available for the object:

Card Layout _|O]

Attibute Mame _D ﬂ

Dimensional Type r

Check Constraint M ame [

Primary K.ep B

Cluzter [

Type v

Annotated [

Haz Symbal [

Replica [

Date Extat v ik
EwtGlobalT ermporanyT able B -
3k AR RAEI IR0 |

] 4 I Cancel | Help |

2. Enter any appropriate layout changes as follows:

o Use the arrow buttons at the bottom of the dialog to reorder properties in the table.
o Select the D column next to a property to display it in the table.
3. Click OK to return to the Report Editor.

Results

1 Note

Select the Displayed check box for the Class Name attribute to distinguish shortcuts cards from the other
object types cards in the generated report.
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1.8.5.12 Suppressing the Titles of Report Items (Legacy
Reports)

You can suppress the title of any item in your report. The following illustration shows a portion of a report, with the
title of the process card displayed:

Context

1 Process Process 1

1.1 Card of process Process_1

Mame Frocess_1
Code Frocess 1
Comment

This illustration shows the same report with the title of the process card suppressed:

1 Process Process_1

MName Process_1
Code Process 1
Comment

Procedure

Right-click an item in the Report Items pane and deselect the Show Title command.
or

Double-click an item to open the Editor dialog box, clear the Show Title check box, then click OK.
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1.8.5.13 Modifying Report Section Headers and Footers (Legacy
Reports)

The Report includes a default header and footer that you can modify.

Context

For more information about the default header and footer, including specifying separate headers and footers for
each section of your RTF report, see Report Properties [page 387].

Procedure

1. Right-click the root section item in the Report Items pane and select Header/Footer (or click the Header &
Footer button in the Presentation Options page of the Report Creation Wizard) to open the Header and Footer
dialog:

Header and Footer |

[ User-defined header
HhODTTLE SIODELN AMEY:

E'&,Header .|{F|:u:|ter /
Insert """" vl Format... | ITI Cancel Help

2. Enter any appropriate changes to the header text. Edit the Footer text by clicking on the Footer sub-tab. You
can use any of the variables available to the RTF template (see RTF Presentation Templates [page 393]).

If you change the default header or footer text, then the User-Defined check box is selected, to indicate that
you have overridden the default values in the associated report language resource file. To revert to the default
value, clear the check box. For more information about report language resource files, see Customizing and
Extending PowerDesigner > Translating Reports with Report Language Files .

1 Note

Use the key combination Ctr/+Tab to insert tabulations in a header or open the Tabs tab in the Format dialog
box (see Formatting Textual Report Items (Legacy Reports) [page 372]) to set tab stop values.

3. Click OK to return to your report.
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1.8.5.14 Previewing Your Report (Legacy Reports)

You can preview your report by selecting |+ Report  Print Preview 3 or by clicking the Preview tool in the End page
of the Report Creation Wizard. You can preview a report item by right-clicking it in the Report Items pane and
selecting Quick View.

PowerDesigner - [PhyzsicalDataModel 1, Report - My First Report]

& B |88 | [100 SR DD G e

Tyl O el
ATsheToh 4

A4 Cordor chee oo b Tabie 4
Taie_1

lame .
2k maisd iukmad
A Carwe ik ris o o b Tabis 4
CEYTRILT

A2 Zeruar chesch soTr kol L bl Tohde 4
L TIEILY

1 Coiman o de-orhies Trhds 1

s
Calmm e o
Co e 3 LU 3

A5 CohranCohran 1 oforhls Tohie 4

4254 Cord off chet coll i Coliran 1 of dhe-orhie Trhds 1
s ol _1

Eadn [ TETEr T
Dum Fpn ladd mad-
Damiumip Ha

A iorelrd chech o coliman Coliran 1 of orhis Tohls 4

1 Dot B Ik ot e o e S ol | o et bl Teble 4
CLC_ MU _lGmL
A S cheik i T b o' o wran Coliran 1 of e bie Tobie o

ol s S e 3 1 G L e WILLED
AL CoranColrdn 2o othis Tohie 1

AL Cond of che cob ran Colran o deecrhls Tobls 4
e L]

Eadn [ TETEr )

Dum Fpn ladd mad-

Damiumip Ha

AL iorelind chech of coliman Coliran sof orhis Trhls 4

FammOmgam EELILT]

Fage 2/14 i

The following tools are available in this window:

Tool Goes to preview

Print the report.

£.||23 Preview the report one or two pages at a time.

@ @ @ @ Go to the first, previous, next, or last page of the report.
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Tool Goes to preview
Eﬂ Eﬂ Generate the report in HTML or RTF format.
Open the Find Objects dialog. Specify the model (for multi-model reports), object type, and ob-
34

ject you want to find, and then click Find to display a list of topics that mention the object. Then
select a topic in the list and click Display to go to that topic in the report preview:

Find Dbjects

1. Select the model to zearch in
IF'uI:uIishing industry j

2. Select the object pou want ko find

Object type:

|Table |

Ayailable objects:

AUTHOR |
DISCOUNT

HISTORY .
BRI
PUELISHER

ROvSCHED

S6LE [

3. Click a topiz, then click Dizplay

- Clear

Repart tapic Fange

Table PFICTURE 17

Card of the table PICTUURE 17

Conztraint name of table PICT URE 17

4 | »

Dizplay Cloge | Help |

@ Help
'ﬂ; Close the preview.
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1.8.5.15 Upgrading Legacy Reports for Use with the Graphical
Editor

You can upgrade a legacy report to allow it to be edited in the new graphical Report Editor at any time from the
Browser or the List of Reports. You can upgrade a legacy report template from the List of Report Templates.

Context

1 Note
Upgrading a legacy report cannot be undone. You may want to copy your legacy report (see Moving and Copying

Objects [page 103]) before upgrading it, to use it for reviewing the upgraded version

To upgrade a report from the Browser, right-click it and select Upgrade to New-Style Report.

To upgrade a report from the List of Reports, select [r Report » Reports Jto open the list, select the report to
upgrade, and then click the Upgrade to New-Style Report tool.

To upgrade a report template from the List of Report Templates, select | Report » Report Templates 3 to open the
list, select the template to upgrade, and then click the Upgrade to New-Style Report tool.

In both the Browser and list, new-style reports display a small overlay to identify them:

[ List of Reports
HE GExXX AdRE B

Mame

E] MyLegacyReport
El MyFReport

[ Claze J [ Help
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1.8.6 Generating a Model Report

You can generate your report directly from the Report Editor by clicking the Generate Web Report or Generate Rich
Text Document tools in the toolbar or selecting the corresponding commands from the Report menu. You can
generate any report in the model or a generic report from a template from the Generate Report dialog.

Procedure

1. Select| Report » Generate Report Jto open the Generate Report dialog.

B x|

— Generate repart

@ Heport femplate € Mode report

Full Phyzical Beport
Ligt Phyzical Report
Standard Phuzsical Repaort

— Generation action
{* Generate HTHL " Print report
" Generate RTF ™ PFrink preview

Repart narme; IFuII Phyzical Report

Language:  |English [

File name: IE:"-.F'rn:-gram FilezhSvbaze'\PowerDezigner

(] I Cancel | Help |

2. Select whether to generate your report from a:

© Report template — Select a standard template or one of your own (see Report Templates [page 386]). Click
the Browse button to change the folder where your templates are stored.

o Model report — Select any report defined in the model.

1 Note

To generate a report directly from its Browser entry, right-click it, and select Print, | Generate » RTF 7,
or | Generate » HTML 1.
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3. Select how you want to generate your report:
o Generate HTML — Generates a set of files to display your report in a Web browser.
o Generate RTF - Generates a Rich Text Format file for opening in Microsoft Word or another RTF editor.
o Print report — Prints the report directly.
o Print preview — Generates a preview of the report (see Previewing a Report or Report Item [page 362].
4. [for HTML or RTF only] Specify a Report name and File name for the generated files.
5. Specify the report Language to use for generating item titles and other report artifacts.

6. Click OK to begin the generation.

1.8.7 Report Templates

A report template specifies content and formatting for a report (or, for a multimodel report, a section).
PowerDesigner provides a set of standard report templates, and you can create your own. You can create a report
template from scratch, or based on an existing template, from the List of Report Templates.

Procedure

1. Select | Tools ¥ Resources ¥ Report Templates J to open the List of Report Templates.
2. Click the New tool and enter a name for your template.

3. Select alanguage and model type for the template, and then click OK to open the empty template in the
Report Template Editor.

4. Edit the report template as necessary (see The Report Editor [page 340]).

5. Select| File » Save Jto save the template and make it available for selection when you create a report.

6. [optional] Check the report template into the repository Library/Resources/Report Templates folder to
make it available to other users (see Sharing Model, Report, and Project Templates and Conversion Tables via
the Library [page 589]).

1.8.71 Saving a Report or Report Section as a Report
Template

You can save your report (or a section in a multimodel report) as a report template for use with other reports.

Procedure

1. Inthe Outline or Design view, click in the section you want to save as a template.
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1 Note
For legacy reports, click the tab at the bottom of the Report items pane to select the section you want to
save.
2. Select | Report ¥ Create Template From Section 4.

3. Select|p File » Save 3, enter a name for the template, and click OK to save it for future use.

4. [optional] Check the report template into the repository Library/Resources/Report Templates folder to

make it available to other users (see Sharing Model, Report, and Project Templates and Conversion Tables via
the Library [page 589]).

1.8.7.2 Modifying and Saving a Template

You can modify a report template from the List of Report Templates.

Procedure

—

Select | Report # Report Templates 4 to open the List of Report Templates

1 Note

You can open the List of Report Templates from the List of Reports by clicking the Manage Report Templates
tool.

Select a template type to display the list of available templates of that type.
[optional] Click the Path tool to select a different directory in which to search for templates.

Select a template and click the Properties tool to open it in the Report Editor.

o M w DN

Make any appropriate changes to the template and then click the X at the top right of the Design view to close
it and be prompted to save your changes.

1.8.8 Report Properties

To open the report property sheet, select | Report  Report Properties 3 from the Report Editor window or right-
click the report in the Browser and select Properties.

The report property sheet General tab contains the following properties:
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Property Description

Name/Code/ Identify the object. The name should clearly convey the object's purpose to non-technical users, while

Comment the code, which is used for generating code or scripts, may be abbreviated, and should not normally
include spaces. You can optionally add a comment to provide more detailed information about the ob-
ject. By default the code is generated from the name by applying the naming conventions specified in
the model options. To decouple name-code synchronization, click to release the = button to the right
of the Code field.

Language Specifies the language of the report. Click the tools to the right of this field to edit the selected report

language resource file or to change the path that populates the list. For more information see Custom-
izing and Extending PowerDesigner > Translating Reports with Report Language Files .

No paragraph num-
bering

Suppresses section numbers in RTF and printed reports. Paragraph numbering is not used in HTML
reports.

Generate empty para-
graphs

Generates titles for all book items, even if they have no content.

Title Page Tab (Legacy Reports)

The report property sheet Title Page tab allows you to specify the contents of a title page for your report:

Property

No title page/ Include
title page

Description

Select whether to include a title page. Selecting Include title page enables the other fields on this tab.

Title Specifies the title of the report. Default: The name of the report.

Author Specifies the report author. Default: User shown on the Version Info tab.

Date Specifies the date of the report. Default: Today's date.

Version Specifies the version number of the report. Default: Version in the model property sheet.
Summary Specifies any additional text to be printed on the title page.

Click the Format button to customize the formatting of these fields.

1 Note

For HTML reports, a home page is generated instead of a title page. Title pages are never generated for RTF
reports generated with a report template.

388 PUBLIC

Core Features Guide
Modeling with PowerDesigner



RTF Format Tab

PowerDesigner provides a set of predefined RTF presentation templates, style sheets, and header and footer files
for generating RTF reports, which are located in the Resource Files\RTF Report Templates directory. You
can use these files as a basis to create your own templates.

The report property sheet RTF Format tab allows you to specify an RTF presentation template for your report, and
contains the following properties:

Property Description

Template Specifies the RTF presentation template to be used to style the report. Click the tools to the right of this
field to edit the selected template (see Referencing Object and Model Properties [page 362]) or browse
to an alternate template directory.

Use sections Specifies to use the header and footer defined in each report section instead of those defined in the RTF

header and footer presentation template (see Modifying Report Section Headers and Footers [page 361]. If you want to pre-
serve the header and footer of the title page and of the table of contents page, you should add a section
break after the table of contents.

This option is recommended when formatting a multi-model report, as otherwise all the pages of the re-
port will have the same header and footer.

1 Note

Click the Set As Default button to specify your current settings as the default for RTF reports. To revert to the
previously saved values, click the Default button.

HTML Format Tab

PowerDesigner provides a set of predefined HTML presentation templates, style sheets and header and footer files
for generating HTML reports, which are located in the Resource Files\HTML Report Style Sheets
directory. You can use these files as a basis to create your own templates.

The report property sheet HTML Format tab allows you to specify HTML presentation options for your report, and
contains the following properties:

Property Description

Template Specifies the HTML presentation template to be used to style the report. Click the tools to the right of
this field to preview, save, or delete the selected template, or to browse to an alternate template direc-
tory.

Style sheet Specifies the style sheet to be used to style the report as an absolute or relative path or a URL. Click the
tools to the right of this field to edit the selected stylesheet (see Referencing Object and Model Properties
[page 362]) or browse to an alternate style sheet.
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Property Description

Header / Footer Specifies the HTML file to be used as the report header or footer as an absolute or relative path or a URL.
Click the tools to the right of the field to edit the selected file (see Referencing Object and Model Proper-
ties [page 362]) or browse to an alternate file.
You can also specify the height, in pixels, of the header and footer.

Home page Specifies the HTML file to be used as the report homepage as an absolute or relative path or a URL. Click

the tools to the right of this field to edit the selected file (see Referencing Object and Model Properties
[page 362]) or browse to an alternate file.

Table of contents These options control the format of the table of contents. You can specify:

® | evel -the maximum number of levels to display in the HTML table of contents. Default: 4.
e Width - the width of the frame as a percentage of the total width of the report window. Default: 25%.
e TOC at right - whether the TOC will be generated on the left (default) or right side of the screen.

You can reduce the size of the HTML TOC by right-clicking book report items and selecting:

e  Show contents in HTML TOC - deselect this option to display only the title of the item without its con-
tents in the TOC.

e Show book title in HTML TOC - deselect this option to remove the title of the book item from the ta-
ble of contents. Automatically deselects the Show contents in HTML TOC option.

Image Format Specifies the file format for graphic files to be generated and embedded in the report:

e SVG - XML-based language for Web graphics, which allows you to interact with the graphics. Note
that SVG is not supported for graphics embedded in RTF in PowerDesigner property fields, and such
graphics will be generated as PNG.

e  PNG - higher quality than JPEG.

e JPEG - smaller file size than PNG.

List format Specifies the format for lists. You can specify the number of rows you want to display per page in the list
results and the number of links to additional results displayed below the list. Additional results are num-
bers with hyperlinks to other pages containing the next rows of the list.

Web browser [legacy reports] Specifies the primary type of browser that will be used to view the HTML report in order
to correctly generate SVG graphics. You can specify HTML5-compliant browsers or Internet Explorer 6,7,
or 8 (which support SVG via the Adobe SVG plug-in).

Add page break for | [legacy reports] Inserts a page break before each top level list and card to avoid long HTML pages.
top level list and
cards

1 Note

Click the Set As Default button to specify your current settings as the default for HTML reports. To revert to the
previously saved values, click the Default button.
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Depending on the type of location (local or UNC paths, or URL), style sheet files, header and footer files and home
page files are used as follows:

Location

Local path or UNC path

Use

The file is copied into the report generation folder.

URL

The file is referenced in its location.

We recommend that you gather your style sheets and header and footer files in a subfolder with the same name as
the presentation template file with which they are associated to ensure that the structure of links between them is
simplified.

For example, the Header_Blue.html header uses files that are gathered in the Header_Blue_files folder:

5 ap (O] =]
B doc?y [ JHeader_Blue_files
E‘D Mg 3 Header_Yellov_filez
EH:' Pd Blue_Theme.css
Ea Fipt == _ Fiik Header_Blue. himl
Cl Header_BIue_flle:s ﬁ Header_ellaw. il
7] Header ellow files HTML Help.css

Sections Tab (Legacy Reports)

You can use sections to structure your report. Reports must contain at least one section, and sections are
displayed as tabs at the bottom of the Report Items pane of the Report Editor. Each section can only report on one
type of model so, in a multi-model report, each different type of model (PDM, OOM, BPM, etc) must have its own
section.

The report property sheet Sections tab allows you to create, configure, and delete report sections, and contains
the following properties:

Property Description

Name Specifies the name of the section, which will be displayed on the sub-tab at the bottom of the Report Edi-
tor window. You can also change the name of a section by right-clicking the section node in the Report
Editor and selecting Rename.

Model [multi-model reports only] Specifies the model on which the section will report.
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Property Description

Template Specifies the template upon which the section is based. You can choose between:

e None [default] — creates an empty section.

® Full <Model Type> Report — provides lists of all the types of objects in the model, together with de-
tailed information on each object.

e |ist<Model Type> Report - provides lists of all the types of objects in the model.

e Standard <Model Type> Report — provides lists of all the types of objects in the model, together
with detailed information on each of the main objects.

Apply Template Re-applies the specified template to the section, deleting any modifications you may have made.

1 Note

You cannot undo this action.

1 Note

You can launch the Report Wizard (see Creating a Report with the Report Wizard [page 325]) from the Report
Editor to configure the present section. The wizard configures only one section at a time, and will delete the
current contents of the section. To configure a second section, select it using the section tabs at the bottom of
the window, and relaunch the wizard.

1.8.8.1 Valid Codepage

By default, PowerDesigner generates in the HTML page a character set (charset) built from the current language of
the report. If this is not correct for your needs, you can change the charset.

Procedure

1. Right-click the report in the Browser, and select Properties from the contextual menu to open its property
sheet.

2. Onthe General tab, click the Properties button to the right of the Language field to open the Report Language
resource file in the Resource Editor.

3. Expand the | Report Titles » Common Objects J category, and set the appropriate values for the CharSet and
CodePage items.
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Results

For information about working with charsets and coding pages, see: http://www.w3.org/International/tutorials/
tutorial-char-enc/ #* .
1 Note

You can translate the navigation buttons (Previous, Next, Home) generated by default in your HTML report
using HtmINext, HtmlIPrevious and HtmIHome items in the Report Titles\Common Objects category of the
Report Language Editor. For more information, see Customizing and Extending PowerDesigner > Translating
Reports with Report Language Files .

1.8.8.2 RTF Presentation Templates

An RTF presentation template file has an .RTF extension and allows you to define the header, footer, title page,
table of contents, and general style of your RTF report. You can insert pictures, page borders and variables in an
RTF presentation template.

The presentation template takes into account all the presentation options that you have defined in the Report
Wizard or Report Editor, except the table of contents report item as this is defined in the RTF presentation
template.

1 Note

If you open a report saved in a previous version, the RTF Template list is set to <None>.

1.8.8.3 HTML Presentation Templates

An HTML presentation template file (* . htmltpl) allows you to define the header, footer, home page, and style
sheet (for font, color, background, size, margin, and alignment) for your HTML report. The formatting defined in
your style sheet will override any defined in the Report Wizard or Report Editor.

1 Note

If you open a report saved in a previous version, the HTML presentation template has the values of the default
HTML presentation template or the Presentation template box will be set to (<None>).
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Style Sheet Structure

The following table describes the use of class names in the report style sheets:

Class names

Description

TABLE.GRID TD.HEADER
TABLE.GRID TD

TABLE.GRID TD TD2

BODY Background styles for all report pages, except the home page frame and the
browser frame page.

.BROWSERBODY Background styles for the browser page.

.HOMEBODY Background styles for the home page.

TEXT Font styles for text blocks, like description, annotation, etc.

TITLE Font styles for the title of the home page.

TABLE Styles for tables.

TD Styles for table cells.

Table.GRID Styles for the tables, header cells, even row, and odd row cells of object lists.

Table.FORM

TABLE.FORM TD.HEADER

TABLE.FORM TD

Styles for the tables, row header cells, and value cells of object cards.

Table TEXT Styles for the tables and the cells of tables around the text blocks.
TABLETEXT TD

TableTITLE Styles for the tables and the cells of tables around the home page title.
TABLETITLE TD

Table.GRAPHICS

TABLE.GRAPHICS TD

Styles for the tables and the cells of tables around graphics.

H1, H2, H3 Styles for level 1, 2, and 3 headings.

HR Styles for separator lines.

A:LINK Colors for non-visited, visited, and highlighted hyperlinks.
A: VISITED

A: HOVER
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Class names Description

.BROWSER Font styles for the browser.

A.BROWSER:LINK Colors for non-visited, visited, and highlighted hyperlinks of the browser.
A.BROWSER:VISITED

A.BROWSER:HOVER

TABLE.NAVGROUP Styles for the tables and the cells of tables around the navigation buttons.
TABLE. NAVGROUP TD

.NAVBUTTON Font styles for navigation buttons and for non-visited, visited, and highlighted
ANAVBUTTON-LINK hyperlinks of navigation buttons.

A.NAVBUTTON:VISITED

A.NAVBUTTON:HOVER

1.9 Comparing and Merging Models

PowerDesigner provides powerful tools for comparing models and merging them.

1.9.1 Comparing Models

You can compare the content of two PowerDesigner models or two resource files of the same type at any time. You
may want to compare models or resource files to review evolutions in models or resources manipulated by
different development teams or to evaluate the differences that exist between the models or resources before
merging them.

Procedure

1. Select | Tools » Compare Models 3 to open the Select Models to Compare dialog box.

The current model is displayed in the Model 2 field.

2. Select a model to compare in the Model 1 list. Only models of the same type in the workspace are available for
comparison.
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kodel 1: Project Management [CORM] j

Model 2: I‘?n &lpha_Project j
Options... | k. I Cancel | Help |

3. [optional] Click the Options button to open the Comparison Options window and specify which objects and
properties you want to include in the comparison (see Excluding Objects and Properties from a Compare or
Merge [page 403]).

4. Click OK to open the Compare Models window, which displays the objects contained within the models or
resource files in a tree format, and highlights the differences between them (see Reviewing Differences
Between Models [page 396]). You can apply a filter to simplify the list of differences (see Filtering Objects and
Changes During a Compare or Merge [page 405]).

1.9.1.1 Reviewing Differences Between Models

The Compare Models window displays the models to compare as two trees of objects in left and right panes (with
the model from which you launch the comparison on the right), and a third pane at the bottom with three columns,
listing each of the properties of the selected object, and the values assigned to these properties in the two models.
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7 | Compare Models

o |G S

BrHFBE WA P M| B
Madel 1 : Project Management (COM) Maodel 2 : Project Management (COM) - new version
-ﬁ Project Management (COM) - E Project Management (COM) - new version -
B-5 i EI-@ Care ¥
LR Core Dizgram [P b [ Core Diagram
EI (| Entities
. [-[F Division
4 -4 Data tems
- @ Main diagram =| | &-[d Main diagram =
[-_d Domains (- _d Domains
E-{@ Entities E-# Entities
g hay CaEm
G- Customer
w-[Z] Division |
-] Employes - [ Employes 7
EI@ Material =3 @ Material
EI _'ﬂ Attributes ' EI Ll Attributes
------ i Material number P E Material number
(4 Material name
[ Material type 5 E Material type
5 - ------ E I'u'IatenaI name =
Property Model 1 Model 2 =
Composite FALSE FALSE
Mapping <Mone: <Mone:= b
A Number 1,000,000 =]
- F‘nmElr'_.r Iderrtrf‘er <Monez <Mones -
[ Cloze ] [ Help ]

Explore the tree by opening nodes to reveal categories, objects, and sub-objects. To expand all nodes, press the
numpad star (¥). To collapse all nodes, press the numpad minus sign (-).

The following types of differences can be detected during a comparison:
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Symbol Description

Existence - The object is present in one model (blue text) and

r-[H Customer Rl . !
’ absent in the other (greyed text and icon).

i Note

The owner of PDM objects (such as tables) is included in
their identifiers and objects with the same name but differ-
ent owners are treated as separate objects. For example, a
table T1 has an owner DEV in PDM1 and an owner DBA in
PDM2 and the tables are not linked. If an owner were speci-
fied in only one model, then the tables would be linked and
show a change in the Owner property value.

E Activity | I E Activity Modification (red warning triangle) - One or more attributes of

’ o the object has different values in each of the models. To review
Properties pane: the differences in properties, look for the red warning triangles
in the list of properties in the bottom pane.

Property Model 1 Maodel 2 1 Note
E3 Mapping <Mone> <None: To open the property sheet of any object in either model,
54 Number 1,000,000 100,000 right-click it in the tree and select Properties.
E Employee ‘—l I E Employee Child Modification (yellow warning triangle) - One or more sub-

objects beneath the object has differences.

E Material name P i Movement (green triangle with arrow) - The object is in a dif-
E Material type E Material type ferent p95|t|on in the collection or in aldn"flerent p?ckgge. The
& E Material name normal icon and text represent the object's position in the

- i HE

present model and the greyed text and icon represent its posi-
tion in the other model. The green triangle becomes red if the
object also has modifications.

1 Note

To go to the other instance of the object, right-click it in the
tree and select either Next Occurrence or Previous

Occurrence.
The following tools are available in this window:
Tool Description
G - Filter - Apply one or more of the predefined filters to control the types of differences that are displayed (see Fil-
tering Objects and Changes During a Compare or Merge [page 405]).
|§| Properties - Open the property sheet of the selected object.
P Options - Open the Comparison Options dialog to control the types of metaclasses, attributes, and collections
that are displayed (see Excluding Objects and Properties from a Compare or Merge [page 403]
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Tool Description
o Manually Synchronize Two Objects - Select an object in either model and then click this tool to link it to an object
in the other model or to break such a link (see Repairing or Breaking Links Between Objects [page 406]).
I First/Last Difference - Jump to the first or last difference in the tree.
4p Previous/Next Difference - Jump to the previous or next difference in the tree.
g Compare Preview - Open the Compare Preview window, which gives a list of the differences in textual or list for-
= mats (see Previewing, Printing, and Saving Comparison Results [page 407]).

1.9.2 Merging Models

You can merge the content of two PowerDesigner models or two resource files of the same type at any time.

Procedure

1. Select |l Tools » Merge Models 3 to open the Select Models to Merge dialog.

The current model is displayed in the To field.

2. Select a model to merge in the From list. Only models of the same type in the workspace are available for
merging.

From: @ Project kManagement [COM] j

Te: Fﬁ.ﬁ.lpha_F'miect j
Options... | k. I Cancel | Help |

1 Note

If you want to merge two PDMs, BPMs, OOMs or XSMs, you have to select two models with the same target
DBMS or language.

3. [optional] Click the Options button to open the Comparison Options dialog and specify which objects and
properties you want to include in the comparison and possible merging (see Excluding Objects and Properties
from a Compare or Merge [page 4037).

4. Click OK to open the Merge Models window, which displays the objects contained within the models or
resource files in a tree format, and highlights the differences between them (see Selecting Merge Actions
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[page 40017). You can apply a filter to simplify the list of differences (see Filtering Objects and Changes During a
Compare or Merge [page 405]).

5. Selecting the merge actions that you want to perform, and then click OK.

The Merge Models dialog box closes and the merge begins, with messages displayed in the Output pane. A
final message informs you that the models were successfully merged.

1.9.2.1 Selecting Merge Actions

The Merge Models window displays the anticipated result of your proposed merge as a tree of objects, with check
boxes to the left of each potential change to allow you to approve or reject it. The properties pane lists each of the
properties of the selected object, and allows you to select or reject the values proposed in the To column. Select or
deselect actions as appropriate and then click OK to perform the merge.

F- =

7 | Merge Models =

By~ Oy~ B v F B W4 b M B
El o : Project Management (COM) - new version

| Project Management (COM) - new version
EIDE Core

-] [ Core Diagram
-3 Entities

E Division
,__J Data kems
EEI---@ Main diagram
-4 Domains

=-Ld Entities

-] B8 Activity
-0 & Customer R
¥

@ Employee

- Material

. B Attributes

»

m

i

i E Material number

...... E Material type -

Property Fram é“' To Iﬁ“' =
4, Mumber 1,000,000 100.000 3
Primary |dertifier <Mone: <Monez

9 Descriotion
' 0 | »

[ k. ][ Cancel ][ Help ]
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Explore the tree by opening nodes to reveal categories, objects, and sub-objects. To expand all nodes, press the
numpad star (¥). To collapse all nodes, press the numpad minus sign (-). Use the Show/Hide Source Model toggle
at the top left of the pane to split the pane and display the source model to the left of the target model.

The following types of merge actions can be approved by selecting or rejected by deselecting the check box:

Symbol Description

Properties pane:

Property From @ To |§'
23 Mapping <MNaones <Mones
[ Number 1,000,000 100,000

(red warning triangle)

% (blue plus sign and greyed text and Creation - Th.e object is absent from the model to be modified
. and present in the model to apply.
icon)
Selected: The object will be created.
O E Customer (purple minus sign and blue text) Deletion - The object is present in the model to be modified
and absent in the model to apply.
Selected: The object will be deleted.
E Activity (red equals sign) Modification - One or more attributes of the object has differ-

ent values in each of the models. To review the differences in
properties, look for the red warning triangles in the list of prop-
erties in the bottom pane.

1 Note

Double-click a property to display differences in textual for-
mat between models. The value to be applied is in blue,
preceded by >>, and the value to be deleted is in red pre-
ceded by <<.

Selected (object): All values in the model to be applied are
copied to the model to be modified.

Selected (property): The value in the From column is applied
to the model to be modified.

E Employee (yellow warning triangle)

Child Modification - One or more sub-objects beneath the ob-
ject has differences. Expand the tree beneath the object to re-
view and approve these changes.

E Material name
[ Material type (green circle with arrow and greyed
text and icon and green triangle with arrow)

Movement - The object is in one position in the model to be
modified (green circle with arrow and greyed text and icon)
and in a different position in the collection or in a different
package in the model to be applied (green triangle with arrow).
The green triangle becomes red if the object also has modifi-
cations.

Selected: The object is moved from the position with the green
circle to the position with the green triangle.

1 Note

To go to the other instance of the object, right-click it in the
tree and select either Next Occurrence or Previous
Occurrence.

By default, merge actions are selected as follows:
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e During merge of unrelated models - all creation, modification and move actions are selected, but deletion
actions are deselected to preserve the superset of all objects in the two models as far as possible.

e During check in/check out from the repository - based on when the latest changes were saved in the model.

e \When updating a generated model - based on whether changes have been made to the generated model (if
the Preserve modifications generation option is selected).

The following tools are available in this window:

Tool

3|3

Description

Select/Deselect All - Select or deselect all merge actions. Click the arrow to the right of the button to select or
deselect all creation, deletion, modification, or move actions.

G-

Filter - Apply one or more of the predefined filters to control the types of merge actions that are displayed (see
Filtering Objects and Changes During a Compare or Merge [page 405]).
1 Note

The filters control only what is displayed in this window. Even if an action is not displayed, if it is selected, it
will be applied when you click OK.

=)

Properties - Open the property sheet of the selected object.

Options - Open the Comparison Options dialog to control the types of metaclasses, attributes, and collections

B that are displayed (see Excluding Objects and Properties from a Compare or Merge [page 403].
1 Note
The options control whether merge actions will be applied to objects. If you exclude a metaclass, attribute,
or collection, then it will not appear in the window, and no merge actions will be applied to it.
o0 Manually Synchronize Two Objects - Select an object in either model and then click this tool to link it to an ob-
ject in the other model or to break such a link (see Repairing or Breaking Links Between Objects [page 406]).
b First/Last Difference - Jump to the first or last difference in the tree.
4 Previous/Next Difference - Jump to the previous or next difference in the tree.
3 Merge Preview - Open the Merge Preview window, which gives a list of the differences in textual or list formats
= (see Previewing, Printing, and Saving Comparison Results [page 407]).
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1.9.3 Excluding Objects and Properties from a Compare or
Merge

You can control what types of objects will appear in the comparison or merge window along with the attributes and
collections to compare for them through the Comparison Options dialog. By default, all objects and properties are
selected.

Context

1 Note

When merging models, differences between the two models that concern deselected metaclasses, attributes,
or collections are disregarded, and will not be merged.

Procedure

1. Click the Options button in the Select Models to Compare/Merge or the Compare/Merge Models window.

The Comparison Options dialog lists Metaclasses in the left pane, and the Attributes and Collections of the
selected metaclass in the two right panes.

2. To exclude an attribute or collection from comparison, click on the name of the metaclass in the left pane and
then deselect the appropriate check boxes in the right panes.

1 Note

For collections that can be reordered (for example, Associated Business Rules, or Columns in a PDM table),
changes in the order of members of the collection are considered, by default, as differences. To ignore such
changes, deselect the checkbox in the [O]rdered column.

For example, to exclude the Number ID attribute and Correlation Keys collection under the Process
metaclass from comparison, click on the Process metaclass name, and then deselect the relevant check
boxes:
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B | Comparison Options
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Set Az Default I ()4 I [ Cancel ] [ Help ]

Metaclasses with one or more attributes or collections deselected have their check box greyed.

To exclude the same attribute or collection from every metaclass where it appears, right click it and select

Deselect for All Metaclasses.

You can select multiple metaclasses at once using the CTRL or SHIFT keys, in which case only the attributes
and collections available under all the selected metaclasses are displayed in the right panes.

1 Note

To exclude all the properties (attributes and collections) of a metaclass from comparison, deselect its check
box in the Metaclasses list. Doing so will only exclude any changes in properties from comparison, but will
not exclude the metaclass itself and will leave any creations or deletions to be detected.

3. To exclude a metaclass from comparison (both modifications of properties and creations and deletions), click
on the model metaclass name, and then deselect the check box of the appropriate collection.

For example, in a BPM, to exclude the Data, Data Formats, andData Items collections from comparison,

click onthe Business Process Model metaclass, and then deselect these collections:
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To ensure that these metaclasses will not be considered, even if objects appear under a package, right-click

each collection and select Deselect for All Metaclasses.

4. [optional] Click the Set as Default button to save your exclusions as the default for future comparisons or
merges for this type of model.

5. Click OK to return to your comparison or merge dialog.

1.9.4 Filtering Objects and Changes During a Compare or

Merge

Click the arrow next to the Filter tool in the Compare or Merge window to select a filter to apply to the object trees
and display only certain types of changes, conflicts or, any combination thereof.

The following filters are available:

e All Objects - [default] Remove all filters.

e All Changes - Show only objects that have some difference.

e Only Created Objects - Show only objects that will be created during a merge (or that are absent from Model 2

in a comparison).

® Only Deleted Objects - Show only objects that will be deleted during a merge (or that are absent from Model 1

in a comparison).

e Only Modified Objects - Show only objects that have differences between attribute values

® Only Moved Objects - Show only objects that have moved in a collection or to another package or parent. In the
Advanced Filters dialog, you can distinguish between:
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o Show Moved Objects (Parent Change) - When moving to a new parent, package, or collection

o Show Changes of Position with Collection - When remaining in the same parent, package, or collection. For
example, when you change the order of attributes within the same entity.

® Only Identical Objects - Show only objects that have no changes.
® Only Selected Objects - [merge only] Show only objects that have merge actions selected.

® Only Conflicts - [repository and generation merge only] Show only objects that have conflicting modifications
in both models A merge conflict occurs when the same object has been modified differently in the origin and
generated model or the local and Repository model.

e Hide All Preservations - [generation merge only] Show only changes made in the origin model since the last
generation.

® Advanced Filters — Opens the Comparison Filters dialog, which allows you to combine several filters

1.9.5 Repairing or Breaking Links Between Objects

Sometimes, when an object has been renamed or modified outside PowerDesigner, its link with the corresponding
object in another model may be lost, and the two objects are shown independently, with a creation and a
suppression in each model tree. You can manually repair the link between the objects or, in rare cases, break a link
between objects that you do not want to compare or merge.

Select the item for which you want to repair or break the link, click the Manually Synchronize Two Objects tool, and
select the object with which to pair it in the From or To box as appropriate.

For example, if the Activities entity in your model needs to be link to the Activity entity in the other model:

Problem ’ Solution

Ea Activities Manual Synchronization E
From
Parent;: | Project Managemert (COM) v]
Object: Activity v]
To
Parent: & Project Management {COM) - New V.~
Object: | [ Activities -
l Ok I l Cancel I l Help ]
1 Note

To break a comparison link, select an object that is linked to an object in the other model, click the tool, and
select None in the other field.
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1.9.6 Previewing, Printing, and Saving Comparison Results

You can preview, save, and export the results of the comparison by clicking the Compare Preview tool to launch the
Compare Preview window.

This window provides three formats viewing the comparison results on the following tabs:

e Comparison Text — a textual representation of the differences between the models. This is the most exhaustive
format, and provides complete information about the whole object tree. Select the Show Legend and/or Show
Model Identification options to display additional information at the beginning of the text.

Compare Preview

Comparisan Text | Actions Description | List |

= [T Show Legend

[T Show Model |dentification

=10 x|

Usze Filter (&l Changes] W

[-+]«<Clas=s symbol: publication
Claz=e=:

[1]«Cla==> group
Attributes:
[#]<Attributer name
¢Data Typ=e: int String
<WSDL Data Type: ==d:int
[#]<Attributer location
¢Data Type: int String
<WSDL Data Type: ==d:int
[-+]«<«Cla==> publication
Attributes:

[-—+]<Attribute:r published_on

[-+]<Attribute: editor
[1]<Cla==> u=ser
Attributes:
[#]<Attribute: first_name
¢Data Typ=e: int char

LTTETT . T 1

=

E=d:=tring

¥=d =tring

IS |
LIJ

e Actions Description — a list of the actions that would need to be taken to render the models the same. This will
often be the most readable format as it represents each change in the form of a sentence:
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Compare Preview |

Comparizon Text  Actions Description | List I

=

=101 %]

Use Filter (&l Changes] W

Modify Attribute "email" in the Class

< |

Delete Attribute "published on" in the Class "publicatiun":J
Delete Attribute "editor" in the Clas=s "publication”
Delete Class "publication” in the Object-Oriented Model “CE
Delete Genseralization "Generalization_4" in the Object-Oric
Delete Class symbol "publication" in the Class Diagram "par
Delete Genseralization s=ymbol "Generalization_4" in the Cla:
Modify Attribute "name" in the Class "group" (Data Type., Wt
Modifvy Attribute "location” in the Class "group” (Data Twvpe
Modify Attribute "first_nam=" in the Clas=s "user" (Data Ty
Modify Attribute "last_name" in the Class "user" (Data Tvpe
Modifvy Attribute "username" in the Class "u=zer" (NHame. Dat:
Modify Attribute "password" in the Class "user" (Data Type.

Modify Object—Oriented Model "CEMZ" (Hame. Code. Model Opt:
Mowve Generalization_1l to collection Svmbols of pages
Mowe Generalization_3 to collection Symbolz of pages

"uzer" (Data Type. WS

Cloze

List — a columnar representation of the required actions. This format is the most easily manipulated. You can
sort by any of the columns, and export the list in a variety of formats to allow for various kinds of

transformation:

PUBLIC
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_i5lx

. Usze Filter (&l Changes] W
Comparizon Te:-:tl Actions Description  List | [ ges]

=

Achion... | Farent | Type | Object | Property | Qld*a... | MHewy. . | -
Delete pages Gener.. Gener.. SWSDL... szdint wad: s

Delete pages Gener.. Gener.. DataT... int String

Delete pages Clazz ... publica... Auto b,

Delete CRMZ Gener... [Gener.. Lizt Po...

Delete CRiZ Clazs publica... Symbolz  Gener.. 3

Delete public...  Attribute  editor Symbolz  Gener... 1

Delete public...  Attnbute  publish...  Model.. [Model.. [Model..

Delete public...  Atribute  publizh.. Code CRk CRMZ

Delete public...  Atribute  publizh...  Mame CR CRM2

b dify Object... CRMZ WSDL. .. sadint char

b odify Object... CRMZ DataT... int char b
b adify Lizer Attribute  email WSOL. ..  wadint char

b dify LIZEr Attribute  email DataT... int char

b dify LIZET Attribute  email M ame LUZEI_N.. Uzerna...

b odify Lizer Attrbute pazsw..  WSDL... wxsdint char

b adify Lizer Attrbute  pagaw..  DataT... int char

b dify LIZEr Attribute wzema.. WSDL...  szdint char ll

Cloze

The following tools are available on each of the tabs:

Tool Description

Use Filter Filters the changes using the filter specified in the main window (see Filtering Objects and Changes
During a Compare or Merge [page 405]). If no filter has been specified before the preview is
launched, then this option is not visible.

Print

e

-

Save - Saves the comparison in text format for Comparison Text and Actions Description , and in
XML, CSV, RTF, or HTML format for List.
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The following columns appear on the List tab:

Column Description
Action Type Specifies the type of action to perform. Can be any of the following:
e (Create — creates an object
® Delete — deletes an object
e Modify — modifies an object
e Move Object — moves an object to a new parent
e CollInsert —inserts an object into a collection
e Col Remove — removes an object from a collection
e Col Move — moves an object from one position to another within a collection
Parent Specifies the parent of the object to be changed (the original parent, in the case of an object that will be
moved). For example, a class for an operation, or a diagram for a symbol.
Type Specifies the type of the object to be changed
Object Specifies the name of the object to be changed
Property Specifies the object property or collection to be changed. Empty for a Create, Delete, or Move Object ac-
tion.
Old Value Specifies the original value of the property to be changed. Empty in the case of a Create or Col Insert
New Value Specifies the updated value of the property. Empty in the case of a Delete or Col Remove.

For example, changing the datatype of attribute MyVariable from int to long would yield the following column
entries:

Action Type Parent Type Object Property O0Old Value New Value
Modify MyClass Attribute MyVariable DataType int long

1.10 The PowerDesigner Plugin for Eclipse

During your installation of PowerDesigner, you can choose to install a plugin to allow you to use PowerDesigner
within your Eclipse environment. The PowerDesigner plugin for Eclipse is available for Eclipse v3.2 to v4.3.

The PowerDesigner plugin for Eclipse has the following limitations:

410

You cannot use the Copy/Paste/Rename features available in the Eclipse contextual menu for PowerDesigner
resources.

In the standalone PowerDesigner application, you can modify the source code of a class or interface from its
property sheet Preview tab. This feature is not available in the plugin for Eclipse.

You cannot export an Eclipse project containing PowerDesigner resources. If you want to export a project, you
must deselect any PowerDesigner resources on the File system page of the Export wizard or the export will fail.
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1.10.1 Activating the PowerDesigner Perspective

Click the title bar of a view to make it active. (The title bar turns blue). The name of the active perspective is shown
in the title bar of the window and its icon is pushed-in in the shortcut bar. We recommend you use the
PowerDesigner perspective.

Procedure

1. Click the Open a Perspective icon in the shortcut bar and select Other, or select |[» Window » Open Perspective

Other ., to open the Select Perspective dialog box:

£ Select Perspective |

Eﬁi CwS Fepository Exploring |
ﬁ Debug

gf.]ava

E,JJava Brovezing

'E:JJava Type Hierarchy

ﬁa" Enterprize Modeling

|-?_‘| Resource [default)
5':' Tearn Synchronizing

Ok, I Cancel

2. Select PowerDesigner in the list of perspectives, and then click OK to display the PowerDesigner perspective in
the workbench window. The PowerDesigner perspective contains the following components:

o Model Explorer — Equivalent to the standard PowerDesigner Browser. Allows you to manage the objects
you use to perform a modeling task. It displays your models and the objects belonging to them in a tree
view, and allows you to rapidly navigate between them. The Model Explorer also has a tab that gives you
access to a PowerDesigner repository, where you can store all your models and associated files.

o Navigator - displays a tree view of all the resource files attached to Eclipse projects open in the workbench
window. These resource files can be model files, diagram files, source code files, specification files, or any
type of file. You can use the Navigator to open models, create new projects and models, or even open
object property sheets.

Core Features Guide
Modeling with PowerDesigner PUBLIC 411



o Editor Area — Equivalent to the standard PowerDesigner canvas. The primary pane that displays your
present model diagram or report outline.

o Modeling Output - shows the progress of any PowerDesigner process, such as checking a model or
generating or reverse engineering a database.

o Modeling Result List - displays the results of a search or a model check.

Results

1 Note

Once you have activated the PowerDesigner perspective, an icon to switch to it is displayed in the shortcut bar.
You can use the Window menu to open, customize, and reset this and other perspectives.

1.10.1.1 Manually Activating PowerDesigner Toolbars

Specific toolbars are available in the PowerDesigner perspective. If they do not appear, you can activate them
manually.

Procedure

1. Select| Window » Customize Perspective J or right-click the toolbar section and select Customnize
Perspective in the contextual menu, to open the Customize Perspective dialog box.

2. Select the Shortcuts tab, and:

o Select New in the Submenus list, then select PowerDesigner in the Shortcut Categories list, and select
Model and Modeling Project in the Shortcuts list.

o Select Open Perspective inthe Submenus list, and select PowerDesigner in the Shortcuts list.

o Select show View inthe Submenus list, then select PowerDesigner in the Shortcut Categories list, and
select Model Explorer,Modeling Output,Modeling Result List, and Tool Paletteinthe
Shortcuts list.

3. Select the Toolbar Visibility tab, and select PowerDesigner Diagram, PowerDesigner Standardand
PowerDesigner View inthe Tool Bar Structure list.

4. Click OK.

The PowerDesigner toolbars that are common to all PowerDesigner modules appear. Additional, module-
specific toolbars will appear automatically when you open or create a model.
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1.10.1.2 Setting PowerDesigner Eclipse Preferences

The PowerDesigner plugin for Eclipse provides options to customize your environment.

Context

Procedure

1. InEclipse, select | Window # Preferences 3 to open the Preferences dialog.

2. Select|p PowerDesigner 3 and set preferences as appropriate:

Preference Description
Close diagram editors on exit By default, when you restart Eclipse, any diagrams that were previously open
will be automatically reloaded. Select this option to prevent reloading.

Flag diagram editor as dirty if parent Select this option if you want to be reminded that a model has been modified
model requires save before you save the changes.
Automatically merge models on code-to- | Select this option if you want the merge process to be silent during reverse en-
model synchronization gineering.

3. Click OK.

For information about the standard PowerDesigner options and preferences, see Customizing Your Modeling
Environment [page 422].

1.10.2 Creating a Modeling Project in Eclipse

You can create a modeling project in Eclipse to group together all your models and other resources.

Procedure

1. Select|p File » New }» Project Jto open the New Project window:

2. Select|p PowerDesigner » Modeling Project 3 in the list of Wizards and click Next to open the PowerDesigner
New Project window.
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3. Specify the project name and location, and select the type of PowerDesigner project to create. PowerDesigner
project templates allow you to create projects that are already populated with models and/or that contain
matrices that help you to follow various modeling frameworks, such as FEAF.

4. Click OK to create the project.

Results

For detailed information about working with projects, see Projects and Frameworks [page 47].

1.10.3 Creating a Model in Eclipse

A model is the basic work unit in PowerDesigner. Every model is contained within a project, and contains at least
one diagram and any number of other objects. Though a model may be split into packages for organizational
reasons or may contain several diagrams, it remains the fundamental basis for your modeling work.

Procedure

1. Select|p File » New » Model Jto open the New Model dialog box.

2. Select a model type and specify whether you want to create an empty model or one based on a template, then
click Next to go to the Destination Container page.

3. Select a project or project folder in which to create the model. Use the buttons to create a project (see
Creating a Modeling Project in Eclipse [page 413]) or folder if necessary, and then click Next to go to the Model
Definitions page.

4. Enter a name for your model and (for BPM, PDM, OOM, and XSM) select the target of the model. Depending
on the type of model, you may also need to specify the first diagram to create.

5. Click Next to go to the Extensions page, and select any extension files that you want to attach to the new
model.

6. Click Finish to create the model in your project in the Model Explorer, and open its default diagram in the editor
area.
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1.10.4 Importing an Existing Model into Eclipse

To open an existing model you have to import it into Eclipse.

Procedure

1. Select|p File » Import Jto open the Import dialog box.
2. Select Model in the list and click Next.

3. Type a model filename in the corresponding box or click the Browse button to select a model from a selection
dialog box.

4. Select the Create a linked resource check box if you want to associate the model to the current project without
copying the file to the project location.

5. Select an existing project or create a new project where to open the existing model and click Finish.

The model default diagram is displayed in the Editor area.

1.10.5 Generating an Eclipse Java Project from an OOM

You can model the structure of your Java application (including EJBs, Servlets, and JSPs) in a PowerDesigner OOM
and then generate an Eclipse Java Project in which you will complete the implementation of the classes, and from
which you will compile, package, deploy, and debug the application.

Context

You can use the PowerDesigner plugin for Eclipse to enable round-trip engineering for Java development:

e Perform high level analysis and design using PowerDesigner
® Design and create Java components in PowerDesigner
e Generate an Eclipse Java project containing the following files:
o A .project file - that defines the name of the project and the build commands
o A .classpath file - that defines the source directory, the binary directory and the list of libraries
o Source files and other files
© Abuild.xml for Ant build script - to specify the necessary build tasks and libraries.
e Finish the implementation of Java classes within the generated Eclipse project
e Compile, package, deploy and debug the application
® Reverse engineer the final Java code to synchronize the PowerDesigner model
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Procedure

1. Select | Tools » General Options 7 and click the Variables category, then add the following variables if they
are not already present:

© ECLIPSE HOME - your Eclipse home directory
© J2EE_HOME - your J2EE SDK home directory
o JWSDP_HOME - [optional] your Java Web Service Developer Pack home directory

2. [optional] Preview the Eclipse .project, .classpath and Antbuild.xml files by right-clicking the model
node in the Browser and selecting Properties. Each of the files is available on its own sub-tab on the Preview
tab of the property sheet.

3. Select | Language #» Generate Java Code Jto open the Generation dialog.

4. Enter the project folder where you want to generate the files in the Directory field. The name of this folder will
be used as the project name.

5. Verify that Eclipse is selected on the Targets tab.

6. [optional] Click the Selection tab and specify the packages, classes and interfaces that you want to generate.
By default, all objects are generated.

7. Click the Options tab and review the generation options, including those that control the Eclipse version to
generate for and whether to overwrite existing .project and .classpath files.

8. [optional] Click the Generated Files tab and specify which files will be generated. By default, all files are
generated

9. Click OK to generate the Eclipse Java project.
If you are generating a new project from the PowerDesigner plugin for Eclipse, the project opens automatically.

When generating code for an existing project, you must refresh the project by right-clicking the project in the
Eclipse Package Explorer and selecting Refresh.

If you have generated the Eclipse project from outside Eclipse, you will need to import the project into Eclipse
by selecting | File » Import 3.

1.10.6 Synchronizing an OOM with Its Java Source

You can synchronize an Object Oriented Model (OOM) with its Java source code, so that each time you modify the
model, a source code file is automatically created or updated, and when you modify and save a source code file,
the changes appear in the model. Synchronization is only available for Java OOMs.

Context

You can activate synchronization from the Model Explorer or Navigator. A model is synchronized per package.

1 Note

You can only synchronize each package with one set of source files and each set of source files with one
package. If you try to synchronize a second model with a package, its check box is unavailable.
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Procedure

1. Inthe Model Explorer, right-click the model and select Synchronize, then select the Synchronized check box:

£ Synchronize

Synchronize

kodify the synchronization zettings of a PowerD ezigher model

¥ Sunchronized

- O -Ha- [default package) Select Al |

........ O -Ha- Peripheral_Package Deselect Al

Finizh I Cancel

1 Note
You can, alternatively, enable synchronization from the Navigator by right-clicking the model, selecting
Properties, selecting PowerDesigner in the left pane and the Synchronized check box in the PowerDesigner
page.

2. Select the packages you want to synchronize with their source code. The default package regroups all the
objects at the root of the model.

3. Click Finish.

In the Navigator, the model bears a synchronized label, each synchronized package bears a synchronized
symbol overlay, and a Java file (. java) and compiled file (. class) appear for each synchronized object:
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[EEEEEERD, i

NSRS
E% Perpheral_Package
----- Jul_?,, parallelPenpheral class
----- m parallelPenpheral java
----- Jul_?,, peripheral_tester.class
----- m peripheral_tester.java
----- Jul_?,, Peripheral.class
----- [J] Peripheral java
----- Jul_?,, Perzistent_computer.class
----- m Perzistent_computer.java
----- Jul_?,, printer. class
----- [J] prirter.java
----- Jul_?,, scannerclass
----- m FCanner.|ava
----- |=| .clazzpath
----- |=| .project
----- Eﬂ High level diagram.cld
----- % Object Model. oom- [gynchronized]

You can double-click a Java or compiled file, to display its source code in the Editor view.

1.10.6.1 Example: Modifying Attributes in a Synchronized
Model

This example is developed from the example synchronized OOM, demo . oom, and demonstrates the creation and
deletion of attributes in a synchronized model.

Context

1 Note

If you change generation templates, you can regenerate source code manually by right-clicking a class,
interface, synchronized package, or model, in the Model Explorer or in a class diagram, and selecting Refresh
Source Code.

Procedure

1. Open the property sheet of the printer class, click the Attributes tab, and add a usbPort attribute with a
boolean data type and public visibility.
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[=] Clazz Propertiez - printer [printer]

Motes I Rulez | Related Diagrams I Estended Attributes I Dependencies I Eustended Dependencies I Yerzion [nfo
General I Detal  Attributes

a0l 2R X A T

| |dentifiers I O perations I Agznciations I Inner Clazzifiers I Seript I F'reviewl k apping

I arne Code Data Type Dromair Yizibiliby [mitial Yalue | D=
1 lager lazer boolean <Mones public [V
2 prints peed prints peed ik <Mones public [V
= |uzbPort LzbPort boolzan <Mones public =] [V
T[] 4]4]2]4] I o
Inkerited. .. | Add accessors
Ok I Cancel | Apply Help |

A -

2. Click OK to return to the class diagram, where the usbPort attribute is displayed in the printer symbol:

printar

laser :
printSpeed
usbPort :

rint

boalean

baalean

+[+ + +

printPage (0

waid

3. Right-click the printer symbol or the printer item in the Model Explorer and select

open the source code file of the printer class in a pane directly under the diagram:
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/ i .

peripheral tester prin-ter
+ test# s int ' ' + laser :boolean
+ testMame : String : : + printSpeed :int
+ testhate : jawa.util.Date ) ) Wy uzbPort :boolean W
+ printRepot Q) woid + printPage ) :woid
[ 5 - |

|

packayge Peripheral Package:

import Java.util.*:

JEF [Apdoid dE9de951-51d1-1145-ad3a-0008c752defs +/
“pubhlic class printer extends parallelPeripheral

{
duw Qpddid d89de93a-581d1-11d5-adS8a-0008c752dota +/f
public boolean las=er:
dF Qpddid d89d693k-81d1-11d5-ad8a-0008c752deta +/
public int printSpeed:;
A% Qpddid 59385e5d-3ad45-4a11-9017-2Z20fh£3216801 */
public boolean ushFPort;

Note that the usbPort attribute is displayed in the synchronized source code.

Delete the code concerning the usbPort attribute.

package Peripheral Package:

import java.util.*:

A% Apdoid d89d6951-81d1-11d5-ad8s-00082752defs */f
wpublic class printer extends parallelPeripheral

{

Jrw [Bpdoid dE9de93a-581dl-11d5-adda-0008c752defs +/
public hoolean laser:

Fuw [@pdoid d89de93ib-581d1l-11d5-adda-0008c752defs #/
public int printSpeed:

Select|j» File » Save i inthe Eclipse menu bar.

The usbPort attribute disappears from the printer symbol because the printer class in the OOM has been
synchronized with its source code.
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printar

+ laser cboolean
+ printSpeed :int

+ printFage ) :woid

1.10.6.2 Deactivating Synchronization

If you decide to deactivate synchronization, the model and its source code remain as they were after the last
synchronization.

Context

You can deactivate synchronization:

e |nthe Model Explorer, by right-clicking the model and selecting Synchronize, unselecting Synchronized, and
clicking Finish.

e |nthe Navigator, by right-clicking the model and selecting Properties, unselecting Synchronized in the
PowerDesigner page, and clicking OK.

e |nthe Navigator, right-clicking a synchronized package and selecting Unsynchronize.

1.10.6.3 Navigating Between an OOM and Its Java Source Code

Once you have synchronized an OOM with its Java source code, you can find its diagram symbols and open its
property sheet from the Model Explorer, the Navigator, or source code files.

To locate an object symbol in a diagram:

e nthe Navigator, right-click an object Java file and select | Find In Diagram 3.
e |n QOutline view, select an object to automatically find in diagram.

1 Note
To open the Outline view, select [ Window » Show View ¥ Outline 3.
e Double-click the name of an object in a source code file in order to select it, then right-click the object name
and select | Find In Diagram 4.

To open an object property sheet:

e |nthe Navigator, right-click an object Java file and select Model Object Properties.
e Double-click the name of an object in a source code file in order to select it, then right-click the object name

and select | Model Object Properties 3.
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1.11 Customizing Your Modeling Environment

PowerDesigner is highly customizable. You can modify its interface to suit your work habits, set default naming
conventions, change the appearance of object symbols, add new properties to objects, and even create your own
types of objects.

1 Note

Administrators can prepare customizations to the PowerDesigner interface and push them to users (see
Customizing the PowerDesigner Interface [page 591]).

1.11.1 User Profiles

User profiles help you to standardize the look and feel of your models and to support standards by making groups
of options and preferences portable for sharing and reuse across your organization. Various user profiles are
provided with PowerDesigner, and you can create your own.

Various kinds of PowerDesigner options and preferences are stored in your model files and/or in your Windows
registry. User profiles can contain default values for:

e Display Preferences — [model or registry] to control the color, shape, size, etc. of your diagram symbols and
the information that is displayed upon them (see Display Preferences [page 227]).

e Model Options — [model only] to control naming conventions (see Naming Conventions [page 155]), case
sensitivity, notation, default values, etc (see the appropriate modeling guide).

e General Options — [registry only] to control dialog preferences, environment variables, fonts, etc (see General
Options [page 429]).

e (Other options — [registry only] such as the layout of toolbars and windows (see Organizing Views [page 443]),
favorite property tabs (see Customizing a Property Sheet [page 109]), default columns for object lists (see
Customizing Object List Columns and Filtering Lists [page 124]), etc.

User profiles are commonly used by an administrator to standardize and simplify the PowerDesigner interface, and
are delivered automatically through the repository (see Controlling Defaults for Options and Preferences [page
604)).

Caution

We discourage the delivery of user profiles via a shared network drive, which can cause PowerDesigner to
become unresponsive if the connection to the shared drive is lost.

To view the list of user profiles, select |» Tools » Resources » User Profiles . For information about the tools
available in resource file lists, see PowerDesigner Resource Files [page 449].

User profiles can contain any number of default preferences and options, the application of which is cumulative.
Thus, if you apply a user profile that contains display preferences specifying that PDM table symbols are by default
red, and view symbols blue, and then apply a second user profile that sets tables by default to green, then table
symbols will be green, and view symbols blue. You can, of course, override these default preferences and options
locally in the model.
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1.11.1.1 Applying a User Profile

You can apply a user profile at any time. The defaults, preferences, and options contained within the profile will
overwrite the existing values for those defaults, preferences and options, while leaving all others unchanged. Note

that while general options take effect immediately, model options and display preferences only take effect when
you create a new model.

Context

1 Note

To return to a default user profile prepared for you by an administrator(see Controlling Defaults for Options and
Preferences [page 604]), select the General Preferences entry inthe Personal Profiles category. To return to
your default Ul profile, select the UI Preferences entry.

Procedure

1. Select|l Tools ¥ Apply User Profile  to open the Apply User Profile dialog:

Apply User Profile = @

Uzer Profile: Change zer Profile Directory Q

D escrption
EI--- Personal Profiles o P

----- @ Ul Preferences

----- @ General Preferences

E—:I General

----- #= Authorize Framewaorke Design
----- #= Mo shorcut property sheet
E—:I Diigplay Preferences

----- @ Cold Theme

----- @ Hot Theme

----- # Rounded comers

=-[E Notation

----- @ CDM - Barker Motation

----- #= CDM - EXR Motation

----- #= CDM - IDEF1X Motation

----- @ CDM - Merise Motation b

m

] ] [ Cancel

2. [optional] Click the Change User Profile Directory button, and browse to a folder where you have saved user
profiles. By default they are saved inthe <install dir>/Resource Files/Profiles directory.
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3. Select a profile from the list and click OK.

The user profile is applied, and overwrites the defaults, preferences, and options contained within it with the
values it defines.

1.11.1.2 Creating a User Profile

You can create a user profile by copying an existing profile, or by copying values from an open model or from your
registry.

Procedure

1. Select|r Tools ¥ Resources # User Profiles 3 to open the List of User Profiles:

FOEHP O|x PP &

Authorize Framework Design E
COM - Barker MNotation THl
CDM - E/R Motation

CDM - IDEF1X Notation
CDM - Merige Motation

Cold Theme (blue, pumple...)
Hot Theme (brown, orange...)
LOM - Barker Matation

LOM - E/R Motation

LDM - IDEF1X Motation

Mo shortout property sheet
FOM - Codasyl Motation P
POM - Conceptual Motation

PDM - IDEF1X Motation B

| E—E— [ Help ]

The following tools are available above the list:

Tool Description
|ﬁ| Properties — opens the selected profile in the resource editor.

New — creates a new profile.

=]

Save — saves the selected profile.
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Tool Description

|E| Save All — saves all the profiles.

|@| Path — Specifies a directory from which to populate the list.

|§| Compare — Opens the Compare window to compare the structure of two profiles.

|@| Merge — Updates the selected profile by merging preferences from another profile, a model, or the registry
(see Updating a User Profile [page 426]).

|g| Check In - [if the repository is installed] Checks the selected resource file into the repository. For information
about storing your resource files in the repository, see Sharing Resource Files via the Library [page 588].

|§| Update from Repository - [if the repository is installed] Checks out a version of the selected file from the repo-
sitory to your local machine.

|§| Compare with Repository - [if the repository is installed] Compares the selected file with a resource file stored
in the repository.

|ﬁ| Apply to Registry — Applies the selected profile to your registry, overwriting your previous defaults and prefer-
ences. This has the same effect as selecting |} Tools > Apply User Profile ] (see Applying a User Profile [page
423)).

2. Click New to open the New User Profile dialog:

New User Profile x|

Mame: IEDrpnrate Il

Copu frorm; I Corporate j

| ] 4 I Cancel |

3. Enter a name for your profile and select a source from which to copy from. You can choose between:

o Another user profile — makes a copy of the existing profile.
o <Registry> - copies all your PowerDesigner defaults from your Windows registry.

o <Model> - opens the Model for User Profile dialog which allows you to specify the preferences to copy
from an open model (see Copying Preferences from a Model [page 426]).

4. Specify a name and a location to create the profile and click Save.

The user profile is created and opened for review in the resource editor.
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1.11.1.3 Updating a User Profile

You can update a user profile by copying values from an existing profile, from an open model, or from the registry.

Procedure

1. Select | Tools ¥ Resources ¥ User Profiles Jto open the List of User Profiles, select the profile to update and
click the Merge tool to open the Select User profiles to Merge dialog.

2. Inthe From field, select a source from which to copy from. You can choose between:

o Another user profile

o  <Registry> - copies all your PowerDesigner defaults from your Windows registry. Note that model check
options and generation options are not stored in the registry and can only be extracted from a model or
another user profile.

o <Model> - opens the Model for User Profile dialog which allows you to specify the preferences to copy
from an open model (see Copying Preferences from a Model [page 426]). Note that general options, and
options relating to the PowerDesigner interface (such as toolbar and window layout, favorite property
sheet pages and grid layouts) are not stored in models and can only be extracted from the registry or
another user profile.

3. Click OK to open the Merge window, which lets you review and approve each proposed change before
committing it. For detailed information about using this window, see Comparing and Merging Models [page
395].

4. When you are satisfied, click OK to update the profile and return to the list.

1.11.1.4 Copying Preferences from a Model

You can create or update a user profile by copying preferences from a model.
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Select which model open in the Workspace to copy from and then select which of the following options and
preferences to capture:

e Model Options

e Generation, and other options.

e Diagram Display Preferences - Select the diagrams to copy preferences from in the tree. To avoid conflicts, you
can only select one instance of each diagram type.

1.11.1.5 Reviewing and Editing User Profiles in the Resource
Editor

You can open any user profile in the Resource Editor to review and edit it. Since the registry key names and values
are not necessarily easy to read, we recommend that you restrict your edits in this environment to deleting
unwanted defaults. You can always make additions or adjustments to the values of user profiles by extracting them
from models or other profiles.

In the following example, the Corporate user profile contains display preferences for CDMs, LDMs, and PDMs,
along with a general option and some model options:
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To delete an item, simply right-click it and select Remove.
The profile root node has the following properties:

Property Description

Name/Code Specifies the name and code (used for scripting) for the profile.

File name [read-only] Specifies the path to the profile file.

Family Specifies the family in which the profile will appear in the Apply User Profile window (see Applying a User
Profile [page 423]) and if it is added to the PowerDesigner installer image. If no value is entered, the pro-
file is added to the General family.

Subfamily Specifies a subfamily within the profile family.

428 PUBLIC

Core Features Guide
Modeling with PowerDesigner



1.11.1.6 Making Custom User Profiles Available in the
PowerDesigner Installer

Once you have developed your own user profiles, you may want to add them to your PowerDesigner install image in
order to allow your users to install them when they install PowerDesigner.

The user profiles that are installed with PowerDesigner are stored in the following directory on the first install CD:

Setup/User Profiles

To include your profiles in the install, simply copy them to this directory in your install image.

For information about installing PowerDesigner, see Installation Guide > Installing PowerDesigner .

1.11.2 General Options

You can control the look and behavior of the PowerDesigner interface through the general options, the values for
which are saved in the registry of your local machine.

To set general options, select |+ Tools # General Options 3. The following options are available under the General

category:

Option Description

Autosave Save recovery backup file every <x> minutes - Instructs PowerDesigner to save changes to all open
models to a recovery backup file at the specified interval. Enabling this option provides you with a
recovery option if PowerDesigner or your computer crash before you have had a chance to save
your changes.

The save will take place after the interval has passed, but only when PowerDesigner is idle for more
than ten seconds. Note that saving large or multiple models may take several seconds, and that
PowerDesigner will not be responsive while it is performing the save.

In the event that your modeling session exits abnormally, when next you open PowerDesigner you
will be invited to restore your unsaved models. You can choose:

® Yes -to open the recovered models in the Browser allowing you to review and save or delete
them as necessary.

® No - toreject the recovered models and return your Browser to its last saved state.

1 Note

This option is not supported for the PowerDesigner plugin for Eclipse.
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Option Description

Delete Confirm object deletion - Controls the display of a confirmation dialog box when you delete an ob-
ject. If you disable this option, the confirmation dialog will no longer be shown and the default be-
havior is as follows:

® Deleting an object symbol - the symbol only is deleted.
e Deleting an object in the browser - the object, any sub-objects it contains, and any associated

diagram symbols are deleted.

You can delete any object without confirmation at any time by selecting its symbol in a diagram
and pressing|shift| + |Delete].

For more information, see Deleting Objects [page 106].

Startup Auto-reload last workspace - Opens the last-edited workspace when you launch PowerDesigner. If
this option is unchecked, PowerDesigner will open with an empty workspace.

Show welcome page - Displays the Welcome Page when starting PowerDesigner. If you select the
Do not show this page again check box in the Welcome page, this option is deselected.

Browser Drag and drop: Default action - Specify the default result of dragging and dropping an object (with-
out any modifier key) in the Browser. You can choose from the following:

e Move () — The object is displaced to the new location (parent object, package, model,
etc).
e Copy () — A copy of the object is created in the new location.

e (Create Shortcut ( + ) — A shortcut to the object (see Creating Shortcuts [page

487]) is created in the new location.

e (reate replica ( + ) — Areplica of the object (see Creating Replicas [page 492])

is created in the new location.
The modifier keys given after the option are valid no matter what the default behavior.

Show shortcuts - Specifies that shortcuts are displayed in the Browser.

Output log Log path - Specifies the path to the log file where PowerDesigner records all of its outputs.

Graphical tool behavior Edit in place after creation - Allows you to directly modify the name of an object from the object
symbol in the diagram without opening its property sheet whenever you create an object with the
Toolbox.

Sort Sort object categories alphabetically - Lists object categories in the browser and Model menu al-
phabetically. By default, object categories are ordered by importance with core objects (such as
PDM tables, CDM entities, and OOM classes) listed first.

Sort object names naturally - Treats numbers numerically when sorting objects in the Browser. For
example, a naturally sorted list of tables would have the order: Table_1, Table_3, Table_12, Ta-
ble_20.
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1.11.2.1 Dialog Box Options

To review and edit options that control the look and behavior of dialog boxes, select | Tools  General Options 3,
and click the Dialog category in the left pane.

The following options are available:

Operating Modes

Description

Auto Commit Specifies that any change made in a property sheet is automatically committed in the object defini-
tion. You can cancel a change by pressing using the Undo feature.

If this option is disabled, you must click Apply or OK to commit your changes.

Property Sheets

In PowerDesigner, property sheets appear by default with a certain size and a series of tabs in the upper part of the
dialog box. The following options are available for property sheets:

Option Description
Keep size Preserves the customized size you have defined
Keep last tab Opens the property sheet to the last selected tab
Open mode Controls how property sheets are opened. You can choose between:
e Open each object in the same property sheet
e Open each object in its own property sheet
Tabs mode Controls the display of tabs. You can choose between:
® Tabs onone row - Aligns all tabs on a single line with arrow buttons < and > for browsing
® Tabs on several rows - Displays tabs on two lines, their size corresponding to the length of their
title.
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Shortcut Property Sheets
The following options are available:

Option Description

Internal Shortcut Controls whether double-clicking an internal shortcut opens the property sheet for the shortcut or
for the target object.

You can switch from one mode to the other by pressing the key while opening the property
sheet. If the target object cannot be found (target model is closed for example), the shortcut prop-
erty sheet automatically opens.

External Shortcut Controls whether double-clicking an external shortcut opens the property sheet for the shortcut or
for the target object.

For more information, see Creating Shortcuts [page 487].

Object Lists

The following options are available:

Option Description

Auto-insert rows Specifies that a new item is created automatically in a list when you click an empty row

Use default name Specifies that new items are given default names upon creation, allowing you to create multiple
new objects without having to supply names or other properties.

Timestamp Template

Specifies the text generated by the Timestamp tool in the Definition tab rich text editor (see Definition Tab [page
112]).

By default, the timestamp contains the following GTL code to generate the date, time, and user name:
*** gCurrentDate% - %CurrentUser% ***\n

For detailed information about working with GTL, see Customizing and Extending PowerDesigner > Customizing
Generation with GTL .

Core Features Guide
432 PUBLIC Modeling with PowerDesigner



1.11.2.2 Text Editors

By default, all files are edited using PowerDesigner's internal editor. To define external editors for editing various
kinds of text, such as object descriptions and annotations or PDM SQL scripts or OOM Java files, select |J» Tools »

General Options 3, and click the Editors category in the left pane.

Context

By default, all files are edited using PowerDesigner's internal editor. You can define an external text editor to launch
automatically for editing various kinds of objects. You can define as many text editors as you need, and the same
file extension can have several text editors allocated, with the first listed acting as the default.

Procedure

Select | Tools » General Options 3 and click the Editors category in the left-hand pane.

2. Click the Insert a Row tool, and enter a file extension (such as .DOC, .RTF, TXT, .XLS) in the Extension column.
The Editor Name and Editor Command columns are both set to <internal> to indicate that the internal
PowerDesigner editor will be used to edit files with this extension.

3. [optional] Enter an editor name (such as MS Word, Notepad, MS Excel) in the Editor Name column, and enter
an editor command (such as winword.exe) in the Editor Command column. You can click the ellipsis button in
this field to browse to the relevant directory.

4. Click OK to close the dialog box.

1.11.2.3 Environment Variables

Environment variables provide access to paths and executables on your workstation for use in generation

commands and GTL templates. To review and edit variables, select | Tools » General Options 3, and click the
Variables category in the left pane.

Click in the row of an existing variable in order to edit its value. To create a new variable, click the Add a Row tool
and specify a name and value. The following variables are defined by default:

Variable Description

CMD Windows command interpreter.
Default: command.com or cmd.exe

HOME Home directory.
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Variable Description

J2EEVERIF Batch program for verifying if the deployment jar for an EJB is correct
Default: verifier.bat

JAR Command for archiving java files
Default: jar.exe

JAVA Command for running JAVA programs
Default: java.exe

JAVAC Command for compiling JAVA source files
Default: javac.exe

JAVADOC Command for defining JAVA doc comments
Default: javadoc.exe

1 Note

To use a variable in GTL (see Customizing and Extending PowerDesigner > Customizing Generation with GTL ),
prefix it with a dollar sign, and wrap it in percent signs. For example, $SCMD%.

1.11.2.4 Named Paths

Named paths allow you to resolve links between models and resource files in different environments. To review and
edit named paths, select |+ Tools » General Options 3, and click the Named Paths category in the left pane.

When you save a PowerDesigner model, project, or workspace, the name of a named path is saved in place of the
actual path, and when you open a file, the named path is replace with the locally defined value . For example, if the
_DBMS named path is defined as C: \DBMS and you have the path C: \DBMS\syase1550.xdb in your model, then
the path will be saved as $DBMS%\syase1550.xdb to allow the model to be opened by another user who stores
their DBMS definition files elsewhere.

To view the existing named paths, select |l Tools » General Options J, and then click the Named Paths category.
To add a new named path, click the Add a Row tool and enter a name and a path for the named path. The multi-

folder named paths are edited by clicking the ellipsis button in the Path column.

1 Note

An administrator may push named paths to users in a general preferences profile (see Controlling Defaults for
Options and Preferences [page 604]).
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The following paths are initialized by default:

Name Path

[XSL] Multi-folder path for storing XML language definition files. Replaces XMLLANG, which is depre-
cated.

[XRL] Multi-folder path for storing report language files. Replaces RTPLANG, which is deprecated.

[XPL] Multi-folder path for storing process language definition files. Replaces PRCSLANG, which is dep-
recated.

[XOL] Multi-folder path for storing object language definition files. Replaces OBJLANG, which is depre-
cated.

[XEM] Multi-folder path for storing extension files. Replaces XEM, which is deprecated.

[XDB] Multi-folder path for storing DBMS definition files. Replaces DBMS, which is deprecated.

[RUL] Multi-folder path for storing impact and lineage rule set files (see Impact and Lineage Analysis
[page 529]). Replaces RULESET, which is deprecated.

_EXAMPLES Folder where demo examples are stored.

_HOME PowerDesigner installation folder. This path facilitates the installation of your add-ins without hav-
ing to modify your XEM or your XML or ActiveX add-ins commands. For example:

% HOMES%$\add-ins\SpellChecker\SpellCheckAddIn.dll

_JSF Folder where JSF libraries are stored.

_LIBRARY Folder where object libraries are stored.

_MODELCATEGORY Folder where model category files are stored (see Model Creation Options [page 442]).

_SHARED Folder where the glossary and library model files are stored (see The Glossary [page 39] and The

Library [page 43]).

_SMARTWINFORM

Folder where smart winform files are stored.

_WINFORM Folder where winform files are stored.

_DBMS [deprecated] Folder where DBMS definition files are stored. This path is now included in [XDB].

_OBJLANG [deprecated] Folder where object language definition files are stored. This path is now included in
[XOL].

_PRCSLANG [deprecated] Folder where process language definition files are stored. This path is now included in
[XPL].

_RTPLANG [deprecated] Folder where report language definition files are stored. This path is now included in
[XRL].

_RULESET [deprecated] Folder where impact and lineage rule set files are stored. This path is now included in

[RUL].

Core Features Guide
Modeling with PowerDesigner

PUBLIC 435



Name Path
_XEM [deprecated] Folder where extension files are stored. This path is now included in [ XEM] .
_XMLLANG [deprecated] Folder where XML language definition files are stored. This path is now included in
[XSL].
1 Note

You should not modify the name of a predefined named path. If you do so, the predefined named path is
preserved in the list and a new path is created with the modified name and value. If you want to cancel a change
to a predefined named path, simply delete it and close the General Options dialog. When you reopen the dialog
the path is recreated with its default value.

If you open a file containing a named path not defined on your machine, a dialog will open, offering you the
following options:

® |gnore the named path and keep the file name unresolved - The link between files is broken and you may have
update problems.

e Define a new named path ... - Allows you to define the path on your machine.

e Browse another existing variable to replace with — Allows you to resolve the path using one of your existing
names paths.

e Directly browse the target file — Allows you to browse for another target file. The selected file will replace the
file you were trying to open

1.11.2.5 Interface Fonts

To review and modify the fonts used in the general user interface, code and rtf editors, and matrices, select [ Tools

» General Options 3, and click the Fonts category in the left pane.

Select the interface element for which you want to modify the font in the Item list, and then select a Font, Font
style, and Size for it.
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1.11.2.6 Repository Options

To review and modify options for connecting to the repository, controlling the Repository Browser tab, and setting

various defaults, select [ Tools » General Options 3, and click the Repository category in the left pane.

Connection

The following options are available in the Connection group box:

Option Description

Auto-connect Automatically connects to the last connected repository when you start a PowerDesigner session
(see Connecting Automatically to the Default Repository [page 22].

Apply profiles Re-applies all Ul preferences profiles and general preferences profiles that are associated with the
user (either directly, or by membership of groups) at each connection to the repository (see Using
Profiles to Control the PowerDesigner Interface [page 598]). This option is selected by default and
may cause local customizations to your interface, options, and preferences to be overwritten.

Default bytes per char Specifies the default number of bytes per character used by the repository database (by default,
2). This value is used to initialize the Bytes per char parameter in the Direct Repository Definition
dialog (see Setting up PowerDesigner for Direct Access [page 17]).

Browser

The following options are available in the Browser group box:

Option Description

Auto-refresh Refreshes the Repository Browser at the interval specified in the Refresh every box.

Display Specifies whether the name or code of items is displayed in the Repository Browser.

Display model contents Enables the display of model diagrams and objects in the Repository Browser.

Display version numbers Enables the display of version numbers for items in the Repository Browser.

Display statusicons in Lo- | Enables the display of status icons (which track whether items are locked and if changes have

cal Browser been made locally and/or in the repository since check out) in the Local Browser (see The
Browser [page 38]).
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Check Out

The following options in the Check Out group box control the default selection of options in the Check Out dialogs
(see Checkout Parameters [page 269]):

Option Description
Merge document Specifies that the Merge document option is selected by default.
Add to workspace Specifies that the Add to workspace option is selected by default.

Check out dependencies Specifies that the Check out dependencies option is selected by default.

Automatic resources up- Enables the automatic checking out and updating of shared resource files.
date
1 Note

This option controls a legacy feature, which has been superceded by the library (see Sharing
Resource Files via the Library [page 588]).

Check In

The following options in the Check In group box control the default selection of options in the Check In dialogs (see
Check-In Parameters [page 251]):

Option Description

Batch update Specifies that the Batch update option is selected by default.

Freeze after check in Specifies that the Freeze after check in option is selected by default.

Save diagrams for Specifies that the Save diagrams for PowerDesigner Portal option is selected by default.
PowerDesigner Portal

Local Cache

The following options in the Local cache group box control the caching of models checked into and out of the
repository on your local workstation. The cache, which is enabled by default, saves a local copy of models you
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check out in the cache directory, and can speed up check ins and check outs when you are primarily working with
models that are rarely modified by other users. The following options are available:

Option Description

Path Specifies the location of the cache.

Maximum size (MB) By default, the maximum size is set to 50MB. Click the Clear Cache button to empty the contents
of the cache.

1.11.2.7 Security Options

Certain PowerDesigner features depend on executing scripts, which can be embedded in model files or located in
resource files attached to models. To reduce the risk posed by malicious scripts, you can instruct PowerDesigner
to notify you when an untrusted script is run, to prompt you for permission to run an untrusted script, or to block
such scripts from running altogether.

To enable the monitoring of scripts, select one of the following settings in the Security level option:

e No Restrictions - Allows scripts in untrusted files to run without notification or warning.

® Run and Notify - Allows scripts in untrusted files to run and displays a notification of their execution in the
Output window.

e Prompt to Run - Requires your confirmation before scripts in untrusted files can run. When you approve
running the script, its file is added to your whitelist of trusted files, and you will not be prompted again for this
file.

1 Note

To remove all files that have been trusted to date from your whitelist, click the Reset Trusted File Whitelist
button.

® Block - Prevents any scripts in untrusted files from running.

PowerDesigner's security policy is based on two concepts:

e Secure locations - Only folders for which write access is restricted to your own user account and administrator
user accounts are considered secure.
When you enable the Security level option, PowerDesigner will review its installation. If any of your named
paths (see Named Paths [page 434]) point to folders with more permissive write permissions, then your
PowerDesigner installation is deemed to be insecure, your local workspace root displays a red shield, and
errors and warnings are written to the Output window.
To secure your installation, review the errors and warnings and change the location of each of the insecure
named path folders (or constrain their permissions) appropriately. If all of your named paths point to secure
folders, your workspace root displays a green shield:
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Insecure Environment Secure Environment

Trusted files - Files can be trusted:

o By default -If they are located in folders for which write access is restricted to administrator user accounts
only. Thus, for example, if you install PowerDesigner, as recommended, under the Program Files folder
then the resource files delivered with it will be trusted by default.

o By adding them to your trusted files whitelist when you are prompted before running them using the
Prompt to Run setting.

1 Note

Folders to which your own user account has write access cannot be trusted by default, but files
contained in them can be added to your trusted file whitelist.

1.11.2.8 Add-Ins

To review and enable add-ins to provide additional features and services in PowerDesigner, select |+ Tools

General Options 3, and click the Add-Ins category in the left pane.

Context

Add-ins installed with PowerDesigner are called system add-ins, and are declared ina Local Machine registry
key. The following system add-ins are installed by default:
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Microsoft SQL Server 2005 Analysis Services - Generates and reverse engineers multidimensional objects for
Microsoft SQL Server 2005 (see Data Architecture > DBMS Definition Reference > Microsoft SQL Server ).
Require the client for the appropriate version of SQL Server.

Microsoft Word Import - Imports and exports MS Word documents to and from requirements models (see
Requirements Management > Working with Word Documents and RQOMs ).

SAP BusinessObjects - Generates universes from physical data models (see Data Architecture > Building Data
Models > Generating and Reverse-Engineering Databases > Generating an SAP BusinessObjects Universe ).
Requires BusinessObijects 4.0 or higher.

SAP ERP - Imports SAP Business Suite Data Dictionary and allows its generation it to HANA (see Data
Architecture > DBMS Definition Reference > SAP Business Suite )

SAP HANA - Generates database schemas using the HANA API (see Data Architecture > DBMS Definition
Reference > SAP HANA ).

SAP Solution Manager - Generates and reverse engineers objects to a Solution Manager server (see Business
Process Architecture > SAP Solution Manager ).
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e Spell Checker - Uses the MS Word spell checker to check PowerDesigner object names, codes, comments,
descriptions, and annotations (see Spell Checking [page 167]). Requires Word 2000 or higher.

e SAPIQ Reference Architecture - Analyzes the architecture required to deploy a SAP® |Q data warehouse
solution suitable for your workload (see Enterprise Architecture > SAP IQ Reference Architecture Model ).

e XML Validation - Checks that an XML document conforms to the schema in the XML model (see XML
Architecture ). Requires MSXML 4.0.

1 Note

If you modify system add-in properties, you can click the Reset Values For System Add-In tool to recover the
parameters registered in the registry.

You enable an add-in by selecting its checkbox.

You can create your own XML or ActiveX user add-ins, which are declared in a Current User registry key:

Procedure

1. Click one of the following tools:

o Add New ActiveX Add-In - An ActiveX add-in implements an interface that defines methods, which are
invoked by PowerDesigner in order to dialog with menus and execute commands that are defined by the
ActiveX.

o Add New XML Add-In - An XML add-in defines a menu structure for calling scripts or executables from
within PowerDesigner.

For information about developing these add-ins, see Customizing and Extending PowerDesigner > Scripting
PowerDesigner > OLE Automation and Add-Ins
2. Enter the name of your add-in and click the Select File tool to browse to the . xm1, .d11, or .exe file.

3. [ActiveX only] Enter the name of the ActiveX implementation class in the Class field.
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Click OK.

If your add-in has been correctly defined, it will immediately be available under the appropriate PowerDesigner

menu.

1.11.2.9 Model Creation Options

To review and modify options for creating models in the New Model dialog, select | Tools » General Options 3, and
click the Model Creation category in the left pane.

The following options are available:
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Option

Enable Categories

Description

Enables the display of the Categories button in the New Model dialog, which lets you create mod-
els from predefined templates. Select the model category set to use in the Default category set list.
If no valid model category set is selected then the Categories button will not be available.

Click the Select Path tool to the right of this field to browse to another folder containing model cat-
egory sets or click the Properties tool to open the currently-selected set in the Resource Editor. For
more information about category sets, which are often developed by an administrator, see Cus-
tomizing the New Model Dialog [page 591].

Enable Model Types

Enables the display of the Model types button in the New Model dialog, which lets you create mod-
els from the classic list of model types.

Enable model template
files

Enables the display of the Template files button in the New Model dialog, which lets you create
models from model templates. If no valid template directory is selected then the Templates button
will not be available.

Click the Select Path tool to the right of this field to browse to another folder containing model
templates. For more information about model templates, see Model Templates [page 15].

For information about using the New Model dialog, see Creating a Model [page 12].

1.11.3 Organizing Views

The PowerDesigner window contains the Browser, Toolbox, Canvas, Result List, and Output sub-windows or views,
which you can move, group, split, hide, or auto-hide to suit your workflow.
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To move a view, click on its title bar or upper or lower tab and drag and drop it onto the docking control that
appears as you hover over a view. You can perform the following kinds of movement in this way:

® To group the view with another view - drop it on the central dock selector:

The dropped view is stacked on the other view, and each has a tab at the bottom of the group to select it.

e To place the view next to, above, or below a view - drop it on the left, right, top, or bottom dock selector. You
can use this to divide the canvas and show multiple diagrams together.

e To place the view next to, above, or below a view, and have it extend the full height or breadth of the

PowerDesigner window - drop it on the separate left, right, top, or bottom dock selectors that appear near the
extremities of the window:
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e To promote a view to an independent window - drop it anywhere except on a dock selector.

1 Note

The Canvas is a special view that displays diagrams as tabbed documents.You can drag other views onto the
Canvas, but you cannot drag Canvas diagrams elsewhere in the PowerDesigner window (though you can
promote them to independent windows). Right-click a diagram tab to access a menu that lets you close the
diagram, close every diagram except this one, or split the canvas horizontally or vertically.

All views except the canvas have a menu available on their title bar to:

Float - promote the view to an independent window.

Show - disable auto-hiding (or click the sideways pin to pin the view open).

Dock as Tabbed Document - add the view as a tab to the Canvas.

Auto Hide - hide the view as a small tab on the side of the screen, that re-expands when you hover over it (or
click the vertical pin to unpin the view).

Hide - remove the view from your window. To show a hidden view, select ¢ View » <View Name> 4.

1 Note

The Browser is a single view with up to three sub-views (Local, Glossary, and Repository). These sub-views
cannot be moved independently.

1.11.4 Organizing Toolbars

The PowerDesigner window provides various toolbars, which you can show, hide, organize, and customize to suit
your workflow.

To move a toolbar in the toolbar tray, click and hold on the four dots on the left edge of the toolbar and drag it
to the desired position.

To show a hidden toolbar or hide a visible toolbar - right-click the toolbar tray and select Toolbars and check or
uncheck the toolbar.

To access tools on a toolbar that is not fully visible due to lack of space - click on the down arrow on the right
edge of the toolbar.

To lock all toolbars to protect them from accidental movements - right-click the toolbar tray and select
|» Toolbars ¥ Lock Toolbars 3.
To add tools to or remove them from a toolbar, or to create new toolbars - right-click the toolbar tray and select

|» Toolbars » Customize Menus and Tools J (see Customizing Menus, Toolbars, and Toolboxes [page 446]).
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1 Note

The Toolbox (see Creating Objects from the Toolbox [page 93]) is not a toolbar, and you cannot add Toolbox
tools (such as those for creating a PDM table or OOM class) to a toolbar, nor add toolbar tools to the Toolbox.

1.11.5 Customizing Menus, Toolbars, and Toolboxes

To customize PowerDesigner menus, toolbars, and toolboxes, select [ Tools » Customize Menus and Tools 3.

Context

1 Note

An administrator can prepare customized Ul profiles, which are made available to users on their first connection
to the repository (see Controlling Defaults for Menus, Toolbars, and Toolboxes [page 603]).
Procedure

1. Select | Tools #» Customize Menus and Tools 3. The dialog opens to the Menus tab, initialized to your current
view (here, the PDM Physical Diagram):

Core Features Guide
446 PUBLIC Modeling with PowerDesigner



@1 Customize Menus and Tools

Menus | Toclbars | Toclboxes

(=]

Search for:

L

View: [ POM::Physical Diagram

)

Command groups:

s A X9 + &

List of commands:

Liae

4 Menus
Eile
Edit
View
4 Model
Users and Roles

|23 Packages...

., Business Rules..

Users and Roles #

)

Laaa

Mame:

&Tables...

Teoltip:

Shows the list of Tables

@ Text and Image

gher Objects (2) Text only

Triggers ﬁ; Domains..
Symbol 12 Image enly
Database 7] Defaults...
Beport
Bepository 3 Tables..
Tools
Window EH Columns..
Help = i

‘| m | »
| QK | [ Cancel ] [ Help

1 Note

Search for any command available in the present context by entering it in the Search for field and clicking
Find. Methods and menus defined in resource files and custom commands are not available for selection

and cannot be moved in this dialog (see Customizing and Extending PowerDesigner > Extension Files >

Menus (Profile) ).

2. [optional] Select a different view to customize. The following views are available:

O No View - when PowerDesigner is running but no model is open and selected.

O <Type> Diagram-each diagramis listed separately.

© All Views - provides a union of all the menus available in all possible views.

1 Note

You can make changes in multiple different views. All your Ul preferences are saved in a single resource file.

3. Navigate to and select a command group (menu or submenu) to modify in the tree in the left panel. The
commands that are available on the selected menu, submenu, toolbar, or toolbox are listed in the middle

panel.

The middle panel shows the contents of only one level at a time. To see the contents of a submenu, double-

click it to descend into its commands. Click the Go Up One Level tool to return to the parent menu. For
example, to see the contents of the | Repository » Administration 3 submenu, expand the Repository node in
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the left panel, and select the Administration node, or click the Repository node in the left panel, and double-
click the Administration node in the middle panel.

1 Note

The special commands in the format <<Command>> such as <Recent Files>and <New Diagrams> are
placeholders for points where the menu dynamically calculates commands to insert. The <Stereotypes
used as Metaclass> placeholder, which is present by default in the Model menu, instructs
PowerDesigner to insert a command to open a list of objects for each type of new object defined in a model
definition or extension file (see PowerDesigner Resource Files [page 449]). If you remove this command
from this menu, then all such object lists will be hidden. If you want to display such object lists under
another menu, then you must add both the parent metaclass from which they are derived and the
<Stereotypes used as Metaclass> placeholder.

4. Use the tools in the middle panel to add, remove, reorder, or otherwise modify the commands of the selected
command group:

Tool Description

[

Create New Menu - Creates a new sub-menu to add to the command group. The sub-menu acts as a container for
commands.

&h

Add Commands - Opens a selection dialog to add a command to the selected command group. The Add Com-
mands dialog has a Pick Command tab to let you select available commands from a tree and a Filter Commands
tab to let you filter the list of available commands by entering a string. When you have located the command to
add, select it and click OK.

Go Up One Level - Displays the commands of the parent menu of the currently selected menu.

Remove - Deletes the selected command from the command group.

Reset List - Undoes any changes to the command group.

W)
Move Up - Moves the selected command up one place in the list.
3
Move Up - Moves the selected command down one place in the list.
¥

5. [optional] Select a command in the middle pane and use the fields in the right pane to change its name,
tooltip, and display method (text and/or image).
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1 Note

Inserting an ampersand sign in the Name field before a letter enables its use as an key menu shortcut.
For example, the File menu has, by default, its name defined as &File so that users can press + |F|to
activate this menu.

6. [optional] Select the Toolbars (see Organizing Toolbars [page 445]) or Toolboxes (see Creating Objects from
the Toolbox [page 93]) tab to customize these Ul elements.

7. Click OK to save your changes and apply them to your environment.

1.11.6 PowerDesigner Resource Files

The SAP® PowerDesigner® modeling environment is powered by XML-format resource files, which define the
objects available in each model along with the methods for generating and reverse-engineering them. You can
view, copy, and edit the provided resource files and create your own in order to customize and extend the behavior
of the environment.

The following types of resource files, based on or extending the PowerDesigner public metamodel are provided:

e Definition file: customize the metamodel to define the objects available for a specific DBMS or language:

o DBMS definition files (.xdb) - define a specific DBMS in the PDM (see Customizing and Extending
PowerDesigner > DBMS Definition Files ).

o Process, object, and XML language definition files (.xpl, .xol, and .xsl) — define a specific language in the
BPM, OOM, or XSM (see Customizing and Extending PowerDesigner > Object, Process, and XML Language
Definition Files ).

e Extension files (.xem) — extend the standard definitions of target languages to, for example, specify a
persistence framework or server in an OOM. You can create or attach one or more XEMs to a model (see
Extension Files [page 452]).

e Report templates (.rtp) - specify the structure of a report. Editable within the Report Template Editor (see
Report Templates [page 386]).

e Report language files (.xrl) — translate the headings and other standard text in a report (see Customizing and
Extending PowerDesigner > Translating Reports with Report Language Files ).

e |mpact and lineage analysis rule sets (.rul) - specify the rules defined for generating impact and lineage
analyses (see Analysis Rule Sets [page 542]).

e Object permission profiles (.ppf) - customize the PowerDesigner interface to hide models, objects, and
properties (see Controlling the Availability of Models, Objects, and Properties [page 599]).

e User profiles (.upf) - store preferences for model options, general options, display preferences, etc (see User
Profiles [page 422)).

e Model category sets (.mcc) - customize the New Model dialog to guide model creation (see Customizing the
New Model Dialog [page 591]).

e Conversion tables (.csv) - define conversions between the name and code of an object (see Conversion Tables
[page 161]).

You can review all the available resource files from the lists of resource files, available by selecting | Tools »

Resources ¥ <type> 4.
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The following tools are available on each resource file list:

Tool Description

|§| Properties - Opens the resource file in the Resource Editor.

||_] | New - Creates a new resource file using an existing file as a model (see Creating and Copying Resource Files [page
o 4517).

o

Save - Saves the selected resource file.

|ﬁ| Save All - Saves all the resource files in the list.

|E| Path - Specifies the directories that PowerDesigenr should search to populate the list (see Specifying Directories
to Search for Resource Files [page 451]).

|5§1| Compare - Selects two resource files for comparison.
|@| Merge - Selects two resource files for merging.
|§| Check In - [if the repository is installed] Checks the selected resource file into the repository. For information

about storing your resource files in the repository, see Sharing Resource Files via the Library [page 588].

|'@| Update from Repository - [if the repository is installed] Checks out a version of the selected file from the reposi-
o tory to your local machine.

|§| Compare with Repository - [if the repository is installed] Compares the selected file with a resource file stored in
the repository.

1.11.6.1 Sharing and Embedding Resource Files

Resource files can be shared and referenced by multiple models or copied to and embedded in a single model. Any
modifications that you make to a shared resource are available to all models using the resource, while
modifications to an embedded resource are available only to the model in which it is embedded. Embedded
resource files are saved as part of their model and not as a separate file.

1 Note

You should never modify the original extensions shipped with PowerDesigner. To create a copy of the file to
modify, open the List of Extensions, click the New tool, specify a name for the new file, and then select the .xem
that you want to modify in the Copy from field.

The File Name field displays the location of the resource file you are modifying is defined. This field is empty if the
resource file is embedded.
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1.11.6.2 Creating and Copying Resource Files

You can create a new resource file in the appropriate resource file list. To create a copy of an existing resource file,
select it in the Copy from field of the New... dialog.

Context

Caution

Since each resource file has a unique id, you should only copy resource files within PowerDesigner, and not in
Windows Explorer.

Procedure

1. Select |l Tools » Resources » <Type> 4to open the appropriate resource file list.

2. Click the New tool, enter a name for the new file and select an existing file to copy. Select the <Default
template>item to create a minimally completed resource file.

3. Click OK to create the new resource file, and then specify a filename and click Save to open it in the Resource
Editor.

1 Note

You can create an extension file directly in your model from the List of Extensions. For more information,
see Creating an Extension File [page 453].

1.11.6.3 Specifying Directories to Search for Resource Files

Use the Path tool in the resource list toolbar to specify directories to search to populate the list. If you plan to
modify the standard resource files or create your own, you must store these files in a directory outside the
PowerDesigner installation directory.

Context

By default, only the directory inside the Program Files folder containing the standard resource files appears in
the list, but PowerDesigner does not allow you to save modifications there, and will propose an alternative location
if you try to do so, adding the selected directory to the list. You can add additional directories as necessary.
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1 Note

If you have created or modified resource files inside Program Files before 16.5, when this rule was
introduced, your files may no longer be available as Windows Vista or Windows 7 actually store them in a virtual
mirror at, for example, C: \Users\<username>\AppData\Local\VirtualStore\Program Files\Sybase
\PowerDesigner 16\Resource Files\DBMS. o restore these files to your lists, optionally move themto a
more convenient path, and add their location to your list using the Path tool.

The first directory in the list is the default location, which is proposed whenever you save a file. The root of the
library belonging to your most recent repository connection is searched recursively before the directories in the list
(see Sharing Resource Files via the Library [page 588]), .

1 Note

In rare cases, when seeking resource files to resolve broken references in models, the directories in the list are
scanned in order, and the first matching instance of the required resource is used.

1.11.6.4 Extension Files

Extensions files (* . xem) allow you to customize and extend the PowerDesigner metamodel to support your exact
modeling needs. You can define additional properties for existing objects or specify entirely new types of objects,
modify the PowerDesigner interface (reorganizing and adding property sheet tabs, Toolbox tools and menu items),
and define additional generation targets and options.

Extension files have an . xem extension and are located in <install dir>/Resource Files/Extended Model

Definitions.

Lists of extension files by model type are available by selecting |+ Tools # Resources # Extensions # <model

type> 4. For information about the tools available in resource file lists, see PowerDesigner Resource Files [page
449].

1 Note

Extensions, such as the Excel Import extension, which can be attached to any model type, are available in the
list at | Tools » Resources » Extensions ¥ All Model Types 3.

Each extension file contains two first-level categories:

e Generation - used to develop or complement the default PowerDesigner object generation (for BPM, OOM,
and XSM models) or for separate generation. For more information, see Customizing and Extending
PowerDesigner > Object, Process, and XML Language Definition Files > Generation Category .

e Profile - used for extending the metaclasses in the PowerDesigner metamodel. You can:
o Create or sub-classify new kinds of objects:
o Metaclasses — drawn from the metamodel as a basis for extension.
o Stereotypes [for metaclasses and stereotypes only] — sub-classify metaclasses by stereotype.
o Criteria — sub-classify metaclasses by evaluating conditions.
o Add new properties and collections to objects and display them:
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o Extended attributes — to add metadata.
o Extended collections and compositions — to enable manual linking between objects.
o Calculated collections — to automate linking between objects.
o Dependency matrices — to show dependencies between two types of objects.
o Forms — to modify property sheets and add custom dialogs.
o Custom symbols - to change the appearance of objects in diagrams.
© Add constraints and validation rules to objects:
o Custom checks - to test the validity of your models on demand
o Event handlers - to perform validation or invoke methods automatically.
o Execute commands on objects:
o Methods - VBScripts to be invoked by menus or form buttons.
o Menus [for metaclasses and stereotypes only] — to add commands to PowerDesigner menus.
o Generate objects in new ways:
o Templates — to extract text from object properties.
o Generated Files - to assemble templates for preview and generation of files
o Transformations — to automate changes to objects at generation or on demand.
o Map correspondences between different metamodels:
o Object generations - to define mappings between different modules in the PowerDesigner metamodel
for model-to-model generation.
o XML imports - to define mappings between an XML schema and a PowerDesigner module to import
XML files as models.

1 Note

Since you can attach several resource files to a model (for example, a target language and one or more
extension files) you can create conflicts, where multiple extensions with identical names (for example, two
different stereotype definitions) are defined on the same metaclass in separate resource files. In case of such
conflicts, the extension file extension usually prevails. When two XEMs are in conflict, priority is given to the one
highest in the List of Extensions.

1.11.6.4.1 Creating an Extension File

You can create an extension file directly in your model or from the appropriate list of extension files.

Context

1 Note

Extensions, such as the Excel Import extension, which can be attached to any model type, can only be created
from the All Model Types extension list. For information about creating an extension file from a list of extension
files, see Creating and Copying Resource Files [page 451].

Core Features Guide
Modeling with PowerDesigner PUBLIC 453



Procedure

Open your model, and then select |» Model  Extensions 3 to open the List of Extensions.

2. Click the Add a Row tool and enter a name for the new extension file.

3. Click the Properties tool to open the new extension file in the Resource Editor, and create any appropriate

extensions.
When you have finished, click OK to save your changes and return to the List of Extensions.
The new XEM is initially embedded in your model, and cannot be shared with any other model. For information

about exporting your extensions and making them available for sharing, see Exporting an Embedded
Extension File for Sharing [page 455].

1.11.6.4.2 Attaching Extensions to a Model

Extensions can be stored in * . xem files that you can attach to one or more models. You can attach one or more
extension files to a model at creation time by clicking the Select Extensions button on the New Model dialog. You
can subsequently attach extension files to your model at any time from the List of Extensions.

Procedure

Select |F Model ¥ Extensions 3 to open the List of Extensions, which contains extensions attached to the
model.

2. Click the Attach an Extension tool to open the Select Extensions dialog.

454

Review the different sorts of extensions available by clicking the sub-tabs and select one or more to attach to
your model.

By default, PowerDesigner creates a link in the model to the specified file. To copy the contents of the
extension file and save it in your model file, click the Embed Resource in Model button in the toolbar.
Embedding a file in this way enables you to make changes specific to your model without affecting any other
models that reference the shared resource.

Click OK to return to the List of Extensions.
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Extension files listed in grey are attached to the model, while those in black are embedded in the model.

1 Note

If you embed an extension file in the model, the name and code of the extension may be modified in order to
make it respect the naming conventions of the Other Objects category in the Model Options dialog.

1.11.6.4.3 Exporting an Embedded Extension File for Sharing

If you export an XEM created in a model, it becomes available in the List of Extensions, and can be shared with
other models. When you export an XEM, the original remains embedded in the model.

Procedure

1. Select | Model » Extensions 3 to open the List of Extensions, which contains extensions attached to the
model.

2. Select an embedded extension in the list and click the Export an Extension tool.

3. Enter a name and select a directory to which to save the extension file and click Save.

1 Note

For the extension to be available for attaching to other models, you must save it to a directory that is listed
by the Path tool in the appropriate extension list (see Specifying Directories to Search for Resource Files
[page 451)).
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1.11.6.4.4 Reconnecting to Missing Extensions

If you rename, move or delete extension files that are attached to a model, you may lose the links to them in your
model. When you next open a model sharing the affected extensions, PowerDesigner will try to help you
reconstruct the broken links.

Missing Exkensions

TN

The model you are opening iz inked to Extensions [HEMs), which are not available.

Click the Open tool - to browse far the miszing #E s

Click the Update from Reposzitor tool - to check out the mizzing =EMs from the repositons,

Click the Delete taal - ta remaove the links bo the miszing S<Ekz.

S W%

I ame

| File

TestDeszign WA TestD ezign. kem

Cloze Help

The following tools are available in this dialog:

Tool

=

Description

Open — Lets you browse to, and re-attach, the missing XEMs.

]

Update from Repository — Lets you check out the missing XEMs from the repository.

[x]

Delete — Lets you remove the links between the model and the missing XEMs.

456 PUBLIC
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1.11.7 Shortcut Keys

PowerDesigner provides many shortcut keys to accelerate your workflow.

Toolbox Shortcuts

Shortcut

+ [a](or double-click Pointer tool)

‘ Action

Select all symbols in diagram.

Double-click Delete tool

Delete selected symbols (with confirmation).

Double-click Grabber tool

Zoom to whole diagram.

Double-click any object tool

Select all symbols of this type.

+Double-click any object tool

Retain current selection and add all symbols of this type.

Right-click

Release tool and select pointer.

Browser Shortcuts

Shortcut ‘ Action

(number pad) Expand all nodes.
(number pad) Expand subnodes.
|Z| (number pad) Collapse subnodes.

F2

Rename selected item.

[ceet] + (o] + 1

Find selected item in Diagram.

Diagram Shortcuts

Shortcut

Del

‘ Action

Delete object with confirmation dialog.

Shift| +

Delete object directly, without confirmation.

Open object property sheet.

ctrl] + E

Paste as shortcut.

Ctrl| + E

[on selected link] Force link to horizontal.

ctrl]| + H

[on selected link] Force link to vertical.

Ctr +

=

Page Upl

Bring symbol to front.
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Shortcut Action

[ctrl| + [Page Down] Send symbol to back

+ Align selection on vertical axis.
+ Align selection on horizontal axis.
+ Open Symbol Format dialog.

+ Auto-resize the symbol to display all the text it contains (up to the value
specified for word wrapping in the diagram).

while dragging a symbol handle Resize object while keeping same center point.

+ while dragging a symbol han- | Resize object while keeping same center point and proportions.
dle

(or [ctr1 [+Right-click on Name) Rename object.
Double-click (or + (plus sign) | [on package or other composite symbol] Open subdiagram.
+ Go to parent diagram.

Drag and Drop Shortcuts

Shortcut ’ Action

+Drag and drop Move object.
+Drag and drop Copy object.
+ +Drag and drop Create shortcut of object.

+Drag and drop Create replica of object.
Right-click+Drag and drop Open menu to choose an action.

Window and General Shortcuts

Action

(%2}
=3
o
=3
-+
(2]
(=
-~

F4 Check model.

F5 Zoom to actual size.
F Zoom in.

E7 Zoom out.

g

2| (]| =] (=] (=) (=] [=]
O[] ] o
o

Zoom to whole diagram.

Previous view.

Display used pages.

Shift| + Redisplay.
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Shortcut

Enls

‘ Action

Next view.

shift [+Click item

Select consecutive items.

+

+ Show/hide Browser.

+ Show/hide Output view.

+ Show/hide Result List view.
Show/hide Welcome page.

Cycle between active windows.

Ctrl| + |Tab

;
FERSEE

Cycle between property sheet tabs.

+

@]
t
o]

=
o

age Upl/lCtrll + |Page Downl

Cycle between property sheet tab subtabs.

Ctrl| +

5|

Cycle between property sheets.

Ctrl

+

Find selected object in Browser.

Ctrl

+

Select diagram.

Open list of reports.

Find objects.

EIEIE EEIE
t t
[a I}
==

;
FEEEEE

Close diagram.

Close model.

+
Ctrl| +

T
Shift| + |F12

Open workspace.

Save workspace.

wll| v
oy =y
I
|| e
|||t
+ |+
H H
s w

Close workspace.

List Shortcuts

Select text for edit.
Select cell to add text.
[ctrl| + [shift]| + [spacebar Select line.

+ Select all.

+ + Deselect all.

Ctrl| + Add entry.

Ctrl| +

Insert entry.

Ctrl| +

EIEIE
(o] [=] [=]

Delete entry.
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Code Preview Tab Shortcuts

Shortcut Action
Next bookmark.
Find next.

Shift| + Menu.
+ Insert/Remove bookmark.
+ Insert file.
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2 Linking and Synchronizing Models

The chapters in this part describe the PowerDesigner features that help you create links between models and trace
the impact of changes between models.

2.1 Getting Started with Linking and Syncing

The PowerDesigner Enterprise Modeling environment allow you to create and exploit complex interdependencies
between objects to model interconnected systems and view them in many different ways.
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MS Excel Files MS Visic Files

Business Process Files

OO Langusge Files

ETL & Regplication Files

A single data item such as a product name can be implicated in multiple systems, which are modeled in a number
of interdependent models. It may also be represented at various levels of abstraction in conceptual, logical, and
physical data models, or in different contexts such as object-oriented, XML, business process, and enterprise
architecture models.

Instead of defining this same object and all its accompanying metadata multiple times, PowerDesigner allows you
to generate these instances or in other ways link them together, and provides powerful tools for tracking and
analyzing the dependencies between them.

462
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1 Note

When working with multiple connected models, we recommend that you group your models together into a
project (see Projects and Frameworks [page 47]).

2.1.1 Creating Links Between Models

PowerDesigner provides many ways to link the objects of your models together.
You can create the following kinds of links between models:

e Generation links - are created during model or object generation. Each generated object is linked with its origin
object.

o Model Generation - generates one model from another and allows subsequent synchronization on
demand (see Generating Models [page 465]).

o Object Generation - allows you to define the generation of objects from one model to another with
subsequent synchronization on demand (see Generating Model Objects [page 476]).

e Shortcuts - create a reference to an object in another model. You either create shortcuts explicitly in order to
share or reuse an object in another model (see Creating Shortcuts [page 487]) or implicitly when creating
other kinds of links. To create any of the kinds of links in this list, the target model in which the referenced
object resides must be open in your workspace:

o Traceability Links - specify connections between any object and any other object in any model (see
Traceability Links [page 146]).

o Related Diagrams - specify connections between any object and any diagram in any model (see Specifying
Diagrams as Related Diagrams [page 189]).

o  RQM Traceability Links - link requirements with design objects that are intended to satisfy them (see
Requirements Management > Requirements Views > Requirements (ROM) > Linking Requirements with
Design Objects and External Files ).

o Object Mappings - specify connections between certain predefined types of objects (see Object Mappings
[page 503]).

o EAM Object Export/Import - link enterprise architecture objects with the design objects that will
implement them (see Enterprise Architecture > Importing to and Generating and Exporting from an EAM >
Exporting and Importing Objects to and from Other Models ).

o BPM Data Export/Import - link data objects in the BPM with objects in other models (see Business
Process Architecture > Analysis BPM > Data (BPM) ).

o Extended Attributes and Collections - allow you to extend the PowerDesigner metamodel to define new
kinds of links between objects (see Extending Objects [page 1677).

e Object Replications - duplicate an object from one model to another and allow you to vary the properties you
choose while keeping the rest synchronized with the original object (see Creating Replicas [page 492]).
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2.1.2 Viewing Links Between Models

PowerDesigner provides an array of tools to allow you to view and analyze the links created between your models.

Some or all of the following tools are available to you to view, analyze and edit the links between your models:

Project Diagram - provides a high-level read-only view of the links between the models in your project (see
Project Diagrams [page 51]).
Dependency Matrix - provides an editable view of all the links between the two object types that you specify in
the matrix definition (see Dependency Matrices [page 198]).
Generation Links Viewer - provides a read-only view of all the model or object generation links between the
present model and any models it is associated through generation (see The Generation Links Viewer [page
480]).

Mapping Editor - provides an editable view of all the mappings between the present model and any models it is
associated with through mappings (see The Mapping Editor [page 508]).

Multi-Model Report - provides a configurable report in HTML or RTF format documenting your models and the
links between them (see Creating a MultiModel Report [page 339]).

Impact and Lineage Analysis - provides a configurable analysis of the objects that impact and/or are impacted
by the selected objects (see Impact and Lineage Analysis [page 529]).
Object Lists - can include shortcuts to objects of the selected type if the Include Shortcuts tool is selected (see
Object Lists [page 118]).
Object property sheets (see Object Properties [page 107]) - provide information on various forms of links on
the following tabs:

o Related Diagrams (see Specifying Diagrams as Related Diagrams [page 189])

o Traceability Links (see Traceability Links [page 146])

o Mappings - where available (see Object Mappings [page 503])

o Requirements - if enabled (see Requirements Tab [page 115])

o Dependencies - lists the objects that depend on the object (see Dependencies Tab [page 116])

2.2 Generating Models and Model Objects

PowerDesigner provides a number of predefined model-to-model generation paths along with mechanisms for
generating any model objects into any other objects in another type of model.

1 Note

If you generate from more than one model to a single model, only the generation links from the last generated
model are retained.
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2.2.1 Generating Models

PowerDesigner provides powerful capabilities for generating one model from another, and keeping the two models
synchronized. Thus, you could model your data at an abstract level in a CDM, generate an LDM to model
implementation-neutral features, and then generate multiple PDMs for various DBMSs.

Context

The following table shows which model types you can generate from each model type. The left column lists the
source model and the column headings the model types that can be generated from it:

’ BPM ’ CDM ‘ LDM ’ PDM ’ DMM ‘ OOM ’ XSM
BPM X
CDM X X X X
LDM X X X
PDM X X X X X
DMM X
OoOoM X X X X
XSM X X

Procedure

1. Select Tools, and then one of the following to open the appropriate Model Generation Options Window:

o Generate Business Process Model...[ctr1] + +
©  Generate Conceptual Data Model...[ctr1] + +
© Generate Logical Data Model...[ctr1] + +

©  Generate Physical Data Model... [ctr1] + + [2]

o  Generate Data Movement Model...

o Generate Object-Oriented Model...[ctr1] + + [o]
o Generate XML Model...[ctr1] + +

2. Onthe General tab, select a radio button to generate a new or update an existing model, and complete the
appropriate options. For more details, see Model Generation Options [page 466].

3. [optional — PDM-PDM generation only] Click the DBMS Preserve Options tab and set any appropriate options.
4. [optional] Click the Detail tab and set any appropriate options.
5. [optional] Click the Target Models tab and specify the target models for any generated shortcuts.
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6. [optional] Click the Selection tab and select or deselect objects to generate. For information about using the
tools on this tab, see Adding an Item from a Selection List [page 130].

7. Click OK to begin generation.

2.211 Model Generation Options

You can customize the generation of your models by selecting model generation options.

General Tab

The General tab lets you specify the new model to be generated or existing model to be updated When generating
a new model, you must specify the following options:

Option Description

DBMS, Object, XML, or Specifies the definition file for the model to be generated. By default, PowerDesigner creates a

Process language link to this file. To copy the definition and save it in your model file, click the Embed Resource in
Model button.

Name / Code Specifies the name and code for the model to be generated.
Click the Configure Model Options button to specify naming conventions (see Naming Conven-
tions [page 155]) and other model options for the model to be generated.

When updating an existing model, you must specify the following options:

Option Description

Select model Specifies the target model to be updated. Select a model that has already been generated from
the current model from the list, or click the ellipsis button to the right to open a list of other mod-
els of the same type open in the workspace.

DBMS, Object, XML, or Displays the definition file of the model to be updated.

Process language

Preserve modifications Allows you to review the changes to be made to the model (see Comparing and Merging Models
[page 395]). If this option is not selected, generated objects will replace objects with the same
name in the model.

DBMS Preserve Options Tab

This tab is only available when you generate a PDM from another PDM, and allows you to choose to preserve,
where possible, the values associated with:
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e Physical options - for relevant objects.

e Triggers and stored procedures — If the target belongs to a different DBMS family, triggers are automatically

rebuilt.

e Database objects — Only objects supported by the target DBMS will be generated.

e [Extended attributes.

Detail Tab

The Detail tab contains options to control the generation of model objects.

Option

Check Model

Description

Invokes a model check before generation, and stops generation if errors are found. You can con-

figure specific model checks before generation by selecting |} Tools > Check Model } (see
Checking Models [page 149]).

Save Generation Depend-
encies

Instructs PowerDesigner to retain links between each source object and the corresponding target
object, which allow objects to be subsequently identified, even if they have been modified (see
The Generation Links Viewer [page 480]).

Generate Mappings

Defines the source model as the data source of the generated model and creates mappings be-
tween all source and target objects (see Object Mappings [page 503]). This option is dependent
on the Save Generation Dependencies option.

Rebuild Triggers

[CDM/OOM-PDM] Instructs PowerDesigner to rebuild triggers with unmodified templates after
the PDM generation.

Convert Names into Codes

Instructs PowerDesigner to generate target model object codes using a conversion script. This
option can be useful when generating models with very different naming conventions. If it is not
selected, target object codes are generated from source object codes.

For example, generate an OOM Java class attribute with a code of customerName to a PDM ta-
ble column called CUSTOMER NAME by clicking the Configure Model Options button on the
General tab, selecting the appropriate conversion script (see Name and Code Conversion Scripts
[page 158]), and selecting this option.

Preserve n-n relationships

[CDM-LDM only] Specifies that many-to-many relationships created in the CDM will be generated
to the LDM if the destination model permits them.

Enable transformations

Displays the Extensions tab, the Pre-generation tab (if your model has transformations defined)
and the Post-generation tab (if you are updating an existing model that has transformations de-
fined) to select transformations to perform before and/or after generation (see Applying Pre- and
Post- Generation Transformations [page 471]).

Skip single root element

[XSM-PDM only] Specifies that the single root element is ignored, and its immediate child ele-
ments are treated as multiple roots, which will be generated as tables.
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Option Description

Generate root element [PDM/OOM-XSM only] Specifies that a single root element representing the PDM or OOM model
is generated. Deselecting this option means that all the tables or classes are generated as multi-
ple roots.

Generate tables/classes as | [PDM/OOM-XSM only] Specifies how PDM tables or OOM classes are generated. You can choose
between:

e Flements - [default] each table/class is generated as an untyped element directly linked to
its columns/attributes generated as attributes or sub-elements.

e Flements with complex types - each table/class is generated as an element typed by a com-
plex type, generated in parallel, to contain the columns/attributes.

You can override this option for individual tables or classes (see Customizing XSM Generation for
Individual Objects [page 475]).

Generate columns/attrib- | [PDM/OOM-XSM only] Specifies how PDM columns or OOM attributes are generated. You can
utes as choose between:

e Flements - [default] each column/attribute is generated as an sub-element of its table/class
element or complex type.

e Attributes - each column/attribute is generated as an attribute of its table/class element or
complex type.

You can override this option for individual columns or attributes (see Customizing XSM Genera-
tion for Individual Objects [page 475]).

Class Prefix [OOM only] Specifies a prefix to apply to the codes for all classes generated.

Detail Tab - PDM Generation Options

The following additional options are available on the Detail tab when generating a PDM:

Option Description

Naming Template [Except XSM-PDM] Controls the generation of codes for tables, columns, domains, and business rules
(default: $Code%). You can use any GTL or applicable variables in these fields.

Table [XSM-PDM only] Controls table generation:

e Table Prefix - Controls the generation of codes for tables.
e |D column type - Specifies the type to use for ID columns, and which will be used to generate
xs: ID types (default: numeric).
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Option

Index

Description

Controls the generation of codes for keys:
e PKindex names - (default: ¥TABLE%_PK).You can use the following variables in all index name
fields:

o STABLES - Generated code of the table.

o $TNAMES%, $TCODES - Table name and code.

o S$TLABLS - Table comment.

AKindex names - (default: ¥TABLES AK).You can use the following variables in this field:

o %REFR%, $PARENTS, $CHILD% - Generated code of the reference, parent table, and child
table.
o SREFNAMES, $REFRCODES% - Reference name and code.
o $PNAME%, $PCODES% - Parent table name and code.
o $CNAMES, $CCODES - Child table name and code.
o S$PQUALIFIER%, $CQUALIFIERS - Parent and child table qualifier.
e FKindex names - (default SREFR%_FK).
FK threshold - Specifies the minimum number of estimated occurrences of an entity necessary to

create an index on a foreign key. This value can be specified in the entity property sheet. If it is not
set, foreign key indexes are generated by default.

1 Note

The generated code of a variable is the code defined in the object property sheet, which may be
truncated when generated if the code contains characters not supported by the DBMS. For more

information about PowerDesigner variables, see Customizing and Extending PowerDesigner >
DBMS Definition Files .
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Option Description
Reference Controls the generation of references:
e Update Rule - Specifies the default update constraint for referential integrity.
e Delete Rule - Specifies the default delete constraint for referential integrity.
e FKcolumn name template - Specifies the naming convention for migrated foreign keys. You can
select one of the default templates from the list or enter your own using the following variables:
o SREFRS% - Name / Code of the reference
o %PARENTS - Name / Code of the parent table
o  $COLUMNS - Name / Code of the parent column
o $KEY$% or $CONSTNAMES - Name / Code of the key constraint attached to the reference
o %PROLES - Role of the CDM entity that generated the parent table. If no role is defined on the
relationship or association, $PROLE% takes the content of $PARENT% to avoid generating a
column with no name.
In the following example, if $PROLE% is not equal to the parent name (and thus a parent role
is present) then it is used. Otherwise, the role is absent and the template % . 3 : PARENTS
%COLUMNS is used:
[$PROLE%=%PARENT%?%.3: PARENT%_%COLUMN% :3PROLE%]
Customized naming templates reappear in the generation dialog box the next time you open
it, but are not saved to the list of predefined templates.
e Use template - Controls whether the FK column name template will always be used or only in case
of conflict.
1 Note

If you modify a primary key in a PDM, then regenerate the PDM from a CDM, the modified primary key is not
preserved. If you want to preserve a modified primary key, you need to modify the identifier in the CDM before
regeneration.

When you reverse engineer a database into a PDM and then generate an OOM, you can add an appropriate
package hierarchy in the OOM by right-clicking the OOM in the Browser, selecting Add Package Hierarchy, and
entering an appropriate hierarchy (for example, com.mycompany . myproduct. oom).

Target Models Tab

This tab contains a list of target models referenced by shortcuts or replications in the current model, and the
appropriate generated models that the generated model will reference (see Generating Shortcuts and Replicas
[page 501)). If any target model does not have a generated model listed, the generation of shortcuts or
replications referencing it will fail. This tab will be empty if your model does not contain shortcuts to other models
or if these shortcuts are set to generate as independent objects.
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2.2.1.2 Applying Pre- and Post- Generation Transformations

Click the Enable transformations button on the Model Generation Options Detail tab to display additional tabs for
selecting transformations to apply to the source model objects before generation and to apply to generated
objects after generation.

Context

In order to apply transformations, you must have either defined transformation profiles in your model's language
definition file (for PDM, OOM, BPM, or XSM) or in an extension file (see Customizing and Extending PowerDesigner
> Extension Files > Transformations (Profile) ).

Procedure

1. Select|p Tools » Generate Model 3to open the Model Generation Options dialog.

2. Click the Enable transformations button on the Detail tab to display the Extensions tab, the Pre-generation tab
(if your model has transformations defined) and the Post-generation tab (if you are updating an existing model
that has transformations defined).

3. Click the Extensions tab to select extensions containing transformations.

4. Click the Pre-generation tab and select the profiles and transformations to be applied before generation. If you
deselect a profile, none of its transformations will be executed. You can drag and drop profiles to modify the
order of execution of transformations.

CDM Generation Dptions _ O] x|

Eenerall Dretail I TargetMudeIsI Estenzions Pre-generation | Selectil:unl

Transfarmation Profile | T arget Transfarmation | t etaclass | ]
Renaming Objects Transformations R enaming Table
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5. Click the Post-generation tab and select the profiles and transformations to be applied after generation.
6. Click OK to begin the generation. The following steps are performed:

1. The object tree of the source model is traversed from the model object down and, for each type of object
for which one or more pre-generation transformation profiles is defined, each profile is applied in the order
in which they appear on the tab, with each transformation being applied in the order in which they are
defined in the profile.

2. The transformed source model is generated to the target model.

3. The object tree of the generated target model is traversed and type of object and, for each type of object
for which one or more post-generation transformation profiles is defined, each profile is applied in the
order in which they appear on the tab, with each transformation being applied in the order in which they
are defined in the profile.

1 Note

You can apply post-generation transformation profiles to your model at any time by selecting [# Tools
Apply Transformations J (see Applying Transformations to Objects [page 183]).

2.2.1.3 Customizing Data Type Mappings

When generating another PDM from your PDM, PowerDesigner maps the existing column datatypes to appropriate
data types in the new model. If the standard mappings are not sufficient for you, you can use the Enhance Data
Type Mapping extension to specify alternative mappings, including on a column-by-column basis.

Context

To review the conversions that PowerDesigner makes by default between the data types of a database or other
modeling target and its standard conceptual types (which are also used in the CDM), select | Tools # Resources
<Type> 4, select the appropriate file in the list and click the Properties tool. Expand the | Script » DataType 3 (for

DBMSs) or ||» Settings » DataType 4 (for other resource files), and review each of the entries (which are described
in their Comment field):
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Procedure

OK | Cancel |

1. Select|p Tools » Generate Physical Data Model 3, enter the appropriate generation options (see Core Features
Guide > Linking and Synchronizing Models > Generating Models and Model Objects).

2. On the Detail tab, click the Enable Transformations button to display the Extensions tab, and select the
Enhance Data Type Mapping extension.

3. Click OK to start the generation. The Data Type Mappings dialog appears, with the existing data types present
in the model listed in the Original type column, and those that PowerDesigner proposes in the new DBMS in

the Target data type column:
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Destination DBMS: | Sybase SQL Arywhere 12

Muodify the default mappings of data types between the cument and target DBMS
by selecting new types in the Target data type column.
To set a data type for an individual column, click the Add Specific Column Mapping button.

F|EE| 4R X AP YES -

Original type = | U - Target datatype =| Specficcolumn -

numeric(5)

char(30)
char(20)
numerc(d,Z) numerc(d, )
char(12) char(12)
date date
AEIRIRdEIEIE

Add Specific Column Mapping

4. You can change data type mappings in two ways:
o To change the mapping for all columns of a certain data type, select the desired new data type from the list
in the Target data type column.

o To change the mapping for one column only, click the Add Specific Column Mapping button, select the
column from the tree, click OK, choose the new data type for the column, and click OK to add this mapping
to the list.

5. When you have modified all the necessary data types, click Close and the generation will continue, using your
custom mappings where appropriate.

1 Note

You can also customize data type mappings when changing the DBMS of your model with the [ Database
Change Current DBMS 3 command. To do so, you must first attach the Enhance Data Type Mapping

extension, by selecting [ Model » Extensions 4, clicking the Attach an Extension tool, select the extension,
and clicking OK to attach it to your model.

For more information about data types, see Customizing and Extending PowerDesigner > DBMS Definition Files
> Script/Data Type Category and Customizing and Extending PowerDesigner > Object, Process, and XML
Language Definition Files > Settings Category: Object Language .
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2.21.4 Customizing XSM Generation for Individual Objects

When generating an XSM from a PDM or OOM, you can specify global generation options to generate tables/
classes as elements with or without complex types and columns/attributes as elements or attributes. You can
override these options for individual objects by attaching the PDM XML Generation or OOM XML Generation
extension to your source model and selecting from their XML generation options.

Context

1 Note

The extension provides new property sheet tabs for setting generation options for individual objects, but you

can also set these options with or without the extension by selecting [» Model » <objects> 4to open the
appropriate object list, clicking the Customize Columns and Filter tool, and selecting to display the XML
Generation Mode column.

For example, if you want to generate the majority of your table columns to an XSM as XML attributes, but want to
generate certain columns as elements, you should:

e Modify the XML generation options for those columns that you want to generate as elements.
e Select to generate columns as attributes on the Model Generation Options Detail tab.

Procedure

1. Select|r Model » Extensions 3to open the List of Extensions, and click the Attach an Extension tool.
2. Onthe General Purpose tab, select PDM XML Generation or OOM XML Generation and click OK to attach
the extension to your model and OK to close the List of Extensions.

These extension files enable the display of the XML tab in all table and column or class and attribute property
sheets.

3. Open the property sheet of the table, column, class, or attribute whose generation you want to customize, and
click the XML tab.

4. Use the radio buttons to specify how you want to generate the object in an XSM.

o Fortables and classes, you can specify to generate them as:
o Elements - the table/class is generated as an untyped element directly linked to its columns/
attributes generated as attributes or sub-elements.
o Elements with complex types - the table/class is generated as an element typed by a complex type,
generated in parallel, to contain the columns/attributes.
o Default - generation of the table/class is controlled by the option selected in the XML Generation
group box on the Model Generation Options Detail tab.
o For tables, you can additionally specify to generate keys as:
o Key - [default] The primary
key columns are generated and also KEY and KEYREF wherever the table is referenced.
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o |D attribute - The primary key columns are not generated and an ID attribute, id, is generated
to replace them.
Wherever the table is referenced, an IDREF attribute is generated to reference the appropriate elemen
t. If the reference role name is assigned, this attribute is given this
name. Otherwise, the referenced table name is used and the standard renaming mechanism is enforc
ed.
o Key and ID attribute - In many cases the primary
key columns have significant data and you may want to generate them, as well as an ID attribute.
In this case an ID attribute is generated for the element and IDREF is used systematically
for any reference to the table:
The following rules apply to the generation of keys:
If a Table generates an ID, all its child tables will generate an ID attribute.

[e]

o

If a Table generates Key columns, all its child tables will generate Key columns.

If a child table is flagged to generate PK only, ID Attribute will be automatically generated.

If a table generates ID attribute, No Key nor KeyRef will be generated, and ALL references will generate
IDREF attribute.. (Even if the table generates also Key Columns)

If a table generates ID attribute ONLY, All Foreign Key Columns referencing its Key columns will be syst
ematically removed and replaced by an IDREF attribute

[e]

o

[¢]

o For columns and attributes, you can specify to generate them as:
o Elements - [default] the column/attribute is generated as an sub-element of its table/class element or
complex type.
o Attributes - the column/attribute is generated as an attribute of its table/class element or complex
type.
o Default - generation of the column/attribute is controlled by the option selected in the XML Generation
group box on the Model Generation Options Detail tab.

5. Modify the XML generation options for any other objects that you want to generate in a different manner.

6. Select |+ Tools » Generate XML Model 3, ensure that the appropriate options are set in the XML Generation
group box on the Model Generation Options Detail tab, and start your generation.

2.2.2 Generating Model Objects

You can define your own model-to-model object generation commands. You can define as many commands as you
need, and generate any of your model's objects as any kinds of objects in any other model. The generated objects
are linked to the original objects and can be resynchronized at any time.

Context

Before you can generate model objects, you must define the details of the generation (see Defining Simple Object
Generations [page 477])

1 Note

This procedure deals with generating one or more object types to another model. For information about
generating your entire model to another model, see Generating Models [page 465].
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Procedure

1. Select|p Tools » Generate Objects » <Menu command name> 4 to open the Object Generation Options

window for the generation that you have previously defined (see Defining Simple Object Generations [page
477] or Defining Advanced Object Generations [page 478]).

2. Onthe General tab, select a radio button to generate a new or update an existing model, and complete the
appropriate options (see Model Generation Options [page 466]).

3. [optional] Click the Detail tab and set any appropriate options.
4. [optional] Click the Target Models tab and specify the target models for any generated shortcuts.

5. [optional] Click the Selection tab and select or deselect objects to generate (see Adding an Iltem from a
Selection List [page 130]).

6. Click OK to begin generation.

2.2.21 Defining Simple Object Generations

Simple object generations allow you to generate a single type of object (eg, Tables or Classes) to any other type of
object. You can define multiple object generations. They are stored as objects in your model and are accessed by

selecting |» Tools » Generate Objects # <Generation Name> 4.

Context

To generate more than a single type of object or to have greater control over how individual properties will be
generated, use an advanced object generation (see Defining Advanced Object Generations [page 478]).

Procedure

1. Select|l Tools » Generate Objects  Define New Object Generation 3 to open the Object Generation
Properties dialog.

2. Select the type of model object you want to generate other model objects from in the Source model objects
list.

3. Click the Choose Metaclass tool to the right of the Target model objects field to open the Select Object Type
dialog, which allows you to select the type of objects you want to generate.
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You can choose any object (including extensions) from any PowerDesigner model type, but some choices will
be more appropriate than others.

4. [optional] Edit the Menu command name that PowerDesigner suggests, and which will appear under the

Tools » Generate Objects . menu to allow you to launch the generation.

Object Generation Properties !IEI E

Source model objects: Target model objecks:

IEntit_l,l j == IEIass in DOk

Menu command name:

IGenerate Entitiez az 00M Clazzes g

(0] 4 I Cancel | Generate. ., | Help |

5. Click Generate to launch the generation immediately or OK to save the generation definition for use later.

Once you have defined an object generation, you can launch it at any time by selecting |} Tools » Generate

Objects » <Menu command name>

2.2.2.2 Defining Advanced Object Generations

Advanced object generations allow you to generate one or more types of object to any other types of object, with
complete control over how all the attributes, compositions (sub-objects), and aggregations (related objects) will
be mapped to the generated objects' properties. The generation mappings are defined in an extension file, can be

shared with all users through the repository library, and are accessed by selecting ||¢ Tools » Generate Objects

<Generation Name>
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Context

1 Note
The following procedure gives an overview of the process for defining an advanced object generation. If an
administrator has already defined a generation and provided the extension file to you, you can perform the

generation directly by selecting | Tools » Generate Objects » <Generation Name> 4. You can also define
simple object generations for a single type of object directly in your model (see Defining Simple Object
Generations [page 477]).

Procedure

1. Select|l Tools # Resources j Extensions ¥ <Model Type> 4to open the appropriate extension file list.

1 Note

As object generations are defined on the source objects, you must choose the correct type of extension file.
For example, if you are generating EAM organization units and processes to a BPM, you should create the
generation definition in an enterprise architecture model extension file.

2. Create a new extension file in the list to contain your object generation definition (see Creating an Extension
File [page 453]).

3. Create an object generation definition in the extension file (see Customizing and Extending PowerDesigner >
Extension Files > Object Generations (Profile) ).

4. Save the extension file, attach it to a test model, and test the generation by selecting [ Tools » Generate
Objects # <Generation Name> 4.

5. [optional] Check the extension file into the repository library to have it automatically deployed to all users (see
Sharing Resource Files via the Library [page 588]).

2.2.2.3 Managing Object Generation Commands

You can review the object generations that you have defined by selecting [ Tools » Generate Objects » Manage

Object Generations 3.
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To review the definition of a generation, select it and click the Properties tool; to launch it, select it and click the Run
Object Generation tool.
1 Note

You can also create object generations directly in this list by clicking the Add a Row tool and specifying a menu
command name and source and target object kinds.

2.2.3 The Generation Links Viewer

The Generation Links Viewer allows you to view (but not edit) the generation links of a given model, which allow
you to identify the origin of each generated or derived object of the model.

1 Note

Links are created between models during model generation only if the Save Generation Dependencies option on
the Detail tab of the generation dialog box is selected.

You can choose to view the:

® Links to the model(s) derived from the present model, by selecting |+ Tools # Generation Links ¥ Derived
Models J - the current model is shown in the Source pane and the derived models in the Target pane.
® Links to the model(s) from which the present model was derived, by selecting |+ Tools » Generation Links

Origin Model 3 - the current model is shown in the Target pane and the origin models in the Source pane.
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The Generation Links Viewer dialog box is divided in three parts:

e The Source pane - which is on the left-hand side, and displays the structure of the source model

e The Target pane - which is on the right-hand side, and displays the structure of the target model(s)

e The Generation Links pane — shows you the sources or the targets of the selected object in the current model
as a tree view. The root object is the source or target object from the current model, and the generation link
name is composed of the object type and name (followed by, for link objects, the names of its extremities)
followed by its parent model. You can double click a generation link in this pane to view the properties of the

source or target object.

Source object icons have a small green arrow symbol and target object icons have a small red target symbol on

their bottom right-hand corners.

Non-editable links are drawn from the origin object in the Source pane to the derived object in the Target pane.
Double-click the link in either pane to open the appropriate object's property sheet, or in the area between the two

panes to display its details in the Generation Links pane.
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The following tools are available in the Generation Links Viewer:

Tool Description

|§| Properties - Opens the property sheet of the selected source or target object.
|£| Find Source Object - Finds an object in the Source pane and highlights it.
|E| Find Target Object - Finds an object in the Target pane and highlights it.

|%,v Filter Generation Links — You can choose to filter by:

e All generation links
®  Only generation links of the selected object

e  Only generation links of the selected object and its child objects

.,Ev Filter Objects - You can choose to filter by:

e Allobjects
e  Only objects with generation links

® Only objects without generation links

2.2.4 Using Impact Analysis with Generated Models

To use impact analysis on generated models, consolidate them in the Repository and extract them with the Extract
Dependencies option selected to display the Generated As subtab in the Dependencies tab of source objects.
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i@ Entity Properties - Customer [CUSTOMER] M=l E3
General | Attributes I |dentifiers I M otes I Rulez
Dependencies | Extended Dependencies I YYersion Info
Ty |mpact Analyzis... |
| Short Description | Farent | b odel |

n Table 'Customer' Physical Data k... PO

4|2 | Relationships | Generated as |4 Disgrams /

¢ Less | - ] 4 I Cancel Aol Help

In the Impact Analysis dialog box, this link does not appear by default, you have to click the Extract Dependencies
tool to display the generation links:
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. Impact Analysis

Dependencies | Ligt I

B 2 B

=] Entity 'Customer’ [Change]
=[] Relationships
E E ntity "order’ [Change]
=1-[_] Generation
E T able 'Cuztomer' [Phwzsical Data Model PO [Change]

Cloze Help

2.3 Shortcuts and Replicas

Shortcuts and object replications allow you to reuse objects defined in one model or package elsewhere. You
should use a shortcut when you want to reference an object in another model or package, and a replica when you
want to create a local copy of the object and make changes to one or more of its properties.

1 Note

You cannot transform a shortcut into a replica, or vice versa. When choosing to create a shortcut or replica, you
should identify how you want to use it. For example, if you want to reuse an existing table in your PDM, you
should create a:

e Shortcut - If you do not require the table to belong to your domain or namespace, and you just want to
reference it without modifying its structure (adding, removing or otherwise changing columns or other sub-
objects).

® Replica - If you need a synchronized copy of the table in your namespace, or you want to modify its
structure.
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e Graphical synonym - If you merely want additional instances of the object symbol in your diagram to
improve its readability and simplify linking (see Creating Graphical Synonyms for Object Symbols [page
219)).

A shortcut or replica is:

® |[nternal — if it points to an object in a different package in the same model.
e External - if it points to an object in a different model.

Shortcuts and replications allow you to benefit from:

® Reusability - You can create libraries of reusable objects whose properties are inherited by multiple objects in
different models. For example, the Person entity and its four attributes (Name, Age, Nationality and
Address) can be used via inheritance links in any model where you have need of a customer, employee, etc.
In the following example, a Person entity is created in the Dictionary CDM, and a shortcut to it is created in the
Sales CDM, where the Employee and Customer entities inherit from it:

Dictionary > X Sales F X
- s
Person
(<Dictionany=)
hame
Age
Mationality
Address
Person >
Name
Age
Matiocnality [@ B
Address | 0 I I(_'":,. -----
Employes Customer
Employes ID | Customer 1D
Social Security # Company Mame
Country
i = : 7 — :

e Automatic updates - When the target object changes, the updates cascade automatically (if both the
referencing and target models are open in the workspace) to all the shortcuts and replicas.
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You can create shortcuts or replicas for most PowerDesigner objects (including composite objects and other
shortcuts or replicas). When you replicate an object, its sub-objects are also replicated. You cannot create
shortcuts or replicas for the following types of objects:

Module No Shortcuts For... No Replicas For...

All Diagrams Diagrams, Links, Packages

RQM Traceability link, user allocation -

EAM - -

BPM Starts, ends, decisions, synchronizations, varia- | Starts, ends, synchronizations
bles

MTM - -

CDM/LDM Associations. External shortcuts not supported | Associations, Inheritances

for associations or inheritances.

1 Note

You can reuse data item shortcuts only if

they are internal (same namespace). A dupli-
cated data item shortcut has the same char-
acteristics as the original data item shortcut.

PDM Privileges Privileges

DMM - Replications not supported

OOM Decisions, synchronizations, interaction frag- Starts, ends, synchronizations, interaction fragments,
ments, interaction references, messages interaction references, messages

XSM External shortcuts not supported for imports, -

includes, redefines, annotations

1 Note

There is no need to create internal shortcuts or replicas to global objects, such as organization units or business
rules, because they belong to the model and cannot be displaced into a sub-package.
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2.3.1 Creating Shortcuts

You can create shortcuts to target objects from another package in the current model, or from another model
open in the workspace through copy and paste, drag and drop, or from the List of Shortcuts.

Drag and Drop - Right-click on the target object in the Browser (or its symbol in a diagram) and drag and drop
it into the diagram where you want to create the shortcut (or onto a model or package in the Browser). Release
the right mouse button, and select Create Shortcut(s) Here.

You can also create shortcuts of objects by left-clicking and dragging and dropping them while holding down

- [eeet)

For more information about dragging and dropping objects, including how to change the default behavior, see
Moving and Copying Objects [page 103].

Copy and Paste - Select the target object in the Browser (or its symbol in a diagram) and press + (or
select [» Edit » Copy 1), then right-click in the diagram where you want to create the shortcut (or on a model

or package in the Browser), and select |» Edit » Paste as Shortcut

For more information about copying and pasting objects, including how conflicts are managed, see Moving
and Copying Objects [page 103].

List of Shortcuts - Select |» Model » Shortcuts :to open the List of Shortcuts and click the Add Shortcuts
tool:

Add Shortcuts [_|O]
b adel: I@ Order Management Process j
I@ Order b anagement F'ru:u:ezj = | By ~ G ~ a1 = Y T
M ame | Code | Parent |
WD Check Stack Check Stock Buzinessz Process Mo,
1@ Confirm Order Sh...  Confirm Order Shipment  Business Process Mao...
WD Create Order Create Order Business Process Mo,
D Process Corporat...  Process Corporate O Buzsiness Process Mo...
WD Process Order Process Order Buzinessz Process Mo,

1D Ship Federal Exp... Ship FedEx Ovemight  Business Process Mo...
[ 12 Ship United Stat...  Ship S Postal Ground  Business Process Muo...

1 | L4 |\Hesnurce }ghﬂessage Format }\F‘ackage }\Prl:u:ess ,J"
Objectz] zelected: 347

k. I Cancel | Help |

Select the target model and package in the upper part of the dialog and objects in the sub-tabs in the lower
part of the dialog, and then click OK to add them as shortcuts to the current model.
For more information about the tools in this dialog, see Adding an Item from a Selection List [page 130].

If you select two linked objects in a model and create shortcuts from them, a shortcut of the link between them will
also be created. If, after having created shortcuts from two objects, you subsequently create a link between them
in the target model, you can update the referencing diagram to display the new link by opening it and selecting

Tools » Complete Links
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Link shortcuts do not display the shortcut overlay symbol. In the following example, both classes and the
association are shortcuts, but only the classes display the shortcut overlay:

Class_1 Class 2
Pezociation_1

.1 S e ] S—

The following rules restrict the use of shortcuts:

® You cannot create more than one shortcut to the same target object in the same model or package.
® You cannot create a shortcut for a CDM data item outside the current namespace.

e A shortcut cannot serve as the child object for a parent/child hierarchy link (for example, a PDM reference link
between two tables or a CDM inheritance link). In the case of internal shortcuts only, if you create such alink,
PowerDesigner creates a shortcut to the parent object in the child object package, then creates the link in the
child object package, and creates a shortcut to the link in the parent object package.

When you create a shortcut in a diagram, the following rules apply. If the model or package where you create the
shortcut:

® Does not contain the shortcut - a shortcut and symbol are created

e Already contains the shortcut, but there is no symbol in the diagram - a symbol is created

e Already contains the shortcut, and there is a symbol in the diagram - a shortcut synonym symbol is created:

#-{_d Business Rules
: : Orders : 1
-4 Domains
L—_| j T ables (=0rders Model=)
: Orderll HUMBER(E] =ph=
& Compose Employee Identifier NUMEER(E) il =
'"j Custamer Shi_Employes Identifier MUMBERIE) afies
---j Drivizion Sal_Employes |dentifier HUMBER(S) i3
- Emploves Customerl [ HUNMBER(E] ik, fhes S T
: . Crescription WARCHARZZEG)
=
] Matenial 1
] Member
E Qrders Orders: 2
-] Participate (20rders Model=)
-] Project OrderlD HUMEBER(E) 2phs
: Employee |dentifier HUMBERIE) =tk
=
j Task Shi_Employee ldentifier MUMBER(S) =tk =
'"j Team Sal_Emplovee |dentifier MUMBER(E) 23>
-] Used CustomerlD: HUMEER(S) <fhech 5 5 T =
R | References Dascription WARCHARZZES)
+-{_14 Estensionz 2]

For more information about synonyms, see Creating Graphical Synonyms for Object Symbols [page 219].

2.311  Shortcut Properties

To open the property sheet of a shortcut and view or edit its properties, double-click its Browser entry or diagram
symbol.

By default the shortcut property sheet contains read-only versions of all the tabs of the target object property
sheet with the following exceptions:
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Traceability Links - The tab is not displayed and you cannot create traceability links with shortcuts as a source.
e Dependencies - Contains dependencies for the shortcut.

Version Info - Contains creation and modification information for the shortcut.
e Shortcut - Contains the following properties describing the shortcut:

Property Description
Target type / Specifies the type of the target model and of the target object, and the name and code of the target
Name / Code object.
Click the Change Target Object at the bottom of the dialog to select a different target object (which
must be of the same type, and cannot already be referenced by another shortcut in the same pack-
age).
Target model / Specify the name of the model and of the model package to which the target object belongs.
package
Shortcut type / Specify whether the shortcut is external (from another model) or internal (from another package in
Status the present model), and the status of the target model, which may affect what information is availa-
ble for external shortcuts if the target model is closed or not found.
For external shortcuts, (and you have not selected to display all properties), only the name of the
shortcut and target model are available. Otherwise, all properties can appear in accordance with the
display preferences.
Objectl and Ob- [link shortcut only] Specify the names of the source and target objects which the link connects
ject2
Generate / Gener- | [external shortcut only] Specifies that the shortcut should be generated when a model is generated
ated as from its parent model, and how it should be generated (see Generating Shortcuts and Replicas [page
501]). You can choose between:
o Shortcut - Generate as a shortcut linked to the target object.
o Object — Generate as an independent object that is not linked to the target object.

1 Note

External shortcuts can display properties defined in the standard PowerDesigner metamodel and in
extensions that are attached to the target model, but not any that are defined in extensions embedded in
the target model. If you want to display such embedded extensions, you should export the extension file
from the target model and then attach it as a shared extension.

To display a minimal shortcut property sheet (to reduce the size of your model), click | Tools » Model Options ¥

Model Settings A and set External Shortcut Properties to Name/Code. The properties previously displayed on the
Shortcut tab are now displayed on the General tab, and no other target object properties are shown.

To display the editable target object property sheet directly instead of the shortcut properties (if the target model

is open in the workspace), click |+ Tools » General Options » Dialog 3 and set Internal Shortcut and/or External
Shortcut to Target object.
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2.3.1.2 Viewing Shortcuts

Shortcuts can be identified in the Browser and diagrams by the shortcut arrow overlay on their bottom left
corners.

1 Note

In certain circumstances, when opening a model, PowerDesigner may display a message saying that it is unable
to display complete properties for certain shortcuts, and offering to try to retrieve the missing information. If
you click:

® Yes - PowerDesigner will try to open the target models to retrieve the missing information. If it is unable to
open one or more of the required models, it will report the failure. To resolve the problem, locate the missing
target models, open them in your workspace, and then re-open the original model.

e No - You can continue to work normally with the model and you will be prompted to retrieve the missing
shortcut properties again next time you open it.

In the following example, the Orders table is a shortcut. It appears in the Browser with the other tables that belong
to the model (to hide shortcuts in the Browser, deselect the Show shortcuts general option (see General Options
[page 4297). Both the Browser entry and the diagram symbol display the shortcut arrow overlay:

B e
- Employes Orders

- Material (<Orders Model=)

- Member OrderlD NUMBEFR(5) ke

53 Ordes Shi, Emplayes Identifier NUMBERSS | «tos

=-0 Participate SaCEmEm:ee Identifier NUMBER(E) Ai3s

-] Project CustomerlD HUMBE RrE) ek 5 A AT =
- Task Description WARCHARZIZES)

& Team 2]

For external shortcuts, if you are displaying all properties (see Shortcut Properties [page 488]) or if the target
model is open in the workspace, the properties that appear on its symbol are controlled by the standard display
preferences for that type of object. Otherwise, only the name will appear, and you can modify the display
preferences specific to shortcuts by clicking | Tools ¥ Display Preferences 3, and selecting the Shortcut category.
The following preferences are available:

Preference Description

Icon Displays the shortcut icon on shortcut symbols
Model [external shortcuts only] Displays the name of the target model on shortcut symbols
Package Displays the package name on shortcut symbols. If you select this option, you must choose to display the:

e Full path — displays the full path to the package

e | ast package only —displays the last package name only

To view all the shortcuts in a model, select [ Model » Shortcuts 3 to open the List of Shortcuts. All the entries are
greyed because you cannot modify a shortcut directly in this list:
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List of Shortcuts : - O] x
B

ey || % G X RGPS -

MHame Code | Object Type ~§ 11 - Type * AT arget tode « =+ |
= IDEMTIFIER  {Shortcut ¥ :iDomain Orderz todel
2 Order_ltemsz ORDER_ITEM :Shartcut v iFeference Orders Model
3 Order_[temsz ORDER_ITEM iShartcut W Feference Orders Model
4 [termsz ITEMS Shortout W iTahlz Orders Model
] Order_ltems ORDER_ITEM :Shortcut [ Table Orders kModel
G Orders ORDERS Shortcut [ iTable Orders Model

+| |
ak. I Cancel | Smply | Help

-
[ ] w] 4|

The U[sed] column is checked when the shortcut has a symbol in a diagram or if it is referenced by at least one
other object. If this column is not checked, the shortcut is not used in the model and you can safely delete it.

To view all the shortcuts for a particular type of object in a model, open the appropriate list by selecting [ Model

<Objects> 4, and click the Include Shortcuts tool:

B List of Tables ' _ O] x|
38 @ X | AT RS E| I
I amne - Code Ohbject Type Iml:_'—ﬁ:ln'ln'uar'lt G| =
aall |Cor 2 = | COMPOSE T ahble v i<
2 Cuztormer CUSTOMER Table W <
] Divizion DIISION T able W <
4 Employes EMPLOYEE Table v <
5 [tems ITEMS Sharkcut ik
G b atenal MATERIAL Table W <
7 Member MEMBER Table W |«
g Order_ltems ORDER_ITEMS Shaorkout i
9 Orderz ORDERS Shartcut W <
10 Participate PARTICIFATE T able v i<,
11 Froject PROJECT T able il
12 Tazk TASE T able v | o
'I‘ i p— T Ak . ) I a}.-_
] 4 I Cancel | Apply | Help |

For information about working with these lists, see Object Lists [page 118].

Core Features Guide
Linking and Synchronizing Models PUBLIC 491



2.3.2 Creating Replicas

You can create a replica of an object from one model to another (or from one package to another) through drag
and drop, or from the Replicate Objects dialog. The replica is a local copy of the object, all its properties (including
replicas of all its sub-objects) are by default synchronized with its source object, and you can select to edit any or
all of the properties and sub-objects locally, while keeping the others synchronized.

492

Drag and Drop - Right-click on the object that you want to reuse in the Browser or a diagram, drag and drop it
into the diagram (or onto a model or package in the Browser) where you want to create the replica, release the
right mouse button, and select Replicate Here. Alternatively, left-click the object and drag and drop it while

holding down + (see Moving and Copying Objects [page 103]).

1 Note

If you drag a symbol from one diagram to create a replica in another, PowerDesigner will copy the format of
the initial symbol when creating the new symbol.

Replicate Objects dialog - Select ||+ Edit » Replicate Objects . in the model in which you want to create the
replica to open the Replicate Objects dialog. Select the model and package from which to choose objects in the
upper part of the dialog, select the objects to replicate in the sub-tabs in the lower part of the dialog, and then
click OK to add them as replicas to the current model.

Rephcate Objects [ |O] x|
todel: I_ j

I%EnnceptualDataMDdeU j B | By ~ B - EtoEL v W
|

Conce

ptuall atabodel 1

I arne | Code | Farent -

W suthor Address All_ADDRESS Conceptuall atabdod..

Ll duthor Advance  AU_ADWANCE Conceptuall atakdod...

Wl Author First Hame  A1)_FNAME ConceptualD atakdod...

[Ceg® Athor 1D Al_|D ConceptualD atakdod...

W suthor Last Mame  a_LNAME Conceptuall atabdod..

Ll suthor Phone M., &U_PHOME Conceptuall atakdod... |
(e B ook collection HOMP_COLLECTIOM  ConceptualDatabdod...

[WIeER City CITY Conceptuall atabdod... d
M\Eusiness Fule }\Dumain }\Data ftem ,{Ent'rt&.f ,J'

Object(z] zelected: 4/8

] I Cancel | Help |

Sub-objects of the selected objects are replicated along with their parents. You can display sub-objects of
composite objects (such as hierarchies of sub-functions inside an EAM function) for selection as replicas
independent of their parents by clicking the Include Sub-Objects tool. Sub-objects such as table columns and
indexes (which cannot exist outside their parent objects) cannot be selected for individual replication in this
dialog, but you can replicate them by drag and drop from Browser to Browser.
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1 Note

Objects, such as business rules, that are not sub-objects and are associated with an object, are not replicated
but shortcuts to them are created in the replica if appropriate.

Name uniqueness rules are enforced when you replicate objects. If an object with the same name already exists,
the replica will be renamed.

2.3.2.1 Replicating Composite EAM Objects

Composite objects in the enterprise architecture model, such as business capabilities can be decomposed into
sub-objects, and these sub-objects can be decomposed into sub-objects and so on. You can replicate a composite
object from any level of the hierarchy, and all the levels of sub-objects under it will be replicated as well.

When working with composite objects (such as hierarchies of sub-capabilities inside an EAM capability), you
create a replica of any object at any level in the hierarchy, and the replica symbol will display all levels of sub-
objects by default. In the following example, objects at each level of the Kayak > Velocity > Reflektor >
Reflektor Core hierarchy of objects are replicated and display their sub-objects in the resulting replica
symbols:

Source Object Replicas
I; Kayak m Velocity
Q Velocity @ FReflettor @ Reflesor
g Reflektor
g g Velocity DB Reflektor DB Reflektor OB
Velocity DB Reflektor DB Identity Management

=

Reflektor Core

Spatial Senices

Veloo Reflektor Core Cumency Operations

If you replicate an object by dragging and dropping a symbol from one diagram to another as a replica, the
replicated object symbol will respect the formatting and content of the source symbol, including displaying only
those sub-objects that are displayed on the source-symbol, and you can:

® (Change the format of the replica symbol as if it were a local object, including controlling whether the
composite view is shown at each level, and hiding individual sub-objects.

e Desynchronize collections of sub-objects to make them editable, and then delete sub-objects from the replica
by selecting them and clicking and create new sub-objects using the Toolbox or property sheet.
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® Review and obtain any changes to desynchronized collections on the source object in your replica by right-
clicking the replica in the Browser or diagram and selecting Update Replica from Source Object. Changes to
any synchronized (non-editable) properties and collections continue to be pushed automatically to the replica.

In the following example, the Marketing business capability is replicated and the following modifications made to
the replica:

e The Name property has been desynchronized and changed.

® TheMarketing Insights and Performance Management sub-sub-capability has been hidden.

® TheCustomer Experience Management Sub-Capabilities collection has been desynchronized, two sub-
capabilities have been deleted, and Project X Experience has been added.

® TheMarketing Resource Management Symbol has been modified to hide its sub-capabilities by right-

clicking it and selecting [F Composite View » None 3.

Source Object Replicas

2 Marketing Project X Marksting
Marketing Insights =] Marksting Insigits
) Sccial Listening Audience Marksting Insights - ) Scdisl Listening Audience
C'ﬁ:f:"z::::e and Sentiment Targeting and =nd Performance MJ:?"QW?::;' C';a':r:"e'emie and Sentiment Tergeting and MG'::*‘"&;'::
=g Analysiz Segmentstion Management age =3 Analysis Segmentation =g

Customer Experiencs Management =] Customer Experience Management

Loyalty i Marketing Lead " Event- Loyalty " .

e Advertising Monagement | | Content Marketing W e Advertising Content Marketing

= Marketing Resource Management =

Brand Marketing Strategy | | Marketing Asset | |Marketing Planning Marketing Marksting Resource Management

& i C

Only objects that are children of the composite object are replicated with it, and objects that are merely associated
with it are not replicated. An exception is made for the objects associated with an area, which while not strictly
sub-objects of the area, are nonetheless replicated with the area.

In the following example, the hierarchy of sites is replicated (though the business capability associated with
France is not), while all the objects associated with the area are replicated with it:
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Source Objects Replicas
Eurcpe Eurcpe
France France
Paris Accounting Paris

hManufacturing Manufacturing

2.3.2.2 Editing the Properties of a Replica

By default, you cannot edit the properties of a replica. Their property sheets are read-only, and all their properties
are synchronized with the properties of their source object.

Procedure

1. Open the replica property sheet, select the Version Info tab, and click the Replication Properties button to open
the replication property sheet.

This property sheet manages the synchronization of the replica's properties with its source object. The
General tab contains the following properties:
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Property

Original Object

Description

Specifies the name of the model in which the source object is located. Click the Properties tool to the

Model right of this field to view or edit its properties.

Full Name Specifies the full path to the source object. Click the Properties tool to the right of this field to view or
edit its properties.

Type Specifies the type of the source object.

Status Specifies the status of the source object model, which can be closed, open, or not found.

Replica Object Full
Name

Specifies the full path to the replica object. Click the Properties tool to the right of this field to view or
edit its properties.

Generate

Specifies to generate the replica along with standard models in a model-to-model generation (see
Generating Shortcuts and Replicas [page 501]).

2. Select one of the following tabs and deselect the properties that you want to edit locally:

o Attributes - Lists the attributes of the replica. Deselect the check box of an attribute to make it editable.

i Replication Properties M=l E3

General Athibutes I I:::ullectiu:unsl Sub-HeplicatiDnsl

Frecizion

Server validation rule
it

ppercase

Desynchronized atiributes

-

k. Cancel | Spply I Help

o Collections - Lists the collections of sub-objects and related objects of the replica. Deselect the check box
of a collection to make it editable.

o Sub-Replications - Lists the sub-objects replicated as part of the object replication. Click the Properties
tool to open the property sheet of the sub-replication in order to make one or more of its properties

editable.
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3. Click OK to close the replication property sheet and return to the property sheet of the replica. The properties
that you have deselected are now editable.

1 Note

To break the replica's link to its source object and turn it into an independent object, click the Delete
Replication button on its Version Info tab. To make multiple replicas into independent objects, select

| Model » Replications 3 to open the List of Replications, and delete the relevant replications.

2.3.2.3 Viewing Replicas

Replicas resemble normal objects, but all or part of their property sheets are read-only. The link between the
replica and its target object is managed by an intermediate object, a replication, which can be opened by clicking

the Properties tool on the replica's Version Info tab or by selecting |+ Model ¥ Replications 3 to open the List of

Replications.

R List of Replications

| & G X80

g, | (] & -

[ | ] 4|

Driginal Objese =¥ Feplica Dbject > § Onginal Dbje « Driginal Model =
B | dentifier |dentifier Damain Froject M anagement [FDM)]
7 b atenal b atenal Table Froject M anagement [FOM)]
g k ernber t ermbier Takle Praoject M anagerment [FOR)
9 b ey b ey Cramain Project M anagement [FOR)
10 M ame M arme Cramain Project M anagerment [FOR)
11 Phone Phone Cramain Project M anagement [FOR)
12 Project Project Table Project M anagement [FOR)
13 Short description i Short description i Domain Froject M anagement [FDM)]
14 Tazk, Tazk, Table Froject M anagement [FDM)]
15 Taszk date control i Taszk date control i Businezs Rule i Project Management [FDM)]
16 Team Team Takle Praoject M anagerment [FOR)
17 IJzed IJzed Table Project M anagement [FOR)
1| | v

x|

Cancel

Smply | Help

As each replica requires a replication, you can view all the replicas present in the model from this list. You cannot
create replicas here (see Creating Replicas [page 492]), but you can access the property sheets of replications
and, from there, the property sheets of replicas and their target objects (see Editing the Properties of a Replica

[page 495)).

If you delete a replication from the list, the associated replica will lose its link to its target object and become an

independent object.

To view all the replicas for a particular type of object in a model, open the appropriate list by selecting [+ Model

<Objects> 4, and look for checkmarks in the R[eplica] column:
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= COMPOSE Table i [
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3 Driviizion DIWISION Table [V [
4 Employes EMPLOYEE Table [V [
5 M atenal MATERIAL Table [ [
E Member MEMEER Table [ [
7 Praoject PROJECT Table v [
8 Task T&SE Table v [
3 Team TEAM Table v [
10 Ilzed ISED Table [ f |
. | [T

| k. I Cancel | Spply | Help

If this column is not visible, click the Customize Columns and Filter tool, and select the Replica attribute to add it
to the list.

Any property that is synchronized (and thus not editable) is grayed.

2.3.2.4 Comparing and Merging Replicas

You can compare and merge the properties of a replica with those of the original object. When merging models, to
merge a replica as a replica, you must merge the replica and its associated replication. If you merge only the replica
and not the replication (which links it to the original object), the replica will be transformed into an independent
object.

For more information about comparison and merging see Comparing and Merging Models [page 395].

2.3.3 Synchronizing Shortcuts and Replicas

When you make changes to a target object, the shortcut or replica is synchronized instantly or, if the referencing
model is closed, when it is next opened. Both the referencing and target models must be open for synchronization
to occur.

If you create an external shortcut or a replica from a target model that has never been saved, you should save the
target model before the referencing model in order to allow synchronization between the models. If you attempt to
save the referencing model first, you will be prompted to save the target model.
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2.3.4 Viewing Shortcut and Replica Dependencies

To view all the objects that are linked to or otherwise depend on a shortcut or replica, open the property sheet of
the shortcut or replica and click the Dependencies tab. To view all the shortcuts or replicas that have been created
from a target object, open the property sheet of the target object and click the Dependencies tab and the
Shortcuts or Replicas subtab.

Context

The Dependencies tab on a shortcut or replica property sheet lists all the objects dependent on the shortcut or
replica in all the models open in your workspace, and we recommend that you review this tab before deleting the
object from your model. You can double-click an entry in the list to display the dependent object's property sheet,
or click the Impact and Lineage Analysis button to determine the impact of deleting the shortcut or replica.

il x
General Dependencies | Yersion Info I
ﬁ EE) vg.? Impact and Lineage Analysis... |
Narme | Cade | Child Table | Parent Table |

%:. Referenc... REFEREMC... Matenal Orders [Shor...

Eﬂ Referenc... REFEREMC... Matenal Orders [Shor...

L I incoming References f

% - | ] 4 I Cancel Apply Help

The Shortcuts and Replicas subtabs on an object property sheet Dependencies tab list all the shortcuts and
replicas that have been created from the object in all the models open in your workspace:
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2.3.5 Working with Target Models

Shortcuts and replicas that you create yourself, as well as the shortcuts that PowerDesigner creates automatically
when you link or map objects or perform other tasks, all point to objects in other models, which are called target
models.

These models are listed in the Browser in the Target Models category with status icons to indicate whether your
local copies are the latest available in the repository (see The Browser [page 38]).

This list of models is also available by selecting |+ Model » Target Models 3.
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You can use the tools on this list to open a target model, view its properties, or change or delete it. For information
about all the tools available on this list, see Object Lists [page 118].

1 Note

If you delete a target model from the List of Target Models, you will also delete all the shortcuts that reference it
in the present model and transform any replicas that reference it into independent objects. You cannot undo
deleting or changing a target model.

2.3.6 Generating Shortcuts and Replicas

If you generate another model from your model, you can choose to generate your shortcuts as shortcuts, to
transform them into independent objects, or not to generate your shortcuts and replicas. If you choose to generate
your shortcuts and replicas when generating to another type of model (for instance, a PDM from an OOM), then
you must first generate their target models so that they will have appropriate target objects to synchronize from.

For instance, if you have shortcuts of classes in your OOM, and want to generate a PDM from it, you should
generate your target OOMs to PDMs, so that the table shortcuts generated from your class shortcuts will have
target table objects to synchronize with. In the following example, the class shortcuts in OOM?2 are generated to
table shortcuts in a PDM2:
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Shortcut creation

Class
QOM 1
Generation
Table
PDM 1

Caorrect link for shortcut

Class
oom2 &——
Generation

Table

PDM2 EH

The necessary steps for correctly generating the class shortcuts and replicas as table shortcuts and replicas are:

1. Create the classes in OOML1, and create shortcuts or replicas to them in OOM2. Ensure that the Generate
option on the shortcut properties sheet is selected and that the Generated as option is set to Shortcut (see
Shortcut Properties [page 488)]). For replicas, you must ensure that the Generate option on the associated
replication property sheet is selected (see Editing the Properties of a Replica [page 495]). If this option is not

502

selected, the replica will not be generated.

Generate OOM1 to PDM1 (see Generating Models [page 465]) to provide target table objects for the shortcuts

and replicas to be generated from OOM?2.

Before generating OOM2 to PDM2, review the Target Models tab of the model generation dialog (see Model
Generation Options [page 466]) to ensure that PDML1 is listed in the Generated Models column. If OOML1 is
closed in the workspace, you should click in the Generated Models column to open it, and you can then select

PDMI1 from the list in the cell:
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4. Click OK to perform the generation. Your shortcuts and replicas will be retained in the generated model.

2.4 Object Mappings

Object mapping allows you to establish connections between objects belonging to heterogeneous models and
diagrams. You create mappings between objects to model O/R (Object-Relational) mappings, which associate
classes with tables to store OOM objects into a relational database, or simply to express a correspondence
between objects in different models.

The following table lists the supported types of model-to-model mapping in PowerDesigner:

Source Model CDM Target LDM Target PDM Target OOM Target XSM Target
CDM X X X X

LDM X X X X

PDM X X X X X

OOM X X X X
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Source Model CDM Target LDM Target PDM Target OOM Target XSM Target
XSM X
1 Note

Mappings are also used to define data replications in the DMM. For more information, see Data Movement
Architecture > Replication Modeling > Data Movement Diagrams > Replication Processes (DMM) .

You can create mappings:

e inthe Mapping Editor - which gives you a global view of all the mappings to objects in the current (target)
model (see The Mapping Editor [page 5087)

e on the Mapping tab of the property sheet of the target object (see Creating Mappings from an Object's
Property Sheet [page 522])
e During model generation, by selecting the Generate Mappings option in the Model Generation Options window
(see Generating Models [page 465]).

Each mapping is recorded in a query, a textual expression or an XPATH expression defined in the target object,
which permits the selection of data from the data source and its transfer to the target model. You can view and
refine these mappings in the Mapping Editor.

The following tables list the objects that can be mapped for each kind of model.

CDM Mappings

CDM objects can be mapped to other model objects as follows:

CDM Source Objects

CDM Target Objects

LDM Target Objects

PDM Target Objects

OOM Target Objects

Entity Entity, Association, Re- | Entity, Relationship Table Class, Association
lationship

Entity attribute Entity attribute, Associ- | Entity attribute Column Class attribute
ation attribute

Relationship Entity, Association, Re- | Entity, Relationship Table, Reference Class, Association
lationship

Inheritance Inheritance Inheritance - -

Inheritance attribute

Inheritance attribute

Inheritance attribute

Association Entity, Association Entity, Relationship Table, Reference Class, Association
Association Attribute Association attribute, Entity attribute Column Attribute
Entity attribute
Data item Data item - - -
Domain Domain Domain Domain Domain
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1 Note

You can map inheritances with CDM objects only when its child entities are not generated, i.e. when the
"Generate children" option is deselected in the Generation tab of the inheritance property sheet.

LDM Mappings

LDM objects can be mapped to other model objects as follows:

LDM Source Objects

CDM Target Objects

LDM Target Objects

PDM Target Objects

OOM Target Objects

Entity Entity, Relationship, As- | Entity, Relationship Table Class, Association
sociation

Entity attribute Entity attribute Entity attribute Column Attribute

Relationship Entity, Relationship Entity, Relationship Table, Reference Class, Association

Inheritance Inheritance Inheritance Reference Generalization

Inheritance attribute Inheritance attribute Inheritance attribute - -

Domain Domain Domain Domain Domain

PDM Mappings

PDM objects can be mapped to other model objects as follows:

PDM Source Ob- | CDM Target Ob- LDM Target Ob- PDM Target Ob- OOM Target Ob- XSM Target Ob-
jects jects jects jects jects jects
Table Entity, Relationship | Entity, Relationship | Table, Fact,Dimen- | Class, Association | Element, Complex
sion type
Table column Entity attribute Entity attribute Table column, Attribute Element, Complex
Measure, Dimen- type
sion attribute
View - - Fact,Dimension Class -
View column - - View column, Table | Attribute -
column, Measure,
Dimension attrib-
ute
Reference Relationship Relationship Reference Class, Association | -
Domain Domain Domain Domain Domain -
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OOM Mappings

OOM objects can be mapped to other model objects as follows:

OOM Source Objects

CDM Target Objects

LDM Target Objects

OOM Target Objects

XSM Target Objects

ation attribute

tance attribute

Class Entity, Association, Re- | Entity, Relationship, In- | Class Element, complex type
lationship heritance
Attribute Entity attribute, Associ- | Entity attribute, Inheri- | Attribute Element, Complex type

Generalization Inheritance Generalization
Association Association Entity, Relationship
Domain Domain Domain Domain

XSM Mappings

XSM elements and complex types and their attributes can only serve as source objects for mapping to other XSM
elements, complex types and attributes, but they can serve as the targets for mappings from OOM or PDM source

objects.

2.4.1 Creating a Data Source

A data source provides a connection to one or more other models for mappings and (in the PDM) can also provide
a connection to a database. You are prompted to create a data source with a wizard the first time you open the

Mapping Editor or click the Create Mapping tool on an object property sheet Mappings tab.

Procedure

1. Onthe Data Source Identification page, enter an appropriate name for the data source, and then specify an
access type, which, for PDM data sources, controls the types of queries available in the Mappings pane, and
the availability of forward (Source > Target) and reverse (Target > Source) mappings. You can choose between:

o Read/Write — Enables Criteria, Select, Insert, Update and Delete queries.

o Read-Only - Enables Criteria and Select queries. You can only create forward mappings, and the data
source is not displayed during reverse mapping (see Creating Reverse Mappings [page 521]).

o Write-Only - Enables Criteria, Insert, Update and Delete queries. You can only create reverse mappings,

and the data source is not displayed during forward mapping.

2. Select the type of the model to use as the data source, and click Next to go to the Source Model Selection

page.

3. Select one or more models from the list of open models in the workspace, and then:
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o For data sources created from an object's Mapping tab - click Finish to create the data source and open a
selection dialog to choose the external object to map to.

o For data sources created from the Mapping Editor - click Next to go to the Options page. By default, the
Create default mappings option, which creates mappings where possible based on shared names, is
selected. Click Finish to create the data source and proceed to the Mapping Editor.

To view or edit a data source's properties, double-click its Browser or list entry. The property sheet tabs and
fields listed here are those available by default, before any customization of the interface by you or an
administrator. The General tab contains the following properties:

Property Description

Name/Code/Comment | Identify the object. The name should clearly convey the object's purpose to non-technical users,
while the code, which is used for generating code or scripts, may be abbreviated, and should not
normally include spaces. You can optionally add a comment to provide more detailed informa-
tion about the object. By default the code is generated from the name by applying the naming
conventions specified in the model options. To decouple name-code synchronization, click to re-
lease the = button to the right of the Code field.

Model Type Specifies the type of the models referenced in the data source.

Access type For PDM data sources, controls the types of queries available in the Mappings pane, and the
availability of forward and reverse mappings.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, separate
them with commas.

The following tabs are also available:

o Models - Lists the models associated with the data source. Use the Add Models tool to add models openin
the current workspace.

o Database Connection - [for data sources created in a PDM] Contains the parameters needed to connect to
the database associated with the data source. Click the Select a Data Source tool to specify an ODBC data
source or connection profile (see Connecting to a Data Source [page 30]).

o (Cost - [for data sources created in a PDM that supports lifecycle modeling] Lets you specify the cost per
GB of storage for the data source along with the compression rate, which is used to estimate the relative
size of the data once it has been loaded to the data warehouse (where 100% indicates no compression).

o Data Movement (Lifecycle) - [for data sources created in a PDM that supports lifecycle modeling] Lets you
define parameters to connect to a remote database, whose data will be loaded into the warehouse.

1 Note

For information about the Create Data Source and Add Model to Data Source tools available in the Mapping
Editor, see Mapping Editor Tools [page 520].
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2.4.2 The Mapping Editor

The Mapping Editor provides a graphical interface for creating and viewing mappings between models or between
metamodels. It provides a global view of all the mappings to objects in your model, allowing you to quickly identify
those which are mapped and unmapped.

P =~

Mapping Editor 'El
Source |4 [+ Target

|£.Jiﬂﬂ.§f EEY =T,
L) iActivity: 1 Member 7
E‘) Start date {act) +—— T Paticipate
L 5 End date (act) +—— T Project
[ Customer — E Task
E}'). Diivision ] Project number
= E}') Employes E. Task name
[ Material 5 Start date (act)
[ Patticipate @ End date (act) g
[ Project 5 Task cost 3
E}'). Task I Team
|L = [ Team ] Used 5
m 1 Daldinmabina m A NMarm—ims

Table Mappings - Task (TASK)

M apping: [E. COM Task Mapping_1 - ]
BB X AP ES-

Mame - Code » | Display Na = a
1 Activity ACTIVITY Activity 2
2 Task TASK Task j
4| i | v

|« I, Table Sources £ Mappedto j Base Columns Mapping /

& Flay Demo | ok ] [ Cancel ] [ Apply ] [ Help ]

To open the Mapping Editor, select |+ Tools » Mapping Editor 3. If no data source is defined in your model, you will
be prompted to create one (see Creating a Data Source [page 506]).

The Mapping Editor window is divided into three panes:
e Source - on the left side has a gray background and contains one or more data sources, which each contain
one or more models. Expand the model nodes to display all their mappable objects and sub-objects.
1 Note

To expand all nodes, click in the pane and press the number pad * key.

e Target — on the right side has a white background and contains all the mappable objects and sub-objects in
your model. The details of any mappings you create are saved in the objects in this model.
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® Mappings - at the bottom contains either a list of mappings (when a model, package or folder is selected) or
the selected object's property sheet Mappings tab (see Object and Sub-Object Mapping Properties [page
525]).

Mappings are represented as links drawn between a source and a target object, with an arrow at one or both ends
to indicate in which directions data can flow. Double-clicking the link in the Source or Target pane opens the
property sheet of the source or target object, while clicking it in the area between the panes, displays the
properties of the mapping in the Mappings pane.

An overlay is displayed on the bottom right corner of objects bearing mappings (and, for sub-objects, their parent
objects) and a smaller overlay on the containing model, package or folder (or, for XSM elements, ancestor
elements):

Mapped Object Containing Model, Package, or Folder

Source Source

&) = ) =

1 Note

Click the Play Demo tool in the lower-left corner of the Mapping Editor window to launch a video that briefly
illustrates its main features.

2.4.2.1 Model-to-Model Mappings

You can create mappings in the Mapping Editor by drag and drop, or by using the Create Mapping tool or
contextual command. You can select multiple objects and sub-objects in the Source pane using the or

keys, but only one object in the Source pane.

To create a mapping, perform one of the following actions:

e Drag and drop - Select one or more objects and sub-objects in the Source pane and drag and drop them onto
an object or sub-object in the Target pane. The pointer becomes a barred circle when it is over an object to
which the selected objects cannot be mapped, and if one source object in a multi-selection would create an
invalid mapping, the whole selection is rejected.

e Target pane - Select an object or sub-object in the Target pane and (optionally for objects), one or more objects
and sub-objects in the Source pane and click the Create Mapping tool (or right-click one of the selected objects
and select Create Mapping). If the selected source objects are ambiguous or would create an invalid mapping,
a selection dialog opens, allowing you to select the source objects to map to.

e Mappings pane - Select an object or sub-object in the Target pane and click the Create Mapping tool in the
Mappings pane. For objects, a selection dialog opens, allowing you to select the source objects to map to. For
sub-objects, an empty mapping is created, which you should complete by selecting a source object on the
Sources sub-tab.

e Default mappings - To create default mappings between source and target objects that have the same name,
right-click a data source and select Generate Default Mappings.
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1 Note

If a mapping already exists between a source and target object, then dragging and dropping will reuse and add
additional information to the existing mapping object, while using the Create Mapping tool or contextual
command will create a second mapping object. Each mapping object is available in the Mapping list at the top of
the Mappings pane.

Mappings can be created for combinations of source and target objects and sub-objects as follows:

e Source object mapped to target object - The objects are mapped together, and any sub-objects that have the
same name and code are also mapped together. A mapping overlay is displayed on each of the source and the
target objects and sub-objects mapped, and a link is drawn between them:

= [ {Division} —+=) [ Division
ﬁ', Divigion number #+— > E. Division number
ﬁ', Division name #+—— > E. Division name
ﬁ', Division address #+— > E. Division address

The mapping details are shown in the Mappings pane. The source objects are shown on the Sources sub-tab,
and any sub-objects are shown on the <Ssub-object> Mappings sub-tab.

e Source sub-object mapped to target sub-object — The sub-objects and their parent objects are mapped
together and the mapping is added to the list on the <sub-object> Mappings sub-tab of the parent object.

I | E Task
=] Project number
[ End date (act) =] Task name
= [ Customer —FE Start date (act)
[ Customer number =] End date {act)
[ Customer name =] Task cost

e Source sub-object mapped to target object — The parent source object is mapped to the target object.
e Source object mapped to target sub-object — Not permitted.

Mappings (including sub-object mappings) are always stored in target objects (for example, a mapping between a
source CDM entity attribute and a target PDM table column will be stored in the table).

1 Note

In an XSM, elements can appear at any level in the hierarchy, and objects and sub-objects can be freely mapped
to any element. Each element (whether parent, child, or grandchild) stores its own mappings, except in the case
of elements bearing a complex type, where all mappings to any sub-elements are stored on the element bearing
the type (though they are displayed on the sub-elements).
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If you open the Mapping Editor with a source or target XSM containing shortcuts to complex types in a closed
model, PowerDesigner will offer to open the model for you. If you choose not to open the model at this time, you
can do so at any time by right-clicking a shortcut and selecting Open Model:

Shortcuts Closed ‘ Shortcuts Open

= [ Elements = [ Bements
= Client =] Cliert
= [l Name = [E Mame
Name = G Name
[E] Address Title

First Name
Family Mame

2.4.2.2 Object to Relational (O/R) Mappings

Developers tend to use object-oriented programming languages like Java, to develop business objects and
components. These objects can be stored in a database. A problem arises when the user tries to store objectsina
relational database because object modeling describes a system through objects that have identity, behavior and
encapsulated state whereas relational modeling describes a system by its data.

In addition, object language object codes are often different than the codes used to identify tables and columns in
arelational database, so that you will need to modify them when generating an OOM into a PDM or vice versa.

You can use object mapping to bypass this impedance-mismatch.

The following schema illustrates the link between classes and tables to store objects in a relational database:
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O/R mapping

PDM || OOM
Table_1 I Class 1
|
|
Table_2 Class 2
|
|
Table_3 | Class 2
|
|
Generation ! Generation
|
|
|
. AN
Relationa o
Database AcCcess Application

Object persistence implies to store and extract objects in a relational database.

Mapping Classes with PDM Objects

When a class inherits from a non-generated class via a generalization link, the attributes of the class appear in the
Selection dialog box in order to let you create a mapping with these inherited attributes. The attributes of a non-
generated derived class also appear in the Selection dialog box.

Mapping Associations with PDM Objects

O/R mapping on an association allows you to define the role navigability of an association in the database. When
an association role is not navigable, there is no need to design a mapping for the association since no information
is transmitted between the classes. However, when an association role is navigable, you have to set up the
structure for data transmission within the database. In relational databases, data transmission is implemented via
foreign keys designed to relate a record in one table with a record in another.

Core Features Guide
512 PUBLIC Linking and Synchronizing Models



The type of mapping for an association depends on the association multiplicity:

e One-to-one or one-to-many associations can be mapped to a reference in the source model. This reference is
used in the database to transfer data and migrate key columns to the appropriate table

e Many-to-many associations have to be mapped to an associative table. This table is created to maintain a
relationship between two or more tables in a relational database. The columns contained in the associative
table are the combination of the keys in the tables involved in the reference. For example, the following classes
have a many-to-many association:

Account 1.7 Customer

custormerll ;int
lastMame  : String
campany  : 5tring
address : ADDRESS

+ balance vint AuCESSES

+ accountbumber :int \
iz corsulted

+ + + |+

In a relational database, this association is mapped to the following associative table:

Aecount Customer
balance INTESER customerll |NTEGER =ph=
ascourtMumber INTEGER <pk: lastName  TEXT

company  TEXT
address SERIAL  <fks
FE_ASSOCTR ACCOUNT
FE_ASSOCICUSTOME
Aszociation_1
customerlD INTEGER =phfld>
dccountlumber INTEGER <phfhl=
SQL Queries

When the association roles are navigable, the following queries are automatically computed:

Query Action

Select (Role A) Retrieves related class A instances for the role A defined on class B

Insert (Role A) Associates an instance of class A with class B. It is computed only when the source association is
an associative table

Delete (Role A) Deletes from class B the association with class A. This query is computed only when the source
association is an associative table

Select (Role B) Retrieves related class B instances for the role B defined on class A

Insert (Role B) Associates an instance of class B with class A. This query is computed only when the source as-
sociation is an associative table

Core Features Guide
Linking and Synchronizing Models PUBLIC 513



Action

Delete (Role B) Deletes from class A the association with class B. This query is computed only when the source
association is an associative table

2.4.2.3 Operational to Warehouse Data Mappings

Data warehousing requires the extraction, transformation, and loading of data from operational systems to a data
warehouse database. You can create mappings between operational and data warehouse data and from the data
warehouse data and OLAP cubes. To review or edit these mappings, open your multidimensional diagram, and

then select | Tools  Mapping Editor .

You can model operational and data warehouse data structures in PDMs, and specify mappings between the
operational data sources and the data warehouse to generate extraction scripts to populate the data warehouse
with operational data. In this kind of relational-to-relational mapping, operational tables are mapped to data
warehouse tables with a type of fact or dimension, and operational columns are mapped to warehouse columns.

The Generate Cube wizard automatically creates mappings between source tables and facts and dimensions and
you can modify these or manually create mappings between these objects:

Mapping Editor o )
|Source Target
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B = Q‘Lg Sales = Eﬁ, Staging_Sales
B2 [ Tables = 4 Facts
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E Customer = [ Associations
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3 5 Product Family i [im Product Family_Product
E Region :/ = [ Measures
= 55 Sale _,_f“‘-f_ iy Sales ID
E Sales ID » iy Quantity
EProductlD— > gy Unit Cost
e (55 Customer D — # i Discount
(55 Quartity =l [ Attributes
E Unit Cogt —M8MMM # :i& Product ID
il 3 Discount—— > ¢ Customer ID

Fact Mappings - Sale (SALE)
M apping: [% Sales.Sale.Mapping_1 - ]
B-rE-Hd3N[ DA F[nc
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BADLINGT.PRODUCT FAMILY.PRODUCT FRMILY ID "PRODUCT FRMILY PRODUCT FRMILY ID", D
BADLINGT.FPRODUCT FAMILY.PRODUCT FAMILY NAME “FRODUCT_FAMILY MAME™,
BADLINGT.FRODUCT . FRODUCT_ID "PFRODUCT_ID™,
BADLINGT.PRODUCT . FRODUCT MAME "ERODUCT NAME™, -
4 [t :

| J%Fact Sources  Mappedto 3 Named Objects Mapping j Criteria } Cube Select £ Cube Criteria ) Select }, SAPHANA1D /

i Play Demo ook ][ cancel] | appb | [Lohep.]
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The Select sub-tab displays the SQL statement used to select data in the data source. The Generate Cube Data
wizard uses this SQL statement to fill the text files used to populate cubes in an OLAP database.

2.4.2.4 XML Import Mappings

You control how elements defined in an XML schema are imported by mapping them and their attributes,
compositions, and aggregations to objects in the PowerDesigner metamodel. The XML schema is analyzed and
presented as a list of metaclasses on the left side of the Mapping Editor and the PowerDesigner metamodel (and

any extensions) are displayed on the right side.

Context

1 Note

It is not necessary to map all metaclasses (or all their contents), but only those with which you want to work. If
the PowerDesigner metamodel does not contain appropriate metaclasses, attributes, compositions, or
aggregations to map against, you can create them dynamically here or save any existing mappings, close the
Mapping Editor, define or attach appropriate extensions, and then reopen the Mapping Editor to map to them.

Procedure

1. Drag and drop an external metaclass to a PowerDesigner metaclass to create an import mapping. Any external
attributes and collections are automatically mapped to PowerDesigner attributes with which they share a

name:

= E3 Rules (PERRuleOR11R2) +
= [ Attributes

o CSADMName
Caption
CheckConstraints {Id)
GallerylD
Gallerytem|D
GalleryObject|D
GenerateCode
GlobalOrder
Id
lgnoreMC
Name

@ 0 B O 80 8 8 O a 0

v

—w=] Eg BusinessRule
= [ Attributes

O Annotation
Client Expression
Code

Comment
Description
DisplayName

3 KeywordList

O B B O a

— %, Mame

o QCLConstraint
O ServerbBxpression

o Stereotype

By default, the Mapping Editor lists the standard attributes and collections of metaclasses, which are normally
displayed in object property sheets. To display all available properties, click the Filter Properties tool, and

Core Features Guide
Linking and Synchronizing Models

PUBLIC 515



select Show All Properties. You can also filter the tree by using the Filter Mappings and Filter Objects

tools.

1 Note

If no suitable metaclass exists, to create and map to a new extended metaclass based on the
ExtendedObject metaclass, drag and drop the external metaclass onto the PowerDesigner metamodel

root.

2. Drag and drop additional attributes under the metaclass to PowerDesigner attributes with compatible data
types to create mappings for them. Attributes are contained in a folder under the metaclass and represent
individual properties such as Name, Size, DimensionalType, which have boolean, textual, numeric, or object ID

values:

= E5 Entities (PEREntityOR11R2)

= [} Aftributes

O AccessDriverType
AccessParameters
AfterScript

, BeforeScript #+
CSAOName

Hgl B B

E B3 Table

= [, Altributes
i AbstractData Type
o %.!jnntation__

=] Cheu:kCDn;tlairrt MName
@ CheckExpressionPreview

PowerDesigner identifies sub-object metaclasses in the schema that are limited to a single instance and
displays a 1 overlay on their icons. Attributes under such metaclasses are treated as belonging to the parent
metaclass and can be mapped to attributes under the PowerDesigner object with which the parent is mapped:

= RenamerLog (IPERRenamerLogOR11RE)

[= [ Attributes

(m]

B B B B @ &

1 Note

CSAOMName
GlobalOrder
Id

ftems

MName
Ohject Type
Ordinal

If no suitable attribute exists, to create and map to a new extended attribute, drag and drop the external
attribute onto the PowerDesigner metaclass to which its parent is mapped.

3. Dragand drop external sub-object metaclasses (compositions) under the metaclass to PowerDesigner
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compositions to create mappings between them:

S

| Entities (PEREntityQR11R2)
_J Attributes

3 iAttributes (PERAttributeOR11R2)i——

HEEBEED

PUBLIC

B CheckConstraints (PERCheckConstraint EntityOR
B Indexes (PERIndex0R11R2)
B Keys (PERKeyConstraintOR11R2)

= B Table
4 Attributes
_ Collections
& Columns {Column})
_ Attributes
_ Collections
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Any attributes under the sub-object metaclass are automatically mapped to PowerDesigner attributes with
which they share a name. Map other sub-object attributes as necessary.
1 Note

In certain circumstances, it may be appropriate to map an external sub-object metaclass to a
PowerDesigner object metaclass, and so such mappings are also permitted.

4. Drag and drop external collections (aggregations) under the metaclass to PowerDesigner collections to create
mappings between them:

= E5 Keys (PERKeyConstraintOR11R2) = B Keys (Key)
1 Attributes _d Attributes
= [} Collections = [ Collections
%J Keyltems + % AttachedRequirements
= E Trigagers (FERTriggerEntityOR11R2) % AttachedRules
i Attrbutes I #% Columns

5. Incertain schemas, it may be necessary to identify attributes as references and identifiers to link one
metaclass to another through aggregation:

a. Right-click an attribute and select Declare as Object Reference to specify that it acts as a pointer to
another object. Such attributes often have a type of GUID, Token, or NCName (PowerDesigner
automatically identifies attributes of type IDRef as references). A rounded arrow overlay is added to the
attribute icon:

= E3 Entities (PEREntityOR11R2)
= ) Attibutes

0 AccessDrverType
0 AccessParameters
O AfterScript
5, BeforeScript
o CSAOMName
o Caption

o Category (Id)

=]

b. Open the metaclass that the object reference points to, select its identifying attribute, right-click it, and
select Declare as Unique Identifier. A key overlay is added to the attribute icon:
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= E3 Users (DBUserOR1T1R2)
= 4 Attibutes

o CSAOMName
Caption
Children {1d)
CodeGenerators (|d)
GallerylD
GalleryttemID
GalleryObjectID
GlobalOrder

B B B B B B O

......

c. The object reference attribute can now be mapped to a PowerDesigner attribute of type object (which also
bears a rounded arrow overlay):

O Commerts | | g Mumber
™ DbOwner {Id) - » %, Owner
= Directory (Id) | | O PartitionRange

6. [optional] Select a metaclass and enter an initialization or post-processing script to modify the objects at or
after creation (see Metamodel Mapping Properties [page 5277).

7. [optional] Click the target model (root node) to display the global list of mappings in the Mappings pane at the
bottom of the dialog and use the arrows at the bottom of the list to change the order in which objects are
imported to ensure that dependencies are respected.

1 Note

To control the order in which attributes, compositions, and aggregations are imported within objects, select
the target metaclass to display its mappings in the Mappings pane, and use the arrows at the bottom of the
lists on the Attribute Mappings, Collection Mappings, and Sub-Object Mappings sub-tabs.

8. Click Apply to save your changes.

2.4.25 Model-to-Model Generation Mappings

You control how metaclasses from one PowerDesigner model type will be generated to metaclasses in another
model type by mapping them and their attributes and collections in the Mapping Editor. Any extensions defined for
the source or target metamodels are displayed and available for mapping.

Context

1 Note

It is not necessary to map all metaclasses (or all their contents), but only those with which you want to work. If
the PowerDesigner metamodel does not contain appropriate metaclasses, attributes, compositions, or
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aggregations to map against, you should save any existing mappings, close the Mapping Editor, define or attach
appropriate extensions, and then reopen the Mapping Editor to map to them.

Procedure

1. Drag and drop a metaclass from the source pane on the left to a metaclass in the Target pane on the right. Any
source attributes are automatically mapped to target attributes with which they share a name:

F E3 BusinessFunction —»-] B Process

= i Aitributes = [ Adtributes
%, Annotation -+ @ ActionType
%, Code + _ﬁ-\-‘“\— ——— [ Annotation
%, Comment _ﬁ-\-‘“\— ———* 7 Code
ﬁT:_}} Default Diagram #—— _ﬁ-\-‘“\— — Comment
%, Description _ﬁ-\-‘“\— — Default Diagram
%, Mame « _ﬁ-\-‘“\— —— 7, Description
3, Stereohype 4 @ Duration

= i Collections ™ EmissionComelation
@i‘}‘ AttachedRequirements +¥—— @ ImplementationMode
@i‘}‘ AttachedRules +#———— i Implemernter
@i‘}‘ RelatedDiagrams +—— O LoopBExpression
% Sites O LoopType

H Rolefssociations (Rolefssociation) ———* & Name

1 Note

By default, the Mapping Editor lists the standard attributes and collections of metaclasses, which are
displayed, by default, in object property sheets. To display all available properties, click the Filter Properties
tool, and select Show All Properties. You can also filter the tree by using the Filter Mappings and Filter
Objects tools.

2. Drag and drop additional source attributes under the metaclass to target attributes with compatible data
types to map them. Attributes are contained in a folder under the metaclass and represent individual
properties such as Name, Size, DimensionalType, containing boolean, textual, numeric, or object ID values:

3. Drag and drop source sub-object metaclasses (compositions) under the metaclass to target compositions to
create mappings between them:

Any attributes under the source sub-object metaclass are automatically mapped to target attributes with
which they share a name. Map other sub-object attributes as necessary.

1 Note

In certain circumstances, it may be appropriate to map a source sub-object metaclass to a target object
metaclass, and so such mappings are also permitted.

4. Drag and drop source collections (aggregations) under the metaclass to target collections to create mappings
between them:

5. [optional] Select a metaclass and enter an initialization or post-processing script to modify the objects at or
after creation (see Metamodel Mapping Properties [page 5277).
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6. [optional] Click the target model (root node) to display the global list of mappings in the Mappings pane at the
bottom of the dialog and use the arrows at the bottom of the list to change the order in which objects are
generated to ensure that dependencies are respected.

1 Note

To control the order in which attributes, compositions, and aggregations are generated, select the target
metaclass to display its mappings in the Mappings pane, and use the arrows at the bottom of the lists on
the Attribute Mappings, Collection Mappings, and Sub-Object Mappings sub-tabs.

7. Click Apply to save your changes.

2.4.2.6 Mapping Editor Tools

The Mapping Editor Source and Target panes contain tools to help you create and review your mappings.

The following tools are available in the Source pane:

Tool Description

=)

Properties - Opens the property sheet of the selected source object.

[

Create Data Source - Launches the Data Source Creation Wizard (see Creating a Data Source [page 506]).

4|

Delete Data Source - Deletes the selected data source, along with any associated mappings.

You can delete all the mappings from a source object by selecting it and pressing Delete or right-clicking it and
selecting Delete Mapping. You can delete a source object from the source model by selecting it and pressing Shift
+Del or right-clicking it and selecting Delete).

Add Model to Data Source - Adds one or more source models of the same type to the selected data source.

Remove Model from Data Source - Deletes the selected model from the data source, along with any associated
mappings.

Find Source Object - Opens a Find dialog to search for an object in the Source pane.
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The following tools are available in the Target pane:

Description
|§T| Properties - Opens the property sheet of the selected target object.
|§| Create Mapping - Creates a mapping between the selected source and target objects (see Model-to-Model Map-

pings [page 509]).

|%| Delete Mappings - Deletes all the mappings for the selected target object. Alternately, press Delete or right-click
the object and select Delete Mapping. You can delete a target object from its model by selecting it and pressing
Shift+Del or right-clicking it and selecting Delete.

|F’ﬁ,v | Filter Mappings - Filters the display of mapping lines to show all mappings or only the mappings on the selected
object or those on the selected object and its sub-objects.

|.,E|v | Filter Objects - Filters the display of both the Source and Target trees to show all objects or to show only those
objects with or without mappings.

|E| Find Target Object - Opens a Find dialog to search for an object in the Target pane.

2.4.2.7 Creating Reverse Mappings

The default forward mappings define how to populate the objects of the current model with those of the data
source model. Reverse mappings are typically used in PDM-OOM mapping when, for example, data has several
sources and you want to define how the data in the OOM is inserted, updated or deleted in the PDM.

To switch to reverse mapping mode, click the left arrow at the top of the area between the Source and Target
panes. The left pane is renamed to Target and the right pane to Source, and the mapping tools which appear at the
top of each pane are switched:

faget__________|& Hoowce___
B # s Y 0 Bar  oP pire

EditDiata Source Mappingg
|E| [i =0l | I|j T bjectdrientedtodel_1
1 Note

Mappings are always saved in the model on the right-hand side (the model from which you launched the
Mapping Editor), whether the pane is called Target or Source.

If the access type of your data source is Read/Write (see Creating a Data Source [page 506]), then each mapping
that you create is, by default, bi-directional (with an arrow at each end). To create a:

e Read-only (ie forward-only mapping), create the mapping in forward mode and then switch to reverse mode
and select and delete it. The mapping link now becomes dotted and has an arrow only on its right end.

e \Write-only (ie reverse-only mapping), create the mapping in reverse mode and then switch to forward mode
and select and delete it. The mapping link now becomes dotted and has an arrow only on its left end.
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When you create uni-directional mappings in this way, the following types of link line can be visible:

Reverse Mode

Forward Mode ‘ Mapping Type

Forward and reverse (read-write) mapping

Forward only (read-only) mapping

Reverse only (write-only) mapping

Solid lines indicate that you can edit the details of the mapping in the Mappings pane (which, in reverse mode, is
renamed to Reverse Mappings). In reverse mode, you can modify the default reverse mapping by editing the Insert,
Update and Delete sub-tabs.

2.4.3 Creating Mappings from an Object's Property Sheet

You can create mappings to an individual object on the Mapping tab of its property sheet. Mappings created in this
way will be visible the next time you open the Mapping Editor.

Procedure

1. Open the property sheet of the object you want to create mappings to and click the Mapping tab.
2. Click the Create Mapping tool to the right of the Mapping list to create a new mapping for the target object. If:

o No data source has yet been created in the model you will be prompted to create one (see Creating a Data
Source [page 506]).

o Several data sources are available, you will be prompted to select one and click OK.
3. Select the object from the data source to map to the present object and click OK to create the mapping.

The new mapping is added in the Mapping list and the mapped object is displayed in the Object Sources sub-
tab:
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4. [optional] Click the Add Objects tool to select more source objects to map with the object.
5. Click the Sub-Object Mapping sub-tab and add or remove mappings between sub-objects (see Object and

Sub-Object Mapping Properties [page 525])
To automatically generate mappings for sub-objects that share a name, click the Generate Mapping tool.

Core Features Guide
PUBLIC 523

Linking and Synchronizing Models



B= Class Properties - parallelPeripheral {(parallelPeripheral)

General I Dretail I Attributes I |dentifiers I Operations I Forts I Farts
Felated Diagrams I Fresie I Dependencies | Extended Dependencies I Yerzion [nfo
Azzociatiohs I |nner Clazzifiers I Script M apping | Java I M otes I Fules

Mapping: I% DataSource_1.parallelPeripheral. b apping_1 j IE @ @
bl We=e s e M R S - R

Attribute b apped to r &=
1 wendort arne FROJ. TEAM. TEANLM
= | perphCodetame PROJ. TEAM. TEASPE ==l

=
=
=
4| | ]
}.,Sele

4| L4 |\Class Sources }\Mappedtu }\.ﬂ.ﬁribLHES happing ,{Operatinns Mapping ACr'rteria

=10l x|

<< Less |% - | k. I Cancel | Apply | Help

6. [optional] Review the other mapping sub-tabs (which are the same as those available from the mapping's own

property sheet (see Object and Sub-Object Mapping Properties [page 525]) and edit them as appropriate.

7. [optional] Use the Mapping list and the tools to its right to review and edit the other mappings defined on the

524

Tool

D)

object:

Description

Create Mapping - Creates a new mapping with the object as a target.

Delete Current Mapping - Deletes the currently selected mapping.

Properties - Opens the property sheet of the currently selected mapping (see Object and Sub-Object Map-
|§| ping Properties [page 525]).
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Description

Launch Mapping Editor - Opens the Mapping Editor (see The Mapping Editor [page 508]).

2.4.4 Object and Sub-Object Mapping Properties

Mappings are sub-objects of the target object on which they are defined. Mappings do not have diagram symbols
or Browser entries, and are only accessible from the Mapping Editor or from the Mapping tab of their parent object
property sheet.

To open a mapping property sheet, select the mapping from the list at the top of the Mapping Editor Mappings
pane or parent object property sheet Mapping tab and click the Properties tool.

b apping; [E. Project Management Entities. Task Mapping_1 = ]

The tabs available on a particular mapping property sheet depend on the objects being mapped. The General tab
contains the following properties:

Property Description

Data Source Specifies the name of the data source in which the source object is defined. Click the Properties tool to
open the property sheet of the data source.

Target Specifies the name of the target object that owns the mapping.

Parent [Sub-object mappings] Specifies the name of the parent of the target object.

Name/Code/ Identify the mapping. The name should clearly convey the object's purpose to non-technical users, while
the code, which is used for generating code or scripts, may be abbreviated, and should not normally in-

Comment ) ) . ; .
clude spaces. You can optionally add a comment to provide more detailed information about the mapping.
By default the code is generated from the name by applying the naming conventions specified in the
model options. To decouple name-code synchronization, click to release the = button to the right of the
Code field.

Mapped to Specifies the mapping expression. You can edit the expression directly in this field, or click the Edit tool to

openitin a dedicated SQL or Object Expression editor. In the editor, select an object type from the list in
the upper left corner, to display a list of available objects of that type in the upper right corner. Double-click
an available object to add it at the insertion point in the expression displayed in the lower half of the editor.

To undo your changes and recover the default expression click to release the User-Defined button.

The following tabs are also available:

e Sources - Lists the source objects mapped to the object. Use the Add Sources tool to add additional source
objects to the list.
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e Sub-Object Mappings - Lists the sub-objects of the mapped object that are mapped with sub-objects of the
object. The following tools are available on this tab.

Tool Description

Properties - Opens the property sheet of the selected sub-object mapping.

|E| Add Mapping - Select additional source sub-objects to map. After adding sub-objects, select the sub-objects
to map them against in the Mapped to column.

Create from Sources - Copy sub-objects from the source object to the object. The name, code , description,
annotation, and comment are copied and the data types are converted in order to match the current model.

|| Generate Mapping - Automatically generate mappings between sub-objects with the same name or code in
the source and target models.

Click the Ellipsis button in the Mapped to column to edit the source expression for the sub-objects.

® Operation Mappings - [OOM classes only] Lists the operations and queries associated with the mapping.
Allows you to associate a SQL query to the operation. When an operation implies action on the database, like
data retrieval or data update, you can associate this operation with a SQL query that will execute an action in
the database. Usually, this query is a SELECT statement used to retrieve one or several instances of the
current class according to the operation parameter. It can also be an UPDATE query. In the context of an EJB,
the SQL query mapped to an operation is used to implement finder or select methods.

e C(riteria - Allows you to specify join criteria between source objects. For example: EMPLOYEE.ID < 100

® Query - Computes a SQL query from the information in the other tabs to retrieve or update data in the
database. If you modify the SQL query, it can no longer be automatically calculated, even when you update the
mapping. You can recover the computed expression by clicking to release the User-Defined tool.
A Select query is available for a forward mapping, and Insert, Update and Delete queries for a reverse
mapping:
o The Select tab retrieves attribute values of class instances from the database using the class identifying
attributes. For example:

select
USER.USERNAME "USERNAME",
USER.PASSWORD "PASSWORD"
from USER

o The Insert tab creates an instance of the class and saves it with its attributes. For example:

insert into USER(
USER.USERNAME,
USER.PASSWORD)

values (
$USERNAMES,
$PASSWORDS%)

o The Update tab displays a statement that allows you to update attribute values of class instances apart
from identifying attributes. For example:

update USER
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set USER.USERNAME = %USERNAMES,
USER.PASSWORD = $PASSWORDS

o The Delete tab displays a statement that allows to delete a class instance from the database using its
identifying attributes. For example:

delete line* from USER

To modify the default syntax of the queries, edit the SelectStatement, InsertStatement,
UpdateStatement, and DeleteStatement entries in the Profile category of the object language or
extension (see Customizing and Extending PowerDesigner > Extension Files ).

2.4.5 Metamodel Mapping Properties

Metamodel mappings are mappings between metamodel objects, which control how objects are imported or
generated. Metamodel mappings are sub-objects of the PowerDesigner metamodel object on which they are
defined.

To open a metamodel mapping property sheet, select the mapping from the list at the top of the Mapping Editor
Mappings pane or parent object property sheet Mapping tab and click the Properties tool.

b appir: [E. Project Management Entities. Task . Mapping_1 "]

The tabs available on a particular mapping property sheet depend on the objects being mapped. The General tab
contains the following properties:

Property Description

Source object Specifies the metamodel object being mapped to the target object.

Target object Specifies the metamodel object being mapped from the source object. This object is the parent of the
mapping itself.

Transformation [metaattribute mappings] Specifies a script to set the value of the attribute. In the following example, from

script an XML import, the notnullable attribute is imported to the Mandatory attribute and, because the

sense of the attributes is reversed, the boolean value imported is set to the opposite of the source value:

Sub %Set% (obj, sourceValue)
obj.SetAttribute "Mandatory", not sourceValue
End Sub

In the following example, from an object generation, the Numbe r ID attribute is generated to the
Comment attribute and a text string is prepended to make clear the origin of the value:

Function $%$AdjustValue$% (sourceValue, sourceObject, targetObject)
Dim targetValue
targetValue = "The original process NumberID is "

t+cstr (sourceValue)
$AdjustValue% = targetValue

End Function

The following tabs are also available for metaclass mappings:
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® [nitialization - Specifies a script to initialize the metaclass to be created. In the following example, the value of
the Stereotype attribute is set to SimpleType:

Sub %$Initialize% (obj)
obj.Stereotype = "SimpleType"
End Sub

e Attribute Mappings - Lists the mappings of attributes under the metaclass. Select a mapping and click the
Properties tool to open its property sheet. To control the order in which attributes are created, in order to
respect dependencies between them, use the arrows at the bottom of the list.

e (Collection Mappings - Lists the mappings of collections under the metaclass.

e Post-Process - Specifies a script to modify the metaclass after creation and execution of mappings. In the
following example, the value of the Code attribute is copied to the Name attribute:

Sub %PostProcess$% (ob7j)
' Copy code into name
obj.Name = obj.Code
End Sub

2.4.6 Metamodel Object Properties

To view the properties of metaclasses, metaattributes, and metacollections displayed in the Mapping Editor,
double-click the object node in the Mapping Editor or right-click the node and selecting Properties.

The General tab contains the following properties:

Property Description

Parent [metaattributes and metacollections] Specifies the metaclass to which the metaobject belongs.

Parent collection | [sub-objects/compositions] Specifies the name of the composition collection that contains the sub-ob-
jects under the parent object.

Name Specifies the name of the metaclass in the PowerDesigner metamodel or XML schema.

Data type [metaattributes] Specifies the data type of the attribute.

Identifier [metaattributes] Specifies that the attribute is used to identify the metaclass for referencing by another
metaclass.

Reference / Refer- | [metaattributes and metacollections] Specifies that the attribute or collection is used to point to another
ence path metaclass to form an aggregation.

Singleton [metaclasses] Specifies that only one instance of the metaclass is possible under each parent object.

Comment Provides additional information about the metaobject.

The following tabs are also available for metaclasses:

e Attributes - Lists the metaattributes belonging to the metaclass. Select an attribute in the list and click the
Properties tool to open its property sheet.

e C(Collections - Lists the metacollections belonging to the metaclass. Select a collection in the list and click the
Properties tool to open its property sheet.
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2.5 Impact and Lineage Analysis

Before you perform an action on a model object, such as deleting a table or changing the datatype of a primary key
column, you can preview which other objects will be impacted (impact analysis) and identify the objects that take
part in the definition of the object (lineage analysis). You can generate the analysis to an impact analysis model
(IAM) to review it in a diagram and save it for future reference.

Procedure

1. Open animpact and lineage analysis in any of the following ways:

o Select one or more objects in the diagram and select |» Tools » Impact and Lineage Analysis 3 (or press
Ctrl+F11).

o Right-click an object in the Browser Local tab or diagram and select Impact and Lineage Analysis.

o [when deleting an object] Click the Impact button on the Confirm Deletion dialog box.

o Inan object's property sheet, select the Dependencies tab, and click the Impact and Lineage Analysis
button.

1 Note

This feature is also available in the repository (see Impact and Lineage Analysis in the Repository [page
289]) and the PowerDesigner Portal (see Impact and Lineage Analysis in the PowerDesigner Portal [page
300])

The analysis applies rules to the initial objects to generate a tree view of influencing (lineage) and dependent
(impacted) objects, which appears instantly in the dialog. The following example shows all the objects that will
be impacted by a change to the Employee table, and all the objects that influence it (lineage analysis):
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2. [optional] Select Use Repository and specify a Repository analysis level to search for additional impacted or
lineage objects in the repository. If you are not currently connected to the repository, the Connect dialog opens

to allow you to do so.

In the example, you see an additional impacted object, an entity that was generated from the table to the
Project Management CDM. The blue overlay in the bottom-left corner of the object indicates that it is

located in the repository.
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EI@] Generated Objects

E Entity 'Emplovee’ [Change] [Project b anagement [COR] - w1]
=13 Ihcoming References

- Table Used' [Change]
j T able 'Project’ [Change]
----- =] Table Member' [Change]
j T able 'Participate’ [Change]
=148 Oukgoing References

3. [optional] Enter a name for your analysis result, which is then used as the name of any generated model.

4. [optional] Change the impact rule set to apply to your analysis:

o Conceptual Impact Analysis — identifies the objects impacted by changes to the object.

o Data Impact Analysis — identifies uses of values contained in the object.

o Delete Impact Analysis — [default when deleting] identifies the objects impacted by the deletion of the
object.

o Global Impact Analysis — [default when not deleting] identifies all the objects that depend on the object.

o  None - noimpact rule set is selected.

1 Note

Click the Properties tool to the right of the field to review the selected rule set. Click the Select Path tool
above the list to change the folder containing rule sets, or the List of Rule Sets tool to open any rule set (see
Analysis Rule Sets [page 542]).

5. [optional] Change the lineage rule set to apply to your analysis:

o Conceptual Lineage Analysis — identifies the objects that justify the existence of the object, and ensure it
fulfills a well-identified need.

o Data Lineage Analysis — identifies the origin of values contained in the object.

o Global Lineage Analysis — [default when not deleting] identifies all the objects that influence the initial
object.

o None — [default when deleting] no lineage rule set is selected.
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6. [optional] Click the Generate Diagram button to save the analysis to a diagram in an impact analysis model

(IAM). The following example shows the 'Employee' table in the center of the diagram with its influencing
objects above it and its dependent objects beneath it:

41 PowerDesigner - [IAM Impact and lineage analysis for Table 'Employee’ [Change], Diagram_1]

¢ File Edit View Mods Symbol  Report  Repository  Tools  Window  Help = X
| d del bol | d I =
[Jhdcdd as|imax|ve @ glacamz nl. bA Rea
1] — =
Praject Management [FDM] * - TT,:::::]M
Impact and lineage ana or Table 'Emplope
@ Diaglam_'l ouigoirg Ilutlln:ls
_4 |I"I|t|a|Dtl|ECtS TFaEe Emen —|
Elj Table ‘Employee’ [Change] | T“’[';:::;’"
=13 Incoming References |_ |

-7 Table 'Paticipate’ [Change] ( | rveoiming Remrences

-[Z] Table Project [Change] |

-7 Table Used [Change] Iecoming Rekierces e EmEn

E‘lﬂ Outgoing References EcT:m: I::::r Ec‘mﬂ: p::; -r::::]n
i Table 'Division' [Lineage] [ehange] [change]

1 Impacted Models

%:-.‘ Froject Management [FDM]

-[Z] Table Member' [Change] J_ — —
reoming Re®rerces

[
reoming Refererces
ICoiming REgrerces

m?;anmlm Redrerces T::l!;'::’]k
- Table Farlcipak

+| | - | s [charge] -

J L | 5o Hepumtar_l,ll LI J k

Impact and lineage analyziz for Table 'Employee’ [Chanage]

2.5.1 Reviewing and Modifying an Analysis

The Impact and Lineage tab displays the result of the analysis in a tree format, showing all the impacted and

lineage objects. Each item in the tree displays either an [action] suffix to indicate the effect on an impacted object
or a [lineage] suffix to designate lineage items

In this example, the analysis shows that:

e Achange onthe Participate entity will result in changes to the Task and Employee entities with which it
has relationships (and that the change will cascade down from the Task entity to the Project and Customer
entities).

® The businessrules Task date control and Participate date control form part of the definition of

the Participate entity, which was generated from the Participate table in Project Management
(PDM) .

1 Note

If an object is dependent multiple times then, for performance reasons, only the first entry appears in detail in
the tree. Right-click subsequent undeveloped entries and select Go to First Occurrence to jump to the detail.
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% Impact and Lineage Analysis - |EI|£|

Analyziz result name; IImpau:t analyziz for Entity 'Participate’ [Change]

&nalpsiz rule zets — 1 - 24
Irmpact rule zet: IEI::.I:-aI Impact Analpziz j =
Lineage rule zet: IEI::.I:uaI Lineage Analysiz j ,ﬁ

Impact and Lineage | List I

.ﬁ E [” Use Repository  Fepositon analysis [2vel |3 "I

ﬁ Impact analyziz for Entity ‘Participate’ [Change]
E- Initial Objects
Eﬁ Entity 'Participate’ [Change]
L——_IE Relationzhipz
Eﬁ Entity 'T azk' [Change]
' EE R elationzhipz
Eﬁ Entity 'Project’ [Change]
EE Relationzhips

-] Entity Emplayes’ [Change]

=3 Associated Business Fules

L Business Aule 'Task date contral' [Lineage]

L Businesz: Rule Participate date control' [Lineage]

=3 Generation Origit

E T able 'Participate’ [Lineage] [Project M anagement [FD#])

[aenerate Diagram I Cloze Help

The following tools are available on this tab:

Tool Description
|§. Properties — Opens the property sheet of the selected item.
|E| Add Initial Objects — Opens a selection dialog to add objects to analyze.
Re-Analyze — Recalculates the analysis from the selected point in the tree downwards. Select the root object to re-
analyze the entire tree.

You can modify your analysis in the following ways:
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To extend the analysis to include objects in the repository, select Use Repository and specify a Repository
analysis level to control the number of levels of dependencies to search for.

To add objects to analyze, click the Add Objects tool to open a selection dialog, select one or more objects, and
click OK.

To simplify the tree, right-click any object or collection and select Remove to remove it and its descendants.

1 Note

Right-click any node in the tree and select Re-analyze to replace any objects or collections that have been
removed in this way. To view the available collections and modify those that appear for an object, right-click
it and select Change Impact Analysis Objects or Change Lineage Analysis Objects (see Controlling the
Display of Object Collections [page 536]).

To change the action being analyzed for any object, right-click it and select one of Change Action to [Change],
Change Action to [Delete], or Change Action Description to open the Action Description dialog (and select one
or more of Delete, Change, and any User-defined actions separated by semicolons).

To change the rule set used in the analysis, select a new rule set from the lists at the top of the dialog.

2.5.11 Viewing the Preview as a List

The List tab displays a tabular report of all the objects contained in the impact and lineage analysis. You can
customize the report by filtering which attributes you want to view, save the report in RTF or CSV format, and print

it.
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+% Impact and Lineage Analysis - ||:||£|
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Impact and Lineage  List |

=™ FERREER: Y A AN
- Shaort Description - Impacted kModel f |
- Entity Participate Project Management [
2 Entity T azk Project Management [
3 Employes Entity Emploves Froject Management [
4 Froject Entity Project Froject Management [
] b aternial Ertity b aterial Froject Management [
= Team Entity Tearnm Project Management [
i Drivvizion E rtity Dhivvizion Project Management [
g Cuistamer E rtity Custormer Project M anagement [
9 Tazk date caontral Buszineszz Rule Tazk date o i Project Management [C
110 Farticipate date contral i Busziness: Rule Participate d: Project Management [T
11 Farticipate Table Participate Froject Management [F
12 T azk date control Buzineszz Rule Tazk date ¢ i Project Management [F
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=
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| Generate Diagram I Cloze | Help |

The following tools are available on the preview List tab:

Tool Description

|§| Properties — Displays the property sheet of the selected object in the list.
Q Save — Saves the list in RTF (for MS Word) or CSV (for MS Excel) format.
= Print — Prints the list.

|§| Copy — Copies the list in RTF or CSV format.
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Tool Description
|ﬁ| Find a Row — Opens the Find dialog box to let you search the list for a specific object.
|$| Customize Columns and Filter — Opens the Customize Columns and Filter dialog to select attributes to display in

the list and specify expressions to filter by (see Customizing Object List Columns and Filtering Lists [page 1241]).

|E| Enable/Disable Filter - Enables or disables the filter on the list.

2.5.1.2 Controlling the Display of Object Collections

You cannarrow or widen the analysis by changing the collections of impact and lineage objects that appear.

Procedure

1. Open the Impact (or Lineage) Analysis Objects dialog box in any of the following ways:

o [from preview] Right-click an object in the preview tree, or in the IAM Browser or diagram, and select
Change Impact Analysis Objects or Change Lineage Analysis Objects to open a list of available collections
of objects. A collection is listed here only if one or more impact (or lineage) objects belonging to the
collection are present in the current analysis:

Il Impact Analysis Objects

I [=] EY

Rule zet: IDelete Impact Analyziz

Action; Delete

& @

| 5 M ame Type | B
[ Parert Abtribute -
W | Calurnns Direct Callection i
W Keps Direct Collection e
[ Primary Eey Abtribute e
¥ | Incoming References | Dependency v [
v | Outgoing References Dependency i
[ Folder Attribute i
4

-
M| w|4|

i

Cancel | Help |

2. Select or unselect the following check boxes to control the display of collections:

o S [Selected] - enables the display of the collection in your analysis.
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o L [Replace link object by extremity] - If the object is a link, this option hides it to simplify the display and
view only the object at the other end of the link.
o R [Recursive] - Displays recursive collections in a single list.
3. [optional] Click the Properties tool to open and review or edit the analysis rule set in the Resource Editor (see
Analysis Rule Sets [page 542]).
4. [optional] Click the Apply Changes to Rule Set tool to apply your changes to the rule set so that they are
automatically applied next time.
5. Click OK to close the dialog box.

The display of the selected object collections is updated in the preview tree or IAM. If you re-analyze your
model, then the collection rules specified in the rule set are reapplied.

2.5.2 Reviewing and Modifying an IAM Model

You generate an impact analysis model (IAM) by clicking the Generate Model button on the Impact and Lineage
Analysis dialog box. An IAM provides a graphical view of your analysis and allows you to save the analysis as a
snapshot for later reference.

+*1 PowerDesigner - [IAM Impact and lineage analysis for Table 'Employee’ [Change], Diagram_1]

ﬁﬁ. File Edit Wiew Model Swmbol Report  Repository  Tools  window  Help ~18] x|
hdcHdd as|smax|oc |5 ¢|aacmlz 0@ rames
2lx =
EI__[ Buziness Rules ;I
414 Domaing
- Tables
[+ References

Impact and lineage analysis for Table 'Employes’ [Chal

=1 Iritial Objects
=[] Table Emplayee’ [Change] R
B3 Incoming References -] | e
----- T Table Member [Change] 2 _-[ LEm
----- T Table Participate’ [Change] S
= Table Project [Change]
EHj] Incoming References
£ Table 'Task' [Change] [Projec__|
£33 Incoming References

- ronge|

=4 Impacted Modelz

B3 Project Management [POM] G
K I +

Lm Local ||_,1 Hepositnlyl ﬂ J _'I_I
Impact and lineage analyziz for Table ‘Emplopes’ [Change] v

In the above example, the Employee table shows influencing (lineage) objects on the left and dependent
(impacted) objects on the right. Links between the objects represent the analysis rules that propagate actions on
objects.
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The following types of objects are available in an IAM:

Symbol Description
Initial objects - The model objects being analyzed have symbols surrounded by dotted lines. In the
(Designliss C ass Tutorial) Browser, click to expand the initial object to view the tree of its incoming references (impacted ob-
Usze Casze Create Use Cases
[Delete] jects) and outgoing references (lineage objects). You can also see the list of initial objects by selecting

|} Model > Analysis Objects ]

Impacted and lineage objects - The model objects that are impacted by or influencing the initial ob-

(Froject Management (PO b
Table Division jects. In the Browser, these collections of objects are inside folders bearing a downward arrow ([Z2)

[Linzage]

for impacted objects or an upward arrow (m) for lineage objects.

Link - Analysis rule between initial objects and impacted objects.

e
[none] Impacted Models - The models that are impacted by the change. You can see the list of impacted
models in the Browser or by selecting | Model * Analysis Models 4.
1 Note

You can add graphical objects, such as notes or decorative symbols, to your diagram.

You can modify your analysis in the following ways:

e To extend the analysis to include objects in the repository, select | Tools » Change Analysis Options 3 to open

the Impact and Lineage Analysis Options dialog, select | Use Repository 3 and specify a Repository analysis
level to control the number of levels of dependencies to search for.

e To add or remove initial objects to analyze, click [ Tools » Change Analysis Options 3, select the Initial Objects
tab, and use the Add Objects or Delete tool.

e Toremove any object or collection and its descendants to simplify the tree, select it in the Browser or diagram
and press Delete.

1 Note

Right-click any node in the Browser or diagram and select Re-analyze to replace any objects or collections
that have been removed in this way. To view the available collections and modify those that appear for an
object, right-click it and select Change Impact Analysis Objects or Change Lineage Analysis Objects (see
Controlling the Display of Object Collections [page 536]).

e To change the action being analyzed for any object, right-click it and select one of Change Action to [Change],
Change Action to [Delete], or Change Action Description to open the Action Description dialog (and select one
or more of Delete, Change, and any User-defined actions separated by semicolons).

e Tochange the rule set used in the analysis, click [ Tools » Change Analysis Options 3 to open the Impact and
Lineage Analysis Options dialog, select a new rule set and click OK.
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2.5.2.1 |AM Model Properties

The model property sheet displays the definition of the current IAM. You can check the last analysis date of your
model or add a comment, for example.

To open an IAM property sheet, double-click its Browser entry. The General tab contains the following properties:

Property Description

Name / Code / Comment Identify the model. The name should clearly convey the model's purpose to non-technical
users, while the code, which is used for generating code or scripts, may be abbreviated, and
should not normally include spaces. You can optionally add a comment to provide more de-
tailed information about the model. By default the code is auto-generated from the name by
applying the naming conventions specified in the model options. To decouple name-code
synchronization, click to release the = button to the right of the Code field.

Filename Specifies the location of the model file. This field is empty if the model has never been
saved.

Author Specifies the author of the model. If you enter nothing, the Author field in diagram title
boxes displays the user name from the model property sheet Version Info tab. If you enter a
space, the Author field displays nothing.

Version Specifies the version of the model. You can use this box to display the repository version or
a user-defined version of the model. This parameter is defined in the Title page of the model
display preferences.

Default diagram Specifies the diagram that appears by default when you open the model.

Last analysis date [Read-only] Computed date of the last model analysis, which is updated every time you re-
analyze the model.

Keywords Provide a way of loosely grouping objects through tagging. To enter multiple keywords, sep-
arate them with commas.

2.5.2.2 Setting IAM Display Preferences

PowerDesigner display preferences let you customize the format of object symbols and the information that

appears on them. To set IAM display preferences, select |+ Tools » Display Preferences 3, or right-click the diagram
background, and select Display Preferences.

These display preferences are available for analysis objects:

Preference Description

Model name Displays the model name of the analysis object.
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Preference Description
Object type Displays the type of the analysis object.
Action Displays the action name of the analysis object.

Highlight initial object Displays a dotted line around the symbol of the initial object.

The following display preferences are available for analysis links:

Preference Description

Name Displays the name of the link.

For information about changing the format of symbols, see Format Display Preferences [page 233].

2.5.2.3 Comparing Two IAM Models

Select | Tool » Compare Models 3 to view the differences between two IAMs. The comparison window displays
the objects contained within the models in a tree format, and highlights the differences between them.
Context

For detailed information about comparing models, see Comparing and Merging Models [page 395].

2.5.3 Printing an Analysis

You can print the preview list or the IAM model diagram, or create a list report in the IAM to document and discuss
proposed changes.

Context

You can print the analysis in any of the following ways:
e [from Preview] Click the List tab (see Viewing the Preview as a List [page 534]) and select the Print tool.
e [from the IAM] Select || File ¥ Print 3 to print the diagram (see Printing Diagrams [page 190]).

e [from the IAM] Select | Reports » List Report Wizard Jto create a list report for an object type and print it
(see Creating a List Report [page 331]).
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2.5.4 |AM Custom Checks

PowerDesigner does not provide any predefined checks for the data testing of an IAM. However, you can create
custom checks in an extension.

For information about developing custom checks, see Customizing and Extending PowerDesigner > Extension
Files .

You can check an IAM in any of the following ways:

e PressF4.

e Select | Tools » Check Model 3.
e Right-click the diagram background and select Check Model.

The Check Model Parameters window opens, which allows you to specify the kinds of checks to perform, and the
objects to apply them to. For detailed information about this window and correcting problems reported, see
Checking Models [page 149].

2.5.5 Obtaining Cross-Model Dependencies Without a
Repository Connection

If you anticipate needing to obtain information about cross-model dependencies with models not in your
workspace in a situation where you will not have a repository connection, you can obtain this information in
advance by checking your model out with the Check out dependencies option.

For models checked out with the Check out dependencies option (see Checkout Parameters [page 269]) objects
that are implicated in an impact or lineage analysis but that are not currently available display a red overlay in their
bottom-left corner to indicate that the analysis cannot proceed beyond this point without connecting to the
repository or otherwise obtaining the parent model. This option also ensures the cross-model dependencies
appear on the Dependencies tab of objects even when the other models are not open in the workspace.

In the following example, the Employee table, which is generated from the Employee entity, is present in the
analysis even though its model is not available, because the model from which the analysis was launched was
checked out with dependencies:
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% Impact and Lineage Analysis _ -0l x|
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-[Z] Entity 'Parlicipate’ [Change]

El 1_@ Generated Objectz
------ a Table 'Employes’ [Change] [Froject Management [FDM])

Generate Diagram I | Cloze I Help

2.5.6 Analysis Rule Sets

Impact and lineage analysis uses sets of analysis rules derived from relationships between metaclasses in the
metamodel to construct the trees of impacted and lineage objects. PowerDesigner provides standard rule sets
(XML resource files with a . rul extension), and you can create your own.

Each rule represents a potential collection of objects, and is represented as a folder in the analysis tree. In the
following example, deleting the Employee table also deletes all the members of the Columns, Keys, Indexes, and
Incoming and Outgoing References collections:
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[ Table Employes’ [Delete]
L—‘_I&J Columtiz
-Z] Column Employes Employes number' [Delete]
-Z] Column Employes. Emp_Emplayee number' [Delete]
-Z] Column Employee. Division number' [ elete]
----- =] Colurn Emplaves.First name' [Delete]
----- =] Colurn Emplaves. Last name' [Delete]
----- =] Colurn Emplaves Employes function' [Delete]
----- =] Colurn Emploves Employes zalany' [Delate]
=2 Keps
# Fey Emplovee|dtf_2* [Delete]
=13 Inderes

----- |2 Index EmployesBELOMGS_TO_FE' [Delete]
----- |Z Index Employes. CHIEF_FE! [Delete]
- = Index EmployesEMPLOYEE_PK [Delete]
#-13] Incoming References
-1 3] Outgoing References

You can open an analysis rule set in any of the following ways:

e From an analysis preview, click the Properties tool next to the rule set.

e From anlAM, select || Tools » Change Analysis Options ., and click the Properties tool next to the rule set.

® From any model, select [|» Tools » Resources » Impact and Lineage Analysis Rule Sets 3, select an available

rule set, and click the Properties tool. For information about the tools available in resource file lists, see
PowerDesigner Resource Files [page 449].

Analysis rule sets contain a list of analysis rules for each metaclass in the PowerDesigner metamodel. All analysis
rule set files have the same basic category structure, with a library for each model type containing the metaclasses
of that module. Clicking a metaclass displays the rules associated with that metaclass:
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T% Analysis Rule Set Properties _ |EI|5|
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i 14 v  Change Ihcoming References Change v
..... @ Tngger o 5 5 = = -
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The following properties are available for each analysis rule:

Property Description

E Enables the rule for use in the analysis.

Action Specifies the action performed on the metaclass that triggers the application of the rule. Select an
action from the list or enter your own (see Creating a User-Defined Action [page 545]). For lineage
analysis rules, Lineage is the only possible value.

Collection Specifies the metaclass collection whose members the rule is applied to. Collections defined in ex-
tensions (see Customizing and Extending PowerDesigner > Extension Files ) are included in one of the
Extended. . . collections.

Effect Specifies the effect on the objects in the collection caused by the action on the metaclass. Select an
action from the list or enter your own (see Creating a User-Defined Action [page 545]). For lineage
analysis rules, Lineage is the only possible value.

L Replace Link Object by Extremity - Simplifies the preview tree and the IAM Browser and diagram by
hiding the link and showing only the object at the other end of the link.

R Recursive - Propagates the effect recursively to the dependent objects of the objects in the collection.
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The root node of each file contains the following properties:

Property Description

Name/Code/ Identify the object. The name should clearly convey the object's purpose to non-technical users, while

Comment the code, which is used for generating code or scripts, may be abbreviated, and should not normally
include spaces. You can optionally add a comment to provide more detailed information about the ob-
ject. By default the code is generated from the name by applying the naming conventions specified in
the model options. To decouple name-code synchronization, click to release the = button to the right
of the Code field.

File name / Type [read-only] Specify the path to the . rul file and the type of the rule set (impact or lineage).

2.5.6.1 Creating an Analysis Rule Set

You can create your own rule sets, which are then available from the List of Impact and Lineage Analysis Rule Sets.

Procedure

1. Select|p Tools » Resources » Impact and Lineage Analysis Rule Sets Jto open the List of Impact and Lineage
Analysis Rule Sets, which shows all the available rule sets.

2. Click the New tool, enter an appropriate name for the rule set, and select the appropriate type of rule set.

3. Select arule set from the Copy From list to create a new rule set that is identical to the original set apart from
the name.

4. Click OK to open a Save As dialog, enter a file name and then click OK to open the new rule set in the Resource
Editor.

2.5.6.2 Creating a User-Defined Action

You can specify a user-defined action on an object to analyze its consequences. You must already have created the
appropriate analysis rule in the Resource Editor.

Context

In the following example, create an impact analysis rule to specify that a ModifyDataType action on the Data Item
metaclass will also change its attributes.

Core Features Guide
Linking and Synchronizing Models PUBLIC 545




Procedure

1. Inthe Resource Editor, open an impact analysis rule set (see Analysis Rule Sets [page 5427).

2. Click the pdcDM library to expand its available metaclasses tree.

3. Fromthetree, select Data Itemand create the appropriate rule by specifying the following options:

o

4. Click OK to save the rule set and close the Resource Editor.

5. Open the Action Description dialog:

o

o

6. Enter ModifyDataType in the User-defined Actions field:

546

Action — enter Modi fyDataType, which specifies the action on the data item, and triggers the impact
analysis rule. The Enable check box is automatically selected.

Collection — select Attributes, which specifies the metaclass collection for which you define the impact

rule.

Effect — enter Modi fyDataType, which specifies the action that is propagated to attributes.

M Analysis Rule Set Properties _ O] x|
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- Conceptual D ata Mode £ v | Change Generated Objects Charge [
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yHappng - 16 [v  Delete Extended lrverse Collections | Change i
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£ LA istion M 17 W Celete Generated Objects Delete
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~ag] Evternal Base Atribute 19 [ Delete Replications Delete T -
""" E External Data Item Mar 20 v  Delete T arget Mappings Change [ =
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[from preview] Right-click a data item in the tree, and select Change Action Description.

[from the IAM] Right-click a data item in the Browser or in the diagram, and select Change Action
Description.
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Action Description |

Predefined Actions:
[T Delete
[T Change

Uzer-defined Actionz:

IM::u:Iif_I,ID ataType]

o]

Cancel | Help

You can enter several actions in a single word using semicolons as separators.

7. Click OK to close the dialog box.

Results

The following example shows how the [ModifyDataType] action on the Employee number data item affects its

Employee number? attribute, which in turns affects its Idtf_2 identifier:

_.,j Wwiork space
=24 Project Management [COM)

----- E Cuztormer management

...... E Employe management

l_,y (Froject Management (EDMJJ—|
Emploves number |
[MadifybrataType]

———|

-4 Main diagram T
- Business Rules
(-4 Domaing Aftributes
-4 Dataltems
__| Entitiez
__| Relationzhips
__' |nherntances [] tFroject Management (ClhAj)
I';'Iﬁ:' Irmpact analpsiz for Data ke Emploves number' [ModifyD 2 ‘Employes number Emploves nurmber?
-&] Diagram_1 [ModifyDataType]
= Trihal Objects
=- @ Data ltem ‘Employes number' [ModifuD ataTvpe]
B3 Attributes »
EE Entity Attibute 'Employee number. Emploves number2'[Mao dentifizrs
=13 |dertifiers
E i ¥ Identifier 'Employes number.|df_2' [ModivDataTvp
‘4] Damain i (Project Management (COhD

= _d Impacted Models
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2.5.6.3 Checking Rule Sets into the Repository

When an administrator creates or upgrades the repository, default rules sets are checked into the Library folder at
the root of the repository to enable impact and lineage analyses in the Repository tab of the Browser. To use other
rule sets to perform analyses in the repository, you must check them in manually.

Context

1 Note

If you have stored customized rule sets delivered with a previous version of PowerDesigner in the repository,
they cannot be used for repository analyses until you have upgraded them by re-checking them into the latest
version of the repository. For general information about updating resource files, see Installation Guide >
Planning Your PowerDesigner Installation > Upgrading PowerDesigner .

Procedure

1. Select| Tools » Resources » Impact and Lineage Analysis Rule Sets 3 and create your custom rule set (see
Creating an Analysis Rule Set [page 545]).

2. Select the rule set in the list and click the Check In tool.
In the Check In Document dialog (see Check-In Parameters [page 251]), select the Folder to which you want to
check in the rule set.
You can check rule sets into any folder for which you have write permission. For example, you might want to
create custom rule sets for a particular project and check them into that project's folder.

4. Click OK to complete the check in.
The rule set is now available for use in the repository. If you have checked your rule set into a folder that did

not previously contain rule sets, you must use the Select Path tool to make your rule set available in the
analysis dialog (see Impact and Lineage Analysis in the Repository [page 289]).

1 Note

All impact and lineage analyses launched from your local workspace, even those that use the repository, are
performed with your local rule sets.
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2.5.7 Repository Rule Set Limitations

While the majority of rules are supported in analyses launched or extended into the repository, many calculated
collections and some other collections are not accessible to the repository analysis engine. In addition, shortcuts
which point to a different branched folder may not be immediately available.

The following list indicates the main categories of collections that are not supported in the repository:

All collections involving symbols. For example, Symbols, Objects in Related Diagrams.

In the EAM, calculated collections based on application link types. For example, Implement Objects,
Implemented By Objects, Produce Objects, Produced By Objects, Use Objects, Used By Objects.

In the EAM, the Responsible For collection, which lists the objects for which people or organization units are
responsible.

In the OOM, calculated collections based on generalization or realization links or navigable roles. For example,
Implemented Operations, Inherited Associations, Inherited Attributes, Inherited Operations, Navigable
Associations.

In the OOM, the Operations collection for the component metaclass.
In the CDM, Barker notation, the SubEntities and SuperEntities collections.
In the BPM for BPMN 2.0 the Participants collection for the choreography task metaclass.

Where one model in a branched folder contains a shortcut to a model in a different branched folder in another part
of the repository tree, the shortcut may not be followed during an analysis if the shortcut is the first link between
the models and the referencing model is checked in before the target model. In such a situation, checking out both
the model containing the shortcut and the target model and checking them back in will enable PowerDesigner to
follow the shortcut correctly.
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3 Administering PowerDesignher

The chapters in this part explain the tools available for administering the PowerDesigner environment through the
repository.

For information about creating, upgrading, and troubleshooting a repository, see Installation Guide > Installing the
Repository .

3.1 Controlling Repository Access

The repository administrator is responsible for controlling access to the documents stored in the repository by
creating users and groups and assigning them rights, permissions, and profiles.Access to the SAP EA Designer
repository is managed via an identity provider configured in the SAP Cloud Platform, but repository rights and
permissions on specific repository folders and documents are controlled by SAP EA Designer administrators
through repository user accounts.

Context

Repository rights give users access to general repository features, while permissions give them access to
particular locations in the repository. The following rights and permissions are available:
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|
Rights (Entire Repository) Permissions (Per Folder or Item)

® Connect - Connect to the repository. ® List - View the document or folder in the repository

e Edit on Web - Create and edit diagrams in browser and in search results. Without this permission,
PowerDesigner Web. the folder or document is hidden from the user.

* Edit Extensions on Web - Createand edit cus- ® Read - Also check documents out from the repository

tom properties in PowerDesigner Web. and compare documents.

® Freeze Versions - (see Freezing and Unfreezing

Document Versions [page 2747). ® Submit - Also check the document into a changelist for

® TLock Documents - (see Locking and Unlocking Docu- review by a user with Wri te permission.

ments [page 275]). ® Write - Also check in (with or without a changelist),
® Manage Branches - (see Branching Version Trees freeze, and lock document versions.

[page 280]). e Full - Also move and delete documents, manage per-
* Manage Configurations - (see Grouping Docu- missions granted to users and groups, and remove locks

ment Versions in a Configuration [page 277]). on documents

® Manage All Documents - Perform any action on any
document version. Implicitly includes Full permission

. 1 Note
on all repository documents.

e Manage Users & Permissions - Create, modify, Administrators, who have implicit Full permission on
and delete repository users and groups, grant them all repository objects, will only receive diagrams for re-
rights, and add them to groups. Users with this right can view if they have been granted explicit Wri te permis-
list all repository documents and set permissions on sion on them

them without needing explicit Full permission.

® Manage Repository - Create, upgrade, and delete
the repository database.

Procedure

1. [optional] Prepare user accounts for your users (see Managing Externally-Authenticated Repository
UsersPreparing User Accounts for New Users [page 556]).

2. [recommended] Connect the repository to an SMTP server to enable the automatic sending of emails for
passwords, changelist submissions, and other notifications (see Connecting to an SMTP Server for
Notifications [page 558]).

3. Determine how you will manage user authentication. You can choose one or more of:

o Repository-managed authentication - Specify an appropriate password policy (see Defining a Password
Policy [page 559]).

o LDAP authentication - Connect the repository to an LDAP server to allow users to connect with their
corporate credentials (see Connecting to an LDAP Server for User Authentication [page 553]).

o X.5009 certificate-based single sign-on - [PowerDesigner Web-only] Configure the server appropriately
(see Enabling Single Sign-On for PowerDesigner Web [page 565]).

1 Note

LDAP or X.509 certificates are only used for authentication. Rights and permissions on repository folders
and documents are controlled in the repository.
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4.

552

[optional] Create high-level functional groups (see Creating Repository Groups [page 568]) to organize users
by type and assign appropriate rights to them to govern general actions that they can performin the
repository (see Granting Rights to Users and Groups [page 570]).

For example:
Groups ’ Rights
Administrators Connect, Manage All Documents, Manage Users & Permissions, Manage Repository
Senior Modelers [use the PowerDesigner desktop client] Connect, Edit on Web, Edit Extensions on Web, Freeze
Versions, Lock Versions, Manage Branches, Manage Configurations
Modelers Connect, Edit on Web
Stakeholders Connect (to provide read-only access to PowerDesigner Web).
1 Note

There is no requirement to create groups - you can assign rights and permissions to individual users - but
we recommend that in all but the smallest deployments, you do create groups to simplify the process.

[optional] Apply profiles to your groups as necessary to filter the PowerDesigner interface to hide or render
read-only types of models, objects, and properties, and to specify defaults for interface elements, options and
preferences for different kinds of users (see Using Profiles to Control the PowerDesigner Interface [page
598])).

In our example, business analysts need only contribute to requirement models, enterprise architecture
models, and conceptual data models and all other types of models are hidden from them. We could imagine
dividing the Modelers group into subgroups such as enterprise architect and information architect and hiding
or rendering read-only models that do not concern them.

Create an appropriate folder structure in the repository to enable you to group documents by project or in any
other appropriate way, and to simplify the granting of permissions.

In this example, the team will use the library folder to share reference models and other documents, and to
push resource files to users (see Deploying an Enterprise Library [page 586]). In addition, two modeling
projects are proposed, and all the documents related to them will be kept in the two top-level folders:

O Library

© Project A

© Project B

Determine your review policy either at a global or project by project level. PowerDesigner supports the
following kinds of policy:

o Simple review - Change lists submitted by users with the Submit permission are reviewed by users with

the Write or Full permission.
o Peer review - Users with the Write or Full permission voluntarily submit change lists for review.

o Direct check in - The submit permission and change lists are not used, and users all check in changes
without review.

Create development groups and implement your review policies by assigning appropriate permissions to
control what actions users and groups can perform on particular repository documents and folders.

In this example, we propose:
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o A Compliance Committee who can modify the reference models and shared resource files contained in the
library and can submit changelists for inclusion in the glossary model.

o A Terminology Committee who can modify the glossary model.

o For each project, lead architects are able to check in changes to the project (and submit changelists for
inclusion in the glossary), and regular architects can submit changelists to the project.

o A cross-project stakeholder groups with read-only access (though we could imagine sub-folders within
each project for which these users would have write or submit permission for storing their own

documents).
Library Glossary Model Project A Project B

Administrators Full Full Full Full
Compliance Commit- | Write Submit Read Read
tee
Terminology Commit- | Read Write Read Read
tee
Project A Leads Submit Submit Write Read
Project A Team Read Read Submit Read
Project B Leads Submit Submit Read Write
Project B Team Read Read Read Submit
Business Stakeholders | Read Read Read Read

9. Create as many users as necessary either manually (see Creating Repository Users [page 566]) or via LDAP
(see Managing Externally-Authenticated Repository UsersPreparing User Accounts for New Users [page
5567]) and assign them to appropriate groups (see Adding Users and Groups to a Group [page 569])
according to their roles and project responsibilities.Assign users to appropriate groups (see Adding Users and
Groups to a Group [page 569]) according to their roles and project responsibilities.

There is no limit to the number of groups to which a user or group can be assigned, and users benefit from the
cumulative total of all the rights and permissions they receive.

3.1.1 Connecting to an LDAP Server for User Authentication

A repository administrator can delegate the authentication of repository users to an LDAP server. PowerDesigner
supports authentication via Active Directory and a number of other LDAP implementations. You can optionally
allow automatic creation of repository accounts when an LDAP user connects to the repository for the first time.

Context

1 Note

LDAP integration provides only authentication. Authorization is always managed via the rights and permissions
granted within the repository environment.
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Procedure

1. Connect to the repository and select [ Repository 34> Administration > LDAP Parameters (or right-click the
root node, and select Properties to open the repository property sheet, and then click the LDAP tab).

2. Select the appropriate Server type from the list to set default values for the other parameters.

For Active Directory, if your environment supports anonymous binding, you may be able to connect without
further configuration. Click the Test Connection button and follow the instructions on the dialog. If your
connection succeeds then no other options are required, but you should consider enabling the Use Secure
Socket Layer (SSL) and Auto-create user accounts in repository options.

3. Modify any appropriate parameters in the General group box:

Parameter Description
Server type Specifies the type of the LDAP server and sets default values for the server. The following types are
available:

o Active Directory - if your environment supports anonymous binding, you may be able to con-
nect without further configuration. Click the Test Connection button and follow the instructions
on the dialog.

o Netscape Directory Server

o OpenlLDAP

o Oracle Directory Server

o Other

If you edit any parameters and want to revert to the defaults, click the Default Settings button.
Provider URL Specifies the URL for the LDAP provider. By default, for Active Directory, the nearest LDAP server is

automatically detected and used for authentication, initializing this field to:
LDAP:// ldap.<domain>:389

For other servers, this field is initialized to:
LDAP://ldap.<domain>:389

and you should replace 1dap with the name or IP address of your LDAP server.

Use Secure Socket
Layer (SSL)

Specifies to connect to the LDAP server using SSL, changing the LDAP provider port to the stand-
ard secure 636. If you have deployed the PowerDesigner Portal, you must obtain and register your
certificate authority root certificate in the Java installation. You must obtain and register your certif-
icate authority root certificate in the Java installation.

1 Note

PowerDesigner users may need to contact their administrator to obtain a certificate and use
\Windows\System32\certmgr.msc to register it on their workstations. Right-click

Trusted Root Certification Authorities and select |} All Tasks > Import } then follow the wizard
instructions.
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Parameter

Default search base | Specifies the level at which the query begins its search for users in the LDAP tree. By default this is

Description

initialized to the domain components (DCs) of the LDAP server. For example:
dc=acme, dc=com

You could include the location of the User directory such as OU=Users, dc=devpd,
dc=1local . If the location of the User directory is not specified here, then you must include itin

the Authentication Search Base.

Anonymous bind

[default] Specifies that the LDAP server supports anonymous access. If you deselect this parame-
ter, you must specify a bind user distinguished name (DN) and password for an account that has
permissions to query the LDAP server.

1 Note

If the Bind user DN is in the same DN as the Authentication search base then you can simply
enter the user id for the search. Otherwise, you must enter the full DN for that account. For ex-
ample, if the Default search base is ou=people, dc=Onebridge, dc=ga, and you have a
user cn=csitest, cn=users, dc=0Onebridge, dc=ga, then the Bind DN must be

cn=csitest,cn=users, dc=0Onebridge, dc=qga.

Auto-create user ac- | Specifies that any users corresponding to the LDAP authentication search filter can connect to the
counts inrepository | repository, and will have an account created for them in the repository when they do so. If you do

not select this option, then an administrator must create an account for each user before they can
connect.

4. Modify any appropriate parameters in the Authentication group box:

Parameter

Search filter

Description

Specifies the LDAP query that selects users for authentication. By default this is initialized to (for Ac-
tive Directory):

(& (objectClass=person) (userPrincipalName={uid}))
and for other servers:
(& (objectClass=person) (cn={uid}))

To determine an alternative filter, you must know the properties of the users defined in the Active Direc-
tory, and which property (for example, name or samAccountName) is being used as the login name.
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Parameter Description

Search base Specifies the location of the User list in your LDAP server. By default this is initialized to the same value
as the Default search base. If the default search base does not include your users you must specify an
appropriate search base here. Users may be in a common node such as cn=Usexrs or an organization
unit such as OU=Users. To determine the correct search base, you should use an LDAP browser to
look at the full distinguished name of a user. Note that your Bind DN may be a user in a different node in
the tree than general users so it is very important that you have the correct information for each.

Search scope Specifies the scope of the authentication search. You can choose between:
o subtree - [default] the search begins at the level of the Search base and also searches any subn-
odes.

o onelevel -only the level specified in the Search base is searched

Authentication Specifies the method to use for authentication requests. You can choose between:
method o simple - [default] clear text authentication. If SSL is enabled, then the password will be en-
crypted.

o DIGEST-MD5 - hashed password authentication. If you select this option, you must specify a di-

gest format.

5. Click the Test Connection button and follow the instructions on the dialog to verify your connection.

6. Click OK to save your changes.

1 Note

If you have not selected the Auto-create user accounts in repository option, you must create repository
accounts for each user that you want to be able to connect. Even if you select this option, we recommend
that you create appropriate user accounts in advance in order to grant appropriate rights and permissions
on your various repository folders and documents. LDAP users connecting to the repository are
automatically added to the External users andAll users groups, and are limited, by default, to read
access on the repository.

3111 Managing Externally-Authenticated Repository
UsersPreparing User Accounts for New Users

You can modify the default rights and permissions for such users by changing the rights and permissions granted
tothe External users group, or provide specific rights and permissions for individual external users by pre-
creating repository user accounts for them.Access to the SAP EA Designer repository is managed via an identity
provider configured in the SAP Cloud Platform, but repository rights and permissions on specific repository
folders and documents are controlled by SAP EA Designer administrators through repository user accounts. When
a user first connects to SAP EA Designer, a repository user account is created for them, and they are automatically
included in the Public group. To personalize a user's first connection you can pre-create a repository user
account and assign appropriate rights and permissions, either directly or by assigning them to one or more
groups.
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Context

For example, if you want to allow any user connecting to the repository to create and edit diagrams in the
Processes folder and submit them for approval, you would:

e Grantthe External usersgrouptheEdit on Web right (see Granting Rights to Users and Groups [page
5707).

e Grantthe External users group Submit permission onthe Processes folder (see Granting Access
Permissions on Repository Items [page 571]).

In many environments, you will want to grant different rights to different groups of users, or provide them with
different permissions. For example you may want to allow users to submit changes only for processes in their
particular line of business based on sub-folders beneath the Processes folder. In this or other more complicated
cases (or if you want to restrict which users can connect to the repository and have not selected the Auto-create
user accounts in repository option), you should create accounts for your anticipated users before inviting them to
connect.

For information about configuring your identity provider in the SAP Cloud Platform, see Identity and Access
Management.

Procedure

1. Select | Repository » Administration » Users 4 to open the List of Users.
2. Click the Add a Row tool, and then click the Properties tool to open the new user's property sheet.
3. Enter the user's corporate account name in the Login name field, select External (managed by LDAP), and click

the Check Name button to verify the login name and auto-fill the remaining fields, which are set, with the
exception of Comment, to read-only.

4. Enter the user's name in the Full Name field, and the login attributed to them in the identity provider in the
Login Name field.

5. Click the Groups tab and add the user to any appropriate groups (see Adding Users and Groups to a Group
[page 569]).

All externally-authenticated users are added to:

© All users (PUBLIC) groups, from which they inherit, by default, Read permission on all the contents of
the repository.

O0 External users (EXTERNAL) - from which they inherit, by default, the Connect right.

6. Click the Rights tab and specify any appropriate rights for the user (see Granting Rights to Users and Groups
[page 570]). By default, all users are granted the Connect right, which entitles them to connect to the
repository.

7. Click the Profiles tab and associate the user with appropriate object permissions, Ul, and general preferences
profiles (see Applying Profiles to Users and Groups [page 604]).

8. Click OK to complete the creation of the user.
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3.1.2 Connecting to an SMTP Server for Notifications

A repository administrator can automate the sending of emails for passwords, changelist submissions, and other
notifications to users by specifying an SMTP server. If an SMTP server is not specified, the administrator must
distribute passwords manually and notifications related to the creation of PowerDesigner Web comments and the
submission and approval of change lists cannot be sent.

Procedure

1. Connect to the repository and select [ Repository 4 > Administration > SMTP Parameters (or right-click the
root node, and select Properties to open the repository property sheet, and then click the SMTP tab).

2. Enter appropriate values for each of the following settings:

Parameter Description

SMTP host Specifies the host name of the SMTP server used to send mail.
SMTP port Specifies the port number of the SMTP server used to send mail.
Sender's email address Specifies the email address from which to send mails.

Use Secure Socket Layer Specifies to connect to the SMTP mail server through SSL.
(SSL)

Server requires authentica- | Specifies that the SMTP server requires authentication. If you select this option, then you
tion must specify an SMTP account and password, and can select to use Secure Password Au-
thentication (SPA).

3. Click the Test button to send a test email to the sender's email address.

4. Click OK to save your changes.
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3.1.3 Defining a Password Policy

In environments where PowerDesigner manages user passwords, the repository administrator is responsible for
defining a password policy to ensure that passwords are sufficiently secure and are changed at appropriate
intervals.

Context

1 Note

The password policy governs only users who are not managed by LDAP (see Managing Externally-Authenticated
Repository UsersPreparing User Accounts for New Users [page 556]) or single sign-on (see Enabling Single
Sign-On for PowerDesigner Web [page 565]).

Procedure

1. Connect to the repository and select [ Repository 3 > Administration > Password Policy (or right-click the root
node, and select Properties to open the repository property sheet, and then click the Passwords tab).

2. Select policy settings as appropriate:

Parameter ’ Description

Password length Specifies the minimum and maximum permitted length of passwords. This option cannot
be disabled. The minimum length for a password is 6 characters.

Password must contain Specifies that passwords must contain at least one of each of the character types selected.

Disallow reuse of previous
<x> passwords

Prevents users from reusing the specified number of old passwords.

Enforce changing of pass-
words after <x> days

Requires that users change their passwords after the specified number of days.

Block inactive users after
<x> days without connection

Blocks users if they try to log in after the specified number of days of inactivity.

Temporarily block users for
<x>minutes after <y> fail-
ures to log in

Blocks users for the specified number of minutes if they submit an invalid combination of
username and password the specified number of times.

Temporary passwords issued
by an administrator are valid
for <x> days

Specifies the period for which temporary passwords (which are issued when a user is cre-
ated or unblocked) are valid. Users attempting to use a temporary password after this time
will be blocked.

3. Click OK to save your changes.

Changes made to the policy take effect immediately. If your policy becomes more restrictive, users whose
passwords are no longer compliant will be instructed to change their password when next they connect.
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3.1.4 Enabling SSL for PowerDesigher Web

We recommend that you enable SSL for the PowerDesigner Web server in order to encrypt its communications
with client Web browsers and between its Node and Tomcat components.

Context

TGP (27000/27010)

i Sysam Tﬂ i) Repository Server

SySAM

Repository Database

1 Note

TLS/SSL support levels are determined by the application server supporting the communication with the client
Web browsers and between its Node and Tomcat components. This procedure enables SSL for connections
from client Web browsers to Node connections and from Node to Tomcat. For Tomcat documentation about
enabling SSL, see the SSL/TLS Configuration HOW-TO # .

Procedure

1. Prepare your environment for this change:

a. Download and install OpenSSL # and add the openss1 command to your path.
b. Locate the keytool utility in your Java installation and add it to your path.

If you chose to install a new Tomcat 8 server with PowerDesigner Web your keytool is located by default
atC:\Program Files\SAP\PowerDesigner Portal 16\sapjvm 8 jre\bin\keytool.exe
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c. Locate your Java installation truststore and obtain its password.

If you chose to install a new Tomcat 8 server with PowerDesigner Web your truststore is located by default

atC:\Program Files\SAP\PowerDesigner Portal 16\sapjvm 8 jre\lib\security\cacerts
with a default password of changeit.

2. Prepare a folder to contain your keys, certificates, and other files, and navigate into it.

In this procedure, we will use the Cc: /ss1 folder to contain the generated files.

a. Copy the following code into a file and save it in your folder as pditebSSL. cfg:

OpenSSL configuration file for enabling SSL for the PowerDesigner Web server
Define the following properties to identify the server:

- FODN (fully qualified server name),

- ServerName (non-qualified name),

# - CommonName (Subject name) and other Subject properties

FODN = <FullyQualifiedServerName>

ServerName = <ServerName>

CommonName = <FullyQualifiedServerName>

CountryName = <TwoLetterCountryCode>

StateName = <State>

City = <City>

Organization = <Organization>

OrganizationUnit = <OrganizationUnit>

# If appropriate, modify the ALTNAMES line to add DNS aliases to the CSR.
# All DNS names must resolve to the same IP address as the FQDN.
ALTNAMES = DNS:$FQDN , DNS:$ServerName

# --— Do not modify below this line---

[ req ]

default bits = 2048

default md = sha256

prompt = no

encrypt key = no

distinguished name = dn

#
#
#
#

req extensions = reqg ext
[ dn ]
CN = SCommonName

C = $CountryName

ST = $StateName

L = $City

O = $Organization

OU = $OrganizationUnit

[ reqg ext ]

subjectAltName = SALTNAMES

b. Editthe pdwebssL. cfqg file to provide appropriate values for the variables defined at the beginning of the

file, and then save your changes:

O FQDN = <FullyQualifiedServerName> - Must contain the fully qualified name of the server.

0 ServerName = <ServerName> - Must containthe unqualified name of the server.

© CommonName = <FullyQualifiedServerName> - Mustcontain the fully qualified name of the
server.

o0 CountryName, etc - Should contain appropriate values for the server.

© ALTNAMES = DNS:S$FQDN , DNS:S$ServerName - If appropriate or required for your environment,
add any additional DNS aliases to the end of the line in the form , DNS:<MyAlternateName>

c. Copy the following code into a file and save it in your folder as pdWebsSSL.bat:

rem "Batch file for enabling SSL for the PowerDesigner Web server"
rem "Generate private "

openssl genrsa -out ca.key 2048

openssl req -new -key ca.key -out ca.csr -subj "/CN=ca"
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openssl x509 -req -days 3650 -in ca.csr -signkey ca.key -out ca.crt

rem "Generate node.js server certificate ..."

openssl genrsa -out nodeserver.key 2048

openssl req -new -key nodeserver.key -out nodeserver.csr -config pdWebSSL.cfg
-extensions req ext

openssl req -in nodeserver.csr -text -noout

openssl x509 -req -days 3650 -in nodeserver.csr -CA ca.crt -CAkey ca.key -
CAcreateserial -out nodeserver.crt -extfile pdWebSSL.cfg -extensions req ext
openssl x509 -in nodeserver.crt -text -noout

rem "Generate node.js client certificate ..."

openssl genrsa -out nodeclient.key 1024

openssl req —-new -key nodeclient.key -out nodeclient.csr -subj "/
CN=nodeclient"

openssl req -in nodeclient.csr -text -noout

openssl x509 -reqg -days 3650 -in nodeclient.csr -CA ca.crt -CAkey ca.key -
CAcreateserial -out nodeclient.crt

openssl x509 -in nodeclient.crt -text -noout

rem "Generate tomcat server certificate ..."

openssl genrsa -out tomcat.key 1024

openssl req -new -key tomcat.key -out tomcat.csr -config pdWebSSL.cfg -
extensions req ext

openssl req -in tomcat.csr -text -noout

openssl x509 -req -days 3650 -in tomcat.csr -CA ca.crt -CAkey ca.key -
CAcreateserial -out tomcat.crt -extfile pdWebSSL.cfg -extensions req ext
openssl x509 -in tomcat.crt -text -noout

rem "Generate server.jks keystore..."

openssl pkcsl2 -export -in tomcat.crt -inkey tomcat.key -out tempkeystore.pl2
-name tomcat -CAfile ca.crt -caname ca -password pass:<KeystorePassword>
keytool -importkeystore -deststorepass <KeystorePassword> -destkeystore
server.jks -srckeystore tempkeystore.pl2 -srcstoretype PKCS12 -srcstorepass
<KeystorePassword> -noprompt

rem "Import node.js client certificate ca to keystore..."

keytool -importcert -keystore server.jks -alias ca -file ca.crt -storepass
<KeystorePassword> -—-noprompt

keytool -list -keystore server.jks -storepass <KeystorePassword>

rem "Import node.js server certificate ca to truststore..."

keytool -delete -alias ca -keystore "C:\Program Files\SAP\PowerDesigner
Portal 16\sapjvm 8 jre\lib\security\cacerts" -storepass <TruststorePassword> -
noprompt

keytool -importcert -keystore "C:\Program Files\SAP\PowerDesigner Portal
16\sapjvm 8 jre\lib\security\cacerts" -alias ca -file ca.crt -storepass
<TruststorePassword> -noprompt

d. Editthe pdWwebssL.bat to provide appropriate values for the following passwords, and then save your
changes:

0 <KeystorePassword>- Choose a secure password for the server. jks keystore (that is created in
the section Generate server.jks keystore)and enter it five times in the commands in the
Generate server.jks keystoreand Import node.js client certificate ca to
keystore sections.

0 <TruststorePassword> - Enter the password for the cacerts truststore two times in the
commands inthe Import node.js server certificate ca to keystore section.

1 Note

If your truststore is not located at C: \Program Files\SAP\PowerDesigner Portal
16\sapjvm 8 jre\lib\security\cacerts, you mustalso provide the appropriate path in the
two commands in this section.

3. Stopthe sSAP PowerDesigner Nodeserver service and then stop the SAP PowerDesigner Portal
service.
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4. Openacommand prompt with administrator privileges in your C: /ss1 folder and run the following command:

pdWebSSL.bat

The command will generate all the necessary files to enable SSL for your PowerDesigner Web installation and

import the appropriate certificates into your keystore and truststore.

1 Note

The nodeserver.crt certificate signed by the private certification authority is sufficient for testing, but
will not be trusted by your users' Web browsers, and they will receive a security warning when accessing
your server. To securely identify your server, you must send your certificate request to your organization's
certification authority.

5. Edit<install dir>\nodeserver\configExt.json toenable SSL for Node and point to the generated

files:
{
"node": {
"secure": true,
"keyFile": "C:/ssl/nodeserver.key",
"passphrase": null,
"certFile": "C:/ssl/nodeserver.crt",
"caFile": null,
"useSSO": false,
"port": 3030,
"home": "C:/Program Files/SAP/PowerDesigner Portal 16",
"useCluster": true,
"cpus": null,
"maxCpus": null,
"useCache": true
}s
"web": {
"applicationContext": "/powerdesigner-web",
"resourcesPath": "/resources"
}s
"connections": {
"repository": {
"secure": true,
"keyFile": "C:/ssl/nodeclient.key",
"passphrase": null,
"certFile": "C:/ssl/nodeclient.crt",
"caFile": "C:/ssl/ca.crt",
"host": "localhost",
"port": 8443,
"oDataPath": "/odata.svc",
"oData2Path": "/odata2.svc",
"maxTimeout": 600000
}
}
}
Where:

o Inthe node list:
0 "secure": true - Enables SSL between client Web browsers and the Node server.
O n"keyFile": "C:/ssl/nodeserver.key" - Points to the generated nodeserver.key file.

Core Features Guide
Administering PowerDesigner PUBLIC

563



o}

1 Note

for this and other paths, you should use only forward slashes as in the example to ensure that the
JSON is correctly interpreted.

"passphrase": null - Not required

"certFile": "C:/ssl/nodeserver.crt" - Points to the generated nodeserver.crt file.
"useSSO": false - Remains at false, until you enable single sign-on (see Enabling Single Sign-On
for PowerDesigner Web [page 565]).

"port": 3030 - Specifies the port to which your users will connect using SSL.

"home": "C:/Program Files/SAP/PowerDesigner Portal 16" - Specifies the portalinstall
directory.

Other options can keep their existing values.

© Inthe connections/repository list:

o

o}

o

o}

"secure": true - Enables SSL between Node and Tomcat.

"keyFile": "C:/ssl/nodeclient.key" - Points to the generated nodeclient.key file.
"passphrase": null - Not required

"certFile": "C:/ssl/nodeclient.crt" - Points to the generated nodeclient.crt file.
"host": "localhost" - Specifies that Tomcat is installed on the same server as Node.

"port": 8443 - Specifies the port that Node will use to connect to Tomcat, and must be the same as
the port specified in server.xml (see next step).

Other options can keep their existing values.

6. Modify <install dir>\Tomcat\conf\server.xml toenable SSL for Tomcat:

a. Create a<Connector element with the following values:

<Connector

port="8443"
protocol="org.apache.coyote.httpll.HttpllNioProtocol"
maxThreads="150"

SSLEnabled="true"

scheme="https"

secure="true"

clientAuth="want"

sslProtocol="TLS"

keystoreFile="C:/ssl/server.jks"

keystoreType="JK3S"

keystorePass="<secure password>"
truststoreFile="C:/ssl/server.jks"
truststoreType="JKS"

truststorePass="<secure password>"

compression="on"

compressionMinSize="2048"
noCompressionUserAgents="gozilla, traviata"
compressableMimeType="text/html, text/xml,application/xml, application/atom

+xml,application/x-font-ttf,application/javascript,application/json, text/
css"/>

Where:

o}

port - must match the port setin <install dir>\nodeserver\configExt.json for

connections/repository/port
clientAuth is set to want to allow a standard login if the certificate cannot be found.

keystoreFile/truststoreFile points to your generated server. jks keystore.
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O keystorePass/truststorePass isthe <secure password> defined for your generated
server. jks keystore.
o The compression options are the standard options set by the PowerDesigner Web installer to optimize
performance.
b. Comment out any other connector elements to prevent any non-secure access.
7. Restart and test your environment:
a. Startthe sAP PowerDesigner Portal service and then startthe SAP PowerDesigner Nodeserver
service.
b. Navigate to the login page using http://<server>:3030 to confirm that it is no longer accessible.

c. Navigate to the login page using https://<server>:3030 to confirm that it is accessible via SSL.

3.1.5 Enabling Single Sign-On for PowerDesigher Web

In environments where X.509 client authentication is in place, an administrator can enable PowerDesigner Web to
authenticate users by the user certificate stored on their client machine. The client browser sends a certificate
issued by a trusted certificate authority to identify the user and they are logged in automatically, without the need
to manually enter their credentials.

Procedure

1. If you have not already done so, enable SSL (see Enabling SSL for PowerDesigner Web [page 560]).
2. Prepare your environment for this change:
a. Enable LDAP (see Connecting to an LDAP Server for User Authentication [page 553]).

Enabling LDAP allows the preparation of user accounts for administrators and enhances the ability of
PowerDesigner Web to obtain the real names and email addresses of your users, which may not always be
available in their certificates from the LDAP server.

b. Create accounts for one or more External (managed by LDAP) users who will act as repository
administrators (Managing Externally-Authenticated Repository UsersPreparing User Accounts for New
Users [page 556]) and add them to the Administrators group.

c. [optional] Customize the rights and permissions that standard users are granted by changing the default
rights and permissions granted to the External users group or pre-creating user accounts for other
individuals.

d. Stopthe sAP PowerDesigner Nodeserver service and then stop the SAP PowerDesigner Portal
service.

3. Edit<install dir>\nodeserver\configExt.json toenable SSO and point to your organization's SSO
CA:

{

"node": {
"secure": true,
"keyFile": "C:/ssl/nodeserver.key",
"passphrase": null,
"certFile": "C:/ssl/nodeserver.crt",
"caFile": "C:/ssl/sso_ca.crt",
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"useSSO": true,
"port": 3030,
"home": "C:/Program Files/SAP/PowerDesigner Portal 16",
"useCluster": true,
"cpus": null,
"maxCpus": null,
"useCache": true
b
"web": {
"applicationContext": "/powerdesigner-web",
"resourcesPath": "/resources"
b
"connections": {
"repository": {
"secure": true,
"keyFile": "C:/ssl/nodeclient.key",
"passphrase": null,
"certFile": "C:/ssl/nodeclient.crt",
"caFile": "C:/ssl/ca.crt",
"host": "localhost",
"port": 8443,
"oDataPath": "/odata.svc",
"oData2Path": "/odata2.svc",
"maxTimeout": 600000

Where:
o Inthe node list:
O "caFile": "C:/ssl/sso_ca.crt" - Points to your organization's certification authority for SSO
certificate.

O "useSSO": true - Enables SSO.
o Other options can keep their existing values.
4. Restart and test your environment:

a. Startthe sAp PowerDesigner Portal service and then startthe SAP PowerDesigner Nodeserver
service.

b. Navigate to the login using the https: // prefix. You should bypass the login screen and go straight to the
homepage.

3.1.6 Creating Repository Users

The repository administrator is responsible for creating user accounts to enable users to connect to the repository
and access the content that they need.

Context

The following standard users are automatically created in the PowerDesigner repository:

® ADMIN - Has all available rights and implicit Full permission on all repository folders.

® ADMIN - |s created as a temporary emergency user for connecting to a repository when no administrator is
able to access it (see Obtaining Emergency Access to the Repository [page 576]).
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1 Note

This procedure is for creating users authenticated by the repository. PowerDesigner also supports delegating
authentication of users to an LDAP server (see Connecting to an LDAP Server for User Authentication [page
553]) and authentication by X509 certificate (see Enabling Single Sign-On for PowerDesigner Web [page 565]).

Procedure

1. Select | Repository # Administration ¥ Users 3 to open the List of Users.

2. Click the Add a Row tool and then click the Properties tool to open the new user's property sheet.

3. Enter the following properties as appropriate:

Property Description

Login Name

Specifies the account name used to connect to the repository.

1 Note

Account names and passwords managed by PowerDesigner are case-sensitive and must only
contain standard ASCII characters.

External (managed

By default, users must enter a password managed by PowerDesigner to connect to the repository.

by LDAP) To allow them to enter their standard corporate password, select External (managed by LDAP) (see
Managing Externally-Authenticated Repository UsersPreparing User Accounts for New Users
[page 556]).

Full Name Specifies the real name of the user.

Email Specifies the email address of the user. If you have specified an SMTP server (see Connecting to an
SMTP Server for Notifications [page 558]) this address will be used to send the password.

Comment Specifies any additional information about the user.

Status Specifies the status of the user, which can be:

o Active - the user can access the repository.

o Inactive - the user is no longer active in the repository (see Deactivating Users [page 573])
and may not connect. The user remains in the List of Users and can be reactivated at any
time.

o Blocked - the user has violated one of the rules of the password policy (see Defining a Pass-
word Policy [page 559]), and cannot access the repository until an administrator unblocks her
account (see Unblocking Blocked Users [page 573]).

4. If you have not enabled delivery of passwords by email (see Connecting to an SMTP Server for Notifications
[page 558)), click the Reset Password button and then select the Show checkbox to display the password and
note it for transmission to the user.

5. Click the Groups tab and add the user to any appropriate groups (see Adding Users and Groups to a Group

[page 569]).

All users are added to the Public group, from which, by default, they inherit the Read permission on all the
contents of the repository (see Granting Access Permissions on Repository Items [page 571]).
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6.

7.

8.

Click the Rights tab and specify any appropriate rights for the user (see Granting Rights to Users and Groups
[page 570]). By default, all users are granted the Connect right, which entitles them to connect to the
repository.

Click the Profiles tab and associate the user with appropriate object permissions, Ul, and general preferences
profiles (see Applying Profiles to Users and Groups [page 604]).

Click OK to complete the creation of the user. If an SMTP server is configured, the password will be sent to the
user at the recorded email address.

Users must log in with their temporary password before the delay specified in the password policy (see
Defining a Password Policy [page 559]). When they first log in they will be required to change the temporary
password.

3.1.7 Creating Repository Groups

The repository administrator is responsible for creating groups of users in the repository. Users are added to
groups in order to simplify the granting of rights and permissions. You can create hierarchies of groups. For
example, you could insert the Designers, Quality Assurance, and Documentation groups into the R&D

group, to which you assign permissions to documents that all these groups must use.

Context

The following standard groups are automatically created in the PowerDesigner repository:

Administrators, [ADMN] - Has, by default, all available rights and implicit Full permission on all repository
folders.

All users [PUBLIC] - Has, by default, Read permission on the repository root. All users belong to this group and
can thus, by default, check out any document.

External users [EXTERNAL] - Has, by default, no rights or permissions. Users authenticated via LDAP (see
Connecting to an LDAP Server for User Authentication [page 553]) or single-sign on (see Enabling Single Sign-
On for PowerDesigner Web [page 565]) are automatically added to this group when they connect for the first
time.

Procedure

Select | Repository » Administration » Groups 3to open the List of Groups.

2. Click the Add a Row tool and then click the Properties tool to open the new group's property sheet.

3. Click the Members tab and add any appropriate users and groups to the group (see Adding Users and Groups

568

to a Group [page 569]).

Click the Parent Groups tab and add the group to any appropriate groups (see Adding Users and Groups to a
Group [page 569]).

Click the Rights tab and specify any appropriate rights for the group (see Granting Rights to Users and Groups
[page 570]). By default, groups do not have any rights.
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6. Click the Profiles tab and associate the group with an appropriate object permissions, Ul, and general
preferences profile (see Applying Profiles to Users and Groups [page 6041]).

7. Click OK to complete the creation of the group.

3.1.71 Adding Users and Groups to a Group

You can add users and groups as members of a group from either the user or the group property sheet.

Context

There are three ways to add members to a group:

e Toadd auser to a group from the user's property sheet, select the Groups tab, which lists the groups to which
the user belongs. Click the Add Groups tool to open a list of groups, select one or more, and then click OK to
add the user to them.

1 Note

Click the Show All Parent Groups tool to show all the parent groups of the groups of which the user is a
member, and from which she may inherit additional rights, permissions, and profiles.

e Toadd a group to a parent group from the child group's property sheet, select the Parent Groups tab, which
lists the groups to which the group belongs. Click the Add Groups tool to open a list of groups, select one or
more, and then click OK to add the group to them.

e Toadd a user or group to a group from the parent group's property sheet, select the Members tab, which lists
the users and groups which are members of the group. Click the Add tool to open a dialog with lists of users
and groups on sub-tabs, select one or more, and then click OK to add them to the group.

1 Note

Click the Show All Children Members tool to show all the groups and users that belong to the members of
the group, and who will inherit rights, permissions, and profiles assigned to the group.

3.1.7.2 Deleting a Group

When you delete a group from the repository you do not delete the members (either users or groups) of the group.

Procedure

1. Select | Repository # Administration » Groups 3 to open the List of Groups.
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2. Selecta group in the list and click the Delete tool. The group is removed from the list, and:
o Any document permissions granted to the group are revoked.
o Any members of the group lose whatever rights or permissions they had inherited from the group.
© The group is removed from membership of any groups to which it belonged.

3. Click OK to close the List of Groups.

3.1.8 Granting Rights to Users and Groups

A new user has only the Connect right assigned by default and belongs only to the PUBLIC group. The repository
administrator can grant additional rights to the user either directly or by adding her to other groups.

Context

1 Note

The rights a user or group receive when they become members of a group (see Adding Users and Groups to a
Group [page 569]) are cumulative. For example, a user with the Manage Branches right will not lose this right
when he becomes a member of a group that has only the Freeze Versions and Lock Versions rights.

User rights are associated with document permissions (see Granting Access Permissions on Repository Items
[page 571]) to define the actions a user can effectively perform on a document.

1 Note

Some user rights are automatically implied by permissions:
e A user with the Write permission on a repository document automatically has the Lock Versions and
Freeze Versions rights forit.

® A user with the Full permission on a document can unlock or unfreeze a version he did not lock or freeze.

Procedure

1. Select|r Repository » Administration » Users 3 (or |# Repository » Administration » Groups ), select the
appropriate user or group in the list, click the Properties tool, and click the Rights tab.

2. Select the check boxes corresponding to the rights you want to assign. The following rights are available:
o0 Connect - Connect to the repository.
o Edit on Web - Create and edit diagrams in PowerDesigner Web.
© Edit Extensions on Web - Create and edit custom properties in PowerDesigner Web.
© Freeze Versions - (see Freezing and Unfreezing Document Versions [page 2747).

0 Lock Documents - (see Locking and Unlocking Documents [page 275]).
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© Manage Branches - (see Branching Version Trees [page 280]).
0 Manage Configurations - (see Grouping Document Versions in a Configuration [page 277]).

0 Manage All Documents - Perform any action on any document version. Implicitly includes Full
permission on all repository documents.

O Manage Users & Permissions - Create, modify, and delete repository users and groups, grant them

rights, and add them to groups. Users with this right can list all repository documents and set permissions
on them without needing explicit Full permission.

© Manage Repository - Create, upgrade, and delete the repository database.

3. Click OK to save your changes and close the user property sheet.

3.1.9 Granting Access Permissions on Repository Items

The repository administrator or a user with Full permission on a document or folder can grant permissions on it.

Permissions can be granted on the repository root, folders, models, model packages, and external application files,
but not on individual model diagrams or objects.

Context

A user wanting to check documents out of and into the repository must have at least the following permissions:
e (Check out - Read permission. When you create a user, she is inserted into the Public group, which by default
is granted Read permission on the repository root.
e First check in (to create a document in the repository) or creating a folder - Write permission on the target
location (the repository root or a folder) or Submit to propose the addition.
The user who creates a repository item has, by default, Full permission over it, though this permission can be

reduced by an administrator. Other permissions are cascaded down from the parent folder or root, so that if
another user has Write permission on the parent folder, then he will have Write permission on the new item.

e Subsequent check ins (to update an existing document) - Read permission on the target location and Write
permission on the document (including, for PowerDesigner models, all impacted packages).

1 Note

Object permissions should be viewed in conjunction with the rights granted to users or groups (see Granting
Rights to Users and Groups [page 570]).

Procedure

1. Right-click the item in the Repository Browser, and select Permissions to open the item's property sheet at the
Permissions tab.
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1 Note

A PowerDesigner project (see Projects and Frameworks [page 47]) acts as both a repository document and
a folder. Use the project permissions to control working with the project file itself (project diagram and any
framework or dependency matrices) and the folder permissions to grant access to the models contained
within the project, as you would for a repository folder.

2. Click the Add button to open a list of available users and groups, select one or more, and click OK to add them
to the list.

3. Foreach user or group, select the permission you want to grant in the Granted Permission column. The
following permissions are available:

© List- View the document or folder in the repository browser and in search results. Without this
permission, the folder or document is hidden from the user.

o0 Read - Also check documents out from the repository and compare documents.

0 submit - Also check the document into a changelist for review by a user with Write permission.

o Write - Also check in (with or without a changelist), freeze, and lock document versions.

o0 Full - Also move and delete documents, manage permissions granted to users and groups, and remove
locks on documents.

1 Note

Administrators, who have implicit Full permission on all repository objects, will only receive diagrams
for review if they have been granted explicit Write permission on them.

4. [optional] Click the Copy Permissions to All Children tool to propagate changes to the item's children.

When you create a folder or check in a model or project, the permissions defined on its parent folder are
propagated to it. However, subsequent changes made to the permissions for the parent are not applied to its
children unless you click this tool. For example, if you grant Write permission on the Major Project folder,
to the Development Team 2 group, then they will not automatically be granted Write access on its existing
contents.

5. [optional] Click the Show All Authorized Users tool to display all the users and groups who have a permission
on the item, including those inheriting permissions from groups.

Consult the read-only Effective Permission column to see the highest level of permission that each user or
group has either directly or via a group. A user who has no directly granted permission on an item may inherit
aWrite permission by virtue of membership in a group, and will appear in the list when the Show All
Authorized Users tool is pressed.

1 Note

If you delete a group from the list while the Show All Authorized Users tool is pressed, it and its members
remain visible in the list with their granted and effective permissions reduced to <none>, until you click
Apply or OK.

6. Click OK to save your changes.
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3.1.10 Unblocking Blocked Users

The repository administrator or a user with the Manage Users & Permissions right can unblock users blocked
for password policy violations.

Procedure

1. Select|r Repository » Administration » Users Jto open the List of Users, select the user in the list and click
the Properties tool to open his property sheet.

2. Click the Reset Password button. If an SMTP server is configured, the password will be sent to the user at the
recorded email address. Otherwise, select the Show checkbox to display the password and note it for
transmission to the user.

Users must log in with their temporary password before the delay specified in the password policy (see
Defining a Password Policy [page 559]). When they first log in they will be required to change the temporary
password.

3.1.11 Deactivating Users

The repository administrator or a user with the Manage Users & Permissions right can deactivate users.
Inactive users cannot connect to the repository and the information held about them is deleted except for the log
of their checkins and other repository actions, which remain available to other users for auditing purposes.

Context

Caution

A user cannot deactivate himself, even if he has the Manage Users & Permissions right.

Procedure

1. Select | Repository # Administration  Users 4 to open the List of Users.

2. Locate the user in the list and then select its [D]eactivate check box.

Core Features Guide
Administering PowerDesigner PUBLIC 573



3.1.12 Monitoring Repository Activities

Users with the appropriate rights can review lists of repository activities.

e | st of Activities - [requires the Manage All Documents right] View events concerning repository

documents. Press[ctrl] + + [v]or select | Repository » Activities 3

o

Check In-Userchecksinanew document oranew version of adocument. This event is also triggered
each time a user saves a draft diagram on the Web.

Change List Submission - User submits a change list for review (see Change Lists [page 258]).
Change List Approval/Rejection/Return for Revision - A reviewer approves, rejects or
returns a change list to the user for revision.

Freeze / Unfreeze - A document version is frozen or unfrozen (see Freezing and Unfreezing Document
Versions [page 274]).

Lock / Unlock - A document is locked for editing or the lock is released manually or by a check in (see
Locking and Unlocking Documents [page 275]).

Document Move - User moves a document from one repository folder to another (see Moving Documents
in the Repository [page 257]).

Version Deletion/Document Deletion - User deletes a document version or a document (see
Deleting Documents, Document Versions, and Folders [page 294]). If a version of the document being
deleted is included in a configuration (see Grouping Document Versions in a Configuration [page 277]),
then though it will no longer be available through the repository Browser, the version will not be deleted
from the configuration, and the Document Removal action will be shown.

Branch Creation - User creates a branch (see Branching Version Trees [page 280]).

Integration - User integrates a document from one branch to another (see Integrating Changes from
One Branch to Another [page 283]).

Repository Upgrade - Administrator upgrades the repository to a new software version (see
Installation Guide > Installing the Repository > Upgrading the Repository ).

Automatic Fix - Anexisting document is updated to reflect changes required by a new software version.

1 Note

Click the Customize Columns and Filter tool to customize the list. Select an item in the list and click the
Properties tool to open the property sheet of the affected object. You can use the Versions tab of the
property sheet to check out or lock the document version.

e Security Log - [requires the Manage Users & Permissions right] View events concerning user accounts.

Press + + [B]or select | Repository » Administration ¥ User Activities J:

o

574

User Created - User's accountis created, either by an administrator or automatically (if the Auto-create
user accounts in repository option or single sign-on is enabled, see Connecting to an LDAP Server for User
Authentication [page 553] and Enabling Single Sign-On for PowerDesigner Web [page 565]).

Login - User enters correct user name and password combination.

Failed Login - User enters incorrect user name and password combination.

Logout - User logs out.

Password Changed - User changes password.

Password Reset - User's password is changed by an administrator.

User Blocked for Failed Logins - User is blocked for having entered too many incorrect user name
and password combinations (see Defining a Password Policy [page 559]).
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O User

Blocked for Inactivity - Userisblocked for having tried to login after too long a period of

inactivity (see Defining a Password Policy [page 559]).

O User
O User
O User
O User
O User

O User

1 Note

Unblocked - User is unblocked by an administrator (see Unblocking Blocked Users [page 573]).
Deactivated - User is deactivated by an administrator (see Deactivating Users [page 573]).
Activated - User is reactivated by an administrator.

Accessed - User's account information is accessed by an administrator.

Updated - User's account information is updated by an administrator.

Deleted - User's account is deleted by an administrator

Click the Customize Columns and Filter tool to customize the list.

3.1.13 Querying the Repository Using SQL

Administrators can run basic SQL SELECT queries against the repository through the Execute Query window. For
more complex queries, you should use your DBMS query editor.

Context

1 Note

You cannot execute SQL queries when connecting to the repository via the repository proxy.

Procedure

1. Connect to the repository and then select | Repository » Administration » Execute SQL Jto open the
Execute Query window.

2. Enter one or more SQL queries in the appropriate syntax for your DBMS in the window and click the Execute

button.

The results of your query are displayed in the Results pane.
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3.1.14 Obtaining Emergency Access to the Repository

In the event that no administrator is able to log in to a running repository, you can create an emergency
administrator account to regain access.

Procedure

1. Ifthe repository proxy is not already in use in your environment, install it on the repository server or a nearby
machine for which you are an administrator (see Installation Guide > Installing the Repository Proxy ).

2. Launch the Repository Proxy Configuration utility (pdproxyconf16.exe).

1 Note

On a Windows 7 machine, you must open the utility by right-clicking its icon or menu item and selecting Run
as administrator.

3. Ifaninstance is not already available for the repository in question, create one, specifying the appropriate data
source, user name, password, and port to connect to the repository database.

4. Select the appropriate instance and click the Create Emergency User button to open the Emergency Password
dialog, and then select Show password to see an automatically generated password, for use with the special
_ADMIN account.

5. Open PowerDesigner and select | Repository » Connect J, select the appropriate repository, enter ADMTN
as the login name and the generated password in the Password field and click OK.

1 Note
If you do not access the repository within 15 minutes, you must repeat the procedure to generate a new
temporary password.
6. Reset the administrator's password or create a new administrator account as appropriate (see Creating
Repository Users [page 566]).

7. Select | Repository » Disconnect Jto disconnect the emergency user from the repository. The emergency
user is deleted after disconnection.

3.2 Deploying an Enterprise Glossary and Library

An administrator can deploy a glossary and a library of enterprise reference models, resource files, and other
documents, which will be pushed to and automatically updated for all users. By default, only administrators can
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edit the glossary or add models to or edit the library. You can provide access to other users using the standard
repository permissions.

3.2.1 Deploying an Enterprise Glossary

The glossary model (GLM) helps you capture and organize the terminology to be used for naming your model
objects. An administrator deploys the glossary, and users enable it in their models to provide autocompletion for
object names and model checks to ensure compliance. The glossary appears in the Browser Glossary tab and
updates are pushed to users each time they connect to the repository, or on demand. Only one glossary is
permitted per repository.

For information about using the glossary, see The Glossary [page 39].

3.211 Creating Terms, Synonyms, and Related Terms

An administrator can define new glossary terms in the Glossary tab of the Browser.

Context

1 Note

You can quickly populate the glossary by performing a mass import of terms from a model (see Importing
Terms from a Model [page 5801]) or a CSV or Excel file (Importing Terms from an Excel or CSV File [page 581)),
or from the results of the List of Missing Terms glossary compliance model check (see Checking Glossary
Compliance [page 155]). You can also add terms in a glossary terms list (see Glossary Terms Lists [page 583]).

Procedure

1. Select the Glossary tab of the Browser, right-click the Glossary node, and select | New » Term .
2. Enter the Name and Code of the term, which should be approved for use in your organization's models.

3. [optional] Enter a description of the term in the Comment field, and a Reference URL leading to a site giving
further information about the term.
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® Term Properties - Sybase Unwired Platform {Sybase_Unwired P - |EI|5|

General |S_I,Inn:nn_l,lms| Related Termsl Maotes I

Marme: ISybase Urwwired Platfarm j
Code: |S ybasze Unwired_Platform IT
Comment; Sybase Uruwired Platform iz a mobile enterprize application platform that enables

enterprize developers to simply and quickly build applications that connect busineszs data
ko mahile warkers on any device, at any time.

Stereatype: I j

Beference URL: Ihttp:.-’a’www.s_l,lbase.ccu.uka’prDduu:ts#mu:ul:uileenterprisea’sybaseunwiredplatfurm

koare x> | %' - k. I Cancel Apply | Help |

4. [optional] Click the Synonyms tab and enter one or more synonyms for the term.

1 Note

Synonyms are words that have a similar meaning to the term, but are not approved for use in object names.
For example, Customer may be specified as a synonym for the approved term Client. When naming an
object, if a user begins to enter a synonym, the approved term is suggested in the autocompletion list.
Modelers can use the <Object> name contains synonyms of glossary terms model check to find and
replace synonyms in object names (see Checking Glossary Compliance [page 155]).
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® Term Properties - Sybase Unwired Platform {5ybase_Unwired_Platforrs

Geperal  Synonpms | Related Termsl Motes I

(a6l XAV EES -

R

=10l x|

Mame & -

Code

-

sSupP

J

=
[14 | ] 4 |

Muare > | = -

x|

Cancel

Apply

Help

5. [optional] Click the Related Terms tab and use the Add Objects and Create an Object tools to associate other

terms with the term.

1 Note

Related terms are other glossary terms that are in some way associated with the present term. For

example, Bank may be entered as a related term for the term Current Account.
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® Term Properties - Sybase Unwired Platform {5rhase_LlnwirEd_Platf:: - |EI|5|

Generall Synorymz  Related Tems | Motes I

S A an XA Y ES-

Mame - Code - =
i druired_Server
rmired_wiarkzpace

=
(14| #i] 4 |

J

koare x> | %' - k. I Cancel Apply | Help |

6. Click OK to save your changes and add the term to the glossary.

3.211.1 Importing Terms from a Model

You can import the names of objects from any kind of PowerDesigner model as terms to quickly populate your
glossary.

Context

Procedure

1. Right-click the Glossary node, and select Import from Model to open the Import Object Names as Glossary
Terms Wizard.

2. Select a model open in the workspace from which to import object names, and then click Next.

3. Select the kind of object whose names you want to import as glossary terms and, optionally, a property of the
object to specify the category of the imported terms, and then click Next.
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4. Select the objects whose names you want to import as glossary terms, and then click Finish.
The selected objects' names are imported as glossary terms. To import other objects' names as glossary
terms, restart the wizard.
1 Note

Though a repository can only contain one glossary, in multi-repository environments or in other situations
where you want to import terms from another glossary file, right-click the Glossary node, and select Import
from Another Glossary Model. Navigate to the glossary file and click Open to open the Merge Models dialog
(see Merging Models [page 399]), which will allow you to review and modify the proposed changes before
clicking OK to complete the import.

3.211.2 Importing Terms from an Excel or CSV File

You can import terms from an Excel or CSV file to quickly populate your glossary.

Context

To simplify the import of terms from an Excel file, we recommend that you create a worksheet called Term, with
the following format:

Comment Reference URL Synonyms Related Category
Terms
Client CLIENT Specifies... www.diction- Customer, Account, In- Sales
ary.com User voice
Supplier SUPPLIER Specifies... www.diction- Provider, Account, In- Purchasing
ary.com Seller voice
etc etc etc etc etc etc etc

Using these exact column headings allows the Excel import to automatically recognize them as the appropriate
properties. Only the Name column is required. You can enter multiple values in a column by separating them with
commas.

Procedure

Right-click the Glossary node, and select Import from Excel File to open the Excel Import wizard.

2. Click the Options button to open the Import Options dialog, select Auto-map columns to properties, and click
OK to return to the wizard.

3. Click the Select File button, navigate to and select the file you want to import, and click OK to return to the
wizard.

Core Features Guide
Administering PowerDesigner PUBLIC 581



4. Click Next to begin the wizard. If you have named your columns as suggested above, the wizard recognizes and
imports the terms and all their properties without further input from you.

1 Note

For detailed information about the PowerDesigner Excel Import Wizard, see Importing Objects from Excel
Files [page 96].

3.21.2 Organizing Terms in Categories

You can organize terms in the glossary by placing them in categories. You can create categories under the root or
under other categories, and drag and drop terms and categories to move them between categories.

To create a category, right-click the glossary root or a category and select |» New » Category 3, or use the tools on
the Categories tab of a category property sheet.

To add terms to a category, drag and drop them onto the category node in the Browser or use the Add and Create
tools on the Terms tab of the category property sheet.

Caution

If you delete a category, you also delete any categories and terms that it contains.

3.21.3 Adding Other Views and Objects to, and Extending
the Glossary

Although the Glossary's primary purpose is to manage enterprise terminology, you can also add business rules
and create reports on glossary objects. You can create lists and dependency matrices to display the glossary
terms and their relationships with other objects. You can also extend the glossary using all the standard extension
mechanisms including adding new properties to glossary terms and creating new types of objects.

These features are available from the glossary contextual menu. Right-click the glossary and select [+ New > :

o |» Glossary Terms List J - to create a terms list in the canvas (see Glossary Terms Lists [page 583]).
o |» Dependency Matrix 3 - to create a dependency matrix (see Dependency Matrices [page 198]).

e |» Business Rule 1 - to create a business rule (see Business Rules [page 139]).

o |» Report 3 -to create areport on the glossary (see Reports [page 324]).

e | List Report 1 - to create a list report on terms or other glossary objects (see Creating a List Report [page
331)).

® [xtension - to add an extension file (see Extension Files [page 452]) to the glossary to allow you to extend
glossary objects or define new extended objects. You can also add extended attributes to a glossary term,
synonym, or related term directly from its property sheet using the standard mechanism (see Adding New
Properties to an Object [page 168])
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3.214 Glossary Terms Lists

You can create glossary terms lists to help users browse the glossary and to simplify glossary editing. You can
create terms directly in a list and define custom filters for each list. To create a list, right-click the Glossary node

and select | New # Glossary Terms List 4.

The following tools are available on the glossary terms list toolbar:

Tools Description
|§| Properties [Alt+Enter] - Opens the property sheet of the selected term.
|@| Add a Row [Ctrl+N] - Create a new term.

Show Titles and Texts and Show Titles Only - Shows the titles and descriptions or only the titles of all
terms in the view.

Show Current Title and Text / Show Current Title Only - Toggle between showing the title and descrip-
tion or only the title of the selected term.

=
v
&

Cut ( + ),Copy ( + ),and Paste ( + )-Perform the standard clipboard

actions.

X

Delete [Ctrl+D] - Deletes the selected term.

|“i'_§¢| Customize Columns and Filter - Opens a dialog to change the columns displayed in the list or define a
T filter (see Customizing Object List Columns and Filtering Lists [page 124]).

|E Enable/Disable Filter - Toggles the filter specified in the Customize Columns and Filter dialog.

|E| Find ( + ) - Opens a dialog to search for text.

|E| Format ( + ) - Opens a dialog to specify fonts and styles.

Bold, Italic, and Underline - Format the selected text.

Align Left, Align Center, and Align Right - Align the selected text.

Bullets - Indent and bullet the selected text.

New Glossary Terms List - Creates a new list.

Open Glossary Terms List - Opens a dialog to select another terms list to view.

| (G

Export to Excel - Saves the list to a *xIs, *xIsx, or *csv format (specify the format in the Save as type
field in the Save as dialog).
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1 Note

Right-click the glossary node in the Browser and select Model Options to set default formats for the term names
and descriptions in your glossary terms lists (see Glossary Model Options [page 585]).

3.21.5 Checking the Glossary

To perform a model check on the glossary, right-click the glossary root and select Check Model. PowerDesigner
provides default model checks to verify the validity of terms, synonyms, and categories.

For detailed information about working with model checks, see Checking Models [page 149]. By default, these
checks are provided for glossary objects:

Check Description and Correction

Name and code unique- | Term, synonym, and category names and codes must be unique in the glossary.

ness ® Manual correction: Modify the duplicate name/code.

e Automatic correction: Appends a number to the duplicate name/code.

Missing term definition | Terms should be defined.

e Manual correction: Enter a definition in the Description field.

e Automatic correction: None.

3.2.1.6 Deploying the Glossary

Once you have created your glossary and added your terms, check it into the repository to automatically deploy it
to all users connecting to the repository.

Procedure

1. Right-click the Glossary root, and select Check In to open the Check In Document dialog (see Checking
Documents into the Repository [page 246]).

2. Enter an appropriate comment and click OK to complete the check in.

The glossary is now deployed to the repository and will be pushed to all users the next time they connect.

1 Note

You can continue to make modifications to your local glossary model, and each time that you check it in,
your changes are pushed to users the next time they connect to the repository.
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3.217 Glossary Model Properties

The model property sheet displays information about the glossary model.

To open the glossary property sheet, double-click its entry in the Browser Glossary tab. The General tab contains
the following properties:

Property Description

Name / Code / Comment Identify the model. The name should clearly convey the model's purpose to non-technical
users, while the code, which is used for generating code or scripts, may be abbreviated, and
should not normally include spaces. You can optionally add a comment to provide more de-
tailed information about the model. By default the code is auto-generated from the name by
applying the naming conventions specified in the model options. To decouple name-code
synchronization, click to release the = button to the right of the Code field.

Filename Specifies the location of the glossary model file.

Conjunctions Specifies a comma-separated list of small words that are excluded from glossary compli-
ance checks. For example: and, of, to, the.

Name / Code separators Specify lists of characters that indicate the end of a word in the name and code fields to pro-
vide bounding of words for the compliance checking and auto-completion. By default, the
characters . (space and dot) are set as separators for the name field and _ (underscore)
for the code field.

Author Specifies the author of the model. If you enter nothing, the Author field in diagram title
boxes displays the user name from the model property sheet Version Info tab. If you enter a
space, the Author field displays nothing.

Version / Repository Specify the version of the model. You can enter any value in the first field, while the second
field displays the repository version.

3.21.8 Glossary Model Options

You can set glossary model options by right-clicking the glossary node and selecting Model Options.

You can set the following options on the Model Settings page:

Description

Name/Code case sen- | Specifies that the names and codes for all objects are case sensitive, allowing you to have two objects

sitive with identical names or codes but different cases in the same model. If you change case sensitivity
during the design process, we recommend that you check your model to verify that your model does
not contain any duplicate objects.

Core Features Guide
Administering PowerDesigner PUBLIC 585



Option Description
External Shortcut Specifies the properties that are stored for external shortcuts to objects in other models for display in
Properties property sheets and on symbols. By default, All properties appear, but you can select to display only

Name/Code to reduce the size of your model.

1 Note

This option only controls properties of external shortcuts to models of the same type (PDM to PDM,
EAM to EAM, etc). External shortcuts to objects in other types of model can show only the basic
shortcut properties.

Click the Terms Fonts page to control the fonts and formatting used for the various types of text in your glossary
terms lists (see Glossary Terms Lists [page 5837).

3.2.2 Deploying an Enterprise Library

The library is a special folder at the root of the repository, which can be used to push models, resource files, model
and report templates and external documents to all users. An administrator controls access to the library using
standard permissions. The library folder appears at the top of the Browser Local tab and updates are pushed to
users each time they connect to the repository. Library models are for reference or to provide objects for reuse
while resource files are made available for selection wherever appropriate in the PowerDesigner interface.

For information about using the library, see The Library [page 43]

3.2.2.1 Sharing Models and External Documents via the
Library

An administrator or other user with Write permission on the Library folder or its subfolders can check models,
model templates, resource files, and other files into the library. Users with Submi t permission can propose
changes to the library. Once one or more documents are added to the library, users connecting to the repository
are invited to check them out into the library folder in their local workspace.

Context

1 Note

For information about managing permissions, see Granting Access Permissions on Repository Items [page 571].
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Procedure

1. Select a model or other type of file (such as a Word document or PDF) that you want to deploy to all users, and
connect to the repository.

1 Note

You cannot check projects into the library. For information about checking resource files and model
templates into the library, see Sharing Resource Files via the Library [page 588] and Sharing Model,
Report, and Project Templates and Conversion Tables via the Library [page 589].

2. Right-click the document in the Local tab of the Browser and select Check In.

3. Select the Library folder (or a subfolder beneath it) as the destination for your check in and enter an
appropriate comment:

7| Check In Document @
Enlder: b.Ublﬁﬁ’ j ﬁ
Comment: == ADMIN - Thursday, June 30, 2011 4:18:05 PM = -
Adding Global Business Rules COM to library for general
deployment.

[ ] ] [ Cancel ] [ Help ]

4. Select whether to check into a change list (see Change Lists [page 258]). You can choose from:
O <None> - [if you have Write permission on the target folder] Allows you to check the documents in
directly without review.
0 <New change list> - To create a new change list to contain the checked in documents.
© Change list_<xxxx>-Toadd the documents to an existing draft change list. Click the Properties tool to
the right of this field to access the property sheet of the change list.

1 Note

If you are checking in a new version of a document that is already contained in a draft change list, then
this field is read-only.

5. Enter a comment to explain the purpose of your check in, select any other appropriate parameters (see
Check-In Parameters [page 251]), and click OK to check in the document.

If you check into a change list, you can add other documents to it as necessary through other check ins before
submitting it (see Creating, Building, and Submitting a Change List [page 259]). Once the change list has been
approved by the reviewers, your changes are integrated into the official repository versions of the documents
and made available to other users. If an administrator has connected the repository to an SMTP server (see
Connecting to an SMTP Server for Notifications [page 558]) you will receive an email at the moment of
submission of your change list and when it is approved, rejected, or returned to you for further revision.

Core Features Guide
Administering PowerDesigner PUBLIC 587



The document is checked into the library in the repository:

Object Browser 0 X
7§ PD_Repository::ADMIN -
=-) Library P

5 Project Guildelines pdf - w1
-2 Data Dictionary - v1
&4 Global Business Rules - v1
- @ Glossany - vl

----- &g{ Global Impact Analysis - w1

&g Global Lineage Analysis -w1 ™

|T-_a Local | I'_‘E Glossar'_.r| 14 Repository

The next time a user connects to the repository (or selects |+ Repository # Synchronize Library 3, they will be
invited to check the model out into the library in their local workspace (see Connecting to a Repository [page
20D).

1 Note

Branching (see Branching Version Trees [page 280]) is not supported for the library.

3.2.2.2 Sharing Resource Files via the Library

Users with submit permission or higher can check DBMS definition files, extension files and other PowerDesigner
resource files into the library. Resource files are pushed to repository users in the same way as other library
documents, and appear automatically in the new model dialog, resource file lists, and anywhere in the interface
where a resource file can be selected.

Procedure

1

588

Expand the Library/Resources folder in the Repository browser tab to view the available sub-folders:
o Extensions

o Model Languages - for DBMS and process, object, and XML language definition files
o Report Languages

1 Note

PowerDesigner recursively scans all folders in the library to populate resource file lists with shared
resources, but we recommend that you group your files inside the Resources subfolder. All resource files,
including those without specific sub-folders are supported, and you can create additional sub-folders (and
sub-sub-folders) as appropriate. For information about templates and conversion tables, which must be
saved to specific sub-folders, see Sharing Model, Report, and Project Templates and Conversion Tables via
the Library [page 589)).
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2. Select | Tools » Resources » <type> 4to open the list of resource files containing the file that you want to
share (see PowerDesigner Resource Files [page 449]).

3. Select the resource file to check in from the list and click the Check In tool.

4. Select the folder inside the library into which you want to check in the file.

1 Note

If you check the resource into a folder outside the library and it is referenced by any models, PowerDesigner
will try to resolve the reference when these models are checked out, but the resource will not be
automatically synchronized in users' library folders and so will not be available for selection in lists of
resource files.

5. Select whether to check into a change list (see Change Lists [page 258]). You can choose from:
O <None> - [if you have Write permission on the target folder] Allows you to check the documents in
directly without review.
0 <New change list> - To create a new change list to contain the checked in documents.
© Change list_<xxxx>-Toadd the documents to an existing draft change list. Click the Properties tool to
the right of this field to access the property sheet of the change list.

1 Note

If you are checking in a new version of a document that is already contained in a draft change list, then
this field is read-only.

6. Enter a comment to explain the purpose of your check in, select any other appropriate parameters (see
Check-In Parameters [page 251]), and click OK to check in the document.
If you check into a change list, you can add other documents to it as necessary through other check ins before
submitting it (see Creating, Building, and Submitting a Change List [page 259]). Once the change list has been
approved by the reviewers, your changes are integrated into the official repository versions of the documents
and made available to other users. If an administrator has connected the repository to an SMTP server (see
Connecting to an SMTP Server for Notifications [page 558]) you will receive an email at the moment of
submission of your change list and when it is approved, rejected, or returned to you for further revision.

The next time users connect to the repository (or select |F Repository # Synchronize Library 3, they will be
invited to check the resource out into their local library, and it will immediately be available for use wherever a
resource file can be selected.

1 Note

The Resources folder and its sub-folders are only displayed inside the library folder in the Local browser tab
if you have at least Submi t permission on them.

3.2.2.3 Sharing Model, Report, and Project Templates and
Conversion Tables via the Library

Users with submi t permission or higher can check model, report, and project templates and conversion tables
into special sub-folders in the library. These files are pushed to repository users in the same way as other library
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documents, and appear automatically for selection anywhere in the interface where a template or conversion table
can be selected.

Procedure

1. Expandthe Library/Resources folder in the Repository browser tab to display the following sub-folders:

[e]

Model Templates (see Model Templates [page 15])

o Report Templates (see Report Templates [page 386])
o Project Templates (see Project Templates [page 82])
o Conversion Tables (see Conversion Tables [page 161])

2. Right-click the appropriate folder and select Add. Navigate to the file you want to check into the library and
click Open.

1 Note

You must check these files into the correct folder or they will not be available for selection in PowerDesigner
dialog boxes.

3. Select whether to check into a change list (see Change Lists [page 258]). You can choose from:

O <None> - [if you have Write permission on the target folder] Allows you to check the documents in
directly without review.

© <New change 1list>- To create a new change list to contain the checked in documents.

© Change list_ <xxxx>-Toadd the documents to an existing draft change list. Click the Properties tool to
the right of this field to access the property sheet of the change list.

1 Note

If you are checking in a new version of a document that is already contained in a draft change list, then
this field is read-only.

4. Enter a comment to explain the purpose of your check in, select any other appropriate parameters (see
Check-In Parameters [page 251]), and click OK to check in the document.

If you check into a change list, you can add other documents to it as necessary through other check ins before
submitting it (see Creating, Building, and Submitting a Change List [page 259]). Once the change list has been
approved by the reviewers, your changes are integrated into the official repository versions of the documents
and made available to other users. If an administrator has connected the repository to an SMTP server (see
Connecting to an SMTP Server for Notifications [page 558]) you will receive an email at the moment of
submission of your change list and when it is approved, rejected, or returned to you for further revision.

The next time users connect to the repository (or select [ Repository » Synchronize Library 3, they will be
invited to check the file out into their local library, and it willimmediately be available for use wherever a
template or conversion table can be selected.

1 Note

The Resources folder and its sub-folders are only displayed inside the library folder in the Local browser tab
if you have at least Submi t permission on them.
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3.2.3 Controlling Library and Glossary Write Permissions

Since library models and other documents are intended to be a reference for users, many administrators will want
to closely control who can edit them. You control access to the Library folder with standard repository
permissions. By default, all users can see the Library folder and have updates pushed to them as necessary, but
only administrators have the right to modify the glossary and other library models.

Context

The following are common uses of permissions on the Library folder and individual models within it:

e To allow arestricted group of users to modify library models - Create a Compliance Committee Or Library
Administrators group with Wwrite permission on the Library folder. Sometimes a separate Terminology
Committee Or Glossary Administrators group is created and Write permission on the glossary model is
restricted to this subset of users.

e To allow other users to propose changes to library models via change lists - Grant them Submi t permission on
the Library folder. Changes proposed are only applied to the library models if they are approved by your
administrators (see Change Lists [page 258]).

e To hide library models while they are being developed - Remove the A11 Users group from the permissions
list of individual models until they are ready for deployment.

For detailed information about setting repository permissions, see Granting Access Permissions on Repository
ltems [page 571].

3.3 Customizing the PowerDesigner Interface

You can customize the New Model dialog to guide model creation through templates and use profiles to hide types
of models, objects, and object properties, and to customize menus, commands, and preferences.

3.3.1 Customizing the New Model Dialog

A model category set is a PowerDesigner resource file that contains one or more categories, which in turn contain
templates to guide users through model creation in the New Model dialog. Using categories and templates for
model creation simplifies the model creation process by preselecting appropriate targets, extensions, and
diagrams, and by hiding irrelevant choices from users.

To view the list of model category sets, select | Tools ¥ Resources » Model Category Sets . For information about
the tools available in resource file lists, see PowerDesigner Resource Files [page 449].

You can deploy model category sets to users (see Sharing Resource Files via the Library [page 588]) to ensure that
everyone on your team is creating models using the same centralized targets and extensions checked out
automatically from the repository. You can create different category sets for different users so that, for example,
data architects will have different choices from business analysts when they open the New Model dialog.

Core Features Guide
Administering PowerDesigner PUBLIC 591



In the following example, the Information category is selected and provides eight templates to choose from:

" New Model
Categony: Categony items:
- r Business
= r Infarmation
Categories P Application ’ : . ’
= Conceptual Data Data Flow Diagram Drata Movement Logical Data
- Technalogy todel
] L Requirements and Planning
T
todel types
MultiDimenzional
Data

&, phyzical data model [POR] helps vou to analyze the tables, views, and other objects in a database, including multidimenzional Dbiectsil

necezzany for data warehouzing, & POM iz more concrete than a conceptual [COM) or logical (LOM] data model, vou can model,

reverse-enginesr, and generate for all the most popular DERMSs, et
todel nanne: |F'h_l,JsicaI Data 1
DEMS: ISybase SOAL Arywhere 11 ﬂ

¥ Share the DEMS definition
" Copy the DBMS definition in model
QK I Cancel | Help |
1 Note

You can also hide model types from certain types of users with object permission profiles (see Controlling the
Availability of Models, Objects, and Properties [page 599]).
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3.3.1.1 Selecting a Model Category Set to Display in the New
Model Dialog

The model category set you select in the Model Creation general options will be displayed in the New Model
window.

Procedure

1. Select | Tools j» General Options 3, and click the Model Creation category in the left hand pane.

Il General Options [_ O] x|
Category:
- Dhial }
. — Cateqgories
- Editars " :
- ariables v Enable categories
- Mamed Paths Default categany set; IDefauIt j
- Fants
- Repozitony ~ Model types
- Add-ng

W
todel Creation o - wetl el pes

— kodel templates
¥ Enable model termplate

M adel templates path: C:%Program FilezhSvbase\PowerDe

k. I Cancel Help

2. Verify that the Enable categories check box is selected, and select the category set you want to display from
the Default category set list.

3. [optional] Click the Path tool to the right of this field to browse to another folder containing model category
sets or the Properties tool to open the currently-selected set in the Resource Editor.

4. Click OK to close the General Options dialog.
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The selected category set and the templates it contains will be displayed in the New Model dialog next time
you open it.

3.3.1.2 Creating a Model Category Set

You can create as many different model category sets as you need, creating different sets for different types of
users, for example.

Procedure

1. Select| Tools » Resources » Model Category Sets 4 to open the List of Model Category Sets.
2. Click the New tool to open the New Model Category Set dialog.
Enter a name for your model category set, and select a source to copy it from. You can choose between:

o <Default template> — creates an empty set that you complete by adding categories and templates.
o Another model category set — makes a copy of an existing set that you can edit as necessary.

4. Specify a name and a location to create the set and click Save.
The model category set is created and opened for review in the Resource Editor.

5. For each category that you need, right-click the root node, and select |r New J. In the right-hand pane, enter a
name for the category and, optionally, click the Browse for icon tool to change the default icon.

1 Note

You can reorder the categories if necessary by drag and drop.

6. When you have created your categories, you add templates to them by right-clicking the category and
selecting | New 3 and then one of the following:
o Model - creates a simple model template that can specify a default target, extensions, and an empty first
diagram (see Adding a Model Template to a Model Category Set [page 595]).
©o Model from Template - which points to an actual model file that, in addition to specifying a target and
extensions, can contain multiple diagrams, display preferences, general and model options, etc (see
Adding a Model from Template to a Model Category Set [page 596])

7. When you have finished creating categories and templates, click OK to close the resource editor and click the
Save tool in the List of Model Category Sets to save your edits.
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& Model Category Set Properties M=l &3

General |
- - IDefauIt::InfurmatiDn j "l» . lﬂ . .:I.i: 12}

l,'-_’_"";- Default

{f_‘i‘l Buziness

=R} nformation lzorn: PEllE] |
-] Conceptual Data :
{74 Diata Flaw Diagram Commet:

-] Datta s Use the itemns in thiz categom to capture information about your data, independent &
[ Logical Data of applications and processes, by creating diagrams to analyze data items, entities,
-] Physical Data relationships, tables, etc,

{74 UML Class Diagran

M arne: |Inf0rmati|:|n

i| MultDimenzional Data
-} Application
B Technology
-} Requirements and Planning

Ok I Cancel | Apply | Help |

You can test your category set by selecting it in the General Options dialog (see Selecting a Model Category
Set to Display in the New Model Dialog [page 593]) and selecting |» File » New Model

33121 Adding a Model Template to a Model Category Set

Model templates are simple templates that can specify a default target, extensions, and an empty first diagram.

Procedure

1. Right-click the category to which you want to add the template, and select |» New » Model

2. Onthe General tab, enter a template name and select a model and diagram type.

3. [optional, for model types with targets] Specify a target (DBMS, object or process language, etc). If you select
None, then the user can select any available target language in the New Model dialog.

4. [optional] On the Icon tab, click the Browse for icon tool to change the default template icon.

5. [optional] On the Extensions tab, click the Select Extensions tool to attach one or more extensions to the
model (see Attaching Extensions At Model Creation Time [page 14]).

6. [optional] Select the Allow additional extensions at model creation check box if you want to allow users to
attach additional extensions to those you have specified. The Extensions button in the New Model dialog is not
available if you do not select this check box.
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In the following example, the Physical Data template is specified to create a Physical Data Model with a
physical diagram, and since no DBMS is specified, the user will be able to choose one at model creation time:

@ Model Category Set Properties Ol x|
General |
- - IDefault::Infu:urmatiu:un'xF'h_l,lsicaI [ata j '\k A H - 'E'f 1';}
2% Default .
: General
{ﬂ' Busingss | [[=talg} I Extenszions I
=25 Information M ame: IF'h_I,Isiu:aI Data
~{"| Conceptual Data
-[| Data Flow Diagram Model tvpe: IF'h_l,lsicaI Data Model j
-] Data Movement Modsl . : . .
B Logisal Dats Diagram tpe: IF'h_I,Isu:aI Diagram j
R REIE P rzical Data DEMS: <Mone> ~ [zl [®
"] UML Clasz Diagram I J
whAL Commept:
~{d r?dult.lDlmensu:naI I & physical data model [PDM) helps vou to analyze the tables, views, and
-2 Application other objects in a databaze, including multidimensional objects neceszan
#-{} Technalogy far data warehousing. & PO is mare concrete than a conceptual [COR] ar
- Requirements and Planning logizal [LD'M] data model. “f'ou can model, reverse-engineer, and generate

far all the most popular DEMS s,

(] I Cancel Spply Help

33122 Adding a Model from Template to a Model Category
Set

Models from templates are templates that point to existing model files that, in addition to specifying a target and
extensions, can contain multiple diagrams, display preferences, general and model options, etc.

Context

In order to add a model from template to a category, you must have a model file that contains all the appropriate
parameters ready to point to.
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Procedure

1. Right-click the category to which you want to add the template, and select |+ New » Model from Template

2. Onthe General tab, enter a template name and click the Select File tool to the right of the Model file field to
browse to and select the model file to use as the template.

3. [optional] On the Icon tab, click the Browse for icon tool to change the default template icon.

In the following example, the Data Flow Diagram template is specified to create a Business Process Model
from an existing dfd.bpm model, and will inherit its pre-configured options, preferences, extensions, and

objects:
& Model Category Set Properties M=l E3
General |
- e IDefault::lnfnrmatinn'\Data Flowy Diagram j ‘% - = 'Ti": 12}
[ Detault
{ﬂ- Business General I (20 I
=3 Information M arne: IData Flows Driagrarn
Conceptual Data
..... 8 D1 ata Flow Diagram todel file: |C:"~F'rngram Filez\Sybaze’\PowerD ezsigner 154E xampl
Data Moverment Model
. Comment;
Logical Data
Phuzical Data ;I
kL Clags Diagram LI
ML L i
MultiDimenzional D ata File prerview
F-15 Application Model type: IBusiness Process Model j
-7} Technaolagy :
P I B -
[#-% Requirements and Planning Process language:  [Dats Flow Diagar -
" Share the process language definition
" Copyithe process language defitition in mode!
k. I Cancel Apply Help
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3.3.1.3 Pushing Model Category Sets to Users

You can deploy your model category sets to the library to make them available to other users.

Procedure

1. Select | Tools ¥ Resources # Model Category Sets 3 to open the List of Model Category Sets.
2. Select the category set you want to push to other users and click the Check In tool.

3. Select the folder inside the library into which you want to check in the category set, and enter an appropriate
comment.

1 Note

If you check the category set into a folder outside the library, it will not be available for selection in the
General Options dialog. For more information about the library, see Deploying an Enterprise Library [page
586].

4. Click OK to check in the category set.

The next time users connect to the repository (or select |# Repository » Synchronize Library 3, they will be
invited to check the category set out into their local library, and it will immediately be available for selection

when they click |» Tools  General Options 3, and click the Model Creation category in the left pane.

3.3.2 Using Profiles to Control the PowerDesigner Interface

An administrator can create profiles in the repository to customize and simplify the PowerDesigner interface for
users by hiding types of models, objects, and object properties, by reconfiguring menus, toolbars, and toolboxes,
and by setting appropriate defaults for options and preferences. You can define multiple profiles to customize the
interface in different ways for different kinds of users and apply them as appropriate to individual user accounts or
to repository groups.

Three types of profiles are available to administrators to customize the PowerDesigner interface for users:

e Object permissions profiles - to hide types of models or make them read-only, and to hide model objects and
object properties. Use these profiles to simplify the modeling environment by presenting users with only the
concepts that they need:

o Hiding a module - prevents the creation or opening of models of this type.

o Hiding an object - removes it from the Toolbox, Browser, Model menu, New contextual menu, and property
sheets.

o Hiding an attribute or collection - removes it from object symbols and property sheets.

e Ul preferences profiles - to customize the commands available in menus, toolbars, and toolboxes. Use these
profiles to reorganize and simplify the PowerDesigner interface for users. They provide the same kind of
customization as users can perform using the | Tools » Customize Menus and Tools 4 command (see
Customizing Menus, Toolbars, and Toolboxes [page 446]).
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e General preferences profiles - to set default display preferences and model and general options. Use these
profiles to guide users toward making appropriate option and preference choices. They provide the same kind
of customization as users can perform using user profiles (see User Profiles [page 422]).

3.3.2.1 Controlling the Availability of Models, Objects, and
Properties

An administrator can define object permissions profiles to hide models, objects, and properties, or make models
available in read-only form for users or group of users. By default, all types of models, objects, and properties are
available and you hide them (or make them read-only) by adding entries to an object permissions profile.

Procedure

1. Connect to the repository and then select |+ Repository i Administration » Object Permission Profiles 3.
2. Click the Create an Object tool, enter a name for the profile, select a template to start from, and click OK to
create and open it in the Resource Editor.

3. [optional] Click the Import Items tool to import an existing profile, review the items to be imported in the
Merge dialog, and then click OK to complete the import.

For detailed information about working with this dialog, see Merging Models [page 399]. You can repeat this
step as many times as necessary to import additional profiles.

1 Note

PowerDesigner provides a number of example profiles, which you can combine as necessary and edit to
support your particular workflow (see Example Permission Profiles [page 602]).

4. To modify the status of model types (modules) for users associated with this profile, right-click the root
element and select Add Modules to Customize (or click the equivalent tool in the toolbar), select the modules
and click OK to add them to the profile. Then select the appropriate status:

o Undefined - [default] The module's availability is not specified in the profile. This status is useful when the

profile will be combined with others, and these other profiles will determine the availability of the module.
The module can be customized by hiding objects, object attributes, and collections.

o Enable - The module is available to users associated with the profile, and can be customized by hiding
objects, attributes, and collections.

o Disable (Hide) - The module and all models of this type are hidden to users associated with the profile. No
further customization is possible.

o Read-Only - The module is available to users associated with the profile, but they may not edit models of
this type. No further customization is possible.

In this example, the OOM, DMM, LDM, and PDM are added to the profile to hide them from business users:

Core Features Guide
Administering PowerDesigner PUBLIC 599



= Permissions Profile Properties =
General

& - Bl - Business User v\.xvlgvﬂfab'lw;’l

_;} Object Oriented Model Mame:; Business User E]
o4 Data Movement Model Code: Business User E};]
i3] Logical Data Moded
73 Physical Data Model Caomment:

™

1

@ x| -

Display Mame & =|F =|H =R ={U =] Metamember Type = =
1 Object-Oriented Model ] i [@] ¢ [ ¢ [ i Metalibrary
= Data Movemert Model ] &[] ¢ [ § [ § Metalibrary £
3 Logical Data Model ] i [ i [ i [F] i Metalibrary
= | Physical Data Model ] § @] i [0 § [ i Metalibrary "I
e
BIEEE E

-
-

Lok ][ Comced ][ ooy || Heb |

5. To modify the status of object types (metaclasses) for users associated with this profile, right-click the parent
module, select Add Metaclasses to Customize (or click the equivalent tool in the toolbar), select the
metaclasses and click OK to add them to the profile. Then select the appropriate status:

o Undefined - [default] The metaclass's availability is not specified in the profile. This status is useful when
the profile will be combined with others, and these other profiles will determine the availability of the
metaclass. The metaclass can be customized by hiding attributes and collections.

o Enable - The metaclass is available to users associated with the profile, and can be customized by hiding
attributes and collections.

o Disable (Hide) - The metaclass and all objects of this type are hidden to users associated with the profile.
No further customization is possible.

1 Note

To add a metaclass defined in a DBMS, language definition, or extension file to a permission profile, enter it
by hand in the format <metaclass>: :<stereotype>. For example, to hide SAP IQ events, enter
ExtendedObject: :Event, and select the checkbox in the H column.

In this example, the Application Architecture Diagram and Service Oriented Diagram metaclasses are added to
the profile to hide them from business users:
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= Permissions Profile Properties EI
General

- - Business User:PdEAM r Q-Hd-§ s
Busi U
g%ﬂgf,f:d;fmm Model Mame; Enterprise Architecture Model
% EJ:t_a rulioDv:tmT ;ﬂ;dﬁ @ Undefined ) Enable () Disable(Hide] ) Read-Oriy
gical Data Mo
-3 Physical Data Model B X | B[
; o = S -
=8 %::] Enterprise Architecture Model | | .
-[%| Application Architecturs D Display Name & v|F »JH ~]U ~ o
el Service Oriented Diagram = | Application Architecture D: |7 I
Z Service Oriented Diagram § 7] |
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L. I
] =
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6. To modify the status of object properties (attributes and collections) for users associated with this profile,
right-click the parent metaclass and select Add Meta-attributes to Customize or Add Metacollections to
Customize (or click the equivalent tool in the toolbar), select the attributes or collections and click OK to add
them to the profile. Then select the appropriate status:

o Undefined - The attribute or collection's availability is not specified in the profile.
o Enabled - The attribute or collection is available to users associated with the profile.
o Disabled (Hidden) [default] - The attribute or collection is hidden to users associated with the profile.

1 Note

To add an extended attribute defined in a DBMS, language definition, or extension file to a permission
profile, enter it by hand. For example, to hide the DBSpace attribute for SAP |Q tables, enter DBSpace, and
select the checkbox in the H column.

In this example, the entity Code attribute is added to the profile to hide it from business users:

Core Features Guide
Administering PowerDesigner PUBLIC 601




= Permissions Profile Properties EI
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1 Note

You can propagate customizations of properties to other metaclasses, including to metaclasses in other
types of models. Select a metaclass with customized properties and click the Apply to All Metaclasses in
This Module or Apply to All Metaclasses in All Modules tool or right-click a meta-attribute or metacollection
and select:

o Apply to All Metaclasses in This Module - to propagate its customization to all other metaclasses that
include this property in the present module. PowerDesigner will add the minimum number of
metaclasses necessary to apply the customization by exploiting inheritance in the metamodel. This
often involves adding the Named Object and a handful of other metaclasses.

o Apply to All Metaclasses in All Modules - to propagate its customization to all other metaclasses that
include this property in all the modules that are included in the profile. PowerDesigner will not add
additional modules to the profile, so if you want to customize the property everywhere it appears, you
must first add all relevant modules.

7. Click OK to save the profile in the repository.

3.3.2.11 Example Permission Profiles

PowerDesigner provides a set of permission profiles that you can merge into your own profiles, combining, editing,
or adding to them as appropriate for your team's working practices.

There are four kinds of example profiles available inthe <install dir>/Resource Files/Profiles
directory:
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e Hide Objects - Remove one or more types of objects from the Toolbox, Browser, Model menu, New contextual
menu, and property sheets:
o Hide Objects - Business Rules
o Hide Objects - EAM Application Objects
o Hide Objects - EAM Business Objects
o Hide Objects - EAM Technology Objects
o Hide Objects - Traceability Links
e Hide Properties - remove attributes and collections from object symbols and property sheets:
o Hide Properties - Codes for Non-Data Objects
o Hide Properties - Keywords
© Hide Properties - Mappings
o Hide Properties - Related Diagrams
o Hide Properties - Stereotype
o Hide Properties - Technical Properties
® |ock - Prevent the user from changing special model properties:

o Lock - Extensions (removes extension files from the Browser, Model menu, and New contextual menu to
prevent users changing extensions)

o Lock - Model Options (removes the Model Options command from the Tools menu to prevent users
changing model options)
® Role - Control the availability of modules for various types of users:
o Role - Developer (hides the BPM and EAM, and makes the CDM, LDM, and RQM read-only)
o Role - Enterprise Architect (hides or makes read-only all models except the EAM)
o Role - Information Architect (hides the RQM, and makes the BPM, EAM, and OOM read-only)
© Role - Process Architect (hides or makes read-only all models except the BPM)

3.3.2.2 Controlling Defaults for Menus, Toolbars, and
Toolboxes

An administrator can define Ul preferences profiles to control the default configuration of menus, toolbars, and
toolboxes for users or group of users.

Procedure

1. Connect to the repository and then select |» Repository ¥ Administration » Ul Preference Profiles 3.

2. Click the Create an Object tool, enter a name for the profile, select a template to start from, and click OK to
create and open it in the Customize Menus and Tools dialog.

3. Select and modify the menus, toolbars, and toolboxes for the appropriate views using the various panels in the
dialog (see Customizing Menus, Toolbars, and Toolboxes [page 446]).

4. Click OK to save the profile in the repository.
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3.3.2.3 Controlling Defaults for Options and Preferences

An administrator can define general preferences profiles to control the default values for display preferences,
model options, general options, and other preferences for users or group of users.

Procedure

1. Connect to the repository and then select | Repository j Administration  General Preference Profiles 3.

These profiles are the same as those that individual users can use to customize their options and preferences
(see User Profiles [page 422]).

2. Click the Add a Row tool, enter a name, and click the Properties tool, to create the profile and open it in the
resource editor.

3. Click the Create an Object tool, enter a name for the profile, and select a source from which to copy from. You
can choose between:

o Another user profile — Makes a copy of the existing profile.
© <Registry> - Copies all your PowerDesigner defaults from your Windows registry.

0 <Model> - Opens the Model for User Profile dialog, which allows you to specify preferences to copy from
an open model (see Copying Preferences from a Model [page 426]).

4. Click OK to open the profile in the Resource Editor.

5. [optional] Click the Import Items tool to import an existing profile, review the items to be imported in the
Merge dialog (see Merging Models [page 399]), and then click OK to complete the import.
You can repeat this step as many times as necessary to import additional profiles.

6. Edit the profile as necessary (see Reviewing and Editing User Profiles in the Resource Editor [page 427]).

Click OK to save the profile in the repository.

3.3.2.4 Applying Profiles to Users and Groups

An administrator applies object permissions profiles, Ul preferences profiles, and general preferences profiles to a
user or group via their repository property sheet Profiles tab.

Context

1 Note

Though you can apply only one of each type of profile to each user or group, you can apply multiple profiles to a
user or group by inserting them into multiple groups or by using a hierarchy of groups (see Adding Users and
Groups to a Group [page 569]).
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Where a user or group is associated with multiple profiles through membership in multiple groups, the following
rules apply:

® (Object Permissions Profiles - The most permissive superset of permissions is applied and the order of group
membership is unimportant. For example, if the user is associated with one profile which hides the EAM
module and another which enables it, then it will be visible for him.

e Ul and General Preference Profiles - Preferences are applied starting from the bottom of the list on the Groups
tab and finishing with any profile applied directly to the user, with the last applied preferences being used in
the case of conflicts. In the following example, any Ul or preference profile applied to the All users group will be
applied, followed by those for the Acme Corp, Manufacturing Division, and Developers groups, and finally any
profile applied to Gemma herself:

P

{p User Properties - Gemma McBride (Gemma) El
General | Groups | Profiles | Rights | Version irfo |
N REAX A vYEe ES -
MName - Code b =
= | Developers Developers
2 Manufacturing Division : Manufacturing Divis
3 Acme Comp Acme Comp
4 All users PUBLIC =
Ak EIR4EIEIR TT— T
=~ | 0K || Camcel || Mopy || Hep

Procedure

1. Create appropriate object permission, Ul preference, and general preference profiles in the repository.

2. Select | Repository » Administration » Users 3 (or |# Repository # Administration » Groups 1) and select the
user or group to whom you want to apply the profile.

3. Click the Properties tool to open the user's property sheet, and then click the Profiles tab.

4. Select the appropriate profile in one or more of the Object Permissions, Ul Preferences, and General
Preferences fields, and click OK.
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(_';; Uzer Properties - Brian Cooper (Brian) L= @
| General I (Groups | Profiles | Rights | Wersion Irrfol

Object Permizzions: Business User v]ﬂﬁ
Ul Preferences: [Ilﬁ Business User U v]ﬂﬁ
General Preferences: [Ilﬁ Business User Defaults v]ﬂﬁ
S~ | ok || Cancel Apply Help

When the user next connects to the repository, the selected profiles will be pushed to their installation of
PowerDesigner.

1 Note

Permissions profiles are enforced (the user cannot access types of models or objects that are hidden from
her), and the defaults specified in the Ul and general preference profiles are re-applied each time the user
connects to the repository (if the Apply profiles option is selected in the user's repository general options
(see Repository Options [page 437]).

3.4 PowerDesigner Security Guide

This Security Guide provides an overview of the security concepts used and recommended in administering a
PowerDesigner environment. It is aimed at technology consultants, security consultants, and system
administrators.

As it becomes more and more important for organizations to protect their critical data from unauthorized access
and to ensure compliance with a growing number of rules and regulations, the demands on security are also on the
rise. As a repository for your enterprise metadata, PowerDesigner can contain sensitive information about your
organization and its systems. It is therefore essential that you integrate PowerDesigner into your infrastructures
securely and that you protect your data in PowerDesigner.

This guide provides an overview of the security-relevant information that applies to PowerDesigner:

e Auditing and Logging [page 607]
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e Data Protection and Privacy [page 607]

e |dentity and Access Managment [page 608]

® Network and Communication Security [page 610]

e Cookies [page 612]

e Secure Delivery, Configuration, and Change Management [page 612]
e Operational Security [page 613]

3.4.1 Auditing and Logging

Auditing provides you with visibility on who did what in the PowerDesigner repository (or tried to do what) and
when.

Auditing allows you to monitor and record selected actions performed in the PowerDesigner repository. Although
auditing does not directly increase your system's security, if wisely designed, it can help you achieve greater
security in the following ways:

e Uncover security holes if too many privileges were granted to some user

e Show attempts to breach security

® Protect the system owner against accusations of security violations and data misuse
e Allow the system owner to meet security standards

The following forms of auditing are available:

e \View lists of events concerning repository documents and user accounts (see Monitoring Repository Activities
[page 574]).

e View the repository proxy log file (see Installation Guide > Installing the Repository Proxy ).

e |f you are experiencing problems with memory usage or repository database performance, contact customer
support to obtain access to further debugging features.

3.4.2 Data Protection and Privacy

Data protection is associated with numerous legal requirements and privacy concerns. In addition to compliance
with general data privacy acts, it is necessary to consider compliance with industry-specific legislation in different
countries.

1 Note

In the majority of cases, compliance with data privacy laws is not a product feature. SAP software supports data
privacy by providing security features and specific functions relevant to data protection, such as functions for
the deletion of personal data. SAP does not provide legal advice in any form. The definitions and other terms
used in this guide are not taken from any given legal source.
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3.4.3 |ldentity and Access Managment

Every user who wants to work with the repository must have a repository user with the necessary rights and
permissions. After a successful logon, the user's authorization to perform the requested operations on the
requested objects is verified.

Repository rights give users access to general repository features, while permissions give them access to
particular locations in the repository. The following rights and permissions are available:

Rights (Entire Repository) Permissions (Per Folder or Item)
® Connect - Connect to the repository. e List - View the document or folder in the repository
e Edit on Web - Create and edit diagrams in browser and in search results. Without this permission,
PowerDesigner Web. the folder or document is hidden from the user.
* Edit Extensions on Web - Createand edit cus- e Read - Also check documents out from the repository

tom properties in PowerDesigner Web.
® Freeze Versions - (see Freezing and Unfreezing
Document Versions [page 274]).

and compare documents.
e Submit - Also check the document into a changelist for

® TLock Documents - (see Locking and Unlocking Docu- review by a user with Wri te permission.

ments [page 275]). ® Write - Also check in (with or without a changelist),
® Manage Branches - (see Branching Version Trees freeze, and lock document versions.
[page 280]). e Full - Also move and delete documents, manage per-

® Manage Configurations - (see Grouping Docu-
ment Versions in a Configuration [page 277]).

missions granted to users and groups, and remove locks

on documents.
® Manage All Documents - Perform any action on any

document version. Implicitly includes Full permission i Note
on all repository documents.

e Manage Users & Permissions - Create, modify, Administrators, who have implicit Full permission on
and delete repository users and groups, grant them all repository objects, will only receive diagrams for re-
rights, and add them to groups. Users with this right can view if they have been granted explicit Write permis-

list all repository documents and set permissions on
them without needing explicit Full permission.

sion on them.

® Manage Repository - Create, upgrade, and delete
the repository database.

Rights and permissions can be granted to repository users either directly, or indirectly through groups.

User Administration Tools

In order to manage repository users and groups, you must have the Manage Users right. In order to grant
permission on a repository folder or document, you must have Full permission on the folder or document.

See Controlling Repository Access [page 550].

Standard Users and Groups

The following standard users are automatically created in the PowerDesigner repository:
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® ADMIN - Has all available rights and implicit Full permission on all repository folders.

® ADMIN - |s created as a temporary emergency user for connecting to a repository when no administrator is
able to access it (see Obtaining Emergency Access to the Repository [page 576]).

The following standard groups are automatically created in the PowerDesigner repository:

e Administrators, [ADMN] - Has, by default, all available rights and implicit Full permission on all repository
folders.

e Allusers [PUBLIC] - Has, by default, Read permission on the repository root. All users belong to this group and
can thus, by default, check out any document.

e [External users [EXTERNAL] - Has, by default, no rights or permissions. Users authenticated via LDAP (see
Connecting to an LDAP Server for User Authentication [page 553]) or single-sign on (see Enabling Single Sign-
On for PowerDesigner Web [page 565]) are automatically added to this group when they connect for the first
time.

Password Policy

Passwords for the user name/password authentication of repository users are subject to a password policy. You
can change the default password policy in line with your organization’s security requirements. You cannot
deactivate the password policy.

See Defining a Password Policy [page 559].

LDAP

PowerDesigner supports delegating user authentication to an LDAP server.

See Connecting to an LDAP Server for User Authentication [page 553].

Single Sign-On

In environments where X.509 client authentication is in place, PowerDesigner Web supports authentication of
users by the user certificate stored on their client machine.

See Enabling Single Sign-On for PowerDesigner Web [page 565].

Controlling Write Access through Change Lists

PowerDesigner supports the enforcement of reviewing proposed changes to repository documents through the
use of the submi t permission, which requires users to pass through a review process before publication.

See Change Lists [page 258].
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Secure Locations and Trusted Files

To reduce the risk posed by malicious scripts, you can instruct PowerDesigner to notify you when an untrusted
script embedded in or called from a model or resource file is run, to prompt you for permission to run an untrusted
script, or to block such scripts from running altogether.

See Security Options [page 439].

3.4.4 Network and Communication Security

The components of a PowerDesigner landscape communicate through different network communication
channels. It is recommended security practice to have a well-defined network topology to control and limit network
access to the PowerDesigner repository to only those communication channels needed for your scenario, and to
apply appropriate additional security measures, such as encryption, where necessary.

This can be achieved through different means, such as separate network zones and network firewalls, and through
the configuration options. The exact setup depends on your environment, your implementation scenario, and your
security requirements and policies.

Remaote Site
B P _
|'. “_ | TCP N ! j{
= = .
Wi PowerDesigner Client
Internal Metwork
TCP (27000/27010)
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H L ™ ODBG - _ JoBc | L gl HTTP;HTTPS,H
T T - - S BLELLEELE
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SySAM Reposi Proogy Tomcat Nod
& pository Repository Database e =
'] A
TCP (27000/27010)
TGP (32999)
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fi
ol
I TCP {389/838)
PowerDesigner Client

The network connections shown in the diagram can be encrypted as follows:

e PowerDesigner Client to:
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Repository - encryptable through options in the appropriate connection profile.

Proxy - encrypted by default.

SySAM - not encryptable.

LDAP Server - encryptable by enabling SSL (see Connecting to an LDAP Server for User Authentication
[page 553]).

® Proxy Server to Repository - encryptable through options in the appropriate connection profile.
e \Web Browser to Node - encryptable by enabling SSL (see Enabling SSL for PowerDesigner Web [page 560]).
e Node to Tomcat - encryptable by enabling SSL (see Enabling SSL for PowerDesigner Web [page 560]).

e Tomcat to:

e}

o

o

Repository - encryptable through options in the appropriate connection profile.

LDAP Server - encryptable by enabling SSL (see Connecting to an LDAP Server for User Authentication
[page 553]).

SMTP Server - can be encrypted by enabling SSL (see Connecting to an SMTP Server for Notifications
[page 558]).

SySAM - not encryptable.

Several mechanisms can be used to protect security-relevant data stored in and read from the PowerDesigner
repository. PowerDesigner supports encryption of both passwords and data for direct and proxy connections to a
repository and for connections to other databases using most of the supported DBMSs via one or both of ODBC
and JDBC connections.

The following table provides information and examples for encrypting passwords and data with each type of
connection:

Type ’ Encryption

ODBC Password and data encryption can generally be enabled in the ODBC Configuration dialog.
For example, to encrypt the password for SAP SQL Anywhere, select the Encrypt password option on the Login
tab, and to encrypt data, select an encryption method on the Network tab.

JDBC Itis not possible to control password and data encryption through the PowerDesigner connection profile inter-
face, but you may be able to enable encryption directly in your database client.

For more information about using connection profiles, see Connecting to a Database [page 23]. For detailed
information about encryption and other parameters for your database, see your DBMS documentation.

PowerDesigner Web supports reverse engineering from and generating to SAP Solution Manager v7.2 servers via
HTTP connections. We recommend that you encrypt your connections, if possible, by selecting the Use https
connection option.
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3.4.5 Cookies

Session cookies are required for each PowerDesigner Web client session and are deleted when the session is
closed. Additional persistent cookies are used to store the most recent choices for content language and user
interface language.

3.4.6 Secure Delivery, Configuration, and Change Management

PowerDesigner and PowerDesigner Web require third party components and will install them if they are not
present in your environment.

PowerDesigner Dependencies

PowerDesigner depends on the following frameworks and libraries:

e Microsoft .NET Framework 4.0.

1 Note

After installation is complete, we recommend that you check for and install the latest security updates.

® 02003pia.msi, 02007pia.msi, 02010pia.msi - Microsoft Office Primary Interop Assemblies for MS Office
2003, 2007, and 2010 to support PowerDesigner MS Office plugins.

® msxml6-KB2758696-fra-x86.exe Ormsxml6-KB2758696-fra-amd64.exe - to support the
PowerDesigner XSM.

® NCo3016 Net40 x86.msiOrNCo3016 Net40 x64.msi-SAP DotNetConnector3

® vjredist.exe - Microsoft Visual J# 2.0 redistribuable to support the PowerDesigner Auto-Layout feature.

® vcredist x86.exeoOrvcredist x64.exe - Microsoft Visual C++ 2008 and 2010 Runtime Libraries

® vstor redist.exe - Visual Studio Tools for Office

PowerDesigher Web Dependencies

PowerDesigner Web depends on the following components:

e Arecent Node.js 6.x Active LTS version.
e Java 8 (The installer will install the SAP JVM 8.x and a Tomcat 8 server.)

1 Note

After installation is complete, we recommend that you check for and install the latest security updates.
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3.4.7 Operational Security

Itis possible to securely scale your PowerDesigner Web installation through the use of load balancers such as
NGINX or HAProxy. Refer to your load balancer documentation for security recommendations
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency (see:
https://help.sap.com/viewer/disclaimer).
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